
Bulk Administration Guide for Cisco Unified Communications Manager,
Release 14 and SUs
First Published: 2021-10-28

Last Modified: 2023-05-18

Americas Headquarters
Cisco Systems, Inc.
170 West Tasman Drive
San Jose, CA 95134-1706
USA
http://www.cisco.com
Tel: 408 526-4000

800 553-NETS (6387)
Fax: 408 527-0883



THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT NOTICE. ALL STATEMENTS,
INFORMATION, AND RECOMMENDATIONS IN THIS MANUAL ARE BELIEVED TO BE ACCURATE BUT ARE PRESENTED WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED. USERS MUST TAKE FULL RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS.

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET FORTH IN THE INFORMATION PACKET THAT SHIPPED WITH
THE PRODUCT AND ARE INCORPORATED HEREIN BY THIS REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE LICENSE OR LIMITED WARRANTY,
CONTACT YOUR CISCO REPRESENTATIVE FOR A COPY.

The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as part of UCB's public domain version of
the UNIX operating system. All rights reserved. Copyright © 1981, Regents of the University of California.

NOTWITHSTANDING ANY OTHERWARRANTY HEREIN, ALL DOCUMENT FILES AND SOFTWARE OF THESE SUPPLIERS ARE PROVIDED “AS IS" WITH ALL FAULTS.
CISCO AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION, THOSE OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING, USAGE, OR TRADE PRACTICE.

IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL DAMAGES, INCLUDING, WITHOUT
LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR INABILITY TO USE THIS MANUAL, EVEN IF CISCO OR ITS SUPPLIERS
HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Any Internet Protocol (IP) addresses and phone numbers used in this document are not intended to be actual addresses and phone numbers. Any examples, command display output, network
topology diagrams, and other figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses or phone numbers in illustrative content is unintentional
and coincidental.

All printed copies and duplicate soft copies of this document are considered uncontrolled. See the current online version for the latest version.

Cisco has more than 200 offices worldwide. Addresses and phone numbers are listed on the Cisco website at www.cisco.com/go/offices.

The documentation set for this product strives to use bias-free language. For purposes of this documentation set, bias-free is defined as language that does not imply discrimination based on
age, disability, gender, racial identity, ethnic identity, sexual orientation, socioeconomic status, and intersectionality. Exceptions may be present in the documentation due to language that
is hardcoded in the user interfaces of the product software, language used based on standards documentation, or language that is used by a referenced third-party product.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries. To view a list of Cisco trademarks, go to this URL:
https://www.cisco.com/c/en/us/about/legal/trademarks.html. Third-party trademarks mentioned are the property of their respective owners. The use of the word partner does not imply a
partnership relationship between Cisco and any other company. (1721R)

© 2021 Cisco Systems, Inc. All rights reserved.

https://www.cisco.com/c/en/us/about/legal/trademarks.html


C O N T E N T S

Preface xxviiP R E F A C E

Purpose xxvii

Audience xxvii

Organization xxvii

Related Documentation xxix

Conventions xxx

Documentation and Service Requests xxxi

Cisco Product Security Overview xxxi

New and Changed Information 1C H A P T E R 1

New and Changed Information 1

Overview 3P A R T I

Cisco Unified Communications Manager Bulk Administration Tool (BAT) 5C H A P T E R 2

About Cisco Unified Communications Manager Bulk Administration Tool 5

BAT Installation 6

BAT Data Input Files 7

Perform BAT Configuration Multistep Process 7

About the BAT Menu 7

BAT Configuration Templates 8

Standard Phone Templates 9

CSV Data File Overrides Template Values 9

Example Template Override 9

CSV Data File Adds New Devices 9

CSV Data File Updates Existing Devices 10

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
iii



CSV Data File and Custom File Formats 11

BAT Spreadsheet Data Collection for CSV Data File Creation 12

Validate BAT Data Input File 14

Insert BAT Data Input File Records Into Database 15

BAT Application Web Browser Considerations 15

Access BAT Online Help 16

Verify Cisco Unified Communications Manager Version 16

File Upload and Download 17P A R T I I

Upload and Download Files 19C H A P T E R 3

Find Downloadable File on Server 19

Download File Off Server 20

Upload File to Server 21

Delete File From Server 21

Phones 23P A R T I I I

Phone Template 25C H A P T E R 4

Add Phones to Database 25

BAT Phone Templates 26

Find BAT Phone Template 26

Create New BAT Phone Template 27

Add or Update Phone Lines in BAT Template 28

Add or Update IP Services in BAT Template 29

Add or Update Speed Dials in BAT Template 29

Add or Update Busy Lamp Field in BAT Template 30

Add or Update Busy Lamp Field Directed Call Park in BAT Template 31

Add or Update Intercom Template in BAT Template 31

Modify BAT Phone Templates 32

Copy BAT Phone Template 33

Delete BAT Phone Template 34

BAT Phone Template Field Descriptions 34

BAT Template Phone Line Field Descriptions 65

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
iv

Contents



BAT Template Field Descriptions to Add Intercom Template 81

Create Phone CSV Data File Using BAT Spreadsheet 84

Phone Field Descriptions in BAT Spreadsheet 86

Update Jabber Device 110

Rename Jabber Devices 110

Phone File Formats 111C H A P T E R 5

Text Editors for Phone CSV Data File Creation 111

Find Phone File Formats 111

Configure Phone File Format for CSV Data File 112

Create Custom Phone File Format Using Text Editor 112

Copy Custom Phone File Format for CSV Data File 113

Modify Custom File Format for CSV Data File 114

Delete Existing CSV Data File Format 115

Associate Text-Based File Format with CSV Data File 115

Phone Record Validation 117C H A P T E R 6

Validate CSV Data File Phone Records 117

Phone Validation Limitations 118

Topics Related to Phone Record Validation 118

Phone Insertions 119C H A P T E R 7

Insert Phones Into Unified Communications Manager 119

Topics Related to Inserting Phones 121

Phone Updates 123C H A P T E R 8

Update Phones Using Query 123

Update Phones Using Custom File 124

Choose Update Parameters 126

Phone Update Field Descriptions 126

Phone Deletions 141C H A P T E R 9

Delete Phones Using Query 141

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
v

Contents



Delete Phones Using Custom File 143

Delete Unassigned Directory Numbers 144

Phone Exports 147C H A P T E R 1 0

Phone Record Exports 147

Exported Phone Record Fields 148

Export Phone Records 149

Multiple User Phones to Export or Import 151

Topics Related to Phone Exports 151

Phone Line Addition and Updates 153C H A P T E R 1 1

Update Phone Lines Using Query 153

Phone Line Update Field Descriptions 155

Add Phone Lines to Existing Phones and UDPs 161

Add Phone Lines to Existing Phones Using BAT Spreadsheet 162

Phone Line Field Descriptions for Line Additions Using BAT Spreadsheet 163

Phone Resets and Restarts 169C H A P T E R 1 2

Reset or Restart Phone Using Query 169

Reset or Restart Phone Using Custom File 170

Wipe or Lock Phones Using Query 172

Wipe or Lock Phones Using Custom File 173

Phone Reports 175C H A P T E R 1 3

Phone Report Generation 175

Generate Phone Reports 175

Phone and IP Telephony Device Reports 177

Generate List of Phones Having Dummy MAC Addresses 180

Phone Migrations 183C H A P T E R 1 4

Migrate Phone From SCCP to SIP 183

Topics Related to Phone Migration 185

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
vi

Contents



Intercom Additions and Updates 187C H A P T E R 1 5

Update Intercom DNs 187

Add Intercom DNs 188

Intercom DN Update Field Descriptions 189

Users 191P A R T I V

User Additions 193C H A P T E R 1 6

New User Group Additions and User Associations 193

Add Users 193

Create User CSV Data File From BAT Spreadsheet 194

BAT Spreadsheet User Data Field Descriptions 195

Topics Related to User Additions 198

User Templates 199C H A P T E R 1 7

Find BAT User Template 199

Create New BAT User Template 200

Modify BAT User Template 200

Copy BAT User Template 201

Delete BAT User Template 201

BAT User Template Field Descriptions 202

User Insertions 207C H A P T E R 1 8

Insert Users in Unified Communications Manager Database 207

Topics Related to User Insertions 208

User Updates 209C H A P T E R 1 9

Update User Information Using CSV Data File 209

Retain Existing User Information During Update 210

Create User Update CSV Data File Using BAT Spreadsheet 210

BAT Spreadsheet Update User Data Field Descriptions 212

Update User Information in Cisco Unified Communications Manager Directory 214

User Update Settings 215

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
vii

Contents



Update Users Using Query 218

Select Update Parameters for User Query 220

Topics Related to User Updates 220

User Deletions 221C H A P T E R 2 0

Delete Users Using Query 221

Delete Users Using Custom File 222

User Record Exports 225C H A P T E R 2 1

Export User Records 225

Topics Related to User Record Exports 227

Password and PIN Resets 229C H A P T E R 2 2

Reset Passwords And PINs 229

Reset User Password and PIN Using Query 229

Reset User Password and PIN Using Custom File 231

User Report Generation 233C H A P T E R 2 3

Generate User Reports 233

Line Appearance 235C H A P T E R 2 4

View Line Appearances 235

Export Line Appearances 236

Update Line Appearances 237

End User CAPF Profiles 239C H A P T E R 2 5

Insert End User CAPF Profile 239

Delete End User CAPF Profile 240

Export End User CAPF Profile 241

BAT Spreadsheet End User CAPF Profile Field Descriptions 242

Phones and Users 245P A R T V

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
viii

Contents



Phones with Users 247C H A P T E R 2 6

Add New Phones with Users 247

Add Phones with Users Using the BAT Spreadsheet 248

Topics Related to Phones with Users 248

Phones and Users File Formats 249C H A P T E R 2 7

Add Phone and User File Format 249

Topics Related to Phone and User File Formats 250

Phone and User Validations 251C H A P T E R 2 8

Validate Phones and User Records 251

Topics Related to Phone and User Validation 252

Phone and User Insertions 253C H A P T E R 2 9

Insert Phones with Users Into Unified Communications Manager 253

Topics Related to Phone and User Insertion 254

Managers and Assistants 255P A R T V I

Cisco Unified Communications Manager Assistant 257C H A P T E R 3 0

Phones and Lines for Cisco Unified Communications Manager Assistant 257

Set Up Phones in Proxy Line Mode for Cisco Unified Communications Manager Assistant 258

Cisco Unified Communications Manager Assistant Manager Phone Template Default Settings 259

Manager and Assistant Proxy Line Configurations 259

Set Up Proxy Lines on New Manager and Assistant Phones for Cisco Unified Communications
Manager Assistant 262

Set Up Proxy Lines on ExistingManager and Assistant Phones for Cisco Unified Communications
Manager Assistant 263

Set Up Phones in Shared Line Mode for Cisco Unified Communications Manager Assistant 264

Manager Phone Settings for Shared Line Mode 265

Assistant Phone Settings for Shared Line Mode 265

Manager and Assistant Shared Line Configurations 265

CSV Data File for Manager-Assistant Associations 266

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
ix

Contents



Add or Update Manager-Assistant Associations Using BAT Spreadsheet 267

Manager-assistant Association Additions and Updates Using BAT Spreadsheet 267

Create Default Manager-Assistant CSV Data Files 267

Create Custom Manager-Assistant CSV Data Files 269

Topics Related to CVS Data Files for Manager-Assistant 270

Manager and Assistant Insertions 271C H A P T E R 3 1

Insert Manager-Assistant Associations to Cisco Unified Communications Manager 271

Topics Related to Manager and Assistant Insertion 273

Manager and Assistant Deletions 275C H A P T E R 3 2

Delete Specific Manager-Assistant Associations From Cisco Unified Communications Manager 275

Manager Deletions 277C H A P T E R 3 3

Manager Deletions From Cisco Unified Communications Manager 277

Delete Manager Associations Using Query 277

Delete Manager Associations Using Custom File 279

Topics Related to Manager Deletions 280

Assistant Deletions 281C H A P T E R 3 4

Assistant Deletions From Cisco Unified Communications Manager 281

Delete Assistants Associations Using Query 281

Delete Assistant Associations Using Custom File 282

Manager and Assistant Report Generation 285C H A P T E R 3 5

Generate Reports for Cisco Unified Communications Manager Assistant Managers and Assistants 285

Report Log Files 287

Topics Related to Manager Assistant Report Generation 287

User Device Profiles 289P A R T V I I

Manage User Device Profiles 291C H A P T E R 3 6

Add User Device Profiles 291

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
x

Contents



Create User Device Profile CSV Data Files Using BAT Spreadsheet 292

User Device Profile Fields Descriptions in BAT Spreadsheet 293

Topics Related to User Device Profiles 304

User Device Profile Templates 305C H A P T E R 3 7

Find User Device Profile Template 305

Create Bulk Administration Tool (BAT) Template for User Device Profiles 306

User Device Profile Template Fields Descriptions in BAT Spreadsheet 307

Modify User Device Profile BAT Template 310

Copy User Device Profile Template 310

Delete User Device Profile Template 311

User Device Profile File Format 313C H A P T E R 3 8

User Device Profile File Format Setup 313

Find UDP File Format 313

Create UDP File Format 314

Copy UDP File Format 315

Modify UDP File Format 315

Delete UDP File Format 316

User Device Profile File Format Addition 317C H A P T E R 3 9

Add User Device Profile File Format 317

Topics Related to UDP File Format Creation 317

User Device Profile Validation 319C H A P T E R 4 0

Validate User Device Profiles 319

User Device Profile Validation Limitations 320

Topics Related to User Device Profile Validation 320

UDP Generation 321C H A P T E R 4 1

Insert User Device Profiles for User Devices 321

Topics Related to User Device Profile Generation 323

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
xi

Contents



User Device Profile Updates 325C H A P T E R 4 2

Update UDPs Using Query 325

Update UDPs Using Custom File 326

Choose Update Parameters 327

Update UDP Field Descriptions 328

User Device Profile Deletions 333C H A P T E R 4 3

Delete UDP Using Query 333

Delete UDP Using Custom File 334

Topics Related to UDP Deletions 335

User Device Profile Exports 337C H A P T E R 4 4

All User Device Profile Details Format 337

Specific User Device Profile Format 338

Export User Device Profile Records 339

Line Attribute Updates for Devices and User Device Profiles 341C H A P T E R 4 5

Device and UDP Line Updates 341

Update Device and UDP Lines Using Query 341

Topics Related to User Device Profile Line Updates 343

UDP Line Additions 345C H A P T E R 4 6

Add Lines to Existing UDPs 345

Add Lines to Existing UDPs Using BAT Spreadsheet 346

UDP Line Field Descriptions in BAT Spreadsheet 347

Topics Related to UDP Line Additions 350

UDP Report Generation 351C H A P T E R 4 7

BAT Report Generation 351

Generate User Device Profile Reports 351

Topics Related to UDP Report Generation 353

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
xii

Contents



Intercom DN Additions and Updates for UDPs 355C H A P T E R 4 8

Update Intercom DNs for User Device Profiles 355

Add Intercom DNs to User Device Profiles 356

Update Intercom DN Field Descriptions for UDPs 357

Gateways 359P A R T V I I I

Gateway Templates 361C H A P T E R 4 9

Cisco Gateway Additions 361

Add Cisco VG200 Gateways Using BAT 361

Add Cisco Catalyst 6000 (FXS) Gateways and Ports Using BAT 362

Add Cisco VG224 Gateways Using BAT 363

Add Cisco VG202 and Cisco VG204 Gateway Using BAT 363

Add Cisco VG310 Gateway Template 364

Add Cisco VG320 Gateway Template 364

Add Cisco VG350 Gateway Template 365

Add Cisco VG420 Gateway Using BAT 365

Add Cisco VG450 Gateway Using BAT 366

Add Cisco ISR 4461 Gateway Using BAT 366

Find Gateway Template 367

Add or Edit Gateway Template 368

Create Cisco VG200 Gateway Template 369

Cisco VG200 Gateway Template Port Additions 370

Add FXS Ports to VG200 Gateway Template 371

Add FXO Ports to VG200 Gateway Template 371

Add Digital Access T1 (T1-CAS) Ports to VG200 Gateway Template 372

Add T1 PRI or E1 PRI Device to VG200 Gateway Template 373

Create Cisco Catalyst 6000 (FXS) Gateway Template 373

Create Cisco VG224 Gateway Template 374

Add FXS Ports to VG224 Gateway Template 375

Create Cisco VG202 or VG204 Gateway Template 376

Add FXS Ports to VG202 or VG204 Gateway Template 377

Create Cisco VG310 Gateway Template 378

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
xiii

Contents



Create Cisco VG320 Gateway Template 378

Create Cisco VG350 Gateway Template 379

Create Cisco VG420 Gateway Template 379

Create Cisco VG450 Gateway Template 380

Create Cisco ISR 4461 Gateway Template 380

Gateway Configuration Settings 381

VG200 Gateway Template Field Descriptions 381

VG224 Gateway Template Field Descriptions 382

VG202 and VG204 Gateway Template Field Descriptions 383

VG310 Gateway Template Field Description 383

VG320 Gateway Template Field Description 384

VG350 Gateway Template Field Description 385

VG420 Gateway Template Field Descriptions 386

VG450 Gateway Template Field Description 387

ISR 4461 Gateway Template Field Descriptions 388

Cisco Catalyst 6000 24 Port FXS Gateway Template Field Descriptions 389

FXS/FXO Port Configuration Field Descriptions 393

Digital Access T1 Trunks on Cisco VG200 Gateway Template Field Descriptions 399

T1 PRI or E1 PRI Trunks on Cisco VG200 Gateway Template Field Descriptions 402

Port Configuration Settings 413

POTS Port Configuration Settings 413

E and M Ports for Digital Access T1 Field Descriptions 415

Topics Related to Gateway Configuration Settings 417

Gateway File Format 419C H A P T E R 5 0

Find Gateway File Format 419

Gateway File Format Configuration 420

Create Gateway File Format for CSV Data File 420

Copy Existing Gateway File Format 421

Modify Existing Gateway File Format 421

Delete File Format From CSV Data File 422

Associate File Format with CSV Data File 422

Gateway Insertions 425C H A P T E R 5 1

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
xiv

Contents



CSV Data File Creation for Cisco VG200 Gateways 425

Create CSV Data Files for Cisco VG200 Gateways and T1 CAS, T1 PRI, E1 PRI, FXS or FXO Ports
Using BAT Spreadsheet 425

Create CSV Data File for Cisco Catalyst 6000 (FXS) Ports 427

CSV Data Files Creation for Cisco VG224 Gateways and Ports 428

Create CSV Data Files for Cisco VG224 FXS Gateways and Ports Using BAT Spreadsheet 428

CSV Data File Creation for Cisco VG202 and VG204 Gateways 430

Create CSV Data Files for Cisco VG202 and VG204 FXS Gateways and Ports Using BAT
Spreadsheet 431

CSV Data Files Creation for Cisco VG310 Gateways and Ports 432

Create CSV Data Files for Cisco VG310 FXS Gateways and Ports Using BAT Spreadsheet 433

CSV Data Files Creation for Cisco VG320 Gateways and Ports 434

Create CSV Data Files for Cisco VG320 FXS Gateways and Ports Using BAT Spreadsheet 435

CSV Data Files Creation for Cisco VG350 Gateways and Ports 436

Create CSV Data Files for Cisco VG350 FXS Gateways and Ports Using BAT Spreadsheet 437

CSV Data File Creation for Cisco VG420 Gateways 438

Create CSV Data Files for Cisco VG420 Gateways Using BAT Spreadsheet 439

CSV Data Files Creation for Cisco VG450 Gateways and Ports 440

Create CSV Data Files for Cisco VG450 FXS Gateways and Ports Using BAT Spreadsheet 441

CSV Data File Creation for Cisco ISR 4461 Gateways 442

Create CSV Data Files for Cisco ISR 4461 Gateways Using BAT Spreadsheet 443

Insert Gateways and Ports to Cisco Unified Communications Manager 444

Cisco Gateway Deletions 447C H A P T E R 5 2

Delete Cisco Gateway Records Using Query 447

Topics Related to Cisco Gateway Deletions 448

Cisco Gateway Report Generation 451C H A P T E R 5 3

Generate Cisco Gateway Reports 451

Topics Related to Cisco Gateway Reports 453

Forced Authorization Codes and Client Matter Codes 455P A R T I X

Client Matter Codes and Forced Authorization Codes 457C H A P T E R 5 4

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
xv

Contents



CMC and FAC Setup Using BAT 457

Implement CMC and FAC Features 458

Create CMC and FAC CSV Data File Using BAT.xlt 459

CSV Data File Creation for Client Matter Codes and Forced Authorization Codes Using Text Editor 460

Edit Existing CMC or FAC CSV Data File 460

CMC and FAC CSV Data File Settings 461

Update CMC or FAC in CUCM Database Using BAT 462

BAT Settings to Update CMC and FAC in the Database 463

Topics Related to CMC and FAC Configuration 463

Forced Authorization Codes and Client Matter Code Deletions 465C H A P T E R 5 5

Code Setting Deletion Examples 465

Delete Forced Authorization Codes and Client Matter Codes 467

Topics Related to Forced Authorization Codes and Client Matter Codes 468

Call Pickup Groups 469P A R T X

Manage Call Pickup Groups 471C H A P T E R 5 6

Call Pickup Group Setup Using BAT 471

Create Call Pickup Group CSV Data File Using BAT.xlt 472

CSV Data File Creation for Call Pickup Groups Using Text Editor 473

Edit Existing Call Pickup Group CSV Data File 473

Call Pickup Group CSV File Settings 474

Update Call Pickup Groups in CUCM Database Using BAT 475

BAT Settings to Update Pickup Groups in the Database 475

Topics Related to Call Pickup Groups 476

Call Pickup Group Deletions 477C H A P T E R 5 7

Delete Call Pickup Groups 477

Mobility 479P A R T X I

Access List 481C H A P T E R 5 8

Insert Access Lists 481

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
xvi

Contents



Delete Access Lists 482

Export Access Lists 482

Remote Destination 485C H A P T E R 5 9

Insert Remote Destination 485

Delete Remote Destination 486

Export Remote Destination 487

Remote Destination Profiles 489C H A P T E R 6 0

Remote Destination Profile Templates 489

Find Remote Destination Profile Template 489

Create Remote Destination Profile Template 490

Add or Update Lines in Remote Destination Profile Template 491

Delete Remote Destination Profile Template 491

Remote Destination Profile Template Field Descriptions 492

Remote Destination Profile File Format 494

CSV Data File Creation for Remote Destination Using Text Editor 494

Find Remote Destination File Format 494

Remote Destination Profile File Format Configuration 495

Create Remote Destination Profile File Format 495

Copy Remote Destination Profile File Format 496

Modify Remote Destination Profile File Format 496

Delete Remote Destination Profile File Format 497

Associate Remote Destination File Format with CSV Data File 497

Remote Destination Profile Insertions 498

Insert Remote Destination Profiles in Cisco Unified Communications Manager 498

Remote Destination Profile Deletions 499

Delete Remote Destination Profiles Using Custom File 499

Remote Destination Profile Exports Using Export Utility 500

Export Remote Destination Profile Using Export Utility 500

Default Remote Destination Profile File Format 502

Mobility Profile 503C H A P T E R 6 1

Insert Mobility Profile 503

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
xvii

Contents



Delete Mobility Profile 504

Export Mobility Profile 504

Region Matrix 507P A R T X I I

Region Matrix Updates 509C H A P T E R 6 2

Populate and Depopulate Region Matrix 509

Import/Export 511P A R T X I I I

Import/Export Menu 513C H A P T E R 6 3

Export Configuration Data 513

Export Configuration Data Options 514

Log Files 522

Edit .tar File 522

Topics Related to the Import/Export Menu 523

Import Configuration Data 525C H A P T E R 6 4

Import Configuration to Server 525

Cyclic Dependency 527

Items Not Supported on Import or Export 528

Override Only 528

Upgrade From Cisco Unified CallManager 4.x Releases 529

Topics Related to Import/Export Menu 529

Import File Validation 531C H A P T E R 6 5

Import File Validation Items 531

Validate Import File 531

Topics Related to Import File Validation 532

Phone Migration 533P A R T X I V

Manage Phone Migration 535C H A P T E R 6 6

Phone Migration Considerations 535

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
xviii

Contents



Create CSV Data Files for Phone Migration Using BAT Spreadsheet 535

Migrate Phones 536

Extension Mobility Cross Cluster (EMCC) 539P A R T X V

Extension Mobility Cross Cluster Template 541C H A P T E R 6 7

EMCC Templates 541

Find EMCC Template 541

Create New EMCC Template 542

Delete EMCC Template 543

BAT EMCC Template Field Descriptions 543

Topics Related to EMCC Templates 544

Insert, Update, and Delete EMCC Devices 545C H A P T E R 6 8

Insert EMCC Devices 545

Update EMCC Devices 546

Delete EMCC Devices 547

Intercompany Media Engine (IME) 549P A R T X V I

Trust Element 551C H A P T E R 6 9

Insert Trust Element Configuration 551

Delete IME Trust Element Configuration 552

Topics Related to IME 552

Trust Group 555C H A P T E R 7 0

Insert IME Trust Group Configuration 555

Deleting IME Trust Group Configuration 556

Topics Related to IME Trust Group Configuration 556

Enrolled Group 559C H A P T E R 7 1

Insert IME Enrolled Group Configuration 559

Delete IME Enrolled Group Configuration 560

Topics Related to IME Enrolled Group Configuration 560

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
xix

Contents



Exclusion Group 563C H A P T E R 7 2

Insert IME Exclusion Group Configuration 563

Delete IME Exclusion Group Configuration 564

Topics Related to IME Exclusion Group Configuration 564

Fallback Profile 567C H A P T E R 7 3

Insert Fallback Profile Configuration 567

Delete Fallback Profile Configuration 568

Topics Related to Fallback Profile Configuration 568

Configure Confidential Access Level 571P A R T X V I I

Confidential Access Level Setup 573C H A P T E R 7 4

About Confidential Access Level Setup 573

CAL Enforcement Level 574

CAL Limitations 575

Set Up Confidential Access Level 576

CUPS 577P A R T X V I I I

License Updates and Exports Using CUP Menu 579C H A P T E R 7 5

Update and Export CUP and CUPC User Licenses 579

Add or Update CUPS and CUPC User Licenses 579

Export All CUPS/CUPC User License Information 580

Tool for Auto-Registered Phones Support 581P A R T X I X

Manage Tool for Auto-Registered Phones Support (TAPS) 583C H A P T E R 7 6

TAPS Overview 583

TAPS Auto-registration Options 584

TAPS with New Phone Examples 584

Reloading Configurations Using TAPS 585

Secured Directory Numbers 585

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
xx

Contents



Language Prompts for TAPS Users 586

Install TAPS 586

TAPS Application Configuration in UCCX Applications Server 587

Activate TAPS Service 588

Start Stop and Restart TAPS 588

TAPS Option Settings 589

Configure TAPS Auto-Registration 589

TAPS Secure Directory Number Option 590

Find Secure Directory Numbers 590

Restrict Directory Numbers 591

Remove Directory Number Restriction 591

View TAPS Log Files 592

Related Topics 592

Tool for Auto-Registered Phone Support (TAPs) User Locales 593C H A P T E R 7 7

User Locales for Tool for Auto-Registered Phone Support 593

Add Languages to Tool for Auto-Registered Phone Support Prompts 594

Remove Languages From Tool for Auto-Registered Phone Support Prompts 594

Select Language of TAPs Prompts on New Phone 595

Topics Related to Tool for Auto-Registered Phone Support User Locales 596

Scheduling Jobs 597P A R T X X

Manage Scheduled Jobs 599C H A P T E R 7 8

Activate Bulk Provisioning Service 599

Start, Stop and Restart BPS 600

Deactivate BPS and Log Out 600

Find Jobs Submitted to BPS 601

Schedule Submitted Jobs 602

Troubleshooting BAT and TAPS 605P A R T X X I

Manage Troubleshooting BAT and TAPS 607C H A P T E R 7 9

Enable Trace to View Configuration Files 607

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
xxi

Contents



Disable Trace of Configuration Files 608

BAT Log Files 609

Troubleshooting BAT 609

Bulk Administration Menu Does Not Display in Administration 609

Cannot Access Complete Bulk Administration Functionality 610

Export to BAT Format Button Does Not Work in BAT.xlt File 610

BAT Excel Spreadsheet Gives a Compilation Error While Exporting Data to the CSV Format 610

BAT Excel Spreadsheet Does Not Respond to Actions 610

Data Files (CSV) Format Do Not Match Phone Template/Sample File 610

Uploaded CSV File Does Not Display in the File Name Drop-down List Box 611

Jobs Remain in Pending State Even After the Scheduled Time Expires 611

Jobs Remain in Hold State 611

Job Does Not Display in the Find and List Jobs Window 611

Port Number Not Configured in the Template 612

MAC Address Values Are Not Allowed in the File If Dummy MAC Address Values Are Desired 612

The BAT.xlt Spreadsheet Does Not Work with Microsoft Excel XP (Office XP) 612

After the Request to Migrate an SCCP Phone to SIP Through the Migrate Phones - SCCP TO SIP
Window Is Submitted, Model 7940 and 7960 Continue to Show Up as SCCP Phones 612

Record Does Not Match the File Format Selected 613

BAT.xlt Is Working in Compatibility Mode with Microsoft Excel 2007 613

Troubleshooting BAT Performance 613

Troubleshooting BAT and TAPS 614

Viewing Tool for Auto-Registered Phones Support Log Files 614

Tool for Auto-Registered Phones Support Error Messages 614

When Dialing the TAPS Route Point Number, the Caller Receives a Busy Tone 614

When the CiscoUCCX Server Starts, the JTAPI Subsystem Shows Partial Service or Out of
Service 614

Topics Related to Troubleshooting BAT and TAPS 615

Infrastructure Devices 617P A R T X X I I

Manage Infrastructure Devices 619C H A P T E R 8 0

Infrastructure Device Setup Using BAT 619

Create Infrastructure Device CSV Data File using BAT.xlt 619

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
xxii

Contents



CSV Data File Creation for Infrastructure Devices Using Text Editor 620

Insert Infrastructure Devices 621

Infrastructure Device Insert Examples 622

Manage Directory URIs and Patterns 623P A R T X X I I I

Manage Directory URIs and Patterns 625C H A P T E R 8 1

Export Local Directory URIs and +E.164 Patterns 625

Import Directory URIs and Patterns From a Non-ILS System 626

Directory URI Format 627

Text-Based CSV Files 629A P P E N D I X A

Create Text-Based CSV File for Phones 630

Phone CSV Data File Formats 631

Phones with Users Combinations File Format 631

CTI Ports/H.323 Clients File Format 632

CTI Ports-Users and H.323 Client-Users Combinations File Format 632

Export the Fields for All Phone Details Option 633

Phone CSV File Examples 634

Create Text-Based CSV User File 635

User File Format 636

Update Users File Format 637

Create Text-Based CSV File for User Device Profile 638

User Device Profile File Format 638

User Device Profile with Two Lines and Two Speed Dials 639

Export File Fields for User Device Profile with All Details Option 640

Create Text-Based CSV File for Cisco Unified CM Assistant Manager-Assistant Associations 641

Managers and Assistants File Formats 642

Default Manager-Assistant Association 642

Default Assistant-Manager Association 642

Custom Manager-Assistant Association 642

Create Text-Based CSV File for Cisco VG200 Gateways 642

FXO or FXS Trunks CSV File Format 643

T1 CAS T1 PRI or E1 PRI Trunks File Format 644

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
xxiii

Contents



Create Text-Based CSV File for Cisco VG224 Gateways 645

FXS Trunks CSV File Format for VG224 645

Create Text-Based CSV File for Cisco VG310 Gateways 646

FXS Trunks CSV File Format for VG310 647

Create Text-Based CSV File for VG320 Gateways 647

FXS Trunks CSV File Format for VG320 648

Create Text-Based CSV File for VG350 Gateways 649

FXS Trunks CSV File Format for VG350 649

Create Text-Based CSV File for VG420 Gateways 650

Create Text-Based CSV File for VG450 Gateways 650

FXS Trunks CSV File Format for VG450 651

Create Text-Based CSV File for ISR 4461 Gateways 652

Create Text-Based CSV File for Cisco Catalyst 6000 FXS Ports 652

Cisco Catalyst 6000 (FXS) Torts File Format 653

Create Text-Based CSV File for Cisco VG202 and VG204 Gateways 654

CSV File Format for VG202 and VG204 Gateways 655

Create Custom Text-Based CSV Files for Client Matter Codes and Forced Authorized Codes 655

CMC File Format 657

Update CMC File Format 657

FAC File Format 657

Update FAC File Format 658

Create Text-Based CSV File for Call Pickup Groups 658

CPG File Format 659

Update CPG File Format 659

Create Text-Based CSV File for Remote Destination Profile 660

Creating Text-Based CSV File for Phone Migration 661

Phone Migration File Format 661

Create Text-Based CSV File for IME Trusted Element Configuration 662

IME Trusted Element Configuration File Format 662

Create Text-Based CSV File for IME Trusted Group Configuration 663

IME Trusted Element Configuration File Format 663

Create Text-Based CSV File for IME Enrolled Group Configuration 664

IME Enrolled Group Configuration File Format 664

Create Text-Based CSV File for IME Exclusion Group Configuration 665

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
xxiv

Contents



IME Exclusion Group Configuration File Format 665

Create Text-Based CSV File for Fallback Profile Configuration 666

Fallback Profile Configuration File Format 666

Create Text-Based CSV File for End User CAPF Profile 667

End User CAPF Profile File Format 667

Create Text-Based CSV File for Mobility Profile 668

Mobility Profile File Format 668

Create Text based CSV file for Infrastructure Devices 669

Related Topics 669

BAT Performance 671A P P E N D I X B

BAT Performance 671

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
xxv

Contents



Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
xxvi

Contents



Preface

This preface describes the purpose, audience, organization, and conventions of this guide, and provides
information on how to obtain related documentation.

This document may not represent the latest Cisco product information available. You can obtain the most
current documentation by accessing Cisco's product documentation page at this URL: http://www.cisco.com/
en/US/products/sw/voicesw/ps556/tsd_products_support_series_home.html

Note

• Purpose, on page xxvii
• Audience, on page xxvii
• Organization, on page xxvii
• Related Documentation, on page xxix
• Conventions, on page xxx
• Documentation and Service Requests, on page xxxi
• Cisco Product Security Overview, on page xxxi

Purpose
The CiscoUnified Communications Manager Bulk Administration Guide provides instructions for using the
Bulk Administration menu of Cisco Unified Communications Manager Administration.

Audience
This document provides information for network administrators and engineers who are responsible for managing
the CiscoUnified CommunicationsManager system. Administering CiscoUnified CommunicationsManager
Bulk Administration (BAT) requires knowledge of telephony and IP networking technology.

Organization
Table1 provides the organization of this guide.

Layout of BAT Tool User Guide
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DescriptionChapter

Unified Communications Manager Bulk Administration OverviewOverview, on page 3

Provides an overview of BAT.

Upload/Download FilesFile Upload and Download, on
page 17 Describes how to upload and download files.

PhonesPhones, on page 23

Describes how to add phones, phones and users, computer telephony
integration (CTI) ports, and CTI ports and users in batches rather than
adding each device or combination individually. Also describes how to
add or update lines, phone services, and speed dials and how to update
and delete phones.

UsersUsers, on page 191

Describes how to add, update, and delete batches of users.

Phones and UsersPhones and Users, on page 245

Describes how to add a group of users and their phones on a Unified
Communications Manager server in one bulk transaction.

Managers and AssistantsManagers and Assistants, on page
255 Describes how to add, update, or deleteManager Assistant Associations.

User Device ProfilesUser Device Profiles, on page 289

Describes how to add, update, or delete User Device Profiles.

GatewaysGateways, on page 359

Describes how to add, update, or delete Cisco VG200 gateways and
ports, and how to add or delete Foreign Exchange Station (FXS) ports
for Cisco Catalyst 6000 analog interface modules. Also describes how
to create a gateway directory number template for use with FXS ports.

Forced Authorization Codes and Client Matter CodesForced Authorization Codes and
Client Matter Codes, on page 455 Describes how to add, update, or delete Client Matter Codes and Forced

Authorization Codes.

Pickup GroupsCall Pickup Groups, on page 469

Describes how to add, update, or delete call pickup groups.

MobilityMobility, on page 479

Describes how to insert, delete, and export access lists, remote
destinations and remote destination profiles.

Region MatrixRegion Matrix, on page 507

Describes how to populate and depopulate the region matrix.
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Import/ExportImport/Export, on page 511

Describes how to import or export Unified Communications Manager
database to another server, or to the same server with modifications.

Phone MigrationPhone Migration, on page 533

Describes the Phone Migration menu in BAT and details the procedure
to migrate phones in bulk.

Extension Mobility Cross Cluster (EMCC)Extension Mobility Cross Cluster
(EMCC), on page 539 Describes the EMCCmenu in BAT and details how to insert, delete, and

update EMCC.

Intercompany Media ServicesIntercompany Media Engine
(IME), on page 549 Describes the Intercompany Media Services menu in BAT and details

how to insert and delete Trusted Element, Trusted Group, EnrolledGroup,
Exclusion Group, and Fallback Profile configuration.

CUPSCUPS, on page 577

Describes the CUPSmenu in BAT and details its use to update and export
the CUPS and CUPC users.

Tool for Auto-Registered Phones Support (TAPS).Tool for Auto-Registered Phones
Support, on page 581 Describes how to install, configure, and use TAPS.

Scheduling JobsScheduling Jobs, on page 597

Describes how to schedule and activate jobs.

Troubleshooting BAT and UnifiedCM Auto-Register Phone ToolTroubleshooting BAT and TAPS,
on page 605 Describes some common scenarios for bulk transaction log files and

provides an explanation and resolution for various error messages that
you may encounter while working with BAT or UnifiedCM
Auto-Register Phone Tool.

AppendixesAppendixes

Describes how to create text-based files for the devices and users for
bulk transactions. Also provides example of file formats for different
scenarios.

Related Documentation
Refer to the following documents for further information about related CiscoIPtelephony applications and
products:

• Cisco Unified Communications Manager Online Help

• Cisco Unified Communications Manager System Configuration Guide

• Release Notes for Cisco Unified Communications Manager
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• Installing Cisco Unified Communications Manager

• Cisco Unified Serviceability Administration Guide

• Cisco Unified Communications Manager Security Guide

• Hardware Configuration Guide for the Cisco VG200

• Software Configuration Guide for the Cisco VG200

• Cisco VG248 Analog Phone Gateway Software Configuration Guide

• CiscoUnifiedIPPhone Administration Guide for Cisco Unified Communications Manager

• Feature Configuration Guide for Cisco Unified Communications Manager

• Troubleshooting Guide for Cisco Unified Communications Manager

• Cisco Unified Communications Manager Assistant User Guide

Conventions
This document uses the following conventions:

DescriptionConvention

Commands and keywords are in boldface.boldface font

Arguments for which you supply values are in italics.italic font

A nonquoted set of characters. Do not use quotation marks
around the string or the string will include the quotation
marks.

string

Terminal sessions and information the system displays are
in screen font.

screen font

Information you must enter is in boldface screen font.boldface screen font

Notes use the following conventions:

Means reader take note. Notes contain helpful suggestions or references to material not covered in the
publication.

Note

Timesavers use the following conventions:

Means the described action saves time. You can save time by performing the action described in the paragraph.Timesaver

Tips use the following conventions:

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
xxx

Preface
Conventions



Means the information contains useful tips.Tip

Cautions use the following conventions:

Means reader be careful. In this situation, you might do something that could result in equipment damage or
loss of data.

Caution

Warnings use the following conventions:

This warning symbol means danger. You are in a situation that could cause bodily injury. Before you work
on any equipment, you must be aware of the hazards involved with electrical circuitry and familiar with
standard practices for preventing accidents.

Warning

Documentation and Service Requests
For information on obtaining documentation, submitting a service request, and gathering additional information,
see themonthlyWhat'sNew in CiscoProduct Documentation, which also lists all new and revised Ciscotechnical
documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication(RSS) feed and
set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free service
and Cisco currently supports RSSVersion2.0.

Cisco Product Security Overview
This product contains cryptographic features and is subject to United States and local country laws governing
import, export, transfer and use. Delivery of Cisco cryptographic products does not imply third-party authority
to import, export, distribute or use encryption. Importers, exporters, distributors and users are responsible for
compliance with U.S. and local country laws. By using this product you agree to comply with applicable laws
and regulations. If you are unable to comply with U.S. and local laws, return this product immediately.

Further information regarding U.S. export regulations may be found at
http://www.access.gpo.gov/bis/ear/ear_data.html
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C H A P T E R 1
New and Changed Information

• New and Changed Information, on page 1

New and Changed Information
The following table provides an overview of the significant changes to the features in this guide up to this
current release. The table does not provide an exhaustive list of all changes made to the guide or of the new
features up to this release.

Table 1: New Features and Changed Behavior in Unified Communications Manager and IM and Presence Service

DateSeeDescriptionFeature or Change

March 31, 2021——Initial Release of
Document for Release 14

October 27, 2021——Initial Release of
Document for Release
14SU1

October 27, 2021Add Cisco VG420
Gateway Using BAT, on
page 365

Introduced support for the
Cisco VG420 Gateway

Cisco VG420 Gateway
Using BAT

May 18, 2023——Initial Release of
Document for Release
14SU3

May 18, 2023Rename Jabber Devices,
on page 110

You can now auto
provision the Webex App
or Cisco Jabber devices
when new LDAP users
are synchronized from
Microsoft Active
Directory.

Auto Provision of Webex
App and Cisco Jabber
Devices
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P A R T I
Overview

• Cisco Unified Communications Manager Bulk Administration Tool (BAT), on page 5





C H A P T E R 2
Cisco Unified Communications Manager Bulk
Administration Tool (BAT)

This chapter provides information about the Cisco Unified Communications Manager Bulk Administration
Tool (BAT).

• About Cisco Unified Communications Manager Bulk Administration Tool, on page 5
• BAT Installation, on page 6
• BAT Data Input Files, on page 7
• Perform BAT Configuration Multistep Process, on page 7
• BAT Application Web Browser Considerations, on page 15
• Access BAT Online Help, on page 16
• Verify Cisco Unified Communications Manager Version, on page 16

About Cisco Unified Communications Manager Bulk
Administration Tool

The Unified Communications Manager Bulk Administration Tool (BAT) is a web-based application that you
can use to perform bulk transactions to the Unified Communications Manager database. You can use BAT
to add, update, or delete a large number of similar phones, users, or ports at the same time. When you use
Unified Communications Manager Administration, each database transaction requires an individual manual
operation, while BAT automates the process and achieves faster add, update, and delete operations.

The Bulk Administration menu is visible only on the first node of Unified Communications Manager server.Note

Bulk Provision Service (BPS) administers andmaintains all jobs that are submitted through Bulk Administration
menu of Unified Communications Manager administration. You can start this service from Unified
Communications Manager Serviceability.

The BPS Server service parameter determines whether the service is activated on a particular server. You
need to activate BPS only on the first node of Unified Communications Manager.

You can use BAT to work with the following types of devices and records:

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
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• Add, update, and delete Cisco Unified IP Phones including voice gateway (VG) phones, computer
telephony interface (CTI) ports, and H.323 clients, and migrate phones from Skinny Client Control
Protocol (SCCP) to Session Initiation Protocol (SIP)

• Add, update, and delete users

• Add, update, and delete User Device Profiles

• Add, update, and delete Unified Communications Manager Assistant and Managers associations

• Add, update, and delete ports on a Cisco Catalyst 6000 FXS Analog Interface Module

• Add or delete Cisco VG200 and Cisco VG224 analog gateways and ports

• Add or delete Forced Authorization Codes

• Add or delete Client Matter Codes

• Add or delete Call Pickup Groups

• Update or export CUP/CUPC users

• Populate or depopulate the Region Matrix

• Insert, delete, or export the Access List

• Export or import configuration

• Insert, delete, or export Remote Destination and Remote Destination Profile

• Add Infrastructure Devices

When you perform a bulk transaction, limit the number of records to a maximum of 12,000 records. This
applies when you insert, update, delete, or query any records using BAT.

Note

You can also work with these devices in combination with the user information. For example, when you add
CTI ports and users, you can use BAT to “Enable CTI Application Use.” This saves time when you add users
who have applications that require a CTI port, such as Cisco IP SoftPhone.

An optional component of BAT, the Unified Communications Manager Auto-Register Phone Tool, further
reduces the time and effort that is involved in administering a large system. To add a large block of new
phones, you can use BAT to add the devices with dummy media access control (MAC) addresses instead of
entering each MAC address in the data input file. After the phones are installed, the phone users or the
administrator can call the Unified CMAuto-Register phone Tool directory number, follow the voice prompts,
and download the correct user device profiles for their phones.

Related Topics
Manage Tool for Auto-Registered Phones Support (TAPS), on page 583

BAT Installation
BAT is installed as part of the Unified Communications Manager Administration.

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
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BAT Data Input Files
Every device includes a multitude of individual attributes, settings, and information fields that enable the
device to function in the network and provide its telephony features. Many devices have the same attributes
and settings in common, while other values, such as the directory number, are unique to a user or to a device.
To condense the BAT data input file contents, BAT uses templates for settings that devices usually have in
common.

For bulk configuration transactions on the Unified Communications Manager database, the BAT process uses
two components: a template for the device type and a data file in comma separated value (CSV) format that
contains the unique values for configuring a new device or updating an existing record in the database. The
CSV data file works in conjunction with the device template.

For instance, when you create a bulk transaction for a group of CiscoIPPhones, you set up the CSV data file
that contains the unique information for each phone, such as the directory number and MAC address. In
addition, you set up or choose the BAT template that contains the common settings for all phones in the
transaction, such as a CiscoIPPhone7960 template.

Perform BAT Configuration Multistep Process
BAT uses a multistep process to prepare the bulk configuration transaction. BAT uses Bulk Administration
menu options to guide you through the configuration tasks. The BAT process includes these tasks:

Procedure

Step 1 Set up the template for data input.
Step 2 Define a format for the CSV data file.
Step 3 Collect the data for each device in the bulk transaction.
Step 4 Upload the data files choosing the relevant target and function for the transaction.
Step 5 Validate the data input files with the Unified Communications Manager database.
Step 6 Submit jobs for execution.
Step 7 Schedule jobs.
Step 8 Execute jobs to insert the devices into the Unified Communications Manager database.

To blank out a field, type "NULL" (without quotations) in the field. Do not leave the field blank.Note

About the BAT Menu
From the Bulk Administration menu, you can choose one of these device or configuration options:

• Upload/Download Files
• Phones
• Users
• Phones and Users

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
7

Overview
BAT Data Input Files



• Manager/Assistants
• User Device Profiles
• Gateways
• Forced Authorization Codes
• Client Matter Codes
• Call Pickup Group
• Mobility
• Region Matrix
• Import/Export
• Phone Migration
• EMCC
• Intercompany Media Engine
• CUPS
• TAPS
• Infrastructure Devices
• Job Scheduler

When you choose an option, the corresponding menu items display. For example, when you choose phones,
the following list of menu items displays:

• Validate Phones—Validate phones records.
• Insert Phones—Add new phones.
• Update Phones—Locate and modify existing phones.
• Delete Phones—Locate and delete phones.
• Export Phones—Locate and export specific phone records or all phone records.
• Add/Update Lines—Add new lines to existing phones, and locate and modify lines on existing phones.
• Reset/Restart Phones—Locate and reset or restart phones.
• Generate Phone Reports—Generate customized reports for phones.
• Migrate Phones—Migrate phones from SCCP to SIP.

When you choose a menu option from the Bulk Administration menu, the corresponding window opens, such
as the phone Template Configuration window. The configuration window provides the entry fields for defining
a template.

BAT Configuration Templates
As the first task in the BAT configuration process, you set up a template for the devices that you are configuring.
You specify the type of phone or device that you want to add or modify, and then you create a BAT template
that has features that are common to all the phones or devices in that bulk transaction.

You can create BAT templates for the following types of device options:

• Phones: All CiscoUnifiedIPPhones and Cisco ATA 186, Cisco VGC phones, CTI ports, and H.323 clients

• Gateways: Cisco VG200 and Cisco Catalyst 6000 FXS Analog Interface Module

• User Device Profiles: CiscoUnifiedIPPhone 7900 series and Cisco Softphone

Define a BAT template by specifying values in the template fields that will be common to all the devices in
the bulk transaction. The BAT template fields require similar values to those that you enter when you are
adding a device in Unified Communications Manager Administration.

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
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Prior to creating the BAT template, make sure settings such as device pools, locations, calling search spaces,
button templates, and softkey templates have already been configured in Unified Communications Manager
Administration.

After you create a BAT template, you save it with a name. Later in the configuration process, you associate
the template name with the CSV data file. The system stores the templates, so they are reusable for future
bulk transactions. For example, you can configure a CiscoIPPhone7960 template with a specific button template
and calling search space and then configure another CiscoIPPhone7960 template with a different button
template and the Extension Mobility feature enabled. When you need to add a large number of phones with
the same configuration, you can reuse the existing BAT template.

Standard Phone Templates
When you are adding a group of phones that have multiple lines, you can create a standard phone template
that provides multiple lines and the most common values for a specific phone model. You can use the standard
template to add phones that have differing number of lines, but do not exceed the number of lines in the master
phone template. For example, you can create a standard phone template for a CiscoUnifiedIPPhone 7960 that
has eight lines. You can use this template to add phones that have one line, two lines, or up to eight lines.

CSV Data File Overrides Template Values
The CSV data file contains the unique settings and information for each individual device, such as its directory
number, MAC address, and description. Make sure that all phones and devices in a CSV data file are the same
phone or device model and match the BAT template. The CSV data file can contain duplicates of some values
from the BAT template. Values in the CSV data file override any values that were set in the BAT template.
You can use the override feature for special configuration cases.

Example Template Override
The CSV data file for phones can contain multiple directory numbers. Keep in mind that the number of
directory numbers that are entered in the CSV data file must not exceed—but can be less than— the number
of lines that are configured in the BAT phone template, or an error will result.

If you want most of the phones in the bulk transaction to be redirected to a voice-messaging system, you can
set the Call Forward Busy (Internal/External) (CFB) and Call Forward No Answer (Internal/External) (CFNA)
fields to the voice-messaging number. However, if a few phones in the bulk transaction need to be redirected
to a secretary instead of to a voice messaging system, you can specify the secretary directory number in the
Call CFB and CFNA fields in the CSV data file. Most of the phones will use the CFB and CFNA values from
the BAT phone template, but certain phones will use the secretary directory number as specified in the CSV
data file.

CSV Data File Adds New Devices
When you are adding new devices to the system, you can use theMicrosoft Excel spreadsheet that was designed
to use with BAT. The BAT spreadsheet assists you with the following features:

• Data file templates with macros for the different devices

• Customized file format definition

• Support for multiple phone lines

• Record error checking
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• File conversion to CSV format

When you are creating new records, use the BAT spreadsheet, which is named BAT.xlt, because the data gets
validated automatically when you export to the CSV format.

BAT.xlt validates data only for valid characters, data types, and field length for particular fields.Note

For experienced BAT users who are comfortable with working in a CSV formatted file, you can use a text
editor to create a CSV data file by following the sample text file that is provided on the device insert task
window.

Related Topics
BAT Spreadsheet Data Collection for CSV Data File Creation, on page 12
Validate CSV Data File Phone Records, on page 117
Text-Based CSV Files, on page 629

CSV Data File Updates Existing Devices
To modify or update existing phones and devices, you need to locate the records for these devices. BAT
provides twomethods for locating phones, gateways, and device profiles. You can search by using a customized
query or by using a custom file.

You can also extract a group of phone records from the Unified Communications Manager database for
inclusion in a CSV data file using the export utility.

Customized Query Searches

BAT provides a window for defining your query criteria. You can choose the specific device model and/or
choose criteria from a list of device details and a list of line details. To locate all devices of a specific device
model, you choose the model but add no other criteria for the search. You get the records for all the
Cisco Unified IP Phones that are configured in the database.

Custom File Searches

When no common attribute to use for a query exists, BAT provides the custom file option. A custom file
includes device names or directory numbers. You can build a custom text file by putting each record on a
separate line. The search gives you all the records that match the criteria.

Export Phone Records to CSV Data File

When you need to move a group of phones, you can use the export utility. You use the export utility to extract
existing records from the Unified Communications Manager database to move them into a CSV data file.
When you move phones, use the option, Export Phones with the All Phone Details. This option generates an
export file that contains records with all the information, including the device attributes, line attributes, and
services, that is associated with that phone. You can also export phone records with specific details when
phones have similar line configurations and you want to use a template.

Related Topics
Exported Phone Record Fields, on page 148
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CSV Data File and Custom File Formats
CSV data files comprise a string of device attributes and information in a comma separated value (CSV)
format. To insert data records into the Unified Communications Manager database, ensure that each data file
is in the CSV format. In earlier releases of BAT, the CSV file had a fixed format with two options:

• Default format—CSV files that have a fixed and limited number of attributes and settings for each device.

• All details format—CSV files that are created by using the export utility and include all attributes and
settings for each device.

The first row of every CSV data file shows the file format by displaying the name of each field that the CSV
file includes. The file format information makes it easier to locate the entry for a specific field in the CSV
data file. For instance, in the following sample CSV file, USER ID represents the fourth field in the header,
and the fifth field in the CSV file for the phone shows “johns.”

To blank out a field, type "NULL" (without quotations) in the field. Do not leave the field blank.Note

Sample CSV Data File with the Default File Format

MAC ADDRESS,DESCRIPTION,LOCATION,USER ID,DIRECTORY NUMBER 1,DISPLAY 1,LINE TEXT LABEL
1,FORWARD BUSY EXTERNAL 1,FORWARD NO ANSWER EXTERNAL 1,FORWARD NO COVERAGE EXTERNAL 1,FORWARD
BUSY INTERNAL 1,FORWARD NO ANSWER INTERNAL 1,FORWARD NO COVERAGE INTERNAL 1,CALL PICKUP
GROUP 1,SPEED DIAL NUMBER 1,SPEED DIAL LABEL 1,
1231123245AB,SEP1231123245AB,Dallas,Johns,9728437154,9728437154,Mike,9728437172,9728437196,
9728437127,9728437154,9728437178,9728437189,9728437121/TollByPass,1230000000,Helpdesk,
9728437127,9728437154,9728437178,9728437189,Marketing,1230000000,Helpdesk

Now, you can customize the file format for the CSV data file by using the Create Phone File Format
Configuration window. You can add attributes to your file format that are also in the BAT template. This
allows you to override the template entry with a specific attribute for a device. For instance, you can choose
the route partition attribute for your file format and enter different partitions for each phone in the CSV data
file.

From this window, you can choose specific attributes from Device fields and Line fields

The following device attributes always remain in each file format:

• MAC Address

• Description

The File Format Configuration dialog box makes it easy to choose the device attribute in the Device Field
box and click an arrow to move the attribute into the Selected Device Field box. You can select multiple
attributes at the same time by holding down the Ctrl key.

You can rearrange the order of the device attribute fields and line attribute fields in the file format by using
the Up and Down arrows. You can select an attribute and then click the Up arrow to move the item closer to
the first record or click the down arrow to move the item further away from the first record. You cannot move
line attributes before device attributes or change the order of speed dials.
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You can customize a CSV file format, so it matches the arrangement of your employee phone information
that is stored in another database. This method simplifies exporting data between a company database and the
Unified Communications Manager database.

Tip

Sample CSV Data File with the Customized File Format

Device fields—MAC Address, Description, Device Pool, Calling Search Space

Line fields—Directory number, Partition, Line Text Label (moved to position after directory number in file)

The File Format does not include speed-dial codes. Choose speed-dials by selecting the Include Speed Dials
in the CSV Format check box.
MAC ADDRESS,DESCRIPTION,DEVICE POOL,CSS,DIRECTORY NUMBER,LINE TEXT LABEL,
PARTITION,2234900AEF01,SEP2234900AEF01,DP_1,CSS_Restricted,
9725098827,LobbyPhone,Part1

Associate Custom File Format with CSV Data File

When you are using a text editor to create a CSV data file, you can create a customized file format and then
enter values in the same order as specified by that file format. Before inserting the text-based CSV data file
that uses the customized file format, you must associate the file format name with the CSV data file. You can
associate only one file format with a CSV data file.

Procedure

Step 1 In the Add File Format window, choose the name of the CSV data file <CSVfilename>.txt from the File
Name drop-down list.

Step 2 Choose a file format from the File Format Name drop-down list.
The data in the CSV data file must match the custom file format that is chosen.

BAT Spreadsheet Data Collection for CSV Data File Creation
The BAT spreadsheet simplifies the creation of CSV data files. You can add multiple devices and view the
records for each device in a spreadsheet format. It allows you to customize the file format within the spreadsheet
and provides validation and error checking automatically to help reduce configuration errors. The BAT
spreadsheet includes tabs along the bottom of the spreadsheet for access to the required data input fields for
the various devices and user combinations in BAT.

BAT.xlt validates data only for valid characters, data types, and field length for particular fields.Note

The CSV data file works in combination with the BAT template. For example, when you choose the Phone
tab in the BAT spreadsheet, you can leave Location, Forward Busy Destination, or Call Pickup Group blank.
The values from the BAT phone template get used for these fields; however, if you specify values for Forward
Busy Destination or Call Pickup Group, those values override the values for these fields that were set in the
BAT phone template.
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When Unified Communications Manager is installed, the Microsoft Excel file for the BAT spreadsheet gets
placed on the first node database server; however, you probably do not have Microsoft Excel running on the
first node database server. You must download the file from the first node database server to the local machine
on which you plan to work.

Tip

Download the file BAT.xlt file to a local machine where Microsoft Excel is installed. To use the BAT.xlt
spreadsheet to create a CSV data file, locate and double-click the BAT.xlt file. You must choose to “enable
macros” when you open the BAT spreadsheet.

Most of the times when you download the BAT.xlt file to a local Windows machine, you will see a blocked
content warning: "Macros in this document have been disabled by your enterprise administrator for security
reasons." To solve this issue, download your BAT.xlt files in 97-2003 format (.xls instead of the new .xlsx
format). Use this (*.xls) format to create BAT spreadsheets.

BAT.xlt files functions work best on a Windows machine and not on a Mac OS machine. We recommend
you to use BAT.xlt files on a Windows machine.

Note

The spreadsheet displays a set of columns with attribute headings that specify the BAT field names, whether
the field is a required or optional, and the maximum number of characters that are allowed in the field.

Tabs for every device display along the bottom of the spreadsheet. When you click the tab for the type of
device with which you want to work, the columns adjust to display all relevant fields for the chosen device.
For example, to add phones and users all at once, click the tab that is marked Phones-Users.

If the “enable macros” option does not display while you are opening the spreadsheet, a possibility exists that
macro security on the Excel program is set to high. Ensure that Macro security is medium or low for the
macros to run. To set the Macro security to medium, do the following task: choose Tools >Macro > Security
from Excel menu. Set the security level to medium. Close the Excel program and open it again. This action
should give you the “enable macros” option when you open the spreadsheet the next time.

Tip

Next, define the file format for the CSV data file by clicking the Create File Format button. You can use
the Field Selection dialog box to choose items and their order in your CSV data file. When you click Create,
the columns in the spreadsheet adjust to your new file format.

In the first row, enter data for a device in all mandatory fields and any relevant optional fields. You enter data
in a new row for each device.

The system treats blank rows in the spreadsheet as “end of file” markers and discards subsequent records.Note

After all device records are completed, you export the BAT spreadsheet data to the CSV file format that BAT
must use to perform the bulk transaction with the Unified Communications Manager first node database.

If you enter a comma in one of the fields, BAT.xlt encloses that field entry in double quotes when you export
to BAT format.

Note
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The system saves the CSV formatted file as a text file to the folder that you choose. The filename format
follows:

<tabname><timestamp>.txt

where <tabname> represents the type of device input file that you created (such as phones, user device profiles),
and <timestamp> represents the precise date and time that the file was created.

Next, you must upload the converted CSV data file (CSV format version) back to the Unified Communications
Manager database server by using Upload/Download Files option in the Bulk Administration of Unified
Communications Manager Administration.

Related Topics
Upload and Download Files, on page 19
Validate CSV Data File Phone Records, on page 117

Validate BAT Data Input File
The system runs a validation routine to check for errors in the CSV data file and the BAT template against
the first node database. These checks include the following items:

• Fields, such as description, display text, and speed-dial label that do not have a dependency on a database
table, use valid characters.

• BAT Validate transaction only validates data type, length and relational dependency.

Consider the following example:

MAC ADDRESS,DESCRIPTION,PARTITION

AABBCC112233,Lab Phone,Dallas

If the Partition does not exist, Validate displays an error saying “Dallas is not an existing PARTITION.”

• Number of lines that are configured on a device matches the device template. (Only for Specific Details)

Validation does not check for the existence of a user or for mandatory/optional fields that are BAT defined,
such as the dummy MAC address.

Procedure

Step 1 Select the Validate File option and choose the name of the CSV data input file, the BAT template for the
device, and the model, if applicable.
The CSV data file should contain all details.

Step 2 Select the validation method.
a) Choose Specific Details for validating records that follow the Default or Custom file format.
b) Choose All Details for validating records from a file that was generated from the export utility using the

All Details option.

After the transaction completes, click the Log File Name link in the Job configuration window to see a log
file that displays the devices that could not be validated successfully and the error code.
Related Topics

Manage Troubleshooting BAT and TAPS, on page 607
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Insert BAT Data Input File Records Into Database
When the data input file has passed validation, you are ready to use the Insert window to add the device
records into the Unified Communications Manager first node database.

Before you begin

The CSV data input file must be valid. If any line information for a phone record fails, BAT does not insert
that phone record.

Procedure

Step 1 In the Insert window choose the name of the CSV data input file, the BAT template for the device, and the
model, if applicable.
The CSV data file should contain all details and be valid.

Step 2 Select the insert method.
a) Choose Specific Details to insert records that use a customized file format.
b) Choose All Details to insert records from a file that was generated from the export utility using the All

Details option.

Step 3 Enter Job Information details and click Submit.
This creates a job that can be accessed using the Job Scheduler option in the Bulk Administration menu.
Use the Job Configuration window to view the status and to schedule and activate the job.

If any line information for a phone record fails, BAT does not insert that phone record.Note

After the transaction completes, click the Log File Name link in the Job configuration window to see a log
file that displays the number of records that were added and the number of records that failed, including an
error code.
Related Topics

Manage Troubleshooting BAT and TAPS, on page 607
Validate BAT Data Input File, on page 14

BAT Application Web Browser Considerations
The BAT is a web-based application that requires the use of a web browser. A web browser is a
resource-intensive application that can consume large amounts of system memory and CPU cycles. When a
web browser takes resources away fromUnified CommunicationsManager, it adversely affects call processing.

Possible consequences of using the browser on the same machine as the web server and Unified
Communications Manager include delayed dial tone and dropped calls.

Caution
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Access BAT Online Help
Online help provides a multivolume system that allows you to access several different help systems, all from
the same window. You can also access a comprehensive search engine and index.

Procedure

Step 1 Select the Help menu to access BAT online help.
Step 2 Choose a help feature.

a) Choose Contents and Index to open the BAT help file that you can browse for information or search the
index.

b) Choose For This Page to open the help directly for the window that you are currently viewing.
You can still browse the remainder of the help or use the index.

Verify Cisco Unified Communications Manager Version
Procedure

Select Help > About to find the current version of Unified Communications Manager
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P A R T II
File Upload and Download

• Upload and Download Files, on page 19





C H A P T E R 3
Upload and Download Files

This chapter provides information to upload files to the Cisco Unified Communications Manager first node
and download files to a local machine.

• Find Downloadable File on Server, on page 19
• Download File Off Server, on page 20
• Upload File to Server, on page 21
• Delete File From Server, on page 21

Find Downloadable File on Server
Use the following procedure to find files that you can download from the Unified Communications Manager
server.

Procedure

Step 1 Choose Bulk Administration > Upload/Download Files.
Step 2 From the first Find File where drop-down list box, choose one of the following options:

• Name
• Type

Step 3 In the second Find Job where drop-down list, do one of the following:
a) If you chose Name in Step 2, on page 19, choose one of the following options and continue with Step 4,

on page 20:

• begins with

• contains

• is exactly

• ends with

• is empty

• is not empty
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b) If you chose Type in Step 2, on page 19, continue with Step 4, on page 20.

Step 4 Specify the appropriate search text, if applicable.

To find all files that are registered in the database, click Find without entering any search text.Tip

Step 5 To further define your query and to add multiple filters, check the Search Within Results check box, choose
AND or OR from the drop-down box, and repeat Step 2, on page 19 through Step 4, on page 20.

Step 6 If you choseType inStep 2, on page 19, from the Select item or enter search text drop-down list box, choose
one of the following options:

• Insert Files
• Export Files
• Report Files
• Custom Files
• Log Files
• BAT Excel Template

Step 7 Click Find.

A list of discovered files displays by the following:

• File Name

• Function Type

If you chose Type in Step 2, on page 19, the list of discovered files displays by the following:

• File Name

• Launch Date and Time

What to do next

You can download a file(s) that you chose.

Related Topics
Download File Off Server, on page 20

Download File Off Server
Use the following procedure to download a file from the Unified Communications Manager server.

Procedure

Step 1 Find the files that you want to download.

To find files on the server, see Find Downloadable File on Server, on page 19.Tip

Step 2 Check the check boxes corresponding to the files that you want to download and click Download Selected.
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If you select more than one file to download at a time, the files will be downloaded to a common zip file.

You can download all the files by clicking Select All and then clicking Download Selected.Tip

Step 3 The File Download pop-up window displays. Click Save.
Step 4 In the Save As pop-up window, choose the location where you want to save the file and click Save.
Step 5 The Download Complete pop-up window displays. To open the downloaded file, click Open, or click Close

to open it at a later time.

Upload File to Server
Use the following procedure to upload a file to the Unified Communications Manager server.

The upload file format must always be using alphanumeric (a-z, A-Z and 0-9) characters. Valid characters
include hyphens (-), dot (.), and underscore (_). Also, the file name should not begin with a dot nor contain
double dots.

Note

Procedure

Step 1 Choose Bulk Administration > Upload/Download Files.
Step 2 Click Add New.
Step 3 In the File text box, enter the full path of the file that you want to upload or click Browse, and locate the file.
Step 4 From the Select the Target drop-down list, choose the target for which you want to use the file.
Step 5 From the Transaction Type drop-down list, choose the transaction type that the file defines.
Step 6 If you want to overwrite an existing file with the same name, check theOverwrite File if it Exists check box.
Step 7 Click Save. The status displays that the upload is successful.

Delete File From Server
Use the following procedure to delete files from the Unified Communications Manager server. If you choose
files to delete that are actively being used to execute jobs, those files will not get deleted.

Do not delete the BAT.xlt file.Attention
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Procedure

Step 1 Find the files that you want to delete.
Step 2 In the Search Results area, check the check box that corresponds to the files that you want to delete.
Step 3 Click Delete Selected.

To delete all files that display in the Search Results area, click Select All and Delete Selected.Note

Step 4 To continue, click OK.
The files are now deleted from the server.

Related Topics
Find Downloadable File on Server, on page 19
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P A R T III
Phones

• Phone Template, on page 25
• Phone File Formats, on page 111
• Phone Record Validation, on page 117
• Phone Insertions, on page 119
• Phone Updates, on page 123
• Phone Deletions, on page 141
• Phone Exports, on page 147
• Phone Line Addition and Updates, on page 153
• Phone Resets and Restarts, on page 169
• Phone Reports, on page 175
• Phone Migrations, on page 183
• Intercom Additions and Updates, on page 187





C H A P T E R 4
Phone Template

Cisco Unified Communications Manager Bulk Administration (BAT) gives the administrator a fast and
efficient way to add, update, or delete large numbers of phones in batches, rather than performing individual
updates through Cisco Unified Communications Manager Administration. You can use BAT to work with
the following types of phones:

• CiscoUnifiedIPPhones (all models)

• CTI ports

• H.323 clients

This chapter provides information about how to use BAT to work with phone templates and other IP telephony
devices.

• Add Phones to Database, on page 25
• BAT Phone Templates, on page 26
• Update Jabber Device, on page 110

Add Phones to Database
When you use BAT to add phones and other IP telephony devices in bulk to the Unified Communications
Manager database, you can add multiple lines, services, and speed dials for each phone. You can also add
CTI ports and H.323 clients.

You have two options for creating a CSV data file for phones:

• Use the BAT spreadsheet (BAT.xlt) and export the data to the CSV format
• Use a text editor to create a text file in CSV format (for experienced users)

Procedure

Step 1 Choose Bulk Administration > Phones > Phone Template.

The Find and List Phone Templates window displays.

Step 2 Create a CSV data file to insert the phone templates.

Perform one of the following options:
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a) Create a CSV data file using the BAT spreadsheet.
b) Create a CSV data file using a text editor as follows:

1. Choose Bulk Administration > Phones > Phone File Format > Create File Format.
2. Use a text editor and create the CSV data file for phones that follows the file format that you want to

use.
3. Choose Bulk Administration > Phones > Phone File Format > Add File Format to associate the

text-based file format with the CSV data file.

Step 3 Choose Bulk Administration > Phones > Validate Phones.
Step 4 Choose Bulk Administration > phones > Insert phones to insert phone records into the Unified

Communications Manager database.

Related Topics
Associate Text-Based File Format with CSV Data File, on page 115
BAT Phone Templates, on page 26
Create Phone CSV Data File Using BAT Spreadsheet, on page 84
Create Text-Based CSV File for Phones, on page 630
Find Phone File Formats, on page 111
Insert Phones Into Unified Communications Manager, on page 119
Phone Record Validation, on page 117

BAT Phone Templates
Use BAT phone templates to define the common phone attributes to add a group of new phones. Prior to
creating the template, make sure phone settings such as device pool, location, calling search space, button
template and softkey templates have already been configured in Unified Communications Manager
Administration. You cannot create new settings in BAT.

Find BAT Phone Template
Because you might have several phone templates, Unified Communications Manager lets you locate specific
phone templates on the basis of criteria that you define.

During your work in a browser session, your find/list search preferences are stored in the cookies on the client
machine. If you navigate to other menu items and return to this menu item, or if you close the browser and
then reopen a new browser window, your Unified Communications Manager search preferences are retained
until you modify your search.

Note

Procedure

Step 1 Choose Bulk Administration > Phones > Phone Template.
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The Find and List Phone Templates window displays. Use the two drop-down list boxes to search for a
template.

Step 2 From the first Find Phone Templates where drop-down list box, choose one of the following criteria:

• Device Name
• Description
• Directory Number
• Directory URI
• Calling Search Space
• Device Pool
• Device Type
• Call Pickup Group
• LSC Status
• Authentication String
• Device Protocol
• Security Profile
• Common Device Configuration

Step 3 From the second Find Phone Template where drop-down list box, choose one of the following criteria:

• begins with
• contains
• is exactly
• ends with
• is empty
• is not empty

Step 4 Specify the appropriate search text, if applicable, and click Find.

To find all Phone Templates that are registered in the database, click Find without entering any
search text.

Tip

A list of discovered templates displays.
Step 5 From the list of records, click the device name that matches your search criteria.

The window displays the phone template that you choose.

Create New BAT Phone Template
You can create new BAT phone templates. After you create a phone template, you can add lines, services,
and speed dials.

Procedure

Step 1 Choose Bulk Administration > Phones > Phone Template.
Step 2 Click Add New. The Add a New Phone Template window displays.
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Step 3 From the Phone Type drop-down list, choose the phone model for which you are creating the template. Click
Next.

Step 4 From the Select the Device Protocol drop-down list, choose the device protocol. Click Next.

The Phone Template Configuration window displays with fields and default entries for the chosen device
type.

Step 5 In the Template Name field, enter a name for the template.
The name can contain up to 50 alphanumeric characters.

Step 6 In the Device Information area, enter the phone settings that this batch has in common.
Some phone models and device types do not have all the attributes that the table lists. See, the phone model
documentation for information on all the attributes.

Step 7 After you have entered all the settings for this BAT phone template, click Save.

When the status indicates that the transaction has completed, you can add line attributes.

Add or Update Phone Lines in BAT Template
You can add one or more lines to the BAT template or to update existing lines. The button template in use
for the BAT template determines the number of lines that you can add or update. You can create a primary
phone template that has multiple lines. Then, you can use the standard template to add phones with a single
line or up to the number of lines in the standard template. All phones or user device profiles in this batch will
use the settings that you choose.

Cisco recommends that you use alphanumeric characters for the line template value, so if numbers are given,
a chance exists of this conflicting with an actual directory number. This would also avoid conflicts with
features such as Call Pickup group number and Call Park number.

The maximum number of lines that display for a BAT template depends on the model and button template
that you chose when you created the BAT phone template. For some CiscoUnifiedIPPhone models, you can
also add CiscoUnifiedIPPhone services and speed dials to the template.

Procedure

Step 1 Find the Phone Template to which you want to add the line.
Step 2 In thePhone Template Configurationwindow, clickLine [1] Add a new DN, in theAssociated Information

area.
The Line Template Configuration window displays.

Step 3 Enter or choose the appropriate values for the line settings.
Step 4 Click Save.
Step 5 To add settings for any additional lines, repeat Step 2, on page 28 through Step 4, on page 28.

If you choose Back to Find/List from the Related Links drop-down list box in the upper, right, corner of the
Line Template Configuration window, the Find and List Line Template window displays.
a) To find existing line template, enter the appropriate search criteria and click Find.
b) To add a new line template, click Add New.
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Related Topics
Add or Update IP Services in BAT Template, on page 29
Add or Update Speed Dials in BAT Template, on page 29
Find BAT Phone Template, on page 26
Standard Phone Templates, on page 9

Add or Update IP Services in BAT Template
You can subscribe CiscoUnifiedIPPhone services to the CiscoUnifiedIPPhonemodels that include this feature
directly in the BAT template. To bulk subscribe users or phones to IP services, the IP services must have
common service parameters and be subscribed through a phone template. You can not bulk subscribe IP
services that have unique service parameters. For services with unique parameters, use the CSV file.

Procedure

Step 1 Find the Phone Template to which you want add an IP service.
Step 2 From the Phone Template Configuration window, click Add a new SURL in the Associated Information

area.
A popup window displays. In this window, you can subscribe to CiscoUnifiedIPPhone services that are
available.

Step 3 In the Select a Service drop-down list box, choose a service to which you want all phones to be subscribed.
The Service Description box displays details about the service that you choose.

Step 4 Click Next.
Step 5 In the Service Name field, modify the name of the service, if required.
Step 6 Associate the selected services or add more services to the template.

a) To associate these phone services to the phone template, click Save.
b) To add more services, repeat Step 3, on page 29 through Step 6, on page 29.
c) To add all the services to the template, click Update.
After you are done adding or updating services for the selected template, proceed to the next step.

Step 7 Close the popup window.

Related Topics
Add or Update Speed Dials in BAT Template, on page 29
Find BAT Phone Template, on page 26

Add or Update Speed Dials in BAT Template
You can add and update speed dials in the BAT template for phones and Cisco VGC phones if the Phone
Button Template provides speed-dial buttons. The Phone Button Template in use for the BAT template
determines the number of available speed-dial buttons.

Procedure

Step 1 Find the Phone Template to which you want to add speed dials.
Step 2 From the Phone Template Configuration window, do one of the following:
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a) Click Add a new SD in the Associated Information area.
b) Choose Add/Update Speed Dials from the Related Links drop-down list box in the upper, right-hand

corner of the window.
A popup window displays. In this window, you can designate speed-dial buttons for CiscoUnifiedIPPhones
and expansion modules.

Step 3 In the Speed Dial Settings area, enter the phone number, including any access or long-distance codes, in the
Number field.

When you enter the phone number, it can be followed by Forced Authorized Code (FAC)/Client
Matter Code (CMC) if applicable. You can enter the Phone number, FAC, CMC either in sequence
or separated by a comma (,). The Speed dial may include any PIN, Password or any other digits
to be sent as DTMF digits after the call is connected. If you require a pause while connecting
through speed dial, you can enter one or more comma (,) where each comma represents a pause
of 2 seconds. DTMF digits will be sent after the call is connected and the appropriate pause
duration corresponding to the number of commas is entered.

Note

Step 4 In the Label field, enter a label that corresponds to the speed-dial number.
Step 5 In the Abbreviated Dial Settings area, you can set abbreviated speed dials for applicable IP phone models.

Repeat Step 3, on page 30.
Step 6 Click Save.

BAT inserts the speed-dial settings in the template and the popup window closes.

Related Topics
Find BAT Phone Template, on page 26

Add or Update Busy Lamp Field in BAT Template
You can add and update busy lamp filed speed dials in the BAT template for phones and Cisco VGC phones
if the Phone Button Template provides speed-dial buttons. The Phone Button Template in use for the BAT
template determines the number of available BLF SD buttons.

Procedure

Step 1 Find the Phone Template to which you want to add speed dials.
Step 2 In the Phone Template Configuration window, do one of the following:

a) Click Add a new BLF SD in the Associated Information area.
b) Choose Add/Update Busy Lamp Field Speed Dials from the Related Links drop-down list in the upper,

right-hand corner of the window.
A popup window displays. In this window, you can designate busy lamp field speed-dial (BLF SD) buttons
for CiscoUnifiedIPPhones and expansion modules.

Step 3 In the Speed Dial Settings area, enter the destination, including any access or long-distance codes, in the
Destination field.

Step 4 Choose the directory number from the drop-down list. You can click Find to search for directory numbers.
Step 5 In the Label field, enter a label that corresponds to the BLF SD number.
Step 6 Click Save.
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BAT inserts the BLF SD settings in the template, and the popup window closes.

Related Topics
Find BAT Phone Template, on page 26

Add or Update Busy Lamp Field Directed Call Park in BAT Template
You can add and update busy lamp field (BLF) directed call park in the BAT template for phones and Cisco
VGC phones if the Phone Button Template provides speed-dial buttons. The Phone Button Template in use
for this BAT template determines the number of available BLF Directed Call Park buttons.

Procedure

Step 1 Find the Phone Template to which you want to add BLF speed directed call park.
Step 2 In the Phone Template Configuration window, do one of the following:

a) Click Add a new BLF Directed Call Park in the Associated Information area.
b) Choose Add/Update BLF Directed Call Park from the Related Links drop-down list box in the upper,

right-hand corner of the window.
A popup window displays. In this window, you can designate BLF Directed Call Park buttons for
CiscoUnifiedIPPhones and expansion modules.

Step 3 In the Unassigned Busy Lamp Field/Directed Call Park Settings area, choose the directory number from
the drop-down list. You can click Find to search for directory numbers.

Step 4 In the Label field, enter a label that corresponds to the BLF Directed Call Park number.
Step 5 Click Save.

BAT inserts the BLF Directed Call Park settings in the template, and the popup window closes.

Related Topics
Find BAT Phone Template, on page 26

Add or Update Intercom Template in BAT Template
You can add one or more Intercom templates to the BAT template, or update existing Intercom templates in
the BAT template The button template in use for the BAT template determines the number of lines that you
can add or update. You can create a standard phone template that has multiple lines. Then, you can use the
standard template to add phones with a single line or up to the number of lines in the standard template. All
phones or user device profiles in this batch will use the settings that you choose for the intercom template.

We recommend that you use alphanumeric characters for intercom template, so if numbers are given, a chance
exists of this conflicting with an actual directory number. This would also avoid conflicts with features such
as Call Pickup group number and Call Park number.

The maximum number of lines that display for a BAT template depends on model and button template that
you chose when you created the BAT phone template. For some CiscoUnifiedIPPhone models, you can also
add CiscoUnifiedIPPhone services and speed dials to the template.
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Procedure

Step 1 Find the Phone Template to which you want to add the intercom template.
Step 2 In the Phone Template Configurationwindow, click Intercom [1] - Add a new Intercom in theAssociated

Information area.
The Intercom Template Configuration window displays.

Step 3 Enter or choose the appropriate values for the intercom template settings.
Step 4 Click Save.

BAT adds the intercom template to the phone template configuration.
Step 5 To add settings for any additional intercom templates, repeat Step 2, on page 32 through Step 4, on page 32.

If you choose Back to Find/List from the Related Links drop-down list box in the upper, right, corner of the
Intercom Template Configuration window, the Find and List Intercom Directory Number window
displays.

If you choose Back to Find/List from the Related Links drop-down list box in the upper, right,
corner of the Intercom Template Configurationwindow, theFind and List Intercom Directory
Number window displays.

Note

a) Click Find and enter the appropriate search criteria and to find existing Intercom directory numbers.
b) In the Find and List Intercom Directory Number window, click Add New to add a new intercom

directory number.

Related Topics
Add or Update IP Services in BAT Template, on page 29
Add or Update Phone Lines in BAT Template, on page 28
Add or Update Speed Dials in BAT Template, on page 29
Find BAT Phone Template, on page 26
Standard Phone Templates, on page 9

Modify BAT Phone Templates

Procedure

Step 1 Find the Phone Template that you want to modify.
Step 2 In the phone Template Configuration window, add, change, or remove settings in the template. See Table

3: Field Descriptions for Adding a Line to a BAT Template, on page 65 for more information.
Step 3 After you have modified the settings to update the template, click Save.

What to do next

You can proceed to add or update lines, IP services, or speed dials for the BAT template.

Related Topics
Add or Update IP Services in BAT Template, on page 29
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Add or Update Phone Lines in BAT Template, on page 28
Add or Update Speed Dials in BAT Template, on page 29
Find BAT Phone Template, on page 26

Copy BAT Phone Template
You can copy the properties of an existing phone template into a new phone template when youwant to change
only a few fields. The copy duplicates all the values that were specified in the original template.

Ensure that the new template that you create is the same device type as the original template, such as
CiscoIPPhone 7975.

Note

Procedure

Step 1 Find the Phone Template that you want to copy.
Step 2 Copy the Phone Template. Do one of the following:

a) In the Phone Template Configuration window, verify that this is the template that you want to copy and
click Copy.

b) In the Find and List Phone Templates window, click the icon in the Copy column that corresponds to
the phone template that you want to copy.

c) To copy a template and all the lines associated with that template, in the Find and List Phone Templates
window, click the icon in the Super Copy column that corresponds to the phone template with the lines
that you want to copy.

Step 3 In the Template Name field, enter a name for the template.
The name can contain up to 50 alphanumeric characters.

Example:

Sales_7975.
Step 4 Update the fields as needed for the new template.

See Table 3: Field Descriptions for Adding a Line to a BAT Template, on page 65 for more information.

Step 5 Click Save.
The template that is added to BAT displays in the Phone Templates column on the left.

What to do next

You can continue to add or update phone lines, IP services, and speed dials to the template.

Related Topics
Add or Update IP Services in BAT Template, on page 29
Add or Update Phone Lines in BAT Template, on page 28
Add or Update Speed Dials in BAT Template, on page 29
Find BAT Phone Template, on page 26
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Delete BAT Phone Template
You can delete BAT phone templates.

If you submit a job that uses a particulate phone template and you delete that phone template, the job also
gets deleted.

Caution

Procedure

Step 1 Find the Phone Template that you want to delete.
Step 2 Delete the Phone Template. Do one of the following:

a) In the Phone Template Configuration window, verify that this is the template that you want to delete
and click Delete.

b) In the Find and List Phone Templates window. check the check box next to the template that you want
to delete and click Delete Selected.

A message displays that asks you to confirm the delete operation.

Step 3 To delete the template, click OK. The template name disappears from the list of phone templates list on the
Find and List Phone Templates window.

Related Topics
Find BAT Phone Template, on page 26

BAT Phone Template Field Descriptions
The following table provides descriptions of all possible fields that display when you add a BAT phone
template for all IP telephony devices. Some device types do not require all the phone settings, and only some
fields show the values that were configured in Unified CommunicationsManager Administration. Field names
that have an asterisk in the BAT user interface require an entry. Treat fields that do not have an asterisk as
optional.

Table 2: Field Descriptions for a Phone Template

DescriptionField

Device Information

Select whether the device is trusted or not trusted.
You can configure this setting for analog phones using
SCCP, and for some third-party endpoints.

Device Trust Mode

Enter the name for the template.Template Name
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Enter a description for the phone template that you
want to create. The description can include up to 50
characters in any language, but it cannot include
double-quotes ("), percentage sign (%), ampersand
(&), back-slash (\), or angle brackets (<>).

Description

Check this check box if you want to use activation
codes, rather than autoregistration, to onboard phones
that use this template.

This option is available only for phones
that support activation codes.

Note

Requires Activation Code for Onboarding

Choose the device pool for this group of phones or
ports.

For devices, a devicepool defines sets of common
characteristics, such as region, date/time group,
Unified CommunicationsManager group, and calling
search space for auto-registration.

DevicePool

Choose the common device configuration to which
you want this phone assigned. The common device
configuration includes the attributes (services or
features) that are associated with a particular user.
You configure the Common device configurations in
the Common Device Configuration window.

To see the common device configuration settings,
click the View Details link.

Common Device Configuration

Choose the button template for all phones in this
group. Button templates determine the button identity
(line, speed dial) and the button location on the phone.
Button templates include the expansion modules.

Phone Button Template

Choose the softkey template to be used for all phones
in this group.

Softkey Template

From the drop-down list, choose a common phone
profile from the list of available common phone
profiles.

Common Phone Profile

Choose the calling search space for this group of
phones/ports.

A calling search space specifies the collection of
Route Partitions that are searched to determine how
a dialed number should be routed.

Calling Search Space
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Choose the appropriate calling search space for the
device to use when it performs automated alternate
routing (AAR). The AAR calling search space
specifies the collection of route partitions that are
searched to determine how to route a collected
(originating) number that is otherwise blocked due to
insufficient bandwidth.

AAR Calling Search Space

Choose the media resource group list (MRGL) for
this group of phones/ports.

An MRGL specifies a list of prioritized media
resource groups. An application can choose required
media resources from the available ones according to
the order that is defined in the MRGL.

Media Resource Group List

Choose the user hold audio source for this group of
phones/ports.

The user hold audio source identifies the audio source
from which music is played when a user places a call
on hold.

User Hold MOH Audio Source

Choose the network hold audio source for this group
of IP phones or ports.

The network hold audio source identifies the audio
source from which music is played when the system
places a call on hold, such as when the user transfers
or parks a call.

Network Hold MOH Audio Source

Choose the appropriate location for this group of IP
phones or ports.

The location specifies the total bandwidth that is
available for calls to and from this location. A location
setting of None means that the locations feature does
not keep track of the bandwidth that this CiscoIPPhone
consumes.

Location

Choose the automated alternate routing (AAR) group
for this device. The AAR group provides the prefix
digits that are used to route calls that are otherwise
blocked due to insufficient bandwidth.

Set AAR Group to <None> to prevent rerouting
blocked calls.

AAR Group
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Choose the country and language set that you want
to associate with this group of IP phones.

This choice determines which cultural-dependent
attributes exist for this user and which language
displays for the user in the Unified Communications
Manager user windows and phones.

User Locale

Choose the network locale that you want to associate
with this group of phones.

The Network Locale comprises a set of tones and
cadences that Cisco gateways and phones use when
they communicate with the PSTN and other networks
in a specific geographical area.

Network Locale

Enable or disable the built-in conference bridge for
the barge feature by using the Built In Bridge
drop-down list (choose On, Off, or Default).

Built In Bridge

For each phone that wants Privacy, choose On in the
Privacy drop-down list.

Privacy

From the drop-down list, turn the device mobility
feature on or off for this device or choose Default to
use the default device mobility mode.

Click View Current Device Mobility Settings to
display the current values of these device mobility
parameters:

• Cisco Unified CommunicationsManager Group

• Roaming Device Pool

• Location

• Region

• Network Locale

• AAR Group

• AAR Calling Search Space

• Device Calling Search Space

• Media Resource Group List

• SRST

Device Mobility Mode

Enter a user ID for the primary phone user.Owner User ID
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From the drop-down list, choose the user ID of the
person to whom this dual-mode phone is assigned.

TheMobility User ID configuration gets
used for the Cisco Unified Mobility and
Mobile Voice Access features for
dual-mode phones.

Note

The Owner User ID and Mobility User
ID can differ.

Note

Mobility User ID

(Dual-mode phones only)

From the drop-down list, enable or disable the
personalization settings on the phone, or choose
Default to use the phone personalization that is set in
the Common Phone Profile. You can choose one of
the following options:

• Disabled—None of the personalization settings
on the phone get activated.

• Enabled—This setting accepts a personalized
background image file, which is used for the
phone screen; it accepts a preview image file for
temporary display; and it accepts a personalized
tone file, so the default ring tone can be
personalized.

• Default—Use the phone personalization setting
that is in the Common Phone Profile.

Phone Personalization
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From the drop-down list, choose the Services
Provisioning setting that you want to use from the
following values:

• Internal

• External URLs

• Both

• Default: Internal

This parameter controls whether the phone uses the
services provisioned from the configuration file
(Internal), services received from the Services URLs
(External URLs), or both. The External URLs option
provides backward compatibility with third party
provisioning servers. The Both option allows users to
subscribe to the services specified in the configuration
file while also appending services from an external
provisioning server.

This is a required field.

Services Provisioning

Enter the custom phone load, if applicable.

Any value that is entered in this field
overrides the default value for the
chosen model.

Note

For more information about CiscoIPPhone software
and configuration, refer to the CiscoIPPhone
Administration Guide for Unified Communications
Manager, which is specific to the phone model.

Phone Load Name

From the drop-down list, enable or disable the Single
Button Barge/cBarge feature for this device or choose
Default to use the service parameter setting.

• Off—This setting disables the Single Button
Barge/cBarge feature; however, the regular Barge
or cBarge features will still work.

• Barge—This setting enables the Singe Button
Barge feature.

• cBarge—This setting enables the Single Button
cBarge feature.

• Default—This setting uses the Single Button
Barge/cBarge setting that is in the service
parameter.

Single Button Barge
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From the drop-down list, enable or disable the Join
Across Lines feature for this device or chooseDefault
to use the service parameter setting.

• Off—This setting disables the Join Across Lines
feature.

• On—This setting enables the Join Across Lines
feature.

• Default—Uses the Join Across Lines setting that
is in the service parameter.

Join Across Lines

From the drop-down list, enable or disable whether
Unified Communications Manager inserts a trusted
relay point (TRP) device with this media endpoint.
Choose one of the following values:

• Default—If you choose this value, the device
uses the Use Trusted Relay Point setting from
the common device configuration with which
this device associates.

• Off—Choose this value to disable the use of a
TRP with this device. This setting overrides the
Use Trusted Relay Point setting in the common
device configuration with which this device
associates.

• On—Choose this value to enable the use of a
TRP with this device. This setting overrides the
Use Trusted Relay Point setting in the common
device configuration with which this device
associates.

A Trusted Relay Point (TRP) device designates an
MTP or transcoder device that is labeled as Trusted
Relay Point.

Unified Communications Manager places the TRP
closest to the associated endpoint device if more than
one resource is needed for the endpoint (for example,
a transcoder or RSVPAgent).

If both TRP and MTP are required for the endpoint,
TRP gets used as the required MTP.

Use Trusted Relay Point
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From the drop-down list, choose the BLF Audible
Alert setting that you want to use from the following
values:

• On

• Off

• Default

This parameter provides an audible alert in addition
to a visual alert on a phone that is currently idle when
a call comes in to one of the lines that is monitored
by way of a busy lamp field (BLF) button.

This is a required field.

BLF Audible Alert Setting (Phone Idle)

This parameter for this required field provides an
audible alert in addition to a visual alert on a phone
that is currently in use when a call comes in to one of
the lines that is monitored by way of a busy lamp field
(BLF) button.

From the drop-down list, choose the BLF Audible
Alert setting that you want to use from the following
values:

• On

• Off

• Default

BLF Audible Alert Setting (Phone Busy)

From the drop-down list, choose one of the following
options:

• Off—When the phone is idle and receives a call
on any line, the phone user answers the call from
the line on which the call is received.

• On—When the phone is idle (off-hook) and
receives a call on any line, the primary line gets
chosen for the call. Calls on other lines continue
to ring, and the phone user must select those
other lines to answer these calls.

• Default—Unified Communications Manager
uses the configuration from the Always Use
Prime Line service parameter, which supports
the Cisco CallManager service.

Always Use Prime Line
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From the drop-down list, choose one of the following
options:

• On—If the phone is idle, the primary line on the
phone becomes the active line for retrieving
voice messages when the phone user presses the
Messages button on the phone.

• Off—If the phone is idle, pressing the Messages
button on the phone automatically dials the
voice-messaging system from the line that has a
voice message. Unified Communications
Manager always selects the first line that has a
voice message. If no line has a voice message,
the primary line gets used when the phone user
presses the Messages button.

• Default—Unified Communications Manager
uses the configuration from the Always Use
Prime Line for VoiceMessage service parameter,
which supports the Cisco CallManager service.

Always Use Prime Line for Voice Message

From the drop-down list, choose a geo location.

You can choose the Unspecified geo location, which
designates that this device does not associate with a
geo location.

You can also choose a geolocation that has been
configured with the System > Geolocation
Configuration menu option.

Geo Location

Choose the Feature Control Policy for this group of
phones.

A feature control policy specifies the appearance of
features and the associated softkeys that are displayed
on the phone.

Feature Control Policy
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From the drop-down list, choose the mode that you
want to set for the device:

Use System Default—The phone uses the value that
you specified for the enterprise parameter, Device
Security Mode.

Non-secure—No security features exist for the phone.
A TCP connection opens to Unified Communications
Manager.

Authenticated—Unified Communications Manager
provides integrity and authentication for the phone.
A TLS connection that uses NULL/SHA opens.

Encrypted—Unified Communications Manager
provides integrity, authentication, and encryption for
the phone. A TLS connection that uses AES128/SHA
opens.

This field displays only if the phone model supports
authentication or encryption.

Device Security Mode

This check box applies only to video endpoints that
receive a call. If this phone receives a call that does
not connect as video, the call tries to connect as an
audio call.

By default, the system checks this check box to
specify that this device should immediately retry a
video call as an audio call (if it cannot connect as a
video call) prior to sending the call to call control for
rerouting.

If you uncheck this check box, a video call that fails
to connect as video does not try to establish as an
audio call. The call then fails to call control, and call
control routes the call via Automatic Alternate
Routing (AAR) and/or route/hunt list.

Retry Video Call as Audio

Check this check box to configure call display
restrictions on a call-by-call basis. When this check
box is checked, Unified Communications Manager
ignores any presentation restriction that is received
for internal calls.

Ignore Presentation Indicators (Internal Calls Only)
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Check this check box to allow control of all CTI
controllable devices from CTI.

You can enable or disable this check box based on
CTI Controllable Device Type and Device Protocol.

Cisco dual-mode devices (Jabber) such
as Android, iPhone, and iPad operating
in WiFi mode are monitored through
CTI and not controlled. However,
devices operating in GSMmode cannot
be monitored or controlled.

Note

Allow Control of Device from CTI

This check box, which gets checked by default for all
phones, indicates that the phone is currently logged
in to a hunt list (group). When the phone gets added
to a hunt list, the administrator can log the user in or
out by checking (and unchecking) this check box.

Users use the softkey on the phone to log their phone
in or out of the hunt list.

Logged into Hunt Group

If you are experiencing delayed connect times over
SCCP to remote sites, check the Remote Device check
box in the Phone Configuration window. Checking
this check box tells Unified CommunicationsManager
to allocate a buffer for the phone device when it
registers and to bundle SCCP messages to the phone.

Because this feature consumes resources, be sure to
check this check box only when you are experiencing
signaling delays for phones that are running SCCP.
Most users do not require this option.

Remote Device

Check this check box to designate a phone as
“protected.” This enables the phone to play a
two-second tone notifying the user when a call is both
encrypted and both phones are configured as protected
devices. The tone plays for both parties when the call
is answered. The tone does not play unless both
phones are “protected” and the call occurs over
encrypted media.

For a detailed description of the
secure-tone feature and the configuration
requirements, see the Cisco Unity
Connection System Administration
Guide.

Tip

Protected Device
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Check this check box to make this device a Hotline
device. Hotline devices can only connect to other
Hotline devices. This feature is an extension of PLAR,
which configures a phone to automatically dial one
directory number when it goes off-hook. Hotline
provides additional restrictions that you can apply to
devices that use PLAR.

To implement Hotline, you must also create a softkey
template without supplementary service softkeys, and
apply it to the Hotline device.

Hotline Device

Number Presentation Transformation

Caller ID for Calls from This Phone

From the drop-down list, choose the calling search
space (CSS) that contains the calling party
transformation pattern that you want to apply on the
calling number when this phone initiates a call.

When this phone initiates a call, Unified
CommunicationsManager transforms the calling party
using the digit transformations that are configured on
the matching calling party transformation pattern.
This setting allows you to transform the calling party
number before Unified Communications Manager
routes the call. For example, a transformation pattern
can change a phone extension to an E.164 number.
This setting is generally configured when users dial
using a URI instead of digits. Unified
Communications Manager allows calling party
transformations on various patterns when users dial
using digits; this setting provides similar
transformation provision even when users dial using
a URI.

Calling Party Transformation CSS

Check this check box to use the Calling Party
Transformation CSS that is configured at the device
pool to which this phone belongs for transforming the
calling party for calls that are initiated from this
phone. At the device pool, the Calling Party
Transformation CSS that is present under Phone
Settings is used to transform the calling party for calls
initiated from this phone.

Leave this check box unchecked to apply the Calling
Party Transformation CSS setting that appears in this
configuration window.

Use Device Pool Calling Party Transformation CSS
(Caller ID for Calls from This Phone)

Remote Number Transformation

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
45

Phones
BAT Phone Template Field Descriptions



DescriptionField

From the drop-down list, choose the calling search
space (CSS) that contains the calling party
transformation pattern that you want to apply on the
remote calling number for the calls that are received
on this phone.

Unified Communications Manager transforms the
remote calling number using the digit transformations
that are configured on the matching calling party
transformation pattern before presenting it to this
device.

For example, a transformation pattern can change a
remote number in E.164 format to a localized version.

Use this setting to transform the remote connected
number for direct calls that are initiated from this
phone. Use this setting also to transform a remote
connected number after you invoke the feature
irrespective of the direction of the call. The
transformation of the remote connected number is
controlled using the service parameter “Apply
Transformations on Remote Number,” present under
the Advanced section of Cisco Call Manager service.
For more information, refer to the description for this
parameter.

Calling Party Transformation CSS

Check this check box to apply the Calling Party
Transformation CSS that is configured at the device
pool to which this phone belongs for transforming the
remote calling and remote connected number. At the
device pool, the Calling Party Transformation CSS
present under Device Mobility Related Information
section is used to transform the remote calling and
remote connected number.

Leave this check box unchecked to apply the Calling
Party Transformation CSS setting that appears in this
configuration window for transforming the remote
number.

Use Device Pool Calling Party Transformation CSS
(Device Mobility Related Information)

Associated Mobility Identity —These mobility fields are available only for Nokia S60 device and Cisco
Unified Mobile Communicator phones. Click the Add New Mobile Identity link to display the Mobile
Identity Configuration page.

Enter a name that identifies the mobile identity.Name
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Enter the telephone number for the identity. Include
the area code and any additional digits that are
required to obtain an outside line. Maximum field
length equals 24 characters; individual characters can
take the values 0-9, *, and #. Cisco recommends that
you configure the caller ID of the smart phone
destination.

Add the necessary translation pattern or route patterns
to route the destination number.

Destination Number

Enter the minimum time in milliseconds that must
pass before the mobile phone can be answered.

Range: 0 - 10,000 milliseconds

Default: 1,500 milliseconds

Answer Too Soon Timer

Enter the maximum time in milliseconds that can pass
before the mobile phone must be answered.

Range: 10,000 - 300,000 milliseconds

Default: 19,000 milliseconds

Answer Too Late Timer

Enter the time that elapses before the mobile phone
rings when a call is transferred from the desktop
phone.

Range: 0 - 30,000 milliseconds

Default: 4,000 milliseconds

Delay Before Ringing Timer

From the drop-down list, choose a time-of-day access
record to associate with this destination.

Time of Day Access

From the drop-down list, choose a time zone to use
for this remote destination.

The time zone that you use for this
remote destination is used by the
time-of-day access feature to allow or
block calls to this destination.

Note

Time Zone

Check the check box if you want calls that are
answered by the desktop phone to be sent to your
mobile phone as the remote destination.

Youmust check this check box for Cisco
Unified Mobility to work with this
remote destination.

Note

Mobile Phone

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
47

Phones
BAT Phone Template Field Descriptions



DescriptionField

Check the check box to allow an incoming call to ring
your desktop phone and remote destination at the same
time.

Enable Cisco Unified Mobility

Associated Remote Destinations— Click the Add a New Remote Destination link to display the Remote
Destination Configuration page

Enter a name that identifies the remote destination.Name

Enter the telephone number for the destination.
Include the area code and any additional digits that
are required to obtain an outside line. Maximum field
length equals 24 characters; individual characters can
take the values 0-9, *, and #. Cisco recommends that
you configure the caller ID of the remote destination.

Add the necessary translation pattern or route patterns
to route the destination number.

Destination Number

Enter the minimum time in milliseconds that must
pass before the mobile phone can be answered.

Range: 0 - 10,000 milliseconds

Default: 1,500 milliseconds

Answer Too Soon Timer

Enter the maximum time in milliseconds that can pass
before the mobile phone must be answered.

Range: 10,000 - 300,000 milliseconds

Default: 19,000 milliseconds

Answer Too Late Timer

Enter the time that elapses before the mobile phone
rings when a call is transferred from the desktop
phone.

Range: 0 - 30,000 milliseconds

Default: 4,000 milliseconds

Delay Before Ringing Timer

From the drop-down list, choose a time-of-day access
record to associate with this remote destination.

Time of Day Access

From the drop-down list, choose a time zone to use
for this remote destination.

The time zone that you use for this
remote destination is used by the
time-of-day access feature to allow or
block calls to this remote destination.

Note

Time Zone
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Check the check box if you want calls that are
answered by the desktop phone to be sent to your
mobile phone as the remote destination.

Youmust check this check box for Cisco
Unified Mobility to work with this
remote destination.

Note

Mobile Phone

Check the check box to allow an incoming call to ring
your desktop phone and remote destination at the same
time.

Enable Cisco Unified Mobility

Protocol Specific Information

From the drop-down list, choose the mode that you
want to set for signal packet capture:

• None—Choose None if you do not want to
specify a mode.

• Real-Time Mode—Use this mode for real-time
signal packet capture.

• Batch Processing Mode—Use this mode for
batch processing signal packet capture mode.

Packet Capture Mode

Enter the time for packet capture in minutes. You can
enter a maximum duration of 300minutes. The default
duration specifies 60 minutes.

Packet Capture Duration

Used with the BLF Presence feature, the phone that
is running SIP or SCCP serves as a watcher because
it requests status about the presence entity; for
example, directory number, that is configured as a
BLF speed dial button on the phone.

If you want the phone to receive the status of the
presence entity, choose a BLF Presence group that is
allowed to view the status of the Presence group that
is applied to the directory number, as indicated in the
BLF Presence Group Configuration window.

BLF Presence Group
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If required, choose the appropriate SIP dial rule. SIP
dial rules provide local dial plans for Cisco IP phones
7940, and 7975 that are running SIP, so users do not
have to press a key or wait for a timer before the call
gets processed.

Leave the SIP Dial Rules field set to <None> if you
do not want dial rules applied to the IP phone that is
running SIP. This means the user will have to use the
Dial softkey or wait for the timer to expire before the
call gets processed.

SIP Dial Rules

For phones that are running SCCP or SIP, choose the
security profile that you want to apply to the device.

All phones require that you apply a security profile.
If the phone does not support security, choose a
nonsecure profile.

Device Security Profile

From the drop-down list, choose the codec to use if
a media termination point is required for SIP calls.

MTP Preferred Originating Codec

From the drop-down list, choose a calling search space
to use for rerouting.

The rerouting calling search space of the referrer gets
used to find the route to the refer-to target. When the
Refer fails due to the rerouting calling search space,
the Refer Primitive rejects the request with the “405
Method Not Allowed” message.

The redirection (3xx) primitive and transfer feature
also uses the rerouting calling search space to find the
redirect-to or transfer-to target.

Rerouting Calling Search Space

From the drop-down list, choose an out-of-dialog refer
calling search space.

Unified Communications Manager uses the
out-of-dialog (OOD) Refer Authorization calling
search space (CSS) to authorize the SIP out-of-dialog
Refer. The administrator can restrict the use of
out-of-dialog Refer by configuring the OOD CSS of
the Referrer. Refer Primitive rejects the OOD Refer
request with a “403 Forbidden” message.

Out-of-Dialog Refer Calling Search Space

Used with the Presence feature, the SUBSCRIBE
Calling Search Space determines how Unified
Communications Manager routes the subscription
requests that come from the phone. From the
drop-down list, choose the calling search space that
you want to use for this purpose.

SUBSCRIBE Calling Search Space
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Choose the default SIP profile or a specific profile
that was previously created. SIP profiles provide
specific SIP information for the phone such as default
telephony event payload type, registration and
keepalive timers, media ports, Iris, and dynamic DNS
server addresses.

SIP Profile

Used with digest authentication (SIP security), choose
an end user that you want to associate with the phone.

Ensure that you configured digest credentials for the
user that you choose, as specified in the End User
Configuration window.

After you save the phone configuration and reset the
phone, the digest credentials for the user get added to
the phone configuration file.

For more information on digest authentication, refer
to the Cisco Unified Communications Manager
Security Guide.

Digest User

Use this field to indicate whether a media termination
point is used to implement features that H.323 does
not support (such as hold and transfer).

Check the Media Termination Point Required check
box if you want to use anMTP to implement features.
Uncheck theMedia Termination Point Required check
box if you do not want to use an MTP to implement
features.

Use this check box only for H.323 clients and those
H.323 devices that do not support the H.245 empty
capabilities set or if you want media streaming to
terminate through a single source.

Media Termination Point Required

Check this check box to indicate an unattended port
on this device.

Unattended Port

For phones that are running SIP and SCCP, check this
check box to require DTMF reception for this phone.

Require DTMF Reception

For phones that are running SCCP, check this check
box to disable RFC2833 support.

RFC2833 Disabled

Certification Authority Proxy Function (CAPF) Information (These parameters display only for devices
with the capability to support authentication or encryption.)
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From the drop-down list, choose the Certification
Operation that youwant to perform from the following
options:

• No Pending Operation—No pending
Certification Operation lists exist for this device.
Choosing this option disables the remaining
CAPF fields.

• Install/Upgrade—Install or upgrade a
Certification Operation.

• Delete—Delete a Certification Operation.

• Troubleshoot—Troubleshoot a Certification
Operation.

Certificate Operation
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From the drop-down list, choose the Authentication
Mode by which you want the phone to authenticate
with CAPF during the certificate operation from the
following options:

• By Null String—Install/upgrade, delete, or
troubleshoot a locally significant certificate
without user intervention.

• <None>

This option prompts you to specify a
value for the Authentication Mode.

Note

• By Authentication String—Installs/upgrades,
deletes, or troubleshoots a locally significant
certificate only when the user enters the CAPF
authentication string on the phone.

• By Existing Certificate (precedence to
LSC)—Installs or upgrades, deletes, or
troubleshoots a locally significant certificate if
a manufacture-installed certificate (MIC) or
locally significant certificate (LSC) exists in the
phone.

Before you choose this option, verify
that a certificate exists in the phone. If
you choose this option and no certificate
exists in the phone, the operation fails.

Note

• By Existing Certificate (precedence to
MIC)—Installs/upgrades, deletes, or
troubleshoots a locally significant certificate if
a LSC or MIC exists in the phone.

Before you choose this option, verify
that a certificate exists in the phone. If
you choose this option and no certificate
exists in the phone, the operation fails.

Note

Authentication Mode

If you chose the ByAuthentication String option from
the Authentication Mode drop-down list in the
security profile, this setting applies. Manually enter
a numeric string that contains 4 to 10 digits. To install,
upgrade, or troubleshoot a locally significant
certificate, the phone user or administrator must enter
the authentication string on the phone.

Authentication String
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This field specifies the sequence of the key for CAPF.
Select one of the following values from the drop-down
list:

• RSA Only

• EC Only

• EC Preferred, RSA Backup

When you add a phone based on the
value in Key Order, RSA Key Size,
and EC Key Size fields, the device
security profile is associated with the
phone. If you select the EC Only value
with the EC Key Size value of 256 bits
then the device security profile appends
with EC-256 value.

Note

Key Order

From the drop-down list, choose one of the these
values—512, 1024, 2048, 3072, or 4096.

Some phone models may fail to register
if the RSA key length selected for the
CallManager Certificate Purpose is
greater than 2048. From the Unified CM
Phone Feature List Report on the Cisco
Unified Reporting Tool (CURT), you
can check the 3072/4096 RSA key size
support feature for the list of supported
phone models.

Note

RSA Key Size (Bits)

From the drop-down list, choose one of the these
values—256, 384, or 521.

EC Key Size (Bits)

This field, which supports the Install/Upgrade, Delete,
and Troubleshoot Certificate Operation options,
specifies the date and time in which you must
complete the operation.

Operation Completes By

This field displays the progress of the certificate
operation; for example, <operation type> pending,
failed, or successful, where operating type equals the
Install/Upgrade, Delete, or Troubleshoot Certificate
Operation options. You cannot change the information
that displays in this field.

Certificate Operation Status

Expansion Module Information

Choose the expansion module if it is installed in the
phone.

Module 1
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Enter the firmware load for the first
CiscoUnifiedIPPhone Expansion Module, if
applicable. Leave this field blank to use the default
load.

Module1 Load Name

Choose the expansion module if it is installed in the
phone.

Module 2

Enter the firmware load for the second
CiscoUnifiedIPPhone Expansion Module, if
applicable. Leave this field blank to use the default
load.

Module 2 Load Name

CiscoUnifiedIPPhone - External Data Locations

Enter the help text URL for the information button
for CiscoUnifiedIPPhones.

Information

Enter the URL of the directory server for
CiscoUnifiedIPPhones.

Directory

Enter the voice-messaging access pilot number for
CiscoUnified IPPhones.

Messages

Enter the URL for the services menu for
CiscoUnifiedIPPhones.

Services

Enter the URL that the phone uses to validate requests
that are made to the phones web server. If you do not
provide an authentication URL, the advanced features
on the CiscoUnifiedIPPhone models that require
authentication will not function. Leave this field blank
to accept the default setting.

By default, this URL accesses a Cisco Unified
Communications Self Care Portal window that was
configured during installation.

Authentication Server

Enter the host and port (for example,
proxy.cisco.com:80) that are used to proxy HTTP
requests for access to non-local host addresses from
the phones HTTP client.

If the phone receives a URL such as www.cisco.com
in a service and the phone is not configured in the
cisco.com domain, the phone uses the proxy server
to access the URL. If the phone is configured in the
cisco.com domain, the phone accesses the URL
without using the proxy because it is in the same
domain as the URL.

Leave this field blank to accept the default setting.

Proxy Server
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Enter the URL of the XML service that will appear
as the idle display on the CiscoUnifiedIPPhone LCD
screen when the Phone has not been used for the time
that is specified in the Idle Timer field. For example,
you can display a logo on the LCD screen when the
phone has not been used for 5 minutes. Leave this
field blank to use the default value.

Idle

Enter the seconds that you want to elapse before the
phone displays the URL that is specified in the Idle
field. Leave this field blank to use the default value.

Idle Timer

Enter the secure URL that the phone uses to validate
requests that are made to the phone web server.

If you do not provide a Secure
Authentication URL, the device uses the
nonsecure URL. If you provide both a
secure URL and a nonsecure URL, the
device chooses the appropriate URL,
based on its capabilities.

Note

By default, this URL accesses a Cisco Unified CM
User Options window that was configured during
installation.

Leave this field blank to accept the default setting.

Maximum length: 255

Secure Authentication URL

Enter the secure URL for the server from which the
phone obtains directory information. This parameter
specifies the URL that secured Cisco Unified IP
Phones use when you press the Directory button.

If you do not provide a Secure Directory
URL, the device uses the nonsecure
URL. If you provide both a secure URL
and a nonsecure URL, the device
chooses the appropriate URL, based on
its capabilities.

Note

Leave this field blank to accept the default setting.

Maximum length: 255

Secure Directory URL
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Enter the secure URL for the information that displays
on the Cisco Unified IP Phone display when the phone
is idle, as specified in Idle Timer field. For example,
you can display a logo on the LCD when the phone
has not been used for 5 minutes.

If you do not provide a Secure Idle URL,
the device uses the nonsecure URL. If
you provide both a secure URL and a
nonsecure URL, the device chooses the
appropriate URL, based on its
capabilities.

Note

To accept the default setting, leave this field blank.

Maximum length: 255

Secure Idle URL

Enter the secure URL for the server location where
the Cisco Unified IP Phone can find help text
information. This information displays when the user
presses the information (i) button or the questionmark
(?) button.

If you do not provide a Secure
Information URL, the device uses the
nonsecure URL. If you provide both a
secure URL and a nonsecure URL, the
device chooses the appropriate URL,
based on its capabilities.

Note

To accept the default setting, leave this field blank.

Maximum length: 255

Secure Information URL

Enter the secure URL for the messages server. The
Cisco Unified IP Phone contacts this URL when the
user presses the Messages button.

If you do not provide a SecureMessages
URL, the device uses the nonsecure
URL. If you provide both a secure URL
and a nonsecure URL, the device
chooses the appropriate URL, based on
its capabilities.

Note

To accept the default setting, leave this field blank.

Maximum length: 255

Secure Messages URL
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Enter the secure URL for Cisco Unified IP Phone
services. The is the location that the secure Cisco
Unified IP Phone contacts when the user presses the
Services button.

If you do not provide a Secure Services
URL, the device uses the nonsecure
URL. If you provide both a secure URL
and a nonsecure URL, the device
chooses the appropriate URL, based on
its capabilities.

Note

To accept the default setting, leave this field blank.

Maximum length: 255

Secure Services URL

Extension Mobility (Device Profile) Information

Check this check box to enable the extension mobility
feature. Extension mobility allows a user to log in and
out of a CiscoIPPhone.

Enable Extension Mobility

Choose the profile that a phone should load when an
extension mobility user logs out. You must configure
logout profiles in Unified Communications Manager
Administration.

Use Current Device Setting—This choice creates an
autogenerated device profile as the default device
profile.

Select a User Device Profile—This choice assigns a
user device profile, which has already been defined,
that becomes the default device profile for this device.

The chosen user device profile gets loaded onto the
device when no user is logged in.

Log Out Profile

MultiLevel Precedence and Preemption (MLPP) Information
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If available, this setting specifies whether a device
that is capable of playing precedence tones will use
the capability when it places an MLPP precedence
call.

From the drop-down list, choose a setting to assign
to this device from the following options:

• Default—This device inherits its MLPP
indication setting from its device pool.

• Off—This device does not send indication of an
MLPP precedence call.

• On—This device does send indication of an
MLPP precedence call.

Do not configure a device with the
following combination of settings:
MLPP Indication is set to Off while
MLPP Preemption is set to Forceful.

Note

MLPP Indication

If available, this setting specifies whether a device
that is capable of preempting calls in progress will
use the capability when it places anMLPP precedence
call.

From the drop-down list, choose a setting to assign
to this device from the following options:

• Default—This device inherits its MLPP
preemption setting from its device pool.

• Disabled—This device does not preempt calls
in progress when it places an MLPP precedence
call.

• Forceful—This device preempts calls in progress
when it places an MLPP precedence call.

Do not configure a device with the
following combination of settings:
MLPP Indication is set to Off while
MLPP Preemption is set to Forceful.

Note

MLPP Preemption

Enter a hexadecimal value for the MLPP domain that
is associated with this device. Ensure that this field is
blank or a value between 0 and FFFFFF.

MLPP Domain (e.g., “0000FF”)

H.323 Device Information
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The value designates the H.225 signaling port that
this device uses.

The default value specifies 1720. Valid values include
1 through 65535.

Signaling Port

This check box applies only to video endpoints that
receive a call. If this phone receives a call that does
not connect as video, the call tries to connect as an
audio call.

By default, the system checks this check box to
specify that the sending device should immediately
retry a video call that does not connect as an audio
call prior to sending the call to call control for
rerouting.

If you uncheck this check box, a video call that fails
to connect as video fails to call control. At this point,
call control reroutes the call within the route list. If
Automatic Alternate Routing (AAR) is configured
and enabled, call control also reroutes the call between
route lists.

Retry Video Call as Audio

By default, the system keeps this check box checked
to specify that Unified Communications Manager
should initiate capabilities exchange. This check box
specifies that the Unified Communications Manager
needs to receive the far-end H.245 Terminal
Capability Set before it sends its H.245 Terminal
Capability Set.

Wait for Far End H.245 Terminal Capability Set

H.323 Protocol Specific Information

When this check box is checked, ensure that IPSec is
configured in the network to provide end-to-end
security. Failure to do so will expose keys and other
information.

SRTP Allowed

From the drop-down list, choose the codec to use if
a media termination point is required for SIP calls.

MTP Preferred Originating Codec
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Use this field to indicate whether a media termination
point (MTP) is used to implement features that H.323
does not support (such as hold and transfer).

Check the Media Termination Point Required check
box if you want to use a media termination point to
implement features. Uncheck the Media Termination
Point Required check box if you do not want to use
a media termination point to implement features.

Use this check box only for H.323 clients and those
H.323 devices that do not support the H.245 empty
capabilities set or if you want media streaming to
terminate through a single source.

If you check this check box to require an MTP and
this device becomes the endpoint of a video call, the
call works as audio only.

Media Termination Point Required

H.323 Information

For incoming calls to the phone, enter the pattern,
from 0 to 24 digits, that you want to use for caller ID.

Outgoing Caller ID Pattern

Choose one of the following options to specify which
directory number is sent:

• Originator—Send the directory number of the
calling device.

• First Redirect Number-—Send the directory
number of the redirecting device.

• Last Redirect Number—Send the directory
number of the last device to redirect the call.

• First Redirect Number(external)—Send the
directory number of the redirecting device.

• Last Redirect Number(external)—Send the
directory number of the last device to redirect
the call.

Calling Party Selection
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Choose whether the central office transmits or blocks
caller ID:

• Choose Allowed if you want the central office
to send caller ID.

• Choose Restricted if you do not want the central
office to send caller ID.

• Default displays the caller ID unless the caller
ID was restricted in a previous level in the call
stream.

Calling Party Presentation

Check the check box to deliver the display information
element (IE) in SETUP and CONNECTmessages for
the calling and called party name delivery service.

Display IE Delivery

Check this check box to include the Redirecting
Number IE in the outgoing SETUPmessage from the
Unified CommunicationsManager to indicate the first
redirecting number and the redirecting reason of the
call when the call is forwarded.

Uncheck the check box to exclude the first redirecting
number and the redirecting reason from the outgoing
SETUP message.

Use Redirecting Number IE for voice-messaging
integration only. If your configured voice-messaging
system supports Redirecting Number IE, check the
check box.

Redirecting Number IE Delivery—Outbound

Use Redirecting Number IE when you are integrating
a voice-messaging system that supports Redirecting
Number IE.

Check this check box to accept the Redirecting
Number IE in the incoming SETUP message to the
Unified Communications Manager.

Uncheck the check box to exclude the Redirecting
Number IE in the incoming SETUP message to the
Unified Communications Manager.

Redirecting Number IE delivery—Inbound

Gatekeeper Information
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Choose the gatekeeper for the gatekeeper-controlled
H.323 device from the drop-down list.

If you do not choose the device, the
system disables the E.164, Technology
Prefix, and Zone fields.

Note

You cannot change the device to a
gatekeeper-controlled phone if more
than one directory number is configured
for the device.

Note

Gatekeeper Name

Choose the E.164 address that is registered with the
gatekeeper.

Ensure the H.323 client is configured as
a gatekeeper-controlled device.

Note

You must enter a value in this field for
a gatekeeper-controlled H.323 client.
You can enter only numbers (0-9) and
special characters # and * in this field.

Note

E.164

Enter the technology prefix to eliminate the need for
entering the IP address for every Unified
Communications Manager system when the
gw-type-prefix command is configured. For example,
you can enter 1#* in this field if you can use the
following gw-type-prefix command on the gatekeeper:

gw-type-prefix 1#* default-technology.

You must enter a value in this field for
a gatekeeper-controlled H.323 client.
You can enter only numbers (0-9) and
special characters # and * in this field.

Note

Technology Prefix

On the gatekeeper, enter the specific zone with which
Unified Communications Manager will register. The
zone specifies the total bandwidth that is available for
calls between this zone and another zone.

You must enter a value in this field for
a gatekeeper-controlled phone. You can
enter only letters, numbers, spaces,
dashes, dots, and underscores in this
field.

Note

Zone

Check this check box to configure the H.323 client
gatekeeper as a controlled gatekeeper.

Gatekeeper Controlled H.323 Client
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Do Not Disturb (DND)

Check this check box if you want DND to be enabled.Do Not Disturb

From the drop-down list, choose a DND option from
the following options:

• None

• Ringer Off

DND Option

From the drop-down list, choose one of the following
options:

• None

• Disable

• Flash Only

• Beep Only

DND Incoming Call Alert

Secure Shell Information

Enter a user ID for the secure shell user. If the phone
that you are configuring does not support secure shell
access, this field does not display. Cisco Technical
Assistance Center (TAC) uses secure shell for
troubleshooting. Contact TAC for further assistance.

Secure Shell User

Enter the password for a secure shell user. If the phone
you are configuring does not support secure shell
access, this field does not display. Contact TAC for
further assistance.

Secure Shell Password

Product-Specific Configuration

The device manufacturer specifies the model-specific
fields under product-specific configuration. Because
they are dynamically configured, they can change
without notice.

To view field descriptions and help for
product-specific configuration items, click the “?”
information icon to the right of the Product Specific
Configuration heading to display help in a popup
dialog box.

If you need more information, refer to the
documentation for the specific device that you are
configuring or contact the manufacturer.

Model-specific configuration fields defined by the
device manufacturers
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The following table provides descriptions of all possible fields that display when you add or update a line in
the BAT templates.

• BAT phone template

• Gateway template

• UDP template

• Remote destination template

Some device types do not require all the phone settings. Only some fields show the values that were configured
in Unified Communications Manager Administration. Field names that have an asterisk in the BAT user
interface require an entry. Treat fields that do not have an asterisk as optional.

Table 3: Field Descriptions for Adding a Line to a BAT Template

DescriptionField

Directory Number Information

Enter a unique name for the line template.

Be aware that this field is available only when you are adding a line
and not when you are updating an existing line.

Line Template Name

Choose a route partition to which the directory number belongs.

The directory number can appear in more than one
partition.

Note

Route Partition

Enter description for the line template. The description can include
up to 50 characters in any language, but it cannot include
double-quotes ("), percentage sign (%), ampersand ('), or angle
brackets (<>).

Description

This name represents the name that displays during an alert to a
shared directory number. For non-shared directory numbers, during
alerts, the system uses the name that is entered in theDisplay field.

Alerting Name

This field provides the same information as the Alerting Name field,
but you must limit input to ASCII characters. Devices that do not
support Unicode (internationalized) characters display the content
of the Alerting Name ASCII field.

Alerting Name ASCII

Checking this check box allows calls to this DN to be forwarded
(if forwarding is configured). If check box is not checked, Unified
Communications Manager ignores the DN.

Active

Directory Number Settings
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Choose this parameter to make the pilot number the same as the
directory number for this line. This action proves useful if you do
not have a voice-messaging server that is configured for this phone.

Voice Mail Profile

Choose partitions that are searched for numbers that are called from
this directory number.

Changes cause an update of Pickup Group Names that
are listed in theCall Pickup Group field. The setting
applies to all devices that are using this directory
number.

Note

Calling Search Space

Used with the Presence feature, the directory number serves as the
presence entity; that is, watchers request the status of the directory
number, so the real-time status of the directory number displays on
the device.

If you want the phone to receive the status of the presence entity,
make sure that the Presence group of the watcher is allowed to view
the status of the Presence group that is applied to the directory
number, as indicated in the Presence Group Configuration
window.

Presence Group

Choose the music on hold audio source to be played when the user
presses HOLD to place a call on hold.

User Hold MOH Audio Source

Choose the music on hold audio source to be played when the
system places a call on hold while the user transfers a call or initiates
a conference or call park.

Network Hold MOH Audio Source

Choose one of the following options to activate the Auto Answer
feature for this directory number:

• Auto Answer Off <Default>

• Auto Answer with Headset

• Auto Answer with Speakerphone

Make sure that the headset or speakerphone is not
disabled when you choose Auto Answer with headset
or Auto Answer with speakerphone.

Note

Do not configure Auto Answer for devices that have shared lines.

Auto Answer

AAR Settings—The settings in this row of fields specify treatment of calls for which insufficient bandwidth
exists to reach the destination. Automated alternate routing (AAR) handles these calls that are routed to the
AAR Destination Mask or Voice Mail.
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Check this check box to use settings in the Voice Mail Profile
Configuration window.

When this check box is checked, Unified
Communications Manager ignores the settings in the
Coverage/Destination box and Calling Search Space.

Note

AAR Voice Mail

Use this setting instead of the external phone number mask to
determine the AAR Destination to be dialed.

AAR Destination Mask

Choose the appropriate calling search space for the device to use
when it performs automated alternate routing (AAR). The AAR
calling search space specifies the collection of route partitions that
are searched to determine how to route a collected (originating)
number that is otherwise blocked due to insufficient bandwidth.

AAR CSS

Choose the automated alternate routing (AAR) group for this device.
The AAR group provides the prefix digits that are used to route
calls that are otherwise blocked due to insufficient bandwidth.

Set AAR Group to <None> to prevent rerouting blocked calls.

AAR Group

Checking this check box allows the AAR leg of the call to be present
in the Call History.

Retain this destination in the call
forwarding history

Use this field to configure the handset lamp illumination policy.
Choose one of the following options:

• Use System Policy (The directory number refers to the service
parameter “Message Waiting Lamp Policy” setting.)

• Light and Prompt

• Prompt Only

• Light Only

• None

Setting applies only to the current device unless you check the
Update Shared Device Settings check box and click the Propagate
Selected button. (The check box displays only if other devices share
this directory number.)

Visual Message Waiting Indicator
Policy

Use this field to configure an audible message waiting indicator
policy. Choose one of the following options:

• Off

• On—When you select this option, you will receive a stutter
dial tone when you take the handset off hook.

• Default—When you select this option, the phone uses the
default that was set at the system level.

Audible Message Waiting Indicator
Policy
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This field determines the type of notification an incoming call sends
to members of a call pickup group. If the called phone does not
answer, the phones in the call pickup group that are idle will either
hear a short ring (ring once) or hear nothing (disabled).

• Use System Default—The value of this field gets determined
by the setting of the Cisco CallManager service parameter Call
Pickup Group Audio Alert Setting of Idle Station.

• Disable—No alert is sent to members of the call pickup group.

• Ring Once—A short ring is sent to members of the call pickup
group.

Call Pickup Group Audio Alert Setting
(Phone Idle)

This field determines the type of notification an incoming call sends
to members of a call pickup group. If the called phone does not
answer, the phones in the call pickup group that are busy will either
hear a beep only or hear nothing (disabled).

• Use System Default—The value of this field gets determined
by the setting of the Cisco CallManager service parameter Call
Pickup Group Audio Alert Setting of Busy Station.

• Disable—No alert is sent to member of the call pickup group.

• Beep Only—A beep is sent to members of the call pickup
group.

Call Pickup Group Audio Alert Setting
(Phone Active)

This field determines the recording option on the line appearance
of an agent. By default, the recording option specifies Call
Recording Disabled.

Choose one of the following options:

• Call Recording Disabled—The calls that the agent makes on
this line appearance are not recorded.

• Automatic Call Recording Enabled—The calls that the agent
makes on this line appearance are automatically recorded.

• Application Invoked Call Recording Enabled—The calls that
the agent makes on this line appearance are recorded if an
application invokes calling recording.

When the recording option is set to either Automatic Call Recording
Enabled or Application Invoked Call Recording Enabled, the line
appearance can be associated with a recording profile.

When automatic recording is enabled, the application's recording
requests get rejected.

Recording Option

This field determines the recording profile on the line appearance
of an agent.

Recording Profile
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The monitoring calling search space of the supervisor line
appearance must include the agent line or device partition to allow
monitoring the agent.

Set the monitoring calling search space on the supervisor line
appearance window. Choose an existing calling search space from
the drop-down list box.

The default value specifies None.

Monitoring Calling Search Space

Call Forward and Pickup Settings

Check this check box if you want calls to forward to the number
that you chose in the voice-mail profile.

Checking this check box makes the Forward All Destination field
and Forward All Calling Search Space check box not relevant.

Forward All Voice Mail

Enter the directory number or directory URI to which all calls are
forwarded.

The setting applies to any dialable phone number,
including an outside destination unless restricted, and
to all devices that are using this directory number.

Note

Forward All Destination

Choose the calling search space to use when calls are forwarded to
the specified destination.

This setting applies to all devices that are using this
directory number.

Note

Forward All Calling Search Space

Choose the secondary calling search space (CSS) from the
drop-down list box.

Because Call Forwarding is a line-based feature, in cases where the
device calling search space is unknown, the system uses only the
line calling search space to forward the call. If the line calling search
space is restrictive and not routable, the forward attempt fails.

Addition of a secondary calling search space for Call Forward All
provides a solution to enable forwarding. The primary calling search
space for Call Forward All and secondary calling search space for
Call Forward All get concatenated (Primary CFACSS + Secondary
CFA CSS) when Call Forward All is processed. Unified
Communications Manager uses this combination to validate the
CFA destination and to forward the call.

Secondary Calling Search Space for
Forward All

Check this check box if you want calls from an internal number to
be forwarded to a number that you chose in the voice-mail profile.

Checking this check box makes the Forward Busy Internal
Destination field and Calling Search Space check box not relevant.

Forward Busy Internal Voice Mail
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Enter the directory number or directory URI to which an internal
call is forwarded when the line is in use.

This setting applies to any internal, dialable phone
number and to all devices that are using this directory
number.

Note

Forward Busy Internal Destination

Choose the calling search space to use when internal calls are
forwarded to the specified destination.

This setting applies to all devices that are using this
directory number.

Note

Forward Busy Internal Calling Search
Space

Check this check box if you want calls from an external number to
be forwarded to a number that you chose in the voice-mail profile.

Checking this check box makes the Forward Busy External
Destination field andCalling Search Space check box not relevant.

Forward Busy External Voice Mail

Enter the directory number or directory URI to which an external
call is forwarded when the line is in use.

This setting applies to any dialable external phone
number, including an outside destination unless
restricted, and to all devices that are using this
directory number.

Note

Forward Busy External Destination

Choose the calling search space to use when external calls are
forwarded to the specified destination.

This setting applies to all devices that are using this
directory number.

Note

Forward Busy External Calling Search
Space

Check this check box if you want calls from an internal number
forwarded to the number that you chose in the voice-mail profile.

Checking this check box makes the Forward No Answer Internal
Destination field andCalling Search Space check box not relevant.

Forward No Answer Internal Voice
Mail

Enter a directory number or directory URI to which an internal call
is forwarded when the phone is not answered.

This setting applies to any internal, dialable phone
number and to all devices that are using this directory
number.

Note

Forward No Answer Internal
Destination

Choose the calling search space to use when internal calls are
forwarding to the specified destination. The setting displays only
if it is configured in the system.

This setting applies to all devices that are using this
directory number.

Note

Forward No Answer Internal Calling
Search Space
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Check this check box if you want calls to forward to an external
number that you chose in the voice-mail profile.

Checking this check box makes the Forward No Answer
Externally Destination field and External Calling Search Space
check box not relevant.

Forward No Answer External Voice
Mail

Enter a directory number or directory URI to which an external call
is forwarded when the phone is not answered.

This setting applies to any external, dialable phone
number, including an outside destination unless
restricted, and to all devices that are using this
directory number.

Note

Forward No Answer External
Destination

Choose the calling search space to use when external calls are
forwarded to the specified destination. The setting displays only if
it is configured in the system.

This setting applies to all devices that are using this
directory number.

Note

Forward No Answer External Calling
Search Space

Check this check box if you want calls from an internal number
forwarded to the number that you chose in the voice-mail profile.

Checking this check box makes the Forward No Answer
Destination field andCalling Search Space check box not relevant.

Forward No Coverage Internal Voice
Mail

Enter a directory number or directory URI to which an internal call
is forwarded when the phone has no coverage.

This setting applies to any internal, dialable phone
number and to all devices that are using this directory
number.

Note

Forward No Coverage Internal
Destination

Choose the calling search space to use when internal calls are
forwarded to the specified destination. The setting displays only if
it is configured in the system.

This setting applies to all devices that are using this
directory number.

Note

Forward No Coverage Internal Calling
Search Space

Check this check box if you want calls from an external number to
be forwarded to the number that you chose in the voice-mail profile.

Checking this check box makes the Forward No Answer
Destination field andCalling Search Space check box not relevant.

Forward No Coverage External Voice
Mail
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Enter a directory number or directory URI to which an external call
is forwarded when the phone has no coverage.

This setting applies to any dialable phone number,
which includes an outside destination unless restricted,
and to all devices that are using this directory number.

Note

Forward No Coverage External
Destination

Choose the calling search space to use when external calls are
forwarded to the specified destination. The setting displays only if
it is configured in the system.

This setting applies to all devices that are using this
directory number.

Note

ForwardNoCoverage External Calling
Search Space

The Forward on CTI Failure field applies only to CTI route points
and CTI ports. The settings in this row specify the forwarding
treatment for external calls to this CTI route point or CTI port if
the CTI route point or CTI port fails.

Check this check box to use settings in the Voice Mail Profile
Configuration window.

When this check box is checked, Unified CommunicationsManager
ignores the settings in the Destination box and Calling Search
Space.When this check box is checked for internal calls, the system
automatically checks the Voice Mail check box for external calls.
If you do not want external calls to forward to the voice-messaging
system, you must uncheck the Voice Mail check box for external
calls.

Forward on CTI Failure Voice Mail

This setting specifies the directory number or directory URI to
which an internal, nonconnected call is forwarded when an
application that controls that directory number fails. Use any dialable
phone number, including an outside destination.

When you enter a destination value for internal calls, the system
automatically copies this value to theDestination field for external
calls. If you want external calls to forward to a different destination,
you must enter a different value in theDestination field for external
calls.

Forward on CTI Failure Destination

This setting applies to all devices that are using this directory
number.

When you choose a Calling Search Space for internal calls, the
system automatically copies this setting to the Calling Search Space
setting for external calls. If you want external calls to forward to a
different calling search space, choose a different setting in the
Calling Search Space for external calls.

Forward on CTI Failure Calling Search
Space

Enter the number of seconds to allow the call to ring before the
system forwards the call to the Forward No Answer Destination.

No Answer Ring Duration
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Choose a Pickup Group Name to specify the call pickup group,
which can answer incoming calls to this directory number by dialing
the appropriate pickup group number.

Call Pickup Group

Park Monitoring

When the parkee is an external party, then the call will be forwarded
to the specified destination in the parker’s ParkMonitoring Forward
No Retrieve Destination External parameter. If the Park
Monitoring Forward No Retrieve Destination External field
value is empty, the parkee will be redirected to the parker’s line.

Park Monitoring Forward No Retrieve
Destination External

When the parkee is an internal party, then the call will be forwarded
to the specified destination in the parker’s ParkMonitoring Forward
No Retrieve Destination Internal parameter. If thePark Monitoring
Forward No Retrieve Destination Internal field value is empty,
the parkee will be redirected to the parker’s line.

Park Monitoring Forward No Retrieve
Destination Internal

This parameter determines the number of seconds that Unified
Communications Manager waits before prompting the user to
retrieve a call that the user parked. This timer starts when the user
presses the Park softkey on the phone, and a reminder is issued
when the timer expires.

Default: 60 seconds

If you configure a non-zero value, this value overrides
the value of this parameter set in the Service
Parameters window. However, if you configure a
value of 0 here, then the value in the Service
Parameters window will be used.

Note

Park Monitoring Reversion Timer

Check this check box to use settings in the Voice Mail Profile
Configuration window.

When this check box is checked, Unified
Communications Manager ignores the settings in the
Destination box and Calling Search Space.

Note

Park Monitoring Forward No Retrieve
Internal Voice Mail

Check this check box to use settings in the Voice Mail Profile
Configuration window.

When this check box is checked, Unified
Communications Manager ignores the settings in the
Destination box and Calling Search Space.

Note

Park Monitoring Forward No Retrieve
Destination External Voice Mail

Choose the calling search space to apply to the directory number.Park Monitoring Forward No Retrieve
External CSS

Choose the calling search space to apply to the directory number.Park Monitoring Forward No Retrieve
Internal CSS
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This field applies to unregistered internal DN calls. The calls are
rerouted to a specified Destination Number or Voice Mail.

Check this check box if you want calls from an unregistered internal
number to be forwarded to a number that you chose in the voice-mail
profile.

Checking this check boxmakes theForward Unregistered Internal
Destination field and Calling Search Space drop-down list box
not relevant.

Forward Unregistered Internal Voice
Mail

Enter the directory number to which an unregistered internal call
is forwarded when the line is in use.

This setting applies to any internal, dialable phone number and to
all devices that are using this directory number.

Forward Unregistered Internal
Destination

Choose the calling search space to use when unregistered internal
calls are forwarded to the specified destination.

This setting applies to all devices that are using this directory
number.

Forward Unregistered Internal CSS

This field applies to unregistered external DN calls. The calls are
rerouted to a specified Destination Number or Voice Mail.

You must also specify the maximum number of
forwards in the Service Parameters Configuration
window for a Directory Number.

Note

Forward Unregistered External Voice
Mail

Enter the directory number to which an external call is forwarded
when the line is in use.

This setting applies to any dialable external phone number, including
an outside destination unless restricted, and to all devices that are
using this directory number.

Forward Unregistered External
Destination

Choose the calling search space to use when external calls are
forwarded to the specified destination.

This setting applies to all devices that are using this directory
number.

Forward Unregistered External CSS

Multilevel Precedence and Preemption Alternate Party Settings

Enter the number to which MLPP precedence calls should be
directed if this directory number receives a precedence call and
neither this number nor its call forward destination answers the
precedence call.

Values can include numeric characters, pound (#), and asterisk (*).

Target (Destination)

From the drop-down list box, choose the calling search space to
associate with the alternate party target (destination) number.

MLPP Calling Search Space
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Enter the number of seconds (between 4 and 30) after which an
MLPP precedence call will get directed to the alternate party of this
directory number if this directory number and its call forwarding
destination have not answered the precedence call.

Leave this setting blank to use the value that is set in the Unified
Communications Manager enterprise parameter, Precedence
Alternate Party Timeout.

MLPP No Answer Ring Duration
(Seconds)

Line Settings for This Phone

Use this field only if you do not want the directory number to show
on the line appearance. Enter text that identifies this directory
number for a line/phone combination.

Suggested entries include name of the boss, department, or other
appropriate information to identify multiple directory numbers to
secretary/assistant who monitors multiple directory numbers.

Display (Internal Caller ID)

This field provides the same information as the Display (Internal
Caller ID) field, but you must limit input to ASCII characters.
Devices that do not support Unicode (internationalized) characters
display the content of the ASCII Display (Internal Caller ID)
field.

Setting applies only to the current device unless you check the check
box at right (Update Shared Device Settings) and click the
Propagate Selected button. (The check box at right displays only
if other devices share this directory number.)

ASCII Display (Internal Caller ID)

Enter text that identifies this directory number for a line/phone
combination.

The default language specifies EnglishNote

Line Text Label

Enter the phone number (or mask) that is sent for Caller ID
information when a call is placed from this line.

You can enter a maximum of 24 numbers and “X” characters. The
Xs represent the directory number and must appear at the end of
the pattern. For example, if you specify a mask of 972813XXXX,
an external call from extension 1234 displays a caller ID number
of 9728131234.

External Phone Number Mask
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Use this field to configure the handset lamp illumination policy.
Choose one of the following options:

• Use System Policy (The directory number refers to the service
parameter “Message Waiting Lamp Policy” setting.)

• Light and Prompt

• Prompt Only

• Light Only

• None

Setting applies only to the current device unless you check the
Update Shared Device Settings check box and click thePropagate
Selected button. (The check box displays only if other devices share
this directory number.)

Visual Message Waiting Indicator
Policy

Use this field to configure an audible message waiting indicator
policy. Choose one of the following options:

• Off

• On—When you select this option, you will receive a stutter
dial tone when you take the handset off hook.

• Default—When you select this option, the phone uses the
default that was set at the system level.

Audible Message Waiting Indicator
Policy

Choose the ring setting for the line appearance when an incoming
call is received and no other active calls exist on that device. Choose
one of the following options:

• Use system default

• Disable

• Flash only

• Ring once

• Ring

Ring Setting (Phone Idle)

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
76

Phones
BAT Template Phone Line Field Descriptions



DescriptionField

Choose the ring setting that is used when this phone has another
active call on a different line. Choose one of the following options:

• Use system default

• Disable

• Flash only

• Ring once

• Ring

• Beep only

Ring Setting (Phone Active)

This field determines the type of notification an incoming call sends
to members of a call pickup group. If the called phone does not
answer, the phones in the call pickup group that are idle will either
hear a short ring (ring once) or hear nothing (disabled).

• Use System Default—The value of this field gets determined
by the setting of the Cisco CallManager service parameter Call
Pickup Group Audio Alert Setting of Idle Station.

• Disable—No alert is sent to members of the call pickup group.

• Ring Once—A short ring is sent to members of the call pickup
group.

Call Pickup Group Audio Alert Setting
(Phone Idle)

This field determines the type of notification an incoming call sends
to members of a call pickup group. If the called phone does not
answer, the phones in the call pickup group that are busy will either
hear a beep only or hear nothing (disabled).

• Use System Default—The value of this field gets determined
by the setting of the Cisco CallManager service parameter Call
Pickup Group Audio Alert Setting of Busy Station.

• Disable—No alert is sent to member of the call pickup group.

• Beep Only—A beepis sent to members of the call pickup
group.

Call Pickup Group Audio Alert Setting
(Phone Active)
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This field determines the recording option on the line appearance
of an agent. By default, the recording option specifies Call
Recording Disabled.

Choose one of the following options:

• Call Recording Disabled—The calls that the agent makes on
this line appearance are not recorded.

• Automatic Call Recording Enabled—The calls that the agent
makes on this line appearance are automatically recorded.

• Application Invoked Call Recording Enabled—The calls that
the agent makes on this line appearance are recorded if an
application invokes calling recording.

When the recording option is set to either Automatic Call Recording
Enabled or Application Invoked Call Recording Enabled, the line
appearance can be associated with a recording profile.

When automatic recording is enabled, the application’s recording
requests get rejected.

Recording Option

This field determines the recording profile on the line appearance
of an agent. Choose an existing recording profile from the
drop-down list box. To create a recording profile, use the Device >
Device Settings > Recording Profile menu option.

The default value specifies None.

Recording Profile

The monitoring calling search space of the supervisor line
appearance must include the agent line or device partition to allow
monitoring the agent.

Set the monitoring calling search space on the supervisor line
appearance window. Choose an existing calling search space from
the drop-down list box.

The default value specifies None.

Monitoring Calling Search Space

This check box allows you to turn this feature on or off. If the check
box displays as checked (turned on), which is the default for this
setting, Unified Communications Manager logs missed calls in the
call history for that directory number on the phone.

Log Missed Calls
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Select one of the following options from the drop-down list box:

• Use System Default

• With Configured CSS

• With Activating Device/Line CSS

If you select the With Configured CSS option, the Forward All
Calling Search Space that is explicitly configured in the Directory
Number Configurationwindow controls the forward all activation
and call forwarding. If the Forward All Calling Search Space is set
to None, no CSS gets configured for Forward All. A forward all
activation attempt to any directory number with a partition will fail.
No change in the Forward All Calling Search Space and Secondary
Calling Search Space for Forward All occurs during the forward
all activation.

If you prefer to utilize the combination of the Directory Number
Calling Search Space and Device Calling Search Space without
explicitly configuring a Forward All Calling Search Space, select
With Activating Device/Line CSS for the Calling Search Space
Activation Policy. With this option, when Forward All is activated
from the phone, the Forward All Calling Search Space and
Secondary Calling Search Space for Forward All automatically gets
populated with the Directory Number Calling Search Space and
Device Calling Search Space for the activating device.

Forward All CSS Activation Policy

Enter a number from 0 to 1200 (inclusive) to specify the wait time
in seconds before issuing a reverted call alert to the holding party
phone.

If you enter a value of 0, Unified Communications Manager does
not invoke the reverted call feature for a held call.

Hold Reversion Ring Duration
(seconds)

Enter a number from 0 to 1200 (inclusive) to specify the interval
time in seconds for sending periodic reminder alerts to the holding
party phone.

If you enter a value of 0, Unified Communications Manager does
not send reminder alerts.

Hold Reversion Notification Interval
(seconds)
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Choose one of the following options from the drop-down list box:

• Default—Use the value that you configured in the Party
Entrance Tone service parameter.

• On—A tone plays on the phone when a basic call changes to
a multi party call; that is, a barge call, cBarge call, ad hoc
conference, meet-me conference, or a joined call. In addition,
a different tone plays when a party leaves the multi party call.
If the controlling device, that is, the originator of the multi
party call has a built-in bridge, the tone gets played to all
parties if you choose On for the controlling device. When the
controlling device, for example, the conference controller, no
longer remains present on the call or if the controlling device
cannot play the tone, Unified Communications Manager does
not play the tone even if you choose On.

• Off—A tone does not play on the phone when a basic call
changes to a multi party call.

Party Entrance Tone

Multiple Call/Call Waiting Settings

You can configure up to 184 calls for a line on a device in a cluster,
with the limiting factor being the device. As you configure the
number of calls for one line, the calls that are available for another
line decrease.

The default specifies 4. If the phone does not allow multiple calls
for each line, the default specifies 2.

For CTI route points, you can configure up to 10,000 calls for each
port. The default specifies 5000 calls.

Use this field in conjunction with the Busy Trigger field.

Maximum Number of Calls

This setting, which works in conjunction with Maximum Number
of Calls and Call Forward Busy, determines the maximum number
of calls to be presented at the line. If maximum number of calls is
set for 50 and the busy trigger is set to 40, incoming call 41 gets
rejected with a busy cause (and will get forwarded if Call Forward
Busy is set). If this line is shared, be aware that all the lines must
be busy before incoming calls get rejected.

Use this field in conjunction with Maximum Number of Calls for
CTI route points. The default specifies 4500 calls.

Busy Trigger

Forwarded Call Information Display for This Device

Check this check box to include the caller name in the display when
a forwarded call is received. Default leaves this check box checked.

Caller Name

Check this check box to include the caller number in the display
when a forwarded call is received.

Caller Number
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Check this check box to include the redirected number in the display
when a forwarded call is received.

Redirected Number

Check this check box to include the dialed number in the display
when a forwarded call is received. The default setting leaves this
check box checked.

Dialed Number

Directory URI Fields

Enter a directory URI to associate with the directory number for
this phone. Follow the username@host format. Enter a username
of up to 47 alphanumeric characters. For the host address, enter an
IPv4 address or fully qualified domain name. You can associate up
to five directory URIs to a single directory number.

Within Cisco Unified CM Administration, you can
enter directory URIs with embedded double quotes or
commas. However, when you use BulkAdministration
to import a csv file that contains directory URIs with
embedded double quotes and commas, you must use
enclose the entire directory URI in double quotes and
escape the embedded double quotes with a double
quote. For example, the Jared, "Jerry",Smith@test.com
directory URI must be input as
"Jared,""Jerry"",Smith@test.com" in the csv file.

Note

URI (1-5) on Directory Number

Enter the partition on which the directory URI belongs. If you do
not want to restrict access to the directory URI, leave the field blank.

URI (1-5) Route Partition on Directory
Number

Enter a 't' (True) to indicate that this directory URI is the primary
directory URI for this extension. Otherwise, enter an 'f' (False) to
indicate that this is not the primary directory URI for this extension.

You can associate up to five directory URIs to a single
directory number, but youmust select a single primary
directory URI.

Note

URI (1-5) Is Primary on Directory
Number

Related Topics
Add or Update Phone Lines in BAT Template, on page 28
Add or Update Lines in Remote Destination Profile Template, on page 491
Add Lines to Existing UDPs, on page 345
Add or Edit Gateway Template, on page 368

BAT Template Field Descriptions to Add Intercom Template
The following table provides descriptions of all possible fields that display when you add an Intercom template
in a BAT phone, gateway, or UDP template. Some device types do not require all the phone settings. Only
some fields show the values that were configured in Unified Communications Manager Administration. Field
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names that have an asterisk in the BAT user interface require an entry. Treat fields that do not have an asterisk
as optional.

Table 4: Field Descriptions for Adding an Intercom Template to a BAT Template

DescriptionField

Intercom Directory Number Information

Enter a unique name for the intercom template.Intercom Template Name

Choose a route partition to which the directory number belongs.

The directory number can appear in more than one
partition.

Note

Route Partition

Enter a description of the directory number and route partition. The
description can include up to 50 characters in any language, but it
cannot include double-quotes (""), percentage sign (%), ampersand
('), or angle brackets (<>).

Description

Use this field only if you do not want the directory number to show
on the line appearance. Enter text that identifies this directory
number for a line/phone combination.

Suggested entries include name of the boss, department, or other
appropriate information to identify multiple directory numbers to
a secretary or assistant who monitors multiple directory numbers.

Display (Internal Caller ID)

This field provides the same information as the Display (Internal
Caller ID) field, but you must limit input to ASCII characters.
Devices that do not support Unicode (internationalized) characters
display the content of the ASCII Display (Internal Caller ID)
field.

Setting applies only to the current device unless you check the check
box at right (Update Shared Device Settings) and click the
Propagate Selected button. (The check box at right displays only
if other devices share this directory number.)

ASCII Display (Internal Caller ID)

Enter text that identifies this directory number for a line/phone
combination.

The default language specifies EnglishNote

Line Text Label

This name represents the name that displays during an alert to a
shared directory number. For non-shared directory numbers, during
alerts, the system uses the name that is entered in theDisplay field.

Alerting Name

This field provides the same information as the Alerting Name field,
but you must limit input to ASCII characters. Devices that do not
support Unicode (internationalized) characters display the content
of the Alerting Name ASCII field.

Alerting Name ASCII
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Enter the number that you want the system to dial when the user
presses the speed-dial button. You can enter digits 0 through 9, *,
#, and +, which is the international escape character.

Speed Dial

Enter the phone number (or mask) that is sent for Caller ID
information when a call is placed from this line.

You can enter a maximum of 24 numbers and “X” characters. The
Xs represent the directory number and must appear at the end of
the pattern. For example, if you specify a mask of 972813XXXX,
an external call from extension 1234 displays a caller ID number
of 9728131234.

External Phone Number Mask

Intercom Directory Number Settings

From the drop-down list box, choose the appropriate calling search
space. A calling search space comprises a collection of partitions
that are searched for numbers that are called from this directory
number. The value that you choose applies to all devices that are
using this directory number.

Calling Search Space

Configure this field with the presence feature.

From the drop-down list box, choose a Presence Group for this
directory number. The selected group specifies the devices, end
users, and application users that can monitor this directory number.

Presence Group

Choose one of the following options to activate the auto answer
feature for this directory number:

• Auto Answer Off <Default>
• Auto Answer with Headset
• Auto Answer with Speakerphone

Do not configure auto answer for devices that have
shared lines.

Note

Auto Answer

From the drop-down list box, choose a default activated device for
this directory number. The selected device specifies the phone on
which this directory number is activated by default. The drop-down
list box lists only devices that support intercom.

You must specify a default activated device for this
intercom directory number to be active as an intercom
line.

Note

If an intercom DN is specified in a device profile that
is configured for Cisco Extension Mobility, that
intercom DN will display as an intercom line only
when a user logs in to the specified default activated
device by using that device profile, as long as the
device supports the intercom feature.

Note

Default Activated Device
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Create Phone CSV Data File Using BAT Spreadsheet
Use the BAT spreadsheet to create the CSV data file. You can define the file format within the spreadsheet,
and the BAT spreadsheet uses the data file formats to display the fields for the CSV data file.

If you enter a comma in one of the fields, BAT.xlt encloses that field entry in double quotes when you export
to BAT format.

If you enter a blank row in the BAT spreadsheet, the system treats the empty row as the end of the file and
does not convert data that is entered after a blank line to the BAT format.

Note

You can use the dummyMAC address option when adding CTI ports. This option gives a unique device name
to each CTI port in the form of dummy MAC addresses that you can manually update later using the or the
UnifiedCM Auto-Register phone Tool. Do not use the dummy MAC address option for H.323 clients, VGC
phones, or VGC virtual phones.

The dummy MAC address option automatically generates dummy MAC addresses in the following format:

XXXXXXXXXXXX

where X represents any 12-character, hexadecimal (0-9 and A-F) number.

The number of lines and speed dials that you define for phones in the BAT spreadsheet must not exceed the
numbers that are defined in the BAT phone template, otherwise, an error occurs when you attempt to insert
the CSV data file and BAT template.

Attention

After you have finished editing all the fields in the BAT spreadsheet, you can export the content to a CSV
formatted data file. A default filename is assigned to the exported CSV formatted data file:

<tabname>-<timestamp>.txt

where <tabname> represents the type of input file that you created, such as phones, and <timestamp> represents
the precise date and time that the file was created.

You can rename the CSV formatted data file after you save the exported file to your local workstation.

You cannot upload a CSV filename that contains a comma (for example, abcd,e.txt) to the server.Note

Procedure

Step 1 To open the BAT spreadsheet, locate and double-click the BAT.xlt file
Step 2 When prompted, click Enable Macros to use the spreadsheet capabilities.
Step 3 To display the phones options, click the Phones tab at the bottom of the spreadsheet.
Step 4 Choose the radio button for one of the following device types:

The device type that you select determines the validation criteria for data in the BAT spreadsheet.

• Phones
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• CTI Port

• H.323 Client

• VGC Phones

• VGC Virtual Phones

• Cisco IP Communicator Phone

The spreadsheet displays options that are available for the chosen device. For example, when you choose
phones, fields for the number of phone lines and the number of speed dials display.

Step 5 Choose the device and line fields to appear in the BAT spreadsheet for each phone. Do the following:
a) Click Create File Format.
b) To choose the device fields, click a device field name in the Device Field box and then click the arrow

to move the field to the Selected Device Fields box.

A CSV data file must include MAC Address/Device Name and Description; therefore, these fields
always remain selected.

To select a range of items in the list, hold down the Shift key. To select random field names,
hold down the Ctrl key and click field names.

Tip

c) Click a line field name in the Line Field box and click the arrow to move the field to the Selected Line
Fields box.

To change the order of the items in the Selected Line and Device boxes, choose an item and
use the up and down arrows to move the field up or down in the list.

Tip

d) Amessage asks whether you want to overwrite the existing CSV format. ClickCreate to modify the CSV
data file format.

e) Click OK.
New columns for the selected fields display in the BAT spreadsheet in the order that you specified.

Step 6 Scroll to the right to locate the Number of Phone Lines box and enter the number of lines for the phone.

The number of lines you enter must not exceed the number of lines that are configured in the
BAT template.

Note

Step 7 For phones, you must enter the number of speed-dial buttons in the Maximum Number of Speed Dials box.

The number of speed dials you enter must not exceed the number of speed dials that are configured
in the BAT template.

Note

After you enter the number, columns display for each speed-dial number.
Step 8 Enter the number of Busy Lamp Field (BLF) speed-dial buttons in the Maximum Number of BLF Speed

Dials box.
After you enter the number, columns display for each BLF speed-dial number.

Step 9 Enter data for an individual phone on each line in the spreadsheet.

Complete all mandatory fields and any relevant, optional fields. Each column heading specifies the length of
the field and whether it is required or optional. See online help for phone field descriptions.

Step 10 If you did not enter the MAC address for each phone, check the Create Dummy MAC Address check box.
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Do not use the dummy MAC address option for H.323 clients, VGC phones, or VGC virtual
phones.

Attention

Step 11 To transfer the data from the BAT Excel spreadsheet into a CSV formatted data file, click Export to BAT
Format.

For information on how to read the exported CSV data file, click the link to View Sample File
in the Insert phones window in BAT.

Tip

The system saves the file with the default filename: <tabname>-<timestamp>.txt to your choice of a folder
on your local workstation.

Related Topics
BAT Spreadsheet Data Collection for CSV Data File Creation, on page 12
TAPS Overview, on page 583
Upload and Download Files, on page 19

Phone Field Descriptions in BAT Spreadsheet
The following table provides descriptions of the phone fields that are available for adding device and line
details in a CSV data file.

Table 5: Phone Field Descriptions for the BAT Spreadsheet

DescriptionField

Device Fields

Enter theMAC address for phones, VGC virtual phones, and VGC phones.
Enter a unique identifier (Device Name) for the CTI port or H.323 client.
You can check the Create Dummy MAC Addresses check box to
automatically generate unique device identifiers.

MAC Address/Device Name

Enter a description such as “Conference Room A” or “John Smith” that
identifies the phone or device. The description can include up to 50
characters in any language, but it cannot include double-quotes ("),
percentage sign (%), ampersand (&), back-slash (\), or angle brackets (<>).

Description

Enter the media resource group list (MRGL) for this group of phones/ports.

An MRGL specifies a list of prioritized media resource groups. An
application can choose required media resources from the available ones
according to the order that is defined in the MRGL.

Media Resource Group List

Enter the user hold audio source that this group of IP phones or CTI ports
should use.

The user hold audio source identifies the audio source from which music
is played when a user places a call on hold.

User Hold Audio Source
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Enter the network hold audio source that this group of IP phones or CTI
ports should use.

The network hold audio source identifies the audio source from which
music is played when the system places a call on hold, such as when the
user transfers or parks a call.

Network Hold MOH Audio Source

Enter the country and language set that you want to associate with this
group of IP phones.

This choice determines which cultural-dependent attributes exist for this
user and which language displays for the user in the Unified
Communications Manager user windows and phones.

User Locale

Enter the network locale that you want to associate with this group of
phones.

The Network Locale comprises a set of tones and cadences that Cisco
gateways and phones use when they communicate with the PSTN and
other networks in a specific geographical area.

Network Locale

Enter the softkey template to be used for all phones in this group.Softkey Template

From the drop-down list box, choose a common phone profile from the
list of available common phone profiles.

Common Phone Profile

Used with the Presence feature, the phone that is running SIP or SCCP
serves as a watcher because it requests status about the presence entity;
for example, directory number, that is configured as a BLF speed dial
button on the phone.

If you want the phone to receive the status of the presence entity, choose
a Presence Group that is allowed to view the status of the Presence Group
that is applied to the directory number, as indicated in the Presence Group
Configuration window.

Device Presence Group

Enter the custom phone load, if applicable.

Any value that is entered in this field overrides the default
value for the chosen phone.

Note

Value does not apply for CTI ports.

Phone Load Name

Enter the security profile that you want to apply to the device. If the phone
does not support the profile that you choose, Unified Communications
Manager does not allow you to apply the configuration.

All phones require that you apply a security profile. If the phone does not
support security, choose a nonsecure profile.

Security Profile

Used with the presence feature, the SUBSCRIBE Calling Search Space
determines howUnified CommunicationsManager routes the subscription
requests that come from the phone. Enter the calling search space that you
want to use for this purpose.

Device SUBSCRIBE CSS

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
87

Phones
Phone Field Descriptions in BAT Spreadsheet



DescriptionField

Choose the E.164 address that is registered with the gatekeeper.

Ensure the H.323 client is configured as a
gatekeeper-controlled device.

Note

You must enter a value in this field for a
gatekeeper-controlled H.323 client. You can enter only
numbers (0-9) and special characters # and * in this field.

Note

E.164

Enter the user ID for the phone user.UserID

This list provides a prioritized grouping of media resource groups. An
application chooses the requiredmedia resource, such as aMusic OnHold
server, from among the available media resources according to the priority
order that is defined in a Media Resource List.

Media Resource Group List

Enter the appropriate calling search space for the device to use when it
performs automated alternate routing (AAR). The AAR calling search
space specifies the collection of route partitions that are searched to
determine how to route a collected (originating) number that is otherwise
blocked due to insufficient bandwidth.

AAR Calling Search Space

Enter a hexadecimal value for the MLPP domain that is associated with
this device. Ensure that this value is blank or a value between 0 and
FFFFFF

MLPP Domain

If available, this setting specifies whether a device that is capable of playing
precedence tones will use the capability when it places an MLPP
precedence call.

• Default—This device inherits its MLPP indication setting from its
device pool.

• Off—This device does not handle nor process indication of anMLPP
precedence call.

• On—This device does handle and process indication of an MLPP
precedence call.

MLPP Indication

If available, this setting specifies whether a device that is capable of
preempting calls in progress will use the capability when it places anMLPP
precedence call.

• Default—This device inherits its MLPP indication setting from its
device pool.

• Off—This device does not handle nor process indication of anMLPP
precedence call.

• On—This device does handle and process indication of an MLPP
precedence call.

MLPP Preemption
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Enter the mode that you want to set for signal packet capture:

• None—Choose None if you do not want to specify a mode.
• Real-TimeMode—Use this mode for real-time signal packet capture.
• Batch Processing Mode—Use this mode for batch processing signal
packet capture mode.

Signal Packet Capture Mode

Enter the time for packet capture in minutes. You can enter a maximum
duration of 300 minutes.

Packet Capture Duration

Enter a numeric string that contains 4 to 10 digits. To install, upgrade, or
troubleshoot a locally significant certificate, the phone user or administrator
must enter the authentication string on the phone.

Authentication String

Enter Yes or No to configure call display restrictions on a call-by-call
basis. When this check box is checked, Unified CommunicationsManager
ignores any presentation restriction that is received for internal calls.

Ignore Presentation Indicator

Enter the default SIP profile or a specific profile that was previously
created. SIP profiles provide specific SIP information for the phone such
as default telephony event payload type, registration and keep alive timers,
media ports, Iris, and dynamic DNS server addresses.

SIP Profile

Used with digest authentication (SIP security), choose an end user that
you want to associate with the phone.

Ensure that you configured digest credentials for the user that you choose,
as specified in the End User Configuration window.

After you save the phone configuration and reset the phone, the digest
credentials for the user get added to the phone configuration file.

Digest User

Enter the profile that a phone should load when an extension mobility user
logs out. You must configure logout profiles in Unified Communications
Manager Administration.

Use Current Device Setting—This choice creates an autogenerated device
profile as the default device profile.

Select a User Device Profile—This choice assigns a user device profile,
which has already been defined, that becomes the default device profile
for this device.

The chosen user device profile gets loaded onto the device when no user
is logged in.

Log Out Profile

Enter the codec to use if a media termination point is required for SIP
calls.

SIPCodec_MTPPreferredOrigCodec
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If required, enter the appropriate SIP dial rule. SIP dial rules provide local
dial plans for Cisco Unified IP Phones 7940, and 7975 that run SIP, so
users do not have to press a key or wait for a timer before the call gets
processed.

Leave the SIP Dial Rules field set to <None> if you do not want dial rules
applied to the IP phone that is running SIP. This means the user must use
the Dial softkey or wait for the timer to expire before the call gets
processed.

Dial Rules

Enter a calling search space to use for rerouting.

The system uses the rerouting calling search space of the referrer to find
the route to the refer-to target. When the Refer fails due to the rerouting
calling search space, the Refer Primitive rejects the request with the “405
Method Not Allowed” message.

The redirection (3xx) primitive and transfer feature also uses the rerouting
calling search space to find the redirect-to or transfer-to target.

CSS Reroute

Enter the common phone configuration to which you want this phone
assigned. The common phone configuration includes the attributes (services
or features) that are associated with a particular user.

Common Phone Configuration

Enter an out-of-dialog refer calling search space.

Unified Communications Manager uses the out-of-dialog (OOD) Refer
Authorization calling search space (CSS) to authorize the SIP out-of-dialog
Refer. The administrator can restrict the use of out-of-dialog Refer by
configuring the OODCSS of the Referrer. Refer Primitive rejects the OOD
Refer request with a “403 Forbidden” message.

Calling Search Space Refer

Enter the Certification Operation that you want to perform from the
following options:

• No Pending Operation—No pending Certification Operation lists
exist for this device. Choosing this option disables the remaining
CAPF fields.

• Install/Upgrade—Install or upgrade a Certification Operation.
• Delete—Delete a Certification Operation
• Troubleshoot—Troubleshoot a Certification Operation.

Certificate Operation

This field, which supports the Install/Upgrade, Delete, and Troubleshoot
Certificate Operation options, specifies the date and time in which you
must complete the operation.

Certificate Operation Completion Time

Enter a user ID for the secure shell user. If the phone that you are
configuring does not support secure shell access, this field does not display.
Cisco Technical Assistance Center (TAC) uses secure shell for
troubleshooting. Contact TAC for further assistance.

Secure Shell User
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Enter the password for a secure shell user. If the phone that you are
configuring does not support secure shell access, this field does not display.
Contact TAC for further assistance.

Secure Shell Password

Enter the appropriate device pool.

The device pool specifies a collection of properties for this device that
includes Communications Manager Group, Date/Time Group, Region,
and Calling Search Space for auto registration of devices.

Device Pool

Enter On, Off, or Default to enable or disable the built-in conference bridge
for the barge feature.

Built-in Bridge

Enter the appropriate calling search space. A calling search space comprises
a collection of partitions that are searched for numbers that are called from
this phone number. The value that you choose applies to all devices that
are using this phone number.

Calling Search Space

Choose the appropriate location for this phone. A location setting of
Hub_None means that the locations feature does not keep track of the
bandwidth that this phone consumes.

Location

Enter the appropriate expansion module or none.Module 1

Enter the custom software for the appropriate expansion module, if
applicable.

The value that you enter overrides the default value for the current model.
Ensure the firmware load matches the module load.

Module 1 Load Name

Enter the appropriate expansion module or none.Module 2

Enter the custom software for the second expansion module, if applicable.

The value that you enter overrides the default value for the current model.
Ensure the firmware load matches the module load.

Module 2 Load Name

Enter the phone template name that you created for this type of bulk
transaction.

Phone Template

Enter the URL that the phone uses to validate requests that are made to
the phones web server. If you do not provide an authentication URL, the
advanced features on the CiscoUnifiedIPPhones that require authentication
will not function. Leave this field blank to accept the default setting.

By default, this URL accesses a CiscoUnifiedIPPhone Self Care Portal
window that was configured during installation.

Authentication Server
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Enter the host and port (for example, proxy.cisco.com:80) that are used
to proxy HTTP requests for access to non-local host addresses from the
phones HTTP client.

If the phone receives a URL such as www.cisco.com in a service and the
phone is not configured in the cisco.com domain, the phone uses the proxy
server to access the URL. If the phone is configured in the cisco.com
domain, the phone accesses the URL without using the proxy because it
is in the same domain as the URL.

Proxy Server

Enter the URL of the XML service that will appear as the idle display on
the CiscoUnifiedIPPhone LCD screen when the phone has not been used
for the time that is specified in the Idle Time field.

For example, you can display a logo on the LCD screen when the phone
has not been used for 5 minutes.

Idle

Enter the seconds that you want to elapse before the phone displays the
URL that is specified in the Idle field.

Idle Timer

Enter the secure URL that the phone uses to validate requests that are made
to the phone web server.

If you do not provide a Secure Authentication URL, the
device uses the nonsecure URL. If you provide both a secure
URL and a nonsecure URL, the device chooses the
appropriate URL, based on its capabilities.

Note

By default, this URL accesses a CiscoUnifiedIPPhone Self Care Portal
window that was configured during installation.

Leave this field blank to accept the default setting.

Maximum length: 255

Secure Authentication URL

Enter the secure URL for the server fromwhich the phone obtains directory
information. This parameter specifies the URL that secured Cisco Unified
IP Phones use when you press the Directory button.

If you do not provide a Secure Directory URL, the device
uses the nonsecure URL. If you provide both a secure URL
and a nonsecure URL, the device chooses the appropriate
URL, based on its capabilities.

Note

Leave this field blank to accept the default setting.

Maximum length: 255

Secure Directory URL
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Enter the secure URL for the information that displays on the Cisco Unified
IP Phone display when the phone is idle, as specified in Idle Timer field.
For example, you can display a logo on the LCD when the phone has not
been used for 5 minutes.

If you do not provide a Secure Idle URL, the device uses the
nonsecure URL. If you provide both a secure URL and a
nonsecure URL, the device chooses the appropriate URL,
based on its capabilities.

Note

To accept the default setting, leave this field blank.

Maximum length: 255

Secure Idle URL

Enter the secure URL for the server location where the Cisco Unified IP
Phone can find help text information. This information displays when the
user presses the information (i) button or the question mark (?) button.

If you do not provide a Secure Information URL, the device
uses the nonsecure URL. If you provide both a secure URL
and a nonsecure URL, the device chooses the appropriate
URL, based on its capabilities.

Note

To accept the default setting, leave this field blank.

Maximum length: 255

Secure Information URL

Enter the secure URL for the messages server. The Cisco Unified IP Phone
contacts this URL when the user presses the Messages button.

If you do not provide a Secure Messages URL, the device
uses the nonsecure URL. If you provide both a secure URL
and a nonsecure URL, the device chooses the appropriate
URL, based on its capabilities.

Note

To accept the default setting, leave this field blank.

Maximum length: 255

Secure Messages URL

Enter the secure URL for Cisco Unified IP Phone services. The is the
location that the secure Cisco Unified IP Phone contacts when the user
presses the Services button.

If you do not provide a Secure Services URL, the device uses
the nonsecure URL. If you provide both a secure URL and
a nonsecure URL, the device chooses the appropriate URL,
based on its capabilities.

Note

To accept the default setting, leave this field blank.

Maximum length: 255

Secure Services URL
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Enter ‘T’ or ‘F’. Hotline devices can only connect to other Hotline devices.
This feature is an extension of PLAR, which configures a phone to
automatically dial one directory number when it goes off-hook. Hotline
provides additional restrictions that you can apply to devices that use
PLAR.

To implement Hotline, you must also create a softkey template without
supplementary service softkeys, and apply it to the Hotline device.

Hotline Device

Enter a user ID for the primary phone user.Owner User ID

Enter the common phone profile to which you want this phone assigned.
The common phone profile includes the attributes (services or features)
that are associated with a particular user.

Common Phone Profile

Turn the device mobility feature on or off for this device or enter Default
to use the default device mobility mode.

Device Mobility Mode

Choose a DND option from the following options:

• None
• Ringer Off

DND Option

Enter one of the following options:

• None
• Disable
• Flash Only
• Beep Only

DND Incoming Call Alert

Enter one of the following options:

• On
• Off
• Default

Privacy

Enter one of the following options:

• Default
• Off
• On

Use Trusted Relay Point

Enter the help text URL for the information button for
CiscoUnifiedIPPhones.

Information

Enter the URL of the directory server for CiscoUnifiedIPPhones.Directory

Enter the voice-messaging access pilot number for CiscoUnified IPPhones.Messages

Enter the URL for the services menu for CiscoUnifiedIPPhones.Services
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This setting allows you to localize the calling party number on the device.
Make sure that the Calling Party Transformation CSS that you enter
contains the calling party transformation pattern that you want to assign
to this device

Calling Party Transformation CSS

Enter one of the following options:

• Off—This setting disables the Single Button Barge/cBarge feature;
however, the regular Barge or cBarge features will still work.

• Barge—This setting enables the Singe Button Barge feature.
• cBarge—This setting enables the Single Button cBarge feature.
• Default—This setting uses the Single Button Barge/cBarge setting
that is in the service parameter.

Single Button Barge

Enter one of the following options:

• Off—This setting disables the Join Across Lines feature.
• On—This setting enables the Join Across Lines feature.
• Default—Uses the Join Across Lines setting that is in the service
parameter.

Join Across Lines

Enter the BLFAudible Alert setting that youwant to use from the following
values:

• On
• Off
• Default

For this required field, this parameter provides an audible alert in addition
to a visual alert on a phone that is currently idle when a call comes in to
one of the lines that is monitored by way of a busy line field (BLF) button.

BLF Audible Alert Setting (Phone Idle)

For this required field, enter the BLF Audible Alert setting that you want
to use from the following values:

• On
• Off
• Default

BLF Audible Alert Setting (Phone Busy)

Enter the Always Use Prime Line setting that you want to use from the
following values:

• On
• Off
• Default

Always Use Prime Line

Enter the Always Use Prime Line for VoiceMessage setting that you want
to use from the following values:

• On
• Off
• Default

Always Use Prime Line for Voice Message
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For this required field, enter one of the following values:

• Internal
• External URLs
• Both
• Default: Internal

Services Provisioning

Enter one of the following values:

• Disabled—None of the personalization settings on the phone get
activated.

• Enabled—This setting accepts a personalized background image file,
which is used for the phone screen; it accepts a preview image file
for temporary display; and it accepts a personalized tone file, so the
default ring tone can be personalized.

• Default—Use the phone personalization setting that is in the Common
Phone Profile.

Phone Personalization

Enter a name that identifies the remote destination.Mobility Identity Name

Enter the telephone number for the destination. Include the area code and
any additional digits that are required to obtain an outside line. Maximum
field length equals 24 characters; individual characters can take the values
0-9, *, and #. Cisco recommends that you configure the caller ID of the
remote destination.

Add the necessary translation pattern or route patterns to route the
destination number.

Mobility Identity Destination Number

Enter the minimum time in milliseconds that must pass before the mobile
phone can be answered.

Range: 0 - 10,000 milliseconds

Default: 1,500 milliseconds

Mobility Identity Answer Too Soon Timer

Enter the maximum time in milliseconds that can pass before the mobile
phone must be answered.

Range: 10,000 - 300,000 milliseconds

Default: 19,000 milliseconds

Mobility Identity Answer Too Late Timer

Enter the time that elapses before the mobile phone rings when a call is
transferred from the desktop phone.

Range: 0 - 30,000 milliseconds

Default: 4,000 milliseconds

Mobility Identity Delay Before Ringing Cell

Enter a time-of-day access record to associate with this remote destination.Mobility Identity Time of Day Access
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Enter a time zone to use for this remote destination.

The time zone that you use for this remote destination is used
by the time-of-day access feature to allow or block calls to
this remote destination.

Note

Mobility Identity Time Zone

Enter ‘T’ or ‘F’ in this field to allow or disallow an incoming call to ring
your desktop phone and remote destination at the same time.

Mobility Identity Enable Mobile Connect

Mobile Smart Client Profile is the Smart Client for smart client devices
and dual-mode phones.

Enter “Standard Cisco UnifiedMobile Communicator Profile” in this field
to enable Cisco Unified Mobile Communicator. Leave it blank to disable
it.

Mobile Smart Client Profile

Enter the geo location that you want to associate with the phone.

Enter “unspecified” if you do not want to associate the phone to any geo
location.

Geo Location

Enter the Feature Control Policy for this group of phones.

A feature control policy specifies the appearance of features and the
associated softkeys that are displayed on the phone.

Feature Control Policy

Line Fields (Optional)

Enter the directory number, up to 24 digits and special characters, for the
phone.

Directory Number

Enter a route partition to which the directory number belongs.

The directory number can appear in more than one partition.Note

Route Partition

Enter the text that you want to display on the called party phone display,
such as the user name (John Smith) or phone location (Conference Room
1).

If this filed is left blank, the system uses the value that is
entered in the Directory Number field.

Note

The default language specifies English.Note

Display

Enter text that identifies this directory number for a line/phone combination.

The default language specifies EnglishNote

Line Text Label

Enter this parameter to make the pilot number the same as the directory
number for this line. This action proves useful if you do not have a
voice-messaging server that is configured for this phone.

Voice Mail Profile
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Enter partitions that are searched for numbers that are called from this
directory number.

Changes cause an update of Pickup Group Names that are
listed in the Call Pickup Group field. The setting applies to
all devices that use this directory number.

Note

Line Calling Search Space

Enter the automated alternate routing (AAR) group for this device. The
AAR group provides the prefix digits that are used to route calls that are
otherwise blocked due to insufficient bandwidth.

Set AAR Group to <None> to prevent rerouting blocked calls.

AAR Group

Enter the calling search space to use when a call is forwarded to the
specified destination.

This setting applies to all devices that are using this directory
number.

Note

Forward All CSS

Enter the secondary calling search space (CSS).Secondary CSS for Forward All

Enter the directory number or directory URI to which all calls get
forwarded.

This setting applies to any dialable phone number, including
an outside destination unless restricted, and to all devices
that are using this directory number.

Note

Forward All Destination

Enter the calling search space to use when a call from an external number
gets forwarded to the specified destination.

This setting applies to all devices that are using this directory
number.

Note

Forward Busy External CSS

Enter the calling search space to use when a call from an internal number
gets forwarded to the specified destination.

This setting applies to all devices that are using this directory
number.

Note

Forward Busy Internal CSS

Enter the directory number or directory URI to which a call that is coming
from an external number gets forwarded when the line is in use.

This setting applies to any dialable phone number, including
an outside destination unless restricted, and to all devices
that are using this directory number.

Note

Forward Busy Destination External
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Enter the directory number or directory URI to which a call that is coming
from an internal number gets forwarded when the line is in use.

This setting applies to any dialable phone number, including
an outside destination unless restricted, and to all devices
that are using this directory number.

Note

Forward Busy Destination Internal

Enter the calling search space to use when a call from an external number
gets forwarded to the specified destination. The setting displays only if it
is configured in the system.

This setting applies to all devices that are using this directory
number.

Note

Forward No Answer External CSS

Enter the calling search space to use when a call from an internal number
gets forwarded to the specified destination. The setting displays only if it
is configured in the system.

This setting applies to all devices that are using this directory
number.

Note

Forward No Answer Internal CSS

Enter the directory number or directory URI to which a call that is coming
from an external number gets forwarded when the phone is not answered.

This setting applies to any dialable phone number, including
an outside destination unless restricted, and to all devices
that are using this directory number.

Note

Forward No Answer External Destination

Enter the directory number or directory URI to which a call that is coming
from an internal number gets forwarded when the phone is not answered.

This setting applies to any dialable phone number, including
an outside destination unless restricted, and to all devices
that are using this directory number.

Note

Forward No Answer Internal Destination

Enter the calling search space to use when a call from an external number
gets forwarded to the specified destination. The setting displays only if it
is configured in the system.

This setting applies to all devices that are using this directory
number.

Note

Forward No Coverage External CSS

Enter the calling search space to use when a call from an internal number
gets forwarded to the specified destination. The setting displays only if it
is configured in the system.

This setting applies to all devices that are using this directory
number.

Note

Forward No Coverage Internal CSS
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Enter the directory number or directory URI to which a call that is coming
from an external number gets forwarded when the phone does not have
coverage.

This setting applies to any dialable phone number, including
an outside destination unless restricted, and to all devices
that are using this directory number.

Note

Forward No Coverage External Destination

Enter the directory number or directory URI to which a call that is coming
from an internal number gets forwarded when the phone does not have
coverage.

This setting applies to any dialable phone number, including
an outside destination unless restricted, and to all devices
that are using this directory number.

Note

Forward No Coverage Internal Destination

(CTI ports only) Enter the calling search space to use when a call from an
internal or external call gets forwarded to the specified destination. The
setting appears only if it is configured in the system.

This setting applies to all devices that are using this directory
number.

Note

Calling Search Space Forward on Failure
External/Internal

(CTI ports only) Enter the directory number or directory URI to which a
call coming from an internal or an external number should get forwarded
when a phone or CTI application fails.

Forward on Failure Destination
External/Internal

This setting specifies the directory number to which an internal
nonconnected call gets forwarded when an application that controls that
directory number fails. Use any dialable phone number, including an
outside destination.

When you enter a destination value for internal calls, the system
automatically copies this value to the Destination field for external calls.
If you want external calls to forward to a different destination, you must
enter a different value in the Destination field for external calls.

Forward on CTI Failure Destination

This setting applies to all devices that are using this directory number.

When you choose a Calling Search Space for internal calls, the system
automatically copies this setting to the Calling Search Space setting for
external calls. If you want external calls to forward to a different calling
search space, choose a different setting in the Calling Search Space for
external calls.

Forward on CTI Failure Calling Search Space

Choose a Pickup Group Name to specify the call pickup group, which can
answer incoming calls to this directory number by dialing the appropriate
pickup group number.

Call Pickup Group
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Enter the phone number (or mask) that is sent for Caller ID information
when a call is placed from this line.

You can enter a maximum of 24 numbers and “X” characters. The Xs
represent the directory number and must appear at the end of the pattern.
For example, if you specify a mask of 972813XXXX, an external call
from extension 1234 displays a caller ID number of 9728131234.

External Phone Number Mask

Enter the number of seconds to allow the call to ring before forwarding
the call to the Forward No Answer Destination.

Forward No Answer Ring Duration (CFNA)

Enter the number to which MLPP precedence calls should be directed if
this directory number receives a precedence call and neither this number
nor its call forward destination answers the precedence call.

Values can include numeric characters, pound (#),and asterisk (*).

Target Destination (MLPP)

Enter the calling search space to associate with the alternate party target
(destination) number.

Calling Search Space (MLPP)

Enter the time, seconds (between 4 and 30), after which an MLPP
precedence call will be directed to this directory number’s alternate party
if this directory number and its call forwarding destination have not
answered the precedence call.

Leave this setting blank to use the value that is set in the Unified
Communications Manager enterprise parameter, Precedence Alternate
Party Timeout.

No Answer Ring Duration (MLPP)

You can configure up to 200 calls for a line on a device in a cluster, with
the limiting factor being the device. As you configure the number of calls
for one line, the calls that are available for another line decrease.

The default specifies 4. If the phone does not allow multiple calls for each
line, the default specifies 2.

For CTI route points, you can configure up to 10,000 calls for each port.
The default specifies 5000 calls. Use this field in conjunction with the
Busy Trigger field.

Maximum Number of Calls

This setting, which works in conjunction withMaximumNumber of Calls
and Call Forward Busy, determines the maximum number of calls to be
presented at the line. If maximum number of calls is set for 50 and the
busy trigger is set to 40, incoming call 41 gets rejected with a busy cause
(and will get forwarded if Call Forward Busy is set). If this line is shared,
be aware that all the lines must be busy before incoming calls get rejected.

Use this field in conjunction with Maximum Number of Calls for CTI
route points. The default specifies 4500 calls.

Busy Trigger

This name represents the name that displays during an alert to a shared
directory number. For non-shared directory numbers, during alerts, the
system uses the name that is entered in the Display field.

Alerting Name
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This field provides the same information as the Alerting Name field, but
you must limit input to ASCII characters. Devices that do not support
Unicode (internationalized) characters display the content of theAlerting
Name ASCII field.

Alerting Name ASCII

Enter one of the following options to activate the Auto Answer feature for
this directory number:

• Auto Answer Off <Default>
• Auto Answer with Headset
• Auto Answer with Speakerphone

Make sure that the headset or speakerphone is not disabled
when you choose Auto Answer with headset or Auto Answer
with speakerphone.

Note

Do not configure Auto Answer for devices that have shared lines.

Auto Answer

Enter a name in the Route Filter Name field. The name can contain up to
50 alphanumeric characters and can contain any combination of spaces,
periods (.), hyphens (-), and underscore characters (_). Ensure each route
filter name is unique to the route plan.

Use concise and descriptive names for your route filters. The
CompanynameLocationCalltype format usually provides
enough detail and is short enough to enable you to quickly
and easily identify a route filter. For example,
CiscoDallasMetro identifies a route filter for toll free,
inter-local access and transport area (LATA) calls from the
Cisco office in Dallas.

Note

Route Filter

Enter a dial plan; for example, North American Numbering Plan.Dial Plan

Enter the audio source to use for music on hold (MOH) when a user
initiates a hold action.

Line User Hold MOH Audio Source

Enter the audio source to use for music on hold (MOH) when the network
initiates a hold action.

Line Network Hold MOH Audio Source

Enter the ring setting that is used when this phone has another active call
on a different line. Choose one of the following options:

• Use system default
• Disable
• Flash only
• Ring once
• Ring
• Beep only

Ring Setting (Phone Active)
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Enter the ring setting for the line appearance when an incoming call is
received and no other active calls exist on that device. Choose one of the
following options:

• Use system default
• Disable
• Flash only
• Ring once
• Ring

Ring Setting (Phone Idle)

Enter the E.164 address that is registered with the gatekeeper.

Ensure the H.323 client is configured as a
gatekeeper-controlled device.

Note

You must enter a value in this field for a
gatekeeper-controlled H.323 client. You can enter only
numbers (0-9) and special characters # and * in this field.

Note

E.164

Enter the setting to use instead of the external phone number mask to
determine the AAR Destination to be dialed.

AAR Destination Mask

Enter the directory number to which an unregistered internal call is
forwarded when the line is in use.

This setting applies to any internal, dialable phone number and to all
devices that are using this directory number.

Forward Unregistered Internal Destination

Enter the calling search space to use when unregistered internal calls are
forwarded to the specified destination.

This setting applies to all devices that are using this directory number.

Forward Unregistered Internal CSS

Enter the directory number to which an external call is forwarded when
the line is in use.

This setting applies to any dialable external phone number, including an
outside destination unless restricted, and to all devices that are using this
directory number.

Forward Unregistered External Destination

Enter the calling search space to use when external calls are forwarded to
the specified destination.

This setting applies to all devices that are using this directory number.

Forward Unregistered External CSS

Use this field to configure an audible message waiting indicator policy.
Enter one of the following options:

• Off
• On—When you enter this option, you will receive a stutter dial tone
when you take the handset off hook.

• Default—When you enter this option, the phone uses the default that
was set at the system level.

Audible Message Waiting Indicator Policy
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This field determines the type of notification an incoming call sends to
members of a call pickup group. If the called phone does not answer, the
phones in the call pickup group that are idle will either hear a short ring
(ring once) or hear nothing (disabled).

• Use System Default—The value of this field gets determined by the
setting of the Cisco CallManager service parameter Call PickupGroup
Audio Alert Setting of Idle Station.

• Disable—No alert is sent to members of the call pickup group.
• Ring Once—A short ring is sent to members of the call pickup group.

Call Pickup Group Audio Alert Setting
(Phone Idle)

This field determines the type of notification an incoming call sends to
members of a call pickup group. If the called phone does not answer, the
phones in the call pickup group that are busy will either hear a beep or
hear nothing (disabled).

• Use System Default—The value of this field gets determined by the
setting of the Cisco CallManager service parameter Call PickupGroup
Audio Alert Setting of Busy Station.

• Disable—No alert is sent to member of the call pickup group.
• Beep Only—A beep is sent to members of the call pickup group.

Call Pickup Group Audio Alert Setting
(Phone Active)

This field determines the recording option on the line appearance of an
agent. By default, the recording option specifies Call Recording Disabled.

Enter one of the following options:

• Call Recording Disabled—The calls that the agent makes on this line
appearance are not recorded.

• Automatic Call Recording Enabled—The calls that the agent makes
on this line appearance are automatically recorded.

• Application Invoked Call Recording Enabled—The calls that the
agent makes on this line appearance are recorded if an application
invokes calling recording.

When the recording option is set to either Automatic Call Recording
Enabled or Application Invoked Call Recording Enabled, the line
appearance can be associated with a recording profile.

When automatic recording is enabled, the application's recording requests
get rejected.

Call Recording Option

This field determines the recording profile on the line appearance of an
agent.

Recording Profile

The monitoring calling search space of the supervisor line appearance
must include the agent line or device partition to allow monitoring the
agent.

Enter the monitoring calling search space on the supervisor line appearance
window.

The default value specifies None.

Monitoring Calling Search Space
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Enter one of the following options:

• Use System Default
• With Configured CSS

Forward All CSS Activation Policy

Enter one of the following Party Entrance Tone options:

• Default—Use the value that you configured in the Party Entrance
Tone service parameter.

• On—A tone plays on the phone when a basic call changes to a
multi-party call; that is, a barge call, cBarge call, ad hoc conference,
meet-me conference, or a joined call. In addition, a different tone
plays when a party leaves the multi-party call. If the controlling
device, that is, the originator of the multi-party call has a built-in
bridge, the tone gets played to all parties if you choose On for the
controlling device. When the controlling device, for example, the
conference controller, is no longer present on the call or if the
controlling device cannot play the tone, Unified Communications
Manager does not play the tone even if you choose On.

• Off—A tone does not play on the phone when a basic call changes
to a multi-party call.

Party Entrance Tone

When the parkee is an external party, then the call will be forwarded to
the specified destination in the parker’s Park Monitoring Forward No
Retrieve Destination External parameter. If the Forward No Retrieve
Destination External field value is empty, the parkee will be redirected
to the parker’s line.

Park Monitor Forward No Retrieve Ext
Destination

When the parkee is an internal party, then the call will be forwarded to
the specified destination in the parker’s Park Monitoring Forward No
Retrieve Destination Internal parameter. If the Forward No Retrieve
Destination Internal is empty, the parkee will be redirected to the parker’s
line.

Park Monitor Forward No Retrieve Int
Destination

This setting uses the settings in the Voice Mail Profile Configuration
window.

With this setting, Unified Communications Manager ignores the settings
in the Destination box and Calling Search Space.

Park Monitor Forward No Retrieve Int Voice
Mail

This setting uses the settings in the Voice Mail Profile Configuration
window.

With this setting, Unified Communications Manager ignores the settings
in the Destination box and Calling Search Space.

ParkMonitor Forward No Retrieve Ext Voice
Mail

Choose the calling search space to apply to the directory number.Park Monitor Forward No Retrieve Ext CSS

Choose the calling search space to apply to the directory number.Park Monitor Forward No Retrieve Int CSS
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This parameter determines the number of seconds that Unified
Communications Manager waits before prompting the user to retrieve a
call that the user parked. This timer starts when the user presses the Park
softkey on the phone, and a reminder is issued when the timer expires.

Default: 60 seconds

If you configure a non-zero value, this value overrides the value of this
parameter set in the Service Parameters window. However, if you configure
a value of 0 here, then the value in the Service Parameters window will
be used.

Park Monitor Reversion Timer

This field allows you to turn this feature on or off. Enter ‘T’ to enable
Unified Communications Manager to log missed calls in the call history
for that directory number on the phone. Enter ‘F’ to disable this feature.

Log Missed Calls

Enter a directory URI to associate with the directory number for this phone.
Follow the username@host format. Enter a username of up to 47
alphanumeric characters. For the host address, enter an IPv4 address or
fully qualified domain name. You can associate up to five directory URIs
to a single directory number.

Within Cisco Unified CM Administration, you can enter
directory URIs with embedded double quotes or commas.
However, when you use Bulk Administration to import a csv
file that contains directory URIs with embedded double
quotes and commas, youmust use enclose the entire directory
URI in double quotes and escape the embedded double quotes
with a double quote. For example, the Jared,
"Jerry",Smith@test.com directory URI must be input as
"Jared,""Jerry"",Smith@test.com" in the csv file.

Note

URI (1-5) on Directory Number

Enter the partition on which the directory URI belongs. If you do not want
to restrict access to the directory URI, leave the field blank.

URI (1-5) Route Partition on Directory
Number

Enter a 't' (True) to indicate that this directory URI is the primary directory
URI for this extension. Otherwise, enter an 'f' (False) to indicate that this
is not the primary directory URI for this extension.

You can associate up to five directory URIs to a single
directory number, but you must select a single primary
directory URI.

Note

URI (1-5) Is Primary on Directory Number

Enter a 't' to add this enterprise alternate number to a local route partition.
Enter 'f' to leave the E.164 number off of local routing.

Enterprise Add to Local Route Partition

Enter a 't' to enable ILS to advertise this alternate number to rest of the
ILS network. Enter an 'f' if you don't want ILS to advertise this number.

Enterprise Advertise via globally
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Enter a 't' to classify routing for this alternate number as urgent.

By default, if the dial plan contains overlapping route patterns Unified
Communications Manager does not route the call until the interdigit timer
expires (even if a possible route exists for the dialed digits). This setting
guards against learned numbers that overlap with statically configured
directory numbers and number patterns by allowing Unified
CommunicationsManager to choose the best match of all available routes
for the dial string.

When you mark the number as urgent priority, Unified Communications
Manager routes the call as soon as it finds a match between the dialed
digits and an available route, without waiting for the interdigit timer to
expire (for example, the T302 Timer service parameter).

Enterprise Is Urgent

Enter the number mask to apply to the directory number. Unified
CommunicationsManager applies themask to create an enterprise alternate
number that is an alias of this directory number.

Enterprise Number Mask

Enter the local route partition to which you want to assign this enterprise
alternate number.

Enterprise Route Partition

Enter a 't' to add this E.164 alternate number to a local route partition.
Enter 'f' to leave the E.164 number off of local routing.

+E.164 Add to Local Route Partition

Enter a 't' to enable ILS to advertise this alternate number to rest of the
ILS network. Enter an 'f' if you don't want ILS to advertise this number.

+E.164 Advertise via globally

Enter a 't' to classify routing for this alternate number as urgent.

By default, if the dial plan contains overlapping route patterns Unified
Communications Manager does not route the call until the interdigit timer
expires (even if a possible route exists for the dialed digits). This setting
guards against learned numbers that overlap with statically configured
directory numbers and number patterns by allowing Unified
CommunicationsManager to choose the best match of all available routes
for the dial string.

When you mark the number as urgent priority, Unified Communications
Manager routes the call as soon as it finds a match between the dialed
digits and an available route, without waiting for the interdigit timer to
expire (for example, the T302 Timer service parameter).

+E.164 Is Urgent

Enter the number mask to apply to the directory number. Unified
Communications Manager applies the mask to create an +E.164 alternate
number that is an alias of this directory number.

+E.164 Number Mask

Enter the local route partition to which you want to assign this +E.164
alternate number.

+E.164 Route Partition

Intercom Fields (Optional)
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Enter a dialable phone number. Values can include numeric characters
and route pattern wildcards and special characters except for (.) and (@).

The directory number that you enter can appear in more than one partition.

At the beginning of the directory number, enter \+ if you want to use the
international escape character +. For this field, \+ does not represent a
wildcard; instead, entering \+ represents a dialed digit.

Intercom Directory Number

Enter the partition to which the directory number belongs. Make sure that
the directory number that you enter in the Intercom Directory Number
field is unique within the partition that you choose.

The directory number can appear in more than one partition.Note

Intercom Route Partition

Enter a description of the directory number and route partition.Description

Enter a name that you want to display on the phone of the caller.

This setting, which supports the Identification Services for the QSIG
protocol, applies to shared and nonshared directory numbers.

Alerting Name

This field provides the same information as the Alerting Name field, but
you must limit input to ASCII characters. Devices that do not support
Unicode (internationalized) characters display the content of the Alerting
Name ASCII field.

Alerting Name ASCII

Intercom Directory Number Settings

Enter the appropriate calling search space. A calling search space comprises
a collection of partitions that are searched for numbers that are called from
this directory number. The value that you choose applies to all devices
that are using this directory number.

Calling Search Space

Enter a Presence Group for this directory number. The selected group
specifies the devices, end users, and application users that can monitor
this directory number.

Intercom Presence Group

Leave this field blank to have the system display the extension.

Use a maximum of 30 alphanumeric characters. Typically, use the user
name or the directory number (if using the directory number, the person
receiving the call may not see the proper identity of the caller).

Intercom Display

This field provides the same information as the Display (Internal Caller
ID) field, but you must limit input to ASCII characters. Devices that do
not support Unicode (internationalized) characters display the content of
the ASCII Display (Internal Caller ID) field.

Intercom ASCII Display

Use this field only if you do not want the intercom directory number to
show on the line appearance. Enter text that identifies this directory number
for a line/phone combination.

Intercom Line Text Label
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Enter the number that you want the system to dial when the user presses
the speed-dial button. You can enter digits 0 through 9, *, #, and +, which
is the international escape character.

Intercom Speed Dial

Enter the phone number (or mask) that is used to send Caller ID information
when a call is placed from this line.

You can enter a maximum of 24 number, the international escape character
+, and “X” characters. The Xs represent the directory number and must
appear at the end of the pattern. For example, if you specify a mask of
972813XXXX, an external call from extension 1234 displays a caller ID
number of 9728131234.

Intercom External Phone Number Mask

Enter ‘T’ to enable the caller name to display upon call forward. Enter ‘F’
to disable it.

Intercom Caller Name

Enter ‘T’ to enable the caller number to display upon call forward. Enter
‘F’ to disable it.

Intercom Caller Number

Enter one of the following options:

• Call Recording Disabled—The calls that the agent makes on this line
appearance are not recorded.

• Automatic Call Recording Enabled—The calls that the agent makes
on this line appearance are automatically recorded.

• Application Invoked Call Recording Enabled—The calls that the
agent makes on this line appearance are recorded if an application
invokes calling recording.

Intercom Call Recording Option

Enter the recording profile on the line appearance of an agent.Intercom Recording Profile

The monitoring calling search space of the supervisor line appearance
must include the agent line or device partition to allow monitoring the
agent.

Enter an existing calling search space.

The default value specifies None.

Intercom Monitoring Calling Search Space

Enter one of the following options to activate the auto answer feature for
this directory number:

• Auto Answer Off <Default>
• Auto Answer with Headset
• Auto Answer with Speakerphone

Do not configure auto answer for devices that have shared
lines.

Note

Auto Answer

Related Topics
Create Phone CSV Data File Using BAT Spreadsheet, on page 84
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Update Jabber Device
Cisco Unified Communications Manager Bulk Administration (BAT) gives the administrator an easy and
efficient way to rename the auto provisioned Cisco Jabber devices created during LDAP synchronization in
batches using the Cisco Unified CM Administration user interface.

Rename Jabber Devices

Before you begin

• All Cisco Jabber devices should exist in Unified CM server already.

• You must have a data file in text (.txt) format that contains the list of old Cisco Jabber device names that
you wish to rename with the new Cisco Jabber device names.

• If the value of the field includes a comma, ensure that this field is enclosed within double quotes.

Procedure

Step 1 Choose Bulk Administration > Phones > Update Jabber Device.
Step 2 In the Jabber Device Information section, from the File Name drop-down list, choose the text file that you

uploaded.
Step 3 In the Job Information area, enter the Job description.
Step 4 Choose a method to update the device names. Do one of the following:

• Select Run Immediately to update the device names immediately.

• Select Run Later to insert the device names later.

Step 5 To create a job for updating the device names, click Submit.
To schedule or activate this job, use the Job Scheduler option in the Bulk Administration main menu.
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C H A P T E R 5
Phone File Formats

This chapter provides information about configuring file formats for CSV data files that are created using a
text editor.

• Text Editors for Phone CSV Data File Creation, on page 111
• Find Phone File Formats, on page 111
• Configure Phone File Format for CSV Data File, on page 112
• Associate Text-Based File Format with CSV Data File, on page 115

Text Editors for Phone CSV Data File Creation
You can create the CSV data file by using lines of ASCII text with values separated by commas. The comma
separated values (CSV) file provides textual information in tabular form.

Use one of these file format options to identify the device and line fields within the CSV data file:

• Default Phone—Contains a predetermined set of phone device and line fields.

• Simple Phone—Contains basic device and line fields for phones.

• Custom—Contains device and line fields that you choose and order yourself.

You cannot modify or delete the Simple Phone or Default Phone file formats.

When you use the Unified Communications Manager Bulk Administration (BAT) spreadsheet to create the
CSV data file, you can create the file format within the spreadsheet. When you use a text editor to create the
CSV data file, you need to create a file format or use the simple or default file format. You enter the values
in the text-based file in the same order as specified in the file format.

Note

Related Topics
Create Text-Based CSV File for Phones, on page 630

Find Phone File Formats
You can use the BAT to find a phone file format.
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Procedure

Step 1 Choose Bulk Administration > Phones > Phone File Format > Create File Format.
The Find and List Phone File Formats window displays.

Step 2 From the Find Phone File Format where Format Name drop-down list box, choose one of the following
criteria:

• begins with
• contains
• is exactly
• ends with
• is empty
• is not empty

Step 3 Specify the appropriate search text, if applicable, and click Find.

To find all phone formats, click Find without entering any search text.Tip

Step 4 To further define your query and to add multiple filters, check the Search Within Results check box and
choose AND or OR from the drop-down box, and repeat Step 2, on page 112 and Step 3, on page 112.

To clear the text specified, click Clear Filter.Tip

Step 5 From the list of records, click the file format name that matches your search criteria.
The Create Phone File Format Configuration window displays.

Related Topics
Create Text-Based CSV File for Phones, on page 630

Configure Phone File Format for CSV Data File
You can create, copy, modify, and delete a phone file format for a CSV data file.

Create Custom Phone File Format Using Text Editor
You can use a text editor to create a custom phone file format for the text-based CSV data file.

Procedure

Step 1 Choose Bulk Administration > Phones > Phone File Format > Create File Format.
Step 2 Click Add New.
Step 3 In the Format Name field, enter a name for this custom format.
Step 4 Choose the fields to appear in the custom file format. Do the following:

a) To choose the device fields, click a device field name in the Device Field box and then click the arrow
to move the field to the Selected Device Fields box.
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A CSV data file must include MAC Address/Device Name and Description; therefore, these fields
always remain selected.

To select a range of items in the list, hold down the Shift key. To select random field names,
hold down the Ctrl key and click field names.

Tip

b) Click a line field name in the Line Field box and click the arrow to move the field to the Selected Line
Fields box.

c) Click the intercom DN field names in the Intercom DN Fields box and click the arrow to move the fields
to the Selected Intercom DN Fields Order box.

You can change the order of the items in the Selected Line Fields, Selected Device Fields,
and Selected Intercom DN Fields Order boxes. Choose an item and use the up and down
arrows to move the field up or down in the list.

Tip

Step 5 In the IP Phone Services Maximums area, enter the maximum values for the following fields:

• Maximum Number of Speed Dials

• Maximum Number of BLF Speed Dials

• Maximum Number of BLF Directed Call Parks

• Maximum Number of IP Phone Services

• Maximum Number of IP Phone Service Parameters

Step 6 Click Save.
The name of the custom file format displays in the File Format Names list in the Find and List Phone File
Formats window.

Related Topics
Create Text-Based CSV File for Phones, on page 630

Copy Custom Phone File Format for CSV Data File
You can copy an existing custom phone file format for the text-based CSV data file.

Procedure

Step 1 Find the phone file format that you want to copy.
Step 2 In the Search Results area, choose the file format that you want to copy.

The Phone File Format Configuration window displays.
Step 3 To make a copy of the chosen file format, click Copy.

You can also click the corresponding Copy icon in the Find and List Phone File Formats
window to copy the file format.

Tip

Step 4 In the Format Name field, enter a new name for the copied format.
Step 5 Modify the fields that appear in the copied file format. Do the following:
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a) To add new fields to the file format, click the field name in the Device Fields, Line Fields, or Intercom
DN Fields box and then click the arrow to move the field to the Selected Device Field, Selected Line
Fields, or Selected Intercom DN Fields Order box.

b) To remove fields from the file format, click the field name in the Selected Device Fields, Selected Line
Fields, or Selected Intercom DN Fields Order box and then click the arrow to move the field to the
Device Fields, Line Fields, or Intercom DN Fields box.

You cannot remove the required fields: Number of lines, MAC address, and description.Note

c) To change the order of items in the Selected Device Fields, Selected Line Fields, and Selected Intercom
DN Fields Order boxes, choose an item and use the up and down arrows to move the field up or down
in the list.

Step 6 Click Save.
The edited copy of the file format is saved.

Related Topics
Find Phone File Formats, on page 111

Modify Custom File Format for CSV Data File
You can modify an existing custom file format for the text-based CSV data file. You can modify custom
formats only.

Procedure

Step 1 Find the phone file format that you want to modify.
Step 2 In the Search Results area, choose the file format that you want to modify.

The Phone File Format Configuration window displays.
Step 3 To modify the fields that appear in the file format, do the following:

a) To add new fields to the file format, click the field name in the Device Fields, Line Fields, or Intercom
DN Fields box and then click the arrow to move the field to the Selected Device Field, Selected Line
Fields, or Selected Intercom DN Fields Order box.

b) To remove fields from the file format, click the field name in the Selected Device Fields, Selected Line
Fields, or Selected Intercom DN Fields Order box and then click the arrow to move the field to the
Device Fields, Line Fields, or Intercom DN Fields box.

You cannot remove the required fields: Number of lines, MAC address, and description.Note

c) To change the order of items in the Selected Device Fields, Selected Line Fields, and Selected Intercom
DN Fields Order boxes, choose an item and use the up and down arrows to move the field up or down
in the list.

Step 4 Click Save.
The changes to the custom file format are saved.

Related Topics
Create Text-Based CSV File for Phones, on page 630
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Find Phone File Formats, on page 111

Delete Existing CSV Data File Format
You can delete an existing custom file format for the CSV data file. You can delete only custom formats.

Procedure

Step 1 Find the phone file format that you want to edit.
Step 2 In the Search Results area, verify that this is the file(s) that you want to delete.
Step 3 To remove the file format(s) from the list, click Delete Selected. A message asks you to confirm that you

want to delete the file format(s). Click OK to continue.

Make sure you browse the entire list of displayed results before you click Delete Selected.Tip

The system removes the file format(s) name from the list.

Related Topics
Create Text-Based CSV File for Phones, on page 630
Find Phone File Formats, on page 111

Associate Text-Based File Format with CSV Data File
When you used a text editor to create the CSV data file, you created a file format for entering values in the
text-based file. You entered values in the text file in the order that the file format specified

After the CSV data file is completed, you need to associate the file format with the text-based CSV data file.
After associating the file format with the CSV file, the names for each field display as the first record in the
CSV data file. You can use this information to verify that you entered the values for each field in the correct
order.

Procedure

Step 1 Choose BulkAdministration > Phones > Phone File Format >Add File Format. Add File Format window
displays.

Step 2 In the File Name field, choose the text-based CSV file that you created for this transaction.
Step 3 In the Format File Name field, choose the file format that you created for this type of bulk transaction.
Step 4 In the Job Information area, enter the job description.
Step 5 To create a job for associating the matching file format with the CSV data file, click Submit.

Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
Create Text-Based CSV File for Phones, on page 630
Manage Scheduled Jobs, on page 599
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C H A P T E R 6
Phone Record Validation

This chapter provides information to validate phone records. When you choose Validate Phones, the system
runs a validation routine to check that the CSV data file and Unified Communications Manager Bulk
Administration (BAT) phone template have populated all required fields, such as device pool and locations.
The validation also checks for discrepancies with the first node database.

You must have a BAT phone template for the devices that you are adding. You can use a standard phone
template with multiple lines to add phones that have a single line or several lines. You must also have a data
file in comma separated variable (CSV) format that contains the unique details for the phones or other IP
telephony devices.

• Validate CSV Data File Phone Records, on page 117
• Topics Related to Phone Record Validation, on page 118

Validate CSV Data File Phone Records
You can validate your CSV data file phone records.

Before you begin

• You must have a BAT phone template for the devices that you are adding. You can use a standard phone
template with multiple lines to add phones that have a single line or several lines.

• You must have a data file in comma separated variable (CSV) format that contains the unique details for
the phones or other IP telephony devices.

Procedure

Step 1 Choose Bulk Administration > Phones > Validate Phones.
The Validate Phones Configuration window displays.

Step 2 To validate phone records that use a customized file format, click Validate Phones Specific Details radio
button and continue with Step 4, on page 117 and Step 5, on page 118.

Step 3 To validate phone records from an exported phones file that was generated by using the All Details option,
click Validate Phones All Details radio button.

Step 4 In the File Name drop-down list, choose the CSV data file that you created for this specific bulk transaction.
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Step 5 For the Specific Details option, in the Phone Template Name drop-down list box, choose the BAT phone
template that you created for this type of bulk transaction.

Step 6 To verify the chosen CSV data file with the first node database, click Submit.
The job gets submitted and gets executed immediately.

Related Topics
BAT Log Files, on page 609
Standard Phone Templates, on page 9
Manage Scheduled Jobs, on page 599
Topics Related to Phone Record Validation, on page 118

Phone Validation Limitations
The validation of phones has the following limitations:

• The validation process only checks for the number of lines that are configured on the template; it does
not check the line numbers that are configured on the template. After running the Validate phones -
specific details job, the administrator sees the following message in the log when the CSV date file
contains more lines than are supported by the phone template: “WARNING: CSV contains more number
of lines than are supported by the phone template.” If blank Directory Numbers and/or blank Speed dials
and/or blank Busy Lamp Field Speed Dials exist, this indicates that the warningmessage that is displayed
in the summary log file may be inaccurate.

• The validate process does not check whether mandatory fields are specified in the CSV file.

• If IP phone service parameters are specified in the phone text file, the validate process only checks
whether a parameter exists with a name that is specified in the CSV onUnified CommunicationsManager.
It does not check whether the parameter that is specified is configured on the IP phone service.

Topics Related to Phone Record Validation
• Phone Template, on page 25
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C H A P T E R 7
Phone Insertions

This chapter provides information to add phones, Cisco VGC Phones, CTI ports, or H.323 clients into the
Cisco Unified Communications Manager database.

You must have a Cisco Unified Communications Manager Bulk Administration (BAT) phone template for
the devices that you are adding, and a data file in comma separated value (CSV) format that contains the
unique details for the phones or other IP telephony devices. You can choose the target and method of the data
file upload. Phone records must be validated before insertion.

• Insert Phones Into Unified Communications Manager, on page 119
• Topics Related to Inserting Phones, on page 121

Insert Phones Into Unified Communications Manager
When you insert phone records into the Unified Communications Manager database, you define the target
CSV data file and how the phone records get inserted. Select any combination of the listed actions to overwrite
the existing phone records, or you can choose to insert the records during upload:

• Delete all existing Speed Dials before adding new one
• Delete all existing BLF Speed Dials before adding new one
• Delete all existing BLF Directed Call Parks before adding new one
• Delete all existing Subscribed Services before adding new one

Phone records must be validated before insertion.Note

BAT expects Directory Number URI fields for directory numbers in the following format:

URI 1 on Directory Number 1, URI 1 Route Partition on Directory Number 1, URI 1 is Primary on Directory
Number 1.

Note

You can use the dummy MAC address option. When adding CTI ports, this option gives a unique device
name to each CTI port in the form of dummy MAC addresses that you can manually update later using the
Unified Communications Manager Administration or the UnifiedCM Auto-Register Phone Tool. Do not use
the dummy MAC address option for H.323 clients, VGC phones, or VGC virtual phones.

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
119



The dummy MAC address option automatically generates dummy MAC addresses in the following format:

XXXXXXXXXXXX

where X represents any 12-character, hexadecimal (0-9 and A-F) number.

Before you begin

• You must have a Unified Communications Manager Bulk Administration (BAT) phone template for the
devices that you are adding. You can choose the target and method of the data file upload. Phone records
must be validated before insertion.

• You must have a data file in comma separated value (CSV) format that contains the unique details for
the phones or other IP telephony devices.

Procedure

Step 1 Choose Bulk Administration > Phones > Insert Phones.
Step 2 Specify the file format type for the phone record that you are uploading.

a) To insert phone records that use a customized file format, click Insert Phones Specific Details radio
button and continue with Step 3, on page 120 and Step 5, on page 120.

b) To insert phone records from an exported phone's file that was generated using the All Details option,
click Insert phones All Details radio button.

Step 3 In theFile Name drop-down list box, choose the CSV data file that you created for this specific bulk transaction.
Next, check the Allow Update Phone with Custom File check box to allow updating the phone with the
chosen custom file.

Step 4 Check the Override the existing configuration check box to overwrite the existing phone settings with the
information that is contained in the file that you want to insert. Next, check the check boxes beside the upload
action(s) to perform during the upload.

The following upload actions get enabled for selection after you have checked the Override the existing
configuration check box.

• Delete all existing Speed Dials before adding new one.
• Delete all existing BLF Speed Dials before adding new one.
• Delete all existing BLF Directed Call Parks before adding new one.
• Delete all existing Subscribed Services before adding new one.

Leave the check boxes clear to append those records to the existing records in the CSV data
file during the upload.

Note

Step 5 For the Specific Details option, in thePhone Template Name drop-down list, choose the BAT phone template
that you created for this type of bulk transaction.

If you did not enter individual MAC addresses in the CSV data file, you must check the Create
Dummy MAC Address check box. You can update this information manually later. Skip to
Step 8, on page 121. If you suppliedMAC addresses or device names in the data input file, do not
choose this option.

If you do not know the MAC address of the phone that is assigned to the user, then choose this
option. When the phone is plugged in, a MAC address registers for that device.

Attention
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Step 6 In the Job Information area, enter the Job description.
Step 7 Choose an insert method. Do one of the following:

a) Click Run Immediately to insert the phone records immediately.
b) Click Run Later to insert the phone records later.

Step 8 Click Submit to create a job for inserting the phone records.
Use the Job Configuration window to schedule or activate this job.

What to do next

If the phones inserted are of the type Cisco Unified Mobile Communicator, then you must reset the devices
after the insert job is completed. You can reset the phones using the Bulk Administration > Phones >
Reset/Restart Phones option.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
TAPS Overview, on page 583
Topics Related to Inserting Phones, on page 121

Topics Related to Inserting Phones
• Phone Template, on page 25

• Phone File Formats, on page 111

• Upload and Download Files, on page 19

• Phone Record Validation, on page 117
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C H A P T E R 8
Phone Updates

This chapter provides information about how to use the Update Phones option to update phone settings, such
as changing or adding the device pool or calling search space for a group of similar phones. You can locate
existing phone records that you want to update using either a query or a custom file. After locating the phone
records, you can proceed to define the update parameters.

• Update Phones Using Query, on page 123
• Update Phones Using Custom File, on page 124
• Choose Update Parameters, on page 126
• Phone Update Field Descriptions, on page 126

Update Phones Using Query
Create a query to locate phones to update. After locating phones following this procedure, you must proceed
to choose the update parameters.

Procedure

Step 1 Choose Bulk Administration > Phones > Update Phones > Query.

The Update Phones Query window displays.

To update all phones, click Find and do not specify a query. Skip the rest of this procedure and
proceed to choose the update parameters for the phones.

Note

Step 2 From the first Find Phone where drop-down list box, choose one of the following criteria:

• Device Name
• Description
• Directory Number
• Calling Search Space
• Device Pool
• Device Type
• Call Pickup Group
• LSC Status
• LSC Expires
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• LSC Issued by
• LSC Issuer Expires by
• Authentication String
• Location
• Phone Load Name
• Device Protocol
• Security Profile
• Last Active

• Last Registered

The status of LSC Expires and LSC Issuer Expires by fields are set to “NA” when there is no
LSC issued on a new device.

The status of LSC Expires and LSC Issuer Expires by fields are set to “ Unknown” when the
LSC is issued to a device before the upgrade to Unified Communications Manager11.5(1).

Note

From the second Find Phone where drop-down list box, choose one of the following criteria:

• is before
• is exactly
• is after
• begins with
• contains
• ends with
• is exactly
• is empty
• is not empty

Step 3 Specify the appropriate search text, if applicable.

To find all phones that are registered in the database, click Find without entering any search text.Tip

Step 4 To further define your query and to add multiple filters, check the Search Within Results check box, choose
AND or OR from the drop-down box, and repeat Step 2, on page 123 and Step 3, on page 124.

Step 5 Click Find.
A list of discovered phones displays. The Update Phones window displays the details of the phones that you
choose.

What to do next

To complete the procedure for updating phones, continue to the Choose Update Parameters, on page 126.

Update Phones Using Custom File
Create a custom file to locate phones to update. After locating phones following this procedure, you must
proceed to choose the update parameters.
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Do not use the insert or export transaction files that are created with bat.xlt for the update transaction. Instead,
you must create a custom file with details of the phone records that need to be updated. Use only this file for
the update transaction.

Note

Before you begin

1. Identify the devices that you need to update.
2. Create a text file that lists one of these options on a separate line:

• Device names
• Directory numbers
• Description

Enter values for device name, description, or directory number in the custom update file. You do not need to
include a header in the custom update file.

Note

3. Upload the text file to the Unified Communications Manager server. See Upload File to Server, on page
21.

Procedure

Step 1 Choose Bulk Administration > Phones > Update Phones > Use Custom File.

The Update Phones Custom Configuration window displays.

Step 2 In the Update Phones where drop-down list box, choose the type of custom file that you have created from
the following criteria:

• Device Name
• Directory Number
• Description

Step 3 In the list of custom files, choose the filename of the custom file for this update.
Step 4 Click Find.

If the query results are not what you expected, you can change the custom file selections.

What to do next

To complete the procedure for updating phones, continue to the Choose Update Parameters, on page 126.
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Choose Update Parameters
After you have located the phones to update, you can choose the parameters and define values for updating
those phones.

Procedure

Step 1 In the Update Phones Query window, click Next.
The Update Phones shows the type of query that you chose. If you want to change the type of query, click
Back.

Step 2 Choose the Logout Users before Update check box to log out the users prior to the update.
You can also use this option to bulk log out users if no fields are chosen.

Step 3 Specify the setting that you want to update for all the records that you have defined in your query or custom
file. You can choose multiple parameters to update. See the Table 6: Field Descriptions for Update Phones,
on page 127 for descriptions of parameters.

Step 4 Select the update check box to the left of the field that you want to update.

This tells BAT to overwrite the existing value for the field.

Be aware that BAT updates only those fields for which you have selected the update check box.Note

Step 5 In the Value field for the checked parameter, enter the new value or choose a value from the list box.
Step 6 In the Reset/Restart Phones area, check one of the following choices:

• Don't Reset/Restart phones/Apply Config—To reset/restart devices at a later time.
• Reset phones—To reset (power-cycle) the phones
• Restart phones—To reset phones without power-cycling
• Apply Config—To reset only the settings that have changed since the last reset

Step 7 Update the required phone parameters. See Table 6: Field Descriptions for Update Phones, on page 127 for
field descriptions.

Step 8 To create a job for updating the records, click Submit.
Use the Job Scheduler option in the Bulk Administration main menu to schedule and activate this job.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599

Phone Update Field Descriptions
The following table provides descriptions for all possible fields that display when you are updating phones.
Some device types do not require all the phone settings.

Values that appear in some fields display from Unified Communications Manager. You must configure these
values by using Unified Communications Manager Administration.
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Be aware that some fields have two check boxes. The first check box determines if you need to update the
field; the second check box determines the value (checked or unchecked) to use for the field.

Note

Check the first check box if you need to update the field and the second check box to apply a checked value
to the phones you select. For example, if you check the first check box for Do Not Disturb and leave the
second one unchecked, you update phones with an unchecked value for Do Not Disturb.

Tip

Table 6: Field Descriptions for Update Phones

DescriptionField

Enter a description that makes the device easy to recognize. The description can
include up to 50 characters in any language, but it cannot include double-quotes ("),
percentage sign (%), ampersand (&), back-slash (\), or angle brackets (<>).

Description

Choose the device pool to which this group of phones/ports should belong.

A devicepool defines sets of common characteristics for devices, such as region,
date/time group, Unified CommunicationsManager group, and calling search space
for auto-registration.

DevicePool

Choose the common device configuration to which you want this phone assigned.
The common device configuration includes the attributes (services or features) that
are associated with a particular user.

To see the common device configuration settings, click the View Details link.

Common Device
Configuration

Choose the appropriate phone button template. The phone button template determines
the configuration of buttons on a phone and identifies which feature (line, speed
dial, and so on) is used for each button.

Unified Communications Manager does not make this field available for H.323
clients or CTI ports.

Phone Button Template

Choose the softkey template to be used for all phones in this group.Softkey Template

From the drop-down list, choose a common phone profile from the list of available
common phone profiles.

Common Phone Profile

Choose the calling search space to which this group of phones/ports should belong.

A calling search space specifies the collection of route partitions that are searched
to determine how a dialed number should be routed.

Calling Search Space

Choose the appropriate calling search space for the device to use when it performs
automated alternate routing (AAR). The AAR calling search space specifies the
collection of route partitions that are searched to determine how to route a collected
(originating) number that is otherwise blocked due to insufficient bandwidth.

AAR Calling Search
Space
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DescriptionField

Choose the media resource group list (MRGL) to which this group of phones/ports
should belong.

An MRGL specifies a list of prioritized media resource groups. An application can
choose required media resources among the available ones according to the priority
order that is defined in the MRGL.

Media Resource Group
List

Choose the user-hold audio source for this group of phones or ports.

The user-hold audio source plays music when a user places a call on hold.

User Hold MOHAudio
Source

Choose the network hold audio source that this group of IP phones or CTI ports
should use.

The network-hold audio source plays music when the system places a call on hold,
such as when the user transfers or parks a call.

Network Hold MOH
Audio Source

Choose the location to which this group of phones/ports should belong.

A location indicates the remote location that is accessed by using restricted bandwidth
connections.

Location

Choose the automated alternate routing (AAR) group for this device. The AAR
group provides the prefix digits that are used to route calls that are otherwise blocked
due to insufficient bandwidth. If noAARgroup is specified, Unified Communications
Manager uses the AAR group that is associated with Device Pool or Line.

AAR Group

Choose the country and language set that you want to associate with this user.

This choice determines which cultural-dependent attributes exist for this user and
which language displays for the user in the Unified Communications Manager user
windows and phones.

User Locale

Choose the network locale that you want to associate with this user.

The Network Locale comprises a set of tones and cadences that Cisco gateways and
phones use when they are communicating with the PSTN and other networks in a
specific geographical area.

Network Locale

Enable or disable the built-in conference bridge for the barge feature by using the
Built In Bridge drop-down list (choose On, Off, or Default).

Built in Bridge

For each phone that wants Privacy, choose On in the Privacy drop-down list.

For more configuration information, refer to Barge and Privacy Features in the
Feature Configuration Guide for Cisco Unified Communications Manager .

Privacy
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DescriptionField

From the drop-down list, turn the device mobility feature on or off for this device
or choose Default to use the default device mobility mode.

ClickView Current Device Mobility Settings to display the current values of these
device mobility parameters:

• Cisco Unified Communications Manager Group

• Roaming Device Pool

• Location

• Region

• Network Locale

• AAR Group

• AAR Calling Search Space

• Device Calling Search Space

• Media Resource Group List

• SRST

Device Mobility Mode

From the drop-down list, choose the user ID of the person to whom this dual-mode
phone is assigned.

Be aware that the Mobility User ID configuration is used for Mobile
Connect and Mobile Voice Access for dual mode phones.

Note

The Owner User ID and Mobility User ID can differ.Note

Mobility User ID

Enter a user ID for the primary phone user.Owner User ID

From the drop-down list, enable or disable the Cisco Unified Phone Designer feature
for this device or choose Default to use the phone personalization that is set in the
Common Phone Profile.

• Disabled—None of the Cisco Unified Phone Application Suite features get
activated.

• Enabled—This setting accepts a personalized background image file, which
is used for the phone screen; it accepts a preview image file for temporary
display; and it accepts a personalized tone file, so the default ring tone can be
personalized.

• Default—Use the phone personalization setting that is in the Common Phone
Profile.

Phone Personalization
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DescriptionField

From the drop-down list, choose the Services Provisioning setting that you want to
use from the following values:

• Internal

• External URLs

• Both

• Default: Internal

This parameter controls whether the phone uses the services provisioned from the
configuration file (Internal), services received from the Services URLs (External
URLs), or both. The External URLs option provides backward compatibility with
third party provisioning servers. The Both option allows users to subscribe to the
services specified in the configuration file while also appending services from an
external provisioning server.

This is a required field.

Services Provisioning

Enter the custom phone load, if applicable.

Any value that is entered in this field overrides the default value for
the chosen model and specifies the custom software for a
CiscoUnifiedIPPhone.

Note

Phone Load Name

From the drop-down list, enable or disable the Single Button Barge/cBarge feature
for this device or choose Default to use the service parameter setting.

• Off—This setting disables the Single Button Barge/cBarge feature; however,
the regular Barge or cBarge features will still work.

• Barge—This setting enables the Singe Button Barge feature.

• cBarge—This setting enables the Single Button cBarge feature.

• Default—This setting uses the Single Button Barge/cBarge setting that is in
the service parameter.

Single Button Barge

From the drop-down list, enable or disable the Join Across Lines feature for this
device or choose Default to use the service parameter setting.

• Off—This setting disables the Join Across Lines feature.

• On—This setting enables the Join Across Lines feature.

• Default—This setting uses the Join Across Lines setting that is in the service
parameter.

Join Across Lines
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DescriptionField

From the drop-down list, enable or disable whether Unified Communications
Manager inserts a trusted relay point (TRP) device with this media endpoint. Choose
one of the following values:

• Default—If you choose this value, the device uses the Use Trusted Relay Point
setting from the common device configurationwith which this device associates.

• Off—Choose this value to disable the use of a TRP with this device. This
setting overrides the Use Trusted Relay Point setting in the common device
configuration with which this device associates.

• On—Choose this value to enable the use of a TRPwith this device. This setting
overrides the Use Trusted Relay Point setting in the common device
configuration with which this device associates.

A Trusted Relay Point (TRP) device designates an MTP or transcoder device that
is labeled as Trusted Relay Point.

Unified CommunicationsManager places the TRP closest to the associated endpoint
device if more than one resource is needed for the endpoint (for example, a transcoder
or RSVP Agent).

If both TRP and MTP are required for the endpoint, TRP gets used as the required
MTP.

Use Trusted Relay Point

This setting allows you to localize the calling party number on the device. Make
sure that the Calling Party Transformation CSS that you choose contains the calling
party transformation pattern that you want to assign to this device.

The device takes on the attributes of the Calling Party Transformation Pattern when
you assign the pattern to a partition where the Calling Party Transformation CSS
exists.

Calling Party
Transformation CSS

From the drop-down list, choose a geolocation.

You can choose the Unspecified geolocation, which designates that this device does
not associate with a geolocation.

You can also choose a geolocation that has been configured with the System >
Geolocation Configuration menu option.

Geolocation

Choose the Emergency Location (ELIN) group to which this group of phones should
belong. An ELIN group identifies a location to which ELINs under this ELIN group
must be mapped in the ALI database.

Emergency Location
(ELIN) Group

Choose the Feature Control Policy for this group of phones.

A feature control policy specifies the appearance of features and the associated
softkeys that display on the phone.

Feature Control Policy
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DescriptionField

For this required field, from the drop-down list, choose the BLF Audible Alert
setting that you want to use from the following values:

• On

• Off

• Default

This parameter provides an audible alert in addition to a visual alert on a phone that
is currently idle when a call comes in to one of the lines that is monitored by way
of a busy lamp field (BLF) button.

BLF Audible Alert
Setting (Phone Idle)

For this required field, this parameter provides an audible alert in addition to a visual
alert on a phone that is currently in use when a call comes in to one of the lines that
is monitored by way of a busy lamp field (BLF) button.

From the drop-down list, choose the BLF Audible Alert setting that you want to
use from the following values:

• On

• Off

• Default

BLF Audible Alert
Setting (Phone Busy)

From the drop-down list, choose the Always Use Prime Line setting that you want
to use from the following values:

• On

• Off

• Default

Always Use Prime Line

From the drop-down list, choose the Always Use Prime Line for Voice Message
setting that you want to use from the following values:

• On

• Off

• Default

Always Use Prime Line
for Voice Message

To use the Calling Party Transformation CSS that is configured in the device pool
that is assigned to this device, check this check box. If you do not check this check
box, the device uses the Calling Party Transformation CSS that you configured in
the device configuration window.

Use Device Pool
Calling Party
Transformation CSS

Check this check box if the system must ignore presentation indicators.Ignore Presentation
Indicators

Check this check box to retry a video call as an audio call.Retry Video Call as
Audio
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DescriptionField

Check this check box to allow CTI to control and monitor this device.

If the associated directory number specifies a shared line, the check box should
remain enabled as long as at least one associated device specifies a combination of
device type and protocol that CTI supports.

Cisco dual-mode devices (Jabber) such as Android, iPhone, and iPad
operating inWiFi mode are monitored through CTI and not controlled.
However, devices operating in GSM mode cannot be monitored or
controlled.

Note

Allow Control of
Device from CTI

This check box, which gets checked by default for all phones, indicates that the
phone is currently logged in to a hunt list (group). When the phone gets added to a
hunt list, the administrator can log the user in or out by checking (and unchecking)
this check box.

Users use the softkey on the phone to log their phone in or out of the hunt list.

Logged into Hunt
Group

If you are experiencing delayed connect times over SCCP to remote sites, check
the Remote Device check box in the Phone Configuration window. Checking this
check box tells Unified CommunicationsManager to allocate a buffer for the phone
device when it registers and to bundle SCCP messages to the phone.

Because this feature consumes resources, be sure to check this check
box only when you are experiencing signaling delays for phones that
run SCCP. Most users do not require this option.

Note

Remote Device

Check this check box to designate a phone as “protected.” This enables the phone
to play a two-second tone notifying the user when a call is both encrypted and both
phones are configured as protected devices. The tone plays for both parties when
the call is answered. The tone does not play unless both phones are “protected” and
the call occurs over encrypted media.

Protected Device

Protocol Specific Information

From the drop-down list, choose the mode that you want to set for signal packet
capture:

None—Choose None if you do not want to specify a mode.

Real-Time Mode—Use this mode for real-time signal packet capture.

Batch Processing Mode—Use this mode for batch processing signal packet capture
mode.

Packet Capture Mode

Enter the time for packet capture in minutes. You can enter a maximum duration
of 300 minutes. The default duration specifies 60 minutes.

Packet Capture
Duration
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Used with the Presence feature, the phones that is running SIP or SCCP serves as
a watcher because it requests status about the presence entity, for example, directory
number, that is configured as a BLF speed dial button on the phone.

If you want the phone to receive the status of the presence entity, choose a Presence
Group that is allowed to view the status of the Presence Group that is applied to the
directory number, as indicated in the Presence Group Configuration window.

Presence Group

For phones that run SCCP and SIP, choose the security profile that you want to
apply to the device.

All phones require that you apply a security profile. If the phone does not support
security, choose a nonsecure profile.

The CAPF settings that are configured in the profile relate to the
Certificate Authority Proxy Function settings that display in the Phone
Configurationwindow. If you want to manage manufacture-installed
certificates (MICs) or locally significant certificates (LSC), you must
configure the CAPF settings in the profile and in the Phone
Configuration window.

Tip

Device Security Profile

Used with the Presence feature, the SUBSCRIBE Calling Search Space determines
how Unified Communications Manager routes the subscription requests that come
from the phone. From the drop-down list, choose the calling search space that you
want to use for this purpose.

SUBSCRIBE Calling
Search Space

From the drop-down list, choose the rollover option that youwant to use for outbound
calls.

No Rollover—Choose this option to Switch off the rollover feature. Conference
and transfer will not work in this mode.

Rollover within the same DN—Choose this option to use rollover within the same
DN. Conferences and call transfers complete by using the same directory number
(on different lines).

Rollover to any line—Choose this option to roll over to any line. Conferences and
call transfers complete by using a different directory number and line than the
original call.

OutboundCall Rollover

Check this check box to indicate an unattended port on this device.Unattended Port

For phones that run SIP and SCCP, check this check box to require DTMF reception
for this phone.

Require DTMF
Reception

External Data Locations Information

Enter the help text URL for the information button.Information

Enter the URL of the directory server.Directory

Enter the voice-messaging access pilot number.Messages

Enter the URL for the services menu.Services
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Enter the URL that the phone uses to validate requests that are made to the phones
web server. If you do not provide an authentication URL, the advanced features on
CiscoUnifiedIPPhones that require authentication will not function. Leave this field
blank to accept the default setting.

By default, this URL accesses a CiscoUnifiedIPPhone Self Care Portal window that
was configured during installation.

Authentication Server

Enter the host and port (for example, proxy.cisco.com:80) that are used to proxy
HTTP requests for access to non-local host addresses from the phones HTTP client.

If the phone receives a URL such as www.cisco.com in a service and the phone is
not configured in the cisco.com domain, the phone uses the proxy server to access
the URL. If the phone is configured in the cisco.com domain, the phone accesses
the URL without using the proxy because it is in the same domain as the URL.

Leave this field blank to accept the default setting.

Proxy Server

Enter the URL to display on the CiscoUnifiedIPPhone screen when the phone has
not been used for the time that is specified in the Idle Time field. For example, you
can display a logo on the screen when the phone has not been used for 5 minutes.
Leave this field blank to use the default value.

Idle

Enter the seconds that you want to elapse before the phone displays the URL that
is specified in the Idle field. Leave this field blank to use the default value.

Idle Timer

Enter the secure URL that the phone uses to validate requests that are made to the
phone web server.

If you do not provide a Secure Authentication URL, the device uses
the nonsecure URL. If you provide both a secure URL and a nonsecure
URL, the device chooses the appropriate URL, based on its capabilities.

Note

By default, this URL accesses a CiscoUnifiedIPPhone Self Care Portal window that
was configured during installation.

Leave this field blank to accept the default setting.

Maximum length specifies 255 characters.

Secure Authentication
URL

Enter the secure URL for the server from which the phone obtains directory
information. This parameter specifies the URL that secured Cisco Unified IP Phones
use when you press the Directory button.

If you do not provide a Secure Directory URL, the device uses the
nonsecure URL. If you provide both a secure URL and a nonsecure
URL, the device chooses the appropriate URL, based on its capabilities.

Note

Leave this field blank to accept the default setting.

Maximum length specifies 255 characters.

Secure Directory URL
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Enter the secure URL for the information that displays on the Cisco Unified IP
Phone display when the phone is idle, as specified in the Idle Timer field. For
example, you can display a logo on the LCD when the phone has not been used for
5 minutes.

If you do not provide a Secure Idle URL, the device uses the nonsecure
URL. If you provide both a secure URL and a nonsecure URL, the
device chooses the appropriate URL, based on its capabilities.

Note

To accept the default setting, leave this field blank.

Maximum length specifies 255 characters.

Secure Idle URL

Enter the secure URL for the server location where the Cisco Unified IP Phone can
find help text information. This information displays when the user presses the
information (i) button or the question mark (?) button.

If you do not provide a Secure Information URL, the device uses the
nonsecure URL. If you provide both a secure URL and a nonsecure
URL, the device chooses the appropriate URL, based on its capabilities.

Note

To accept the default setting, leave this field blank.

Maximum length specifies 255 characters.

Secure Information
URL

Enter the secure URL for the messages server. The Cisco Unified IP Phone contacts
this URL when the user presses the Messages button.

If you do not provide a Secure Messages URL, the device uses the
nonsecure URL. If you provide both a secure URL and a nonsecure
URL, the device chooses the appropriate URL, based on its capabilities.

Note

To accept the default setting, leave this field blank.

Maximum length specifies 255 characters.

Secure Messages URL

Enter the secure URL for Cisco Unified IP Phone services. This setting specifies
the location that the secure Cisco Unified IP Phone contacts when the user presses
the Services button.

If you do not provide a Secure Services URL, the device uses the
nonsecure URL. If you provide both a secure URL and a nonsecure
URL, the device chooses the appropriate URL, based on its capabilities.

Note

To accept the default setting, leave this field blank.

Maximum length specifies 255 characters.

Secure Services URL

Enter T or F. Hotline devices can connect only to other Hotline devices. This feature
extends the PLAR feature, which configures a phone to automatically dial one
directory number when it goes off-hook. Hotline provides additional restrictions
that you can apply to devices that use PLAR.

To implement Hotline, you must also create a softkey template without
supplementary service softkeys and apply the softkey template to the Hotline device.

Hotline Device
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Extension Information

Check this check box to enable extension mobility.

Choose 0-Off to disable this feature, or choose 1-On to enable this feature.

Extension mobility allows a user to log in and out of a Cisco Unified IP Phone.

Enable Extension
Mobility

Use Unified Communications Manager to choose any services that have been
configured.

IP Services1

Use Unified Communications Manager to choose any services that have been
configured.

Using Unified Communications Manager Bulk Administration (BAT), you cannot
update more than two IP services in one transaction.

IP Services2

Certification Authority Proxy Function (CAPF) Information

(These parameters display only for devices with the capability to support authentication or encryption.)

From the drop-down list, choose the CertificationOperation that you want to perform
from the following options:

• No Pending Operation—No pending Certification Operation lists exist for this
device. Choosing this option disables the remaining CAPF fields.

• Install/Upgrade—Install or upgrade a Certification Operation.

• Delete—Delete a Certification Operation.

• Troubleshoot—Troubleshoot a Certification Operation.

Certificate Operation

Check this check box if you want a unique authentication string to be generated for
each device.

Generate Unique
Authentication String
for Each Device

If AuthenticationMode is By Authentication String, enter the Authentication String.
Alternately, to get a system-generated string, click Generate String.

Authentication String

Enter the date by which the Certification Operation will complete. The date format
specifies YYYY: MM: DD: HH. The default completion date specifies 10 days
from the current system date.

Operation Completes
By

MultiLevel Precedence and Preemption (MLPP) Information
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If available, this setting specifies whether a device that is capable of playing
precedence tones will use the capability when it places an MLPP precedence call.

From the drop-down list, choose a setting to assign to this device from the following
options:

• Default—This device inherits its MLPP indication setting from its device pool.

• Off—This device does not send indication of an MLPP precedence call.

• On—This device does send indication of an MLPP precedence call.

Do not configure a device with the following combination of settings:
MLPP Indication is set to Off while MLPP Preemption is set to
Forceful.

Note

MLPP Indication

If available, this setting specifies whether a device that is capable of preempting
calls in progress will use the capability when it places an MLPP precedence call.

From the drop-down list, choose a setting to assign to this device from the following
options:

• Default—This device inherits its MLPP preemption setting from its device
pool.

• Disabled—This device does not preempt calls in progress when it places an
MLPP precedence call.

• Forceful—This device preempts calls in progress when it places an MLPP
precedence call.

Do not configure a device with the following combination of settings:
MLPP Indication is set to Off while MLPP Preemption is set to
Forceful.

Note

MLPP Preemption

Enter a hexadecimal value for the MLPP domain that is associated with this device.
Ensure that this value is blank or a value between 0 and FFFFFF.

MLPP Domain (e.g.,
"0000FF")

Do Not Disturb (DND)

If you want to enable the DND feature, check this check box.Do Not Disturb

From the drop-down list, choose a DND option from the following options:

• None

• Ringer Off

• Call Reject

• Use Common Phone Profile Setting

DND Option
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From the drop-down list, choose one of the following options:

• None

• Disable

• Flash Only

• Beep Only

DND Incoming Call
Alert

Secure Shell Information

Enter a user ID for the secure shell user. If the phone that you are configuring does
not support secure shell access, this field does not display. Cisco Technical Assistance
Center (TAC) uses secure shell for troubleshooting. Contact TAC for further
assistance.

Secure Shell User

Enter the password for a secure shell user. If the phone that you are configuring
does not support secure shell access, this field does not display. Contact TAC for
further assistance.

Secure Shell Password

Assign IP Phone Services

From the drop-down list, choose the template that contains list of services with
which you want to update the phones.

You can click the Edit IP Phone Service link to update the subscribed CiscoUnifiedIP
Phones services on the template.

Add All Services From
This Template

Check this check box to remove duplicate IP phone services. If you check this check
box, the system removes the duplicate service subscriptions from phones and user
device profiles. The IP system deletes services based on the IP service name.

Remove Duplicate

Product Specific Information

From the drop-down list, choose the mode that you want to set for the device:

Use SystemDefault—The phone uses the value that you specified for the enterprise
parameter, Device Security Mode.

Non-secure—No security features exist for the phone. A TCP connection opens to
Unified Communications Manager.

Authenticated—Unified Communications Manager provides integrity and
authentication for the phone. A TLS connection that uses NULL/SHA opens.

Encrypted—Unified Communications Manager provides integrity, authentication,
and encryption for the phone. A TLS connection that uses AES128/SHA opens

This field applies only if the phone model supports authentication or encryption.

Device Security Mode

Check this check box to remove duplicate IP phone services. If you check this check
box, the system removes the duplicate service subscriptions from phones and user
device profiles. The IP system deletes services based on the IP service name.

Remove Duplicate IP
Services from all
Phones and Device
Profiles
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Check this check box to disable the speakerphone.Disable SpeakerPhone

Check this check box to disable the speakerphone and headset.Disable Speakerphone
and Headset

Use this field to enable or disable forwarding delay. Choose enable when you want
the port to wait a few seconds before forwarding a call.

Forwarding Delay

Use this field to enable or disable the PC port on phones that have internal switches.
Users can connect a PC or workstation to the phone by using the port labeled “10/100
PC” on the back of the phone.

PC Port

Use this field to choose whether the user has access to phone settings. The options
include Enabled and Disable.

Setting Access

Choose Enabled or Disabled to control gratuitous ARP.Gratuitous ARP

Choose Enabled or Disabled to control access to a PC voice VLAN.PC Voice VLAN
Access

Choose Enabled or Disabled to control video capabilities access.Video Capabilities

Choose Enabled or Disabled to allow or disallow automatic line selection on the
phone.

Auto Line Select

Choose Enabled or Disabled to allow web access on the phone.Web Access
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C H A P T E R 9
Phone Deletions

This chapter provides information to delete a group of phones or other IP telephony devices from the Cisco
Unified Communications Manager database. You can locate existing phone records that you want to delete
using either a query or a custom file. You can also search for and delete unassigned directory numbers.

• Delete Phones Using Query, on page 141
• Delete Phones Using Custom File, on page 143
• Delete Unassigned Directory Numbers, on page 144

Delete Phones Using Query
Create a query to locate phone records for deletion.

The delete action is final. You cannot retrieve deleted records.Caution

Procedure

Step 1 Choose Bulk Administration > Phones > Delete Phones > Query.
The Bulk Phones Delete Configuration window displays.

Step 2 From the first Find Phone where drop-down list box, choose one of the following criteria:

• Device Name
• Description
• Directory Number
• Calling Search Space
• Device Pool
• Device Type
• Call Pickup Group
• LSC Status
• Authentication String
• Device Protocol
• Security Profile
• Unassigned DN
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• Last Registered

• Last Active

From the second Find Phone where drop-down list box, choose one of the following criteria:

• begins with
• contains
• is exactly
• ends with
• is empty
• is not empty

Step 3 Specify the appropriate search text, if applicable.

To find all phones that are registered in the database, click Find without entering any search text.Tip

Step 4 To further define your query and to add multiple filters, check the Search Within Results check box, choose
AND or OR from the drop-down box, repeat Step 2, on page 141 and Step 3, on page 142.

Step 5 Click Find.

A list of discovered phones displays by

• Device Name
• Description
• Device Pool
• Device Protocol
• Status
• Last Registered

• Last Active

• Unified CM

• IP Address

Step 6 In the Job Information area, enter the Job description.
Step 7 Choose a deletion method. Do one of the following:

a) Click Run Immediately to delete phone records immediately
b) Click Run Later to delete the phone records at a later time.

If you do not enter any information in the query text box, the system deletes all phone records.
The delete action is final. You cannot retrieve deleted records.

Caution

Step 8 Click Submit to create a job for deleting the phone records.

Make sure you browse the entire list of displayed results before submitting the job.Note

To schedule and/or activate this job, use the Job Configuration window.

Related Topics
BAT Log Files, on page 609
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Manage Scheduled Jobs, on page 599

Delete Phones Using Custom File
You can create a custom file of phones that you want to delete using a text editor. You can haveMAC addresses
and device names in the same custom file, but you cannot have directory numbers in the same file. You need
to create separate files—one file that contains the device names and MAC addresses and another file that
contains the directory numbers.

Do not use the insert or export transaction files that are created with bat.xlt for the delete transaction. Instead,
you must create a custom file with details of the phone records that need to be deleted. Use only this file for
the delete transaction.

Note

The delete action is final. You cannot retrieve deleted records.Caution

Before you begin

1. Create a text file that lists one of these details on separate lines for each phone that you want to delete:

• Device names

• Description

• Directory numbers

Enter values for device name, description, or directory number in the custom delete file. You do not need to
include a header in the custom delete file.

Note

2. Upload the custom file to Unified Communications Manager server.

Procedure

Step 1 Choose Bulk Administration > Phones > Delete Phones > Custom File.
The Bulk Phones Delete Configuration window displays.

Step 2 In the Delete Phones where drop-down list box, choose the type of custom file that you have created from
one of the following criteria:

• Device Name
• Directory Number
• Description

Step 3 In the list of custom files, choose the filename of the custom file for this delete.
Step 4 Click Find. A list of phones matching your search criteria display.
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Step 5 In the Job Information area, enter the Job description.
Step 6 Choose a deletion method. Do one of the following:

a) Click Run Immediately to delete phone records immediately
b) Click Run Later to delete the phone records at a later time.

The delete action is final. You cannot retrieve deleted records.Caution

Step 7 Click Submit to create a job for deleting the phone records.
To schedule and/or activate this job, use the Job Configuration window.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Upload File to Server, on page 21

Delete Unassigned Directory Numbers
Delete unassigned directory numbers for phone records that you locate using query.

The delete action is final. You cannot retrieve deleted unassigned directory numbers.Caution

Procedure

Step 1 Choose Bulk Administration > Phones > Delete Phones > Delete Unassigned DN.
The Delete Unassigned Directory Numbers window displays.

Step 2 From the first Delete Bulk Unassigned Directory Number where drop-down list box, choose one of the
following criteria:

• Pattern
• Description
• Route Partition

From the second Delete Bulk Unassigned Directory Number where drop-down list box, choose one of the
following criteria:

• begins with
• contains
• is exactly
• ends with
• is empty
• is not empty

Step 3 Specify the appropriate search text, if applicable.
Step 4 Click Find.
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A list of discovered phones displays by the following criteria:

• Pattern
• Description
• Partition

To find all unassigned directory numbers that are registered in the database, click Find without
entering any search text.

Tip

Step 5 In the Job Information area, enter the Job description.

The default description is Delete Unassigned DN - Query.

Step 6 Choose a deletion method. Do one of the following:
a) Click Run Immediately to delete the unassigned directory numbers immediately.
b) Click Run Later to delete the phone records at a later time.

The delete action is final. You cannot retrieve deleted unassigned directory numbers.Caution

Step 7 Click Submit to create a job for deleting the phone records.

Make sure you browse the entire list of displayed results before submitting the job.Note

To schedule and/or activate this job, use the Job Configuration window.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
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C H A P T E R 10
Phone Exports

This chapter provides information about using the export utility to merge records frommultiple Cisco Unified
Communications Manager servers onto one Cisco Unified Communications Manager server.

• Phone Record Exports, on page 147
• Exported Phone Record Fields, on page 148
• Export Phone Records, on page 149
• Multiple User Phones to Export or Import, on page 151
• Topics Related to Phone Exports, on page 151

Phone Record Exports
Use the phone record export option to move records from one Unified Communications Manager server to
another. Only export the records that you are interested in moving. You can export the following:

• phone records

• user records

• user device profile records

Optionally, you can edit the CSV file with a text editor. The record format must follow the format that is
specified for that file format. For example, records for phones need to follow the phone file format.

Use extreme care when editing the CSV file. Phones might not work if you insert records that are in the wrong
format.

Caution

You can choose between two file format options when you export phone records:

• Specific Details—For phones that have similar configurations

• All Details—For phones that have different line configurations, such as multiple partitions or calling
search spaces

When you are ready to insert the exported records, the order in which the records are inserted is important.
You must insert user records first to ensure that devices properly associate with existing users.

1. Upload the CSV file to Unified Communications Manager server.
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2. Insert User Records.

3. Insert Phone Records.

4. Insert User Device Profile Records.

5. Check the log files for errors.

Related Topics
BAT Log Files, on page 609
Export Phone Records, on page 149
Export User Device Profile Records, on page 339
Export User Records, on page 225
Topics Related to Phone Exports, on page 151
Upload File to Server, on page 21

Exported Phone Record Fields
Default Phone File Format Exported Fields

The export Default Phone file format option is useful when you want to export phone file formats for phones
that have similar configurations. Default phone records are exported using a defined query.

The following table lists the fields that are exported when you choose the Default Phone file format.

Table 7: Exported Fields in the Default Phone File Format

Exported fieldsField types

MAC Address, Description, LocationDevice Fields

Directory Number, Display, Line Text Label, Forward Busy External, Forward
Busy Internal, Forward No Answer Internal, Forward No Answer External,
Forward No Coverage Internal, Forward No Coverage External, Call Pickup
Group

Line Fields

All Phone Details File Format Exported Fields

When you export phone records using All Phone Details option, you export phone records for a particular
model of phone along with all the device field information, different line attributes, and services that are
associated with the phone, or you can export all phone models in a single file. To export all phone types to a
single file, you can choose All Phone Types from the Select the Device Type drop-down list box. You cannot
use the query to limit the number of records.

The following table lists the fields that are exported when you choose the All Phone Details file format.

The device name, not theMACAddress, gets saved when you choose to export by using the All Phone Details
file format.

Note
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Table 8: Exported Fields in the All Phone Details File Format

Exported fieldsField types

Device Name, Description, Owner User ID, Device Pool, CSS, AAR CSS, Media
Resource Group List, User Hold Audio Source, Network Hold Audio Source,
Location, User Locale, Network Locale, Phone Button Template, ExpansionModule
type I, Expansion Module type II, Softkey Template, Phone Load Name, Module
1 Load Name, Module 2 Load Name, Login user ID, Built in Bridge, MLPP
Indication, MLPP Preemption, MLPP Domain, Retry Video call as Audio, Privacy,
SecurityMode, Ignore Presentation Indicators, Single Packet Capturemode, Packet
Capture Duration, Certificate Operation, Authentication Mode, Authentication
String, Key Size (bits), Operation Completes By

Device Fields

Information, Directory, Messages, Services, Authentication Server, Proxy Server,
Idle, Idle Timer, Enable Extension Mobility, Logout Profile, Login User ID, Login
Time, Logout Time, Product Specific XML

Model Specific Device
Fields

Directory Number, Partition, Voice Mail Profile, Line CSS, AARGroup, Line User
Hold Audio Source, Line Network Hold Audio Source, Auto Answer, Forward All
to Voice Mail, Forward All Destination, Forward All CSS, Forward Busy External
to Voice Mail, Forward Busy External Destination, Forward Busy External CSS,
Forward No Answer External to Voice Mail, Forward No Answer External
Destination, Forward No Answer External CSS, Forward On Failure to Voice Mail,
Forward On Failure Destination, Forward on Failure CSS, Call pickup group,
Forward Busy Internal to Voice Mail, Forward Busy Internal Destination, Forward
Busy Internal CSS, Forward NoAnswer Internal to VoiceMail, Forward NoAnswer
Internal Destination, Forward No Answer Internal CSS, Forward No Call Coverage
External to Voice Mail, Forward No Call Coverage External Destination, Forward
No Call Coverage External CSS, Forward No Call Coverage Internal to VoiceMail,
Forward No Call Coverage Internal Destination, Forward No Call Coverage Internal
CSS, Display, External Phone Number Mask, Message Waiting Lamp Policy, Ring
Setting When Idle, Line Text Label, Ring Setting When Active, No Answer Ring
Duration,MLPPTarget Destination,MLPPCalling Search Space,MLPPNoAnswer
Ring Duration, Max Num Calls, Busy Trigger, Call Info Display Mask, Alerting
Name

Line Fields

User IDUser Fields

Speed Dial Number, Speed Dial LabelSpeed Dials

Service Name, Subscribed Service Name, Parameter Name, Parameter ValueServices

Export Phone Records
You can export phone records from the Cisco Unified Communications Manager database. After the phone
records are exported, you can search and download the exported file using the Upload/Download Files option
in the Bulk Administration menu.
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Procedure

Step 1 Choose one of the following options:

• Bulk Administration > Phones >Export Phones > Specific Details. The Export Phones Query window
displays.

• Bulk Administration > Phones > Export Phones > All Details. The Export Phone Configuration
window displays.

Step 2 For All Details option, choose the type of device or specific model in the Device Type drop-down list box.
Skip to Step 4, on page 150.
See Table 7: Exported Fields in the Default Phone File Format, on page 148 for the list of exported fields in
this format.

Step 3 For Specific Details, you can customize the export file by choosing which set of phones to export, but you
cannot configure the phone details.
a) From the first Find Phone where, drop-down list box, choose from the following options:

• Device Name
• Description
• Directory Number
• Calling Search Space
• Device Pool
• Call Pickup Group
• LSC Status
• Authentication String
• Security Profile
• Last Registered

• Last Active

b) In the second drop-down list box, choose from the following options:

• begins with
• contains
• is exactly
• ends with
• is empty
• is not empty

c) In the search field/list box, either choose or enter the value that you want to locate, such as a device name.
d) You can click the Search Within Results check box and choose AND or OR to add multiple filters and

repeat 3.a, on page 150 through 3.c, on page 150 to further define your query.
e) Click Find.

The search results display.

f) Click Next.
The Export Phones Configuration window displays.

g) From the File Format drop-down list box, choose a Phone file format.

Step 4 Enter the export file name in the File Name text box.
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Step 5 In the Job Information area, enter the Job description.
Step 6 Choose an export method. Do one of the following:

a) Click Run Immediately to export phone records immediately.
b) Click Run Later to export at a later time.

Step 7 To create a job for exporting phone records, click Submit.
To schedule and/or activate this job, use the Job Scheduler option in the Bulk Administration main menu.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Topics Related to Phone Exports, on page 151
Upload and Download Files, on page 19

Multiple User Phones to Export or Import
The exported file name gets suffixed with the timestamp. If a recurring job is scheduled for export phones,
the information gets exported with same filename but different timestamps.

When you import the exported file that has phones with multiple users, all users get exported in the same
record.

Related Topics
Topics Related to Phone Exports, on page 151

Topics Related to Phone Exports
• Export Phone Records, on page 149

• Export User Records, on page 225

• Export User Device Profile Records, on page 339
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C H A P T E R 11
Phone Line Addition and Updates

This chapter provides information to update line attributes for a specific group of devices or user device
profiles using the Update Lines option. Lines for a phone and a user device profile get updated at the same
time when both are part of the query result.

When a phone is deleted from the Cisco Unified Communications Manager database, the directory number
remains in the database. To manage these orphan directory numbers, you can use the Update Lines option to
search for unassigned directory numbers and delete or update these directory numbers.

Note

You can add lines to a group of existing phones or user device profiles in the Cisco Unified Communications
Manager database. When you use the template to add new lines, you cannot change phone services or speed
dials. Cisco Unified CommunicationsManager Bulk Administration (BAT) ignores those fields on the template
when you add lines to existing devices.

• Update Phone Lines Using Query, on page 153
• Phone Line Update Field Descriptions, on page 155
• Add Phone Lines to Existing Phones and UDPs, on page 161
• Add Phone Lines to Existing Phones Using BAT Spreadsheet, on page 162
• Phone Line Field Descriptions for Line Additions Using BAT Spreadsheet, on page 163

Update Phone Lines Using Query
You can update phone lines using query.

Procedure

Step 1 Choose Bulk Administration > Phones > Add/Update Lines > Update Lines or Bulk Administration >
User Device Profiles > Add/Update Lines > Update Lines.

The Update Lines Query window displays.

You can update all lines by not specifying a query. Skip to Phone Line Update Field Descriptions,
on page 155.

Note

Step 2 From the first Find Line where drop-down list box, choose one of the following criteria:
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• Directory Number
• Route Pattern
• Line Description
• Calling Search Space (Phone)
• Calling Search Space (Line)
• Device Pool
• Device Description
• Line Position
• Unassigned DN
• Call Pickup Group

To locate and delete orphaned directory numbers, use “unassigned DN.”Note

From the second Find Line where drop-down list box, choose one of the following criteria:

• begins with
• contains
• is exactly
• ends with
• is empty
• is not empty

Step 3 In the search field list box, choose or enter the value that you want to locate.

Example:

You can choose the Route Partition from the list or enter a range of directory numbers.

To find all lines that are registered in the database, click Find without entering any search text.Tip

Step 4 To further define your query and to add multiple filters, check the Search Within Results check box, choose
AND or OR from the drop-down box, and repeat Step 2 and Step 3.

Step 5 To display the records that are going to be affected, click Find.

A list of discovered lines displays by

• Pattern/Directory Number
• Partition
• Description

Step 6 Click Next.
The Update Lines window shows the type of query that you chose at the top.

If you want to change the type of query, click Back.Tip

Step 7 Specify the setting that you want to update for all the records that you have defined in your query.
You can choose multiple parameters to update. See Phone Line Update Field Descriptions, on page 155 for
field descriptions.

Step 8 In the Value field for the checked parameter, enter the new value or choose a value from the list box.
Step 9 In the Job Information area, enter the Job description.
Step 10 Choose an insert method. Do one of the following:
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a) Click Run Immediately to insert lines immediately.
b) Click Run Later to insert at a later time.

Step 11 To create a job for inserting the phone records, click Submit.
To schedule this job, activate this job, or both, use the Job Configuration window.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599

Phone Line Update Field Descriptions
The following table provides the field descriptions for updating line details.

Values that display in some fields display from Unified Communications Manager. You must configure these
values by using Unified Communications Manager Administration.

Table 9: Field Descriptions for Updating Line Details

DescriptionField

Choose a partition. A partition indicates the route partition to which the
directory number belongs.

The directory number can appear in more than one partition.Note

Route Partition

Choose the partitions that are searched for numbers that are called from this
directory number.

Changes cause an update of the Pickup Group Names that are
listed in the Call Pickup Group field. The setting applies to
all devices that are using this directory number.

Note

Calling Search Space (Line)

Choose the calling search space to use when a call is forwarded to the
specified destination.

This setting applies to all devices that are using this directory
number.

Note

Calling Search Space Forward
All

Enter the directory number to which all calls are forwarded.

This setting applies to any dialable phone number, including
an outside destination unless restricted, and to all devices that
are using this directory number.

Note

Forward All Destination

Check this check box to forward all calls to the number that you chose in
the voice-messaging profile.

Checking this check box makes the values in the Forward All Destination
field and Calling Search Space check box not relevant.

Forward All to Voice Mail
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DescriptionField

Choose the calling search space to use when a call from an external number
is forwarded to the specified destination.

This setting applies to all devices that are using this directory
number.

Note

Calling Search Space Forward
Busy External

When the parkee is an external party, then the call will be forwarded to the
specified destination in the parker'’s Park Monitoring Forward No Retrieve
Destination External parameter. If the Forward No Retrieve Destination
External field value is empty, the parkee will be redirected to the parker’s
line.

Park Monitoring Forward No
Retrieve Destination External

When the parkee is an internal party, then the call will be forwarded to the
specified destination in the parker’s Park Monitoring Forward No Retrieve
Destination Internal parameter. If the Forward No Retrieve Destination
Internal is empty, the parkee will be redirected to the parker’s line.

Park Monitoring Forward No
Retrieve Destination Internal

Check this check box to use settings in theVoice Mail Profile Configuration
window.

When this check box is checked, Unified CommunicationsManager ignores
the settings in the Destination box and Calling Search Space.

Park Monitoring Forward No
Retrieve Internal Voice Mail

Check this check box to use settings in the Voice Mail Profile Configuration
window.

When this check box is checked, Unified CommunicationsManager ignores
the settings in the Destination box and Calling Search Space.

Park Monitoring Forward No
Retrieve External Voice Mail

Choose the calling search space to apply to the directory number.Park Monitoring Forward No
Retrieve External CSS

Choose the calling search space to apply to the directory number.Park Monitoring Forward No
Retrieve Internal CSS

This parameter determines the number of seconds that Unified
Communications Manager waits before prompting the user to retrieve a call
that the user parked. This timer starts when the user presses the Park softkey
on the phone, and a reminder is issued when the timer expires.

Default: 60 seconds

If you configure a non-zero value, this value overrides the value of this
parameter set in the Service Parameters window. However, if you configure
a value of 0 here, then the value in the Service Parameters window will be
used.

Park Monitoring Reversion
Timer

This check box allows you to turn this feature on or off. If the check box
displays as checked (turned on), which is the default for this setting, Unified
Communications Manager logs missed calls in the call history for that
directory number on the phone.

Log Missed Calls
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DescriptionField

Choose one of the following options from the drop-down list box:

• Default—Use the value that you configured in the Party Entrance Tone
service parameter.

• On—A tone plays on the phone when a basic call changes to a
multi-party call; that is, a barge call, cBarge call, ad hoc conference,
meet-me conference, or a joined call. In addition, a different tone plays
when a party leaves the multi-party call. If the controlling device, that
is, the originator of the multi-party call has a built-in bridge, the tone
gets played to all parties if you choose On for the controlling device.
When the controlling device, for example, the conference controller, is
no longer present on the call or if the controlling device cannot play the
tone, Unified Communications Manager does not play the tone even if
you choose On.

• Off—A tone does not play on the phone when a basic call changes to
a multi-party call.

Party Entrance Tone

Choose the calling search space to use when a call from an internal number
is forwarded to the specified destination.

This setting applies to all devices that are using this directory
number.

Note

Calling Search Space Forward
Busy Internal

Enter the directory number to which a call that is coming from an external
number is forwarded when the line is in use.

This setting applies to any dialable phone number, including
an outside destination unless restricted, and to all devices that
are using this directory number.

Note

Forward Busy Destination
External

Enter the directory number to which a call that is coming from an internal
number is forwarded when the line is in use.

This setting applies to any dialable phone number, including
an outside destination unless restricted, and to all devices that
are using this directory number.

Note

Forward Busy Destination
Internal

Check this check box to forward calls from an external number to the number
that you chose in the voice-messaging profile when the line is in use.

Checking this check boxmakes the values in the Forward Busy Destination
field and Calling Search Space check box not relevant.

Forward Busy to Voice Mail
External

Check this check box to forward calls from an internal number to the number
that you chose in the voice-messaging profile when the line is in use.

Checking this check boxmakes the values in the Forward Busy Destination
field and Calling Search Space check box not relevant.

Forward Busy to Voice Mail
Internal
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DescriptionField

Choose the calling search space to use when a call from an external number
is forwarded to the specified destination. The setting displays only if it is
configured in the system.

This setting applies to all devices that are using this directory
number.

Note

Calling Search Space Forward
No Answer External

Choose the calling search space to use when a call from an internal number
is forwarded to the specified destination. The setting displays only if it is
configured in the system.

This setting applies to all devices that are using this directory
number.

Note

Calling Search Space Forward
No Answer Internal

Enter the directory number to which a call that is coming from an external
number is forwarded when the phone is not answered.

This setting applies to any dialable phone number, including
an outside destination unless restricted, and to all devices that
are using this directory number.

Note

Forward No Answer
Destination External

Enter the directory number to which a call that is coming from an internal
number is forwarded when the phone is not answered.

This setting applies to any dialable phone number, including
an outside destination unless restricted, and to all devices that
are using this directory number.

Note

Forward No Answer
Destination Internal

Check this check box to forward unanswered calls from an external number
to the number that you chose in the voice-messaging profile.

Checking this check box makes the values in the Forward No Answer
Destination field and Calling Search Space check box not relevant.

Forward No Answer to Voice
Mail External

Check this check box to forward unanswered calls from an internal number
to the number that you chose in the voice-messaging profile.

Checking this check box makes the values in the Forward No Answer
Destination field and Calling Search Space check box not relevant.

Forward No Answer to Voice
Mail Internal

Choose the calling search space to use when a call from an external number
is forwarded to the specified destination. The setting displays only if it is
configured in the system.

This setting applies to all devices that are using this directory
number.

Note

Calling Search Space Forward
No Coverage External
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DescriptionField

Choose the calling search space to use when a call from an internal number
is forwarded to the specified destination. The setting displays only if it is
configured in the system.

This setting applies to all devices that are using this directory
number.

Note

Calling Search Space Forward
No Coverage Internal

Enter the directory number to which a call that is coming from an external
number is forwarded when the phone does not have coverage.

This setting applies to any dialable phone number, including
an outside destination unless restricted, and to all devices that
are using this directory number.

Note

Forward No Coverage
Destination External

Enter the directory number to which a call that is coming from an internal
number is forwarded when the phone does not have coverage.

This setting applies to any dialable phone number, including
an outside destination unless restricted, and to all devices that
are using this directory number.

Note

Forward No Coverage
Destination Internal

Check this check box to forward calls from an external number to the number
that you chose in the voice-messaging profile when the phone does not have
coverage.

Checking this check box makes the values in the Forward No Answer
Destination field and Calling Search Space check box not relevant.

Forward No Coverage to
Voice Mail External

Check this check box to forward calls from an external number to the number
that you chose in the voice-messaging profile when the phone does not have
coverage.

Checking this check box makes the values in the Forward No Answer
Destination field and Calling Search Space check box not relevant.

Forward No Coverage to
Voice Mail Internal

(CTI ports only) Choose the calling search space to use when a call from an
internal or external call is forwarded to the specified destination. The setting
appears only if it is configured in the system.

This setting applies to all devices that are using this directory
number.

Note

Calling Search Space Forward
on Failure External/Internal

(CTI ports only) Enter the directory number to which a call that is coming
from an internal or an external number should be forwarded when a phone
or CTI application fails.

Forward on FailureDestination
External/Internal

(CTI ports only) Check this check box to forward failed calls from external
or internal numbers to the number that you chose in the voice-messaging
profile.

Forward on Failure to Voice
Mail External/Internal

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
159

Phones
Phone Line Update Field Descriptions



DescriptionField

Enter the number of seconds (between 1 and 300) to allow the call to ring,
before forwarding the call to the destination number that is entered in the
Forward No Answer Destination field.

Leave this field blank to use the value that is set in the Unified
Communications Manager service parameter, Forward No
Answer Timer.

Note

Call Forward NoAnswer Ring
Duration

Choose the music on hold audio source that plays when the user presses the
Hold button or softkey to put a call on hold.

User Hold Audio Source

Choose the music on hold audio source that plays when the system places a
call on hold such as when user transfers a call or initiates a conference or
call park.

Network Hold Audio Source

Choose this parameter if you want all lines that are updated here to use the
auto answer feature. With auto answer, Unified Communications Manager
automatically answers calls when a headset is in use. A zip tone plays to
alert the user that an incoming call connected.

Auto Answer

Choose this parameter to make the pilot number the same as the directory
number for this line. This choice proves useful if you do not have a
voice-messaging server that is configured for this phone.

Voice Mail Profile

Choose the type of ring for an incoming call on a phone.Ring Setting When Idle

Choose the type of ring for an incoming call on a phone, which is used when
this phone has another active call on a different line.

Ring Setting when Active

Choose a Pickup Group Name to specify the call pickup group, which can
answer incoming calls to this directory number by dialing the appropriate
pickup group number.

Call Pickup Group Name

Choose the automated alternate routing (AAR) group for this device. The
AAR group provides the prefix digits that are used to route calls that are
otherwise blocked due to insufficient bandwidth.

To prevent rerouting blocked calls, set AAR Group to <None>.

AAR Group

Enter the number to which MLPP precedence calls should be directed if this
directory number receives a precedence call and neither this number nor its
call forward destination answers the precedence call.

Values can include numeric characters, pound(#), and asterisk (*).

Target (Destination)

From the drop-down list box, choose the calling search space to associate
with the alternate party target (destination) number.

MLPP Calling Search Space
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DescriptionField

Enter the number of seconds (between 4 and 30) after which an MLPP
precedence call will be directed to the alternate party for this directory number
if this directory number and its call forwarding destination have not answered
the precedence call.

Leave this setting blank to use the value that is set in the Unified
CommunicationsManager enterprise parameter, Precedence Alternate Party
Timeout.

MLPP No Answer Ring
Duration

Enter the phone number (or mask) that is sent for Caller ID information when
a call is placed from this line.

You can enter a maximum of 30 numbers and “X” characters. The Xs
represent the directory number and must appear at the end of the pattern. For
example, if you specify a mask of 972813XXXX, an external call from
extension 1234 displays a caller ID number of 9728131234.

External Phone Number Mask

You can configure up to 184 calls for a line on a device in a cluster, with the
limiting factor being the device. As you configure the number of calls for
one line, the calls available for another line decrease.

The default specifies 4. If the phone does not allow multiple calls for each
line, the default specifies 2.

For CTI route points, you can configure up to 10,000 calls for each port. The
default specifies 5000 calls.

Use this field in conjunction with the Busy Trigger field.

Maximum Number of Calls

This setting, which works in conjunction with Maximum Number of Calls
and Call Forward Busy, determines the maximum number of calls to be
presented at the line. If maximum number of calls is set for 50 and the busy
trigger is set to 40, incoming call 41 gets rejected with a busy cause (and
will get forwarded if Call Forward Busy is set). If this line is shared, incoming
calls do not get rejected unless all the lines are busy.

Use this field in conjunction with Maximum Number of Calls for CTI route
points. The default specifies 4500 calls.

Busy Trigger

Add Phone Lines to Existing Phones and UDPs
You can add lines to exiting phones and UDP templates.

Before you begin

• You must have a BAT template for this transaction.
• You must have a CSV data file for this transaction.
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Procedure

Step 1 Choose Bulk Administration > Phones > Add/Update Lines > Add Lines.
The Phone Add Lines window displays.

Step 2 In the File Name field, choose the CSV data file that you created for this bulk transaction.
Step 3 In the Phone Template Name field, choose the BAT phone template to use for this bulk transaction.
Step 4 If you are changing the phone settings for existing phones in the template, check the Update the existing

phone button template check box.
The user phone information also gets updated when this check box is checked.

Step 5 In the Job Information area, enter the Job description.
Step 6 Choose an insert method. Do one of the following:

a) Click Run Immediately to insert the phone records immediately.
b) Click Run Later to insert the phone records at a later time.

Step 7 To create a job for adding lines to existing phones and UDPs, click Submit.
To schedule, this job, activate this job, or both, use the Job Configuration window.

Related Topics
Add Phone Lines to Existing Phones Using BAT Spreadsheet, on page 162
Add or Update Phone Lines in BAT Template, on page 28
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599

Add Phone Lines to Existing Phones Using BAT Spreadsheet
You can create a CSV data file using the BAT spreadsheet to add phone lines to existing phones.

After you have finished adding lines in the BAT spreadsheet, you can export the content to a CSV formatted
data file. A default filename is assigned to the exported CSV formatted data file:

<tabname>-<timestamp>.txt

where <tabname> represents the type of input file that you created, such as phones, and <timestamp> represents
the precise date and time that the file was created.

The system saves the file to C:\XLSDataFiles\, or you can save the file to another existing folder on
your local workstation. You can rename the CSV formatted data file after you save the exported file to your
local workstation. If you enter a comma in one of the fields, BAT.xlt encloses that field entry in double quotes
when you export to BAT format.

You cannot upload a CSV filename that contains a comma (for example, abcd,e.txt) to the Unified
Communications Manager server.

If you enter a blank row in the spreadsheet, the system treats the empty row as the end of the file. Data that
is entered after a blank line does not get converted to the BAT format.

Note
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Procedure

Step 1 To open the BAT Spreadsheet, locate and double-click the BAT.xlt file.
Step 2 When prompted, click Enable Macros to use the spreadsheet capabilities.
Step 3 To display the fields, click the Add Lines tab at the bottom of the spreadsheet.
Step 4 Select the Phones radio button to add lines to a phone.

You can choose to add lines to a User Device Profile by selecting the User Device Profile radio
button.

Note

Step 5 Enter data for an individual phone on each line in the spreadsheet.
Complete all mandatory fields and any relevant optional fields. Each column heading specifies the length of
the field and whether it is required or optional. See Table 10: Field Descriptions for Adding Lines Using the
BAT Spreadsheet, on page 163 for field descriptions.

Step 6 To transfer the data from the BAT Excel spreadsheet into a CSV formatted data file, click Export to BAT
Format.

For information on how to read the exported CSV data file, click the link to View Sample File
in the Insert phones window in BAT.

Tip

The system saves the file to C:\XLSDataFiles\with the default filename <tabname>-<timestamp>.txt,
or you can use Browse to save the file to another existing folder on your local workstation.

Related Topics
BAT Spreadsheet Data Collection for CSV Data File Creation, on page 12
Upload and Download Files, on page 19
Upload File to Server, on page 21

Phone Line Field Descriptions for Line Additions Using BAT
Spreadsheet

The following table provides the field descriptions when you add lines using the BAT spreadsheet.

Table 10: Field Descriptions for Adding Lines Using the BAT Spreadsheet

DescriptionField

Enter theMAC address for phones, VGC virtual phones, and VGC phones.
Enter a unique identifier for CTI ports and H.323 clients.

MAC Address

Enter a number between 1 and 34 for the line index of a phone.Line Index

Enter a directory number, up to 24 numerals and special characters, for
this line.

Directory Number
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DescriptionField

Enter the text that you want to display on the called party’s phone display,
such as the user name (John Smith) or phone location (Conference Room
1).

If this field is left blank the system uses the value that is
entered in the Directory Number field.

Note

The default language specifies English.Note

Display

Enter text that identifies this directory number for a line/phone combination.

The default language specifies EnglishNote

Line Text Label

Enter the directory number or directory URI to which a call that is coming
from an external number is forwarded when the line is in use.

This setting applies to any dialable phone number, including
an outside destination unless restricted, and to all devices
that are using this directory number.

Note

Forward Busy External

Enter the directory number or directory URI to which a call that is coming
from an external number is forwarded when the phone is not answered.

This setting applies to any dialable phone number, including
an outside destination unless restricted, and to all devices
that are using this directory number.

Note

Forward No Answer External

Enter the directory number or directory URI to which a call that is coming
from an external number is forwarded when the phone does not have
coverage.

This setting applies to any dialable phone number, including
an outside destination unless restricted, and to all devices
that are using this directory number.

Note

Forward No Coverage External

Enter the directory number or directory URI to which a call that is coming
from an internal number is forwarded when the line is in use.

This setting applies to any dialable phone number, including
an outside destination unless restricted, and to all devices
that are using this directory number.

Note

Forward Busy Internal

Enter the directory number or directory URI to which a call that is coming
from an internal number is forwarded when the phone is not answered.

This setting applies to any dialable phone number, including
an outside destination unless restricted, and to all devices
that are using this directory number.

Note

Forward No Answer Internal
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DescriptionField

Enter the directory number or directory URI to which a call that is coming
from an internal number is forwarded when the phone does not have
coverage.

This setting applies to any dialable phone number, including
an outside destination unless restricted, and to all devices
that are using this directory number.

Note

Forward No Coverage Internal

Enter a Pickup Group Name to specify the call pickup group, which can
answer incoming calls to this line by dialing the appropriate pickup group
number.

Call Pickup Group

When the parkee is an external party, then the call will be forwarded to
the specified destination in the parker’s Park Monitoring Forward No
Retrieve Destination External parameter. If the Forward No Retrieve
Destination External field value is empty, the parkee will be redirected
to the parker’s line.

Park Monitoring Forward No
Retrieve Destination External

When the parkee is an internal party, then the call will be forwarded to
the specified destination in the parker’s Park Monitoring Forward No
Retrieve Destination Internal parameter. If the Forward No Retrieve
Destination Internal is empty, the parkee will be redirected to the parker’s
line.

Park Monitoring Forward No
Retrieve Destination Internal

This parameter determines the number of seconds that Unified
Communications Manager waits before prompting the user to retrieve a
call that the user parked. This timer starts when the user presses the Park
softkey on the phone, and a reminder is issued when the timer expires.

Default: 60 seconds

If you configure a non-zero value, this value overrides the value of this
parameter set in the Service Parameters window. However, if you
configure a value of 0 here, then the value in the Service Parameters
window will be used.

Park Monitoring Reversion
Timer

This setting uses the settings in the Voice Mail Profile Configuration
window.

When this check box is checked, Unified CommunicationsManager ignores
the settings in the Destination box and Calling Search Space.

Park Monitoring Forward No
Retrieve Internal Voice Mail

This setting uses the settings in the Voice Mail Profile Configuration
window.

When this check box is checked, Unified CommunicationsManager ignores
the settings in the Destination box and Calling Search Space.

Park Monitoring Forward No
Retrieve External Voice Mail

Choose the calling search space to apply to the directory number.Park Monitoring Forward No
Retrieve External CSS

Choose the calling search space to apply to the directory number.Park Monitoring Forward No
Retrieve Internal CSS
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DescriptionField

This field allows you to turn this feature on or off. Enter ‘T’ to enable
Unified Communications Manager to log missed calls in the call history
for that directory number on the phone. Enter ‘F’ to disable this feature.

Log Missed Calls

Enter one of the following Party Entrance Tone options:

• Default—Use the value that you configured in the Party Entrance
Tone service parameter.

• On—A tone plays on the phone when a basic call changes to a
multi-party call; that is, a barge call, cBarge call, ad hoc conference,
meet-me conference, or a joined call. In addition, a different tone
plays when a party leaves the multi-party call. If the controlling
device, that is, the originator of the multi-party call has a built-in
bridge, the tone gets played to all parties if you choose On for the
controlling device. When the controlling device, for example, the
conference controller, is no longer present on the call or if the
controlling device cannot play the tone, Unified Communications
Manager does not play the tone even if you choose On.

• Off—A tone does not play on the phone when a basic call changes
to a multi-party call.

Party Entrance Tone

Enter a directory URI that you want to associate with the directory number
for this phone. Follow the username@host format. Enter a username of
up to 47 alphanumeric characters. For the host address, enter an IPv4
address or fully qualified domain name.

You can associate up to five directory URIs to a single
directory number, but you must select one primary directory
URI.

Note

URI on Directory Number

Enter the partition on which the directory URI belongs. If you do not want
to restrict access to the directory URI, leave the field blank.

URI Route Partition onDirectory
Number

Enter a ‘t’ (True) to indicate that this directory URI is the primary directory
URI for this extension. Otherwise, enter an ‘f’ (False) to indicate that this
is not the primary directory URI for this extension.

You can associate up to five directory URIs to a single
directory number, but you must select one primary directory
URI.

Note

URI Is Primary on Directory
Number

Enter a 't' to add this enterprise alternate number to a local route partition.
Enter 'f' to leave the E.164 number off of local routing.

Enterprise Add to Local Route
Partition

Enter a 't' to enable ILS to advertise this alternate number to rest of the
ILS network. Enter an 'f' if you don't want ILS to advertise this number.

Enterprise Advertise via globally
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DescriptionField

Enter a 't' to classify routing for this alternate number as urgent.

By default, if the dial plan contains overlapping route patterns Unified
Communications Manager does not route the call until the interdigit timer
expires (even if a possible route exists for the dialed digits). This setting
guards against learned numbers that overlap with statically configured
directory numbers and number patterns by allowing Unified
CommunicationsManager to choose the best match of all available routes
for the dial string.

When you mark the number as urgent priority, Unified Communications
Manager routes the call as soon as it finds a match between the dialed
digits and an available route, without waiting for the interdigit timer to
expire (for example, the T302 Timer service parameter).

Enterprise Is Urgent

Enter the number mask to apply to the directory number. Unified
CommunicationsManager applies themask to create an enterprise alternate
number that is an alias of this directory number.

Enterprise Number Mask

Enter the local route partition to which you want to assign this enterprise
alternate number.

Enterprise Route Partition

Enter a 't' to add this E.164 alternate number to a local route partition.
Enter 'f' to leave the E.164 number off of local routing.

+E.164 Add to Local Route
Partition

Enter a 't' to enable ILS to advertise this alternate number to rest of the
ILS network. Enter an 'f' if you don't want ILS to advertise this number.

+E.164 Advertise via globally

Enter a 't' to classify routing for this alternate number as urgent.

By default, if the dial plan contains overlapping route patterns Unified
Communications Manager does not route the call until the interdigit timer
expires (even if a possible route exists for the dialed digits). This setting
guards against learned numbers that overlap with statically configured
directory numbers and number patterns by allowing Unified
CommunicationsManager to choose the best match of all available routes
for the dial string.

When you mark the number as urgent priority, Unified Communications
Manager routes the call as soon as it finds a match between the dialed
digits and an available route, without waiting for the interdigit timer to
expire (for example, the T302 Timer service parameter).

+E.164 Is Urgent

Enter the number mask to apply to the directory number. Unified
Communications Manager applies the mask to create an +E.164 alternate
number that is an alias of this directory number.

+E.164 Number Mask

Enter the local route partition to which you want to assign this +E.164
alternate number.

+E.164 Route Partition
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C H A P T E R 12
Phone Resets and Restarts

This chapter provides information to reset or restart devices without updating any attributes. Use this procedure
if a problem arises, and you must reset or restart the phones with a bulk transaction. You can locate phones
that you want to reset using either a query or a custom file.

• Reset or Restart Phone Using Query, on page 169
• Reset or Restart Phone Using Custom File, on page 170
• Wipe or Lock Phones Using Query, on page 172
• Wipe or Lock Phones Using Custom File, on page 173

Reset or Restart Phone Using Query
You can create a query to locate phones that you want to reset or restart.

Procedure

Step 1 Choose Bulk Administration > Phones > Reset/Restart Phones > Query.
The Reset/Restart Phones Configuration window displays.

Step 2 From the first Find Phones where drop-down list box, choose one of the following criteria:

• Device Name
• Description
• Directory Number
• Calling Search Space
• Device Pool
• Device Type
• Call Pickup Group
• LSC Status
• Authentication String
• Device Protocol
• Security Profile
• Common Device Configuration

From the second Find Phone where drop-down list box, choose one of the following criteria:

• begins with
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• contains
• is exactly
• ends with
• is empty
• is not empty

Step 3 Specify the appropriate search text, if applicable.

To find all phones that are registered in the database, click Find without entering any search text.Tip

Step 4 To further define your query, you can choose AND or OR to add multiple filters and repeat Step 2, on page
169 and Step 3, on page 170.

Step 5 Click Find.

A list of discovered templates displays by

• Device Name
• Description
• Device Pool
• Device Protocol
• Status
• IP Address

Step 6 From the list of records, click the device name that matches your search criteria.
Step 7 Click one of the following options:

• Reset—To reset (power-cycle) the phones
• Restart—To reset phones without power-cycling
• Apply Config—To reset only the settings that have changed since the last reset

Step 8 In the Job Information area, enter the Job description.
Step 9 Choose an insert method. Do one of the following:

a) Click Run Immediately to insert phone records immediately.
b) Click Run Later to insert phone records at a later time.

Step 10 To create a job for inserting the phone records, click Submit.
To schedule this job, activate this job, or both, use the Job Configuration window.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599

Reset or Restart Phone Using Custom File
You can create a custom file of phones that you want to reset or restart using a text editor. You can use either
device names or directory numbers in the custom file.
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Before you begin

1. Create a text file that lists one of these details for the phones that you want to reset or restart:

• Device names

• Description

• Directory numbers

Put each item on a separate line in the text file.Note

2. Upload the file to the first node of Unified Communications Manager.

Procedure

Step 1 Choose Bulk Administration > Phones > Reset/Restart Phones > Custom File.
The Reset/Restart Phones Custom Configuration window displays.

Step 2 In the Update Phones where drop-down list box, choose the type of custom file that you have created from
one of the following criteria:

• Device Name
• Directory Number
• Description

Step 3 In the list of custom files, choose the filename of the custom file for this update and then click Find.

If no information is entered into the query text box, the system resets or restarts all phones.Caution

Step 4 Click one of the following

• Reset—To reset (power-cycle) the phones
• Restart—To reset phones without power-cycling
• Apply Config—To reset only the settings that have changed since the last reset

Step 5 In the Job Information area, enter the Job description.
Step 6 Choose an insert method. Do one of the following:

a) Click Run Immediately to insert phone records immediately.
b) Click Run Later to insert phone records at a later time.

Step 7 To create a job for inserting the phone records, click Submit.
To schedule and/or activate this job, use the Job Configuration window.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Upload File to Server, on page 21
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Wipe or Lock Phones Using Query
You can create a query to locate phones that you want to wipe and/or lock.

The wipe operation cannot be undone. You should only perform this operation when you are sure you want
to reset the phone to its factory settings.

Caution

Procedure

Step 1 Choose Bulk Administration > Phones > Wipe and Lock Phones > Query.
The Wipe and Lock Phones Configuration window displays.

Step 2 From the first Find Phones where drop-down list box, choose one of the following criteria:

• Device Name
• Description
• Directory Number
• Calling Search Space
• Device Pool
• Device Type
• Call Pickup Group
• LSC Status
• Authentication String
• Device Protocol
• Security Profile
• Common Device Configuration

From the second Find Phone where drop-down list box, choose one of the following criteria:

• begins with
• contains
• is exactly
• ends with
• is empty
• is not empty

Step 3 Specify the appropriate search text, if applicable.

To find all phones that are registered in the database, click Find without entering any search text.Tip

Step 4 To further define your query, you can choose AND or OR to add multiple filters and repeat Step 2 and Step 3.
Step 5 Click Find.

A list of discovered templates displays by

• Device Name
• Description
• Device Pool
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• Device Protocol
• Status
• IP Address

Step 6 From the list of records, click the device name that matches your search criteria.
Step 7 Click one of the following options:

• Lock—To lock the phones
• Wipe—To wipe the phones
• Wipe and Lock—To wipe and lock the phones

If a phone does not support the functionality you have chosen, the transaction will fail for that
phone. It will also fail if the functionality has already been requested for the phone.

Note

Step 8 In the Job Information area, enter the Job description.
Step 9 Choose an insert method. Do one of the following:

a) Click Run Immediately to wipe or lock phones immediately.
b) Click Run Later to wipe or lock phones at a later time.

Step 10 To create a job for locking and/or wiping the phones, click Submit.
To schedule and/or activate this job, use the Job Configuration window.

Wipe or Lock Phones Using Custom File
You can create a custom file of phones that you want to wipe and/or lock using a text editor. You can use
either device names or directory numbers in the custom file.

Before you begin

The wipe operation cannot be undone. You should only perform this operation when you are sure you want
to reset the phone to its factory settings.

Caution

1. Create a text file that lists one of these details for the phones that you want to wipe and/or lock:

• Device names

• Description

• Directory numbers

Put each item on a separate line in the text file.Note

2. Upload the file to the first node of Unified Communications Manager.
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Procedure

Step 1 Choose Bulk Administration > Phones > Wipe and Lock Phones > Custom File.
The Wipe and Lock Phones Configuration window displays.

Step 2 In the Update Phones where drop-down list box, choose the type of custom file that you have created from
one of the following criteria:

• Device Name
• Directory Number
• Description

Step 3 In the list of custom files, choose the filename of the custom file for this update and then click Find.

If no information is entered into the query text box, the system wipes or locks all phones.Caution

Step 4 Click one of the following:

• Lock—To lock the phones
• Wipe—To wipe the phones
• Wipe and Lock—To wipe and lock the phones

If a phone does not support the functionality you have chosen, the transaction will fail for that
phone. It will also fail if the functionality has already been requested for the phone.

Note

Step 5 In the Job Information area, enter the Job description.
Step 6 Choose an insert method. Do one of the following:

a) Click Run Immediately to wipe or lock phones immediately.
b) Click Run Later to wipe or lock phones at a later time.

Step 7 To create a job for locking and/or wiping the phones, click Submit.
To schedule and/or activate this job, use the Job Configuration window.
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C H A P T E R 13
Phone Reports

This chapter provides information about CSV file format BAT reports that you can generate. You can customize
BAT reports for phones and user device profiles but reports for users, managers, assistants, and gateways
have a fixed format and can not be customized.

• Phone Report Generation, on page 175
• Generate Phone Reports, on page 175

Phone Report Generation
Unified Communications Manager Bulk Administration (BAT) provides reports to help you manage records
effectively. You can create and save reports that provide information about phones, users, user device profiles,
managers and assistants, and gateway records. You can save these reports with a filename and store them in
a folder on the first node server to review and print.

You can customize BAT reports for phones and for user device profiles to meet your particular needs by
choosing items from a list of device fields and line fields. You can also choose how to arrange the fields in
the report. The system generates the report in the CSV file format. Because reports for users, managers,
assistants, and gateways have a fixed format, you cannot customize them.

Example

You need to have a list of all the directory numbers with their forwarding destinations by phone model. You
can generate a Phone Report for the Cisco Unified IP Phone 7960 and choose these query details: Device
Name, Directory Number, Forward Busy Destination, Forward No Answer Destination, and Label. You can
arrange the report fields, so the Label field follows the Directory Number field and precedes the two forward
destination numbers.

Generate Phone Reports
You can generate reports for phones and other IP telephony devices.

Procedure

Step 1 Choose Bulk Administration > Phones > Generate Phone Reports.
The Report Phone Query window appears.
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Step 2 In the first Find Phone where drop-down list box, choose the field to query such asDevice Name orDirectory
Number.

Step 3 In the second drop-down list box, choose the search criteria such as begins with, contains, or is empty.
Step 4 In the search field/list box, either choose or enter the value that you want to locate, such as the model name

from the list or directory number range.
Step 5 Specify the appropriate search text, if applicable, and click Find.

To generate a report for all phones that are registered in the database, click Findwithout entering
any search text.

Tip

To further define your query and to add multiple filters, check the Search Within Results check box, choose
AND or OR from the drop-down box, and repeat Steps Step 2, on page 176 through Step 5, on page 176.

A list of discovered phones appears.
Step 6 To choose details for your type of report, click Next.

The Generate Phone Report Configuration window appears and shows the Query that you chose.

If you want to change the type of query, click Back.Tip

Step 7 In the Report File Name field, enter your name for this report (required).
Step 8 In the Available Device Fields drop-down list box, choose a device item and click the arrow to move the

item into the Selected Fields for this Report list.
You must specify at least one device field to generate a report. You can choose multiple fields to include in
your report. For a list of device and live fields, see the Phone and IP Telephony Device Reports, on page 177.

To rearrange the order of the items in the Selected Device Fields for this Report list, choose an
item and click the Up arrow or Down arrow to move the item to another position in the list.

Tip

Step 9 In the Available Line Fields drop-down list box, choose a line item and click the arrow to move the item into
the Selected Fields for this Report list.
You must specify at least one line field to generate a report. You can choose multiple fields to include in your
report.

To rearrange the order of the items in the Selected Line Fields for this Report list, choose an
item and click the Up arrow or Down arrow to move the item to another position in the list.

Tip

Step 10 If you want to include IP phone services fields in your report, check the check boxes for Speed Dial Services
and/or IP Phone Services.

Step 11 In the Job Information area, enter the Job description.
Step 12 Choose when to generate the report. Do one of the following:

a) Click Run Immediately to generate the report immediately.
b) Click Run Later to generate the report at a later time.

Step 13 To create a job for inserting the phone records, click Submit.
Use the Job Configuration window to schedule this job, activate this job, or both.
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What to do next

You can search and download the report file using the Upload/Download Files option in the Bulk
Administration menu.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Upload and Download Files, on page 19

Phone and IP Telephony Device Reports
You can produce phone reports for all phones and IP telephony devices or limit the report to one of these
options:

• Device Name—Specify a filter or use exact name.

• Description—Specify a filter or use exact description.

• Phone Load Name—Specify a filter or use exact name.

• Device Pool—Choose one from a list of device pools that are configured in the cluster.

• Calling Search Space—Choose one from a list of CSS that are configured in the cluster.

• Location—Choose one from a list of locations that are configured in the cluster.

• Directory Number—Specify a filter or use exact number.

After choosing the phone report type, you can choose the device and line details to include in the report.

You can choose from these Device fields:

• AAR Calling Search Space

• AAR Neighborhood

• Authentication String

• Built In Bridge

• Calling Search Space

• Calling Search Space Reroute

• Certificate Operation

• Certificate Status

• Common Profile

• Country

• Description

• Device Name

• Device Pool

• Device Profile
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• Device Protocol

• Device_Default Profile

• Dial Rules

• Last Login user ID

• Load Information

• Location

• Login Duration

• Login Time

• MLPP Domain

• MLPP Indication

• Media Resource List

• Network Hold MOH Audio Source

• Network Location

• Packet Capture Duration

• Packet Capture Mode

• Phone Template

• Preemption

• Privacy

• Product

• Public Key

• Qsig

• SIP Profile

• Secure Shell Password

• Secure Shell User ID

• Security Profile

• Softkey Template

• Upgrade Finish Time

• User ID

• Geo Location

• Always Use Prime Line

• Always Use Prime Line for Voice Message

You can choose from these Line fields:
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• Alerting Name

• Auto Answer

• CSS_Device Failure

• CSS_MWI

• Call Forward Duration

• Calling Line Presentation Bit

• Calling Name Presentation Bit

• Calling Party Prefix Digits

• Connected Line Presentation Bit

• Connected Name Presentation Bit

• Device Failure DN

• Directory Number

• Forward All CSS

• Forward All Destination

• Forward Busy External CSS

• Forward Busy External Destination

• Forward Busy Internal CSS

• Forward Busy Internal Destination

• Forward No Answer External CSS

• Forward No Answer External Destination

• Forward No Answer Internal CSS

• Forward No Answer Internal Destination

• Forward No Answer Ring Duration

• Forward No Coverage External CSS

• Forward No Coverage External Destination

• Forward No Coverage Internal CSS

• Forward No Coverage Internal Destination

• Forward Unregistered External CSS

• Forward Unregistered External Destination

• Forward Unregistered Internal CSS

• Forward Unregistered Internal Destination

• Forward on CTI Failure CSS
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• Forward on CTI Failure Destination

• Line AAR Neighborhood

• Line Alerting Name ASCII

• Line Description

• Line Network Hold MOH Audio Source

• MLPP No Answer Ring Duration (Seconds)

• Route Partition

• Secondary Call Forward All CSS

• Target CSS

• Target Destination

• User Hold MOH Audio Source

• Party Entrance Tone

• Log Missed Calls

• Park Monitor Forward No Retrieve External Destination

• Park Monitor Forward No Retrieve Internal Destination

• Park Monitor Forward No Retrieve Internal Voice Mail

• Park Monitor Forward No Retrieve External Voice Mail

• Park Monitor Forward No Retrieve External CSS

• Park Monitor Forward No Retrieve Internal CSS

• Park Monitor Reversion Timer

• URI Is Primary on Directory Number (1-5)

• URI Route Partition on Directory Number (1-5)

• URI on Directory Number (1--5)

Generate List of Phones Having Dummy MAC Addresses
You can generate a list of phones that use dummy MAC addresses.

Procedure

Step 1 Choose Bulk Administration > Phones > Generate Phone Reports.
The Report Phone Query window displays.

Step 2 In the first Find Phone(s) where drop-down list box, choose Device Name.
Step 3 In the second drop-down list box, choose begins with.
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Step 4 In the text field, enter BAT. All phones that are added with a dummy MAC address have device names that
begin with BAT.

Step 5 Click Find. The text Device Name begins with 'BAT' and displays in the query text box.
Step 6 Click Next. The Generate Phone Report Configuration window displays.

What to do next

Complete the report generation procedure. Go to Generate Phone Reports, on page 175.

Refer to Report Log Files, on page 287.
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C H A P T E R 14
Phone Migrations

Using Cisco Unified Communications Manager Bulk Administration (BAT), you can migrate a group of
phones from Skinny Client Control Protocol (SCCP) to Session Initiation Protocol (SIP).

• Migrate Phone From SCCP to SIP, on page 183
• Topics Related to Phone Migration, on page 185

Migrate Phone From SCCP to SIP
You can migrate phones from SCCP to SIP. During the SCCP to SIP migration, only SIP specific default
values in the phone report get migrated. Other values in the template are not migrated.

Migrating a phone that is running SCCP to SIP does not require a manual reset because the migration itself
handles the reset of phones.

Note

Procedure

Step 1 Choose Bulk Administration > Phones > Migrate Phones > SCCP to SIP.
The Migrate Phones—SCCP to SIP window displays.

Step 2 From the first Find Phone where drop-down list box, choose one of the following criteria:

• Device Name

• Description

• Directory Number

• Calling Search Space

• Device Pool

• Device Type

• Call Pickup Group

• LSC Status
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• Authentication String

• Location

• Phone Load Name

• Security Profile

Step 3 From the second Find Phone where drop-down list box, choose one of the following criteria:

• begins with

• contains

• is exactly

• ends with

• is empty

• is not empty

Step 4 Specify the appropriate search text, if applicable, then click Find.

To further define your query, check the check box corresponding to Search Within Results Using drop-down
list box. You can choose AND or OR to add multiple filters. Repeat Step 2, on page 183 through Step 4, on
page 184.

To find all phones that are registered in the database, click Find without entering any search text.Tip

A list of discovered phones displays by:

• Device Name

• Description

• Device Pool

• Device Protocol

• Status

• IP Address

Step 5 Click Next.
Step 6 From the drop-down list box, choose the phone template.

SCCP to SIP migration will pick up only SIP specific default values from this template during
migration. It will not pick any other value from the template.

Note

Step 7 In the Job Information area, enter the Job description.
Step 8 Choose a migration method. Do one of the following:

a) Click Run Immediately to migrate phone records immediately.
b) Click Run Later to migrate phone records at a later time.

Step 9 To create a job for migrating the phone records, click Submit.
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To schedule and/or activate this job, use the Job Scheduler option in the Bulk Administration main menu.

What to do next

After submitting a job for migrating phones from SCCP to SIP, make sure that you reset these phones. Reset
phones by using BulkAdministration > Phones > Reset/Restart Phones > Query.

Related Topics
BAT Log Files, on page 609
Reset or Restart Phone Using Query, on page 169
Manage Scheduled Jobs, on page 599
Topics Related to Phone Migration, on page 185

Topics Related to Phone Migration
• Migrate Phone From SCCP to SIP, on page 183

• Reset or Restart Phone Using Query, on page 169

• Manage Scheduled Jobs, on page 599
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C H A P T E R 15
Intercom Additions and Updates

The Intercom feature allows one user to call another user, and that call automatically gets answered with
one-way media from caller to called party, regardless of whether the called party is busy or idle.

You can use the Add/Update Intercom utility to add or update intercoms in bulk to Cisco Unified
Communications Manager server.

• Update Intercom DNs, on page 187
• Add Intercom DNs, on page 188
• Intercom DN Update Field Descriptions, on page 189

Update Intercom DNs
You can update Intercom DNs for phones or devices.

Procedure

Step 1 Choose which intercom DN to update. Do one of the following:
a) Choose Bulk Administration > Phones > Add/Update Intercom > Update Intercom Directory

Numbers to update Phone intercom directory numbers.
b) Choose Bulk Administration > User Device Profiles > Add/Update Intercom > Update Intercom

Directory Numbers to update User Device Profile intercom directory numbers.

Step 2 From the first Find and List Intercom Directory Numbers To Update where drop-down list, choose one
of the following criteria:

• Intercom Directory Number

• Route Partition

• Description

Step 3 From the second Find and List Intercom Directory Numbers To Update where drop-down list, choose
one of the following criteria:

• begins with

• contains
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• ends with

• is exactly

• is empty

• is not empty

Step 4 Specify the appropriate search text in the text field, if applicable.

To find all Intercom DNs that are registered in the database, click Find without entering any
search text.

Tip

Step 5 To further define your query, you can choose AND or OR to add multiple filters and repeat Step 2, on page
187 and Step 3, on page 187.

Step 6 Click Find.

A list of discovered Intercom DNs displays by:

• Intercom DN Pattern

• Route Partition

• Description

Step 7 Click Next.
Step 8 Specify the settings that you want to update for all the records that you have defined in your query.

You can choose multiple parameters to update.

Related Topics
Intercom DN Update Field Descriptions, on page 189

Add Intercom DNs
You can add Intercom DNs to a Unified Communications Manager server.

Before you begin

• You must have a data file in comma separated value (CSV) format that contains the unique details for
the phones or other IP telephony devices.

• Upload the data files by choosing the relevant target and function for the transaction.

Procedure

Step 1 Choose Bulk Administration > Phones > Add/Update Intercom > Add Intercom Directory Numbers.
Step 2 In theFile Name drop-down list box, choose the CSV data file that you created for this specific bulk transaction.
Step 3 In the Phone Template Name drop-down list, choose the BAT Phone template that you created for this type

of bulk transaction.
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Step 4 Check the Override Configuration Settings check box to update the existing phone button template settings
with the information that is contained in the file that you want to insert.
Consider overriding the configuration settings as optional.

Step 5 In the Job Information area, enter the Job description.

The default job description for this transaction specifies Insert Intercom DNs.

Step 6 Choose a method to add Intercom DNs. Do one of the following:
a) Click Run Immediately to add Intercom DNs immediately.
b) Click Run Later to add Intercom DNs at a later time.

Step 7 To create a job for adding Intercom DNs, click Submit.
To schedule and/or activate this job, use the Job Configuration window.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599

Intercom DN Update Field Descriptions
The following table provides the field descriptions for updating line details.

Table 11: Field Description for Updating Intercom DN Details

DescriptionField

Intercom Directory Number Information

Choose a route partition to which the directory number belongs.

The directory number can appear in more than one
partition.

Note

Route Partition

Enter a description that makes the device easy to recognize. The
description can include up to 50 characters in any language, but it
cannot include double-quotes ("), percentage sign (%), ampersand (&),
or angle brackets (<>).

Description

This name represents the name that displays during an alert to a shared
directory number. For non-shared directory numbers, during alerts, the
system uses the name that is entered in the Display field.

Alerting Name

This field provides the same information as the Alerting Name field,
but you must limit input to ASCII characters. Devices that do not
support Unicode (internationalized) characters display the content of
the Alerting Name ASCII field.

ASCII Alerting Name

Intercom Directory Number Settings
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DescriptionField

Choose the calling search space to which this group of phones/ports
should belong.

A calling search space specifies the collection of route partitions that
are searched to determine how a dialed number should be routed.

Calling Search Space

Used with the Presence feature, the phone that is running SIP or SCCP
serves as a watcher because it requests status about the presence entity,
for example, directory number, that is configured as a BLF speed dial
button on the phone.

If you want the phone to receive the status of the presence entity, choose
a Presence Group that is allowed to view the status of the Presence
Group that is applied to the directory number, as indicated in the
Presence Group Configuration window.

Presence Group
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P A R T IV
Users

• User Additions, on page 193
• User Templates, on page 199
• User Insertions, on page 207
• User Updates, on page 209
• User Deletions, on page 221
• User Record Exports, on page 225
• Password and PIN Resets, on page 229
• User Report Generation, on page 233
• Line Appearance, on page 235
• End User CAPF Profiles, on page 239





C H A P T E R 16
User Additions

This chapter describes how to manage user records and work with user combinations, such as phones and
users or CTI ports and user records in the Cisco Unified Communications Manager LDAP database.

• New User Group Additions and User Associations, on page 193
• Add Users, on page 193
• Create User CSV Data File From BAT Spreadsheet, on page 194
• BAT Spreadsheet User Data Field Descriptions, on page 195
• Topics Related to User Additions, on page 198

New User Group Additions and User Associations
You can use Unified Communications Manager Bulk Administration (BAT) to add a group of new users and
to associate users to phones and other IP Telephony devices in the Unified CommunicationsManager database.

If you use your corporate directory and have Lightweight Directory Access Protocol (LDAP) synchronization
enabled (in Cisco Unified Communications Manager Administration, choose System > LDAP >
LDAP System), then you cannot use BAT to reset passwords, and insert/update or delete users.

Note

Related Topics
Add Users, on page 193
Export User Records, on page 225
Generate User Reports, on page 233

Add Users
You must create a CSV data file to add new users in bulk to the Unified Communications Manager database
using the BAT spreadsheet. For users who have applications that require a CTI port, such as CiscoIPSoftPhone,
BAT can associate CTI ports to existing users.
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Procedure

Step 1 Create a comma separated values (CSV) data file to define individual values for each user that you want to
add.

Step 2 Use BAT to insert the users in the Unified Communications Manager database.

Related Topics
Create Text-Based CSV User File, on page 635
Create User CSV Data File From BAT Spreadsheet, on page 194
Insert Users in Unified Communications Manager Database, on page 207
Topics Related to User Additions, on page 198

Create User CSV Data File From BAT Spreadsheet
You can provide details for adding new users to the Unified Communications Manager database in the BAT
spreadsheet and then convert it in to a CSV data file.

If you enter a blank row in the BAT spreadsheet, the system treats the empty row as the end of the file and
does not convert data that is entered after a blank line to the BAT format.

Note

After you have finished editing the fields to add users in the BAT spreadsheet, you can export the content to
a CSV formatted data file. A default filename is assigned to the exported CSV formatted data file:

<tabname>-<timestamp>.txt

where <tabname> represents the type of input file that you created, such as phones, and <timestamp> represents
the precise date and time that the file was created.

You can rename the CSV formatted data file after you save the exported file to your local workstation. If you
enter a comma in one of the fields, BAT.xlt encloses that field entry in double quotes when you export to
BAT format.

You cannot upload a CSV filename that contains a comma (for example, abcd,e.txt) to the Unified
Communications Manager server.

Note

Procedure

Step 1 To open the BAT spreadsheet, locate and double-click BAT.xlt file.
Step 2 When prompted, click Enable Macros to use the spreadsheet capabilities.
Step 3 To add users, click the Users tab at the bottom of the spreadsheet.
Step 4 Complete all mandatory fields and any relevant optional fields. Each column heading specifies the length of

the field and whether it is required or optional.
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In each row, provide the information as described in the online help files.

• If a user has multiple devices, the device name field should be repeated, once for each device.
• To enter additional device names that will be associated to a new user, enter a value in the Number of

Controlled Devices text box.

You can associate all devices, including CTI ports, ATA ports, and H.323 clients, with a user.Note

Step 5 To enter additional device names that will be associated to a new user, enter a value in the Number of
Controlled Devices text box.

Step 6 Click Export to BAT Format to transfer the data from the BAT Excel spreadsheet into a CSV formatted
data file.

The system saves the file to C:\XLSDataFiles with the default file name <tabname>-<timestamp>.txt , or uses
Browse to save the file to another existing folder.

For information on how to read the exported CSV data file, click the link to View Sample File
in the Insert Users window in BAT.

Tip

What to do next

You must upload the CSV data file to the first node of Unified Communications Manager database server so
that BAT can access the data file.

Related Topics
BAT Spreadsheet Data Collection for CSV Data File Creation, on page 12
Topics Related to User Additions, on page 198
Upload and Download Files, on page 19

BAT Spreadsheet User Data Field Descriptions
The following table provides the field descriptions for adding users details.

Table 12: Field Description in BAT Spreadsheet for Adding Users

DescriptionField

Enter the first name, up to 64 characters, of the phone user.First Name

Enter the middle name, up to 64 characters, of the phone user.Middle Name

Enter the last name, from 1 to 64 characters, of the phone user.Last Name

Enter the last name, from 1 to 128 characters, of the phone user.User ID
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DescriptionField

Enter the password, up to 128 characters, that the user needs to access
the CiscoIPPhone Configuration window.

You must specify the Password either in the CSV data file or by using
the BAT user interface during the user template addition. If you want
to apply individual passwords for each user or groups of users, specify
the password information in the CSV data file. If you want to use a
default password for all users, provide the default password when you
insert the users in BAT.

Password

Enter manager user ID, up to 128 characters, for the user of this phone.Manager User ID

Enter the department number, up to 64 characters, for the user of this
phone.

Department

Enter the personal identification number (PIN), up to 128 numerals,
to be used for extension mobility.

You must enter a PIN either in the CSV data file or by using the BAT
user interface during the user template addition. If you want to apply
individual PINs for each user or groups of users, specify the PIN in
the CSV data file. To use a default PIN that all users can use, provide
default PIN when you insert the users in BAT.

PIN

Enter the default profile for this user and device, up to 50 characters.
You can choose the user device profile from the list of existing UDPs
in CiscoUnified CommunicationsManager Administration that appears
in BAT.

Default Profile

Enter the language and country set, up to 50 characters, that you want
to associate with this user. Your choice determines which
cultural-dependent attributes exist for this user and which language
displays in the Unified Communications Manager user windows and
phones.

User Locale

Enter the name, up to 50 characters, for the phone or device that you
want to associate with this user.

The Controlled Device field(s) displays when the
Number of Controlled Devices field, at the extreme
right in the spreadsheet, is set to greater than Zero.

Note

Controlled Device 1

Enter the telephone number, up to 64 numerals for the primary
extension (usually Line 1) for the phone.

Telephone Number

This field displays after the user is added and represents the primary
database number for the user. You choose no primary line when you
associate devices to the user. Users can have multiple lines on their
phones.

Primary Extension
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DescriptionField

This field, which is required for Cisco SoftPhone and Cisco Unified
Communications Manager Attendant Console users, displays after the
user is added.

Associated PC

From the drop-down list box, choose an IPCC extension for this user.IPCC Extension

Enter the user e-mail address up to 255 characters.Mail ID

Enter the name, up to 50 characters, for any additional phones that you
want to associate with this user.

The Controlled Device field(s) displays when the
Number of Controlled Devices field, at the extreme
right in the spreadsheet, is set to greater than zero.

Note

Controlled Device 2

Enter the presence group that watches the status of the database number,
the presence entity.

Presence Group

All calling search spaces that you configure in Cisco Unified
CommunicationsManager Administration display in the SUBSCRIBE
Calling Search Space drop-down list box.

The SUBSCRIBECalling Search Space determines howCisco Unified
Communications Manager routes the Presence subscription requests
that come from the user. To configure a calling search space specifically
for this purpose, you configure a calling search space as you do all
calling search spaces (Call Routing >Class Control >Calling Search
Space).

SUBSCRIBE Calling Search
Space

When you configure digest authentication for phones that are running
SIP, Cisco Unified Communications Manager challenges the identity
of the phone every time the phone sends a SIP request to Cisco Unified
CommunicationsManager. The digest credentials that you enter in this
field get associated with the phone when you choose a digest user in
the Phone Configuration window.

Enter a string of up to 128 alphanumeric characters.

For more information on digest authentication, refer to the Cisco
Unified Communications Manager Security Guide Security Guide.

Digest Credentials

Enter the user group to which the user belongs.

The User Group field(s) displays when the Number of
User Groups field, at the extreme right in the spreadsheet,
is set to greater than zero.

Note

User Group
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DescriptionField

Enter the primary directory URI that you want to associate to this user’s
primary extension. Follow the username@host format. Enter a username
of up to 47 alphanumeric characters. For the host address, enter an
IPv4 address or fully qualified domain name.

Within Cisco Unified CM Administration, you can enter
directory URIs with embedded double quotes or commas.
However, when you use Bulk Administration to import
a csv file that contains directory URIs with embedded
double quotes and commas, you must use enclose the
entire directory URI in double quotes and escape the
embedded double quotes with a double quote. For
example, the Jared, "Jerry",Smith@test.com directory
URI must be input as "Jared,""Jerry"",Smith@test.com"
in the csv file.

Note

Directory URI

The Self-Service User ID is a DTMF digit string that is used to identify
a user (usually same as the user directory number).

Self-Service User ID

The User Profile is a profile that collects settings to share across a
group of users. This profile is used when you create new devices.

User Profile

Enter the maximum login time for Extension Mobility and Extension
Mobility Cross Cluster users. Enter the value in minutes. The range of
the value is from 0 to 10080 minutes (7 days).

EM MAX LOGIN TIME

Topics Related to User Additions
• Add Users, on page 193

• Export User Records, on page 225

• Generate User Reports, on page 233

• BAT Log Files, on page 609.
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C H A P T E R 17
User Templates

This chapter provides information about using Cisco Unified Communications Manager Bulk Administration
(BAT) user templates to define the common user attributes to add a group of new users.

• Find BAT User Template, on page 199
• Create New BAT User Template, on page 200
• Modify BAT User Template, on page 200
• Copy BAT User Template, on page 201
• Delete BAT User Template, on page 201
• BAT User Template Field Descriptions, on page 202

Find BAT User Template
Unified Communications Manager lets you locate specific user templates on the basis of specific criteria,
which is useful when you have more than one user template.

During your work in a browser session, your find/list search preferences get stored in the cookies on the client
machine. If you navigate to other menu items and return to this menu item, or if you close the browser and
then reopen a new browser window, the system retains your Unified Communications Manager search
preferences until you modify your search.

Note

Procedure

Step 1 Choose Bulk Administration > Users > User Template.

The Find and List User Templates window displays. Use the two drop-down list boxes to search for a
template.

Step 2 From the first Find User Template where drop-down list box, choose one of the following criteria:

• User Template Name
• Department

From the second Find User Template where drop-down list box, choose one of the following criteria:

• begins with
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• contains
• is exactly
• ends with
• is empty
• is not empty

Step 3 Specify the appropriate search text, if applicable, and click Find.

To find all User Templates that are registered in the database, click Find without entering any
search text.

Tip

A list of discovered templates displays by

• User Template
• Department

Step 4 From the list of records, click the user template that matches your search criteria.
The window displays the user template that you choose.

Create New BAT User Template
You can create new user templates.

Procedure

Step 1 Choose Bulk Administration > Users > User Template.
The Find and List User Templates window displays.

Step 2 Click Add New.
The User Template Configuration window displays.

Step 3 Enter the user settings that this group of users have in common.
See BAT User Template Field Descriptions, on page 202 for field descriptions.

Step 4 Click Save.
When the user template is added to the database, the status indicates that the transaction has completed.

Modify BAT User Template
You can view or modify an existing user template.

Procedure

Step 1 Find the user template that you want to modify.
Step 2 In the User Template Configuration window, add, change, or remove settings in the template.
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See Table 13: Field Descriptions for a User Template in BAT, on page 202 for field descriptions.

Step 3 After you have modified the settings to update the template, click Save.

Related Topics
Find BAT User Template, on page 199

Copy BAT User Template
You can copy the properties of a user template into a new user template when you want to change only a few
fields.

Procedure

Step 1 Find the user template that you want to copy.
Step 2 In the User Template Configuration window, verify that this is the template that you want to copy and click

Copy.
The template reproduces and creates a copy. The copy duplicates all the values that were specified in the
original template.

Step 3 Update the fields as needed for the new template.
See Table 13: Field Descriptions for a User Template in BAT, on page 202 for field descriptions.

Step 4 Click Save.

Related Topics
Find BAT User Template, on page 199

Delete BAT User Template
You can delete BAT user templates when you no longer require them. Use this procedure to delete a user
template.

The delete action is final. You cannot retrieve deleted templates.Caution

Procedure

Step 1 Find the user template that you want to delete.
Step 2 In the User Template Configuration window, verify that this is the template that you want to delete and

click Delete.

You can also delete the user template from the Find and List User Templates window. Check
the check box next to the template that you want to delete and click Delete Selected.

Note
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A message displays that asks you to confirm the delete operation.

Step 3 To delete the template, click OK. The template name disappears from the list of user templates list on the
Find and List User Templates window.

If you submit a job with a particular user template, and if you delete that user template before
the execution of the job, the job also gets deleted. You have to resubmit the job by creating another
user template.

Caution

Related Topics
Find BAT User Template, on page 199

BAT User Template Field Descriptions
In the BAT user interface, field names that have an asterisk require an entry. Treat fields that do not have an
asterisk as optional.

The following table provides descriptions of all possible fields that appear after you add a BAT user template.

Table 13: Field Descriptions for a User Template in BAT

DescriptionField

Enter a unique name, up to 30 alphanumeric characters, for the user
template.

User Template Name

Check this check box if you want to make the user ID the default
password for all users.

Default Password to User ID

Check this check box to make the telephone number the default PIN.Default PIN to Telephone Number

Check this check box to make the telephone number the primary
extension.

Default Telephone Number to
Primary Extension

Check this check box to make the mail ID to default for the user ID.Default Mail ID to User ID

Enter manager user ID, up to 128 characters, for the user of this phone.Manager User ID

Enter the department number, up to 64 characters, for the user of this
phone.

Department

Choose the language and country set that you want to associate with
this user from the drop-down list. Your choice determines which
cultural-dependent attributes exist for this user and which language
displays in the Unified CM user windows and phones.

User Locale

This field, which is required for Cisco SoftPhone and Cisco Unified
Communications Manager Attendant Console users, displays after
the user is added.

Associated PC

Choose the default profile for this user from the default Profile
drop-down list.

Default Profile
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DescriptionField

From the drop-down list, choose the BLF presence group that watches
the status of the directory number, the presence entity.

BLF Presence Group

All calling search spaces that you configure in Unified CM
Administration appear in the SUBSCRIBE Calling Search Space
drop-down list.

The SUBSCRIBECalling Search Space determines howCiscoUnified
Communications Manager routes the Presence subscription requests
that come from the user. To configure a calling search space
specifically for this purpose, you configure a calling search space as
you do all calling search spaces (Call Routing > Class Control >
Calling Search Space).

SUBSCRIBE Calling Search Space

Check this check box to allow CTI to control and monitor this device.

If the associated directory number specifies a shared line, enable this
check box as long as at least one associated device specifies a
combination of device type and protocol that CTI supports.

Cisco dual-mode devices (Jabber) such as Android,
iPhone, and iPad operating inWiFi mode are monitored
through CTI and not controlled. However, devices
operating in GSM mode cannot be monitored or
controlled.

Note

Allow Control of Device from CTI

Check this check box to enable the EMCC service.EMCC Enabled

From the drop-down list box, select the rank that you want to assign
to this user. The highest rank is 1, the lowest is 10.

User Rank

From the drop-down list, choose the access control group to which
the user belongs. Only those access control groups that are either the
same or lower than the user's rank are available to select from.

Access Control Group

When you configure digest authentication for phones that are running
SIP, Cisco Unified Communications Manager challenges the identity
of the phone every time that the phone sends a SIP request to Cisco
Unified Communications Manager. The digest credentials that you
enter in this field get associated with the phone when you choose a
digest user in the Phone Configuration window.

Enter a string of up to 128 alphanumeric characters.

For information about digest authentication, see the Cisco Unified
Communications Manager Security Guide.

Digest Credentials

To confirm that you entered the digest credentials correctly, reenter
the credentials in this field.

Confirm Digest Credentials
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DescriptionField

Check this check box to home users in this user template to this cluster.
The user must only be homed to one cluster within the enterprise.

IM and Presence does not function properly if a user is
assigned to more than one home cluster.

Note

Home Cluster

Check this check box to enable users in this user template for IM and
Presence. Configure IM and Presence in the associated service profile.

You must install a Cisco Unified Communications
Manager IM and Presence node along with this Cisco
Unified Communications Manager cluster.

Use the User Management > User Settings > UC
Servicesmenu to configure the IM and Presence service.

Note

Enable User for Unified CM IM and
Presence

Check this check box to enable the user to include meeting and
calendar information in IM and Presence Service.

The user must be on the home cluster and have IM and Presence
enabled. Also ensure that an Exchange PresenceGateway is configured
on the Cisco Unified Communications Manager IM and Presence
Service server.

Include meeting information in
Presence

Assign a user to an IM and Presence Service server that is installed
in the cluster if the system is nonbalanced. The server you specify
using the Bulk Administration Tool must be part of a Presence
Redundancy Group.

For clusters that have the user assignment mode for the IM and
Presence server set to balanced or active-standby, user assignments
that are made using the Bulk Administration Tool override the
automatic user assignments.

Assigned Presence Server

Choose a UC service profile from the drop-down list.

Use the User Management > User Settings > Service
Profile menu to set up service profiles for the users.

Note

UC Service Profile

Check this check box to activate Cisco UnifiedMobility, which allows
a user to manage calls by using a single phone number and to pick up
calls on the desk phone and mobile phone.

Enable Mobility

Check this check box to allow the user to access the Mobile Voice
Access integrated voice response (IVR) system to initiate Cisco
Unified Mobility calls and activate or deactivate Cisco Unified
Mobility capabilities.

Enable Mobile Voice Access

Enter the maximum wait time, up to five numerals, for this user.

This value indicates the maximum time that is permitted to pass before
the user pickup a call that is transferred from the mobile phone to the
desk phone.

Maximum Wait Time for Desk
Pickup
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DescriptionField

Enter the maximum login time in the HHH:MM format to configure
maximum login time for the Extension Mobility and Extension
Mobility Cross Cluster users.

The value ranges from 00:01 to 168:00 hours.

For example: 168:00, 25:16, 025:16, :30 or 00:30.

Maximum Login Time (HHH:MM)

Enter the maximum number of phones, up to two numerals, to which
the user is permitted to transfer calls from the desk phone.

Remote Destination Limit
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C H A P T E R 18
User Insertions

This chapter provides information to use Cisco Unified CommunicationsManager Bulk Administration (BAT)
to add a group of users to the Cisco Unified Communications Manager database.

This feature supports only custom files that are saved with the UTF-8 encoding format.Note

• Insert Users in Unified Communications Manager Database, on page 207
• Topics Related to User Insertions, on page 208

Insert Users in Unified Communications Manager Database
You can add a group of users to the Unified Communications Manager database using a CSV data file. The
field values that you enter in the CSV file for inserting users override the values provided in the user template.

If the credential policy has “check for trivial password” enabled, and the password in the user template is the
user ID, inserting users through BAT may fail if the user ID does not satisfy the necessary criteria for the
trivial password.

Attention

Users can be inserted using BATwith primary extension configured without any devices selected for controlled
devices. To do so, you must pre-populate the DN in Unified Communications Manager before inserting the
users using BAT. The following steps outline the process of pre-populating the DN:

1. Create range of DNs to be associated for primary extension for users in the DN page.

2. Create a BAT template with primary extension configured (which should be the same DN's pre-populated).

3. Insert the users using BAT (as shown in the following procedure)

Before you begin

You must have a CSV data file that is saved in the UTF-8 encoding format and that contains the usernames,
controlled device names, and directory numbers. You can create the CSV data file by using one of these
methods:

• BAT spreadsheet that is converted to CSV format
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• Export utility that produces an export file of user data

When you are inserting users by using an exported BAT file, you might get errors stating “User ID already
exists” for some users that were exported in more than one file. For example, a list of first line managers and
a list of users might both include the same manager user ID.

Note

Procedure

Step 1 Choose Bulk Administration > Users > Insert Users.
Step 2 In the File Name field, choose the CSV data file that you created for this bulk transaction.
Step 3 If the CSV data file was created by using the export utility, check the File created with Export Users check

box.
Step 4 From the User Template Name drop-down list, choose the user template you want to use for this insert.

The User Profile, Controlled Device Name, and Directory Number should exist in the Unified
Communications Manager database. The controlled device name should be entered in full. If it
contains only MAC Address, then BAT displays a non-existing device error.

Note

Step 5 In the Job Information area, enter the Job description.
Step 6 Choose an insert method. Do one of the following:

a) Click Run Immediately to insert the user records immediately.
b) Click Run Later to insert the user records at a later time.

Step 7 To create a job for inserting the user records, click Submit.
To schedule and/or activate this job, use the Job Scheduler option in the Bulk Administration main menu.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Topics Related to User Insertions, on page 208

Topics Related to User Insertions
• Create New BAT User Template, on page 200

• BAT User Template Field Descriptions, on page 202

• Insert Users in Unified Communications Manager Database, on page 207
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C H A P T E R 19
User Updates

This chapter provides information about updating existing user records in the Cisco Unified Communications
Manager database.

• Update User Information Using CSV Data File, on page 209
• Update User Information in Cisco Unified Communications Manager Directory, on page 214
• User Update Settings, on page 215
• Topics Related to User Updates, on page 220

Update User Information Using CSV Data File
You can update existing user information that is in the database using a comma-separated value (CSV) data
file you create using the Bulk Administration (BAT) spreadsheet, or you can update a user file format using
a custom text-based CSV file.

You can retain existing user information and settings that were previously stored in the Unified CM directory.

You do not require a user template for the update users transaction using a custom text-based CSV file. If you
choose a user template, the system takes the fields that are not provided in the CSV from the template for the
update or else these fields are ignored. Also, if you specify another value for fields to be ignored (for example,
#), then the fields with the value # are ignored, because blank is not a value to be ignored for such fields.

The Bulk Administration Tool (BAT) cannot be used to disassociate devices that are already associated to an
end user. If you manually delete a controlled device from an exported end user record and then insert the
modified user record back in to the Cisco Unified Communications Manager database as a custom CSV data
file, the insertion appears as successful when you check the job results using Bulk Administration > Job
Scheduler. However, the controlled device is still listed on the end-user page.

Note

Procedure

Step 1 Create a CSV data file to define individual values for each user that you want to update.
Step 2 Use BAT to insert the updated user records that are in the database.
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Related Topics
Create User Update CSV Data File Using BAT Spreadsheet, on page 210
Retain Existing User Information During Update, on page 210
Topics Related to User Updates, on page 220
Update Users File Format, on page 637
Update User Information in Cisco Unified Communications Manager Directory, on page 214

Retain Existing User Information During Update
When you update user records, you can keep values or settings for a user that were previously stored in the
Unified CM directory. You can use a symbol such as“#” for fields where the value must be retained. In the
following example CSV data file, the # tells BAT to keep the Manager field the same as the one that was
previously entered in the DC directory.
userid,#,department,,,123456789012,

To identify the value to use to retain a stored value, use the following procedure.

Procedure

Step 1 Choose Bulk Administration > Users > Update Users.

The User Update Configuration window appears.

Step 2 Notice the Value for fields to be ignored field. When you insert the CSV data file with the updated user
values, you must enter the symbol that you used to retain values in this box.

Step 3 Decide the symbol that you want to use for retaining values.
Step 4 Enter this value that is in the Value for fields to be ignored field into the BAT spreadsheet box.
Step 5 Use this symbol in BAT spreadsheet fields for any values that you want to retain.

Related Topics
Topics Related to User Updates, on page 220

Create User Update CSV Data File Using BAT Spreadsheet
You can create a CSV data file using the BAT spreadsheet to update a group of existing users.

After you add lines in the BAT spreadsheet, you can export the content to a CSV formatted data file. A default
filename is assigned to the exported CSV formatted update users data file:

Update_Users-timestamp.txt

where <timestamp> represents the precise date and time that the file was created.

The system saves the file with a default filename to C:\XlsDataFiles\, or you can save the file to another
existing folder on your local workstation. You can rename the CSV formatted data file after you save the
exported file to your local workstation. If you enter a comma in one of the fields, BAT.xlt encloses that field
entry in double quotes when you export to BAT format.
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You cannot upload a CSV filename that contains a comma (for example, abcd,e.txt) to the server.

If you enter a blank row in the spreadsheet, the system treats the empty row as the end of the file. Data that
you enter after a blank line is not converted to the BAT format.

Note

The Bulk Administration Tool (BAT) cannot be used to disassociate devices that are already associated to an
end user. If you manually delete a controlled device from an exported end-user record and then insert the
modified user record back in to the Unified Communications Manager database as a custom CSV data file,
the insertion appears successful when you check the job results usingBulk Administration > Job Scheduler.
However, the controlled device is still listed on the End User Configuration window in Cisco Unified
Communications Manager Administration.

Procedure

Step 1 Download and open the BAT.xlt file.
Step 2 When prompted, click Enable Macros to use the spreadsheet capabilities.
Step 3 To add user information, click the Update Users tab at the bottom of the spreadsheet.
Step 4 Complete all mandatory fields and any relevant, optional fields.

Each column heading specifies the length of the field and whether it is required or optional. For field
descriptions, see Table 14: Field Description in BAT Spreadsheet for Updating Users, on page 212.

Step 5 In the Value for fields to be ignored field, enter the symbol that you will use to tell BAT that you want to
keep the value that was previously stored in the DC directory. Enter the same value in the value of the field
you want to retain.

Step 6 To transfer the data from the BAT Excel spreadsheet into a CSV file, click Export to BAT.

The system saves the file to C:\XlsDataFiles\with the default filename Update_Users-timestamp.txt
or you can use Browse to save the file to another existing folder on your local workstation.

For information about how to read the CSV data file, click the View Sample File link in the Update Users
window in BAT.

What to do next

You must upload the CSV data file to the first node of the Unified CM server, so BAT can access the CSV
data file.

Related Topics
Topics Related to User Updates, on page 220
Upload and Download Files, on page 19
Upload File to Server, on page 21
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BAT Spreadsheet Update User Data Field Descriptions
The following table provides the field descriptions for updating user details in the BAT spreadsheet.

Table 14: Field Description in BAT Spreadsheet for Updating Users

DescriptionField

Enter the last name, from 1 to 128 characters, of the phone user.User ID

Enter manager user ID, up to 128 characters, for the user of this phone.Manager User ID

Enter the password, up to 128 characters, that the user needs to access
the Cisco IP Phone Configuration window.

You must specify the Password either in the CSV data file or by using
the BAT user interface when you add the user template. If you want
to apply individual passwords for each user or groups of users, specify
the password information in the CSV data file. If you want to use a
default password for all users, provide the default password when you
insert the users in BAT.

Password

Enter the department number, up to 64 characters, for the user of this
phone.

Department

Enter the default profile for this user and device, up to 50 characters.
You can choose the user device profile from the list of existing UDPs
in Unified CM Administration that appears in BAT.

Default Profile

Enter the language and country set, up to 50 characters, that you want
to associate with this user. Your choice determines which
cultural-dependent attributes exist for this user and which language
displays in the Unified CM user windows and phones.

User Locale

Enter the password, up to 128 characters, that the user needs to access
the Cisco IP Phone Configuration window.

You must specify the password either in the CSV data file or by using
the BAT user interface during user template addition. If you want to
apply individual passwords for each user or groups of users, specify
the password information in the CSV data file. If you want to use a
default password for all users, provide the default password when you
insert the users in BAT.

Password

Enter the personal identification number (PIN), up to 128 numerals,
to be used for extension mobility.

You must enter a PIN either in the CSV data file or by using the BAT
user interface during user template addition. If you want to apply
individual PINs for each user or groups of users, specify the PIN in
the CSV data file. To use a default PIN that all users can use, provide
a default PIN when you insert the users in BAT.

PIN

Enter the telephone number, up to 64 numerals, for the primary
extension (usually Line 1) for the phone.

Telephone Number
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DescriptionField

This field appears after you add the user and represents the primary
directory number for the user. You choose no primary line when you
associate devices to the user. Users can have multiple lines on their
phones.

If you configure the system for Unity Integration, the Create Voice
Mailbox link appears.

Primary Extension

This field, which is required for Cisco SoftPhone and Unified CM
Attendant Console users, displays after the user is added.

Associated PC

Enter an IPCC extension, up to 50 characters, for this user.IPCC Extension

Enter the user e-mail address up to 255 characters.Mail ID

Enter the BLF presence group that watches the status of the database
number, the presence entity.

For information about the BLF Presence feature, see the Feature
Configuration Guide for Cisco Unified Communications Manager .

BLF Presence Group

All calling search spaces that you configure in Unified CM
Administration appear in the SUBSCRIBE Calling Search Space
drop-down list box.

The SUBSCRIBE Calling Search Space determines how Unified CM
routes the Presence subscription requests that come from the user. To
configure a calling search space specifically for this purpose, you
configure a calling search space as you do all calling search spaces
(Call Routing > Class Control > Calling Search Space).

To set up a calling search space, see the Cisco Unified Communications
Manager Online Help.

SUBSCRIBE Calling Search
Space

When you configure digest authentication for phones that are running
SIP, Unified CM challenges the identity of the phone every time the
phone sends a SIP request to Unified Communications Manager. The
digest credentials that you enter in this field is associated with the
phone when you choose a digest user in the Phone Configuration
window.

Enter a string of up to 128 alphanumeric characters.

For more information about digest authentication, see theCisco Unified
Communications Manager Security Guide.

Digest Credentials

Enter the user group to which the user belongs.

TheUser Group fields appear when you set theNumber
of User Groups field to greater than zero.

Note

User Group
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DescriptionField

Enter the primary directory URI that you want to associate to this user's
primary extension. Follow the username@host format. Enter a username
of up to 47 alphanumeric characters. For the host address, enter an
IPv4 address or fully qualified domain name.

Within Unified CM Administration, you can enter
directory URIs with embedded double quotes or commas.
However, when you use Bulk Administration to import
a CSV file that contains directory URIs with embedded
double quotes and commas, you must use enclose the
entire directory URI in double quotes and escape the
embedded double quotes with a double quote. For
example, the Jared, "Jerry",Smith@test.com directory
URI must be input as "Jared,""Jerry"",Smith@test.com"
in the CSV file.

Note

Directory URI

The Self-Service User ID is a DTMF digit string that is used to identify
a user (usually same as the user directory number).

Self-Service User ID

The User Profile is a profile that collects settings to share across a
group of users. This profile is used when you create new devices.

User Profile

Enter the maximum login time for Extension Mobility and Extension
Mobility Cross Cluster users. Enter the value in minutes.The range of
the value is from 0 to 10080 minutes (7 days).

EM MAX LOGIN TIME

Update User Information in Cisco Unified Communications
Manager Directory

You can update a group of user records in the Cisco Unified Communications Manager directory.

Before you begin

You must have a .csv data file with updated user information.

Procedure

Step 1 Choose Bulk Administration > Users > Update Users > Custom File.

The User Update Configuration window appears.

Step 2 From the File Name drop-down list box, choose the .csv data file that you created for this bulk transaction.

Click View File to view the uploaded .csv data file.

Click View Sample File to view a sample .csv data file.

Note
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Step 3 From the User Template Name drop-down list box, choose the user template that you created for this bulk
transaction.

Step 4 In the Value for fields to be ignored field, enter the symbol that you want to tell Unified CM Bulk
Administration Tool to retain the value that was previously stored in the DC directory.

The value that you enter in the .csv file for updating users overrides the values that are provided
in the user template.

Note

Step 5 In the Job Information area, enter the Job description.
Step 6 Choose a method to update user records. Do one of the following:

• Select Run Immediately to update user records immediately.
• Select Run Later to insert the user records at a later time.

Step 7 To create a job for updating the user records, click Submit.
To schedule or activate this job, use the Job Scheduler option in the Bulk Administration main menu.

Related Topics
BAT Log Files, on page 609
Create User Update CSV Data File Using BAT Spreadsheet, on page 210
Retain Existing User Information During Update, on page 210
Manage Scheduled Jobs, on page 599
Topics Related to User Updates, on page 220

User Update Settings
Values that appear in some fields display from . You must configure these values by using .

Be aware that some fields have two check boxes. The first check box determines if you need to update the
field; the second check box determines the value (checked or unchecked) to use for the field.

Note

Check the first check box if you need to update the field and the second check box to apply a checked value
to the users you select. For example, if you check the first box for Home Cluster and leave the second one
unchecked, you update users with an unchecked value for Home Cluster.

Tip

The following table provides descriptions for all possible fields when you update users with the Query option.

Table 15: Field Descriptions for Update Users

DescriptionField

User Information

Enter manager user ID, up to 128 characters, for the user of this
phone.

Manager User ID
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DescriptionField

Enter the department number, up to 64 characters, for the user of this
phone.

Department

This field, which is required for Cisco SoftPhone and Cisco Unified
Communications Manager Attendant Console users, displays after
you add the user.

Associated PC

Choose the language and country set that you want to associate with
this user from the drop-down list. Your choice determines which
cultural-dependent attributes exist for this user and which language
displays in the CiscoUnified CommunicationsManager user windows
and phones.

User Locale

When you configure digest authentication for phones that are running,
Cisco Unified Communications Manager challenges the identity of
the phone every time the phone sends a SIP request to Cisco Unified
Communications Manager. The digest credentials that you enter in
this field get associated with the phone when you choose a digest
user in the Phone Configuration window.

Enter a string of up to 128 alphanumeric characters.

For more information on digest authentication, see theCisco Unified
Communications Manager Security Guide.

Digest Credentials

To confirm that you entered the digest credentials correctly, reenter
the credentials in this field.

Confirm Digest Credentials

Service Setting

Check the check box if the end user is associated with this cluster.
The end user must be associatedwith one cluster within the enterprise.

IM and Presence feature does not function properly if
an end user is associated with more than one home
cluster.

Note

Home Cluster

Check the check box to enable the end user (on the home cluster) for
IM and Presence feature. Configure IM and Presence feature in the
associated service profile.

You can only enable IM and Presence feature for users
that have this Unified CM cluster marked as their home
cluster.

Note

Use the User Management > User Settings > UC
Servicemenu to configure the IM and Presence feature.

Tip

Enable User for Unified CM IM and
Presence
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DescriptionField

Assign the end user to an server that is installed in the cluster if the
system is nonbalanced. The server you specify using the Bulk
Administration Tool must be part of a Presence Redundancy Group.

For clusters that have the user assignment mode for the IM and
Presence server set to balanced or active-standby, user assignments
that are made using the Bulk Administration Tool override the
automatic user assignments.

Assigned Presence Server

Select a UC service profile from the drop-down list box to associate
with end users.

Use theUser Management > User Settings > Service
Profile menu to set up service profiles for end users.

Note

UC Service Profile

Check this check box to create a sync between CUCM IM and
Presence server so that it can include the meeting information under
the Presence feature.

You can only access this field if Home Cluster and
Enable User for Unified CM IM and Presence is
enabled.

Note

Include Meeting Information in
Presence (Requires Exchange Presence
Gateway to be configured on CUCM
IM and Presence server.)

Extension Mobility

From the drop-down list, choose the BLF presence group that watches
the status of the directory number, the presence entity.

BLF Presence Group

All calling search spaces that you configure in Cisco Unified
CommunicationsManagerAdministration display in the SUBSCRIBE
Calling Search Space drop-down list.

The SUBSCRIBE Calling Search Space determines how Cisco
Unified Communications Manager routes the Presence subscription
requests that come from the end user. Use the Call Routing > Class
Control >Calling Search Spacemenu to configure a calling search
space specifically for this purpose.

SUBSCRIBE Calling Search Space

Enter the maximum login time in the HHH:MM format to configure
maximum login time for ExtensionMobility and ExtensionMobility
Cross Cluster users.

The value ranges from 00:01 to 168:00 hours.

For example: 168:00, 25:16, 025:16, :30 or 00:30.

Maximum Login Time (HHH:MM)

Check this check box to allow CTI to control and monitor this device.

If the associated directory number specifies a shared line, the check
box should be checked as long as at least one associated device
specifies a combination of device type and protocol that CTI supports.

Allow Control of Device from CTI
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DescriptionField

Check this check box to enable the ExtensionMobility Cross Cluster
CSS setting that gets used as the device CSS of the remote phone
when the user selects this device profile during the EMCC login.

Enable Extension Mobility Cross
Cluster

Mobility Information

Check this check box to activate Mobile Connect, which allows the
user to manage calls by using a single phone number and to pick up
and manage calls on the desk phone and mobile phone.

Enable Mobility

Check this check box to allow the user to access the Mobile Voice
Access integrated voice response (IVR) system to initiate Mobile
Connect calls and activate or deactivateMobile Connect capabilities.

Enable Mobile Voice Access

Enter the maximum wait time, up to 5 numerals, for this user.

This indicates the maximum time that is permitted to pass before the
user pickup a call that is transferred from the mobile phone to the
desktop phone.

MaximumWait Time for Desk Pickup

Enter the maximum number of phones, up to 2 numerals, to which
the user is permitted to transfer calls from the desk phone.

Remote Destination Limit

Job Information

Enter the job description.Job Description

Click this radio button to schedule and immediately activate the
update users job.

Run Immediately

Click this radio button to schedule and activate the update users job
later.

Run Later (To schedule and activate
this job, use Job Scheduler page.)

Related Topics
Update Users Using Query, on page 218
Select Update Parameters for User Query, on page 220

Update Users Using Query
Use this procedure to create a query to locate users to update. After locating users, you must select the update
parameters.

Before you begin

To update all users, select Find and do not specify a query.

Procedure

Step 1 Select Bulk Administration > Users > Update Users > Query
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The Update Users Query window appears.

Step 2 From the first Find Phone where drop-down list, select one of the following criteria:

• Last Name

• First Name

• User ID

• Manager

• Department

• Has Home Cluster Enabled

• Does not have Home Cluster Enabled

• Has IM and Presence Enabled

• Does not have IM and Presence Enabled

Step 3 From the second Find Users where drop-down list, select one of the following criteria:

• begins with

• contains

• is exactly

• ends with

• is empty

• is not empty

Step 4 Specify the appropriate search text, if applicable.

To find all users that are registered in the database, select Find without entering any search text.Tip

To further define your query and to add multiple filters, click the plus (+) button and repeat step
2 and step 3.

Tip

Step 5 Select Find.

A list of discovered users appears. TheUpdate Userswindow displays the details of the users that you select.

What to do next

Select update parameters for the user.

Related Topics
Select Update Parameters for User Query, on page 220
User Update Settings, on page 215
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Select Update Parameters for User Query
After you locate the users to update, use this procedure to select the parameters and define values for updating
those users.

Procedure

Step 1 In the Update Users Query window, select Next.

If you want to change the type of query, select Back.

The Update Users shows the type of query that you select.

Step 2 Check the check box to the left of the field that you want to update.

This selection tells BAT to overwrite the existing value for the field.

BAT updates only those fields for which you check the update check box.Note

Step 3 Update the required user parameters. See the “User update settings” topic.
Step 4 In the Job Information area, enter the job description.
Step 5 Select one of the following methods to update user records:

a) Select Run Immediately to update users immediately.
b) Select Run Later to update users at a later time.

Step 6 Select Submit.

This action creates a job for updating the records.

Use the Job Scheduler option in the Bulk Administration main menu to schedule and activate
this job.

Note

Related Topics
Update Users Using Query, on page 218
User Update Settings, on page 215

Topics Related to User Updates
• Update User Information Using CSV Data File, on page 209

• Retain Existing User Information During Update, on page 210

• Create User Update CSV Data File Using BAT Spreadsheet, on page 210

• Update User Information in Cisco Unified Communications Manager Directory, on page 214

• Upload and Download Files, on page 19
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C H A P T E R 20
User Deletions

This chapter provides information to delete a group of users from the Unified Communications Manager
directory. You can locate existing user records to delete using either a query search or a custom file.

• Delete Users Using Query, on page 221
• Delete Users Using Custom File, on page 222

Delete Users Using Query
You can create a query filter to locate the user records for the users that you want to delete.

The delete action is final. You cannot retrieve deleted records.Caution

Procedure

Step 1 Choose Bulk Administration > Users > Delete Users > Query.

The Delete Users Configuration window displays.

Step 2 From the first Find User where drop-down list box, choose one of the following criteria:

• User ID

• First Name

• Middle Name

• Last Name

• Manager

• Department Name

From the second Find User where drop-down list box, choose one of the following criteria:

• begins with

• contains
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• is exactly

• ends with

• is empty

• is not empty

Step 3 Specify the appropriate search text, if applicable.

To find all users that are registered in the database, click Find without entering any search text.Tip

Step 4 To further define your query and to add multiple filters, check the Search Within Results check box, choose
AND or OR from the drop-down box, and repeat Step 2, on page 221 and Step 3, on page 222.

Step 5 Click Find.

A list of discovered templates displays by:

• User ID

• First Name

• Middle Name

• Last Name

• Manager

• Department Name

• LDAP Sync Status

Step 6 In the Job Information area, enter the Job description.
Step 7 Choose a method to delete user records. Do one of the following:

a) Click Run Immediately to delete user records immediately.
b) Click Run Later to delete the user records at a later time.

The delete action is final. You cannot retrieve deleted records.Caution

Step 8 To create a job for deleting the user records, click Submit.
To schedule and/or activate this job, use the Job Scheduler option in the Bulk Administration main menu.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Topics Related to User Updates, on page 220

Delete Users Using Custom File
1. Create a text file that lists each user ID that you want to delete on a separate line.

2. Upload the custom file with the first node of the Unified Communications Manager server.
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To locate and delete users, you can create a custom file of user IDs by using a text editor.

Do not use the insert or export transaction files that are created with bat.xlt for the delete transaction. Instead,
you must create a custom file with details of the user records that need to be deleted. Use only this file for the
delete transaction. In this custom delete file, you do not need a header, and you can enter values for user ID.

Note

The delete action is final. You cannot retrieve deleted records.Caution

Procedure

Step 1 Choose Bulk Administration > Users > Delete Users > Custom File.

The Find and List Users - Delete Users Based on Custom File window displays.

Step 2 In Delete Users where drop-down list box, choose one of the following criteria:

• User ID

• First Name

• Middle Name

• Last Name

• Department

Step 3 In the Custom file where drop-down list box, choose the filename for the custom file.
Step 4 To check that the query includes the information that you need, click Find.
Step 5 In the Job Information area, enter the Job description.
Step 6 Choose a method to delete user records. Do one of the following:

a) Click Run Immediately to delete user records immediately.
b) Click Run Later to delete the user records at a later time.

The delete action is final. You cannot retrieve deleted records.Caution

Step 7 To create a job for deleting the user records, click Submit.
To schedule and/or activate this job, use the Job Scheduler option in the Bulk Administration main menu.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Topics Related to User Updates, on page 220
Upload and Download Files, on page 19
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C H A P T E R 21
User Record Exports

When you use Unified Communications Manager Bulk Administration (BAT) to export user records, the
export utility sorts users according to the organizational hierarchy in the database.

From the Exports Users Configuration window, if Default User Format is selected from the File Format
drop-down list box. the export utility only exports the default user device profile that is associated with a user.
You must insert the other user device profiles for that user separately by using Cisco Unified Communications
Manager Administrator.

• Export User Records, on page 225
• Topics Related to User Record Exports, on page 227

Export User Records
When you export user records using BAT, some users might have a blank PIN because these user records
were created prior to Unified Communications Manager 3.1. If this is the case, you must specify a default
PIN before reinserting the user records in the BAT user interface.

The user ID, PKID, password, pin, and digest credentials columns in the exported file should not be modified
under any circumstances.

Caution

Procedure

Step 1 Choose Bulk Administration > Users > Export Users.

The Find and List Users to Export window displays.

Step 2 In the first Find User where drop-down list, choose a field to query from the following options:

• User ID

• First Name

• Middle Name

• Last Name

• Manager
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• Department

Step 3 In the second drop-down list, choose from the following options:

• begins with

• contains

• is exactly

• ends with

• is empty

• is not empty

Step 4 In the search field/list box, enter the value that you want to locate, such as a specific name or User ID.

To choose users from more than one department, enter multiple departments in this field. For
example, to choose users from departments 12 and 34, enter 12, 34 in the third box instead of
performing two operations.

Note

Step 5 You can click the Search Within Results check box and choose AND or OR to add multiple filters and repeat
Step 2, on page 225 through Step 4, on page 226 to further define your query.

Step 6 Click Find. The search results display.

To find all users that are registered in the database, click Find without entering any search text.Note

Step 7 Click Next.
Step 8 Enter the export users file name in the File Name text box.
Step 9 Choose file format from the File Format drop-down list.
Step 10 In the Job Information area, enter the Job description.
Step 11 Choose a method to export user records. Do one of the following:

a) Click Run Immediately to export user records immediately.
b) Click Run Later to export at a later time.

Step 12 To create a job for exporting user records, click Submit.
To schedule and/or activate this job, use the Job Scheduler option in the Bulk Administration main menu.

What to do next

You can search and download the exported file using the Upload/Download Files option in the Bulk
Administration menu.

The user ID, PKID, password, pin, and digest credentials columns in the exported file should not be modified
under any circumstances.

Caution

Related Topics
BAT Log Files, on page 609
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Manage Scheduled Jobs, on page 599
Topics Related to User Record Exports, on page 227
Upload and Download Files, on page 19

Topics Related to User Record Exports
• BAT Log Files, on page 609

• Upload and Download Files, on page 19
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C H A P T E R 22
Password and PIN Resets

This chapter provides information about how to reset user passwords used to log on to the CiscoUnifiedIP
Phone Self Care Portal window and the extensionmobility feature PINs used to log in to CiscoUnifiedIPPhones.

• Reset Passwords And PINs, on page 229

Reset Passwords And PINs
You can reset the password that users use when they log on to the CiscoUnifiedIPPhone Self Care Portal
window. You can also reset the PINs for the extension mobility feature that users use when they log in to
CiscoUnifiedIPPhones. Use this action when you must reset a group of users to a default password or to a
default PIN without updating any other attributes.

You can choose users for resetting passwords and PINs using either a query search or a custom file.

Be aware that the credential settings selected on the reset page apply to both the password and the pin.Note

Reset User Password and PIN Using Query
You can use a query to locate users and reset passwords and PINs to a default value.

Procedure

Step 1 Choose Bulk Administration > Users > Reset Password/PIN > Query.
Step 2 To locate the users that you want to reset, define the query filter.
Step 3 From the first Find User where drop-down list, choose one of the following criteria:

• User ID

• First Name

• Middle Name

• Last Name
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• Manager

• Department

From the second Find User where drop-down list box, choose one of the following criteria:

• begins with

• contains

• is exactly

• ends with

• is empty

• is not empty

Step 4 Specify the appropriate search text, if applicable, and click Find.

To choose users from more than one department, enter multiple departments separated with a
comma in this field. For example, to choose users from departments 12 and 14, enter 12, 14 in
the third box instead of performing two operations.

Note

To find all users that are registered in the database, click Find without entering any search text.Tip

Step 5 To further define your query, you can choose AND or OR to add multiple filters and repeat Step 3, on page
229 and Step 4, on page 230.

Step 6 Click Find.

A list of discovered users displays by

• User ID

• First Name

• Middle Name

• Last Name

• Manager

• Department Name

• LDAP Sync Status

Step 7 Click Next.
Step 8 Enter the values that you want to update for all the records that you defined in your query.

• Password—Enter the default password that users use when they log on to the Cisco Unified IP Phone
Self Care Portal window.

• Confirm Password—Reenter the password.

• PIN—Enter the default PIN for the extension mobility feature that users should use when they log in to
a Cisco Unified IP Phone.

• Confirm PIN—Reenter the PIN.

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
230

Users
Reset User Password and PIN Using Query



If you want your end users to be able to use this PIN to access their Cisco Unity Connection
Voicemail, the Enable End User PIN Synchronization check box in the Application Server
Configuration window must be checked for the connection to the Cisco Unity Connection
server. The PIN in Cisco Unified Communications Manager gets updated only if the PIN in
Cisco Unity Connection gets updated successfully.

Note

Step 9 In the Job Information area, enter the Job description.
Step 10 Choose a method to change passwords or PINs. Do one of the following:

a) Click Run Immediately to change passwords or PINs immediately.
b) Click Run Later to change them at a later time.

Step 11 To create a job for resetting passwords or PINs, click Submit.
Step 12 To schedule and activate this job, use the Job Scheduler option in the Bulk Administration main menu.

To schedule and/or activate this job, use the Job Scheduler option in the Bulk Administration main menu.

The log file displays the number of users that were updated and the number of records that failed,
including an error code.

Tip

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599

Reset User Password and PIN Using Custom File
To locate users and to reset passwords and PINs to default values, you can create a custom file of user IDs
by using a text editor.

Before you begin

1. Create a text file that lists each user ID on a separate line for which you want to reset password or PIN.

2. Upload the custom file into first node.

Do not use the insert or export transaction files that are created with bat.xlt for the reset transaction. Instead,
you must create a custom file with details of the user records that need to be reset. Use only this file for the
reset transaction. In this custom reset file, you do not need a header, and you can enter values for user ID.

Note

Procedure

Step 1 Choose Bulk Administration > Users > Reset Password/PIN > Custom File.
Step 2 In the Find and List Users window, choose the field that you used in the custom file from the following

options:

• User ID

• First Name
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• Middle Name

• Last Name

• Department

Step 3 In the In Custom File drop-down list box, choose the filename for the custom file.
Step 4 Click Next.
Step 5 In the Reset Password/PIN for Users window, enter the values that you want to update for all the records.

• Password—Enter the default password that users use when they log on to the Cisco Unified IP Phone
Self Care Portal window.

• Confirm Password—Reenter the password.

• PIN—Enter the default PIN for the extension mobility feature that users should use when they log in to
a Cisco Unified IP Phone.

• Confirm PIN—Reenter the PIN.

If you want your end users to be able to use this PIN to access their Cisco Unity Connection
Voicemail, the Enable End User PIN Synchronization check box in the Application Server
Configuration window must be checked for the connection to the Cisco Unity Connection
server. The PIN in Cisco Unified Communications Manager gets updated only if the PIN in
Cisco Unity Connection gets updated successfully.

Note

Step 6 In the Job Information area, enter the Job description.
Step 7 Choose a method to change passwords or PINs. Do one of the following:

a) Click Run Immediately to change passwords or PINs immediately.
b) Click Run Later to change them at a later time.

Step 8 To create a job for resetting passwords or PINs, click Submit.
Step 9 To schedule and activate this job, use the Job Scheduler option in the Bulk Administration main menu.

To schedule and/or activate this job, use the Job Scheduler option in the Bulk Administration main menu.

The log file displays the number of users that were updated and the number of records that failed,
including an error code.

Tip

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Upload File to Server, on page 21
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C H A P T E R 23
User Report Generation

Unified Communications Manager Bulk Administration (BAT) provides reports to help you manage records
effectively. You can create and save reports that provide information about phones, users, user device profiles,
managers and assistants, and gateway records. You can save these reports with a filename and store them in
a folder on Unified Communications Manager first node to review and print.

• Generate User Reports, on page 233

Generate User Reports
You can generate a report for all users by not specifying any query options, or you can specify a limited set
of query options. The format of the reports for users can be customized.

Procedure

Step 1 Choose Bulk Administration > Users > Generate User Reports.

The Find and List Users window displays.

You can generate a report for all users by not specifying a query, or you can generate a report
for specific users by using following steps:

Note

Step 2 In Select Users Where scroll box, choose from these query options: User ID, Department, First Name,Middle
Name, Last Name, Manager.

Step 3 In the second drop-down list box, choose from the following search criteria.

• begins with

• contains

• is exactly

• ends with

• is empty

• is not empty
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Step 4 In the search field box, enter the value that you want to locate, such as the exact user ID or the last name of
a user.

You can addmultiple values to the search field box by separating themwith a comma as shown in this example:
JohnJ, PaulP, SueS, JoeJ

To generate a report for all users that are registered in the database, click Find without entering
any search text.

Tip

Step 5 Click Find. A list of discovered user records displays.
Step 6 To choose details for your type of report, click Next.

If you want to change the type of query, click Back.Note

Step 7 In the File Name field, enter your name for this report (required).
Step 8 In the Available Fields drop-down list box, choose an item and click the arrow to move the item into the

Selected Fields for this Report list. You can choose one or more fields to include in your report.

You can rearrange the order of the items in the Selected Fields for this report list by choosing
an item and clicking the Up arrow or Down arrow to move the item to another position in the
list.

Tip

Step 9 In the Job Information area, enter the Job description.
Step 10 Choose a method to generate reports. Do one of the following:

a) Click Run Immediately to generate reports immediately.
b) Click Run Later to generate reports at a later time.

Step 11 To create a job for generating reports, click Submit.
Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

What to do next

You can search and download the report file using the Upload/Download Files option in the Bulk
Administration menu.

Related Topics
BAT Log Files, on page 609
Report Log Files, on page 287
Manage Scheduled Jobs, on page 599
Upload and Download Files, on page 19
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C H A P T E R 24
Line Appearance

This chapter provides information to use the Line Appearance menu in BAT to view, export, and update line
appearances.

A line appearance is the linkage of a line to a device. The end user is now linked to a line appearance rather
than a line.

The system did not provide detailed presence information about relationships such as shared lines to Cisco
Unified Presencepreviously, which led to inaccurate or incomplete presence state. The Line Appearance
feature provides detailed information are multiple line appearances associate with a user.

• View Line Appearances, on page 235
• Export Line Appearances, on page 236
• Update Line Appearances, on page 237

View Line Appearances
Because you might have several line appearance records, Unified Communications Manager lets you locate
specific records on the basis of specific criteria.

During your work in a browser session, the cookies on the client machine store your find/list search preferences.
If you navigate to other menu items and return to this menu item, or if you close the browser and then reopen
a new browser window, the system retains your Cisco Unified Communications Manager search preferences
until you modify your search.

Note

Procedure

Step 1 Choose Bulk Administration > Users > Line Appearance > Export Line Appearance.
The Export Users Query window displays.

Step 2 To find all records in the database, ensure the dialog box is empty; go to Step 3, on page 236.

To filter or search records

• From the first drop-down list box, select a search parameter.
• From the second drop-down list box, choose a search pattern.
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• Specify the appropriate search text, if applicable.

To add additional search criteria click the + button.When you add criteria, the system searches
for a record that matches all criteria that you specify. To remove criteria, click the – button
to remove the last added criteria or click the Clear Filter button to remove all added search
criteria.

Note

Step 3 Click Find.

All or matching records display. You can change the number of items that display on each page by choosing
a different value from the Rows per Page drop-down list box.

You can delete multiple records from the database by checking the check boxes next to the
appropriate record and clicking Delete Selected. You can delete all configurable records for this
selection by clicking Select All and then clicking Delete Selected.

Note

Step 4 From the list of records that display, click the link for the record that you want to view.

To reverse the sort order, click the up or down arrow, if available, in the list header.Note

The window displays the item that you choose.

Export Line Appearances
1. Create a text file that lists details of the line appearance that you want to export.

2. Upload the custom file into Unified Communications Manager first node.

3. Find the line appearance records you want to export.

After you have selected line appearance items to export, you can proceed to export the selected line appearances.

Procedure

Step 1 After you have located the items to export, click Next.
The Export Line Appearance Configuration window displays.

Step 2 In the In Custom File field, enter the filename for the custom file.
Step 3 In the File Format drop-down list box, choose the file format.

The Line Appearance Format is available by default.

Step 4 Check one or more of the following check boxes:

• Export line appearances for Cisco Unified Presence users only—The export operation will only get
performed on Cisco Unified Presenceusers.

• Export line appearances for all the primary extensions—Line appearances for all devices that share a
line to which a user is associated will get exported.
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• Export line appearances for the devices associated—Line appearances for all the lines that share a device
to which a user is associated will be exported.

Step 5 In the Job Information area, enter the Job description.
Step 6 Choose an export method. Do one of the following:

a) Click Run Immediately to export line appearances immediately.
b) Click Run Later to export line appearances at a later time.

Step 7 To create a job for generate reports, click Submit.

To schedule and/or activate this job, use the Job Scheduler option in the Bulk Administration main menu.

What to do next

The log file displays the number of users that were updated and the number of records that failed, including
an error code.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Upload File to Server, on page 21
View Line Appearances, on page 235

Update Line Appearances
1. Create a text file that lists the following details for the line appearances that you want to update:

• User ID

• Device

• Directory numbers

• Partition (optional)

2. Put each item on a separate line in the text file.

3. Upload the custom file to Unified Communications Manager server.

You can update line appearances that are listed in a custom file.

The line must be associated to the end user for the Update Line Appearance transaction to be successful.Attention

Procedure

Step 1 Choose Bulk Administration > Users > Line Appearance > Update Line Appearance.
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The Update Line Appearance Configuration window displays.
Step 2 From the File Name drop-down list box, choose the name of the custom file.
Step 3 Check the following check boxes to select these options, or skip to Step 4, on page 238.

a) If you want to update the line appearance for Cisco Unified Presenceusers only, check the Update line
appearance for CUP users only check box.

b) If you want to disassociate the line appearance, check the Disassociate line appearances check box.

Step 4 In the Job Information area, enter the Job description.
Step 5 Choose a method to update line appearances. Do one of the following:

a) Click Run Immediately to update line appearances immediately.
b) Click Run Later to update line appearances at a later time.

Step 6 To create a job for updating line appearances, click Submit.
To schedule and/or activate this job, use the Job Scheduler option in the Bulk Administration main menu.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Upload File to Server, on page 21
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C H A P T E R 25
End User CAPF Profiles

This chapter provides information about using Unified Communications Manager Bulk Administration Tool
to add CAPF Profiles to the existing end users in the Unified Communications Manager database.

• Insert End User CAPF Profile, on page 239
• Delete End User CAPF Profile, on page 240
• Export End User CAPF Profile, on page 241
• BAT Spreadsheet End User CAPF Profile Field Descriptions, on page 242

Insert End User CAPF Profile
You can use a CSV data file to insert CAPF profiles for existing end user records in the Unified
Communications Manager database.

If any information for a record fails during insertion, BAT does not insert that CAPF profile record.Attention

Before you begin

You must have a data file in comma-separated value (CSV) format that contains the unique details for the
end user CAPF profiles.

You can create the CSV data file by using one of these methods:

• BAT spreadsheet that is converted to CSV format

• Export utility that produces an export file of End User CAPF Profile data

Procedure

Step 1 Choose Bulk Administration > Users > End User CAPF Profile > Insert End User CAPF Profile.
The Insert End User CAPF Profile Configuration window displays.

Step 2 From the File Name drop-down list box, choose the CSV data file that you created for this specific bulk
transaction.
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Step 3 To overwrite the existing CAPF Profile settings with the information that is contained in the file that you want
to insert, select the Override the existing configuration check box.

Step 4 In the Job Information area, enter the job description.
Step 5 Choose an insert method. Do one of the following:

a) Click Run Immediately to insert the CAPF profile immediately.
b) Click Run Later to insert the CAPF profile at a later time.

Step 6 To create a job for inserting the CAPF profile, click Submit.
To schedule and/or activate this job, use the Job Scheduler option in the Bulk Administration main menu.

If any information for a record fails during insertion, BAT does not insert that CAPF profile
record.

Attention

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599

Delete End User CAPF Profile
You can delete end user CAPF profiles from the Unified Communications Manager database using a custom
file.

Before you begin

Before you can delete an end user CAPF profile fromCisco Unified CommunicationsManager Administration,
you must perform the following tasks:

• Create a text file that lists each end user CAPF profile that you want to delete on a separate line.

• Upload the custom file with the first node of the Unified Communications Manager server.

Do not use the insert or export transaction files that are created with bat.xlt for the delete transaction. Instead,
create a custom file with details of the end user CAPF profile records that need to be deleted. Use only this
file for the delete transaction. The custom delete file does not require a header and you can enter values for
the you can enter values for the Instance ID or End User ID.

Note

Procedure

Step 1 Choose Bulk Administration > Users > End User CAPF Profile > Delete End User CAPF Profile.
The Delete End User CAPF Profile Configuration window displays.

Step 2 From the Delete End User CAPF Profile where End User ID/ Instance ID in custom file drop-down list
box, choose the file that you uploaded for deleting end user CAPF profile.

Step 3 Click Find.

The Job Information section displays along with the selected end user CAPF profile.
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Step 4 You can choose to run the job immediately or later by selecting the corresponding radio buttons.
Step 5 Click Submit to create a job for deleting the End User CAPF Profile.

A message in the Status section lets you know that the job was submitted successfully.
Step 6 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
Upload and Download Files, on page 19

Export End User CAPF Profile
You can export end user CAPF profiles by using BAT.

Procedure

Step 1 Choose Bulk Administration > Users > End User CAPF Profile > Export End User CAPF Profile.
The Find and List End User CAPF Profiles To Export window displays.

Step 2 In the first Find End User CAPF Profile where drop-down list box, choose a field to query from the following
options:

• Instance Id

• End User Id

Step 3 In the second drop-down list box, choose from the following options:

• begins with

• contains

• is exactly

• ends with

• is empty

• is not empty

Step 4 In the search field box, enter the value that you want to locate, such as a specific instance ID or end user ID.
Step 5 You can choose AND or OR to add multiple filters and repeat Step 2, on page 241 through Step 4, on page

241 to further define your query.
Step 6 Click Find.

All matching records display. You can change the number of items that display on each page by choosing a
different value from the Rows per Page drop-down list box.

To find all users that are registered in the database, click Find without entering any search text.Tip

Step 7 From the list of records that display, click the link for the record that you want to view.
The window displays the record that you choose.

Step 8 Click Next.
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The Export End User CAPF Profile Configuration window displays.

Step 9 In the File Name text box, enter the end user CAPF filename you intend to export.
Step 10 From the File Format drop-down list box, choose the CAPF file format.
Step 11 In the Job Information area, enter the job description.
Step 12 Choose an export method. Do one of the following:

a) Click Run Immediately to export the end user CAPF profiles immediately.
b) Click Run Later to export the end user CAPF profiles at a later time.

Step 13 Click Submit to create a job for exporting the End User CAPF Profile.

Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

See BATSpreadsheet EndUser CAPF Profile FieldDescriptions, on page 242 for field descriptions.Note

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599

BAT Spreadsheet End User CAPF Profile Field Descriptions
The following table describes the fields that display when you are inserting, deleting, or exporting an end user
CAPF profile.

In the BAT user interface, field names that have an asterisk require an entry. Treat fields that do not have an
asterisk as optional.

Table 16: Field Descriptions for an End User CAPF Profile in BAT

DescriptionField

Enter the end user User ID.End User ID

Enter 1-128 alphanumeric characters (a through z, A, through Z, and
0 through 9). The Instance ID identifies the user for the certificate
operation.

Instance ID

Enter one of the following options:

• No Pending Operation—Displays when no certificate operation
is occurring. This is the default setting for certificate operation.

• Install/Upgrade—Installs a new or upgrades an existing locally
significant certificate for the application.

Certificate Operation

The authentication mode for the Install/Upgrade certificate operation
specifies “ByAuthentication String,” whichmeans that CAPF installs,
upgrades, or troubleshoots a locally significant certificate only when
the user/administrator enters the CAPF authentication string in the
JTAPI/TSP Preferences window.

Authentication Mode

Enter a numeric string that contains between 4 and 10 digits.Authentication String
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DescriptionField

Enter the key size for the certificate. The default setting specifies
1024. Other options include 512 and 2048.

Key Size (bits)

This field, which supports all certificate operations, specifies the date
and time by which you must complete the operation.

Operation Completes by
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P A R T V
Phones and Users

• Phones with Users, on page 247
• Phones and Users File Formats, on page 249
• Phone and User Validations, on page 251
• Phone and User Insertions, on page 253





C H A P T E R 26
Phones with Users

This chapter provides information about using Cisco Unified Communications Manager Bulk Administration
to add a group of users and their phones on a Cisco Unified Communications Manager server in one bulk
transaction. You have two options for creating a CSV data file for the phones:

• Use the BAT spreadsheet (BAT.xlt) and export the data to the CSV format.

• Use a text editor to create a text file in CSV format (for experienced users).

You can access the Insert Phones with Users option by choosing Bulk Administration > Phones and Users
from the Cisco Unified Communications Manager Administration main menu.

• Add New Phones with Users, on page 247
• Add Phones with Users Using the BAT Spreadsheet, on page 248
• Topics Related to Phones with Users, on page 248

Add New Phones with Users
Use the following steps to insert phones with users.

Procedure

Step 1 To define individual values for each phone/user record that you want to update, create a comma separated
values (CSV) data file.

• See the Add Phones with Users Using the BAT Spreadsheet, on page 248.

• For a text-based CSV file, see the Phones with Users Combinations File Format, on page 631.

Step 2 Associate file format with the CSV data file.

• See the Add Phone and User File Format, on page 249.

Step 3 Validate phones with users records

• See the Validate Phones and User Records, on page 251.

Step 4 Insert phones with users records.
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• See the Insert Phones with Users Into Unified Communications Manager, on page 253.

Add Phones with Users Using the BAT Spreadsheet
Create a CSV data file for adding phones and users in bulk.

Procedure

Step 1 To open the BAT spreadsheet, locate and double-click BAT.xlt file.
You can download a BAT.xlt file.

Step 2 When prompted, click Enable Macros to use the spreadsheet capabilities.
Step 3 At the bottom of the spreadsheet, click the Phones-Users tab.
Step 4 Follow steps 4 through 10 in Create Phone CSV Data File Using BAT Spreadsheet, on page 84.

Related Topics
BAT Spreadsheet Data Collection for CSV Data File Creation, on page 12
Topics Related to Phones with Users, on page 248
Upload and Download Files, on page 19

Topics Related to Phones with Users
• Add New Phones with Users, on page 247

• Phones with Users Combinations File Format, on page 631

• Add Phone and User File Format, on page 249

• Validate Phones and User Records, on page 251

• Insert Phones with Users Into Unified Communications Manager, on page 253
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C H A P T E R 27
Phones and Users File Formats

This chapter provides information to update phones and users file formats using a comma separated values
(CSV) data file.

• Add Phone and User File Format, on page 249
• Topics Related to Phone and User File Formats, on page 250

Add Phone and User File Format
You can add the phone and user file format with a text-based CSV data file. After the CSV data file is created,
you need to associate the file format with the text-based CSV data file. After associating the file format with
the CSV file, the names for each field display as the first record in the CSV data file. You can use this
information to verify that you entered the values for each field in the correct order.

Before you begin

You must create a CSV data file that defines individual values for each user that you want to update.

When you use a text editor to create the CSV data file, you create a file format for entering values in the
text-based file. You enter values in the text file in the order that the file format specifies.

Procedure

Step 1 Choose Bulk Administration > Phones and Users > Phones & Users File Format > Assign File Format.
The Add File Format Configuration window displays.

Step 2 In the File Name field, choose the text-based CSV file that you created for this transaction.
Step 3 In the Format File Name field, choose the file format that you created for this type of bulk transaction.
Step 4 To create a job for associating the matching file format with the CSV data file, click Submit.
Step 5 To schedule and/or activate this job, use the Job Scheduler option in the Bulk Administration main menu.

The user fields get added automatically when you add the file format.Note

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
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Topics Related to Phone and User File Formats, on page 250

Topics Related to Phone and User File Formats
• Add Phones with Users Using the BAT Spreadsheet, on page 248

• Phones with Users Combinations File Format, on page 631

• BAT Log Files, on page 609
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C H A P T E R 28
Phone and User Validations

You can use Cisco Unified Communications Manager Bulk Administration (BAT) to add a group of users
and their phones on a Cisco Unified Communications Manager server in one bulk transaction. Two options
exist for creating a CSV data file for the phones:

• Use the BAT spreadsheet (BAT.xlt) and export the data to the CSV format.

• Use a text editor to create a text file in CSV format (for experienced users).

You can access the Insert Phones with Users option by choosing Bulk Administration > PhonesandUsers
from the Cisco Unified Communications Manager Administration main menu.

• Validate Phones and User Records, on page 251
• Topics Related to Phone and User Validation, on page 252

Validate Phones and User Records
You can validate your CSV data file records for phones and users. When you choose Validate Phones/Users,
the system runs a validation routine to check that the CSV data file and BAT phone template have populated
all required fields, such as device pool and locations. The validation checks only the device fields and their
dependencies.

The Primary Extension and Primary User Device of the user do not get validated.Note

Before you begin

1. You must have a BAT phone template for the devices that you are adding. You can use a master phone
template with multiple lines to add phones that have a single line or several lines.

2. You must create a comma separated values (CSV) data file that defines individual values for each
phone/user that you want to validate. You can create the CSV data file using the BAT spreadsheet
(BAT.xlt) and export data to the CSV format, or use a text editor to create a custom text file in CSV
format.

3. Associate the file format with the CSV data file.
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Procedure

Step 1 Choose Bulk Administration > Phones and Users > Validate Phones/Users.
The Validate Phones/Users Configuration window displays.

Step 2 In the File Name field, choose the CSV data file that you created for this specific bulk transaction.
Step 3 In the Phone Template Name field, choose the BAT phone template that you created for this bulk transaction.
Step 4 To create a job for validating users and phones, click Submit.
Step 5 To schedule and/or activate this job, use the Job Scheduler option in the Bulk Administration main menu.

Related Topics
Associate Text-Based File Format with CSV Data File, on page 115
BAT Log Files, on page 609
Standard Phone Templates, on page 9
Phones with Users Combinations File Format, on page 631
Manage Scheduled Jobs, on page 599
Topics Related to Phone and User Validation, on page 252
Validate Phones and User Records, on page 251

Topics Related to Phone and User Validation
• Phones with Users Combinations File Format, on page 631

• Associate Text-Based File Format with CSV Data File, on page 115

• BAT Log Files, on page 609

• Manage Scheduled Jobs, on page 599
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C H A P T E R 29
Phone and User Insertions

This chapter provides information to add a group of phones and users to the Unified CommunicationsManager
database and directory.

• Insert Phones with Users Into Unified Communications Manager, on page 253
• Topics Related to Phone and User Insertion, on page 254

Insert Phones with Users Into Unified Communications Manager
You can add a group of phones and users to the Unified Communications Manager database and directory.

Phone records must be validated before insertion.Note

You can use the dummy MAC address option. When adding CTI ports, this option gives a unique device
name to each CTI port in the form of dummy MAC addresses that you can manually update later using the
Unified Communications Manager Administration or the UnifiedCM Auto-Register phone Tool. Do not use
the dummy MAC address option for H.323 clients, VGC phones, or VGC virtual phones.

The dummy MAC address option automatically generates dummy MAC addresses in the following format:

XXXXXXXXXXXX

where X represents any 12-character, hexadecimal (0-9 and A-F) number.

Before you begin

1. Create a comma-separated values (CSV) data file to define individual values for each phone with users
that you want to insert. You can create the CSV data file using the BAT spreadsheet (BAT.xlt) to add
phones with users, or create a custom text file in CSV format to add phones with users combinations.

2. Associate file format with the CSV data file.
3. Validate phones with users records.

Procedure

Step 1 Choose Bulk Administration > Phones & Users > Insert Phones with Users.
Step 2 In the File Name field, choose the CSV data file that you created for this bulk transaction.
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Step 3 In the Phone Template Name field, choose the BAT phone template that you used for this transaction.

If you did not enter individual MAC addresses in the CSV data file, you must check the Create
Dummy MAC Address check box. You can update this information manually later. If you
supplied MAC addresses or device names in the data input file, do not choose this option.

If you do not know the MAC address of the phone that is assigned to the user, choose this option.
When the phone is plugged in, a MAC address registers for that device.

Attention

Step 4 In the User Template Name field, choose the BAT user template that you used for this transaction
Step 5 In the Job Information area, enter the Job description.
Step 6 Choose an insert method. Do one of the following:

a) Click Run Immediately to insert the phones with users immediately.
b) Click Run Later to insert the phones with users at a later time.

Step 7 To create a job for inserting the phones and user records, click Submit.
To schedule and activate this job, use the Job Scheduler option in the Bulk Administration main menu.

Related Topics
Add Phone and User File Format, on page 249
Add Phones with Users Using the BAT Spreadsheet, on page 248
BAT Log Files, on page 609
Phones with Users Combinations File Format, on page 631
Manage Scheduled Jobs, on page 599
TAPS Overview, on page 583
Topics Related to Phone and User Insertion, on page 254
Validate Phones and User Records, on page 251

Topics Related to Phone and User Insertion
• Add Phones with Users Using the BAT Spreadsheet, on page 248

• Phones with Users Combinations File Format, on page 631

• Add Phone and User File Format, on page 249

• Validate Phones and User Records, on page 251

• Manage Scheduled Jobs, on page 599

• TAPS Overview, on page 583

• BAT Log Files, on page 609
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P A R T VI
Managers and Assistants

• Cisco Unified Communications Manager Assistant, on page 257
• Manager and Assistant Insertions, on page 271
• Manager and Assistant Deletions, on page 275
• Manager Deletions, on page 277
• Assistant Deletions, on page 281
• Manager and Assistant Report Generation, on page 285





C H A P T E R 30
Cisco Unified Communications Manager
Assistant

This chapter provides information about setting up manager and assistant phones with either shared lines or
proxy lines for the Unified Communications Manager Assistant. Information is also provided for adding and
updating manager-assistant associations using a BAT spreadsheet, and for creating default and custom CSV
data files for manager-assistants.

You can use the Cisco Unified Communications Manager Bulk Administration (BAT) to manage the Cisco
Unified Communications Manager Assistant feature in Unified Communications Manager. You can add,
update, and delete managers or assistants with their associations in bulk transactions.

For detailed tasks and information about Cisco Unified Communications Manager Assistant, see the Feature
Configuration Guide for Cisco Unified Communications Manager at http://www.cisco.com/c/en/us/support/
unified-communications/unified-communications-manager-callmanager/
products-installation-and-configuration-guides-list.html.

• Phones and Lines for Cisco Unified Communications Manager Assistant, on page 257
• CSV Data File for Manager-Assistant Associations, on page 266
• Topics Related to CVS Data Files for Manager-Assistant, on page 270

Phones and Lines for Cisco Unified Communications Manager
Assistant

The CiscoUnifiedCMAssistant feature works with several CiscoUnifiedIPPhone models and device profiles.
CiscoUnifiedCM Assistant provides two modes for configuring managers and assistants lines for use with
CiscoUnifiedCM Assistant features.

• Proxy mode—The primary manager line associates with a proxy line that has a different directory number
on the assistant phone.

• Shared line mode—The manager and assistant have a shared line on their phones that uses the same
directory number and partition.

You can associate users to devices/phones only if they support UnifiedCM Assistant.Note
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You can use BAT to set up the manager and assistant phones with either proxy lines or shared lines.

Related Topics
Set Up Phones in Proxy Line Mode for Cisco Unified Communications Manager Assistant, on page 258
Set Up Phones in Shared LineMode for Cisco Unified CommunicationsManager Assistant, on page 264
Insert Manager-Assistant Associations to Cisco Unified Communications Manager, on page 271

Set Up Phones in Proxy Line Mode for Cisco Unified Communications Manager
Assistant

To prepare for configuring manager and assistant phones with UnifiedCM Assistant proxy line support, you
must complete the following tasks:

Procedure

Step 1 Set up and configure UnifiedCMAssistant requirements for your system. Cisco recommends that you use the
CiscoUnifiedCM Assistant Configuration Wizard. The wizard automatically creates the phone templates for
UnifiedCM Assistant manager and assistant, route points, partitions, translation patterns, and calling search
space for the CiscoUnifiedCMAssistant service. To run the CiscoUnifiedCMAssistant ConfigurationWizard,
ensure BAT and the wizard are on the same server.

See theFeature Configuration Guide for Cisco Unified Communications Manager Guide for information
about running the CiscoUnifiedCM Assistant Configuration Wizard.

You can use the CiscoUnifiedCM Assistant Configuration Wizard only one time to set up the
UnifiedCMAssistant configuration requirements for your system. After running the configuration
wizard, you can only view, but not change, your configuration with the wizard.

Note

Step 2 To add new phones and users for managers and assistants, use the UnifiedCMAssistant manager andUnifiedCM
Assistant assistant phone templates that the CiscoUnifiedCM Assistant Configuration Wizard produced on
the BAT server. Use the BAT templates to configure phones for proxy mode only.

Step 3 For existing manager and assistant phones, you can change the manager and assistant phones to correspond
to the UnifiedCM Assistant phone templates by using either of these methods:

• You can use the Add Lines feature in BAT tomodify existing phones to resemble the UnifiedCMAssistant
phone templates.

• You can delete the original phones and add new phones by using the UnifiedCMAssistant phone templates
for managers and assistants.

Step 4 After you configure the phones and lines for managers and assistants, you associate the manager and assistant
lines for UnifiedCM Assistant control.

Related Topics
Cisco Unified Communications Manager Assistant Manager Phone Template Default Settings, on page
259
Add Phone Lines to Existing Phones and UDPs, on page 161
Add Phones to Database, on page 25
Manager and Assistant Proxy Line Configurations, on page 259
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Cisco Unified Communications Manager Assistant Manager Phone Template Default Settings
The following table lists the default settings for the UnifiedCM Assistant manager phone template.

Table 17: Default Settings for Manager Phone Templates for Proxy Lines

Default ValueField

Softkey Template Standard ManagerSoftkey Template

Standard CiscoUnifiedIPPhone 7960 (2 lines)Phone Button Template

Primary line

• CSS = Generated_CSS_I_E
• Partition = Generated_Managers

Line1

Incoming Intercom line

• CSS = Generated_CSS_I_E
• Partition = Generated_Everyone
• Also configure auto answer with headset option.

Line 2

Assistant Primary ServiceServices

The following table lists the default settings for the UnifiedCM Assistant assistant phone template.

Table 18: Default Settings for Assistant Phone Template for Proxy Lines

Default ValueField

Softkey AssistantSoftkey Template

Standard CiscoUnifiedIPPhone 7960 AssistantPhone Button Template

14-button expansion moduleExpansion Module 1

For proxy lines, one line on base phone and five lines on expansion
module have the following default configuration:

• CSS = Generated_CSS_M_E
• Partition = Generated_Everyone

One line on base phone and five
lines on expansion module

Intercom line

• CSS = Generated_CSS_I_E
• Partition = Generated_Everyone
• Also configure auto answer with headset option.

Line 7

(On Expansion Module)

Manager and Assistant Proxy Line Configurations
BAT assigns UnifiedCM Assistant line configurations by mapping the primary manager lines on the phone
to proxy lines on the assistant phone. When you use the UnifiedCM Assistant manager and assistant default
templates that the UnifiedCM Assistant wizard created, you can associate from one to five manager lines on
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one assistant phone. For phones that are configured with the UnifiedCM Assistant templates, this example
shows the line configurations when you associate two manager phones to an assistant phone.

Manager 1 Phone

• Line 1— Primary line

• Line 2— Intercom line

Manager 2 Phone

• Line 1— Primary line

• Line 2— Intercom line

Assistant Phone

• Line 1—Primary line

• Line 2—Proxy line for Manager 1

• Line 3—Proxy line for Manager 2

• Lines 4 through 6 are unassigned

• Line 7—Intercom line

Assistant Phone

Lines 4 through 6 remain available for other manager associations.

When you associate multiple managers to an assistant phone, BAT creates proxy lines based on the
order in the CSV data file. BAT creates the first manager-assistant line by assigning all the primary
manager lines as proxy lines to the unassigned lines on the assistant phone. BAT continues creating
individual manager-assistant proxy lines based on the order of the CSV record until all lines on the
assistant phone are assigned or all managers in the CSV record are associated.

When you associate multiple assistants to a manager primary line, BAT assigns assistants to the
manager based on the order in the CSV data file. BAT assigns the primary manager lines based on
the first assistant number of available lines. For example, a manager phone has two primary lines.
The first assistant, who is listed in the CSV data file, has only one available line. Consequently, BAT
associates only one primary line for the manager and one proxy line on all the assistant phones that
are listed in the CSV record.

Cisco Unified Communications Manager Assistant Manager Phone Line Configurations

The following table lists all possible line configurations for a manager phone that BAT can set up when you
are using manager-assistant associations.
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Table 19: Manager Phone Line Configuration

ConfigurationNumber of Available Lines

Line 1—Primary line (UnifiedCM Assistant controlled)

Intercom line (none)

One line

Line 1—Primary line (UnifiedCM Assistant controlled)

Line 2—Intercom line (optional)

Two lines

(Default UnifiedCMAssistantmanager
phone template)

Last line gets configured as the intercom line.

The number of available lines on the assistant phone determines
the number of manager lines that get associated with proxy lines.

More than two lines

Unified CM Assistant Phone Line Configurations

The following table lists the default line configurations for the assistant phones that BAT sets up during
manager-assistant associations.

Table 20: Assistant Phone Line Configurations

ConfigurationNumber of Available Lines

Line 1—Proxy line

Intercom line (none)

One line

Line 1—Primary line

Line 2—Proxy line

Intercom line (none)

Two lines

Line 1—Primary line

Line 2—Proxy line

Line 3—Intercom line

Three lines

Line 1—Primary line

Line 2—Proxy line

Last line gets configured as the intercom line

All other lines get configured as proxy lines

More than three lines

Line 1—Primary line

Line 2 through line 6 can get configured as proxy lines to support up to
five managers.

Line 7—Intercom line

Seven lines

(Default UnifiedCM Assistant
assistant phone template)
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Proxy Line Example for Cisco Unified Communications Manager Assistant Manager and Assistant Phones

You associate two managers, each with three existing lines, to an assistant phone with six unassigned lines.
BAT sets the following line configurations on the manager and assistant phones.

Manager 1 Phone

• Line 1—Manager primary line (DN is 2355)

• Line 2—Manager primary line (DN is 2366)

• Line 3—Manager intercom line

Manager 2 Phone

• Line 1—Manager primary line (DN is 2656)

• Line 2—Manager primary line (DN is 2666)

• Line 3—Manager intercom line

Assistant Phone

• Line 1—Assistant primary line (DN is 3333)

• Line 2—Proxy line 1 for Manager 1 (DN is 3455)

• Line 3—Proxy line 1 for Manager 2 (DN is 3656))

• Line 4—Proxy line 2 for Manager 1 (DN is 3366)

• Line 5—Proxy line 2 for Manager 2 (DN is 3666)

• Line 6—Available

• Line 7—Assistant intercom line

Assistant Phone

When you associate a manager phone that has preexisting primary lines, you must ensure that the
number of unassigned lines on the assistant phone equals or is greater than the number of primary
lines on the manager phone. For instance, BAT does not allow you to create an association between
a manager that has a phone with four configured primary lines and an assistant with only three
available lines.

Set Up Proxy Lines on New Manager and Assistant Phones for Cisco Unified Communications
Manager Assistant

You can set up new UnifiedCM Assistant manager and assistant phones to use proxy lines.
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Before you begin

1. Run the UnifiedCMAssistant ConfigurationWizard to create the UnifiedCMAssistant templates, partition,
and calling search space.

2. If you want to associate more than five managers to an assistant, youmust access the UnifiedCMAssistant
Template andmake a copy with a new name. Addmore lines to the template to accommodate the additional
managers.

Procedure

Step 1 Choose BAT Administration > Phones > Phones Template.

The Phone Template Configuration window displays.

Because BAT UnifiedCM Assistant templates are write protected, if you want to make changes
to these templates, you must make a copy of the template and then edit the template with your
changes. See Table 17: Default Settings for Manager Phone Templates for Proxy Lines, on page
259 for default manager phone template field descriptions. See Table 18: Default Settings for
Assistant Phone Template for Proxy Lines, on page 259 for default assistant phone template field
descriptions.

Note

Step 2 Create the CSV data file for manager phones and another file for assistant phones using these options:
a) Use the BAT spreadsheet and choose the Phones tab.
b) Use a text editor and refer to the manager or assistant template fields as a guide.

What to do next

Follow the procedures in Add Phones to Database, on page 25 to insert new phones.

Set Up Proxy Lines on Existing Manager and Assistant Phones for Cisco Unified Communications
Manager Assistant

You can set up existing UnifiedCM Assistant manager and assistant phones to use proxy lines.

Procedure

Step 1 Choose BAT Administration > Phones > Add Lines.
The Phone Add Lines window displays.

Step 2 You may need to copy and modify the UnifiedCM Assistant templates for BAT.

See Table 17: Default Settings for Manager Phone Templates for Proxy Lines, on page 259 for default manager
phone template field descriptions, and see Table 18: Default Settings for Assistant Phone Template for Proxy
Lines, on page 259 for default assistant phone template field descriptions.

If you changed any configuration information (for example, partition names) when you ran the
CiscoUnifiedCMAssistant ConfigurationWizard, youmust use the same configuration information
for the fields when you edit the template.

Note
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Step 3 Create the CSV data file for manager phones and another file for assistant phones using one of these options:
a) Use the BAT spreadsheet and choose the Add Lines tab.
b) Use a text editor and use the manager or assistant template fields as a guide.

What to do next

You can set up manager and assistant lines on existing phones.

Related Topics
Add Phone Lines to Existing Phones and UDPs, on page 161
Topics Related to CVS Data Files for Manager-Assistant, on page 270

SetUpPhonesinSharedLineModeforCiscoUnifiedCommunicationsManager
Assistant

You can set up manager and assistant phones to use shared lines when you create a BAT template to add new
phones in the CiscoUnified CommunicationsManager database. Use the procedures for setting up new phones
using BAT.

Before you begin

You must set up the UnifiedCM Assistant service parameters for shared line support in CiscoUnified
Communications Manager.

If you have a CiscoUnifiedIPPhone model 7960, you need a phone button template with five or more lines.Note

Procedure

Create a BAT template to add new or update existing manager and assistant phones using the following
guidelines:
a) For manager phones, see Manager Phone Settings for Shared Line Mode, on page 265.
b) For assistant phones, see Assistant Phone Settings for Shared Line Mode, on page 265.

What to do next

You must associate the manager and assistant lines for UnifiedCM Assistant control. Follow the procedures
in the CSV Data File for Manager-Assistant Associations, on page 266.

Related Topics
Add Phones to Database, on page 25
Add Phone Lines to Existing Phones and UDPs, on page 161
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Manager Phone Settings for Shared Line Mode
When you create the BAT template to add new or update existing manager phones with shared lines, use the
following phone settings:

• Assign the Softkey template: Standard Shared Mode Manager.

• Add primary lines to share with assistants, if needed.

• Set up the voice-messaging profile on the primary line.

• Add an incoming intercom line (optional).

• Add speed-dial buttons for outgoing intercom targets (optional).

• Set the user locale.

Related Topics
Add Phones to Database, on page 25
Set Up Phones in Shared LineMode for Cisco Unified CommunicationsManager Assistant, on page 264

Assistant Phone Settings for Shared Line Mode
When you create the BAT template to add new or update existing assistant phones with shared lines, use the
following phone settings:

• Assign the Softkey template: Standard Assistant

• If you are using a Cisco 14-button expansion module (7914) for additional lines, specify the expansion
module type in the BAT template.

CiscoUnifiedIPPhone 7960 phone button templates include expansion module
lines.

Note

• Add a personal primary line.

• Add shared lines for each associated manager. Use the same directory number and partition as the primary
line on the manager phone.

• Add an incoming intercom line (optional)

• Add speed dials to the managers intercom lines (optional)

• Set the user locale

Related Topics
Add Phones to Database, on page 25
Set Up Phones in Shared LineMode for Cisco Unified CommunicationsManager Assistant, on page 264

Manager and Assistant Shared Line Configurations
BAT associates CiscoUnifiedCMAssistant line configurations to shared lines that are assigned to the manager
and the assistant phones. You set the shared line mode in the manager’s configuration when associating
managers with assistants.
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In shared line mode, the manager line corresponds to a shared line on the assistant phone. For example, to
associate twomanagers with an assistant, you add two lines to the assistant phone that have the same directory
numbers and partitions as the primary lines on the manager phones.

Manager 1 Phone

• Line 1— Primary line (DN is 2355)

• Line 2— Intercom line (optional)

Manager 2 Phone

• Line 1— Primary line (DN is 2875)

• Line 2— Intercom line (optional)

Assistant Phone

• Line 1—Assistant primary line (DN is 3356)

• Line 2—Shared line with Manager 1 (DN is 2355)

• Line 3—Shared line with Manager 2 (DN is 2875)

• Lines 4 through 6 are available

• Line 7—Intercom line (optional)

You can add lines 4 through 6 as shared lines for other managers.

When you add multiple manager lines to an assistant phone, all lines on the assistant phone must use shared
line mode. You cannot mix proxy and shared lines on the assistant phone. Likewise, when a manager has
multiple assistants, all associations must use shared line mode.

When you associate multiple assistants to a manager who has shared line mode, BAT assigns UnifiedCM
Assistant associations only to those assistants that are also using shared line mode.

Related Topics
Topics Related to CVS Data Files for Manager-Assistant, on page 270

CSV Data File for Manager-Assistant Associations
When you use BAT to insert manager-assistant associations to the Unified CommunicationsManager database,
you can add new associations or update existing associations.

You have two options for creating a CSV data file to add or update manager-assistant associations: using the
BAT spreadsheet or using a text editor to create a text file in CSV format.

When you create an association for a new manager, you need to enter a device name. When you update a
manager with an existing UnifiedCM Assistant record, consider these fields optional. BAT does not allow
you to assign the intercom line of a manager to a proxy line for an assistant if the number of manager lines is
greater than or equal to three.

Related Topics
Add or Update Manager-Assistant Associations Using BAT Spreadsheet, on page 267
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Managers and Assistants File Formats, on page 642
Manager and Assistant Proxy Line Configurations, on page 259

Add or Update Manager-Assistant Associations Using BAT Spreadsheet
Use the BAT spreadsheet to add new or update existingUnifiedCMAssistant associations. The BAT spreadsheet
includes data file templates with macros to make it easy to add, update, or delete manager-assistant associations.

Procedure

Add new UnifiedCM Assistant associations using the BAT spreadsheet.
a) To create manager-assistant associations with the default line configuration, see Create Default

Manager-Assistant CSV Data Files, on page 267.
See Table 19: Manager Phone Line Configuration, on page 261 and Table 20: Assistant Phone Line
Configurations, on page 261 for the default line configurations for the manager and assistant phones.

b) To assign proxy lines that do not follow the default line configuration, see Create CustomManager-Assistant
CSV Data Files, on page 269.

Related Topics
BAT Spreadsheet Data Collection for CSV Data File Creation, on page 12

Manager-assistantAssociationAdditionsandUpdatesUsingBATSpreadsheet
The BAT spreadsheet includes data file templates with macros to make it easy to add, update, or delete
manager-assistant associations.

When you use the BAT spreadsheet to add new Unified CM Assistant associations, you can set up the
manager-assistant configurations in two ways:

• Createmanager-assistant associations with the default line configuration. For the default line configurations
for the manager and assistant phones, see Table 19: Manager Phone Line Configuration, on page 261and
Table 20: Assistant Phone Line Configurations, on page 261.

• Assign proxy lines that do not follow the default line configuration using a custom CSV data file.

Related Topics
BAT Spreadsheet Data Collection for CSV Data File Creation, on page 12
Create Custom Manager-Assistant CSV Data Files, on page 269
Create Default Manager-Assistant CSV Data Files, on page 267

Create Default Manager-Assistant CSV Data Files
Use the BAT spreadsheet to create a CSV data file for inserting, updating, or deleting default manager-assistant
associations for both proxy and shared mode.

After you have finished editing all the fields in the BAT spreadsheet, you can export the content to a CSV
formatted data file. The file is saved to C:\XLSDataFiles or to your choice of another existing folder on
your local workstation and is assigned a default filename:
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<type of operation>ManagerAssistants-timestamp.txt

where <type of operation> can be either insert or delete, and “timestamp” represents the precise date and
time that the file was created.

Procedure

Step 1 Download and open the BAT.xlt file to open the BAT spreadsheet.
Step 2 When prompted, click Enable Macros to use the spreadsheet capabilities.
Step 3 To display the manager-assistant association options, click theDefault Managers-Assistants tab at the bottom

of the spreadsheet.
Step 4 Scroll to the right side of the template until you see the radio buttons and choose the type of associations for

this transaction:

• One manager, multiple assistants
• One assistant, multiple managers

Step 5 Complete all mandatory fields and any relevant, optional fields.
a) If you choose the One manager, multiple assistants radio button, enter the following information in

each row:

• Manager ID—Enter the user ID, up to 30 characters, of the manager.

• Assistant ID#—Enter the user IDs, up to 30 characters, for the assistants to whom the manager will
be associated, where the # symbol represents the number of assistants assigned to a manager.

To add more assistants, click Add more Assistants.Tip

b) If you choose the One assistant, multiple managers radio button, enter the following information in
each row:

• Assistant ID—Enter the user ID, up to 30 characters, of the assistant.

• Manager ID#—Enter the user IDs, up to 30 characters, for the managers to whom the assistant will
be associated. where the # symbol represents the number of managers assigned to an assistant.

To add more managers, click Add more Managers.Note

Step 6 Choose the operation that you want to perform:
a) To create new manager-assistant associations, click Insert.
b) To delete a manager or an assistant from a manager-assistant association, click Delete.

Step 7 To transfer the data from the BAT spreadsheet into a CSV data file, click Export to BAT Format.

For information on how to read the exported CSV data file, click the link to View Sample File
in theInsert Managers/Assistants window in BAT.

Tip

The system saves the file using the default filename <type of operation>ManagerAssistants-timestamp.txt

to C:\XLSDataFiles or to your choice of another existing folder on your local workstation.
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What to do next

You must upload the CSV data file to the Cisco Unified Communications Manager first node database server
so BAT can access the CSV data file.

Related Topics
Download File Off Server, on page 20
Topics Related to CVS Data Files for Manager-Assistant, on page 270
Upload File to Server, on page 21

Create Custom Manager-Assistant CSV Data Files
When you have existing phones that you want to set up with manager-assistant associations, you can use the
Custom Managers-Assistants tab in the BAT spreadsheet. Use the BAT spreadsheet to create a custom CSV
data file for inserting or updating manager-assistant associations for proxy lines on the assistant phones.

After you have finished editing all the fields in the BAT spreadsheet, you can export the content to a CSV
formatted data file. The system saves the file using the default filename Custom
Manager-Assistants-timestamp.txt to C:\XLSDataFiles or to your choice of another existing folder
on your local workstation.

Procedure

Step 1 Download the BAT.xlt file from Cisco Unified Communications Manager server.
Step 2 Open the BAT.xlt file. When prompted, click Enable Macros to use the spreadsheet capabilities.
Step 3 To display the manager-assistant association options, click the Custom Managers-Assistants tab at the

bottom of the spreadsheet.
Step 4 Scroll to the right side of the template until you seeNumber of Proxy Lines box. In that box, enter the number

of proxy lines that you are assigning to an assistant. The spreadsheet adds Proxy Line DN and Manager Line
DN Columns based on the number that you enter.

Complete all mandatory fields and any relevant, optional fields.

• Manager ID—Enter the user ID of the manager.

• Device Name—Enter the device name that are assigned to the manager phone.

• Intercom DN—Enter the directory number for the manager intercom line. (Optional)

• Assistant ID—Enter the user IDs for the assistants to whom the manager will be associated.

• Device Name—Enter the device name that are assigned to the assistant's phone.

• Intercom DN—Enter the directory number for the assistant intercom line. (Optional)

• Proxy Line DN#—Enter the directory number for the assistant proxy line.

• Manager Line DN#—Enter the directory number for the manager primary line.

The # symbol represents the number of proxy lines that are associated to a manager.

Step 5 To transfer the data from the BAT spreadsheet into a CSV data file, click Export to BAT Format button.
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For information on how to read the exported CSV data file, click the link to View Sample File
in theInsert Managers/Assistants window in BAT.

Tip

The system saves the file using the default filename Custom Manager-Assistants-timestamp.txt to
C:\XLSDataFiles or to your choice of another existing folder on your local workstation.

What to do next

You must upload the CSV data file to the Unified Communications Manager first node database server so
BAT can access the CSV data file.

Related Topics
Topics Related to CVS Data Files for Manager-Assistant, on page 270
Upload File to Server, on page 21

Topics Related to CVS Data Files for Manager-Assistant
• Phones and Lines for Cisco Unified Communications Manager Assistant, on page 257

• CSV Data File for Manager-Assistant Associations, on page 266

• Insert Manager-Assistant Associations to Cisco Unified Communications Manager, on page 271

• Set Up Phones in Proxy Line Mode for Cisco Unified Communications Manager Assistant, on page 258

• Set Up Phones in Shared LineMode for Cisco Unified CommunicationsManager Assistant, on page 264

• Delete SpecificManager-Assistant Associations FromCisco Unified CommunicationsManager, on page
275

For more information related to CiscoUnifiedCM Assistant, refer to this documentation.

• Feature Configuration Guide for Cisco Unified Communications Manager

• Cisco Unified Communications Manager Assistant User Guide
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C H A P T E R 31
Manager and Assistant Insertions

This chapter provides information to use Cisco Unified CommunicationsManager Bulk Administration (BAT)
to manage the Cisco Unified Communications Manager Assistant feature in Cisco Unified Communications
Manager. BAT allows you to add IP phones for managers and assistants with either proxy lines or shared
lines.

The CiscoUnifiedCMAssistant feature works with several CiscoUnifiedIPPhone models and device profiles.
CiscoUnifiedCM Assistant provides two modes for configuring managers and assistants lines for use with
CiscoUnifiedCM Assistant features.

• Proxy mode—Themanager primary line associates with a proxy line that has a different directory number
on the assistant phone. See the Set Up Phones in Proxy Line Mode for Cisco Unified Communications
Manager Assistant, on page 258.

• Shared line mode—The manager and assistant have a shared line on their phones that uses the same
directory number and partition. See the Set Up Phones in Shared Line Mode for Cisco Unified
Communications Manager Assistant, on page 264.

• Insert Manager-Assistant Associations to Cisco Unified Communications Manager, on page 271
• Topics Related to Manager and Assistant Insertion, on page 273

Insert Manager-Assistant Associations to Cisco Unified
Communications Manager

To insert new manager-assistant associations or update existing associations, you need a CSV data file.

When BAT updates manager-assistant associations, it does not change existing CiscoUnifiedCM Assistant
line configurations for the intercom directory number or associated devices.

The manager-assistant association fails when the assistant phone does not have enough lines to support the
minimum CiscoUnifiedCM Assistant configuration.

Caution

Before you begin

1. Make sure that you have configured manager and assistant phones using one of the following two
procedures:
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Set Up Phones in Proxy Line Mode for Cisco Unified Communications Manager Assistant, on page
258

•

• Set Up Phones in Shared Line Mode for Cisco Unified CommunicationsManager Assistant, on page
264

2. You must have a data file in comma separated value (CSV) format that contains the unique details for the
new manager-assistant associations.

Procedure

Step 1 Choose Bulk Administration > Managers/Assistants > Insert Managers/Assistants.
The Manager/Assistant Options window displays.

Step 2 In the File Name field, choose the CSV data file that you created for this bulk transaction.
Step 3 If the managers use extension mobility to log in, check the Configure managers as mobile managers check

box.
Step 4 When all the phones have shared lines, check the Uses shared lines check box.

Step 5 In the Insert Options area, choose the type of CSV data file that you created:

• Default—If you created a standard CSV data file, choose the type of associations for this transaction
based on the data in the CSV file.

• Associate one or more assistants to a manager

• Associate one or more managers to an assistant

• Custom—If you created a custom CSV data file for proxy mode.

Step 6 In the Job Information area, enter the Job description.
Step 7 Choose an insert method. Do one of the following:

a) Click Run Immediately to insert the manager-assistant associations immediately.
b) Click Run Later to insert the manager-assistant associations at a later time.

Step 8 To create a job for inserting the manager-assistant records, click Submit.
To schedule and activate this job, use the Job Scheduler option in the Bulk Administration main menu.

If there were not enough available lines when BAT performs an update to an assistant or manager
configuration, the changes are only partially completed and the whole transaction record fails.

Attention

What to do next

For changes to take effect, you must restart CiscoUnifiedCM Assistant service.

Related Topics
BAT Log Files, on page 609
CSV Data File for Manager-Assistant Associations, on page 266
Manage Scheduled Jobs, on page 599
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Topics Related to Manager and Assistant Insertion, on page 273

Topics Related to Manager and Assistant Insertion
• Set Up Phones in Proxy Line Mode for Cisco Unified Communications Manager Assistant, on page 258

• Set Up Phones in Shared LineMode for Cisco Unified CommunicationsManager Assistant, on page 264

• CSV Data File for Manager-Assistant Associations, on page 266

• Manage Scheduled Jobs, on page 599

• BAT Log Files, on page 609
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C H A P T E R 32
Manager and Assistant Deletions

This chapter provides information to use Unified Communications Manager Bulk Administration (BAT) to
delete a specific manager-assistant association from the Unified Communications Manager database.

• Delete SpecificManager-Assistant Associations FromCisco Unified CommunicationsManager, on page
275

Delete Specific Manager-Assistant Associations From Cisco
Unified Communications Manager

You can delete specific manager-assistant associations from Cisco Unified Communications Manager.

Before you begin

You must have a CSV data file that contains the user IDs for the specific managers and assistants associations
that you want to delete.

For example, the assistant with the user ID, jmorgan, is assigned to two managers with user IDs, rcraig and
dbaker. If you want to change the manager-assistant association, so the assistant, jmorgan is only assigned to
rcraig, you can delete the jmorgan-dbaker association by creating a CSV data file with the following entry:

jmorgan,dbaker

Procedure

Step 1 Choose Bulk Administration > Managers/Assistants > Delete Managers/Assistants.
The Delete Managers/Assistants Configuration window displays.

Step 2 In the File Name field, choose the CSV file that you created for this type of bulk transaction.
Step 3 Choose the type of deletion:

• Delete associated assistants for one manager
• Delete associated managers for one assistant

Step 4 In the Job Information area, enter the Job description.
Step 5 Choose a delete method. Do one of the following:

a) Click Run Immediately to delete the manager-assistant associations immediately.
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b) Click Run Later to delete the manager-assistant associations at a later time.

Step 6 Click Submit to create a job for deleting the required manager-assistant associations.
Use the Job Configuration window to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Cisco Unified Communications Manager Assistant, on page 257
Manage Scheduled Jobs, on page 599
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C H A P T E R 33
Manager Deletions

This chapter provides information to delete managers with all their manager-assistant associations from the
Unified Communications Manager database and LDAP Directory. You can use either a query search or a
custom file to locate existing records to delete.

• Manager Deletions From Cisco Unified Communications Manager, on page 277
• Topics Related to Manager Deletions, on page 280

Manager Deletions From Cisco Unified Communications
Manager

When you delete Unified CM Assistant managers with all their manager-assistant associations from the
Unified Communications Manager database and LDAP Directory, Cisco Unified Communications Manager
maintains information on the manager as a user in the directory. For example, if a manager with the user ID,
rmartinez, has two assistants with user IDs, dbell and jkent, you can disassociate rmartinez from both assistants
by deleting rmartinez as a manager in the Cisco Unified Communications Manager database. The directory
still shows rmartinez as a user.

You can use either a query search or a custom file to locate existing records to delete.

Delete Manager Associations Using Query
You can delete managers from their associations with assistants from Cisco Unified CommunicationsManager
directory, use this procedure.

Procedure

Step 1 Choose BATAdministration > Managers/Assistants > Delete Managers > Query.
Step 2 From the first Find Managers where drop-down list box, choose one of the following criteria:

• User ID

• First Name

• Middle Name

• Last Name
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• Department

From the second Find Managers where drop-down list box, choose one of the following criteria:

• begins with

• contains

• is exactly

• ends with

• is empty

• is not empty

Step 3 Specify the appropriate search text, if applicable, then click Find.

To find all managers that are registered in the database, click Find without entering any search
text.

Tip

a) To choose managers frommore than one department, enter multiple departments in this field. For example,
to choose managers from departments 12 and 24, enter 12, 24 in the third box instead of performing two
operations.

b) To further define your query and to add multiple filters, check the Search Within Results check box,
choose AND or OR from the drop-down box, and repeat Step 2, on page 277 and Step 3, on page 278.

A list of discovered managers displays by

• User ID

• First Name

• Middle Name

• Last Name

• Department

Step 4 In the Job Information area, enter the Job description.
Step 5 Choose a delete method. Do one of the following:

a) Click Run Immediately to delete managers immediately.
b) Click Run Later to delete managers at a later time.

Step 6 Click Submit to create a job for deleting the chosen managers.
Use the Job Configuration window to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Topics Related to Manager Deletions, on page 280
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Delete Manager Associations Using Custom File
You can delete managers associations from the Cisco Unified Communications Manager database using a
custom file that you create using a text-editor. Use the custom file to locate manager associations that you
want to delete.

Do not use the insert or export transaction files that are created with bat.xlt for the delete transaction. Instead,
you must create a custom file with details of the manager association records that need to be deleted. Use only
this file for the delete transaction.

Attention

Before you begin

1. Create a custom text-based CSV data file that lists user IDs for managers that you want to delete. Make
sure you put each user ID on a separate line.

The custom delete CSV data file does not need a header and you can enter values for manager association
IDs.

Note

2. Upload the custom file to the first node of Cisco Unified Communications Manager server.

Procedure

Step 1 Choose BATAdministration>Managers/Assistants > Delete Managers > Custom File.
Step 2 In Select managers where field, keep the identifier, User ID.
Step 3 In the second field, in Custom File drop-down list box, choose the name of the custom file that you created

for this transaction.
Step 4 Click Find.

The list of discovered managers displays.
Step 5 In the Job Information area, enter the Job description.
Step 6 Choose a delete method. Do one of the following:

a) Click Run Immediately to delete managers immediately.
b) Click Run Later to delete manages at a later time.

Step 7 Click Submit to create a job for deleting chosen managers.
Use the Job Configuration window to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Upload File to Server, on page 21
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Topics Related to Manager Deletions
• Delete SpecificManager-Assistant Associations FromCisco Unified CommunicationsManager, on page
275

• Assistant Deletions From Cisco Unified Communications Manager, on page 281

• BAT Log Files, on page 609

• Upload File to Server, on page 21

• Manage Scheduled Jobs, on page 599
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C H A P T E R 34
Assistant Deletions

This chapter provides information to delete assistants from the Unified Communications Manager database
and LDAP Directory. You can use either a query search or a custom file to locate existing records to delete.

• Assistant Deletions From Cisco Unified Communications Manager, on page 281

Assistant Deletions From Cisco Unified Communications
Manager

When you delete Unified CMAssistant assistants from the Cisco Unified CommunicationsManager database
and LDAP Directory, Cisco Unified Communications Manager maintains information on the assistant as a
user in the directory. For example, Assistant thudson is assigned to two managers, hart and dstewart. You can
disassociate thudson from both managers by deleting thudson as an assistant in the Cisco Unified
Communications Manager database. The directory still shows thudson as a user.

You can use either a query search or a custom file to locate existing records to delete.

Delete Assistants Associations Using Query
You can delete assistants from their associations with managers from the Cisco Unified Communications
Manager directory.

Procedure

Step 1 Choose BATAdministration > Managers/Assistants > Delete Assistants > Query.
Step 2 From the first Find Assistants where drop-down list, choose one of the following criteria:

• User ID

• First Name

• Middle Name

• Last Name

• Department
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From the second Find Assistants where drop-down list box, choose one of the following criteria:

• begins with

• contains

• is exactly

• ends with

• is empty

• is not empty

Step 3 Specify the appropriate search text, if applicable, then click Find.

To find all assistants that are registered in the database, click Find without entering any search
text.

Tip

a) To choose assistants frommore than one department, enter multiple departments in this field. For example,
to choose managers from departments 12 and 24, enter 12, 24 in the third box instead of performing two
operations.

b) To further define your query and to add multiple filters, check the Search Within Results check box,
choose AND or OR from the drop-down list, and repeat Step 2, on page 281 and Step 3, on page 282.

A list of discovered assistants displays by:

• User ID

• First Name

• Middle Name

• Last Name

• Department

Step 4 In the Job Information area, enter the Job description.
Step 5 Choose a delete method. Do one of the following:

a) Click Run Immediately to delete assistants immediately.
b) Click Run Later to delete assistants at a later time.

Step 6 Click Submit to create a job for deleting the chosen assistants.
Use the Job Configuration window to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599

Delete Assistant Associations Using Custom File
You can delete assistants associations from the Cisco Unified Communications Manager database using a
custom file that you create using a text-editor. Use the custom file to locate assistant associations that you
want to delete.
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Do not use the insert or export transaction files that are created with bat.xlt for the delete transaction. Instead,
you must create a custom file with details of the assistant association records that need to be deleted. Use only
this file for the delete transaction.

Attention

Before you begin

1. Create a custom text-based CSV data file that lists user IDs for assistants that you want to delete. Make
sure you put each user ID on a separate line.

The custom delete CSV data file does not need a header and you can enter values for assistants association
IDs.

Note

2. Upload the custom file to the first node of Cisco Unified Communications Manager server.

Procedure

Step 1 Choose BATAdministration > Managers/Assistants > Delete Assistants > Custom File.
Step 2 In Select Assistants where field, keep the identifier, User ID.
Step 3 In the second field, in Custom File drop-down list, choose the name of the custom file that you created for

this transaction.
Step 4 Click Find.
Step 5 In the Job Information area, enter the Job description.
Step 6 Choose a delete method. Do one of the following:

a) Click Run Immediately to delete assistants immediately.
b) Click Run Later to delete assistants at a later time.

Step 7 Click Submit to create a job for deleting chosen assistants.
Use the Job Configuration window to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Upload File to Server, on page 21
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C H A P T E R 35
Manager and Assistant Report Generation

This chapter provides information about generating reports for CiscoUnifiedCM Assistant managers and
assistants. The reports follow a fixed format. You can generate a report by specifying a set of query options
for either managers or assistants.

• Generate Reports for Cisco Unified Communications Manager Assistant Managers and Assistants, on
page 285

• Report Log Files, on page 287
• Topics Related to Manager Assistant Report Generation, on page 287

Generate Reports for Cisco Unified Communications Manager
Assistant Managers and Assistants

You can generate reports for managers or assistants.

Procedure

Step 1 Choose one of these options:
a) To generate amanager report, chooseBulk Administration >Managers/Assistants >Generate Manager

Reports.
b) To generate an assistant report, choose Bulk Administration > Managers/Assistants > Generate

Assistant Reports.

Step 2 You can generate a report for all managers or assistants by not specifying a query, or you can generate a report
for specific managers or assistants by using following steps:
a) In Find Managers (or Assistants) where drop-down list, choose from these query options:

• User ID

• First Name

• Middle Name

• Last Name

• Department
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b) In the second drop-down list, choose from the following options:

• begins with

• contains

• is exactly

• ends with

• is empty

• is not empty

c) In the search field box, enter the value that you want to locate, such as the exact user ID or the last name
of a user, and click Find.

You can add multiple values to the search field box by separating them with a comma as shown in this
example: JohnJ, PaulP, SueS, JoeJ

To further define your query, you can choose AND or OR to add multiple filters and repeat
steps 2.a, on page 285 through 2.c, on page 286.

Note

Step 3 To choose details for your type of report, click Next.

If you want to change the type of query, click Back.Tip

Step 4 In the File Name field, enter your name for this report (required).
Step 5 In the File Format field, select a file format from the drop-down list box.
Step 6 In the Job Information area, enter the Job description.
Step 7 Choose a method to generate reports. Do one of the following:

a) Click Run Immediately to generate reports immediately.
b) Click Run Later to generate reports at a later time.

Step 8 To create a job for generating reports, click Submit.
Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.
Bulk Administration (BAT) saves the report file on the first node of the server.

What to do next

You can search and download the report file using the Upload/Download Files option in the Bulk
Administration menu.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Upload and Download Files, on page 19
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Report Log Files
BAT generates log files for each report transaction and stores them on the first node of Cisco Unified
Communications Manager server. You can find a link to log files from the Job Configuration window for
any job that generated a report. Click the link in the Log File Name column that corresponds to the job with
the log file you want to view.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599

Topics Related to Manager Assistant Report Generation
• Generate Reports for Cisco Unified Communications Manager Assistant Managers and Assistants, on
page 285

• BAT Log Files, on page 609

• Manage Scheduled Jobs, on page 599
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P A R T VII
User Device Profiles

• Manage User Device Profiles, on page 291
• User Device Profile Templates, on page 305
• User Device Profile File Format, on page 313
• User Device Profile File Format Addition, on page 317
• User Device Profile Validation, on page 319
• UDP Generation, on page 321
• User Device Profile Updates, on page 325
• User Device Profile Deletions, on page 333
• User Device Profile Exports, on page 337
• Line Attribute Updates for Devices and User Device Profiles, on page 341
• UDP Line Additions, on page 345
• UDP Report Generation, on page 351
• Intercom DN Additions and Updates for UDPs, on page 355





C H A P T E R 36
Manage User Device Profiles

This chapter provides information about managing user device profiles. The User Device Profiles (UDP)
option in Cisco Unified Communications Manager Bulk Administration (BAT) allows you to add or delete
large numbers of user device profiles. In addition, you can add or update lines for user device profiles. The
system uses UDPs in conjunction with the extension mobility feature.

• Add User Device Profiles, on page 291
• Topics Related to User Device Profiles, on page 304

Add User Device Profiles
When you use BAT to add user device profiles to the Cisco Unified Communications Manager database, you
can add multiple lines and other features.

Choose from two options for creating a CSV data file for user device profiles:

• Use the BAT spreadsheet (BAT.xlt) and export the data to the CSV format.

• Use a text editor to create a text file in CSV format (for experienced users).

Procedure

Step 1 Choose Bulk Administration > User Device Profiles > User Device Profile Template.
The Find and List UDP Templates window displays.

Step 2 Create the CSV data file by following the steps for one of these options.
a) BAT Spreadsheet option

Open the BAT spreadsheet and create the CSV data file.

b) Text Editor option

1. Choose Create UDP File Format. The UDP File Format Query window displays.

2. Use a text editor and create the CSV data file for user device profiles that follows the file format that
you want to use.

3. Choose Add File Format. The Add File Format Configuration window displays.
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Step 3 Choose Validate User Device Profiles.
The User Device Profiles Validation window displays.

Step 4 Choose Insert User Device Profiles.
The User Device Profiles Insert Configuration window displays.

Related Topics
Add User Device Profile File Format, on page 317
Create Bulk Administration Tool (BAT) Template for User Device Profiles, on page 306
Create Text-Based CSV File for User Device Profile, on page 638
Create User Device Profile CSV Data Files Using BAT Spreadsheet, on page 292
Insert User Device Profiles for User Devices, on page 321
Topics Related to User Device Profiles, on page 304
User Device Profile File Format Setup, on page 313
Validate User Device Profiles, on page 319

Create User Device Profile CSV Data Files Using BAT Spreadsheet
You can create the CSV data file for adding new user device profiles using the BAT spreadsheet. When you
use the BAT spreadsheet to add new user device profiles, you can define the file format within the spreadsheet.
The spreadsheet uses the data file formats to display the fields for the CSV data file.

After you have finished editing all the fields in the BAT spreadsheet, you can export the content to a CSV
formatted data file. The file is saved to C:\XLSDataFiles or to your choice of another existing folder on
your local workstation and is assigned a default filename:

<tabname>-<timestamp>.txt

where <tabname> represents the type of input file that you created, such as phones, and <timestamp> represents
the precise date and time that the file was created.

Procedure

Step 1 Download the BAT.xlt file from the Cisco Unified Communications Manager server.
Step 2 Open the BAT spreadsheet. When prompted, click Enable Macros to use the spreadsheet capabilities.
Step 3 To display the User Device Profiles options, click theUser Device Profile tab at the bottom of the spreadsheet.
Step 4 To choose the device and line fields that you can define for each user device profile, clickCreate File Format.

The Field Selection popup window displays.
Step 5 To choose the device fields, click a device field name in the Device Field box, and then click the arrow to

move the field to the Selected Device Fields box.

A CSV data file must include Device Profile Name and Description; therefore, these fields always remain
selected.

You can select a range of items in the list by holding down the Shift key. To select random field
names, hold down the Ctrl key and click field names.

Tip

Step 6 Click a line field name in the Line Field box and click the arrow to move the field to the Selected Line Fields
box.
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You can change the order of the items in the Selected Line and Device boxes. Choose an item
and use the up arrow to move the field closer to the beginning of the list or chose the down arrow
to move the item to the end of the list.

Tip

Step 7 To modify the CSV data file format, clickCreate. A message asks whether you want to overwrite the existing
CSV format. Click OK.
New columns for the selected fields display in the BAT spreadsheet in the order that you specified.

Step 8 To locate the Number of Phone Lines box, scroll to the right.
The number of lines that you specify here must not exceed the number of lines that are configured in the BAT
template or an error will result when you insert the CSV data file and UDP template.

Step 9 You must enter the number of speed-dial buttons in the Number of Speed Dials box. After you enter the
number, columns display for each speed-dial number.

Do not exceed the number of speed dials that are configured in the User Device Profile template,
or an error will result when you insert the CSV data file and UDP template.

Note

Step 10 Enter data for an individual user device profile on each line in the spreadsheet. Complete all mandatory fields
and any relevant optional fields.
Each column heading specifies the length of the field and whether it is required or optional. See Table 21:
Field Descriptions for User Device Profile in the BAT Spreadsheet, on page 293 for field descriptions.

Step 11 To transfer the data from the BAT Excel spreadsheet into a CSV formatted data file, click Export to BAT
Format.

The system saves the file using the default filename <tabname>-<timestamp>.txt to C:\XLSDataFiles\
or to your choice of another existing folder on your local workstation.

For information on how to read the exported CSV data file, click the link to View Sample File
in the Insert User Device Profiles window in BAT.

Note

What to do next

Upload the CSV file to Cisco Unified Communications Manager server.

Related Topics
BAT Spreadsheet Data Collection for CSV Data File Creation, on page 12
Download File Off Server, on page 20
Topics Related to User Device Profiles, on page 304
Upload File to Server, on page 21

User Device Profile Fields Descriptions in BAT Spreadsheet
The following table describes all the user device profile fields in the BAT spreadsheet.

Table 21: Field Descriptions for User Device Profile in the BAT Spreadsheet

DescriptionField

Device Fields (Mandatory Fields)

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
293

User Device Profiles
User Device Profile Fields Descriptions in BAT Spreadsheet



DescriptionField

Enter a unique identifier for the device profile name.Device Profile Name

Enter a description such as “Conference Room A” or “John Smith”
to help identify the phone or device. The description can include up
to 50 characters in any language, but it cannot include double-quotes
("), percentage sign (%), ampersand (&), back-slash (\), or angle
brackets (<>).

Description

Device Fields (Optional Fields)

Enter the country and language set that you want to associate with
this group of IP phones.

This choice determines which cultural-dependent attributes exist for
this user and which language displays for the user in the Cisco Unified
Communications Manager user windows and phones.

User Locale

Enter the softkey template to be used for all phones in this group.Softkey Template

Enter the user ID for the phone user.User ID

Enter the login user ID for a default profile.

If the user device profile is used as a logout profile, specify the login
user ID that will be associated with the phone. After the user logs out
from this user device profile, the phone will automatically log in to
this login user ID.

Login User ID

Enter the user hold audio source that this group of IP phones or CTI
ports should use.

The user hold audio source identifies the audio source from which
music is played when a user places a call on hold.

User Hold Audio Source

Enter the phone template name that you want to associate with this
user device profile.

Phone Template

This setting specifies whether a device that is capable of playing
precedence tones will use the capability when it places an MLPP
precedence call.

MLPP Indication

If available, this setting specifies whether a device that is capable of
preempting calls in progress will use the capability when it places an
MLPP precedence call.

MLPP Preemption
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DescriptionField

Enter one of the following options:

• Off—When the phone is idle and receives a call on any line, the
phone user answers the call from the line on which the call is
received.

• On—When the phone is idle (offhook) and receives a call on
any line, the primary line gets chosen for the call. Calls on other
lines continue to ring, and the phone user must select those other
lines to answer these calls.

• Default—Cisco Unified Communications Manager uses the
configuration from theAlwaysUse Prime Line service parameter,
which supports the Cisco CallManager service.

Always Use Prime Line

Enter one of the following options:

• On—If the phone is idle, the primary line on the phone becomes
the active line for retrieving voice messages when the phone user
presses the Messages button on the phone.

• Off—If the phone is idle, pressing the Messages button on the
phone automatically dials the voice-messaging system from the
line that has a voice message. Cisco Unified Communications
Manager always selects the first line that has a voice message.
If no line has a voice message, the primary line gets used when
the phone user presses the Messages button.

• Default—Cisco Unified Communications Manager uses the
configuration from the Always Use Prime Line for Voice
Message service parameter, which supports the Cisco
CallManager service.

Always Use Prime Line for Voice
Message

Enter a hexadecimal value for the MLPP domain associated with this
device. Must be blank or a value between 0 and FFFFFF.

MLPP Domain

Choose the Feature Control Policy for this group of phones.

A feature control policy specifies the appearance of features and the
associated softkeys that are displayed on the phone.

Feature Control Policy

The Extension Mobility Cross Cluster CSS setting gets used as the
device CSS of the remote phone when the user selects this device
profile during EMCC login.

Extension Mobility Cross Cluster
CSS

Line Fields (Optional Fields)

Enter the directory number for the phone.Directory Number

Choose a route partition to which the directory number belongs.

The directory number can appear in more than one partition.

Route Partition
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DescriptionField

Enter the text that you want to display on the called party’s phone
display, such as the user name (John Smith) or phone location
(Conference Room 1).

If this filed is left blank the system uses the value that is entered in
the Directory Number field.

The default language specifies English.

Display

Choose the calling search space to use when a call is forwarded to the
specified destination.

This setting applies to all devices that are using this directory number.

Forward All CSS

Enter the directory number or directory URI to which all calls are
forwarded.

This setting applies to any dialable phone number, including an outside
destination unless restricted, and to all devices that are using this
directory number.

Forward All Destination

Choose the calling search space to use when a call from an external
number is forwarded to the specified destination.

This setting applies to all devices that are using this directory number.

Forward Busy External CSS

Choose the calling search space to use when a call from an internal
number is forwarded to the specified destination.

This setting applies to all devices that are using this directory number.

Forward Busy Internal CSS

Enter the directory number or directory URI to which a call that is
coming from an external number is forwarded when the line is in use.

This setting applies to any dialable phone number, including an outside
destination unless restricted, and to all devices that are using this
directory number.

Forward Busy Destination External

Enter the directory number or directory URI to which a call that is
coming from an internal number is forwarded when the line is in use.

This setting applies to any dialable phone number, including an outside
destination unless restricted, and to all devices that are using this
directory number.

Forward Busy Destination Internal

Choose the calling search space to use when a call from an external
number is forwarded to the specified destination. The setting displays
only if it is configured in the system.

This setting applies to all devices that are using this directory number.

Calling Search Space Forward No
Answer External

Choose the calling search space to use a call from an internal number
is forwarded to the specified destination. The setting displays only if
it is configured in the system.

This setting applies to all devices that are using this directory number.

Forward No Answer Internal CSS
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DescriptionField

Enter the directory number or directory URI to which a call that is
coming from an external number is forwarded when the phone is not
answered.

This setting applies to any dialable phone number, including an outside
destination unless restricted, and to all devices that are using this
directory number.

Forward No Answer External
Destination

Enter the directory number or directory URI to which a call that is
coming from an internal number is forwarded when the phone is not
answered.

This setting applies to any dialable phone number, including an outside
destination unless restricted, and to all devices that are using this
directory number.

Forward No Answer Internal
Destination

Enter the calling search space to use when a call from an external
number is forwarded to the specified destination. The setting displays
only if it is configured in the system.

This setting applies to all devices that are using this directory number.

Forward NoCoverage External CSS

Enter the calling search space to use when a call from an internal
number is forwarded to the specified destination. The setting displays
only if it is configured in the system.

This setting applies to all devices that are using this directory number.

Forward No Coverage Internal CSS

Enter the directory number or directory URI to which a call that is
coming from an external number is forwarded when the phone does
not have coverage.

This setting applies to any dialable phone number, including an outside
destination unless restricted, and to all devices that are using this
directory number.

Forward No Coverage External
Destination

Enter the directory number or directory URI to which a call that is
coming from an internal number is forwarded when the phone does
not have coverage.

This setting applies to any dialable phone number, including an outside
destination unless restricted, and to all devices that are using this
directory number.

Forward No Coverage Internal
Destination

(CTI ports only) Enter the calling search space to use when a call from
an internal or external call is forwarded to the specified destination.
The setting appears only if it is configured in the system.

This setting applies to all devices that are using this directory number.

Calling Search Space Forward on
Failure External/Internal

(CTI ports only) Enter the directory number or directory URI to which
a call coming from an internal or an external number should be
forwarded when a phone or CTI application fails.

Forward on Failure Destination
External/Internal
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DescriptionField

Enter the number of seconds (between 1 and 300) to allow the call to
ring, before forwarding the call to the destination number entered in
the Forward No Answer Destination field.

Leave this field blank to use the value that is set in the Cisco Unified
Communications Manager service parameter, Forward No Answer
Timer.

Call Forward No Answer Ring
Duration

Enter a name in the Route Filter Name field. The name can contain
up to 50 alphanumeric characters and can contain any combination
of spaces, periods (.), hyphens (-), and underscore characters (_).
Ensure each route filter name is unique to the route plan.

Use concise and descriptive names for your route filters. The
CompanynameLocationCalltype format usually provides a sufficient
level of detail and is short enough to enable you to quickly and easily
identify a route filter. For example, CiscoDallasMetro identifies a
route filter for toll free, inter-local access and transport area (LATA)
calls from the Cisco office in Dallas.

Route Filter

Enter one of the following options:

• Default—Use the value that you configured in the Party Entrance
Tone service parameter.

• On—A tone plays on the phone when a basic call changes to a
multi-party call; that is, a barge call, cBarge call, ad hoc
conference, meet-me conference, or a joined call. In addition, a
different tone plays when a party leaves the multi-party call. If
the controlling device, that is, the originator of the multi-party
call has a built-in bridge, the tone gets played to all parties if you
choose On for the controlling device. When the controlling
device, for example, the conference controller, is no longer
present on the call or if the controlling device cannot play the
tone, Cisco Unified CommunicationsManager does not play the
tone even if you choose On.

• Off—A tone does not play on the phone when a basic call
changes to a multi-party call.

Party Entrance Tone

This field allows you to turn this feature on or off. Enter ‘T’ to enable
Cisco Unified Communications Manager to log missed calls in the
call history for that directory number on the phone. Enter ‘F’ to disable
this feature.

Log Missed Calls

When the parkee is an external party, then the call will be forwarded
to the specified destination in the parker’s Park Monitoring Forward
No Retrieve Destination External parameter. If the Forward No
Retrieve Destination External field value is empty, the parkee will be
redirected to the parker’s line.

Park Monitoring Forward No
Retrieve Destination External

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
298

User Device Profiles
User Device Profile Fields Descriptions in BAT Spreadsheet



DescriptionField

When the parkee is an internal party, then the call will be forwarded
to the specified destination in the parker’s Park Monitoring Forward
No Retrieve Destination Internal parameter. If the Forward No
Retrieve Destination Internal is empty, the parkee will be redirected
to the parker’s line.

Park Monitoring Forward No
Retrieve Destination Internal

This setting uses the settings in theVoice Mail Profile Configuration
window.

When this check box is checked, Cisco Unified Communications
Manager ignores the settings in the Destination box and Calling Search
Space.

Park Monitoring Forward No
Retrieve Internal Voice Mail

This setting uses the settings in theVoice Mail Profile Configuration
window.

When this check box is checked, Cisco Unified Communications
Manager ignores the settings in the Destination box and Calling Search
Space.

Park Monitoring Forward No
Retrieve External Voice Mail

Choose the calling search space to apply to the directory number.Park Monitoring Forward No
Retrieve External CSS

Choose the calling search space to apply to the directory number.Park Monitoring Forward No
Retrieve Internal CSS

This parameter determines the number of seconds that Cisco Unified
CommunicationsManager waits before prompting the user to retrieve
a call that the user parked. This timer starts when the user presses the
Park softkey on the phone, and a reminder is issued when the timer
expires.

Default: 60 seconds

If you configure a non-zero value, this value overrides the value of
this parameter set in the Service Parameters window. However, if
you configure a value of 0 here, then the value in the Service
Parameters window will be used.

Park Monitoring Reversion Timer

Always use a unique E.164 number. Do not use null value.E164

Enter this parameter to make the pilot number the same as the directory
number for this line. This action proves useful if you do not have a
voice-messaging server configured for this phone.

Voice Mail Profile

Enter partitions that are searched for numbers that are called from this
directory number.

Changes cause an update of the call pickup names that
are listed in the Call Pickup Group field. The setting
applies to all devices that are using this directory number.

Note

Line Calling Search Space
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Enter the automated alternate routing (AAR) group for this device.
The AAR group provides the prefix digits that are used to route calls
that are otherwise blocked due to insufficient bandwidth.

Set AAR Group to <None> to prevent rerouting blocked calls.

AAR Group

Enter the music on hold audio source to be played when the user
presses Hold and places a call on hold.

Line User Hold Audio Source

Enter the music on hold audio source to be played when the system
places a call on hold while the user transfers a call or initiates a
conference or call park.

Line Network Hold Audio Source

Enter one of the following values to activate the Auto Answer feature
for this directory number:

• Auto Answer Off <Default>
• Auto Answer with Headset
• Auto Answer with Speakerphone (Intercom)

Make sure that the headset or speakerphone is not
disabled when you choose Auto Answer with Headset
or Auto Answer with Speakerphone.

Note

Auto Answer

Enter the number of seconds to allow the call to ring before forwarding
the call to the Forward No Answer Destination.

No Answer Ring Duration (CFNA)

Enter the Pickup Group Name to specify the call pickup group, which
can answer incoming calls to this line by dialling the appropriate
pickup group number.

To use the BAT phone template entry, leave this field blank.

Call Pickup Group

Enter the number to whichMLPP precedence calls should be directed
if this directory number receives a precedence call and neither this
number nor its call forward destination answers the precedence call.

Values can include numeric characters, pound (#) ,and asterisk (*).

Target Destination (MLPP)

From the drop-down list box, choose the calling search space to
associate with the alternate party target (destination) number.

Target CSS (MLPP)

Enter the number of seconds (between 4 and 30) after which anMLPP
precedence call will be directed to this directory number’s alternate
party if this directory number and its call forwarding destination have
not answered the precedence call.

Leave this setting blank to use the value that is set in the Cisco Unified
CommunicationsManager enterprise parameter, Precedence Alternate
Party Timeout.

No Answer Ring Duration (MLPP)
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Enter text that identifies this directory number for a line/phone
combination.

The default text specifies English

Line Text Label

Enter the phone number (or mask) that is sent for Caller ID information
when a call is placed from this line.

You can enter a maximum of 30 numbers and “X” characters. The
Xs represent the directory number and must appear at the end of the
pattern. For example, if you specify a mask of 972813XXXX, an
external call from extension 1234 displays a caller ID number of
9728131234.

External Phone Number Mask

You can configure up to 200 calls for a line on a device in a cluster,
with the limiting factor being the device. As you configure the number
of calls for one line, the calls available for another line decrease.

The default specifies 4. If the phone does not allow multiple calls for
each line, the default specifies 2.

For CTI route points, you can configure up to 10,000 calls for each
port. The default specifies 5000 calls. Use this field in conjunction
with the Busy Trigger field.

Maximum Number of Calls

This setting, which works in conjunction with Maximum Number of
Calls and Call Forward Busy, determines the maximum number of
calls to be presented at the line. If maximum number of calls is set
for 50 and the busy trigger is set to 40, then incoming call 41 gets
rejected with a busy cause (and will get forwarded if Call Forward
Busy is set). If this line is shared, all the lines must be busy before
incoming calls get rejected.

Use this field in conjunction withMaximumNumber of Calls for CTI
route points. The default specifies 4500 calls.

Busy Trigger

Use this field to configure the handset lamp illumination policy.
Choose one of the following options:

• Use System Policy (The directory number refers to the service
parameter “Message Waiting Lamp Policy” setting.)

• Light and Prompt
• Prompt Only
• Light Only
• None

Message Waiting Lamp Policy
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Choose the ring setting for the line appearance when an incoming call
is received and no other active calls exist on that device. Choose one
of the following options:

• Use system default
• Disable
• Flash only
• Ring once
• Ring

The “Disable ” or “Flash only” setting options apply
only for the handset. The led light on the phone button
line will still flash.

Note

Ring Setting (Phone Idle)

Choose the ring setting that is used when this phone has another active
call on a different line. Choose one of the following options:

• Use system default
• Disable
• Flash only
• Ring once
• Ring
• Beep only

The “Disable ” or “Flash only” setting options apply
only for the handset. The led light on the phone button
line will still flash.

Note

Ring Setting (Phone Active)

Enter a directory URI to associate with the directory number for this
phone. Follow the username@host format. Enter a username of up to
47 alphanumeric characters. For the host address, enter an IPv4 address
or fully qualified domain name.

Within Cisco Unified CMAdministration, you can enter
directoryURIswith embedded double quotes or commas.
However, when you use Bulk Administration to import
a csv file that contains directory URIs with embedded
double quotes and commas, you must use enclose the
entire directory URI in double quotes and escape the
embedded double quotes with a double quote. For
example, the Jared, "Jerry",Smith@test.com directory
URI must be input as "Jared,""Jerry"",Smith@test.com"
in the csv file.

Note

URI (1-5) on Directory Number

Enter the partition on which the directory URI belongs. If you do not
want to restrict access to the directory URI, leave the field blank

URI (1-5) on Route Partition
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Enter a 't' (True) to indicate that this directory URI is the primary
directory URI for this extension. Otherwise, enter an 'f' (False) to
indicate that this is not the primary directory URI for this extension.

You can associate up to five directory URIs to a single
directory number, but you must select a single primary
directory URI.

Note

URI (1-5) Is Primary on Directory
Number

Enter a 't' to add this enterprise alternate number to a local route
partition. Enter 'f' to leave the E.164 number off of local routing.

Enterprise Add to Local Route
Partition

Enter a 't' to enable ILS to advertise this alternate number to rest of
the ILS network. Enter an 'f' if you don't want ILS to advertise this
number.

Enterprise Advertise via globally

Enter a 't' to classify routing for this alternate number as urgent.

By default, if the dial plan contains overlapping route patterns Cisco
Unified Communications Manager does not route the call until the
interdigit timer expires (even if a possible route exists for the dialed
digits). This setting guards against learned numbers that overlap with
statically configured directory numbers and number patterns by
allowing Cisco Unified Communications Manager to choose the best
match of all available routes for the dial string.

When you mark the number as urgent priority, Cisco Unified
Communications Manager routes the call as soon as it finds a match
between the dialed digits and an available route, without waiting for
the interdigit timer to expire (for example, the T302 Timer service
parameter).

Enterprise Is Urgent

Enter the number mask to apply to the directory number. Cisco Unified
Communications Manager applies the mask to create an enterprise
alternate number that is an alias of this directory number.

Enterprise Number Mask

Enter the local route partition to which you want to assign this
enterprise alternate number.

Enterprise Route Partition

Enter a 't' to add this E.164 alternate number to a local route partition.
Enter 'f' to leave the E.164 number off of local routing.

+E.164 Add to Local Route Partition

Enter a 't' to enable ILS to advertise this alternate number to rest of
the ILS network. Enter an 'f' if you don't want ILS to advertise this
number.

+E.164 Advertise via globally
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Enter a 't' to classify routing for this alternate number as urgent.

By default, if the dial plan contains overlapping route patterns Cisco
Unified Communications Manager does not route the call until the
interdigit timer expires (even if a possible route exists for the dialed
digits). This setting guards against learned numbers that overlap with
statically configured directory numbers and number patterns by
allowing Cisco Unified Communications Manager to choose the best
match of all available routes for the dial string.

When you mark the number as urgent priority, Cisco Unified
Communications Manager routes the call as soon as it finds a match
between the dialed digits and an available route, without waiting for
the interdigit timer to expire (for example, the T302 Timer service
parameter).

+E.164 Is Urgent

Enter the number mask to apply to the directory number. Cisco Unified
Communications Manager applies the mask to create an +E.164
alternate number that is an alias of this directory number.

+E.164 Number Mask

Enter the local route partition to which you want to assign this +E.164
alternate number.

+E.164 Route Partition

Topics Related to User Device Profiles
• Add User Device Profiles, on page 291

• Insert User Device Profiles for User Devices, on page 321

• User Device Profile Deletions, on page 333

• Export User Device Profile Records, on page 339

• Add Phone Lines to Existing Phones and UDPs, on page 161

• Generate User Device Profile Reports, on page 351
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C H A P T E R 37
User Device Profile Templates

This chapter provides information to create and modify user device profiles.

• Find User Device Profile Template, on page 305
• Create Bulk Administration Tool (BAT) Template for User Device Profiles, on page 306
• User Device Profile Template Fields Descriptions in BAT Spreadsheet, on page 307
• Modify User Device Profile BAT Template, on page 310

Find User Device Profile Template
You can locate a specific user device profile (UDP) template in the Cisco Unified Communications Manager
database on the basis of specific criteria because you can have several UDP templates.

During your work in a browser session, your find/list search preferences are stored in the cookies on the client
machine. If you navigate to other menu items and return to this menu item, or if you close the browser and
then reopen a new browser window, your Cisco Unified Communications Manager search preferences are
retained until you modify your search.

Note

Procedure

Step 1 Choose Bulk Administration > User Device Profiles > User Device Profile Template.

The Find and List UDP Templates window displays. Use the two drop-down list boxes to search for a
template.

Step 2 From the first Find UDP Templates where drop-down list box, choose one of the following criteria:

• Profile Name
• Profile Description
• Device Type

From the second Find UDP Templates where drop-down list box, choose one of the following criteria:

• begins with
• contains
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• is exactly
• ends with
• is empty
• is not empty

Step 3 Specify the appropriate search text, if applicable, and click Find.

To find all UDP templates that are registered in the database, click Find without entering any
search text.

Tip

A list of discovered templates displays by:

• Name
• Description
• Device Type
• Profile Type

Step 4 From the list of records, click the template name that matches your search criteria.
The UDP Template Configuration window displays.

Create Bulk Administration Tool (BAT) Template for User Device
Profiles

You can create a template to add user device profiles in bulk.

Procedure

Step 1 Choose Bulk Administration > User Device Profiles > User Device Profile Template.
Step 2 Click Add New.
Step 3 From the Device Type drop-down list, choose the model of user device profile. Click Next.
Step 4 Enter data for an individual user device profile template on each line in the spreadsheet. Complete all mandatory

fields and any relevant optional fields.
Each column heading specifies the length of the field and whether it is required or optional. See Table 22:
Field Descriptions for User Device Profile Template in the BAT Spreadsheet, on page 307 for field descriptions.

Depending on the model of device, some of the fields may not display.Note

You can obtain help in finding a valid login user ID by choosing the Select Login User ID link
below the Login User ID field. A separate dialog box pops up. In the Login User ID field, enter
the first few characters of the login user ID that you want to use, and all login user IDs that match
the pattern that you entered will display in the Selected login user ID field. Choose the desired
ID and click OK.

Tip

Step 5 Check the Ignore Presentation Indicators (Internal Calls Only) check box, as needed.
Step 6 Check the Do Not Disturb check box if you need the DND feature to be enabled.
Step 7 Choose the DND option from the DND Option drop down list.
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Step 8 Choose the DND incoming call alert option from the DND Incoming Call Alert drop down list.

• None—Choose this option to have no alert for incoming calls.

• Disable—Choose this option if you want to disable incoming call alerts while in the DND mode.

• Flash Only—Choose this option to have the device flash while in DND mode.

• Beep Only—Choose this option to have the device beep while in the DND mode.

Step 9 Choose the Extension Mobility Cross Cluster CSS from the Extension Mobility Cross Cluster CSS
drop-down list.

Step 10 Choose the Feature Control Policy from the Feature Control Policy drop-down list.

This field displays for RoundTable phones only.Note

Step 11 Click Save.
Step 12 Depending on the phone button template that you chose, links display to add lines, speed dials settings,

subscribed Cisco IP Phone service settings, and busy lamp field speed dial settings.

For some Cisco Unified IP Phone models, you can add Cisco Unified IP Phone services and Speed Dials to
the template.

Related Topics
Phone Template, on page 25

User Device Profile Template Fields Descriptions in BAT
Spreadsheet

The following table describes all the user device profile template fields in the BAT spreadsheet.

Depending on the model of device, some of the fields may not be available.Note

Table 22: Field Descriptions for User Device Profile Template in the BAT Spreadsheet

DescriptionField

Enter a unique identifier for the device profile name up to 50
characters.

User Device Profile Template Name

Enter a description for the UDP template. The description can include
up to 50 characters in any language, but it cannot include
double-quotes ("), percentage sign (%), ampersand (&), back-slash
(\), or angle brackets (<>).

Description
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Enter the user hold audio source that this group of IP phones or CTI
ports should use.

The user hold audio source identifies the audio source from which
music is played when a user places a call on hold.

User Hold Audio Source

Enter the country and language set that you want to associate with
this group of IP phones.

This choice determines which cultural-dependent attributes exist for
this user and which language displays for the user in the Cisco Unified
Communications Manager user windows and phones.

User Locale

Choose a phone button template for this profile.Phone Button Template

Enter the softkey template to be used for all phones in this group.Softkey Template

Choose the appropriate privacy option for the profile. For each Device
that wants Privacy, choose On in the Privacy drop-down list box.

Privacy

Choose the appropriate option for the single button barge feature.

• Off—This setting disables the Single Button Barge/cBarge
feature; however, the regular Barge or cBarge features will still
work.

• Barge—This setting enables the Singe Button Barge feature.

• cBarge—This setting enables the Single Button cBarge feature.

• Default—This setting uses the Single Button Barge/cBarge setting
that is in the service parameter.

Single Button Barge

Choose the appropriate option to join across lines.

• Off— This setting disables the Join Across Lines feature.
• On—This setting enables the Join Across Lines feature.
• Default—Uses the Join Across Lines setting that is in the service
parameter.

Join Across Lines

Enter the Always Use Prime Line setting that you want to use from
the following values:

• On

• Off

• Default

Always Use Prime Line
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Enter the Always Use Prime Line for Voice Message setting that you
want to use from the following values:

• On

• Off

• Default

Always Use Prime Line for Voice
Message

To specify whether the device can play precedence tones when a
MLPP precedence call is placed, choose one of the following values:

• Default—To inherit the MLPP indication from the device pool.
• Off—Does not send MLPP indication tones.
• On—Sends indication of an MLPP precedence call.

MLPP Indication

To specify whether the device can preempt calls in progress when
placing an MLPP precedence call, choose one of the following:

• Default—To inherit theMLPP preemption setting from the device
pool.

• Disable—Does not preempt calls when it places an MLPP
precedence call.

• Foreceful—preempts calls in progress when it places an MLPP
precedence call.

Do not configure a device with MLPP Indication
set to Off while MLPP Preemption is set to
Foreceful.

Note

MLPP Preemption

Enter a hexadecimal value for the MLPP domain associated with this
device. Must be blank or a value between 0 and FFFFFF.

MLPP Domain

Choose the type of expansion module if installed in the phone or
choose <None> for Module 1 and Module 2.

Expansion Module Information

Enter the login user ID for a default profile. After the user logs out
from using the user device profile, the user device profile will
automatically log in to this login user ID and use the default profile.

You can obtain help in finding a valid login user ID by
choosing the Select Login User ID link below the Login
User ID field. A separate dialog box pops up. In the
Login User ID field, enter the first few characters of the
login user ID that you want to use, and all login user IDs
that match the pattern that you entered will display in
the Selected login user ID field. Choose the desired ID
and click OK.

Note

Login User ID
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Modify User Device Profile BAT Template
You can modify the properties of an existing BAT template when you want to change only a few fields for
the same device.

Procedure

Step 1 Find the UDP template you want to modify.
Step 2 From the list of displayed templates, click the template name you want to modify.

The chosen template details display in the UDP Template Configuration window.
Step 3 Verify that this is the template that you want to modify.
Step 4 Modify the details in the template fields as needed.
Step 5 Click Save to save the changes to the existing template.

Related Topics
Find User Device Profile Template, on page 305

Copy User Device Profile Template
You can copy the properties of a template into a new template when you want to change only a few fields.

The new template that you create must be the same device type as the original template, such as CiscoIPUser
Device Profile model 7960.

Note

Use the following procedure to copy an existing BAT template.

Procedure

Step 1 Find the UDP template you want to copy.
Step 2 From the list of displayed templates, click the template name you want to copy.

The chosen template details display in the UDP Template Configuration window.

You can also copy the template by clicking the icon in the Copy column corresponding to the
template you want to copy.

Note

Step 3 Verify that this is the template that you want to copy and click Copy.
The template reproduces and creates a copy. The copy duplicates all the values that were specified in the
original template.

Step 4 In theUser Device Profile Template Name field, enter a new template name, up to 50 alphanumeric characters.
Step 5 Update the fields as needed for the new template.

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
310

User Device Profiles
Modify User Device Profile BAT Template



Step 6 Click Save. The template that is added to BAT displays in the Templates column on the left.

Related Topics
Find User Device Profile Template, on page 305

Delete User Device Profile Template
You can delete BAT user device profile templates when you no longer require them.

Procedure

Step 1 Find the UDP template you want to delete.
Step 2 From the list of displayed templates, click the template name you want to delete.

The chosen template details display in the UDP Template Configuration window.

You can also delete the template by checking the check box next to the template name and clicking
Delete Selected.

Note

Step 3 Verify that this is the template that you want to delete and click Delete. A message displays that asks you to
confirm the delete operation.

Step 4 Click OK to delete the template.
The template name disappears from the list of templates in the Find and List UDP Templates window.

Related Topics
Find User Device Profile Template, on page 305
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C H A P T E R 38
User Device Profile File Format

This chapter provides information about configuring user device profile file formats for CSV data files that
you create using a text editor.

• User Device Profile File Format Setup, on page 313

User Device Profile File Format Setup
You can copy, modify, and delete user device profile file formats for CSV data files that you create using a
text editor.

When you use a text editor to create your CSV data file, you must use a file format to identify the device and
line fields within the CSV data file. You have these options for the file format:

• Default User Device Profile—Contains a predetermined set of user device profile device and line fields.

• Simple User Device Profile—Contains basic device and line fields for user device profiles.

• Customized—Contains device and line fields that you choose and order yourself.

Before creating the CSV file in the text editor, you need to choose an existing file format or create a new file
format. You can then enter the values as specified in the file format in the text-based CSV data file.

Find UDP File Format
Use BAT to locate a user device profile file format.

Procedure

Step 1 Choose Bulk Administration > User Device Profiles > UDP File Format > Create UDP File Format.
The Find and List UDP File Formats window displays.

Step 2 From the Find UDP File Format where Format Name drop-down list box, choose one of the following
criteria:

• begins with
• contains
• is exactly
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• ends with
• is empty
• is not empty

Step 3 Specify the appropriate search text, if applicable, and click Find.

To find all UDP templates that are registered in the database, click Find without entering any
search text.

Tip

A list of discovered templates displays by name of the file format.
Step 4 From the list of records, click the file format name that matches your search criteria.

The UDP File Format Configuration window displays.

Create UDP File Format
You can create a UDP file format for the text-based CSV data file.

Procedure

Step 1 Choose Bulk Administration > User Device Profiles > Create UDP File Format.
The Create UDP File Format Configuration window displays.

Step 2 Click Add new.
The Create UDP File Format Configuration window displays.

Step 3 In the UDP File Format Name field, enter a name for this customized format.
Step 4 Under Device Fields, choose the device field names that you want to define for each user device profile.

Click a device field name in theDevice Field box and click the arrow to move the field to the Selected Device
Fields Order box.

A CSV data file must include Device Profile Name, and Description; therefore, these fields
always remain selected.

Note

You can select several random field names in the list by holding down theCtrl key, then clicking
the arrow to select them together. You can select a range of items by using the Shift key.

Tip

Step 5 Click line field names in theLine Field box and click the arrow to move the fields to the Selected Line Fields
Order box.

Directory Number is a mandatory field if you select line fields in the file format.Note

You can change the order of the items in the Selected Line Fields and Selected Device Fields
boxes. Select an item and then use the up arrow to move the field closer to the beginning of the
list or use the down arrow to move it to the end of the list.

Tip

Step 6 Click Intercom DN field names in the Intercom DN Field box and click the arrow to move the fields to the
Selected Intercom DN Fields Order box.

Step 7 Enter the maximum number of lines, speed dials, IP Phone Services, and IP Phone Service Parameters, you
want to include in the CSV file, in their corresponding text boxes.
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You can enter zero for maximum number of speed dials, IP Phone Services, and IP Phone Service
Parameters, if you do not want to include them in the CSV file. But, the maximum number of
lines should not be zero if line fields are chosen in the file format.

Note

Step 8 To save your customized file format, click Save.
The name of the file format displays in the UDP File Format Query window.

Copy UDP File Format
You can copy an existing user device profile file format for the CSV data file.

Procedure

Step 1 Find the UDP File Format you want to copy.
Step 2 In the Search Results area, click the file format name that you want to copy.

The File Format Configuration window displays.
Step 3 To make a copy of the chosen file format, click Copy.

You can also copy a file format by clicking the icon in the Copy column corresponding to the
format you want to copy, in the UDP File Format Query window.

Note

Step 4 In the File Format Name field, enter a new name for the copied format.
Step 5 Modify the copied format by using one of these methods:

a) Add new fields by choosing them from the Device Fields, Line Fields or Intercom DN Fields box, and
then clicking the arrow to move the chosen fields into the Selected Device Fields Order, Selected Line
Fields Order, or Selected Intercom DN Order box.

b) Remove chosen fields by choosing them from the Selected Device Fields Order, Selected Line Fields
Order, or Selected Intercom DN Fields Order box, and then clicking the arrow to move the chosen fields
into the Device Fields, Line Fields, or Intercom DN Fields box.

c) Change the order of the fields by choosing a field name in the Selected Device Field Order, Selected Line
Fields Order, or Selected Intercom DN Field Order box and using the up or down arrow to change its
location.

Step 6 After making your changes, click Save to save the copied file format with changes in the list.

Related Topics
Find UDP File Format, on page 313

Modify UDP File Format
You can modify an existing user device profile file format for the CSV data file.

Procedure

Step 1 Find the UDP File Format you want to update.
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Step 2 In the Search result area, click the file format name that you want to modify. The File Format Configuration
window displays.

Step 3 Modify the copied format by using one of these methods:
a) Add new fields by choosing them from the Device Fields, Line Fields, or Intercom DN Fields box, and

then clicking the arrow to move the chosen fields into the Selected Device Field Order, Selected Line
Fields Order, or Selected Intercom Fields Order box.

b) Remove the chosen fields by choosing them from the Selected Device Fields Order, Selected Line Fields
Order, or Selected Intercom Fields Order box, and then clicking the arrow to move the chosen fields into
the Device Field or Line Fields box.

c) Change the order of the fields by choosing a field name in the Selected Device Field or Selected Line
Fields box and using the up or down arrow to change its location.

Step 4 After making your changes, click Save to save the changes to the file format.
.

Related Topics
Find UDP File Format, on page 313

Delete UDP File Format
You can delete an existing user device profile file format for the CSV data file.

Procedure

Step 1 Find the UDP File Format you want to delete.
Step 2 In the Search result area, click the file format name that you want to delete.

The File Format Configuration window displays. Verify that you want to delete this file.
Step 3 To remove the file format from the File Format Name list, click Delete. A message asks you to confirm that

you want to delete the file format. Click OK to continue.

The file format name is removed from the list.

You can also delete a file format by checking the corresponding check box and clicking Delete.
You can delete all the file formats by clicking Select All and then clicking Delete Selected.

Tip

Related Topics
Find UDP File Format, on page 313
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C H A P T E R 39
User Device Profile File Format Addition

This chapter provides information to associate the user device file format with the text-based CSV data file.

After you have entered all the values into the text-based CSV data file in the order that the file format specified,
you need to upload the text-based CSV data file to the first node in Cisco Unified Communications Manager.
You must then associate the file format with the text-based CSV data file.

• Add User Device Profile File Format, on page 317
• Topics Related to UDP File Format Creation, on page 317

Add User Device Profile File Format
Use BAT to associate the file format with the text-based CSV data file.

Procedure

Step 1 Choose Bulk Administration > User Device Profile > UDP File Format > Add File Format.
The Add File Format Configuration window displays.

Step 2 In the File Name field, choose the CSV data file that you created for this bulk transaction.
Step 3 In the File Format Name field, choose the file format that you created for this type of bulk transaction.
Step 4 To add the matching file format with the CSV data file, click Submit.

A job is created in the Job Scheduler option in the Bulk Administration menu. Use Job Configuration
window to modify the job schedule.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599

Topics Related to UDP File Format Creation
• Add User Device Profile File Format, on page 317

• Upload File to Server, on page 21
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• Manage Scheduled Jobs, on page 599

• BAT Log Files, on page 609
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C H A P T E R 40
User Device Profile Validation

This chapter provides information to validate that the records in the user device profile CSV data file has all
required fields, such as device profile name and directory number, and to check for discrepancies with the
records in the first node database.

• Validate User Device Profiles, on page 319
• Topics Related to User Device Profile Validation, on page 320

Validate User Device Profiles
You can use BAT to run a validation script to validate your CSV data file user device profile records. When
you choose Validate User Device Profiles, the system runs a validation routine to check that the CSV data
file has all required fields, such as device profile name and directory number, populated and checks for
discrepancies with the records in the first node database.

Before you begin

• You must have a user device profile template for the devices that you are adding. You can use a user
device profile template with multiple lines to add user device profiles that have a single line.

• You must have a CSV data file that contains the unique details for the user device profiles.

Procedure

Step 1 Choose Bulk Administration > User Device Profiles > Validate User Device Profiles.
The User Device Profiles Validation window displays.

Step 2 Choose the Insert option that corresponds to your CSV data file:

• Validate UDP Specific Details—If you are validating User Device Profile records that use a file format.
• Validate UDP All Details—If you are validating user device profile records from an export file that was
generated by using the All Details option.

Step 3 In the File Name field, choose the CSV data file that you created for this specific bulk transaction.
Step 4 For Validate UDP Specific Details option, in the UDP Template Name field, choose the Cisco Unified

Communications Manager Bulk Administration (BAT) User Device Profile template that you created for this
type of bulk transaction.
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Step 5 To verify the chosen CSV data file with the database, click Submit.
A job is created in the Job Scheduler option in the Bulk Administration menu. Use Job Configuration
window to modify the job schedule.

Related Topics
BAT Log Files, on page 609
Create Bulk Administration Tool (BAT) Template for User Device Profiles, on page 306
Create User Device Profile CSV Data Files Using BAT Spreadsheet, on page 292
Manage Scheduled Jobs, on page 599
Validate User Device Profiles, on page 319

User Device Profile Validation Limitations
The validation of phones has the following limitations:

• The validation process only checks for the number of lines that are configured on the template; it does
not check the line numbers that are configured on the template. After running the Validate UDP - specific
details job, the administrator sees the following message in the log when the CSV date file contains more
lines than are supported by the phone template: “WARNING: CSV contains more number of lines than
are supported by the phone template.” If blank Directory Numbers and/or blank Speed dials and/or blank
Busy Lamp Field Speed Dials exist, this indicates that the warning message that is displayed in the
summary log file may be inaccurate.

• The validate process does not check whether mandatory fields are specified in the CSV file.

• If IP phone service parameters are specified in the phone text file, the validate process only checks
whether a parameter exists with a name that is specified in the CSV on Cisco Unified Communications
Manager. It does not check whether the parameter that is specified is configured on the IP phone service.

Topics Related to User Device Profile Validation
• Create Bulk Administration Tool (BAT) Template for User Device Profiles, on page 306

• User Device Profile Validation Limitations, on page 320

• Create User Device Profile CSV Data Files Using BAT Spreadsheet, on page 292

• Manage Scheduled Jobs, on page 599

• BAT Log Files, on page 609
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C H A P T E R 41
UDP Generation

This chapter provides information to use Cisco Unified CommunicationsManager Bulk Administration (BAT)
to set up extension mobility quickly by generating and inserting profiles for all IP phone users. BAT generates
user device profiles for all phones, regardless of the number of devices that the user controls. For example,
if a user controls two devices, BAT generates two separate user device profiles, one for each device and
associates them to the same user. BAT sets one of the generated user device profiles as the default user device
profile for the user. BAT generates user device profiles for all IP phones based on the phone button template
for each phone model.

You do not use a user device profile template or a CSV data file to perform this action. When BAT generates
these user device profiles, they are associated with the user.

Note

• Insert User Device Profiles for User Devices, on page 321
• Topics Related to User Device Profile Generation, on page 323

Insert User Device Profiles for User Devices
You can generate user device profiles for all users.

When you are inserting a file that was generated with the export utility, the export utility appends a numerical
suffix_n for each line that is configured on a phone. For example, an export file with the name
“sales_7960_1_3.txt” indicates that all phone records in this file have lines 1 and 3 configured. Use the
appended suffixes to guide you in choosing a phone template with the correct line configuration during the
UDP profile insertion.

You can use the dummyMAC address option when adding CTI ports. This option gives a unique device name
to each CTI port in the form of dummy MAC addresses that you can manually update later using the Cisco
Unified Communications Manager Administration or the UnifiedCM Auto-Register phone Tool.

The dummy MAC address option automatically generates dummy MAC addresses in the following format:

XXXXXXXXXXXX

where X represents any 12-character, hexadecimal (0-9 and A-F) number.
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Procedure

Step 1 Choose Bulk Administration > User Device Profiles > Insert User Device Profiles.
The User Device Profiles Insert Configuration window displays.

Step 2 Choose an insert method. Do one of the following:
a) Click Insert User Device Profiles Specific Details radio button to insert UDP records that use a customized

file format. Continue with Step 3, on page 322 and Step 4, on page 322.
b) Click Insert User Device Profiles All Details radio button to insert UDP records from an exported UDP

file that was generated by using the All Details option.

Step 3 In theFile Name drop-down list box, choose the CSV data file that you created for this specific bulk transaction.
Step 4 For the Specific Details option, in the User Device Profiles Template Name drop-down list box, choose the

BAT phone template that you created for this type of bulk transaction.
Step 5 If you did not enter individual MAC addresses in the CSV data file, you must check the Create Dummy

MAC Address check box. Skip to Step 9, on page 322.

If you do not know the MAC address of the phone that will be assigned to the user, choose this option. When
the phone is plugged in, a MAC address registers for that device. If you supplied MAC addresses or device
names in the data input file, do not choose this option.

Step 6 Select the following options if applicable:

• If you are changing the phone settings for existing phones in the template, check the Override the
existing configuration check box. The user device profile information also gets updated when this check
box is checked.

• If you want BAT to generate and insert user device profile records for all phones based on the user's
current IP Phone, choose Based on devices controlled by users radio button.

• If you want the device to use the generated user device profile as the logout profile, check the Set User
Device Profile as Log Out Profile for the device check box.

Step 7 In the Job Information area, enter the Job description.
Step 8 Choose an insert method. Do one of the following:

a) Click Run Immediately to insert the UDP records immediately.
b) Click Run Later to insert the UDP records at a later time.

Step 9 Click Submit to create a job for inserting the phone records.
Use the Job Scheduler option in the Bulk Administration main menu to schedule and activate this job.

If any information for a record fails, BAT does not insert that user device profile record.Note

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
TAPS Overview, on page 583
Topics Related to User Device Profile Generation, on page 323
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Topics Related to User Device Profile Generation
• Insert User Device Profiles for User Devices, on page 321

• Manage Scheduled Jobs, on page 599

• TAPS Overview, on page 583

• BAT Log Files, on page 609
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C H A P T E R 42
User Device Profile Updates

This chapter provides information to update the user device profile (UDP) settings, such as changing or adding
the device pool, or calling search space for a group of similar user device profiles. You can locate the existing
UDP records that you want to update using either a query search or a custom file.

• Update UDPs Using Query, on page 325
• Update UDPs Using Custom File, on page 326
• Choose Update Parameters, on page 327

Update UDPs Using Query
You can create a query to locate UDPs to update.

Procedure

Step 1 Choose Bulk Administration > User Device Profiles > Update UDP > Query.

The Find and List User Device Profiles To Update window displays.

You can update all user device profiles by not specifying a query and clicking Find. Skip to the
Choose Update Parameters, on page 327.

Note

Step 2 From the first Find User Device Profiles where drop-down list, choose one of the following criteria:

• Profile Name

• Profile Description

• Profile Type

• Profile Protocol

Step 3 From the second Find User Device Profiles where drop-down list, choose one of the following criteria:

• begins with

• contains

• is exactly
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• ends with

• is empty

• is not empty

Step 4 Specify the appropriate search text, if applicable.

To find all user device profiles that are registered in the database, click Find without entering
any search text.

Tip

Step 5 To further define your query and to add multiple filters, check the Search Within Results check box, choose
AND or OR from the drop-down list, and repeat Step 2, on page 325 and Step 3, on page 325.

Step 6 Click Find.
The details of all the records that match the criteria display in the Find and List User Device Profiles To
Update window. You can change the number of items that display on each page by choosing a different value
from the Rows per Page drop-down list.

What to do next

To complete the procedure for updating UDPs, proceed to choose the update parameters.

Related Topics
Choose Update Parameters, on page 327

Update UDPs Using Custom File
You can update UDPs using a list of UDPs in a custom file. Use the custom file to search for UDPs in the
database that you want to update.

Before you begin

Before you can update a UDP from , you must perform the following tasks:

• Identify the UDPs that you need to update.

• Create a text file that lists one of these options on a separate line:

• Profile Name

• Description

• Profile Type

• Profile Protocol

• Upload the text file to the server.
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Procedure

Step 1 Choose Bulk Administration > User Device Profiles > Update UDP > Custom File.
The Find and List UDP window displays.

Step 2 From the Update Bulk UDP where drop-down list box, choose the type of custom file that you have created
from the following criteria:

• Profile Name

• Description

• Device Type

• Device Protocol

Step 3 From the list of custom files, choose the filename of the custom file for this update.
Step 4 Click Find.

Do not use the insert or export transaction files that are created with bat.xlt for the update
transaction. Instead, create a custom file with details of the UDP records that need to be updated.
Use only this file for the update transaction. In this custom update file, you do not need a header,
and you can enter values for profile name, description, profile type, or profile protocol.

Note

What to do next

To complete the procedure for updating UDPs, proceed to choose the update parameters.

Related Topics
Choose Update Parameters, on page 327
Upload File to Server, on page 21

Choose Update Parameters
After you define the query or custom file to search for UDPs, use this procedure to choose parameters and
define values for updating UDPs.

Procedure

Step 1 Do one of the following:
a) Click Next in the Find and List User Device Profiles To Update window if you used the Query option

to locate UDPs to update.
b) Click Next in the Find and List UDP window if you used the Custom File option to locate UDPs to

update.
The Update UDP window shows the type of query that you chose. If you want to change the type of query,
click Back.
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Step 2 Specify the setting that you want to update for all the records that you have defined in your query or custom
file. You can choose multiple parameters to update.

Step 3 Update the required UDP parameters. See Table 23: Field Descriptions for Updating UDPs in BAT, on page
328 for field descriptions.

Step 4 Select the update check box to the left of the field that you want to update. This action tells BAT to overwrite
the existing value for the field.

The BAT updates only those fields for which you have selected the update check box.Note

Step 5 In the Job Information area, enter the job description.
Step 6 Choose an activation method. Do one of the following:

a) Click Run Immediately to schedule and activate user device profiles immediately.
b) Click Run Later to schedule and activate user device profiles at a later time.

Step 7 Click Submit to create a job for updating the records.

On theUpdate UDPswindow, certain fields may not display if the search results include devices
of multiple types and protocols. Make sure that you have the UDPs of same type and protocol
for all the fields to appear.

Note

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599

Update UDP Field Descriptions
The following table describes the fields that display when you are updating a UDP.

In the BAT user interface, field names that have an asterisk require an entry. Treat fields that do not have an
asterisk as optional.

Table 23: Field Descriptions for Updating UDPs in BAT

DescriptionField

Enter a description that makes the device easy to recognize. The
description can include up to 50 characters in any language, but it cannot
include double-quotes ("), percentage sign (%), ampersand (&), backslash
(\), or angle brackets (<>).

Description

Choose the audio source for this group of UDPs or ports.

The user hold audio source plays music when the user puts a call on
hold.

User Hold MOH Audio Source

Choose the country and language set that you want to associate with
this user.

This choice determines which culture-dependent attributes exist for this
user and which language displays for the user in the Cisco Unified
Communications Manager user windows and phones.

User Locale
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DescriptionField

Choose an appropriate phone button template for this profile.

The phone button template determines the configuration of buttons on
a phone and identifies which feature (line, speed dial, and so on) is used
for each button.

Phone Button Template

Choose the softkey template to be used for all UDPs in this group.Softkey Template

Choose the appropriate privacy option for the profile from the drop-down
list box:

• Off—Enables privacy for each device.
• On—Disables privacy for each device.
• Default—Applies the default privacy settings to the device.

Privacy

Used with the Presence feature, the SUBSCRIBE Calling Search Space
determines how Cisco Unified Communications Manager routes the
subscription requests that come from the phone. From the drop-down
list box, choose the calling search space that you want to use for this
purpose.

SUBSCRIBECalling Search Space

From the drop-down list box, choose a presence group for this group of
UDPs. The selected group specifies the devices, end users, and
application users that can monitor this directory number.

Presence Group

From the drop-down list box, enable or disable the Single Button
Barge/cBarge feature for this device or choose Default to use the service
parameter setting.

• Off—This setting disables the Single Button Barge/cBarge feature;
however, the regular Barge or cBarge features will still work.

• Barge—This setting enables the Singe Button Barge feature.
• cBarge—This setting enables the Single Button cBarge feature.
• Default—This setting uses the Single Button Barge/cBarge setting
that the service parameter specifies.

Single Button Barge

From the drop-down list box, enable or disable the Join Across Lines
feature for this device or choose Default to use the service parameter
setting.

• Off—This setting disables the Join Across Lines feature.
• On—This setting enables the Join Across Lines feature.
• Default—This setting uses the Join Across Lines setting that the
service parameter specifies.

Join Across Lines

From the drop-down list box, choose the Always Use Prime Line setting
that you want to use from the following values:

• On
• Off
• Default

Always Use Prime Line
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DescriptionField

From the drop-down list box, choose the Always Use Prime Line for
Voice Message setting that you want to use from the following values:

• On
• Off
• Default

Always Use Prime Line for Voice
Message

From the drop-down list box, choose the Feature Control Policy for this
group of UDPs.

A feature control policy specifies the appearance of features and the
associated softkeys that display on the UDP.

Feature Control Policy

Check this check box if the system must ignore presentation indicators.Ignore Presentation Indicators
(internal calls only)

If you want to enable the DND feature, check this check box.Do Not Disturb

From the drop-down list box, choose a DND option from the following
options:

• None
• Ringer Off
• Call Reject
• Use Common Phone Profile Setting

DND Option

From the drop-down list box, choose one of the following options:

• None
• Disable
• Flash Only
• Beep Only

DND Incoming Call Alert

From the drop-down list box, choose the appropriate setting for this
group of UDPs.

The ExtensionMobility Cross Cluster CSS setting gets used as the device
CSS of the remote phone when the user selects this device profile during
EMCC login.

Extension Mobility Cross Cluster
CSS

Multilevel Precedence and Preemption (MLPP) Information

Enter a hexadecimal value for the MLPP domain that is associated with
this device. Ensure that this value specifies blank or a value between 0
and FFFFFF.

MLPP Domain
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DescriptionField

If available, this setting specifies whether a device that is capable of
playing precedence tones will use the capability when it places anMLPP
precedence call.

From the drop-down list box, choose a setting to assign to this device
from the following options:

• Default—This device inherits its MLPP indication setting from its
device pool.

• Off—This device does not send indication of anMLPP precedence
call.

• On—This device does send indication of an MLPP precedence
call.

Do not configure a device with the following combination
of settings: MLPP Indication is set to Off while MLPP
Preemption is set to Forceful.

Note

MLPP Indication

If available, this setting specifies whether a device that is capable of
preempting calls in progress will use the capability when it places an
MLPP precedence call.

From the drop-down list box, choose a setting to assign to this device
from the following options:

• Default—This device inherits its MLPP preemption setting from
its device pool.

• Disabled—This device does not preempt calls in progress when it
places an MLPP precedence call.

• Forceful—This device preempts calls in progress when it places
an MLPP precedence call.

Do not configure a device with the following combination
of settings: MLPP Indication is set to Off while MLPP
Preemption is set to Forceful.

Note

MLPP Preemption

Logged Out (Default) Profile Information

From the drop-down list box, choose the user ID to be logged out before
updating the UDP.

Login User Id

Assign IP Phone Services

From the drop-down list box, choose the template that contains the list
of services with which you want to update the UDPs.

You can click the Edit IP Phone Service link to update the subscribed
Cisco Unified IP Phones services on the template.

Add All Services From This
Template
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DescriptionField

Check this check box to remove duplicate IP phone services. If you
check this check box, the system removes the duplicate service
subscriptions from phones and user device profiles. The IP system deletes
services based on the IP service name.

Remove Duplicate

Job Information

Enter an appropriate job description.Job Description

Click this radio button to schedule and activate the update user device
profiles job immediately.

Run Immediately

Click this radio button to schedule and activate the update user device
profiles job at a later time.

Run Later
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C H A P T E R 43
User Device Profile Deletions

This chapter provides information to delete a group of user device profiles (UDPs) from the Cisco Unified
Communications Manager database. You can locate existing phone records that you want to delete using
either a query search or a custom file.

• Delete UDP Using Query, on page 333
• Delete UDP Using Custom File, on page 334
• Topics Related to UDP Deletions, on page 335

Delete UDP Using Query
To locate the UDP records that you want to delete from the Cisco Unified CommunicationsManager database,
you can define a query filter.

Procedure

Step 1 Choose Bulk Administration > User Device Profiles > Delete UDP > Query.
The Find and List Device Profiles To Delete window displays.

Step 2 From the Find drop-down list box, choose one of the following options:

• User
• Autogenerated
• All

Step 3 From the first Device Profiles where drop-down list box, choose one of the following criteria:

• Profile Name
• Description
• Device Type

Step 4 From the second Device Profiles where drop-down list box, choose one of the following criteria:

• begins with
• contains
• is exactly
• ends with
• is empty
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• is not empty

Step 5 Specify the appropriate search text, if applicable.

To find all UDPs that are registered in the database, click Find without entering any search text.Tip

Step 6 To further define your query and to add multiple filters, check the Search Within Results check box, choose
AND or OR from the drop-down box, and repeat Step 2, on page 333 and Step 5, on page 334.

Step 7 Click Find.

A list of discovered templates displays by:

• Device Profile Name
• Description
• Device Type
• Profile Type

Step 8 In the Job Information area, enter the Job description.
Step 9 Choose a delete method. Do one of the following:

a) Click Run Immediately to delete UDP records immediately.
b) Click Run Later to delete UDP records at a later time.

Step 10 Click Submit to create a job for deleting the phone records.
Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

If you do not enter any information in the query text box, the system deletes all UDP records.
Because the delete action is final, you cannot retrieve deleted records.

Caution

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Topics Related to UDP Deletions, on page 335

Delete UDP Using Custom File
You can create a custom file of UDPs that you want to delete using a text editor. You can have device profile
name, device profile description, and directory number in the same custom file, but you cannot have directory
numbers in the same file. You need to create separate files—one file that contains the device names and MAC
addresses and another file that contains the directory numbers.

You cannot delete UDPs with shared lines by using a custom file.Note

Do not use the insert or export transaction files that are created with bat.xlt for the delete transaction. Instead,
you must create a custom file with details of the UDP records that need to be deleted. Use only this file for
the delete transaction.

Note
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Before you begin

1. Create a text file that lists one of these details for the UDPs that you want to delete:

• Profile names

• Profile description

The custom file does not need a header, and you can enter values for name, description, or directory number.
Put each item on a separate line in the text file.

Note

2. Upload the custom files to the server first node.

Procedure

Step 1 Choose Bulk Administration > User Device Profiles > Delete User Device Profiles > Custom File.
The Delete User Device Profiles Custom Configuration window displays.

Step 2 Click Delete.
Step 3 In the Device Profiles where drop-down list box, choose the type of custom file that you have created from

one of the following criteria:

• Profile Name

• Profile Description

• Directory Number

Step 4 In the list of custom files, choose the filename of the custom file for this delete, then click Find.
A list of UDPs matching your search criteria displays.

Step 5 Click Submit to create a job to delete the UDPs.

Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Topics Related to UDP Deletions, on page 335
Upload File to Server, on page 21

Topics Related to UDP Deletions
• Delete UDP Using Query, on page 333

• Delete UDP Using Custom File, on page 334

• Upload File to Server, on page 21
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• Manage Scheduled Jobs, on page 599

• TAPS Overview, on page 583

• BAT Log Files, on page 609
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C H A P T E R 44
User Device Profile Exports

This chapter provides information to export user device profile records. You can choose between two file
format names when you are exporting user device profile records:

• All User Device Profile Details: To export all the line attributes, services and User IDs that are associated
with the user device profile.

• Specific User Device Profile Details: To export a limited set of details that are associated with the user
device profile

• All User Device Profile Details Format, on page 337
• Specific User Device Profile Format, on page 338
• Export User Device Profile Records, on page 339

All User Device Profile Details Format
For phones that have different line configurations, such as multiple partitions or calling search spaces, use
the All User Device Profile Details format.

The following table lists the fields that are exported when you choose the All User Device Profile Details file
format.

Table 24: Exported Fields in the All User Device Profile Details File Format

Exported FieldsField Types

User Device Profile Name, Description, Device Pool, Calling
Search Space, AAR Calling Search Space, Media Resource
Group List, User Hold Audio Service, Network Hold Audio
Source, Login User ID, User Locale, Network Locale, Phone
Button Template, Expansion Module Type I, Expansion
Module Type II, Softkey Template, Phone Load Name,
Module 1 Load Name, Module 2 Load Name, MLPP
Indication, MLPP Preemption, MLPP Domain

Device Fields

Information, Directory, Messages, Services, Authentication
Server, Proxy Server, Idle, Idle Timer, Enable Extension
Mobility, Logout Profile, Login User ID, Login Time, Logout
Time

Model Specific Device
Fields
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Exported FieldsField Types

Directory Number, Partition, Voice Mail Profile, Line CSS,
AAR Group, Line User Hold Audio Source, Line Network
Hold Audio Source, Auto Answer, Forward All to Voice
Mail, Forward All Destination, Forward All CSS, Forward
Busy External to Voice Mail, Forward Busy External
Destination, Forward Busy External CSS, Forward No
Answer External to Voice Mail, Forward No Answer
External Destination, Forward No Answer External CSS,
Forward On Failure to Voice Mail, Forward On Failure
Destination, Forward on Failure CSS, Call pickup group,
Forward Busy Internal to VoiceMail, Forward Busy Internal
Destination, Forward Busy Internal CSS, Forward No
Answer Internal to VoiceMail, Forward NoAnswer Internal
Destination, Forward No Answer Internal CSS, Forward No
Call Coverage External to Voice Mail, Forward No Call
Coverage External Destination, Forward No Call Coverage
External CSS, Forward No Call Coverage Internal to Voice
Mail, Forward No Call Coverage Internal Destination,
Forward No Call Coverage Internal CSS, Display, External
Phone Number Mask, Message Waiting Lamp Policy, Ring
Setting When Idle, Line Text Label, Ring Setting When
Active, NoAnswer RingDuration,MLPPTarget Destination,
MLPP Calling Search Space, MLPP No Answer Ring
Duration, Max Num Calls, Busy Trigger, Call Info Display
Mask, Alerting Name

Line Fields

User IDUser Fields

Speed Dial Number, Speed Dial LabelSpeed Dials

Service Name, Subscribed Service Name, Parameter Name,
Parameter Value

Services

Specific User Device Profile Format
To export a limited set of details that are associated with the user device profile, use the Default User Device
Profile format. You can choose specific query options to customize the export file.

The following table lists the fields that can be exported when you choose the Default User Device Profile
format.

Table 25: Exported Fields in the Default User Device Profile File Format

Exported FieldsField Types

MAC Address, Description, Login User IDDevice Fields
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Exported FieldsField Types

Directory Number,Display,Line Text Label,Forward Busy
External,Forward Busy Internal,Forward No Answer
External,ForwardNoAnswer Internal,ForwardNoCoverage
External,Forward No Coverage Internal,Call pickup group

Line Fields

Export User Device Profile Records
You can export user device profiles from Cisco Unified Communications Manager

Procedure

Step 1 Choose one of the following options:
a) ChooseBulk Administration >User Device Profiles >Export User Device Profiles > Specific Details.

The Find and List User Device Profiles To Export window displays.
b) Choose Bulk Administration > User Device Profiles > Export User Device Profiles > All Details.

The Export User Device Profiles Configuration window displays.

Step 2 ForAll Details option, choose the type of device or specific model from theDevice Type drop-down list box.
Skip to Step 4, on page 340.

Step 3 For Specific Details option, you can customize the export file and set any of the following detail options:
a) Choose Device Type and Device Protocol from the drop-down list boxes.
b) In the first Find a User Device Profile drop-down list box, choose from the following options:

• Profile Name

• Profile Description

c) In the second drop-down list box, choose from the following options:

• begins with

• contains

• is exactly

• ends with

• is empty

• is not empty

d) In the search field box, enter the value that you want to locate, such as a specific profile name or profile
description.

e) You can click the Search Within Results check box and choose AND or OR to add multiple filters and
repeat 3.b, on page 339 through 3.d, on page 339 to further define your query.

f) Click Find. The search results display.
g) Click Next.
h) Choose file format from the File Format drop-down list box.
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Step 4 In the File Name field, enter the file name that you want to use.
Step 5 In the Job Information area, enter the Job description.
Step 6 Choose an export method. Do one of the following:

a) Click Run Immediately to export user device profiles immediately.
b) Click Run Later to export user device profiles at a later time.

Step 7 Click Submit to create a job for exporting user device profiles.
Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
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C H A P T E R 45
Line Attribute Updates for Devices and User
Device Profiles

This chapter provides information to use a query to update lines for devices and User Device Profiles.

• Device and UDP Line Updates, on page 341
• Update Device and UDP Lines Using Query, on page 341
• Topics Related to User Device Profile Line Updates, on page 343

Device and UDP Line Updates
You can use a query to update lines for devices and User Device Profiles. To update line attributes for a
specific group of devices or user device profiles, use the Update Lines option. Lines for a phone and a user
device profile get updated at the same time when both are part of the query result.

When a phone is deleted from the Cisco Unified Communications Manager database, the directory number
remains in the database. To manage these orphan directory numbers, you can use the Update Lines option to
search for unassigned directory numbers and delete or update these directory numbers.

Tip

Update Device and UDP Lines Using Query
Use a query to update lines in devices and user device profiles.

Procedure

Step 1 Choose Bulk Administration > User Device Profiles > Add/Update Lines > Update Lines.

The Update Lines Query window displays.

You can update all lines by not specifying a query. Skip to 2.Note

Step 2 From the first Find Line where drop-down list box, choose one of the following criteria:

• Directory Number
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• Route Pattern

• Line Description

• Calling Search Space (Phone)

• Calling Search Space (Line)

• Device Pool

• Device Description

• Line Position

• Unassigned DN

• Call Pickup Group

To locate and delete orphaned directory numbers, use “Unassigned DN.”Note

Step 3 From the second Find Line where drop-down list box, choose one of the following criteria:

• begins with

• contains

• is exactly

• ends with

• is empty

• is not empty

Step 4 In the search field list box, choose or enter the value that you want to locate.

For example, you can choose the Line Partition from the list or enter a range of directory numbers.

To find all lines that are registered in the database, click Find without entering any search text.Tip

Step 5 To further define your query and to add multiple filters, check the Search Within Results check box, choose
AND or OR from the drop-down box, and repeat Step 2 and Step 3.

Step 6 To display the records that are going to be affected, click Find.

A list of discovered lines displays by

• Pattern/Directory Number

• Partition

• Description

Step 7 Click Next.
The Update Lines window shows the type of query that you chose at the top.

If you want to change the type of query, click Back.Tip
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Step 8 Specify the setting that you want to update for all the records that you have defined in your query. You can
choose multiple parameters to update. See BAT Template Phone Line Field Descriptions, on page 65 for
field descriptions.

Values that display in some fields display from Cisco Unified Communications Manager. You
must configure these values by using Cisco Unified Communications Manager Administration.

Note

Step 9 In the Job Information area, enter the Job description.
Step 10 Choose an insert method. Do one of the following:

a) Click Run Immediately to insert lines immediately.
b) Click Run Later to insert lines at a later time.

Step 11 Click Submit to create a job for inserting the phone records.
Use the Job Configuration window to schedule and/or activate this job.

If any information for a line record fails, Cisco Unified Communications Manager Bulk
Administration (BAT) does not update that line record.

Note

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Topics Related to User Device Profile Line Updates, on page 343

Topics Related to User Device Profile Line Updates
• Update Device and UDP Lines Using Query, on page 341

• BAT Template Phone Line Field Descriptions, on page 65

• Manage Scheduled Jobs, on page 599

• BAT Log Files, on page 609
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C H A P T E R 46
UDP Line Additions

This chapter provides information to add lines to a group of existing user device profiles. When you use the
BAT template to add new lines, you cannot change phone services or speed dials. Cisco Unified
Communications Manager Bulk Administration (BAT) ignores those fields in the BAT template when you
add lines to existing devices.

• Add Lines to Existing UDPs, on page 345
• Add Lines to Existing UDPs Using BAT Spreadsheet, on page 346
• UDP Line Field Descriptions in BAT Spreadsheet, on page 347
• Topics Related to UDP Line Additions, on page 350

Add Lines to Existing UDPs
You can to add lines to a group of existing user device profiles using a CSV data file. Cisco Unified
Communications Manager Bulk Administration (BAT) ignores changes to phone services and speed dials
when you add lines to existing devices.

Before you begin

• You must have a BAT template for this transaction.

• You must have a CSV data file for this transaction.

Procedure

Step 1 Choose Bulk Administration > User Device Profiles > Add/Update Lines > Add Lines.
The UDP Add Lines Configuration window displays.

Step 2 In the File Name field, choose the CSV data file that you created for this bulk transaction.
Step 3 If you are changing the phone settings for existing phones in the template, check the Update the existing

phone button template check box. The user device profile information also gets updated when this check
box is checked.

Step 4 In the Template Name field, choose the User Device Profile template to use for this bulk transaction.
Step 5 In the Job Information area, enter the Job description.
Step 6 Choose an insert method. Do one of the following:

a) Click Run Immediately to insert the phone records immediately.
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b) Click Run Later to insert the phone records at a later time.

Step 7 Click Submit to create a job for inserting the phone records.
Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
Add or Update Phone Lines in BAT Template, on page 28
BAT Log Files, on page 609
Create User Device Profile CSV Data Files Using BAT Spreadsheet, on page 292
Manage Scheduled Jobs, on page 599
Topics Related to UDP Line Additions, on page 350

Add Lines to Existing UDPs Using BAT Spreadsheet
• You must have a BAT template for this transaction.

• You must have a CSV data file for this transaction.

Use the BAT spreadsheet to create the CSV data file for adding lines to existing UDPs. Cisco Unified
Communications Manager Bulk Administration (BAT) ignores changes to phone services and speed dial
fields in the template when you add lines to existing devices.

After you have finished editing the fields in the BAT spreadsheet, you can export the content to a CSV
formatted data file. A default filename is assigned to the exported CSV formatted data file:

<tabname>-<timestamp>.txt

where <tabname> represents the type of input file that you created, such as UDPs, and <timestamp> represents
the precise date and time that the file was created.

If you enter a comma in one of the fields, BAT.xlt encloses that field entry in double quotes when you export
to BAT format.

If you enter a blank row in the spreadsheet, the system treats the empty row as the end of the file. The system
does not convert data that is entered after a blank line to the BAT format.

Note

Procedure

Step 1 To open the BAT Spreadsheet, locate and double-click the BAT.xlt file.
Step 2 When prompted, click Enable Macros to use the spreadsheet capabilities.
Step 3 To display the fields, click the Add Lines tab at the bottom of the spreadsheet.
Step 4 Select the appropriate radio button from the following options:

• Phones

• UDP

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
346

User Device Profiles
Add Lines to Existing UDPs Using BAT Spreadsheet



Step 5 Enter data for an individual device profile on each line in the spreadsheet.
Complete all mandatory fields and any relevant optional fields. Each column heading specifies the length of
the field and whether it is required or optional. See Table 26: Field Descriptions for Adding Lines to UDPs
Using the BAT Spreadsheet, on page 347 for field descriptions.

Step 6 To transfer the data from the BAT Excel spreadsheet into a CSV formatted data file, click Export to BAT
Format.

For information on how to read the exported CSV data file, click the link to View Sample File
in the Insert Phones window in BAT.

Tip

The system saves the file using the default name <tabname>-<timestamp>.txt to C:\XLSDataFiles\ or
you can use Browse to save your file in another existing folder on your local workstation.

What to do next

Upload the CSV file to Cisco Unified Communications Manager Server first node.

Related Topics
Add or Update Phone Lines in BAT Template, on page 28
BAT Log Files, on page 609
BAT Spreadsheet Data Collection for CSV Data File Creation, on page 12
Create User Device Profile CSV Data Files Using BAT Spreadsheet, on page 292
Manage Scheduled Jobs, on page 599
Topics Related to UDP Line Additions, on page 350
Upload File to Server, on page 21

UDP Line Field Descriptions in BAT Spreadsheet
The following table provides the field descriptions when you add lines to UDPs using the BAT spreadsheet.

Table 26: Field Descriptions for Adding Lines to UDPs Using the BAT Spreadsheet

DescriptionField

Enter the MAC address for phones, VGC virtual phones, and VGC phones. Enter a
unique identifier for CTI ports and H.323 clients. Enter the device name for UDPs

MAC Address/Device
Name

Enter a number between 1 and 34 for the line index of a phone.Line Index

Enter a directory number, up to 24 numerals and special characters, for this line.Directory Number

Enter the text that you want to display on the called party's phone display, such as
the user name (John Smith) or phone location (Conference Room 1).

If this filed is left blank the system uses the value that is entered in the
Directory Number field.

Note

The default language specifies English.Note

Display
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DescriptionField

Enter text that identifies this directory number for a line/phone combination.

The default language specifies EnglishNote

Line Text Label

Enter the directory number or directory URI to which a call that is coming from an
external number is forwarded when the line is in use.

This setting applies to any dialable phone number, including an outside
destination unless restricted, and to all devices that are using this
directory number.

Note

ForwardBusyExternal

Enter the directory number or directory URI to which a call that is coming from an
external number is forwarded when the phone is not answered.

This setting applies to any dialable phone number, including an outside
destination unless restricted, and to all devices that are using this
directory number.

Note

Forward No Answer
External

Enter the directory number or directory URI to which a call that is coming from an
external number is forwarded when the phone does not have coverage.

This setting applies to any dialable phone number, including an outside
destination unless restricted, and to all devices that are using this
directory number.

Note

Forward No Coverage
External

Enter the directory number or directory URI to which a call that is coming from an
internal number is forwarded when the line is in use.

This setting applies to any dialable phone number, including an outside
destination unless restricted, and to all devices that are using this
directory number.

Note

Forward Busy Internal

Enter the directory number or directory URI to which a call that is coming from an
internal number is forwarded when the phone is not answered.

This setting applies to any dialable phone number, including an outside
destination unless restricted, and to all devices that are using this
directory number.

Note

Forward No Answer
Internal

Enter the directory number or directory URI to which a call that is coming from an
internal number is forwarded when the phone does not have coverage.

This setting applies to any dialable phone number, including an outside
destination unless restricted, and to all devices that are using this
directory number.

Note

Forward No Coverage
Internal
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DescriptionField

Enter one of the following Party Entrance Tone options:

• Default—Use the value that you configured in the Party Entrance Tone service
parameter.

• On—A tone plays on the phone when a basic call changes to a multi-party call;
that is, a barge call, cBarge call, ad hoc conference, meet-me conference, or a
joined call. In addition, a different tone plays when a party leaves the multi-party
call. If the controlling device, that is, the originator of the multi-party call has
a built-in bridge, the tone gets played to all parties if you choose On for the
controlling device. When the controlling device, for example, the conference
controller, is no longer present on the call or if the controlling device cannot
play the tone, Cisco Unified Communications Manager does not play the tone
even if you choose On.

• Off—A tone does not play on the phone when a basic call changes to a
multi-party call.

Party Entrance Tone

When the parkee is an external party, then the call will be forwarded to the specified
destination in the parker's ParkMonitoring Forward NoRetrieve Destination External
parameter. If the Forward No Retrieve Destination External field value is empty,
the parkee will be redirected to the parker's line.

Park Monitor Forward
No Retrieve Ext
Destination

When the parkee is an internal party, then the call will be forwarded to the specified
destination in the parker's ParkMonitoring Forward No Retrieve Destination Internal
parameter. If the Forward No Retrieve Destination Internal is empty, the parkee will
be redirected to the parker's line.

Park Monitor Forward
No Retrieve Int
Destination

This setting uses settings in the Voice Mail Profile Configuration window.

When this setting is used, Cisco Unified Communications Manager ignores the
settings in the Destination box and Calling Search Space.

Park Monitor Forward
No Retrieve Int Voice
Mail

This setting uses the settings in the Voice Mail Profile Configuration window.

When this setting is used, Cisco Unified Communications Manager ignores the
settings in the Destination box and Calling Search Space.

Park Monitor Forward
No Retrieve Ext Voice
Mail

Choose the calling search space to apply to the directory number.Park Monitor Forward
No Retrieve Ext CSS

Choose the calling search space to apply to the directory number.Park Monitor Forward
No Retrieve Int CSS

This parameter determines the number of seconds that CiscoUnified Communications
Manager waits before prompting the user to retrieve a call that the user parked. This
timer starts when the user presses the Park softkey on the phone, and a reminder is
issued when the timer expires.

Default: 60 seconds

If you configure a non-zero value, this value overrides the value of this parameter
set in the Service Parameters window. However, if you configure a value of 0 here,
then the value in the Service Parameters window will be used.

Park Monitor
Reversion Timer
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DescriptionField

This field allows you to turn this feature on or off. Enter 'T' to enable Cisco Unified
Communications Manager to log missed calls in the call history for that directory
number on the phone. Enter 'F' to disable this feature.

Log Missed Calls

Enter a Pickup Group Name to specify the call pickup group, which can answer
incoming calls to this line by dialing the appropriate pickup group number.

Call Pickup Group

Enter a directory URI to associate with the directory number for this phone. Follow
the username@host format. Enter a username of up to 47 alphanumeric characters.
For the host address, enter an IPv4 address or fully qualified domain name.

Within Cisco Unified CMAdministration, you can enter directory URIs
with embedded double quotes or commas. However, when you use
Bulk Administration to import a csv file that contains directory URIs
with embedded double quotes and commas, you must use enclose the
entire directory URI in double quotes and escape the embedded double
quotes with a double quote. For example, the Jared,
"Jerry",Smith@test.com directory URI must be input as
"Jared,""Jerry"",Smith@test.com" in the csv file.

Note

URI (1-5) onDirectory
Number

Enter the partition on which the directory URI belongs. If you do not want to restrict
access to the directory URI, leave the field blank.

URI (1-5) Route
Partition on Directory
Number

Enter a 't' (True) to indicate that this directory URI is the primary directory URI for
this extension. Otherwise, enter an 'f' (False) to indicate that this is not the primary
directory URI for this extension.

You can associate up to five directory URIs to a single directory
number, but you must select one primary directory URI

Note

URI (1-5) Is Primary
on Directory Number

Topics Related to UDP Line Additions
• Add Lines to Existing UDPs, on page 345

• Add Lines to Existing UDPs Using BAT Spreadsheet, on page 346

• UDP Line Field Descriptions in BAT Spreadsheet, on page 347

• Add or Update Phone Lines in BAT Template, on page 28
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C H A P T E R 47
UDP Report Generation

This chapter provides information to create and save user device profile reports. You can save these reports
with a filename and store them in a folder on the first node server to review and print.

• BAT Report Generation, on page 351
• Generate User Device Profile Reports, on page 351
• Topics Related to UDP Report Generation, on page 353

BAT Report Generation
Cisco Unified Communications Manager Bulk Administration (BAT) provides reports to help you manage
records effectively. You can create and save reports that provide information about phones, users, user device
profiles, managers and assistants, and gateway records.

You can customize BAT reports for phones and for user device profiles to meet your particular needs by
choosing items from a list of device fields and line fields. You can also choose how to arrange the fields in
the report. The system generates the report in the CSV file format. You can save these reports with a filename
and store them in a folder on the first node server to review and print.

You cannot customize reports for users, managers, assistants, and gateways because they have a fixed format.Note

Example

You need to have a list of all the directory numbers with their forwarding destinations by phone model. You
can generate a Phone Report for the Cisco Unified IP Phone model 7960 and choose these query details:
Device Name, Directory Number, Forward Busy Destination, Forward No Answer Destination, and Label.
You can arrange the report fields, so the Label field follows the Directory Number field and precedes the two
forward destination numbers.

Generate User Device Profile Reports
Use BAT to generate reports for User Device Profiles (UDP). The format of the reports for UDPs cannot be
customized.
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Procedure

Step 1 Choose Bulk Administration > User Device Profiles > Generate UDP Reports.
Step 2 From the Find drop-down list, choose one of the following options:

• User

• Autogenerated

• All

Step 3 From the first Device Profiles where drop-down list, choose one of the following criteria:

• Profile Name

• Description

• Device Type

Step 4 From the second Device Profiles where drop-down list, choose one of the following criteria:

• begins with

• contains

• is exactly

• ends with

• is empty

• is not empty

Step 5 Specify the appropriate search text, if applicable, and click Find.

To find all UDPs that are registered in the database, click Find without entering any search text.Tip

A list of discovered templates displays by:

• Name

• Description

• Device Type

• Profile Type

To further define your query and to add multiple filters, check the Search Within Results check
box, choose AND or OR from the drop-down, and repeat Step 2, on page 352 and Step 5, on page
352.

Note

Step 6 Click Next to choose details for your type of report.

The Device Profile Report Configuration window displays and shows the Query that you chose.

If you want to change the type of query, click Back.Tip

Step 7 In the Report File Name field, enter your name for this report (required).
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Step 8 In the Available Device Fields drop-down list, choose a device item and click the arrow to move the item
into the Selected Device Fields for this Report list. You can choose one or more fields to include in your
report.

For a list of device and live fields, see the Phone and IP Telephony Device Reports, on page 177.

You can rearrange the order of the items in the Selected Fields for this report list by choosing
an item and clicking the Up arrow or Down arrow to move the item to another position in the
list.

Tip

Step 9 In the Available Line Fields drop-down list, choose a line item and click the arrow to move the item into the
Selected Fields for this Report list. You can choose one or more fields to include in your report.

You can rearrange the order of the items in the Selected Fields for this report list by choosing
an item and clicking the Up arrow or Down arrow to move the item to another position in the
list.

Tip

You must specify at least one device or line field to generate a report.Note

Step 10 In the Additional IP Services Fields area, check the check boxes for Speed Dial Services and/or IP phone
Services, as needed.

Step 11 In the Job Information area, enter the Job description.
Step 12 Choose a method to generate reports. Do one of the following:

a) Click Run Immediately to generate reports immediately.
b) Click Run Later to generate reports at a later time.

Step 13 Click Submit to create a job for generate report for UDPs.
Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

What to do next

You can search and download the report file using the Upload/Download Files option in the Bulk
Administration menu.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Topics Related to UDP Report Generation, on page 353
Upload and Download Files, on page 19

Topics Related to UDP Report Generation
• Generate User Device Profile Reports, on page 351

• Phone and IP Telephony Device Reports, on page 177

• Manage Scheduled Jobs, on page 599

• BAT Log Files, on page 609
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C H A P T E R 48
Intercom DN Additions and Updates for UDPs

This chapter provides information to use the Add/Update Intercom utility to add or update intercoms in bulk
for user device profiles in Cisco Unified Communications Manager server.

The Intercom feature allows one user to call another user, and that call automatically gets answered with
one-way media from caller to called party, regardless of whether the called party is busy or idle.

• Update Intercom DNs for User Device Profiles, on page 355
• Add Intercom DNs to User Device Profiles, on page 356
• Update Intercom DN Field Descriptions for UDPs, on page 357

Update Intercom DNs for User Device Profiles
Use BAT to update Intercom DNs for user device profiles.

Procedure

Step 1 ChooseBulk Administration >User Device Profiles >Add/Update Intercom >Update Intercom Directory
Numbers.
The Update Intercom Directory Number window displays

Step 2 From the first Find and List Intercom Directory Numbers To Update where drop-down list box, choose
one of the following criteria:

• Intercom Directory Number
• Route Partition
• Description

Step 3 From the second Find and List Intercom Directory Numbers To Update where drop-down list box, choose
one of the following criteria:

• begins with
• contains
• ends with
• is exactly
• is empty
• is not empty
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Step 4 Specify the appropriate search text in the text field, if applicable, and click Find.

To find all Intercom DNs that are registered in the database, click Find without entering any
search text.

Tip

To further define your query, you can choose AND or OR to add multiple filters and repeat Step 2 and Step 3.

A list of discovered Intercom DNs displays by

• Intercom DN Pattern
• Route Partition
• Description

Step 5 Click Next. The next Update Intercom Directory Number window displays.
Step 6 Specify the settings that you want to update for all the records that you have defined in your query. You can

choose multiple parameters to update. See Update IntercomDN Field Descriptions for UDPs, on page 357 for
descriptions of the parameters.

Add Intercom DNs to User Device Profiles
You can use a CSV data file to add Intercom DNs to user device profiles in a Cisco Unified Communications
Manager server.

Before you begin

• You must have a data file in comma separated value (CSV) format that contains the unique details for
the UDPs or other IP telephony devices.

• Upload the data files by choosing the relevant target and function for the transaction.

Procedure

Step 1 Choose Bulk Administration > User Device Profiles > Add/Update Intercom > Add Intercom Directory
Numbers.
The Bulk UDP Intercom DN Insert window displays.

Step 2 In theFile Name drop-down list box, choose the CSV data file that you created for this specific bulk transaction.
Step 3 In the User Device Profile Template Name drop-down list box, choose the BAT UDP template that you

created for this type of bulk transaction.
Step 4 Check the Override Configuration Settings check box to update the existing UDP template settings with

the information that is contained in the file that you want to insert.
Consider overriding the configuration settings as optional.

Step 5 In the Job Information area, enter the Job description.

The default job description for this transaction specifies Insert Intercom DNs.

Step 6 Choose when to add Intercom DNs. Do one of the following:
a) Click Run Immediately to add Intercom DNs immediately.
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b) Click Run Later to add Intercom DNs at a later time.

Step 7 To create a job for adding Intercom DNs, click Submit.
Use the Job Configuration window to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599

Update Intercom DN Field Descriptions for UDPs
The following table provides the field descriptions for updating line details in user device profiles.

Table 27: Field Description for Updating Intercom DN Details in UDPs

DescriptionField

Intercom Directory Number Information

Choose a route partition to which the directory number belongs.

The directory number can appear in more than one
partition.

Note

Route Partition

Enter a description that makes the device easy to recognize.Description

This name represents the name that displays during an alert to a shared
directory number. For non-shared directory numbers, during alerts, the
system uses the name that is entered in the Display field.

Alerting Name

This field provides the same information as the Alerting Name field,
but you must limit input to ASCII characters. Devices that do not
support Unicode (internationalized) characters display the content of
the Alerting Name ASCII field.

ASCII Alerting Name

Intercom Directory Number Settings

Choose the calling search space to which this group of UDPs/ports
should belong.

A calling search space specifies the collection of route partitions that
are searched to determine how a dialed number should be routed.

Calling Search Space

Used with the Presence feature, the SIP or SCCP device serves as a
watcher because it requests status about the presence entity, for
example, directory number, that is configured as a BLF speed dial
button on the device.

If you want the device to receive the status of the presence entity,
choose a Presence Group that is allowed to view the status of the
Presence Group that is applied to the directory number, as indicated
in the Presence Group Configuration window.

Presence Group
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P A R T VIII
Gateways

• Gateway Templates, on page 361
• Gateway File Format, on page 419
• Gateway Insertions, on page 425
• Cisco Gateway Deletions, on page 447
• Cisco Gateway Report Generation, on page 451





C H A P T E R 49
Gateway Templates

This chapter provides information to add and update existing Cisco gateways and ports in the Cisco Unified
Communications Manager database using Cisco Unified Communications Manager Bulk Administration
(BAT).

• Cisco Gateway Additions, on page 361
• Find Gateway Template, on page 367
• Add or Edit Gateway Template, on page 368
• Gateway Configuration Settings, on page 381
• Port Configuration Settings, on page 413
• Topics Related to Gateway Configuration Settings, on page 417

Cisco Gateway Additions
You can use BAT to add Cisco gateways to the Cisco Unified Communications Manager database in bulk.

Related Topics
Add Cisco VG200 Gateways Using BAT, on page 361
Add Cisco Catalyst 6000 (FXS) Gateways and Ports Using BAT, on page 362
Add Cisco VG224 Gateways Using BAT, on page 363
Add Cisco VG202 and Cisco VG204 Gateway Using BAT, on page 363
Topics Related to Gateway Configuration Settings, on page 417

Add Cisco VG200 Gateways Using BAT
When using BAT to add the Cisco VG200 gateways to the Cisco Unified CommunicationsManager database,
you can configure the following types of trunks or ports:

• Foreign Exchange Station (FXS) ports for analog devices

• Foreign Exchange Office (FXO) for loopstart or groundstart trunks

• T1 Primary Rate Interface (PRI) trunks for ISDN services in North America—Currently available only
for Cisco VG200 gateways

• E1 Primary Rate Interface (PRI) trunks for ISDN services in Europe—Currently available only for
Cisco VG200 gateways.
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• Digital Access T1 protocol trunks

Before you begin

Before adding the VG200 gateways to the Cisco Unified Communications Manager database, you must first
configure the gateway by using the Cisco IOS software command line interface (CLI). For gateway
configuration procedures and commands, refer to the configuration documentation that is supplied with the
gateway.

Procedure

Step 1 Create a Cisco VG200 gateway template to define common values for a set of gateways and ports. See the
Create Cisco VG200 Gateway Template, on page 369.

Step 2 Create a CSV data file to define individual values for each gateway and port that you want to add. See the
CSV Data File Creation for Cisco VG200 Gateways, on page 425.

Step 3 Insert gateways and ports in the Cisco Unified Communications Manager database. See the Insert Gateways
and Ports to Cisco Unified Communications Manager, on page 444.

Related Topics
Topics Related to Gateway Configuration Settings, on page 417

Add Cisco Catalyst 6000 (FXS) Gateways and Ports Using BAT
You can use BAT to add Cisco Catalyst 6000 (FXS) gateways to the Cisco Unified Communications Manager
database. You can also add FXS ports on the Cisco Catalyst 6000 (FXS) analog interface modules for analog
devices. You must configure a Gateway Directory Number template to associate with these FXS ports and a
Catalyst 6000 (FXS) ports template before adding these ports to the Cisco Unified Communications Manager
database.

Before you begin

Before using BAT to add the FXS ports for the analog interface modules, you must install the Cisco Catalyst
6000 gateway by performing these tasks:

1. Configure the gateway by using Cisco IOS software command line interface. See the documentation that
was supplied with your gateway for configuration instructions.

2. Use Cisco Unified Communications Manager Administration to add the Cisco Catalyst 6000 gateway in
the Cisco Unified Communications Manager database. In Cisco Unified Communications Manager
Administration, choose Device > Gateway and click Add New. Choose the Cisco Catalyst 6000 24 Port
FXS Gateway and device protocol and then click Next.

Procedure

Step 1 Create a Cisco Catalyst 6000 (FXS) gateway template. See the Create Cisco Catalyst 6000 (FXS) Gateway
Template, on page 373.
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Step 2 To define common values for a set of FXS ports, create a Cisco Catalyst 6000 (FXS) ports template. See the
FXS/FXO Port Configuration Field Descriptions, on page 393.

Step 3 To define individual values for the FXS ports that you want to add, create a CSV data file. See the Create
CSV Data File for Cisco Catalyst 6000 (FXS) Ports, on page 427.

Step 4 Insert gateways and ports in the Cisco Unified Communications Manager database. See the Insert Gateways
and Ports to Cisco Unified Communications Manager, on page 444.

Related Topics
Topics Related to Gateway Configuration Settings, on page 417

Add Cisco VG224 Gateways Using BAT
When using BAT to add the Cisco VG224 gateways to the Cisco Unified CommunicationsManager database,
you can configure the following types of trunks or ports:

• Foreign Exchange Station (FXS) ports for analog devices

Before you begin

Before adding the VG224 gateways to the Cisco Unified Communications Manager database, you must first
configure the gateway by using the Cisco IOS software command line interface (CLI). For gateway
configuration procedures and commands, refer to the configuration documentation that is supplied with the
gateway.

Procedure

Step 1 Create a Cisco VG224 gateway template to define common values for a set of gateways and ports. See the
Create Cisco VG224 Gateway Template, on page 374.

Step 2 Create a CSV data file to define individual values for each gateway and port that you want to add. See the
CSV Data Files Creation for Cisco VG224 Gateways and Ports, on page 428.

Step 3 Insert gateways and ports in the Cisco Unified Communications Manager database. See the Insert Gateways
and Ports to Cisco Unified Communications Manager, on page 444.

Related Topics
Topics Related to Gateway Configuration Settings, on page 417

Add Cisco VG202 and Cisco VG204 Gateway Using BAT
You must perform the following tasks to insert Cisco VG202 or VG204 gateway and ports to Cisco Unified
Communications Manager.

Before you begin

Before adding the VG202 or VG204 gateways to the Cisco Unified Communications Manager database, you
must first configure the gateway by using the Cisco IOS software command line interface (CLI). For gateway
configuration procedures and commands, refer to the configuration documentation that is supplied with the
gateway.
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Procedure

Step 1 Create a Cisco gateway template to define common values for a set of gateways and ports. See the Create
Cisco VG202 or VG204 Gateway Template, on page 376.

Step 2 Create a CSV data file to define individual values for each gateway and port that you want to add. See the
CSV Data File Creation for Cisco VG202 and VG204 Gateways, on page 430.

Step 3 Insert gateways and ports in the Cisco Unified Communications Manager database. See the Insert Gateways
and Ports to Cisco Unified Communications Manager, on page 444.

Related Topics
Topics Related to Gateway Configuration Settings, on page 417

Add Cisco VG310 Gateway Template
You must perform the following tasks to insert Cisco VG310 gateway to Unified Communications Manager.

Before you begin

Before adding the Cisco VG310 gateways to the Unified Communications Manager database, you must first
configure the gateway by using the Cisco IOS software command line interface (CLI). For gateway
configuration procedures and commands, refer to the configuration documentation that is supplied with the
gateway.

Procedure

Step 1 Create a Cisco VG310 gateway template to define common values for a set of gateways and ports. See Create
Cisco VG310 Gateway Template, on page 378.

Step 2 Create a CSV data file to define individual values for each gateway and port that you want to add. See CSV
Data Files Creation for Cisco VG310 Gateways and Ports, on page 432.

Step 3 Insert gateways and ports in the Unified Communications Manager database. See Insert Gateways and Ports
to Cisco Unified Communications Manager, on page 444.

Add Cisco VG320 Gateway Template
You must perform the following tasks to insert Cisco VG320 gateway to Unified Communications Manager.

Before you begin

Before adding the Cisco VG320 gateways to the Unified Communications Manager database, you must first
configure the gateway by using the Cisco IOS software command line interface (CLI). For gateway
configuration procedures and commands, refer to the configuration documentation that is supplied with the
gateway.
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Procedure

Step 1 Create a Cisco VG320 gateway template to define common values for a set of gateways and ports. See Create
Cisco VG320 Gateway Template, on page 378.

Step 2 Create a CSV data file to define individual values for each gateway and port that you want to add. See CSV
Data Files Creation for Cisco VG320 Gateways and Ports, on page 434.

Step 3 Insert gateways and ports in the Unified Communications Manager database. See Insert Gateways and Ports
to Cisco Unified Communications Manager, on page 444.

Add Cisco VG350 Gateway Template
You must perform the following tasks to insert Cisco VG350 gateway to Unified Communications Manager.

Before you begin

Before adding the Cisco VG350 gateways to the Unified Communications Manager database, you must first
configure the gateway by using the Cisco IOS software command line interface (CLI). For gateway
configuration procedures and commands, refer to the configuration documentation that is supplied with the
gateway.

Procedure

Step 1 Create a Cisco VG350 gateway template to define common values for a set of gateways and ports. See Create
Cisco VG350 Gateway Template, on page 379.

Step 2 Create a CSV data file to define individual values for each gateway and port that you want to add. See CSV
Data Files Creation for Cisco VG350 Gateways and Ports, on page 436.

Step 3 Insert gateways and ports in the Unified Communications Manager database. See Insert Gateways and Ports
to Cisco Unified Communications Manager, on page 444.

Add Cisco VG420 Gateway Using BAT
You must perform the following tasks to insert Cisco VG420 gateway to Unified Communications Manager:

Before you begin

Supported from Release 12.5(1)SU4 and 14SU1 onwards.Important

Before adding the Cisco VG420 gateways to the Unified Communications Manager database, you must first
configure the gateway by using the Cisco IOS Software command line interface (CLI). For gateway
configuration procedures and commands, see the configuration documentation that is supplied with the gateway.
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Procedure

Step 1 Create a Cisco VG420 gateway template to define common values for a set of gateways and ports. See Create
Cisco VG420 Gateway Template, on page 379.

Step 2 Create a CSV data file to define individual values for each gateway and port that you want to add. See Create
CSV Data Files for Cisco VG420 Gateways Using BAT Spreadsheet, on page 439.

Step 3 Insert gateways and ports in the Unified Communications Manager database. See Insert Gateways and Ports
to Cisco Unified Communications Manager, on page 444.

Add Cisco VG450 Gateway Using BAT
You must perform the following tasks to insert Cisco VG450 gateway to Unified Communications Manager

Before you begin

Before adding the Cisco VG450 gateways to the Unified Communications Manager database, you must first
configure the gateway by using the Cisco IOS software command line interface (CLI). For gateway
configuration procedures and commands, refer to the configuration documentation that is supplied with the
gateway.

Procedure

Step 1 Create a Cisco VG450 gateway template to define common values for a set of gateways and ports. See Create
Cisco VG450 Gateway Template, on page 380.

Step 2 Create a CSV data file to define individual values for each gateway and port that you want to add. See CSV
Data Files Creation for Cisco VG450 Gateways and Ports, on page 440.

Step 3 Insert gateways and ports in the Unified Communications Manager database. See Insert Gateways and Ports
to Cisco Unified Communications Manager, on page 444.

Add Cisco ISR 4461 Gateway Using BAT
You must perform the following tasks to insert Cisco ISR 4461 gateway to Cisco Unified Communications
Manager.

Before you begin

Before adding the Cisco ISR 4461 gateways to the Cisco Unified Communications Manager database, you
must first configure the gateway by using the Cisco IOS software command line interface (CLI). For gateway
configuration procedures and commands, refer to the configuration documentation that is supplied with the
gateway.

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
366

Gateways
Add Cisco VG450 Gateway Using BAT



Procedure

Step 1 Create a Cisco ISR 4461 gateway template to define common values for a set of gateways and ports. See
Create Cisco ISR 4461 Gateway Template, on page 380.

Step 2 Create a CSV data file to define individual values for each gateway and port that you want to add. See CSV
Data File Creation for Cisco ISR 4461 Gateways, on page 442.

Step 3 Insert gateways and ports in the Cisco Unified Communications Manager database. See Insert Gateways and
Ports to Cisco Unified Communications Manager, on page 444.

Find Gateway Template
Because you might have several gateway templates, Cisco Unified Communications Manager lets you locate
specific template on the basis of specific criteria. Use the following procedure to locate templates.

During your work in a browser session, your find/list search preferences get stored in the cookies on the client
machine. If you navigate to other menu items and return to this menu item, or if you close the browser and
then reopen a new browser window, your Cisco Unified Communications Manager search preferences get
retained until you modify your search.

Note

Procedure

Step 1 Choose Bulk Administration > Gateways > Gateway Template.
The Find and List Gateway Template window displays.

Step 2 From the first Find Gateways where drop-down list, choose one of the following criteria:

• Name

• Description

• DN/Route Pattern

• Calling Search Space

• Device Pool

• Route Group Name

• Device Type

Step 3 From the second Find Gateways where drop-down list, choose one of the following criteria:

• begins with

• contains

• is exactly

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
367

Gateways
Find Gateway Template



• ends with

• is empty

• is not empty

Step 4 Specify the appropriate search text, if applicable.

To find all gateways that are registered in the database, click Find without entering any search
text.

Tip

Step 5 Choose Show from the third drop-down list to show the end points that are associated with gateways, and
click Find.

A list of discovered templates displays by

• Device Name

• Description

• Device Pool

• Status

• IP Address

Step 6 From the list of records, click the device name that matches your search criteria.
The Gateway Configuration window displays.

Related Topics
Topics Related to Gateway Configuration Settings, on page 417

Add or Edit Gateway Template
Use BAT to add or edit VG200, VG202, VG204, VG224, VG310, VG320, VG350, VG420, VG450,
CiscoCatalyst 6000 (FXS), or Cisco ISR 4461 gateway templates in the Cisco Unified Communications
Manager database.

Procedure

Step 1 Choose Bulk Administration > Gateways > Gateway Template.

The Find and List Gateway Template window displays.

a) To edit an existing gateway template, see the Find Gateway Template, on page 367 and select the gateway
that you want to edit.
See the field descriptions for your gateway.

• VG200 Gateway Template Field Descriptions, on page 381

• VG224 Gateway Template Field Descriptions, on page 382

• VG202 and VG204 Gateway Template Field Descriptions, on page 383
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• Cisco Catalyst 6000 24 Port FXS Gateway Template Field Descriptions, on page 389

• VG310 Gateway Template Field Description, on page 383

• VG320 Gateway Template Field Description, on page 384

• VG350 Gateway Template Field Description, on page 385

• VG420 Gateway Template Field Descriptions, on page 386

• VG450 Gateway Template Field Description, on page 387

• ISR 4461 Gateway Template Field Descriptions, on page 388

b) To add a new gateway, click Add New.

The Add a New Gateway window displays.

Step 2 Complete one of the following procedures:
a) To create a VG200 template, see the Create Cisco VG200 Gateway Template, on page 369.
b) To create CiscoCatalyst 6000 (FXS) Ports template, see Create Cisco Catalyst 6000 (FXS) Gateway

Template, on page 373.
c) To create a VG224 template, see the Create Cisco VG224 Gateway Template, on page 374.
d) To create a VG202 or VG204 template, see the Create Cisco VG202 or VG204 Gateway Template, on

page 376.
e) To create a Cisco VG310 template, see the Create Cisco VG310 Gateway Template, on page 378.
f) To create a Cisco VG320 template, see the Create Cisco VG320 Gateway Template, on page 378.
g) To create a Cisco VG350 template, see the Create Cisco VG350 Gateway Template, on page 379.
h) To create a Cisco VG420 template, see the Create Cisco VG420 Gateway Template, on page 379.
i) To create a Cisco VG450 template, see the Create Cisco VG450 Gateway Template, on page 380
j) To create a Cisco ISR 4461 template, see the Create Cisco ISR 4461 Gateway Template, on page 380.

Create Cisco VG200 Gateway Template
Youmust create a CiscoVG200 template and then add endpoint identifiers for the network modules. Configure
the following endpoint identifiers in the BAT template:

• Foreign Exchange Station (FXS) ports

• Foreign Exchange Office (FXO) trunks

• T1 PRI trunks

• E1 PRI trunks

• T1 CAS trunks

Procedure

Step 1 Choose Bulk Administration > Gateways > Gateway Template.
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The Find and List Gateway window displays.
Step 2 Click Add New.

The Add a New Gateway Template window displays.
Step 3 From the Gateway Type drop-down list, select Cisco VG200 and click Next.

The Gateway Template Configuration window displays.
Step 4 Enter values for all the fields.

See VG200 Gateway Template Field Descriptions, on page 381.

Step 5 Click Save.
When the insert completes, a new field displays on the pane.

Step 6 In the Subunit field(s), choose the appropriate type for each subunit field:

• VIC-2FXS—Foreign Exchange Station (FXS) voice interface card

• VIC-2FXO—Foreign Exchange Office (FXO) voice interface card

• VWIC-1MFT-T1—Voice WAN interface card with one endpoint for T1CAS or T1 PRI

• VWIC-2MFT-T1—Voice WAN interface card with two endpoints for T1 CAS or T1 PRI

• VWIC-1MFT-E1—Voice WAN interface card with one endpoint for E1 PRI

• VWIC-2MFT-E1—Voice WAN interface card with two endpoints for E1 PRI

Step 7 Click Save.
When the Status indicates that the update completed, the endpoint identifiers display as links to the right of
the subunit drop-down list.

Step 8 Click an endpoint identifier (for example, 1/0/0) to configure device protocol information and add ports for
the installed types of VICs.

For detailed instructions, see the following procedures:

• Add FXS Ports to VG200 Gateway Template, on page 371

• Add FXO Ports to VG200 Gateway Template, on page 371

• Add Digital Access T1 (T1-CAS) Ports to VG200 Gateway Template, on page 372

• Add T1 PRI or E1 PRI Device to VG200 Gateway Template, on page 373

Step 9 Click Reset to reset the gateway and apply the changes.

What to do next

Continue configuring endpoint information and ports as needed.

Cisco VG200 Gateway Template Port Additions
The device protocols and port types that can be configured on VG200 gateways vary by the type of installed
voice interface cards.

Related Topics
Add FXS Ports to VG200 Gateway Template, on page 371
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Add FXO Ports to VG200 Gateway Template, on page 371
Add Digital Access T1 (T1-CAS) Ports to VG200 Gateway Template, on page 372
Add T1 PRI or E1 PRI Device to VG200 Gateway Template, on page 373

Add FXS Ports to VG200 Gateway Template
You can use Foreign Exchange Station (FXS) ports to connect to any POTS device. Use this procedure to
add FXS ports on a VG200 gateway template.

Before you begin

You must add an VG200 gateway template before configuring ports. See the Create Cisco VG200 Gateway
Template, on page 369 for instructions.

Procedure

Step 1 Find the gateway template to which you want to add FXS ports.
Step 2 From the Gateway Template Configuration window, click the endpoint identifier for the FXS VIC that you

want to configure.
The window refreshes and displays theGateway Template Configurationwindow with the end-point icons.

Step 3 Enter the appropriate Gateway Information and Port Information settings, and click Save.

See the following for field descriptions:

• FXS/FXO Port Configuration Field Descriptions, on page 393

• POTS Port Configuration Settings, on page 413

After you insert a POTS port, the window refreshes and displays the POTS port information at
the bottom of the window. AnAdd a new DN link displays in theDirectory Number Information
area in the left panel.

Note

Step 4 Click Add a new DN to add directory numbers to the POTS port or, if you configured another type of port,
go to Step 6, on page 372.

Step 5 Choose Back to MGCP Configuration in the Related Links drop-down list to return to the main VG200
Gateway Template Configuration window for the gateway to which you just added the ports and click Go.

Step 6 Click Reset to reset the gateway and apply the changes.
Step 7 Repeat Step 1, on page 371 through Step 5, on page 371 to add additional FXS ports.

Related Topics
Add or Update Phone Lines in BAT Template, on page 28
Find Gateway Template, on page 367
Topics Related to Gateway Configuration Settings, on page 417

Add FXO Ports to VG200 Gateway Template
Foreign Exchange Office (FXO) ports are used for connecting to a central office or PBX. You can add and
configure FXO ports for loop start or ground start on an VG200 gateway template using BAT.
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Cisco Unified Communications Manager assumes all loop-start trunks lack positive disconnect supervision.
Configure trunks with positive disconnect supervision as ground start, so active calls can be maintained during
a Cisco Unified Communications Manager server failover.

Note

Before you begin

You must add a VG200 gateway template before configuring ports. See the Create Cisco VG200 Gateway
Template, on page 369 for instructions.

Procedure

Step 1 Find the gateway template to which you want to add FXS ports.
Step 2 From the Gateway Configuration window, click the endpoint identifiers of the FXO port that you want to

configure.
Step 3 From the Port Type drop-down list, choose either Ground Start or Loop Start.

You must choose the same port type for both endpoint identifiers of the VIC-2FXO port. If you
choose different port types, a message displays.

Note

Step 4 Enter the appropriate Gateway Configuration and Port Information settings, and click Save.
See FXS/FXO Port Configuration Field Descriptions, on page 393 for field descriptions.

Step 5 Choose Back to MGCP Configuration in the Related Links drop-down list to return to the main VG200
gateway configuration window for the gateway to which you just added the ports and click Go.

Step 6 Click Reset to reset the gateway and apply the changes.
Step 7 To add more FXO ports, repeat Step 2, on page 372 through Step 4, on page 372.

Related Topics
Find Gateway Template, on page 367
Topics Related to Gateway Configuration Settings, on page 417

Add Digital Access T1 (T1-CAS) Ports to VG200 Gateway Template
You can use BAT to add Digital Access T1 (T1-CAS) ports to an VG200 gateway template.

Procedure

Step 1 Find the gateway template to which you want to add FXS ports.
Step 2 From the Gateway Configuration window, click the endpoint identifier of the Digital Access T1 (T1-CAS)

port that you want to configure.

In the Device Protocol drop-down list box that displays, choose Digital Access T1 and click Next.

Step 3 Enter the appropriate Gateway Configuration settings, and click Save.
See the Digital Access T1 Trunks on Cisco VG200 Gateway Template Field Descriptions, on page 399 for
details.
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Step 4 To reset the gateway and apply the changes, click Reset.
Step 5 See the Port Configuration Settings, on page 413 for the appropriate settings for the port type that you choose.

Related Topics
Find Gateway Template, on page 367
Topics Related to Gateway Configuration Settings, on page 417

Add T1 PRI or E1 PRI Device to VG200 Gateway Template
You can use BAT to add T1 PRI or E1 PRI device to an VG200 gateway template.

Procedure

Step 1 Find the gateway template to which you want to add FXS ports.
Step 2 From the Gateway Configuration window, click the endpoint identifier of the T1 PRI or E1 PRI port that

you want to configure.
Step 3 Configure the T1 PRI or E1 PRI device protocol settings.

See T1 PRI or E1 PRI Trunks on Cisco VG200 Gateway Template Field Descriptions, on page 402 for field
descriptions.

Step 4 Click Save.
Step 5 Click Reset to reset the gateway and apply the changes.

Related Topics
Find Gateway Template, on page 367
Topics Related to Gateway Configuration Settings, on page 417

Create Cisco Catalyst 6000 (FXS) Gateway Template
Use BAT to create a CiscoCatalyst 6000 FXS gateway template. Youmust complete all fields unless otherwise
noted.

Procedure

Step 1 Choose Bulk Administration > Gateways > Gateway Template.
The Find and List Gateway window displays.

Step 2 Click Add New.

The Add a New Gateway Template window displays.

Step 3 From theGateway Type drop-down list, chooseCisco Catalyst 6000 24 Port FXS Gateway and clickNext.

The Gateway Template Configuration window displays.

Step 4 Enter a unique name for the template in the Template Name field.
Step 5 Enter the settings for the fields, and click Save.

See Cisco Catalyst 6000 24 Port FXSGateway Template Field Descriptions, on page 389 for field descriptions.
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Step 6 Click Add a New Port.

A port configuration dialog opens in a separate window.

Step 7 From the drop-down list, choose POTS as the port type depending on the gateway model that you are
configuring.
See T1 PRI or E1 PRI Trunks on Cisco VG200 Gateway Template Field Descriptions, on page 402 for field
descriptions.

Step 8 Enter the appropriate port configuration settings, and click Save.
See POTS Port Configuration Settings, on page 413 for field descriptions.
If you have inserted POTS ports, the window refreshes and displays the POTS port in the list on the left side
of the window. An Add DN link displays to the right of the new port.

Step 9 To add a directory numbers to an FXS port, click Add DN.
Step 10 Click Save.

When the Status indicates that the update completed, the template displays on the Find and List Gateways
window. To go back to the Find and List window, choose Back to Find and List from the Related Links
drop-down list in the top, right corner of the window.

Related Topics
Add or Update Phone Lines in BAT Template, on page 28
Topics Related to Gateway Configuration Settings, on page 417

Create Cisco VG224 Gateway Template
Youmust create a CiscoVG224 template and then add endpoint identifiers for the network modules. Configure
the following endpoint identifiers in the BAT template:

• Foreign Exchange Station (FXS) ports

Procedure

Step 1 Choose Bulk Administration > Gateways > Gateway Template.

The Find and List Gateway window displays.

Step 2 Click Add New.

The Add a New Gateway Template window displays.

Step 3 From the Gateway Type drop-down list, choose VG224 and click Next.

The Add a New Gateway Template window displays.

Step 4 From the Protocol drop-down list, choose MGCP or SCCP and click Next.

The Gateway Template Configuration window displays.

Step 5 Enter values for all the fields, and click Save.

See VG224 Gateway Template Field Descriptions, on page 382 for field descriptions.

When the insert completes, a new field displays on the pane.
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Step 6 In the Subunit 0 field, choose the appropriate type for the subunit field from the drop-down list, and click
Save.

• VIC-2FXS—Foreign Exchange Station (FXS) voice interface card.

When the Status indicates that the update completed, the endpoint identifiers display as links to the right of
the subunit drop-down list.

Step 7 Click an endpoint identifier (for example, 1/0/0) to configure device protocol information and add ports for
the installed types of VICs.

Step 8 Click Reset to reset the gateway and apply the changes.

What to do next

Continue configuring endpoint information and ports as needed.

Related Topics
Add FXS Ports to VG224 Gateway Template, on page 375
Topics Related to Gateway Configuration Settings, on page 417

Add FXS Ports to VG224 Gateway Template
Use BAT to add FXS ports on a VG224 gateway template. Foreign Exchange Station (FXS) ports are used
to connect to POTS devices.

Before you begin

You must add a VG224 gateway template before configuring ports.

Procedure

Step 1 Find the gateway template to which you want to add FXS ports.
Step 2 From the Gateway Template Configuration window, click the endpoint identifier for the FXS VIC that you

want to configure.

The window refreshes and displays the Gateway Template Configuration window with the endpoint icons.

Step 3 Enter the appropriate Gateway Information and Port Information settings, and click Save.

See the following for field descriptions:

• FXS/FXO Port Configuration Field Descriptions, on page 393

• POTS Port Configuration Settings, on page 413

After you insert a POTS port, the window refreshes and displays the POTS port information at
the bottom of the window. AnAdd a new DN link displays in theDirectory Number Information
area in the left panel.

Note

Step 4 Click Add a new DN to add directory numbers to the POTS port or, if you configured another type of port,
go to Step 6.
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Step 5 To return to the main VG224 Gateway Template Configuration window for the gateway to which you just
added the ports, select Back to MGCP Configuration in the Related Links drop-down list and click Go.

Step 6 Click Reset to reset the gateway and apply the changes.
Step 7 Repeat Step 1 through Step 5 to add additional FXS ports.

Related Topics
Add or Update Phone Lines in BAT Template, on page 28
Create Cisco VG224 Gateway Template, on page 374
Find Gateway Template, on page 367
Topics Related to Gateway Configuration Settings, on page 417

Create Cisco VG202 or VG204 Gateway Template
Youmust create a CiscoVG202 or VG204 template and then add endpoint identifiers for the networkmodules.
Configure the following endpoint identifiers in the BAT template:

• Foreign Exchange Station (FXS) ports

Procedure

Step 1 Choose Bulk Administration > Gateways > Gateway Template.

The Find and List Gateway window displays.

Step 2 Click Add New.

The Add a New Gateway Template window displays.

Step 3 From the Gateway Type drop-down list, choose VG202 or VG204 and click Next.

The Add a New Gateway Template window displays.

Step 4 From the Protocol drop-down list, choose MGCP or SCCP and click Next.

The Gateway Template Configuration window displays.

Step 5 Enter values for all the fields, and click Save.
See VG202 and VG204 Gateway Template Field Descriptions, on page 383 for field descriptions.
When the insert completes, a new Subunit 0 field displays on the pane.

Step 6 In the Subunit 0 field, choose the appropriate type for the subunit field from the drop-down list box, and click
Save.
When the Status indicates that the update completed, the endpoint identifiers display as links to the right of
the subunit drop-down list boxes.

Step 7 Click an endpoint identifier (for example, 0/0) to configure device protocol information and add ports for the
installed types of VICs.

Step 8 Click Reset to reset the gateway and apply the changes.
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What to do next

Continue configuring endpoint information and ports as needed.

Related Topics
Add FXS Ports to VG202 or VG204 Gateway Template, on page 377
Find Gateway Template, on page 367
Topics Related to Gateway Configuration Settings, on page 417

Add FXS Ports to VG202 or VG204 Gateway Template
Use BAT to add FXS ports on a VG202 or VG204 gateway template. You can use Foreign Exchange Station
(FXS) ports to connect to any POTS device.

Before you begin

You must add a VG202 or VG204 gateway template before you configure ports. See the Create Cisco VG202
or VG204 Gateway Template, on page 376 for instructions.

Procedure

Step 1 Find the gateway template to which you want to add FXS ports.
Step 2 From the Gateway Template Configuration window, click the endpoint identifier for the FXS VIC that you

want to configure.
The window refreshes and displays the Gateway Template Configuration window with the endpoint icons.

Step 3 Enter the appropriate Gateway Information and Port Information settings and click Save.

See the following for field descriptions:

• FXS/FXO Port Configuration Field Descriptions, on page 393

• POTS Port Configuration Settings, on page 413

After you insert a POTS port, the window refreshes and displays the POTS port information at
the bottom of the window. AnAdd a new DN link displays in theDirectory Number Information
area in the left panel.

Note

Step 4 Click Add a new DN to add directory numbers to the POTS port or, if you configured another type of port,
go to Step 6, on page 377.

Step 5 To return to the main VG202 or VG204Gateway Template Configurationwindow for the gateway to which
you just added the ports, choose Back to MGCP Configuration in the Related Links drop-down list and
click Go (if you configuring an MGCP gateway).

Step 6 Click Reset to reset the gateway and apply the changes.
Step 7 Repeat Step 2, on page 377 through Step 5, on page 377 to add additional FXS ports.

Related Topics
Add or Update Phone Lines in BAT Template, on page 28
Find Gateway Template, on page 367
Topics Related to Gateway Configuration Settings, on page 417
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Create Cisco VG310 Gateway Template
Use BAT to create a Cisco VG310 Gateway template. You must complete all fields unless otherwise noted.

Procedure

Step 1 Choose Bulk Administration > Gateways > Gateway Template.

The Find and List Gateway window displays.

Step 2 Click Add New.

The Add a New Gateway Template window displays.

Step 3 From the Gateway Type drop-down list, choose VG310 and click Next.

The Gateway Template Configuration window displays.

Step 4 From the Protocol drop-down list, choose MGCP or SCCP and click Next.

The Gateway Template Configuration window displays.

Step 5 Enter a unique name for this template in the Template Name field.
Step 6 Enter values for all the fields, and click Save.

See VG310 Gateway Template Field Description, on page 383 for field descriptions.

Create Cisco VG320 Gateway Template
Use BAT to create a Cisco VG320 Gateway template. You must complete all fields unless otherwise noted.

Procedure

Step 1 Choose Bulk Administration > Gateways > Gateway Template.

The Find and List Gateway window displays.

Step 2 Click Add New.

The Add a New Gateway Template window displays.

Step 3 From the Gateway Type drop-down list, choose VG320 and click Next.

The Gateway Configuration window displays.

Step 4 From the Protocol drop-down list, choose MGCP or SCCP and click Next.

The Gateway Template Configuration window displays.

Step 5 Enter a unique name for the template in the Template Name field.
Step 6 Enter values for all the fields, and click Save.
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See VG320 Gateway Template Field Description, on page 384 for field descriptions.

Create Cisco VG350 Gateway Template
Use BAT to create a VG350 Gateway template. You must complete all the fields unless noted.

Procedure

Step 1 Choose Bulk Administration > Gateways > Gateway Template.

The Find and List Gateway window displays.

Step 2 Click Add New.

The Add a New Gateway Template window displays.

Step 3 From the Gateway Type drop-down, choose VG350 and click Next.
Step 4 From the Protocol drop-down list, choose MGCP or SCCP, and click Next.

The Gateway Template Configuration window displays.

Step 5 Enter a unique name for the template in the Template Name field.
Step 6 Enter values for all the fields, and click Save.

See VG350 Gateway Template Field Description, on page 385 for field descriptions.

Create Cisco VG420 Gateway Template
Use BAT to create a Cisco VG420 Gateway template. You must complete all fields unless noted.

Procedure

Step 1 Choose Bulk Administration > Gateways > Gateway Template.
Step 2 Click Add New.
Step 3 From the Gateway Type drop-down list, choose VG420 and click Next.
Step 4 From the Protocol drop-down list, choose SIP, SCCP or MGCP and click Next.
Step 5 Enter a unique name for the template in the Template Name field.
Step 6 Enter values for all the fields, and click Save.

See VG420 Gateway Template Field Descriptions, on page 386 for field descriptions.
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Create Cisco VG450 Gateway Template
Use BAT to create a VG450 Gateway template. You must complete all fields unless noted.

Procedure

Step 1 Choose Bulk Administration > Gateways > Gateway Template.

The Find and List Gateway window displays.

Step 2 Click Add New.

The Add a new Gateway Template window displays.

Step 3 From the Gateway Type drop-down list, choose VG450 and click Next.
Step 4 From the Protocol drop-down list, choose SIP, MGCP or SCCP and click Next.

The Gateway Template Configuration window displays.

Step 5 Enter a unique name for the template in the Template Name field.
Step 6 Enter values for all the fields, and click Save.

See VG450 Gateway Template Field Description, on page 387 for field descriptions.

Create Cisco ISR 4461 Gateway Template
Use BAT to create a Cisco ISR 4461 Gateway template. You must complete all fields unless noted.

Procedure

Step 1 Choose Bulk Administration > Gateways > Gateway Template.

The Find and List Gateway window displays.

Step 2 Click Add New.

The Add a new Gateway Template window displays.

Step 3 From the Gateway Type drop-down list, choose Cisco ISR 4461 and click Next.
Step 4 From the Protocol drop-down list, choose SIP, SCCP or MGCP and click Next.

The Gateway Template Configuration window displays.

Step 5 Enter a unique name for the template in the Template Name field.
Step 6 Enter values for all the fields, and click Save.

See ISR 4461 Gateway Template Field Descriptions, on page 388 for field descriptions.
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Gateway Configuration Settings
Detailed field descriptions are available for all Cisco-supported gateways and ports that you can add or update
using BAT.

Related Topics
Cisco Catalyst 6000 24 Port FXS Gateway Template Field Descriptions, on page 389
Digital Access T1 Trunks on Cisco VG200 Gateway Template Field Descriptions, on page 399
FXS/FXO Port Configuration Field Descriptions, on page 393
Port Configuration Settings, on page 413
T1 PRI or E1 PRI Trunks on Cisco VG200 Gateway Template Field Descriptions, on page 402
VG200 Gateway Template Field Descriptions, on page 381
VG202 and VG204 Gateway Template Field Descriptions, on page 383
VG224 Gateway Template Field Descriptions, on page 382

VG200 Gateway Template Field Descriptions
The following table provides detailed descriptions for VG200 gateway template configuration settings.

Table 28: VG200 Gateway Configuration Settings

DescriptionField

Enter a name up to 64 characters that identifies the CiscoVG200 gateway
template.

Template Name

Enter a description that clarifies the purpose of the device.Description

Choose a Unified Communications Manager redundancy group from
the list.

A Unified Communications Manager redundancy group includes a
prioritized list of up to three Unified Communications Managers. The
first Unified Communications Manager in the list serves as the primary
Unified Communications Manager. If the primary Unified
CommunicationsManager is not available or fails, the gateway attempts
to connect with the next Unified Communications Manager in the list
and so on.

Cisco Unified Communications
Manager Group

Configured Slots, VICs, and Endpoints

You must specify the beginning port number for some VICs. For example, if the VIC in
Subunit 0 begins at 0 and has two ports (0 and 1), the VIC in Subunit 1 must begin at a port
number greater than 1 and have two ports (2 and 3 or 4 and 5).

Note

VG200 gateway has only one slot.Note
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DescriptionField

For the available slot on the VG200 gateway, choose from the following
type of modules:

• NM-1V—Network Module-1Voice has one voice interface card
(VIC) in Sub-Unit 0 for FXS or FXO.

• NM-2V—NetworkModule-2Voice has twoVICs, one in Sub-Unit
0 and one in Sub-Unit 1 for either FXS or FXO.

• NM-HDV—Network Module-High Density Voice has one VIC in
Sub-Unit 0 either for T1 CAS or T1 PRI, or for E1 PRI.

• None—No network modules are installed.

Module in Slot 1

Product-Specific Configuration

The gateway manufacturer specifies the model-specific fields under
product-specific configuration. Because they are dynamically configured,
they can change without notice.

To view field descriptions and help for product-specific configuration
items, click the “?” information icon to the right of the Product Specific
Configuration heading to display help in a popup dialog box.

If you need more information, refer to the documentation for the specific
gateway that you are configuring or contact the manufacturer.

Model-specific configuration
fields defined by the gateway
manufacturer

VG224 Gateway Template Field Descriptions
The following table provides detailed descriptions for VG224 gateway template configuration settings.

Table 29: VG224 Gateway Configuration Settings

DescriptionField

Enter a name of up to 64 characters that identifies the CiscoVG224
gateway template.

Template Name

Enter a description that clarifies the purpose of the device.Description

From the drop-down list box, choose a Cisco Unified Communications
Manager redundancy group.

A Cisco Unified Communications Manager redundancy group includes
a prioritized list of up to three Cisco Unified CommunicationsManagers.
The first Cisco Unified Communications Manager in the list serves as
the primary Cisco Unified Communications Manager. If the primary
Cisco Unified Communications Manager is not available or fails, the
gateway attempts to connect with the next Cisco Unified
Communications Manager in the list and so on.

Cisco Unified Communications
Manager Group

Configured Slots, VICs, and Endpoints
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DescriptionField

For the available slot on the VG224 gateway, select Analog from the
drop-down list box.

Module in Slot 2

For the available subunit 0 on the VG224 gateway, choose 24FXS as
the subunit from the drop-down list box.

Be aware that only Module in Slot 2, and Subunit 0 are
available for VG224 gateways.

Note

Subunit 0

VG202 and VG204 Gateway Template Field Descriptions
The following table provides detailed descriptions for VG202 and VG204 gateway template configuration
settings.

Table 30: VG202 and VG204 Gateway Configuration Settings

DescriptionField

Enter a name of up to 64 characters that identifies the CiscoVG202 or
VG204 gateway template.

Template Name

Enter a description that clarifies the purpose of the device.Description

From the drop-down list box, choose a Cisco Unified Communications
Manager redundancy group.

A Cisco Unified Communications Manager redundancy group includes
a prioritized list of up to three Cisco Unified CommunicationsManagers.
The first Cisco Unified Communications Manager in the list serves as
the primary Cisco Unified Communications Manager. If the primary
Cisco Unified Communications Manager is not available or fails, the
gateway attempts to connect with the next Cisco Unified
Communications Manager in the list and so on.

Cisco Unified Communications
Manager Group

Configured Slots, VICs, and Endpoints

For the available slot on the VG202 or VG204 gateway, select Analog
from the drop-down list box.

Module in Slot 0

For the available subunit 0 on the VG202 or VG204 gateway, choose
2FXS as the subunit from the drop-down list box.

Be aware that only Module in Slot 0, and Subunit 0 are
available for VG202 and VG204 gateways.

Note

Subunit 0

VG310 Gateway Template Field Description
The following table provides detailed descriptions for Cisco VG310 gateway template configuration settings.
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Table 31: VG310 Gateway Configuration Settings

DescriptionField

Enter a name of up to 64 characters that identifies the VG310 gateway
template.

Template Name

Enter a description that clarifies the purpose of the device.Description

From the drop-down list box, choose a Cisco Unified Communications
Manager redundancy group.

A Cisco Unified Communications Manager redundancy group includes
a prioritized list of up to three Cisco Unified CommunicationsManagers.
The first Cisco Unified Communications Manager in the list serves as
the primary Cisco Unified Communications Manager. If the primary
Cisco Unified Communications Manager is not available or fails, the
gateway attempts to connect with the next Cisco Unified
Communications Manager in the list and so on.

Cisco Unified Communications
Manager Group

Configured Slots, VICs, and Endpoints

For the available slot on the VG310 gateway, select VG-2VWIC-MBRD
from the drop-down list box.

Module in Slot 0

Product-Specific Configuration

The gateway manufacturer specifies the model-specific fields under
product-specific configuration. Because they are dynamically configured,
they can change without notice.

To view field descriptions and help for product-specific configuration
items, click the “?” information icon to the right of the Product Specific
Configuration heading to display help in a popup dialog box.

If you need more information, refer to the documentation for the specific
gateway that you are configuring or contact the manufacturer.

Model-specific configuration
fields defined by the gateway
manufacturer

VG320 Gateway Template Field Description
The following table provides detailed descriptions for Cisco VG320 gateway template configuration settings.

Table 32: VG320 Gateway Configuration Settings

DescriptionField

Enter a name of up to 64 characters that identifies the VG320 gateway
template.

Template Name

Enter a description that clarifies the purpose of the device.Description
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DescriptionField

From the drop-down list box, choose a Cisco Unified Communications
Manager redundancy group.

A Cisco Unified Communications Manager redundancy group includes
a prioritized list of up to three Cisco Unified CommunicationsManagers.
The first Cisco Unified Communications Manager in the list serves as
the primary Cisco Unified Communications Manager. If the primary
Cisco Unified Communications Manager is not available or fails, the
gateway attempts to connect with the next Cisco Unified
Communications Manager in the list and so on.

Cisco Unified Communications
Manager Group

Configured Slots, VICs, and Endpoints

For the available slot on the VG320 gateway, select VG-3VWIC-MBRD
from the drop-down list box.

Module in Slot 0

Product-Specific Configuration

The gateway manufacturer specifies the model-specific fields under
product-specific configuration. Because they are dynamically configured,
they can change without notice.

To view field descriptions and help for product-specific configuration
items, click the “?” information icon to the right of the Product Specific
Configuration heading to display help in a popup dialog box.

If you need more information, refer to the documentation for the specific
gateway that you are configuring or contact the manufacturer.

Model-specific configuration
fields defined by the gateway
manufacturer

VG350 Gateway Template Field Description
The following table provides detailed descriptions for Cisco VG350 gateway template configuration settings.

Table 33: VG350 Gateway Configuration Settings

DescriptionField

Enter a name of up to 64 characters that identifies the VG350 gateway
template.

Template Name

Enter a description that clarifies the purpose of the device.Description

From the drop-down list box, choose a Cisco Unified Communications
Manager redundancy group.

A Cisco Unified Communications Manager redundancy group includes
a prioritized list of up to three Cisco Unified CommunicationsManagers.
The first Cisco Unified Communications Manager in the list serves as
the primary Cisco Unified Communications Manager. If the primary
Cisco Unified Communications Manager is not available or fails, the
gateway attempts to connect with the next Cisco Unified
Communications Manager in the list and so on.

Cisco Unified Communications
Manager Group
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DescriptionField

Configured Slots, VICs, and Endpoints

For the available slot on the VG350 gateway, select NM-4VWIC-MBRD
from the drop-down list box.

Module in Slot 0

For the available slot on the VG350 gateway, select NONE from the
drop-down list.

Module in Slot 1/3

For the available slot on the VG350 gateway, select ANALOG from the
drop-down list.

Module in Slot 2/4

Product-Specific Configuration

The gateway manufacturer specifies the model-specific fields under
product-specific configuration. Because they are dynamically configured,
they can change without notice.

To view field descriptions and help for product-specific configuration
items, click the “?” information icon to the right of the Product Specific
Configuration heading to display help in a popup dialog box.

If you need more information, refer to the documentation for the specific
gateway that you are configuring or contact the manufacturer.

Model-specific configuration
fields defined by the gateway
manufacturer

VG420 Gateway Template Field Descriptions
The following table provides detailed descriptions for Cisco VG420 gateway template configuration settings.

Table 34: VG420 Gateway Configuration Settings

DescriptionField

Enter a name of up to 64 characters that identifies the VG420 gateway
template.

Template Name

Enter a description that clarifies the purpose of the device.Description

From the drop-down list, choose a Unified Communications Manager
redundancy group.

A Unified Communications Manager redundancy group includes a
prioritized list of up to three Unified Communications Managers. The
first Unified Communications Manager in the list serves as the primary
Unified Communications Manager. If the primary Unified
CommunicationsManager is not available or fails, the gateway attempts
to connect with the next Unified Communications Manager in the list
and so on.

UnifiedCommunicationsManager
Group

Configured Slots, VICs, and Endpoints

For the available slot on the VG420 gateway, select ISR-2NIM-MBRD
from the drop-down list.

Module in Slot 0
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DescriptionField

For the available slot on the VG420 gateway, select ANALOG from the
drop-down list.

Module in Slot 1

Product-Specific Configuration

The gateway manufacturer specifies the model-specific fields under
product-specific configuration. Because they are dynamically configured,
they can change without notice.

To view field descriptions and help for product-specific configuration
items, click the “?” information icon to the right of the Product Specific
Configuration heading to display help in a pop-up dialog box.

If you need more information, see the documentation for the specific
gateway that you are configuring or contact the manufacturer.

Model-specific configuration
fields defined by the gateway
manufacturer

VG450 Gateway Template Field Description
The following table provides detailed descriptions for Cisco VG450 gateway template configuration settings.

Table 35: VG450 Gateway Configuration Settings

DescriptionField

Enter a name of up to 64 characters that identifies the VG450 gateway
template.

Template Name

Enter a description that clarifies the purpose of the device.Description

From the drop-down list box, choose a Unified Communications
Manager redundancy group.

A Unified Communications Manager redundancy group includes a
prioritized list of up to three Unified Communications Managers. The
first Unified Communications Manager in the list serves as the primary
Unified Communications Manager. If the primary Unified
CommunicationsManager is not available or fails, the gateway attempts
to connect with the next Unified Communications Manager in the list
and so on.

UnifiedCommunicationsManager
Group

Configured Slots, VICs, and Endpoints

For the available slot on the VG450 gateway, select ISR-3NIM-MBRD
from the drop-down list box.

Module in Slot 0

For the available slot on the VG450 gateway, select ANALOG from the
drop-down list.

ANALOG—In the SM-X slot on the gateway, users can choose
SM-X-16FXS/FXO, SM-X-24FXS/4FXO, SM-X-8FXS/12FXO,
SM-X-56FXS, or SM-X-72FXS modules.

Module in Slot 1/2/3
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DescriptionField

Product-Specific Configuration

The gateway manufacturer specifies the model-specific fields under
product-specific configuration. Because they are dynamically configured,
they can change without notice.

To view field descriptions and help for product-specific configuration
items, click the “?” information icon to the right of the Product Specific
Configuration heading to display help in a popup dialog box.

If you need more information, refer to the documentation for the specific
gateway that you are configuring or contact the manufacturer.

Model-specific configuration
fields defined by the gateway
manufacturer

ISR 4461 Gateway Template Field Descriptions
The following table provides detailed descriptions for Cisco ISR 4461 gateway template configuration settings.

Table 36: ISR 4461 Gateway Configuration Settings

DescriptionField

Enter a name of up to 64 characters that identifies the ISR 4461 gateway
template.

Template Name

Enter a description that clarifies the purpose of the device.Description

From the drop-down list box, choose a Cisco Unified Communications
Manager redundancy group.

A Cisco Unified Communications Manager redundancy group includes
a prioritized list of up to three Cisco Unified CommunicationsManagers.
The first Cisco Unified Communications Manager in the list serves as
the primary Cisco Unified Communications Manager. If the primary
Cisco Unified Communications Manager is not available or fails, the
gateway attempts to connect with the next Cisco Unified
Communications Manager in the list and so on.

Cisco Unified Communications
Manager Group

Configured Slots, VICs, and Endpoints

For the available slot on the ISR 4461 gateway, select ISR-3NIM-MBRD
from the drop-down list box.

Module in Slot 0

For the available slot on the ISR 4461 gateway, choose from the
following type of modules:

• ANALOG—In the SM-X slot on the gateway, users can choose
SM-X-16FXS/FXO, SM-X-24FXS/4FXO, SM-X-8FXS/12FXO,
SM-X-56FXS, or SM-X-72FXS modules.

• SM-X-NIM-ADPTR—Adapter for the NIM in a SM-X slot on the
gateway.

Module in Slot 1/2/3
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DescriptionField

Product-Specific Configuration

The gateway manufacturer specifies the model-specific fields under
product-specific configuration. Because they are dynamically configured,
they can change without notice.

To view field descriptions and help for product-specific configuration
items, click the “?” information icon to the right of the Product Specific
Configuration heading to display help in a popup dialog box.

If you need more information, refer to the documentation for the specific
gateway that you are configuring or contact the manufacturer.

Model-specific configuration
fields defined by the gateway
manufacturer

Cisco Catalyst 6000 24 Port FXS Gateway Template Field Descriptions
The following table lists configuration settings for CiscoCatalyst 6000 24 port FXS gateway template.

Table 37: CiscoCatalyst 6000 24 Port FXS Gateway Configuration Settings

DescriptionField

Enter the purpose of the device. The description can include up to 50
characters in any language, but it cannot include double-quotes ("),
percentage sign (%), ampersand (&), back-slash (\), or angle brackets
(<>).

Description

From the drop-down list box, select the appropriate device pool.

The device pool specifies a collection of properties for this device that
includes CommunicationsManager Group, Date/TimeGroup, Region,
and Calling Search Space for auto-registration of devices.

Device Pool

Choose the common device configuration to which you want this
gateway assigned. The common device configuration includes the
attributes (services or features) that are associated with a particular
user. You configure the common device configurations in theCommon
Device Configuration window.

To see the common device configuration settings, click the View
Details link.

Common Device Configuration

This list provides a prioritized grouping of media resource groups. An
application chooses the required media resource, such as a Music On
Hold server, from among the available media resources according to
the priority order that a Media Resource Group List defines.

Media Resource Group List

Choose the network hold audio source for this group of IP gateways.

The network hold audio source identifies the audio source fromwhich
music is played when the system places a call on hold, such as when
the user transfers or parks a call.

Network Hold MOH Audio Source
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DescriptionField

From the drop-down list box, select the appropriate calling search
space. The calling search space specifies a collection of partitions that
are searched to determine how a collected (originating) number should
be routed.

You can configure the number of calling search spaces that display in
this drop-down list box by using the Max List Box Items enterprise
parameter. If more calling search spaces exist than the Max List Box
Items enterprise parameter specifies, the ellipsis button (...) displays
next to the drop-down list box. Click the... button to display the Select
Calling Search Space window. Enter a partial calling search space
name in the List items where Name contains field. Click the desired
calling search space name in the list of calling search spaces that
displays in the Select item to use box and click OK.

To set the maximum list box items, choose System >
Enterprise Parameters and choose UnifiedCMAdmin
Parameters.

Note

Calling Search Space

Choose the appropriate calling search space for the device to use when
it performs automated alternate routing (AAR). The AAR calling
search space specifies the collection of route partitions that are searched
to determine how to route a collected (originating) number that is
otherwise blocked due to insufficient bandwidth.

AAR Calling Search Space

Select the appropriate location for this device. The location specifies
the total bandwidth that is available for calls to and from this location.
A location setting of None means that the locations feature does not
keep track of the bandwidth that this device consumes.

Location

Choose the automated alternate routing (AAR) group for this device.
The AAR group provides the prefix digits that are used to route calls
that are otherwise blocked due to insufficient bandwidth. An AAR
group setting of None specifies that no rerouting of blocked calls will
be attempted.

AAR Group

From the drop-down list box, choose the locale that is associated with
the gateway. The network locale identifies a set of detailed information
to support the hardware in a specific location. The network locale
contains a definition of the tones and cadences that the device uses in
a specific geographic area.

Choose only a network locale that is already installed
and supported by the associated devices. The list contains
all available network locales for this setting, but not all
are necessarily installed. If the device is associated with
a network locale that it does not support in the firmware,
the device will fail to come up.

Note

Network Locale
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DescriptionField

From the drop-down list box, enable or disable whether Cisco Unified
Communications Manager inserts a trusted relay point (TRP) device
with this media endpoint. Choose one of the following values:

• Default—If you choose this value, the device uses the Use Trusted
Relay Point setting from the common device configuration with
which this device associates.

• Off—Choose this value to disable the use of a TRP with this
device. This setting overrides the Use Trusted Relay Point setting
in the common device configuration with which this device
associates.

• On—Choose this value to enable the use of a TRP with this
device. This setting overrides the Use Trusted Relay Point setting
in the common device configuration with which this device
associates.

A Trusted Relay Point (TRP) device designates an MTP or transcoder
device that is labeled as Trusted Relay Point.

Cisco Unified Communications Manager places the TRP closest to
the associated endpoint device if more than one resource is needed for
the endpoint (for example, a transcoder or RSVP Agent).

If both TRP and MTP are required for the endpoint, TRP gets used as
the required MTP.

Use Trusted Relay Point

Choose the order in which ports are chosen. If you are not sure which
port order to use, choose TOP_DOWN:

• TOP_DOWN—Selects ports in descending order, from port 1 to
port 8.

• BOTTOM_UP—Selects ports in ascending order, from port 8 to
port 1.

Port Selection Order

Enter the appropriate firmware load information for the gateway.

The values that you enter here override the default values for this
gateway.

Load Information
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DescriptionField

This device uses the user locale setting of the device's device pool to
determine whether to send unicode and whether to translate received
unicode information.

For the sending device, if you check this check box and the user locale
setting in the device's device pool matches the terminating phone's
user locale, the device sends unicode. If the user locale settings do not
match, the device sends ASCII.

The receiving device translates incoming unicode characters based on
the user locale setting of the sending device's device pool. If the user
locale setting matches the terminating phone's user locale, the phone
displays the characters.

The phone may display junk characters if the two ends
of the trunk configure user locales that do not belong to
the same language group.

Note

Transmit UTF-8 for Calling Party
Name

This setting allows you to localize the calling party number on the
device. Make sure that the Calling Party Transformation CSS that you
choose contains the calling party transformation pattern that you want
to assign to this device.

The device takes on the attributes of the Calling Party Transformation
Pattern when you assign the pattern to a partition where the Calling
Party Transformation CSS exists.

Calling Party Transformation CSS

To use the Calling Party Transformation CSS that is configured in the
device pool that is assigned to this device, check this check box. If
you do not check this check box, the device uses the Calling Party
Transformation CSS that you configured in the device configuration
window.

Use Device Pool Calling Party
Transformation CSS

Multilevel Precedence and Preemption (MLPP) Information

From the drop-down list box, choose an MLPP domain to associate
with this device. If you leave the value <None>, this device inherits
its MLPP domain from the value that was set for the device's device
pool. If the device pool does not have an MLPP Domain setting, this
device inherits its MLPP Domain from the value that was set for the
MLPP Domain Identifier enterprise parameter.

MLPP Domain

This device type does not have this setting.MLPP Indication

This setting does not have this device type.MLPP Preemption

Geo Location Configuration
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From the drop-down list box, select a geo location.

You can select the Unspecified geo location, which designates that
this device does not associate with a geo location.

You can also select a geo location that has been configured with the
System > Geolocation Configuration menu option.

Geo Location

From the drop-down list box, select a geo location filter.

If you leave the <None> setting, no geo location filter gets applied for
this device.

You can also select a geo location filter that has been configured with
the System > Geolocation Filter menu option.

Geo Location Filter

FXS/FXO Port Configuration Field Descriptions
The following table provides detailed descriptions for FXS/FXO port configuration settings.

For the VG200 gateway, not all switch emulation types support the network side. How you configure the
gateway switch type determines whether you may or may not be able to set network side.

Table 38: FXS/FXO Port Configuration Settings

DescriptionField

Device Information

For VG200 gateways, this display-only field contains a string that
Cisco Unified Communications Manager generates that uniquely
identifies the VG200 analog interface.

End-Point Name

Cisco Unified Communications Manager generates a string that
uniquely identifies the analog MGCP description.

For example:

AALN/S0/SU1/1@domain.com

You can edit this field. The description can include up to 50 characters
in any language, but it cannot include double-quotes ("), percentage
sign (%), ampersand (&), back-slash (\), or angle brackets (<>).

Description

From the drop-down list box, choose the appropriate device pool.

The device pool specifies a collection of properties for this device
including Communications Manager Group, Date/Time Group,
Region, and Calling Search Space for auto registration of devices.

Device Pool

This list provides a prioritized grouping of media resource groups.
An application chooses the required media resource, such as a Music
On Hold server, from among the available media resources according
to the priority order that is defined in a Media Resource Group List.

Media Resource Group List
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Configure this field only when you need to troubleshoot encrypted
signaling information for the Cisco IOSMGCP gateway. Configuring
packet capturing may cause call-processing interruptions. For more
information about this field, see the Cisco Unified Communications
Manager Security Guide.

Packet CaptureMode (for Cisco IOS
MGCP gateways only)

Configure this field only when you need to troubleshoot encrypted
signaling information for the Cisco IOSMGCP gateway. Configuring
packet capturing may cause call-processing interruptions. For more
information about this field, see the Cisco Unified Communications
Manager Security Guide.

Packet Capture Duration (for Cisco
IOS MGCP gateways only)

From the drop-down list box, choose the appropriate calling search
space. A calling search space comprises a collection of route partitions
that are searched to determine how a collected (originating) number
should be routed.

Calling Search Space

Choose the appropriate calling search space for the device to use when
it performs automated alternate routing (AAR). The AAR calling
search space specifies the collection of route partitions that are
searched to determine how to route a collected (originating) number
that is otherwise blocked due to insufficient bandwidth.

AAR Calling Search Space

Use locations to implement call admission control (CAC) in a
centralized call-processing system. CAC enables you to regulate audio
quality and video availability by limiting the amount of bandwidth
that is available for audio and video calls over links between locations.
The location specifies the total bandwidth that is available for calls
to and from this location.

From the drop-down list box, choose the appropriate location for this
device.

A location setting of Hub_None means that the locations feature does
not keep track of the bandwidth that this device consumes. A location
setting of Phantom specifies a location that enables successful CAC
across intercluster trunks that use H.323 or SIP protocol.

To configure a new location, use the System >Locationmenu option.

Location

Choose the automated alternate routing (AAR) group for this device.
The AAR group provides the prefix digits that are used to route calls
that are otherwise blocked due to insufficient bandwidth. An AAR
group setting of None specifies that no rerouting of blocked calls will
be attempted.

AAR Group
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From the drop-down list box, choose the locale that is associated with
the gateway. The network locale identifies a set of detailed information
to support the hardware in a specific location. The network locale
contains a definition of the tones and cadences that the device uses in
a specific geographic area.

Choose only a network locale that is already installed
and that the associated devices support. The list contains
all available network locales for this setting, but not all
are necessarily installed. If the device is associated with
a network locale that it does not support in the firmware,
the device will fail to come up.

Note

Network Locale

From the drop-down list box, enable or disable whether Cisco Unified
Communications Manager inserts a trusted relay point (TRP) device
with this media endpoint. Choose one of the following values:

• Default—If you choose this value, the device uses the Use
Trusted Relay Point setting from the common device
configuration with which this device associates.

• Off—Choose this value to disable the use of a TRP with this
device. This setting overrides the Use Trusted Relay Point setting
in the common device configuration with which this device
associates.

• On—Choose this value to enable the use of a TRP with this
device. This setting overrides the Use Trusted Relay Point setting
in the common device configuration with which this device
associates.

A Trusted Relay Point (TRP) device designates anMTP or transcoder
device that is labeled as Trusted Relay Point.

Cisco Unified Communications Manager places the TRP closest to
the associated endpoint device if more than one resource is needed
for the endpoint (for example, a transcoder or RSVP Agent).

If both TRP and RSVP Agent are needed for the endpoint, Cisco
Unified Communications Manager first tries to find an RSVP Agent
that can also be used as a TRP.

If both TRP and transcoder are needed for the endpoint, Cisco Unified
Communications Manager first tries to find a transcoder that is also
designated as a TRP.

Use Trusted Relay Point
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This device uses the user locale setting of the device pool for the
device to determine whether to send unicode and whether to translate
received unicode information.

For the sending device, if you check this check box and the user locale
setting in the device pool for the device matches the terminating phone
user locale, the device sends unicode. If the user locale settings do
not match, the device sends ASCII.

The receiving device translates incoming unicode characters based
on the user locale setting of the sending device pool for the device.
If the user locale setting matches the terminating phone user locale,
the phone displays the characters.

The phone may display junk characters if the two ends
of the trunk configure user locales that do not belong to
the same language group.

Note

Transmit UTF-8 for Calling Party
Name

This setting, which displays for FXS ports (not FXO ports), allows
you to localize the calling party number on the device. Make sure that
the Calling Party Transformation CSS that you choose contains the
calling party transformation pattern that you want to assign to this
device.

Before the call occurs, the device must apply the
transformation by using digit analysis. If you configure
the Calling Party Transformation CSS as None, the
transformation does not match and does not get applied.
Ensure that you configure the Calling Party
Transformation Pattern in a non-null partition that is not
used for routing.

Tip

Calling Party Transformation CSS

To use the Calling Party Transformation CSS that is configured in
the device pool that is assigned to this device, check this check box.
If you do not check this check box, the device uses the Calling Party
Transformation CSS that you configured in the Gateway
Configuration window.

This settings displays for FXS ports, not FXO ports.

Use Device Pool Calling Party
Transformation CSS

Check this check box to make this device a Hotline device. Hotline
devices can only connect to other Hotline devices. This feature is an
extension of PLAR, which configures a phone to automatically dial
one directory number when it goes off-hook. Hotline provides
additional restrictions that you can apply to devices that use PLAR.

To implement Hotline, youmust also create a softkey template without
supplementary service softkeys, and apply it to the Hotline device.

Hotline Device

Multilevel Precedence and Preemption (MLPP) Information
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From the drop-down list box, select an MLPP domain to associate
with this device. If you leave the value <None>, this device inherits
its MLPP domain from the value set for the device pool for the device.
If the device pool does not have anMLPPDomain setting, this device
inherits its MLPP Domain from the value set for the MLPP Domain
Identifier enterprise parameter.

MLPP Domain

Be aware that this setting is not available for all devices. If available,
this setting specifies whether a device that can play precedence tones
will use the capability when it places an MLPP precedence call.

From the drop-down list box, choose a setting to assign to this device
from the following options:

• Default—This device inherits its MLPP indication setting from
its device pool.

• Off—This device does not handle nor process indication of an
MLPP precedence call.

• On—This device does handle and process indication of anMLPP
precedence call.

Do not configure a device with the following
combination of settings: MLPP Indication is set to Off
or Default (when default is Off) whileMLPP Preemption
is set to Forceful.

Note

MLPP Indication

Be aware that this setting is not available for all devices. If available,
this setting specifies whether a device that can preempt calls in
progress will use the capability when it places an MLPP precedence
call.

From the drop-down list box, choose a setting to assign to this device
from the following options:

• Default—This device inherits its MLPP preemption setting from
its device pool.

• Disabled—This device does not allow preemption of lower
precedence calls to take place when necessary for completion of
higher precedence calls.

• Forceful—This device allows preemption of lower precedence
calls to take place when necessary for completion of higher
precedence calls.

Do not configure a device with the following
combination of settings: MLPP Indication is set to Off
or Default (when default is Off) whileMLPP Preemption
is set to Forceful.

Note

MLPP Preemption

Port Information (POTS)
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Choose the direction of calls that are passing through this port:

• Inbound—Use for incoming calls only.
• Outbound—Use for outgoing calls.
• Bothways—Use for inbound and outbound calls (default).

Port Direction

Enter the prefix digits that are appended to the digits that this trunk
receives on incoming calls.

Cisco Unified Communications Manager adds prefix digits after first
truncating the number in accordance with the Num Digits setting.

You can enter the international escape character +.

Prefix DN(for FXS ports)

Enter the number of significant digits to collect, from 0 to 32.

Cisco Unified Communications Manager counts significant digits
from the right (last digit) of the number called.

Use this field for the processing of incoming calls and to indicate the
number of digits starting from the last digit of the called number that
is used to route calls coming into the PRI span. See Prefix DN.

Num Digits(for FXS ports)

Enter the number of digits that are expected on the inbound side of
the trunk. For this rarely used field, leave zero as the default value if
you are unsure.

Expected Digits(for FXS ports)

Use this field for analog access ports that connect to a voice-messaging
system.

Set the SMDI Port Number equal to the actual port number on the
voice-messaging system to which the analog access port connects.

Voice-mail logical ports typically must match physical
ports for the voice-messaging system to operate
correctly.

Note

SMDI Port Number (0-4096)

Check this check box to indicate an unattended port on this device.Unattended Port

Geo Location Configuration

From the drop-down list box, choose a geo location.

You can choose the Unspecified geo location, which designates that
this device does not associate with a geo location.

You can also choose a geolocation that has been configured with the
System > Geolocation Configuration menu option.

Geo Location
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From the drop-down list box, choose a geo location filter.

If you leave the <None> setting, no geo location filter gets applied
for this device.

You can also choose a geo location filter that has been configured
with theSystemGeolocation Filter menu option.

This field is not supported for FXS gateways.Note

Geo Location Filter

Product-Specific Configuration

The gateway manufacturer specifies the model-specific fields under
product-specific configuration. Because they are dynamically
configured, they can change without notice.

To view field descriptions and help for product-specific configuration
items, click the “?” information icon to the right of the Product Specific
Configuration heading to display help in a popup dialog box.

If you need more information, refer to the documentation for the
specific gateway that you are configuring or contact the manufacturer.

Model-specific configuration fields
defined by the gatewaymanufacturer

Digital Access T1 Trunks on Cisco VG200 Gateway Template Field Descriptions
The following table provides detailed field descriptions for adding or updating values for the T1 CAS trunks
on a CiscoVG200 gateway.

Some fields display the values that were configured in CiscoUnified CommunicationsManager Administration.

In the BAT user interface, field names that have an asterisk require an entry. Consider an entry in fields without
an asterisk as optional.

Table 39: Digital Access T1 (T1-CAS) Configuration Settings

DescriptionField

For VG200 gateways, this display-only field contains a string that Cisco
Unified Communications Manager generates that uniquely identifies
the VG200 digital interface.

For example:

S1/DS1-0@VG200-2

S1 indicates slot 1, DS1-0 designates the digital interface, and @VG200-2
designates the VG200 template name.

End-Point Name

Enter a description that clarifies the purpose of the device. The
description can include up to 50 characters in any language, but it cannot
include double-quotes ("), percentage sign (%), ampersand (&), back-slash
(\), or angle brackets (<>).

Description
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From the drop-down list box, choose the appropriate device pool.

The device pool specifies a collection of properties for this device
including CommunicationsManager Group, Date/TimeGroup, Region,
and Calling Search Space for auto-registration of devices.

Device Pool

This parameter determines whether an incoming call that is using this
gateway is considered off the network (OffNet) or on the network
(OnNet).

When the Call Classification field is configured as Use System Default,
the setting of the Cisco Unified Communications Manager clusterwide
service parameter, Call Classification, determines whether the gateway
is OnNet or OffNet.

This field provides an OnNet or OffNet alerting tone when the call is
OnNet or OffNet, respectively.

Call Classification

This list provides a prioritized grouping of media resource groups. An
application chooses the required media resource, such as a Music On
Hold server, from among the available media resources according to
the priority order that is defined in a Media Resource List.

Media Resource Group List

From the drop-down list box, choose the appropriate calling search
space. A calling search space designates a collection of route partitions
that are searched to determine how a collected (originating) number
should be routed.

You can configure the number of calling search spaces that display in
this drop-down list box by using the Max List Box Items enterprise
parameter. If more calling search spaces exist than the Max List Box
Items enterprise parameter specifies, the ellipsis button (...) displays
next to the drop-down list box. Click the... button to display the Select
Calling Search Space window. Enter a partial calling search space
name in the List items where Name contains field. Click the desired
calling search space name in the list of calling search spaces that displays
in the Select item to use box and click OK.

To set the maximum list box items, choose System >
Enterprise Parameters and choose UnifiedCMAdmin
Parameters.

Note

Calling Search Space

Choose the appropriate calling search space for the device to use when
automated alternate routing (AAR) is performed. The AAR calling
search space specifies the collection of route partitions that are searched
to determine how to route a collected (originating) number that is
otherwise blocked due to insufficient bandwidth.

AAR Calling Search Space

Choose the appropriate location for this device. The location specifies
the total bandwidth that is available for calls to and from this location.
A location setting of None means that the locations feature does not
keep track of the bandwidth that this device consumes.

Location
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Choose the automated alternate routing (AAR) group for this device.
The AAR group provides the prefix digits that are used to route calls
that are otherwise blocked due to insufficient bandwidth. An AAR group
setting of None specifies that no rerouting of blocked calls will be
attempted.

AAR Group

From the drop-down list box, choose anMLPP domain to associate with
this device. If you leave the value <None>, this device inherits its MLPP
domain from the value that was set for the device's device pool. If the
device pool does not have anMLPPDomain setting, this device inherits
its MLPP Domain from the value that was set for the MLPP Domain
Identifier enterprise parameter.

MLPP Domain

Check this box to enable this gateway to interpret special DTMF signals
as MLPP precedence levels.

HandleDTMFPrecedence Signals

Enter the appropriate firmware load information for the gateway.

The values that you enter here override the default values for this
gateway.

Load Information

Choose the order in which channels or ports are allocated for outbound
calls from first (lowest number port) to last (highest number port) or
from last to first.

Valid entries include TOP_DOWN (first to last) or BOTTOM_UP (last
to first). If you are not sure which port order to use, choose TOP_DOWN.

Port Selection Order

Choose one of the following digit sending types for out-dialing:

• DTMF—Dual-tone multifrequency. Normal touchtone dialing
• MF—Multifrequency
• PULSE—Pulse (rotary) dialing

Digit Sending

From the drop-down list box, choose the locale that is associated with
the gateway. The network locale identifies a set of detailed information
to support the hardware in a specific location. The network locale
contains a definition of the tones and cadences that the device uses in a
specific geographic area.

Choose only a network locale that is already installed and
supported by the associated devices. The list contains all
available network locales for this setting, but not all are
necessarily installed. If the device is associated with a
network locale that it does not support in the firmware, the
device will fail to come up.

Note

Network Locale

Enter the first SMDI port number of the T1 span.

If you set this parameter to a nonzero value and this gateway belongs
to an unknown type of route list, route group, or route list, hunting does
not continue past this span.

SMDI Base Port
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Geo Location Configuration

From the drop-down list box, choose a geo location.

You can choose the Unspecified geo location, which designates that this
device does not associate with a geo location.

You can also choose a geolocation that has been configured with the
System > Geolocation Configuration menu option.

Geo Location

From the drop-down list box, choose a geo location filter.

If you leave the <None> setting, no geo location filter gets applied for
this device.

You can also choose a geo location filter that has been configured with
the System > Geolocation Filter menu option.

Geo Location Filter

Product-Specific Configuration

The gateway manufacturer specifies the model-specific fields under
product-specific configuration. Because they are dynamically configured,
they can change without notice.

To view field descriptions and help for product-specific configuration
items, click the “?” information icon to the right of the Product Specific
Configuration heading to display help in a popup dialog box.

If you need more information, refer to the documentation for the specific
gateway that you are configuring or contact the manufacturer.

Model-specific configuration
fields that the gateway
manufacturer defines

T1 PRI or E1 PRI Trunks on Cisco VG200 Gateway Template Field Descriptions
The following table provides field descriptions for adding or updating values for T1 PRI or E1 PRI trunks on
a Cisco VG200 gateway.

Some fields display the values that were configured in CiscoUnified CommunicationsManager Administration.

In the BAT user interface, field names that have an asterisk require an entry. Consider an entry in fields without
an asterisk as optional.

Table 40: Field Descriptions for T1 PRI or E1 PRI Trunks

DescriptionField

Device Information
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For VG200 gateways, this display-only field contains a string
that is generated by Cisco Unified CommunicationsManager
that uniquely identifies the VG200 endpoint.

For example:

S1/DS1-0@VG200-2

S1 indicates slot 1, DS1-0 designates the digital interface,
and @VG200-2 designates the VG200 domain name.

Endpoint Name

Enter a description for the end-point that you are configuring.
The description can include up to 50 characters in any
language, but it cannot include double-quotes ("), percentage
sign (%), ampersand (&), back-slash (\), or angle brackets
(<>).

Description

Choose the device pool for this group of gateways/ports.

A device pool defines sets of common characteristics for
devices, such as region, date/time group, Cisco Unified
Communications Manager group, and calling search space
for auto-registration.

Device Pool

From the drop-down list box, choose an option to configure
the device as on net, off net, or system default.

If you chose 'Use System Default' at the device level, the
system uses the value of the service parameter to determine
whether the device is internal (on net) or external (off net).

Call Classification

Choose the network locale that you want to associate with
this gateway.

The Network Locale comprises a set of tones and cadences
that Cisco gateways and phones use when communicating
with the PSTN and other networks in a specific geographical
area.

Network Locale

Choose the media resource group list (MRGL) for this group
of gateways/ports.

An MRGL specifies a list of prioritized media resource
groups. An application can choose required media resources
from among the available ones according to the priority order
that is defined in the MRGL.

Media Resource Group List

Choose the location for this group of gateways/ports.

A location indicates the remote location that is accessed by
using restricted bandwidth connections.

Location
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Choose the automated alternate routing (AAR) group for this
device. The AAR group provides the prefix digits that are
used to route calls that are otherwise blocked due to
insufficient bandwidth. An AAR group setting of None
specifies that no rerouting of blocked calls will be attempted.

AAR Group

Enter the appropriate load information for the custom
software for gateway. The values that you enter here override
the default values for this gateway.

To use the default load, leave this field blank.

Load Information

This device uses the user locale setting of the device's device
pool to determine whether to send Unicode and whether to
translate received Unicode information.

For the sending device, if you check this check box and the
user locale setting in the device's device pool matches the
terminating phone's user locale, the device sends Unicode.
If the user locale settings do not match, the device sends
ASCII.

The receiving device translates incoming Unicode characters
based on the user locale setting of the sending device's device
pool. If the user locale settingmatches the terminating phone's
user locale, the phone displays the characters.

The phone may display junk characters if the two ends of the
trunk configure user locales that do not belong to the same
language group.

Transmit UTF-8 for Calling Party
Name

Multilevel Precedence and Preemption (MLPP) Information

Enter a hexadecimal value for the MLPP domain that is
associated with this device. Ensure that the value is blank or
a value between 0 and FFFFFF.

MLPP Domain (e.g., “0000FF”)

Interface Information
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Choose the communications protocol for the span:

For E1 PRI spans, you have these options:

• PRI AUSTRALIAN—Australian ISDN
• PRI EURO—European ISDN
• PRI ISO QSIG E1—European inter-PBX signaling
protocol

For T1 PRI spans you have several options, depending on
the carrier or switch:

• PRI 4ESS —AT&T interexchange carrier, Lucent
Definity switch

• PRI 5E8 Custom—CiscoUnifiedIPPhone, Nortel
Meridian switch, Lucent Definity switches

• PRI 5E8 Teleos—Madge Teleos box
• PRI 5E8 Intecom—Intecom PBX
• PRI5E9—AT&T family local exchange switch or carrier
• PRI NI2—Sprint local exchange switch or carrier
• PRI DMS-100—Sprint local exchange switch or carrier
• PRI DMS-250—MCI and Sprint local exchange switch
or carrier

• PRI ETSI SC—European local exchange carrier on T1;
also, Japanese local exchange.

• PRI ISO QSIG T1—Inter-PBX signaling protocol

PRI Protocol Type

Choose the appropriate protocol side. This setting specifies
whether the gateway connects to a Central Office/Network
device or to a User device.

Make sure that the two ends of the PRI connection use
opposite settings. For example, if you connect to a PBX and
the PBX uses User as its protocol side, choose Network for
this device. Typically, use User for Central Office (CO)
connections.

Protocol Side

Choose the order in which channels or ports are enabled from
first (lowest number port) to last (highest number port) or
from last to first.

Valid entries include TOP_DOWN (last to first) or
BOTTOM_UP (first to last). If you are not sure which port
order to use, choose TOP_DOWN. The default specifies
BOTTOM_UP.

Channel Selection Order
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Choose one of the following values to specify whether
channel selection is presented as a channel map or a slot map:

• Number—B-channel usage always presents a channel
map format.

• Slotmap—B-channel usage always presents a slotmap
format.

• Use Number When 1B—Channel usage presents a
channel map for one B-channel but presents a slotmap
if more than one B-channel exists. This represents the
default value.

Channel IE Type

Specify the digital encoding format. Choose one of the
following formats:

• a-law: Use for Europe and the rest of the world.
• mu-law: Use for North America, HongKong, Taiwan,
and Japan.

PUnifiedCMType

For this optional field, enter the rate, in 1/8-second
increments, at which the spans are brought in service. The
delay occurs when many PRI spans are enabled on a system
and the Inhibit Restarts at PRI Initialization check box is
unchecked. The default value specifies 32.

For example, set the first five cards to 0 and set the next five
cards to 16. (Wait 2 seconds before bringing them in service.)

Delay for First Restart

Enter the time, in 1/8-second increments, between restarts.
The delay occurs when a PRI RESTART is sent if the Inhibit
Restarts check box is unchecked. The default value specifies
4.

Delay Between Restarts

A restart message confirms the status of the ports on a PRI
span. If RESTARTS are not sent, Cisco Unified
Communications Manager assumes that the ports are in
service. By default, the box gets checked.

When the D-channel successfully connects with another PRI
trunk D-channel, it sends restarts when this box is unchecked.

Inhibit Restarts at PRI Initialization

Check the check box to enable the Cisco Unified
Communications Manager advanced service parameter,
Change B-Channel Maintenance Status. This service
parameter allows you to take individual B-channels out of
service while the B-channels are active.

Uncheck this check box to disable the service parameter
Change B-Channel Maintenance Status.

Default leaves this field unchecked.

Enable Status Poll
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Check this check box to indicate an unattended port on this
device.

Unattended Ports

Call Routing Information - Inbound Calls

This field represents the number of final digits that a PRI
span should retain on inbound calls. A trunk with significant
digits enabled truncates all but the final few digits of the
address that is provided on an inbound call.

Enable or disable this check box depending on whether you
want to collect significant digits:

• If you do not check the check box, Cisco Unified
CommunicationsManager does not truncate the inbound
number.

• If you check the check box, you also need to choose the
number of significant digits to collect. By default, the
box remains checked.

Significant Digits

Choose the calling search space for this group of
phones/ports.

A calling search space specifies the collection of Route
Partitions that are searched to determine how a dialed number
should be routed.

Calling Search Space

Choose the appropriate calling search space for the device
to use when it performs automated alternate routing (AAR).
The AAR calling search space specifies the collection of
route partitions that are searched to determine how to route
a collected (originating) number that is otherwise blocked
due to insufficient bandwidth.

AAR Calling Search Space

For this optional field, enter the prefix digits that are
appended to the digits that this trunk receives on incoming
calls.

Cisco Unified Communications Manager adds prefix digits
after first truncating the number in accordance with the Num
Digits setting.

Prefix DN

Call Routing Information - Outbound Calls

Choosewhether youwant the CiscoUnified Communications
Manager to transmit or block the caller’s phone number.

Choose Default if you do not want to change calling line ID
presentation. Choose Allowed if you want Cisco Unified
Communications Manager to send “Calling Line ID
Allowed.” Choose Restricted if you want Cisco Unified
Communications Manager to send “Calling Line ID
Restricted.”

Calling Line ID Presentation
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DescriptionField

Any outbound call on a gateway can send directory number
information. Choose which directory number is sent:

• Originator—Send the directory number of the calling
device. This number serves as the default value.

• First Redirect Number—Send the directory number of
the redirecting device.

• Last Redirect Number—Send the directory number of
the last device that redirected the call.

Calling Party Selection

Choose the format for the type of number in calling party
directory numbers.

Cisco Unified Communications Manager sets the calling
directory number (DN) type. Cisco recommends that you do
not change the default value unless you have advanced
experience with dialing plans, such as NANP or the European
dialing plan. You may need to change the default in Europe
because Cisco Unified Communications Manager does not
recognize European national dialing patterns. You can also
change this setting when you are connecting to PBXs that
are using routing as a non-national type number.

Choose one of the following options:

• Communications Manager—The Cisco Unified
Communications Manager sets the directory number
type. This option represents the default value.

• International—Use when you are dialing outside the
dialing plan for your country.

• National—Use when you are dialing within the dialing
plan for your country.

• Unknown—This option specifies that the dialing plan
is unknown.

Calling Party IE Number Type
Unknown
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DescriptionField

Choose the format for the type of number in called party
directory numbers. Cisco Unified CommunicationsManager
sets the called directory number (DN) type. Cisco
recommends that you do not change the default value unless
you have extensive experience with dialing plans, such as
NANP or the European dialing plan. Youmay need to change
the default in Europe because CiscoUnified Communications
Manager does not recognize European national dialing
patterns. You can also change this setting when you are
connecting to PBXs that use routing as a non-national type
number.

Choose one of the following options:

• CommunicationsManager—For the default setting, the
Cisco Unified Communications Manager sets the
directory number type.

• International—Use when you are dialing outside the
dialing plan for your country.

• National—Use when you are dialing within the dialing
plan for your country.

• Unknown—This option specifies that the dialing plan
is unknown.

Called Party IE Number Type
Unknown

Choose the format for the numbering plan in called party
directory numbers.

Cisco Unified Communications Manager sets the called DN
numbering plan. Cisco recommends that you do not change
the default value unless you have extensive experience with
dialing plans, such as NANP or the European dialing plan.
Youmay need to change the default in Europe because Cisco
Unified Communications Manager does not recognize
European national dialing patterns. You can also change this
setting when you are connecting to PBXs that are using
routing as a non-national type number.

Choose one of the following options:

• CommunicationsManager—For the default setting, the
Cisco Unified Communications Manager sets the
Numbering Plan in the directory number.

• ISDN—Use when you are dialing outside the dialing
plan for your country.

• National Standard—Use when you are dialing within
the dialing plan for your country.

• Private—Use when you are dialing within a private
network.

• Unknown—This option specifies that the dialing plan
is unknown.

Called Numbering Plan
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DescriptionField

Choose the format for the numbering plan in calling party
directory numbers.

Cisco Unified CommunicationsManager sets the calling DN
numbering plan. Cisco recommends that you do not change
the default value unless you have extensive experience with
dialing plans, such as NANP or the European dialing plan.
Youmay need to change the default in Europe because Cisco
Unified Communications Manager does not recognize
European national dialing patterns. You can also change this
setting when you are connecting to PBXs that are using
routing as a non-national type number.

Choose one of the following options:

• CommunicationsManager—For the default setting, the
Cisco Unified Communications Manager sets the
Numbering Plan in the directory number.

• ISDN—Use when you are dialing outside the dialing
plan for your country.

• National Standard—Use when you are dialing within
the dialing plan for your country.

• Private—Use when you are dialing within a private
network.

• Unknown—This option specifies that the dialing plan
is unknown.

Calling Numbering Plan

Choose the number of digits, from 0 to 32, to strip on
outbound calls. The default value specifies 0.

For example, 8889725551234 is dialed; the number of digits
to strip is 3. In this example, Cisco Unified Communications
Manager strips 888 from the outbound number.

Number of Digits to Strip

Enter the pattern, from 0 to 24 digits, that you want to use
for caller ID.

For example, in North America

• 555XXXX = Variable caller ID, where X equals an
extension number. The CO appends the number with
the area code if you do not specify it.

• 5555000 = Fixed caller ID, for when you want the
Corporate number to be sent instead of the exact
extension fromwhich the call is placed. The CO appends
the number with the area code if you do not specify it.

Caller ID DN

Enter the first SMDI port number of the T1 span.SMDI Base Port

PRI Protocol Type Specific Information
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DescriptionField

For this optional field, check the check box to enable delivery
of the display information element (IE) in SETUP and
CONNECT messages for the calling and called party name
delivery service. By default, the box remains unchecked.

Display IE Delivery

For this optional field, check the check box to include the
Redirecting Number IE in the SETUP message to indicate
the first redirecting number and the redirecting reason of the
call when a call is forwarded. By default, the box remains
unchecked.

This setting applies to the SETUP message only on all
protocols for digital access gateways.

Redirecting Number IE
Delivery—Outbound

For this optional field, check the check box to include the
Redirecting Number IE in the SETUP message to indicate
the first redirecting number and the redirecting reason of the
call when a call is forwarded. By default, the box remains
unchecked.

This setting applies to the SETUP message only on all
protocols for digital access gateways.

Redirecting Number IE
Delivery—Inbound

Check this check box to include a special leading character
byte (non ASCII, nondisplayable) in the DisplayIE field.

Uncheck this check box to exclude this character byte from
the DisplayIE field.

This check box only applies to the DMS-100 protocol and
the DMS-250 protocol.

Default leaves this setting disabled (unchecked).

Send Extra Leading Character in
Display IE

For this optional field, you may need to specify a value in
this field to force ringback on some PBXs.

The default specifies unchecked. Check this check box only
if users are not receiving ringback tones on outbound calls.

When this setting is enabled, Cisco Unified Communications
Manager sends Q.931 setup messages out digital (that is,
non-H.323) gateways with the Progress Indicator field set to
non-ISDN.

This message notifies the destination device that the Cisco
Unified CommunicationsManager gateway is non-ISDN and
that the destination device should play inband ringback.

This problem usually associates with Cisco Unified
Communications Managers that connect to PBXs through
digital gateways.

Setup of Non-ISDN Progress
Indicator IE Enable
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DescriptionField

This field applies to DMS-100 protocol only. Check the check
box to indicate that an Interface Identifier is present. By
default, the box remains unchecked.

MCDN Channel Number Extension
Bit Set to Zero

This field applies to DMS-100 protocol only. Enter the value
that you obtained from the PBX provider. Valid values range
from 0 to 255.

Send Calling Name in Facility IE

This field applies to DMS-100 protocol only. Check the check
box to indicate that an Interface Identifier is present. By
default, the box remains unchecked.

Interface Identifier Present

This field applies to DMS-100 protocol only. Enter the value
that you obtained from the PBX provider. Valid values range
from 0 to 255.

Interface Identifier Value

Choosewhether youwant the CiscoUnified Communications
Manager to allow or block the connected party’s phone
number.

Choose Default if you do not want to change the connected
line ID presentation. Choose Allowed if you want Cisco
Unified Communications Manager to send “Connected Line
ID Allowed.” Choose Restricted if you want Cisco Unified
Communications Manager to send “Connected Line ID
Restricted.”

Connected Line ID Presentation

UUIE Configuration

Check this check box to enable passing MLPP information
through the PRI 4ESS UUIE field. This box is used for
working along with DRSN switch.

The system makes this check box available only if the PRI
Protocol Type value of PRI4ESS is specified for this gateway.

The default value specifies unchecked.

Passing Precedence Level Through
UUIE

Enter the value for the security access level. Valid values
include 00 through 99. The systemmakes this field available
only if the Passing Precedence Level Through UUIE check
box is checked. The default value specifies 2.

Security Access Level

Geo Location Configuration

From the drop-down list box, choose a geo location.

You can choose the Unspecified geo location, which
designates that this device does not associate with a geo
location.

You can also choose a geolocation that has been configured
with the System >Geolocation Configurationmenu option.

Geo Location
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DescriptionField

From the drop-down list box, choose a geo location filter.

If you leave the <None> setting, no geo location filter gets
applied for this device.

You can also choose a geo location filter that has been
configured with the System > Geolocation Configuration
Filter menu option.

Geo Location Filter

Product-Specific Configuration

The gatewaymanufacturer specifies the model-specific fields under product-specific configuration.
To view field descriptions and help for product-specific configuration items, click the “?”
information icon to the right of the Product Specific Configuration heading to display help in a
popup window. If you need more information, refer to the documentation for the specific gateway
that you are configuring.

Port Configuration Settings
Detailed field descriptions are available for all port types and Cisco-supported gateway configuration settings.

Related Topics
POTS Port Configuration Settings, on page 413
E and M Ports for Digital Access T1 Field Descriptions, on page 415
Gateway Configuration Settings, on page 381
Topics Related to Gateway Configuration Settings, on page 417

POTS Port Configuration Settings
The following table describes the POTS port configuration settings.

Table 41: POTS Port Configuration Settings

DescriptionField

From the Port Type drop-down list box, choose POTS.Port Type

Choose whether you want to add and configure all available ports, a single
port, or a range of ports by setting values for the Beginning Port Number
and Ending Port Number fields:

• To specify a range of ports, choose appropriate values for Beginning
Port Number and Ending Port Number.

• To create a single port, choose the same number in the Beginning
Port Number and Ending Port Number fields.

• To add all available ports, choose All Ports for both the Beginning
Port Number and Ending Port Number fields.

Beginning Port Number

Ending Port Number
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DescriptionField

Choose the direction of calls that pass through this port:

• Inbound—Use for incoming calls only.
• Outbound—Use for outgoing calls.
• Bothways—Use for inbound and outbound calls (default).

Port Direction

This field specifies the gain or loss that is applied to the received audio
signal relative to the port application type.

Improper gain setting may cause audio echo. Use caution
when you are adjusting this setting.

Note

Audio Signal Adjustment into
IP Network

This field specifies the gain or loss that is applied to the transmitted audio
signal relative to the port application type.

Improper gain setting may cause audio echo. Use caution
when you are adjusting this setting.

Note

Audio Signal Adjustment from
IP Network

Enter the prefix digits that are appended to the digits that this trunk receives
on incoming calls.

The Cisco Unified Communications Manager adds prefix digits after it
truncates the number in accordance with the Num Digits setting.

Prefix DN

Enter the number of significant digits to collect, from 0 to 32.

Cisco Unified Communications Manager counts significant digits from
the right (last digit) of the number that is called.

Use this field for the processing of incoming calls and to indicate the
number of digits starting from the last digit of the called number that are
used to route calls that are coming into the PRI span. See Prefix DN.

Num Digits

Enter the number of digits that are expected on the inbound side of the
trunk. For this rarely used field, leave zero as the default value if you are
unsure.

Expected Digits

Call Restart Timer (1000-5000 ms); ms indicates time in milliseconds.Call Restart Timer (1000-5000
ms)

Offhook Validation Timer (100-1000 ms); ms indicates time in
milliseconds.

Offhook Validation Timer
(100-1000 ms)

Onhook Validation Timer (100-1000 ms); ms indicates time in
milliseconds.

Onhook Validation Timer
(100-1000 ms)

Hookflash Timer (100-1500 ms); ms indicates time in milliseconds.Hookflash Timer (100-1500ms)
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DescriptionField

Use this field for analog access ports that connect to a voice-messaging
system.

Set the SMDI Port Number equal to the actual port number on the
voice-messaging system to which the analog access port connects.

Voice-mail logical ports typically must match physical ports
for the voice-messaging system to operate correctly.

Note

SMDI Port Number (0-4096)

Product-Specific Configuration

The gateway manufacturer specifies the model-specific fields under
product-specific configuration. Because they are dynamically configured,
they can change without notice.

To view field descriptions and help for product-specific configuration
items, click the “?” information icon to the right of the Product Specific
Configuration heading to display help in a popup dialog box.

If you need more information, refer to the documentation for the specific
gateway that you are configuring or contact the manufacturer.

Model-specific configuration
fields that the gateway
manufacturer defines

E and M Ports for Digital Access T1 Field Descriptions
Use the following field descriptions when you are adding or updating values for E&M ports for the T1 CAS
trunks on a Cisco VG200 gateway.

Some fields display the values that were configured in CiscoUnified CommunicationsManager Administration.

In the BAT user interface, field names that have an asterisk require an entry. Consider an entry in fields without
an asterisk as optional.

The following table describes the E & M port configuration settings.

Table 42: E and M Port Configuration Settings

DescriptionField

From the Port Type drop-down list box, choose EANDM.Port Type

Choose whether you want to add and configure all available ports, a single
port, or a range of ports by setting values for the Beginning Port Number
and Ending Port Number fields:

• To specify a range of ports, choose appropriate values for Beginning
Port Number and Ending Port Number.

• To create a single port, choose the same number in the Beginning
Port Number and Ending Port Number fields.

• To add all available ports, choose All Ports for both the Beginning
Port Number and Ending Port Number fields.

Beginning Port Number

Ending Port Number

Port Details
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DescriptionField

Choose the direction of calls that pass through this port:

• Inbound—Use for incoming calls only.
• Outbound—Use for outgoing calls.
• Both Ways—Use for inbound and outbound calls.

Port Direction

Any outbound call on a gateway can send directory number information.
Choose which directory number is sent:

• Originator—Send the directory number of the calling device.
• First Redirect Number—Send the directory number of the redirecting
device.

• Last Redirect Number—Send the directory number of the last device
to redirect the call.

• First Redirect Number (External)—Send the directory number of the
first redirecting device with the external phone mask applied.

• Last Redirect Number (External)—Send the directory number of the
last redirecting device with the external phone mask applied.

Calling Party Selection

Choose the caller ID type:

• ANI—Choose this type to use the Asynchronous Network Interface
(ANI) caller ID type.

• DNIS—Choose this type to use the Dialed Number Identification
Service (DNIS) caller ID type.

Caller ID Type

Enter the pattern that you want to use for calling line ID, from 0 to 24
digits.

For example, in North America:

• 555XXXX = Variable calling line ID, where X equals an extension
number. The CO appends the number with the area code if you do
not specify it.

• 5555000 = Fixed calling line ID, where you want the Corporate
number to be sent instead of the exact extension from which the call
is placed. The CO appends the number with the area code if you do
not specify it.

Caller ID DN

Enter the prefix digits that are appended to the called party number on
incoming calls.

The Cisco Unified Communications Manager adds prefix digits after first
truncating the number in accordance with the Num Digits setting.

Prefix DN

Choose the number of significant digits to collect, from 0 to 32. Cisco
Unified CommunicationsManager counts significant digits from the right
(last digit) of the number that is called.

Use this field if you check the Sig Digits check box. Use this field for the
processing of incoming calls and to indicate the number of digits starting
from the last digit of the called number that are used to route calls that are
coming into the PRI span. See Prefix DN and Sig Digits.

Num Digits
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DescriptionField

Enter the number of digits that are expected on the inbound side of the
trunk. If you are unsure, leave zero as the default value for this rarely used
field.

Expected Digits

Check this check box to indicate an unattended port on this device.Unattended Port

Product-Specific Configuration

The gateway manufacturer specifies the model-specific fields under
product-specific configuration. Because they are dynamically configured,
they can change without notice.

To view field descriptions and help for product-specific configuration
items, click the “?” information icon to the right of the Product Specific
Configuration heading to display help in a popup dialog box.

If you need more information, refer to the documentation for the specific
gateway that you are configuring or contact the manufacturer.

Model-specific configuration
fields that the gateway
manufacturer defines

Topics Related to Gateway Configuration Settings
• Cisco Gateway Additions, on page 361

• Find Gateway Template, on page 367

• Add or Edit Gateway Template, on page 368

• Gateway Configuration Settings, on page 381

• Port Configuration Settings, on page 413

• Delete Cisco Gateway Records Using Query, on page 447

• Generate Cisco Gateway Reports, on page 451
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C H A P T E R 50
Gateway File Format

This chapter provides information to use Cisco Unified CommunicationsManager Bulk Administration (BAT)
to configure Cisco gateway file formats in the Cisco Unified Communications Manager database in batches.

• Find Gateway File Format, on page 419
• Gateway File Format Configuration, on page 420
• Associate File Format with CSV Data File, on page 422

Find Gateway File Format
Use BAT to find a gateway file format.

Procedure

Step 1 Choose Bulk Administration > Gateways > Gateway File Format > Create File Format.
The Gateway File Format Find and List window displays.

Step 2 Do one of the following:
a) To find all records in the database, ensure the dialog box is empty; go to Step 3, on page 419.
b) To filter or search records:

1. From the first drop-down list box, select a search parameter.
2. From the second drop-down list box, choose a search pattern.
3. Specify the appropriate search text, if applicable.

To add additional search criteria click the + button. When you add criteria, the system
searches for a record that matches all criteria that you specify. To remove criteria, click
the – button to remove the last added criteria or click the Clear Filter button to remove
all added search criteria.

Note

Step 3 Click Find.

All or matching records display. You can change the number of items that display on each page by choosing
a different value from the Rows per Page drop-down list box.
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You can delete multiple records from the database by checking the check boxes next to the
appropriate record and clicking Delete Selected. You can delete all configurable records for this
selection by clicking Select All and then clicking Delete Selected.

Note

Step 4 From the list of records that display, click the link for the record you want to view.

To reverse the sort order, click the up or down arrow, if available, in the list header.Tip

The window displays the item that you choose.

Gateway File Format Configuration
You can use BAT to create, copy, modify, or delete a gateway file format.

Related Topics
Create Gateway File Format for CSV Data File, on page 420
Copy Existing Gateway File Format, on page 421
Modify Existing Gateway File Format, on page 421
Delete File Format From CSV Data File, on page 422
Topics Related to Gateway Configuration Settings, on page 417

Create Gateway File Format for CSV Data File
You can create a gateway file format for the text-based CSV data file.

Procedure

Step 1 Choose Bulk Administration > Gateways > Gateway File Format > Create File Format.
Step 2 Click Add New.

The Create Gateway File Format window displays.
Step 3 In the Format Name field, enter a name for this custom format.
Step 4 Under Device Fields, choose the device field names that you want to define for each gateway. In the Device

Field box, click a device field name and click the arrow to move the field to the Selected Device Fields box.

Gateway Name and Description are always selected.

You can select several random field names in the list by holding down the Ctrl key, and then
clicking the arrow to select them together. You can select a range of items by using the Shift key.

Tip

Step 5 Click line field names in theLine Field box and click the arrow to move the fields to the Selected Line Fields
box.

Make sure that you select Directory Number if you select Line for the file format.Note

You can change the order of the items in the Selected Line Fields and Selected Device Fields
Order boxes. Select an item and then use the up arrow to move the field closer to the beginning
of the list or the down arrow to move it to the end of the list.

Tip
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Step 6 In the IP Phone Lines Maximums area, enter the maximum values for the Maximum Number of Lines
field.

Step 7 To save your custom file format, click Save. The name of the file format displays in the File Format Names
list in the Gateway File Format Find and List window.

Copy Existing Gateway File Format
You can copy an existing gateway file format.

Procedure

Step 1 Find the gateway file format you want to copy.
Step 2 In the Search Results area, choose a file format that you want to copy.

The Gateway File Format Configuration window displays.
Step 3 To make a copy of the chosen file format, click Copy.

To copy the file format, you can also click the corresponding Copy icon in the Gateway File
Format Find and List window.

Tip

Step 4 In the Format Name field, enter a new name for the copied format.
Step 5 After making your changes, click Save to save the copied file format with changes in the list.

Related Topics
Find Gateway File Format, on page 419
Modify Existing Gateway File Format, on page 421

Modify Existing Gateway File Format
Use BAT to modify an existing gateway file format. You can modify custom file formats only.

Procedure

Step 1 Find the gateway file format that you want to modify.
Step 2 In the Search Results area, choose a file format that you want to modify.

The Gateway File Format Configuration window displays.
Step 3 Modify the format using the following methods:

a) To add new fields, choose them from the Device Fields or Line Fields box, then click the arrow to move
the chosen fields into the Selected Device Field or Selected Line Fields Order box.

b) To remove fields, choose them from the Selected Device Fields or Selected Line Fields Order box, then
click the arrow to move the selected fields into the Device Field or Line Fields box.

You cannot remove the required fields: Gateway Name and Description.Note
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c) To change the order of the fields, choose a field name in the Selected Device Fields Order or Selected
Line Fields Order box and use the up or down arrow to change its location.

Step 4 After making your changes, click Save to save the changes to the file format.

Related Topics
Find Gateway File Format, on page 419

Delete File Format From CSV Data File
Use BAT to delete an existing file format for the CSV data file. You can delete only custom formats.

Procedure

Step 1 Find the gateway file format that you want to delete.
Step 2 In the Search Results area, verify that this is the file(s) that you want to delete.
Step 3 To remove the file format(s) from the list, click Delete Selected. A message asks you to confirm that you

want to delete the file format(s). Click OK to continue.

Make sure to browse the entire list of displayed results before clicking Delete Selected.Note

The system removes the file format(s) name from the list.

Related Topics
Find Gateway File Format, on page 419

Associate File Format with CSV Data File
You can add the file format with the text-based CSV data file.

When you used a text editor to create the CSV data file, you created a file format for entering values in the
text-based file. You entered values in the text file in the order that the file format specified

After the CSV data file is completed, you need to associate the file format with the text-based CSV data file.
After associating the file format with the CSV file, the names for each field display as the first record in the
CSV data file. You can use this information to verify that you entered the values for each field in the correct
order.

Procedure

Step 1 Choose Bulk Administration > Gateways > Gateway File Format > Add File Format.
Add Gateway File Format window displays.

Step 2 In the File Name field, choose the text-based CSV file that you created for this transaction.
Step 3 In the Format File Name field, choose the file format that you created for this type of bulk transaction.
Step 4 To create a job for associating the matching file format with the CSV data file, click Submit.
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Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
Manage Scheduled Jobs, on page 599
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C H A P T E R 51
Gateway Insertions

This chapter provides information to insert Cisco-supported gateways into Cisco Unified Communications
Manager database.

• CSV Data File Creation for Cisco VG200 Gateways, on page 425
• Create CSV Data File for Cisco Catalyst 6000 (FXS) Ports, on page 427
• CSV Data Files Creation for Cisco VG224 Gateways and Ports, on page 428
• CSV Data File Creation for Cisco VG202 and VG204 Gateways, on page 430
• CSV Data Files Creation for Cisco VG310 Gateways and Ports, on page 432
• CSV Data Files Creation for Cisco VG320 Gateways and Ports, on page 434
• CSV Data Files Creation for Cisco VG350 Gateways and Ports, on page 436
• CSV Data File Creation for Cisco VG420 Gateways, on page 438
• CSV Data Files Creation for Cisco VG450 Gateways and Ports, on page 440
• CSV Data File Creation for Cisco ISR 4461 Gateways, on page 442
• Insert Gateways and Ports to Cisco Unified Communications Manager, on page 444

CSV Data File Creation for Cisco VG200 Gateways
You can create a CSV data file to insert Cisco VG200 gateways and ports in the database. Use either the
BAT spreadsheet or a text editor to create the CSV data file.

Related Topics
Create Text-Based CSV File for Cisco VG200 Gateways, on page 642
Create CSV Data Files for Cisco VG200 Gateways and T1 CAS, T1 PRI, E1 PRI, FXS or FXO Ports
Using BAT Spreadsheet, on page 425

Create CSV Data Files for Cisco VG200 Gateways and T1 CAS, T1 PRI, E1 PRI,
FXS or FXO Ports Using BAT Spreadsheet

Use the BAT spreadsheet to create the CSV data file that contains the details, such as domain name, MGCP
description, and port identifier, for individual T1 CAS, T1 PRI, E1 PRI, FXS or FXO ports.

For T1 CAS only, the ports that you specify in the BAT spreadsheet must be the same ports that you specified
in the VG200 template. In the CSV data file, you can specify none, some, or all ports that were configured in
the template. Do not configure any ports in the CSV data file that were not also configured in the template,
or an error will result when you attempt to insert the BAT VG200 template and the CSV file.
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For example, if you configured ports 1,2,3, and 4 in the template, you could configure none of the ports, or
ports 1, 2, 3, and 4, or only ports 1 and 2 in the CSV file, and the insertion would be accepted. But if you
configured ports 5 and 6 in the CSV file when they are not configured in the template, you will receive an
insertion error in BAT.

After you are finished editing the fields for the gateway ports in the BAT spreadsheet, export the file. The
system saves the file to C:\XLSDataFiles or to your choice of another existing folder on your local
workstation using the following default filename:

VG200Gateways#timestamp.txt

where "timestamp" represents the precise date and time that the file was created.

If you enter a comma in one of the fields, BAT.xlt encloses that field entry in double quotes when you export
to BAT format. If you enter a blank row in the spreadsheet, the system treats the empty row as the end of the
file. Data that is entered after a blank line does not get converted to the BAT format.

Attention

Procedure

Step 1 To open the BAT spreadsheet, locate and double-click BAT.xlt file
Step 2 When prompted, click Enable Macros to use the spreadsheet capabilities.
Step 3 Click the VG200 T1-Pri T1-Cas E1-Pri FXSFXO tab.
Step 4 For T1 CAS endpoints only, scroll to the right until you see the Number of Port Identifiers field. Enter the

number of port identifiers that you want to add for each Cisco VG200 gateway. If you want only one port
identifier, skip this step.

Step 5 Provide the information for the following fields.

Table 43: VG200 gateway T1 CAS, T1-PRI, E1-PRI, FXS and FXO ports field settings

DescriptionField

Enter a name, from 1 to 64 characters that identifies the gateway. Use the
Domain Name System (DNS) host name if it is configured to resolve correctly;
otherwise, use the host name as defined on the Cisco MGCP gateway.

The host name must match the host name that is configured on the Cisco IOS
gateway. For example, if the host name is configured on the gateway to resolve
to vg200-1 and the IP domain name is not configured, enter the host name in
this field (in this case, vg200-1). If the host name is configured on the gateway
as vg200-1 and the IP domain name is configured on the gateway as cisco.com,
enter vg200-1.cisco.com in this field.

MGCP Domain Name

Enter a description, up to 100 characters for the gateway. Use a specific
description that helps you locate the gateway.

MGCP Description

Enter a description for port 1, up to 50 characters. Use a description to help
identify the port in a list of ports. This applies to the description field for port
2 through port 4.

Port Description
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DescriptionField

Enter the directory number, up to 24 numerals and special characters, for this
port. This applies to the directory number field for port 2 through port 4.

Port 1 Directory Number and Partition fields are required for FXS
ports only. For FXO ports, leave these fields blank.

Attention

Port Directory Number

Enter the slot number that you are trying to configure. For VG200, it is always
1.

Slot

Enter an integer for the subunit value.Subunit

Enter an integer for the Port Number.Port Number

Step 6 To transfer the data from the BAT Excel spreadsheet into a CSV file, click Export to BAT Format.

The system saves the file using the default filename VG200Gateways#timestamp.txt to C:\XLSDataFiles
or to your choice of another existing folder on your local workstation, where “timestamp” represents the
precise date and time that the file was created.

For information on how to read the exported CSV data file, click the link to View Sample File
in the Insert Gateways window in BAT.

Note

What to do next

You must upload the CSV data file to the first node of the server, so BAT can access the data input file.

Related Topics
BAT Spreadsheet Data Collection for CSV Data File Creation, on page 12
T1 CAS T1 PRI or E1 PRI Trunks File Format, on page 644
FXO or FXS Trunks CSV File Format, on page 643
Upload and Download Files, on page 19

Create CSV Data File for Cisco Catalyst 6000 (FXS) Ports
You can create the CSV data file to insert Cisco Catalyst 6000 (FXS) ports, such as directory number and a
description of the port, in the database. Use either the BAT spreadsheet or a text editor to create the CSV
data file.

Procedure

Step 1 To open the BAT Spreadsheet, locate and double-click BAT.xlt file.
Step 2 When prompted, click Enable Macros to use the spreadsheet capabilities.
Step 3 Click the Catalyst 6000 (FXS) Ports tab.
Step 4 Enter information for each port record in a row.
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Complete all mandatory fields and any relevant, optional fields. Each column heading specifies the length of
the field.

• MAC Address—Enter the 12-character MAC address for the gateway.

• Port Number—Enter the numeric port number (1 through 24) that you want to add to the gateway.

• Directory Number—Enter a directory number, up to 24 numerals and special characters, for this port.
You must enter a directory number if you have specified a partition.(Optional)

• Partition—Enter the route partition, up to 50 characters, to which you want this port to belong. Do not
specify a partition unless you also have specified a directory number. (Optional).

The system treats blank rows in the spreadsheet as End of File and discards subsequent records.Caution

Step 5 To transfer the data from the BAT Excel spreadsheet into a CSV file, click Export to BAT Format.

The system saves the file to C:\XLSDataFiles\ or to your choice of another existing folder.

For information on how to read the exported CSV data file, click the link to View Sample File
in the Insert Gateways window in BAT.

Note

What to do next

You must upload the CSV data file to the first node of the server, so BAT can access the data input file. For
more information, see Upload and Download Files, on page 19.

Related Topics
BAT Spreadsheet Data Collection for CSV Data File Creation, on page 12
Create Text-Based CSV File for Cisco Catalyst 6000 FXS Ports, on page 652
Upload and Download Files, on page 19

CSV Data Files Creation for Cisco VG224 Gateways and Ports
You can create a CSV data file to insert VG224 gateways and ports in the database. Use either the BAT
spreadsheet or a text editor to create the CSV data file.

Related Topics
Create CSV Data Files for Cisco VG224 FXS Gateways and Ports Using BAT Spreadsheet, on page 428
Create Text-Based CSV File for Cisco VG224 Gateways, on page 645

Create CSV Data Files for Cisco VG224 FXS Gateways and Ports Using BAT
Spreadsheet

Use the BAT spreadsheet to create the CSV data file that contains the details, such as domain name, MGCP
description, and port identifier, for individual FXS ports.
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After you are finished editing the fields for the gateway ports in the BAT spreadsheet, export the file. The
system saves the file to C:\XLSDataFiles or to your choice of another existing folder on your local
workstation using the following default filename:

VG224Gateways#timestamp.txt

where “timestamp” represents the precise date and time that the file was created.

If you enter a comma in one of the fields, BAT.xlt encloses that field entry in double quotes when you export
to BAT format. If you enter a blank row in the spreadsheet, the system treats the empty row as the end of the
file. Data that is entered after a blank line does not get converted to the BAT format.

Tip

Procedure

Step 1 To open the BAT spreadsheet, locate and double-click BAT.xlt file.
Step 2 When prompted, click Enable Macros to use the spreadsheet capabilities.
Step 3 Click the VG224 tab.

a) For MGCP protocol, click the MGCP radio button.
b) For SCCP protocol, click the SCCP radio button.

Step 4 Do one of the following:
a) If you choose MGCP, skip to Step 5, on page 429.
b) If you choose SCCP, a Create File Format button appears in the spreadsheet.

1. Click Create File Format, the Field Selection window displays.

2. From theDevice Fields box, select the required device fields and click on the >> button to move them
to the Selected Device Fields box.

3. From the Line Fields box, select the line fields and click the >> button to move them to the Selected
Line Fields box.

4. Click the Up and Down buttons to rearrange the selected fields.

5. Click the << button to remove any of the selected fields from the selected fields list.

6. Click Create to add the selected fields to the VG224 sheet.

Step 5 Provide the information for the following fields:

• Domain Name—Enter a name, from 1 to 64 characters that identifies the gateway. Use the Domain Name
System (DNS) host name if it is configured to resolve correctly; otherwise, use the host name as defined
on the Cisco MGCP gateway.

The host name must match the host name that is configured on the Cisco IOS gateway. For example, if
the host name is configured on the gateway to resolve to vg224-1 and the IP domain name is not
configured, enter the host name in this field (in this case, vg224-1). If the host name is configured on the
gateway as vg224-1 and the IP domain name is configured on the gateway as cisco.com, enter
vg224-1.cisco.com in this field.
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• Description—Enter a description, up to 100 characters for the gateway. Use a specific description that
helps you locate the gateway.

• Port Description—Enter a description for port 1, up to 50 characters. Use a description to help identify
the port in a list of ports. This applies to the description field for port 2 to port 4.

• Port Directory Number—Enter the directory number, up to 24 numerals and special characters, for this
port. This applies to the directory number field for port 2 to port 4.

Port 1 Directory Number and Partition fields are required for FXS ports only. For FXO ports,
leave these fields blank.

Note

• Slot 2—Enter the slot number that you are trying to configure. For VG224, the slot is always 2.

• Subunit—Enter an integer for the subunit value. For VG224, the subunit is always 0.

• Port Number—Enter an integer for the Port Number.

Step 6 To transfer the data from the BAT Excel spreadsheet into a CSV file, click Export to BAT Format.

The system saves the file using the default filename VG224Gateways#timestamp.txt to C:\XLSDataFiles
or to your choice of another existing folder on your local workstation.

For information on how to read the exported CSV data file, click the link to View Sample File
in the Insert Gateways window in BAT.

Note

What to do next

You must upload the CSV data file to the first node of the Cisco Unified Communications Manager server,
so BAT can access the data input file.

Related Topics
BAT Spreadsheet Data Collection for CSV Data File Creation, on page 12
FXS Trunks CSV File Format for VG224, on page 645
Upload and Download Files, on page 19

CSV Data File Creation for Cisco VG202 and VG204 Gateways
You can create a CSV data file to insert VG202 and VG204 gateways and ports in the Cisco Unified
Communications Manager database. Use either the BAT spreadsheet or a text editor to create the CSV data
file.

Related Topics
Create CSV Data Files for Cisco VG202 and VG204 FXS Gateways and Ports Using BAT Spreadsheet,
on page 431
Create Text-Based CSV File for Cisco VG202 and VG204 Gateways, on page 654
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Create CSV Data Files for Cisco VG202 and VG204 FXS Gateways and Ports
Using BAT Spreadsheet

Use the BAT spreadsheet to create the CSV data file that contains the details, such as domain name, MGCP
description, and port identifier, for individual FXS ports.

After you are finished editing the fields for the gateway ports in the BAT spreadsheet, export the file. The
system saves the file to C:\XLSDataFiles or to your choice of another existing folder on your local
workstation using the following default filename:

VG202Gateways#timestamp.txt or VG204Gateways#timestamp.txt

where “timestamp” represents the precise date and time at which the file was created.

If you enter a comma in one of the fields, BAT.xlt encloses that field entry in double quotes when you export
to BAT format. If you enter a blank row in the spreadsheet, the system treats the empty row as the end of the
file. Data that is entered after a blank line does not get converted to the BAT format.

Tip

Procedure

Step 1 To open the BAT spreadsheet, locate and double-click BAT.xlt file.
Step 2 When prompted, click Enable Macros to use the spreadsheet capabilities.
Step 3 Click the VG202-VG204 tab.

a) For MGCP, click the MGCP radio button.
b) For SCCP, click the SCCP radio button.

Step 4 Do one of the following:
a) If you choose MGCP, proceed to Step 5, on page 431.
b) If you choose SCCP, a Create File Format button appears in the spreadsheet.

1. Click Create File Format; the Field Selection window displays.

2. From the Device Fields box, select the required device fields and click on the >> button to move them
to the Selected Device Fields box.

3. From the Line Fields box, select the line fields and click the >> button to move them to the Selected
Line Fields box.

4. Click the Up and Down buttons to rearrange the selected fields.

5. Click the << button to remove any of the selected fields from the selected fields list.

6. Click Create to add the selected fields to the VG224 sheet.

Step 5 Provide the information for the following fields:

• Domain Name/MAC Address—Enter a name from 1 to 64 characters, that identifies the gateway. Use
the Domain Name System (DNS) host name if it is configured to resolve correctly; otherwise, use the
host name as defined on the Cisco MGCP gateway. For SCCP gateways, use the MAC address.

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
431

Gateways
Create CSV Data Files for Cisco VG202 and VG204 FXS Gateways and Ports Using BAT Spreadsheet



The host name must match exactly the host name that is configured on the Cisco IOS gateway. For
example, if the host name is configured on the gateway to resolve to vg204-1 and the IP domain name
is not configured, enter the host name in this field (in this case, vg204-1). If the host name is configured
on the gateway as vg204-1 and the IP domain name is configured on the gateway as cisco.com, enter
vg204-1.cisco.com in this field.

• Description—Enter a description up to 100 characters for the gateway. Use a specific description that
helps you locate the gateway.

• Slot—Enter the slot number that you are trying to configure. For VG202 and VG204, the slot always
equals 0.

• Subunit—Enter an integer for the subunit value. For VG202 and VG204, the subunit always equals 0.

• Port Directory Number—Enter the directory number up to 24 numerals and special characters for this
port. This applies to the directory number field for port 2 to port 4.

Be aware that Port 1 Directory Number and Partition fields are required for FXS ports only.Note

• Port Number—Enter an integer for the Port Number.

• Port Description—Enter a description for port 1 up to 50 characters. Use a description to identify the
requried port in a list of ports. This applies to the description field for port 2 to port 4.

Step 6 To transfer the data from the BAT Excel spreadsheet into a CSV file, click Export to BAT Format.

The system saves the file using the default filename VG202Gateways#timestamp.txt or
VG204Gateways#timestamp.txt to C:\XLSDataFiles on your local workstation or to your choice of
another existing folder.

For information on how to read the exported CSV data file, click the link to View Sample File
in the Insert Gateways window in BAT.

Note

What to do next

You must upload the CSV data file to the first node of the Cisco Unified Communications Manager server,
so BAT can access the data input file.

Related Topics
BAT Spreadsheet Data Collection for CSV Data File Creation, on page 12
CSV File Format for VG202 and VG204 Gateways, on page 655
Upload and Download Files, on page 19

CSV Data Files Creation for Cisco VG310 Gateways and Ports
You can create a CSV data file to insert VG310 gateways and ports in the database. Use either the BAT
spreadsheet or a text editor to create the CSV data file.

Related Topics
Create CSV Data Files for Cisco VG310 FXS Gateways and Ports Using BAT Spreadsheet, on page 433
Create Text-Based CSV File for Cisco VG310 Gateways, on page 646
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Create CSV Data Files for Cisco VG310 FXS Gateways and Ports Using BAT
Spreadsheet

Use the BAT spreadsheet to create the CSV data file that contains the details, such as domain name, MGCP
description, and port identifier, for individual FXS ports.

After you are finished editing the fields for the gateway ports in the BAT spreadsheet, export the file. The
system saves the file to C:\XLSDataFiles or to your choice of another existing folder on your local
workstation using the following default filename:

VG310Gateways#timestamp.txt

where “timestamp” represents the precise date and time that the file was created.

If you enter a comma in one of the fields, BAT.xlt encloses that field entry in double quotes when you export
to BAT format. If you enter a blank row in the spreadsheet, the system treats the empty row as the end of the
file. Data that is entered after a blank line does not get converted to the BAT format.

Tip

Procedure

Step 1 To open the BAT spreadsheet, locate and double-click BAT.xlt file.
Step 2 When prompted, click Enable Macros to use the spreadsheet capabilities.
Step 3 Click the VG310 tab.

a) For MGCP protocol, click the MGCP radio button.
b) For SSCP protocol, click the SCCP radio button.

Step 4 Do one of the following:
a) If you choose MGCP, skip to Step 5, on page 429.
b) If you choose SCCP, a Create File Format button appears in the spreadsheet.

1. Click Create File Format, the Field Selection window displays.

2. From theDevice Fields box, select the required device fields and click on the >> button to move them
to the Selected Device Fields box.

3. From the Line Fields box, select the line fields and click the >> button to move them to the Selected
Line Fields box.

4. Click the Up and Down buttons to rearrange the selected fields.

5. Click the << button to remove any of the selected fields from the selected fields list.

6. ClickCreate to add the selected fields to the VG310 sheet when you have selected the required fields

Step 5 Provide the information for the following fields:

• Domain Name—Enter a name from 1 to 64 characters that identifies the gateway. Use the Domain Name
System (DNS) host name if it is configured to resolve correctly; otherwise, use the host name as defined
on the Cisco MGCP gateway.
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The host name must match the host name that is configured on the Cisco IOS gateway. For example, if
the host name is configured on the gateway to resolve to VG310-1 and the IP domain name is not
configured, enter the host name in this field (in this case, VG310-1). If the host name is configured on
the gateway as VG310-1 and the IP domain name is configured on the gateway as cisco.com, enter
VG310-1.cisco.com in this field.

• Description—Enter a description up to 100 characters for the gateway. Use a specific description that
helps you locate the gateway.

• Port Description—Enter a description for port 1 up to 50 characters. Use a description to help identify
the port in a list of ports. This applies to the description field for port 2 to port 4.

• Port Directory Number—Enter the directory number up to 24 numerals and special characters for this
port. This applies to the directory number field for port 2 to port 4.

Port 1 Directory Number and Partition fields are required for FXS ports only. For FXO ports,
leave these fields blank.

Note

• Slot 2—Enter the slot number that you are trying to configure. For VG310, the slot is always 2.

• Subunit—Enter an integer for the subunit value. For VG310, the subunit is always 0.

• Port Number—Enter an integer for the Port Number.

Step 6 To transfer the data from the BAT Excel spreadsheet into a CSV file, click Export to BAT Format.

The system saves the file using the default filename VG310Gateways#timestamp.txt to C:\XLSDataFiles
or to your choice of another existing folder on your local workstation.

For information on how to read the exported CSV data file, click the link to View Sample File
in the Insert Gateways window in BAT.

Note

What to do next

You must upload the CSV data file to the first node of the Unified Communications Manager server, so BAT
can access the data input file.

Related Topics
BAT Spreadsheet Data Collection for CSV Data File Creation, on page 12
FXS Trunks CSV File Format for VG310, on page 647
Upload and Download Files, on page 19

CSV Data Files Creation for Cisco VG320 Gateways and Ports
You can create a CSV data file to insert VG320 gateways and ports in the database. Use either the BAT
spreadsheet or a text editor to create the CSV data file.

Related Topics
Create CSV Data Files for Cisco VG320 FXS Gateways and Ports Using BAT Spreadsheet, on page 435
Create Text-Based CSV File for VG320 Gateways, on page 647
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Create CSV Data Files for Cisco VG320 FXS Gateways and Ports Using BAT
Spreadsheet

Use the BAT spreadsheet to create the CSV data file that contains the details, such as domain name, MGCP
description, and port identifier, for individual FXS ports.

After you are finished editing the fields for the gateway ports in the BAT spreadsheet, export the file. The
system saves the file to C:\XLSDataFiles or to your choice of another existing folder on your local
workstation using the following default filename:

VG320Gateways#timestamp.txt

where “timestamp” represents the precise date and time that the file was created.

If you enter a comma in one of the fields, BAT.xlt encloses that field entry in double quotes when you export
to BAT format. If you enter a blank row in the spreadsheet, the system treats the empty row as the end of the
file. Data that is entered after a blank line does not get converted to the BAT format.

Tip

Procedure

Step 1 To open the BAT spreadsheet, locate and double-click BAT.xlt file.
Step 2 When prompted, click Enable Macros to use the spreadsheet capabilities.
Step 3 Click the VG320 tab.

a) For MGCP protocol, click the MGCP radio button.
b) For SCCP protocol, click the SCCP radio button.

Step 4 Do one of the following:
a) If you choose MGCP, skip to Step 5, on page 429.
b) If you choose SCCP, a Create File Format button appears in the spreadsheet.

1. Click Create File Format, the Field Selection window displays.

2. From theDevice Fields box, select the required device fields and click on the >> button to move them
to the Selected Device Fields box.

3. From the Line Fields box, select the line fields and click the >> button to move them to the Selected
Line Fields box.

4. Click the Up and Down buttons to rearrange the selected fields.

5. Click the << button to remove any of the selected fields from the selected fields list.

6. ClickCreate to add the selected fields to the VG320 sheet when you have selected the required fields.

Step 5 Provide the information for the following fields:

• Domain Name—Enter a name from 1 to 64 characters that identifies the gateway. Use the Domain Name
System (DNS) host name if it is configured to resolve correctly; otherwise, use the host name as defined
on the Cisco MGCP gateway.
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The host name must exactly the host name that is configured on the Cisco IOS gateway. For example,
if the host name is configured on the gateway to resolve to VG320-1 and the IP domain name is not
configured, enter the host name in this field (in this case, VG320-1). If the host name is configured on
the gateway as VG320-1 and the IP domain name is configured on the gateway as cisco.com, enter
VG320-1.cisco.com in this field.

• Description—Enter a description, up to 100 characters for the gateway. Use a specific description that
helps you locate the gateway.

• Port Description—Enter a description for port 1 up to 50 characters. Use a description to help identify
the port in a list of ports. This applies to the description field for port 2 to port 4.

• Port Directory Number—Enter the directory number, up to 24 numerals and special characters, for this
port. This applies to the directory number field for port 2 to port 4.

Port 1 Directory Number and Partition fields are required for FXS ports only. For FXO ports,
leave these fields blank.

Note

• Slot 2—Enter the slot number that you are trying to configure. For VG320, the slot is always 2.

• Subunit—Enter an integer for the subunit value. For VG320, the subunit is always 0.

• Port Number—Enter an integer for the Port Number.

Step 6 To transfer the data from the BAT Excel spreadsheet into a CSV file, click Export to BAT Format.

The system saves the file using the default filename VG320Gateways#timestamp.txt to C:\XLSDataFiles
or to your choice of another existing folder on your local workstation.

For information on how to read the exported CSV data file, click the link to View Sample File
in the Insert Gateways window in BAT.

Note

What to do next

You must upload the CSV data file to the first node of the Unified Communications Manager server, so BAT
can access the data input file.

Related Topics
BAT Spreadsheet Data Collection for CSV Data File Creation, on page 12
FXS Trunks CSV File Format for VG320, on page 648
Upload and Download Files, on page 19

CSV Data Files Creation for Cisco VG350 Gateways and Ports
You can create a CSV data file to insert VG350 gateways and ports in the Unified Communications Manager
database. Use either the BAT spreadsheet or a text editor to create the CSV data file.

Related Topics
Create CSV Data Files for Cisco VG350 FXS Gateways and Ports Using BAT Spreadsheet, on page 437
Create Text-Based CSV File for VG350 Gateways, on page 649
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Create CSV Data Files for Cisco VG350 FXS Gateways and Ports Using BAT
Spreadsheet

Use the BAT spreadsheet to create the CSV data file that contains the details, such as domain name, MGCP
description, and port identifier, for individual FXS ports.

After you are finished editing the fields for the gateway ports in the BAT spreadsheet, export the file. The
system saves the file to C:\XLSDataFiles or to your choice of another existing folder on your local
workstation using the following default filename:

VG350Gateways#timestamp.txt

where “timestamp” represents the precise date and time that the file was created.

If you enter a comma in one of the fields, BAT.xlt encloses that field entry in double quotes when you export
to BAT format. If you enter a blank row in the spreadsheet, the system treats the empty row as the end of the
file. Data that is entered after a blank line does not get converted to the BAT format.

Tip

Procedure

Step 1 To open the BAT spreadsheet, locate and double-click BAT.xlt file.
Step 2 When prompted, click Enable Macros to use the spreadsheet capabilities.
Step 3 Click the VG350 tab.

a) For MGCP protocol, click the MGCP radio button.
b) For SCCP protocol, click the SCCP radio button.

Step 4 Do one of the following:
a) If you choose MGCP, skip to Step 5, on page 429.
b) If you choose SCCP, a Create File Format button appears in the spreadsheet.

1. Click Create File Format, the Field Selection window displays.

2. From theDevice Fields box, select the required device fields and click on the >> button to move them
to the Selected Device Fields box.

3. From the Line Fields box, select the line fields and click the >> button to move them to the Selected
Line Fields box.

4. Click the Up and Down buttons to rearrange the selected fields.

5. Click the << button to remove any of the selected fields from the selected fields list.

6. ClickCreate to add the selected fields to the VG350 sheet when you have selected the required fields.

Step 5 Provide the information for the following fields:

• Domain Name—Enter a name from 1 to 64 characters that identifies the gateway. Use the Domain Name
System (DNS) host name if it is configured to resolve correctly; otherwise, use the host name as defined
on the Cisco MGCP gateway.
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The host name must match the host name that is configured on the Cisco IOS gateway. For example, if
the host name is configured on the gateway to resolve to VG350-1 and the IP domain name is not
configured, enter the host name in this field (in this case, VG350-1). If the host name is configured on
the gateway as VG350-1 and the IP domain name is configured on the gateway as cisco.com, enter
VG350-1.cisco.com in this field.

• Description—Enter a description up to 100 characters for the gateway. Use a specific description that
helps you locate the gateway.

• Port Description—Enter a description for port 1 up to 50 characters. Use a description to help identify
the port in a list of ports. This applies to the description field for port 2 through port 4.

• Port Directory Number—Enter the directory number up to 24 numerals and special characters for this
port. This applies to the directory number field for port 2 through port 4.

Port 1 Directory Number and Partition fields are required for FXS ports only. For FXO ports,
leave these fields blank.

Note

• Slot 2—Enter the slot number that you are trying to configure. For VG350, the slot is always 2.

• Subunit—Enter an integer for the subunit value. For VG350, the subunit is always 0.

• Port Number—Enter an integer for the Port Number.

Step 6 To transfer the data from the BAT Excel spreadsheet into a CSV file, click Export to BAT Format.

The system saves the file using the default filename VG350Gateways#timestamp.txt to C:\XLSDataFiles
or to your choice of another existing folder on your local workstation.

For information on how to read the exported CSV data file, click the link to View Sample File
in the Insert Gateways window in BAT.

Note

What to do next

You must upload the CSV data file to the first node of the Unified Communications Manager server, so BAT
can access the data input file.

Related Topics
BAT Spreadsheet Data Collection for CSV Data File Creation, on page 12
FXS Trunks CSV File Format for VG350, on page 649
Upload and Download Files, on page 19

CSV Data File Creation for Cisco VG420 Gateways
You can create a CSV data file to insert VG420 gateways and ports in the Unified Communications Manager
database. Use either the BAT spreadsheet or a text editor to create the CSV data file.

Related Topics
Create CSV Data Files for Cisco VG420 Gateways Using BAT Spreadsheet, on page 439
Create Text-Based CSV File for VG420 Gateways, on page 650
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Create CSV Data Files for Cisco VG420 Gateways Using BAT Spreadsheet
Use the BAT spreadsheet to create the CSV data file that contains the details, such as domain name, MGCP
description, and port identifier, for individual FXS ports.

After you are complete editing the fields for the gateway ports in the BAT spreadsheet, export the file. The
system saves the file to C:\XLSDataFiles or to your choice of another existing folder on your local
workstation using the following default filename:

VG420Gateways#timestamp.txt

where “timestamp” represents the precise date and time that the file was created.

If you enter a comma in one of the fields, BAT.xlt encloses that field entry in double quotes when you export
to BAT format. If you enter a blank row in the spreadsheet, the system treats the empty row as the end of the
file. Data that is entered after a blank line does not get converted to the BAT format.

Tip

Procedure

Step 1 To open the BAT spreadsheet, locate and double-click BAT.xlt file.
Step 2 When prompted, click Enable Macros to use the spreadsheet capabilities.
Step 3 Click the VG420 tab.

a) For MGCP protocol, click the MGCP radio button.
b) For SCCP protocol, click the SCCP radio button.
c) For SIP protocol, click the SIP radio button.

Step 4 Do one of the following:

a. If you choose MGCP, skip to step 6

b. If you choose SCCP or SIP, a Create File Format button appears in the spreadsheet.

1. Click Create File Format, the Field Selection window displays.

2. From the Device Fields box, select the required device fields and click the >> button to move them
to the Selected Device Fields box.

3. From the Line Fields box, select the line fields and click the >> button to move them to the Selected
Line Fields box.

4. Click the Up and Down buttons to rearrange the selected fields.

5. Click the << button to remove any of the selected fields from the selected fields list.

6. ClickCreate to add the selected fields to the VG420 sheet when you have selected the required fields.

Step 5 Provide the information in the following fields:

• Domain Name—Enter a name from 1 to 64 characters that identifies the gateway. Use the Domain Name
System (DNS) hostname if it is configured to resolve correctly; otherwise, use the hostname as defined
on the Cisco MGCP gateway.
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The hostname must match the hostname that is configured on the Cisco IOS gateway. For example, if
the hostname is configured on the gateway to resolve to VG420-1 and the IP domain name is not
configured, enter the hostname in this field (in this case, VG420-1). If the hostname is configured on the
gateway as VG420-1 and the IP domain name is configured on the gateway as cisco.com, enter
VG420-1.cisco.com in this field.

• Description—Enter a description up to 100 characters for the gateway. Use a specific description that
helps you locate the gateway.

• Port Description—Enter a description for port 1 up to 50 characters. Use a description to help identify
the port in a list of ports.

• Port Directory Number—Enter the directory number up to 24 numerals and special characters for this
port.

Port 1 Directory Number and Partition fields are required for FXS ports only. For FXO ports,
leave these fields blank.

Note

• Slot—Enter the slot number that you are trying to configure. For VG420, the slot can be 0 or 1.

• Subunit—Enter an integer for the subunit value. For VG420, for slot 0, the subunit can be 1, 2, or 3. For
slot 1, the subunit is always 0.

• Port Number—Enter an integer for the Port Number.

Step 6 To transfer the data from the BAT Excel spreadsheet into a CSV file, click Export to BAT Format.

The system saves the file using the default filename VG420Gateways#timestamp.txt to C:\XLSDataFiles
or to your choice of another existing folder on your local workstation.

For information on how to read the exported CSV data file, click the link to View Sample File
in the Insert Gateways window in BAT.

Tip

What to do next

You must upload the CSV data file to the first node of the Unified Communications Manager server, so BAT
can access the data input file.

CSV Data Files Creation for Cisco VG450 Gateways and Ports
You can create a CSV data file to insert VG450 gateways and ports in the Unified Communications Manager
database. Use either the BAT spreadsheet or a text editor to create the CSV data file.

Related Topics
Create CSV Data Files for Cisco VG450 FXS Gateways and Ports Using BAT Spreadsheet, on page 441
Create Text-Based CSV File for VG450 Gateways, on page 650
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Create CSV Data Files for Cisco VG450 FXS Gateways and Ports Using BAT
Spreadsheet

Use the BAT spreadsheet to create the CSV data file that contains the details, such as domain name, MGCP
description, and port identifier, for individual FXS ports.

After you are complete editing the fields for the gateway ports in the BAT spreadsheet, export the file. The
system saves the file to C:\XLSDataFiles or to your choice of another existing folder on your local
workstation using the following default filename:

VG450Gateways#timestamp.txt

where “timestamp” represents the precise date and time that the file was created.

If you enter a comma in one of the fields, BAT.xlt encloses that field entry in double quotes when you export
to BAT format. If you enter a blank row in the spreadsheet, the system treats the empty row as the end of the
file. Data that is entered after a blank line does not get converted to the BAT format.

Tip

Procedure

Step 1 To open the BAT spreadsheet, locate and double-click BAT.xlt file.
Step 2 When prompted, click Enable Macros to use the spreadsheet capabilities.
Step 3 Click the VG450 tab.

a) For MGCP protocol, click the MGCP radio button.
b) For SCCP protocol, click the SCCP radio button.
c) For SIP protocol, click the SIP radio button.

Step 4 Do one of the following:

a. If you choose MGCP, skip to step 6

b. If you choose SCCP or SIP, a Create File Format button appears in the spreadsheet.

1. Click Create File Format, the Field Selection window displays.

2. From theDevice Fields box, select the required device fields and click on the >> button to move them
to the Selected Device Fields box.

3. From the Line Fields box, select the line fields and click the >> button to move them to the Selected
Line Fields box.

4. Click the Up and Down buttons to rearrange the selected fields.

5. Click the << button to remove any of the selected fields from the selected fields list.

6. ClickCreate to add the selected fields to the VG450 sheet when you have selected the required fields.

Step 5 Provide the information in the following fields:
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• Domain Name—Enter a name from 1 to 64 characters that identifies the gateway. Use the Domain Name
System (DNS) host name if it is configured to resolve correctly; otherwise, use the host name as defined
on the Cisco MGCP gateway.

The host name must match the host name that is configured on the Cisco IOS gateway. For example, if
the host name is configured on the gateway to resolve to VG450-1 and the IP domain name is not
configured, enter the host name in this field (in this case, VG450-1). If the host name is configured on
the gateway as VG450-1 and the IP domain name is configured on the gateway as cisco.com, enter
VG450-1.cisco.com in this field.

• Description—Enter a description up to 100 characters for the gateway. Use a specific description that
helps you locate the gateway.

• Port Description—Enter a description for port 1 up to 50 characters. Use a description to help identify
the port in a list of ports. This applies to the description field for port 2 through port 4.

• Port Directory Number—Enter the directory number up to 24 numerals and special characters for this
port. This applies to the directory number field for port 2 through port 4.

Port 1 Directory Number and Partition fields are required for FXS ports only. For FXO ports,
leave these fields blank.

Note

• Slot 2—Enter the slot number that you are trying to configure. For VG450, the slot is always 2.

• Subunit—Enter an integer for the subunit value. For VG450, the subunit is always 0.

• Port Number—Enter an integer for the Port Number.

Step 6 To transfer the data from the BAT Excel spreadsheet into a CSV file, click Export to BAT Format.

The system saves the file using the default filename VG450Gateways#timestamp.txt to C:\XLSDataFiles
or to your choice of another existing folder on your local workstation.

For information on how to read the exported CSV data file, click the link to View Sample File
in the Insert Gateways window in BAT.

Tip

What to do next

You must upload the CSV data file to the first node of the Unified Communications Manager server, so BAT
can access the data input file.

Related Topics
BAT Spreadsheet Data Collection for CSV Data File Creation, on page 12
FXS Trunks CSV File Format for VG450, on page 651
Upload and Download Files, on page 19

CSV Data File Creation for Cisco ISR 4461 Gateways
You can create a CSV data file to insert ISR 4461 gateways in the Cisco Unified Communications Manager
database. Use either the BAT spreadsheet or a text editor to create the CSV data file.
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Related Topics
Create CSV Data Files for Cisco ISR 4461 Gateways Using BAT Spreadsheet, on page 443

Create CSV Data Files for Cisco ISR 4461 Gateways Using BAT Spreadsheet
Use the BAT spreadsheet to create the CSV data file that contains the details, such as domain name, MGCP
description, and other relevant information.

After you are finished editing the fields for the gateway ports in the BAT spreadsheet, export the file. The
system saves the file to C:\XLSDataFiles or to your choice of another existing folder on your local
workstation using the following default filename:

ISR4461Gateways-#timestamp.txt

where “timestamp” represents the precise date and time at which the file was created.

If you enter a comma in one of the fields, BAT.xlt encloses that field entry in double quotes when you export
to BAT format. If you enter a blank row in the spreadsheet, the system treats the empty row as the end of the
file. Data that is entered after a blank line does not get converted to the BAT format.

Tip

Procedure

Step 1 To open the BAT spreadsheet, locate and double-click BAT.xlt file.
Step 2 When prompted, click Enable Macros to use the spreadsheet capabilities.
Step 3 Click the ISR 4461 tab.

a) For MGCP protocol, click the MGCP radio button.
b) For SCCP protocol, click the SCCP radio button.
c) For SIP protocol, click the SIP radio button.

Step 4 Do one of the following:
a) If you choose MGCP, proceed to Step 5, on page 443.
b) If you choose SCCP or SIP, a Create File Format button appears in the spreadsheet.

1. Click Create File Format; the Field Selection window displays.

2. From the Device Fields box, select the required device fields and click the >> button to move them
to the Selected Device Fields box.

3. From the Line Fields box, select the line fields and click the >> button to move them to the Selected
Line Fields box.

4. Click the Up and Down buttons to rearrange the selected fields.

5. Click the << button to remove any of the selected fields from the selected fields list.

6. Click Create to add the selected fields to the ISR 4461 sheet when you have selected the required
fields.

Step 5 In each row, provide the information for the following fields:
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• Domain Name/MAC Address—Enter a name from 1 to 64 characters that identifies the gateway. Use
the Domain Name System (DNS) host name if it is configured to resolve correctly; otherwise, use the
host name as defined on the CiscoMGCP gateway. For SCCP gateways and SIP gateways, use the MAC
address.

The host name must match the host name that is configured on the Cisco IOS gateway. For example, if
the host name is configured on the gateway to resolve to ISR 4461 and the IP domain name is not
configured, enter the host name in this field (in this case, ISR 4461). If the host name is configured on
the gateway as ISR 4461 and the IP domain name is configured on the gateway as cisco.com, enter ISR
4461.cisco.com in this field.

• Description—Enter a description up to 100 characters for the gateway. Use a specific description that
helps you locate the gateway.

• Slot—Enter the slot number that you are trying to configure. For ISR 4461, the slot can be 0, 1, 2, or 3.

• Subunit—Enter an integer for the subunit value. In ISR 4461, for slot 0, the subunit can be 1, 2, or 3.
For slot 1, 2, or 3, the subunit is always 0.

• Port Directory Number—Enter the directory number, up to 24 numerals and special characters, for this
port. This applies to the directory number field for port 2 through port 4.

Port 1 Directory Number and Partition fields are required for FXS ports only.Note

• Port Number—Enter an integer for the Port Number.

• Port Description—Enter a description for port 1 up to 50 characters. Use a description to help identify
the port in a list of ports. This applies to the description field for port 2 through port 4.

Step 6 To transfer the data from the BAT Excel spreadsheet into a CSV file, click Export to BAT Format.

The system saves the file using the default filename ISR4461Gateways-#timestamp.txt to
C:\XLSDataFiles on your local workstation or to your choice of another existing folder.

For information on how to read the exported CSV data file, click the link to View Sample File
in the Insert Gateways window in BAT.

Note

What to do next

You must upload the CSV data file to the first node of the Unified Communications Manager server, so BAT
can access the data input file.

Insert Gateways and Ports to Cisco Unified Communications
Manager

You can use the BAT spreadsheet to add Cisco gateways and ports to Cisco Unified CommunicationsManager.

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
444

Gateways
Insert Gateways and Ports to Cisco Unified Communications Manager



Before you begin

• If you want to insert a CiscoVG200 gateway, you must have a Cisco VG200 gateway template for the
trunks or ports, and a CSV data file for the VG200 gateway ports. See Create Cisco VG200 Gateway
Template, on page 369 and CSV Data File Creation for Cisco VG200 Gateways, on page 425.

• If you want to insert a CiscoCatalyst 6000 Port, you must have a CiscoCatalyst 6000 Ports template and
a CSV data file that contains port details for this bulk transaction. See Create Cisco Catalyst 6000 (FXS)
Gateway Template, on page 373 and Create CSV Data File for Cisco Catalyst 6000 (FXS) Ports, on page
427.

• If you want to insert a CiscoVG224 gateway, you must have a Cisco VG224 gateway template for the
trunks or ports, and a CSV data file for the VG224 gateway ports. See Create Cisco VG200 Gateway
Template, on page 369 and CSV Data File Creation for Cisco VG200 Gateways, on page 425.

• If you want to insert a CiscoVG202 or VG204 gateway, youmust have a Cisco VG202 or VG204 gateway
template for the trunks or ports and a CSV data file for the VG202 or VG204 gateway ports. See Create
Cisco VG202 or VG204 Gateway Template, on page 376 and CSV Data File Creation for Cisco VG202
and VG204 Gateways, on page 430.

Procedure

Step 1 Choose Bulk Administration > Gateways > Insert Gateways.

The Insert Gateways Configuration window displays.

Step 2 From the Gateway Type drop-down list, choose the type of gateway you want to insert.

The Insert Gateway Configuration window displays.

Step 3 Choose the name of the CSV data file that contains the Cisco VG200 gateway information to be added from
the File Name field drop-down list.

Step 4 Choose the name of the VG200 or the FXS gateway template that you created for this type of bulk transaction
in the Gateway Template Name field.

Step 5 (Optional) Check the Override the existing configuration button to overwrite the existing gateway settings
with the information that is contained in the file that you want to insert.

Step 6 Enter the job description in the Job Information area.
Step 7 Choose an insert method. Do one of the following:

a) Click Run Immediately to insert the gateway immediately.
b) Click Run Later to insert the gateway later.

Step 8 Click Submit to create a job for inserting the gateways.
Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
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C H A P T E R 52
Cisco Gateway Deletions

This chapter provides information to locate the gateway records that you want to delete from the Cisco Unified
Communications Manager database. You must define a query filter to delete a group of gateways. You can
only delete CiscoVG200 and CiscoCatalyst6000 gateway records using the Delete Gateway Configuration
window.

• Delete Cisco Gateway Records Using Query, on page 447
• Topics Related to Cisco Gateway Deletions, on page 448

Delete Cisco Gateway Records Using Query
You can use a query to locate the gateway records that you want to delete fromCisco Unified Communications
Manager. You can only delete Cisco VG200, VG202, VG204, VG224, VG310, VG320, VG350, VG420,
VG450, ISR 4461, and Cisco Catalyst 6000 gateways using the Delete Gateway Configuration window.

The delete action is final. You cannot retrieve deleted records.Caution

Procedure

Step 1 Choose Bulk Administration > Gateways > Delete Gateways.
Step 2 From the Delete Gateways where drop-down list, choose one of the following options:

• Name

• Description

• DN/Route Pattern

• Calling Search Space

• Device Pool

• Device Type

Step 3 From the second Find Gateways where drop-down list, choose one of the following criteria:

• begins with
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• contains

• is exactly

• ends with

• is empty

• is not empty

Step 4 From the third drop-down list, choose Show to display the associated endpoints.
Step 5 Specify the appropriate search text, if applicable, and click Find.

To find all gateways that are registered in the database, click Find without entering any search
text.

Tip

To further define your query, you can choose AND or OR to add multiple filters and repeat Step 2, on page
447 through Step 5, on page 448.

A list of discovered templates displays by:

• Device Name

• Description

• Device Pool

• Status

• IP address

Step 6 In the Job Information area, enter the Job description.
Step 7 Choose a delete method. Do one of the following:

a) Click Run Immediately to delete gateways immediately.
b) Click Run Later to delete gateways at a later time.

Step 8 Click Submit to create a job for deleting the gateway records.
Step 9 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

If you do not enter any information in the query text box, the system deletes all gateway records.
The delete action is final. You cannot retrieve deleted records.

Caution

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Topics Related to Cisco Gateway Deletions, on page 448

Topics Related to Cisco Gateway Deletions
• Delete Cisco Gateway Records Using Query, on page 447

• Insert Gateways and Ports to Cisco Unified Communications Manager, on page 444
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• Manage Scheduled Jobs, on page 599

• BAT Log Files, on page 609
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C H A P T E R 53
Cisco Gateway Report Generation

This chapter provides information to generate reports for VGXXX Gateways.

Reports can be generated only for VG200, VG224, VG202, VG310, VG320, VG350, VG450, ISR 4461,, ,
VG420, and VG204 gateways.

Note

• Generate Cisco Gateway Reports, on page 451
• Topics Related to Cisco Gateway Reports, on page 453

Generate Cisco Gateway Reports
You can generate a report for all VGXXX Gateways or for a limited set of gateways. Reports for VGXXX
Gateways have a fixed format.

Reports can be generated only for VG200, VG224, VG202, VG310, VG320, VG350, VG450, ISR 4461,, ,
VG420, and VG204 gateways.

Note

Procedure

Step 1 Choose Bulk Administration > Gateways > Generate Gateway Reports.
Step 2 From the Find Gateways where drop-down list, choose one of the following options:

• Name

• Description

• DN/Route Pattern

• Calling Search Space

• Device Pool

• Device Type
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Step 3 From the second Find Gateways where drop-down list, choose one of the following criteria:

• begins with

• contains

• is exactly

• ends with

• is empty

• is not empty

Step 4 From the third drop-down list, choose Show to display the associated endpoints.
Step 5 Specify the appropriate search text, if applicable, and click Find.

To find all gateways that are registered in the database, click Find without entering any search
text.

Tip

To further define your query, you can choose AND or OR to add multiple filters and repeat Step 2, on page
451 through Step 5, on page 452.

A list of discovered templates displays by:

• Device Name

• Description

• Device Pool

• Status

• IP address

Step 6 Click Next to choose details for your type of report.
The Gateway Report Configuration window displays and shows the query that you chose. If you want to
change the type of query, click Back.

Step 7 In the File Name field, enter your name for this report (required).
Step 8 Choose the file format from the drop-down list.
Step 9 In the Job Information area, enter the Job description.
Step 10 Choose when to generate a report. Do one of the following:

a) Click Run Immediately to generate a report immediately.
b) Click Run Later to generate a report at a later time.

Step 11 Click Submit to create a job for generating the report.
Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

What to do next

You can search and download the report file using the Upload/Download Files option in the Bulk
Administration menu.
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Related Topics
BAT Log Files, on page 609
Report Log Files, on page 287
Manage Scheduled Jobs, on page 599
Topics Related to Cisco Gateway Reports, on page 453
Upload and Download Files, on page 19

Topics Related to Cisco Gateway Reports
• Generate Cisco Gateway Reports, on page 451

• Report Log Files, on page 287

• Upload and Download Files, on page 19

• Manage Scheduled Jobs, on page 599

• BAT Log Files, on page 609
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P A R T IX
Forced Authorization Codes and Client Matter
Codes

• Client Matter Codes and Forced Authorization Codes, on page 457
• Forced Authorization Codes and Client Matter Code Deletions, on page 465





C H A P T E R 54
Client Matter Codes and Forced Authorization
Codes

This chapter provides information about using BAT to configure Forced Authorization Codes (FAC) and
Client Matter Codes (CMC). You can create, update, delete, or add more CMC or FAC settings using either
a CSV data file or a custom text-based CSV file.

• CMC and FAC Setup Using BAT, on page 457
• Implement CMC and FAC Features, on page 458
• Create CMC and FAC CSV Data File Using BAT.xlt, on page 459
• CSV Data File Creation for Client Matter Codes and Forced Authorization Codes Using Text Editor, on
page 460

• Edit Existing CMC or FAC CSV Data File, on page 460
• CMC and FAC CSV Data File Settings, on page 461
• Update CMC or FAC in CUCM Database Using BAT, on page 462
• BAT Settings to Update CMC and FAC in the Database, on page 463
• Topics Related to CMC and FAC Configuration, on page 463

CMC and FAC Setup Using BAT
Forced Authorization Codes (FAC) and Client Matter Codes (CMC) allow you to manage call access and
accounting. CMC assists with call accounting and billing for billable clients, while Forced Authorization
Codes regulate the types of calls that certain users can place.

Client Matter Codes force the user to enter a code to specify that the call relates to a specific client matter.
You can assign client matter codes to customers, students, or other populations for call accounting and billing
purposes. The Forced Authorization Codes feature forces the user to enter a valid authorization code before
the call completes.

The CMC and FAC features require that you make changes to route patterns and update your dial plan
documents to reflect that you enabled or disabled FAC and/or CMC for each route pattern.

Before you use BAT to configure CMC or FAC, review the following information:

• Create separate CSV files for CMC and FAC. Do not mix the two features in a single CSV file.

• When you add CMC or FAC settings for the first time, you can create a CSV file through BAT.xlt or
create a custom text-based CSV file.
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• To update, delete, or add more CMC or FAC settings (not first time), you can edit an existing CSV file
or create a custom text-based CSV file.

• In the file/spreadsheet, do not enter two or more codes (and corresponding settings) on a single line.
Designate a single line for each code (and corresponding setting). For example, use the following format
when you enter codes for Forced Authorization Codes:

(Authorization Code, Authorization Code Name, Authorization Level)

1234,John Smith,20

1235,Lisa Mendez,10

5551,Debbie Dunn,30

• Deleting information from a file and leaving the information blank does not remove the information from
the database; in other words, a blank value does not overwrite an existing value in the database. Updating
the values overwrites the existing value in the database.

• Make sure that you upload the appropriate CSV files to the first node of the server.

• Any time that you create or change a CSV file, you must insert the CSV file in BAT to update the
database.

Related Topics
Topics Related to CMC and FAC Configuration, on page 463
Update CMC or FAC in CUCM Database Using BAT, on page 462
Upload and Download Files, on page 19

Implement CMC and FAC Features
You can use Bulk Administration (BAT) to implement CMC and FAC features.

The CMC and FAC features require that you make changes to route patterns and update your dial plan
documents to reflect that you enabled or disabled FAC and/or CMC for each route pattern.

Note

Procedure

Step 1 Review important BAT information and general information about the CMC and FAC features.

• CMC and FAC Setup Using BAT, on page 457

• Feature Configuration Guide for Cisco Unified Communications Manager

Step 2 Create a CSV file for CMC or FAC and enter the CMC and FAC configuration information.
Step 3 To update the database, insert the CSV file in BAT.
Step 4 Enable FAC or CMC by adding or updating route patterns in Administration.
Step 5 Update your dial plan documents or keep a printout of the BAT CSV file with your dial plan documents.

Refer to your dial plan documents.
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Step 6 Provide all necessary information, for example, codes, to users and explain how the features work.

Related Topics
Topics Related to CMC and FAC Configuration, on page 463

Create CMC and FAC CSV Data File Using BAT.xlt
You can create the CSV file for CMC or FAC using the BAT spreadsheet BAT.xlt. You must create two
separate CSV files, one for CMC and one for FAC.

The BAT.xlt file exists on the first node of the server; however, you normally do not have Microsoft Excel
installed on the server. In that case, copy the file from the first node and move it to a local machine that has
Microsoft Excel installed.

Note

Before you begin

Review important considerations in CMC and FAC Setup Using BAT, on page 457 before you use BAT to
configure CMC or FAC.

Procedure

Step 1 Choose Bulk Administration > Upload/Download Files.
The Find and List Files window opens.

Step 2 Click Find and download the BAT.xlt file.
Step 3 Copy BAT.xlt to a local machine where Microsoft Excel is installed.
Step 4 To open the BAT Spreadsheet, locate and double-click the BAT.xlt file.
Step 5 When prompted, click Enable Macros to use the spreadsheet capabilities.
Step 6 Click one of the following tabs:

• Insert CMC—If you are creating a CMC CSV file

• Insert FAC—If you are creating a FAC CSV file

Step 7 Enter CMC or FAC settings in the columns.
See Table 44: Configuration Settings for CMC and FAC, on page 461 for descriptions of configuration settings.

Repeat Step 7, on page 459 until you enter all codes.Note

Step 8 To transfer the Excel spreadsheet format to a CSV file, click Export to BAT Format.

The system automatically saves CSV files to C:\XlsDatafiles on the local machine.

Click Browse to choose a different location.Tip
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What to do next

Upload the CSV files to the first node of the server.

You must add the CSV file to BAT and insert the file to update the database.

Related Topics
Download File Off Server, on page 20
Topics Related to CMC and FAC Configuration, on page 463
Update CMC or FAC in CUCM Database Using BAT, on page 462
Upload File to Server, on page 21

CSV Data File Creation for Client Matter Codes and Forced
Authorization Codes Using Text Editor

You can use a text editor to create the text-based CSV data file for client matter codes and forced authorization
codes. The comma separated values (CSV) file provides textual information in tabular form and contains lines
of ASCII text with values separated by commas.

Related Topics
Create Custom Text-Based CSV Files for Client Matter Codes and Forced Authorized Codes, on page
655
Topics Related to CMC and FAC Configuration, on page 463

Edit Existing CMC or FAC CSV Data File
You update existing codes by manually updating an existing CSV file or creating a new CSV file using a text
editor.

If you are updating a CMC CSV file, for example, you may enter 5555,Acme Toys, where 5555 equals the
mandatory client matter code, and Acme Toys equals the description.

If you are updating a FAC CSV file, for example, you may enter 1234,John Smith,20, where 1234 equals the
forced authorization code, John Smith equals the authorization code name, and 20 equals the authorization
level.

You can change any part of an existing record, but you must include the code; for example, the forced
authorization code or client matter code. Deleting information and leaving it blank does not remove the
information from the database; a blank value does not overwrite an existing value in the database, but, updating
the value, for example, to Acme Toys, Inc. or John L. Smith from the preceding examples, overwrites the
existing value in the database.

Procedure

Step 1 To edit existing CSV data files, download the CSV files from the first node of the Cisco Unified
Communications Manager server to your local workstation.

Step 2 Open and edit the existing CSV file using a text editor.
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Delete existing settings, add new codes, or update existing settings. See Table 44: Configuration Settings for
CMC and FAC, on page 461 for descriptions of the CMC and FAC configuration settings.

If you add new codes at the same time that you update them, make sure that you enter all required
information.

A blank value does not overwrite an existing value in the database, but updating the value
overwrites the existing value in the database.

Caution

What to do next

Upload the CSV files to the first node of the Cisco Unified Communications Manager server.

You must add the CSV file to BAT and insert the file to update the Cisco Unified Communications Manager
database.

Related Topics
Download File Off Server, on page 20
Topics Related to CMC and FAC Configuration, on page 463
Update CMC or FAC in CUCM Database Using BAT, on page 462
Upload File to Server, on page 21

CMC and FAC CSV Data File Settings
The following table provides descriptions of the configuration settings in the CMC and FAC CSV data files.

Table 44: Configuration Settings for CMC and FAC

DescriptionSetting/Column

For CMC CSV file

Enter a unique code of no more than 16 digits that the
user will enter when placing a call. The client matter
code displays in the CDRs for calls that use this code.

Client Matter Code

This optional field helps you associate a client code with
a client. The description can include up to 50 characters
in any language, but it cannot include double-quotes ("),
percentage sign (%), ampersand (&), back-slash (\), or
angle brackets (<>).

Description

For FAC CSV File

Enter a unique authorization code that is no more than
16 digits. The user enters this code when the user places
a call through a FAC-enabled route pattern.

Authorization Code
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DescriptionSetting/Column

Enter a unique name that is no more than 50 characters.
The authorization code name ties the authorization code
to a specific user or group of users; this name displays
in the CDRs for calls that use this code.

If you plan to assign an authorization code
to every user in the system, make sure that
the code name includes an identifier for
the user, such as the user name or another
unique, non-sensitive identifier; for
example, an email alias or
employee/student number. Do not use
identifiers such as a social security number
because the authorization code namewrites
to CDRs, which are not secure.

Tip

Authorization Code Name

Enter a three-digit authorization level that exists within
the range of 0 to 255; the default equals 0. The level that
you assign to the authorization code determines whether
the user can route calls through FAC-enabled route
patterns. To successfully route a call, the user
authorization level must equal or be greater than the
authorization level that is specified for the route pattern
for the call.

Authorization Level

Update CMC or FAC in CUCM Database Using BAT
To update the Cisco Unified Communications Manager database, you must insert the CMC or FAC CSV data
file using BAT.

Before you begin

Before you can update Cisco Unified Communications Manager, you must create or edit a CMC or FAC CSV
file.

Procedure

Step 1 In Cisco Unified Communications Manager Administration, choose one of the following options:
a) For CMC, choose Bulk Administration > Client Matter Codes > Insert Client Matter Codes.
b) For FAC, chooseBulk Administration > Forced Authorization Codes > Insert Forced Authorization

Codes.

Step 2 In the File Name drop-down list box, choose the CSV file that contains the updated codes.

To view the contents of the file that you want to insert, click View File.Tip

Step 3 If you are updating an existing list of codes, check the Override the existing configuration check box.
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See BAT Settings to Update CMC and FAC in the Database, on page 463 for configuration details.

Step 4 In the Job Information area, enter the Job description.
Step 5 Choose an insert method. Do one of the following:

a) Click Run Immediately to insert FAC and CMC immediately.
b) Click Run Later to insert FAC and CMC at a later time.

Step 6 To create a job for inserting FAC and CMC, click Submit.
Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
BAT Settings to Update CMC and FAC in the Database, on page 463
Manage Scheduled Jobs, on page 599
Topics Related to CMC and FAC Configuration, on page 463

BAT Settings to Update CMC and FAC in the Database
The following table provides descriptions of the BAT update configuration settings for CMC and FAC.

Table 45: Settings in BAT for Inserting CSV Files

DescriptionSetting in BAT

From the drop-down list box, choose the CMC or FAC file that you want
to insert.

File Name

This check box applies if you are updating code for existing settings.

Checking this check box overwrites the existing authorization code name
(FAC), authorization level (FAC), or description (CMC)with the information
that is contained in the file that you want to insert (existing authorization
and client matter codes do not change). If you do not check the check box,
an error, which writes to the log file, indicates that the authorization or client
matter code already exists; therefore, no updates occur.

Override the existing
configuration

Topics Related to CMC and FAC Configuration
• Implement CMC and FAC Features, on page 458

• CMC and FAC Setup Using BAT, on page 457

• Create CMC and FAC CSV Data File Using BAT.xlt, on page 459

• CSV Data File Creation for Client Matter Codes and Forced Authorization Codes Using Text Editor, on
page 460

• Edit Existing CMC or FAC CSV Data File, on page 460
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• Code Setting Deletion Examples, on page 465

• CMC and FAC CSV Data File Settings, on page 461

• Update CMC or FAC in CUCM Database Using BAT, on page 462

• BAT Settings to Update CMC and FAC in the Database, on page 463

• Create Custom Text-Based CSV Files for Client Matter Codes and Forced Authorized Codes, on page
655
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C H A P T E R 55
Forced Authorization Codes and Client Matter
Code Deletions

This chapter provides information to delete CMC and FAC codes from the system using a custom file that
contains the codes that you want to delete. You can edit a custom file where you previously inserted or updated
authorization codes, or you can create a new CSV file where you manually enter the codes that you want to
delete.

• Code Setting Deletion Examples, on page 465
• Delete Forced Authorization Codes and Client Matter Codes, on page 467
• Topics Related to Forced Authorization Codes and Client Matter Codes, on page 468

Code Setting Deletion Examples
If you plan to edit an existing CSV file, you must update the file, so only the lines that contain the codes that
you want to delete remain in the file.

Example for CMC (Existing CSV File)

You obtain a file that contains the following information, and you decide to delete the client matter codes,
5550, 5551, and 5555:

• 5550,Phil Jones DDS

• 5551,Southwest Shades

• 5552,Happy Pharmaceuticals

• 5553,Weddings by Joyce

• 5554,Peterson Plumbing

• 5555,Acme Toys

• 5556,Chicago Paralegals

Before you delete the entries, the file must contain only the following entries:

• 5550,Phil Jones DDS

• 5551,Southwest Shades
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• 5555,Acme Toys

Example for CMC (New CSV File)

If you create a new file to delete the codes, list only the codes, separated by lines, as shown in the following
example:

5550

5551

5555

Example for FAC (Existing CSV File)

You obtain a file that contains the following information, and you decide to delete the authorization codes
that are assigned to John, Dave, and Bill:

• 1233,Sandy Brown,30

• 1234,John Smith,20

• 1235,Dave Green,30

• 1236,John David,20

• 1237,Alex Anderson,30

• 1238,Bill Jones,20

• 1239,Jennifer Summers,20

Before you can delete the entries for John, Dave, and Bill, the file must contain only the following entries:

• 1234,John Smith,20

• 1235,Dave Green,30

• 1238,Bill Jones,20

Example for FAC (New File)

If you create a new file to delete the codes, list only the codes, separated by lines, as shown in the following
example:

1234

1235

1238

Related Topics
Delete Forced Authorization Codes and Client Matter Codes, on page 467
Topics Related to Forced Authorization Codes and Client Matter Codes, on page 468
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Delete Forced Authorization Codes and Client Matter Codes
You can delete CMC and FAC records using a custom CSV file.

Do not use the insert or export transaction files that are created with bat.xlt for the delete transaction. Instead,
you must create a custom file with details of the CMC or FAC records that need to be deleted. Use only this
file for the delete transaction. In this custom delete file, you do not need a header, and you can enter values
for codes.

Note

Before you begin

• Create a new CSV file for codes that you want to delete using one of the following tasks:

• For CMC, see Example for CMC (New CSV File), on page 466.

• For FAC, see Example for FAC (Existing CSV File), on page 466.

• On the server download the appropriate CSV files from the first node of the server. For more information,
see Download File Off Server, on page 20.

• In a text editor, open and edit the existing CSV file to delete the entries.

• Upload the modified CSV files to the first node of the server. For more information, see Upload File to
Server, on page 21.

Procedure

Step 1 In Administration, choose one of the following options, depending on whether you plan to delete client matter
codes or forced authorization codes:
a) For CMC, choose Bulk Administration > Client Matter Codes > Delete Client Matter Codes
b) For FAC, choose Bulk Administration > Forced Authorization Codes >Delete Forced Authorization

Codes

Step 2 Choose a custom file from the drop-down list and click Find.
The Find and List Client Matter Codes window or Find and List Forced Authorization window displays.

Step 3 In the Job Information area, enter the Job description.
Step 4 Choose a delete method. Do one of the following:

a) Click Run Immediately to delete CMC or FAC immediately.
b) Click Run Later to delete CMC or FAC at a later time.

Step 5 Click Submit to create a job for deleting FAC and CMC.
Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Make sure that you browse the entire list of the displayed results before submitting the job for
deletion.

Caution
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Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Topics Related to Forced Authorization Codes and Client Matter Codes, on page 468

Topics Related to Forced Authorization Codes and Client Matter
Codes

• Implement CMC and FAC Features, on page 458

• CMC and FAC Setup Using BAT, on page 457

• Create CMC and FAC CSV Data File Using BAT.xlt, on page 459

• CSV Data File Creation for Client Matter Codes and Forced Authorization Codes Using Text Editor, on
page 460

• Edit Existing CMC or FAC CSV Data File, on page 460

• CMC and FAC CSV Data File Settings, on page 461

• Update CMC or FAC in CUCM Database Using BAT, on page 462

• Code Setting Deletion Examples, on page 465
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P A R T X
Call Pickup Groups

• Manage Call Pickup Groups, on page 471
• Call Pickup Group Deletions, on page 477





C H A P T E R 56
Manage Call Pickup Groups

This chapter provides information to set up call pickup groups using BAT. Call pickup allows you to pick up
incoming calls within your own groups or in other groups when you dial the appropriate pickup group number.

• Call Pickup Group Setup Using BAT, on page 471
• Create Call Pickup Group CSV Data File Using BAT.xlt, on page 472
• CSV Data File Creation for Call Pickup Groups Using Text Editor, on page 473
• Edit Existing Call Pickup Group CSV Data File, on page 473
• Call Pickup Group CSV File Settings, on page 474
• Update Call Pickup Groups in CUCM Database Using BAT, on page 475
• BAT Settings to Update Pickup Groups in the Database, on page 475
• Topics Related to Call Pickup Groups, on page 476

Call Pickup Group Setup Using BAT
Before you use BAT to set up call pickup groups, review the following information:

• When you add call pickup group settings for the first time, you can create a CSV file through BAT.xlt
or create a custom, text-based CSV file.

• To update call pickup group settings, you can edit an existing CSV file or create a custom, text-based
CSV file.

• Designate a single line for each pickup group name (and corresponding setting). For example, use the
following format when you enter information for pickup groups:

• (Pickup Group Name, Pickup Group Number, Partition, Other Pickup Group Name-Member1...
Other Pickup Group Name-Member10)

• Marketing,7815,Part1,Marketing,Managers,Training

• When you add new pickup groups, you must complete all required fields like the pickup group name
and pickup group number. If the procedure specifies an entry as mandatory, you must provide the
information in the file.

• Deleting information from a file and leaving the information blank does not remove the information from
the Cisco Unified Communications Manager database; in other words, a blank value does not overwrite
an existing value in the database. Updating the values overwrites the existing value in the database.

• Upload the appropriate CSV files to the first node of the Cisco Unified CommunicationsManager cluster.
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• Any time that you create or change a CSV file, you must insert the CSV file in BAT to update the Cisco
Unified Communications Manager database.

Create Call Pickup Group CSV Data File Using BAT.xlt
You can create the CSV file for call pickup groups using the BAT spreadsheet BAT.xlt.

The BAT.xlt file exists on the first node of the Cisco Unified Communications Manager server; however, you
normally do not have Microsoft Excel installed on the server. In that case, copy the file from the first node
and move it to a local machine that has Microsoft Excel installed.

Note

Before you begin

Review important considerations in Call Pickup Group Setup Using BAT, on page 471 before you use BAT
to configure call pickup.

Procedure

Step 1 Choose Bulk Administration > Upload/Download Files.
The Find and List Files window opens.

Step 2 Click Find and download the BAT.xlt file.
Step 3 Copy BAT.xlt to a local machine where Microsoft Excel is installed.
Step 4 To open the BAT Spreadsheet, locate and double-click the BAT.xlt file.
Step 5 When prompted, click Enable Macros to use the spreadsheet capabilities.
Step 6 Click the Call Pickup Group tab.
Step 7 Enter call pickup group settings in the columns.

See Table 46: Configuration Settings for Call Pickup Groups, on page 474 for descriptions of configuration
settings.

Repeat Step 7, on page 472 until you enter all pickup groups.Note

Step 8 To transfer the Excel spreadsheet format to a CSV file, click Export to BAT Format.

The system automatically saves CSV files to C:\XlsDatafiles on the local machine.

Click Browse to choose a different location.Tip

What to do next

Upload the CSV files to the first node of the Cisco Unified Communications Manager server.

You must add the CSV file to BAT and insert the file to update the Cisco Unified Communications Manager
database.
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Related Topics
Download File Off Server, on page 20
Topics Related to Call Pickup Groups, on page 476
Update CMC or FAC in CUCM Database Using BAT, on page 462
File Upload and Download, on page 17
Upload File to Server, on page 21

CSV Data File Creation for Call Pickup Groups Using Text Editor
You can use a text editor to create the text-based CSV data file for call pickup groups. The comma separated
values (CSV) file provides textual information in tabular form and contains lines of ASCII text with values
separated by commas.

Related Topics
Create Text-Based CSV File for Call Pickup Groups, on page 658
Topics Related to Call Pickup Groups, on page 476

Edit Existing Call Pickup Group CSV Data File
You update existing codes by manually updating an existing CSV file or creating a new CSV file using a text
editor.

When you update the Pickup Groups, existing Other Pickup Groups will be disassociated. Do not leave Other
Pickup Group as blank fields. Enter all Other Pickup Groups, that you want to associate with Pickup Group,
continuously.

You can change any part of an existing record, but you must include the pickup group name.

Caution

Procedure

Step 1 To edit an existing CSV data file, download the CSV file from the first node of the Cisco Unified
Communications Manager server to your local workstation.

Step 2 Open and edit the existing CSV file using a text editor.
Delete existing settings, add new call pickup groups, or update existing settings. See Table 46: Configuration
Settings for Call Pickup Groups, on page 474 for descriptions of configuration settings.

Example:

To update a call pickup group CSV file, you may enter Marketing,,,Marketing,Managers,Training, where
Marketing is the mandatory pickup group name. Marketing, Managers, and Training are the other pickup
group names associated to the pickup group Marketing.
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You can change any part of an existing record, but you must include the pickup group name.
When you update the Pickup Groups, existing Other Pickup Groups will be disassociated. Do
not leave Other Pickup Group as blank fields. Enter all Other Pickup Groups, that you want to
associate with Pickup Group, continuously.

Caution

What to do next

Upload the CSV files to the first node of the Cisco Unified Communications Manager server.

You must add the CSV file to BAT and insert the file to update the Cisco Unified Communications Manager
database.

Related Topics
Download File Off Server, on page 20
Topics Related to Call Pickup Groups, on page 476
Update CMC or FAC in CUCM Database Using BAT, on page 462
Upload File to Server, on page 21

Call Pickup Group CSV File Settings
The following table provides descriptions of the configuration settings for call pickup groups.

Table 46: Configuration Settings for Call Pickup Groups

DescriptionSetting/Column

For CPG CSV file

For this mandatory field, enter a unique call pickup
group name of nomore than 50 alphanumeric characters.

Pickup Group Name

For this mandatory field, enter a pickup group number
of no more than 24 digits that the user will enter to pick
up incoming calls.

Pickup Group Number

Choose a route partition to which the directory number
(pickup group number) belongs.

The directory number (pickup group) can
appear in more than one partition.

Note

The combination of PickupGroupNumber
and Partition should be unique.

Note

This field is optional.

Partition

Enter the name of the other pickup group to be associated
with the new pickup group. This optional field allows
each pickup group to be associated with maximum of
ten other pickup groups.

Other Pickup Group
Name-Member(x)
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Update Call Pickup Groups in CUCM Database Using BAT
To update the Cisco Unified Communications Manager database, you must insert the call pickup group CSV
data file using BAT.

Before you begin

Before you can update pickup groups in Cisco Unified Communications Manager database, you must create
or edit a call pickup group CSV file and upload it on the first node on the Cisco Unified Communications
Manager server.

Procedure

Step 1 Choose Bulk Administration > Call Pickup Group > Insert Call Pickup Groups.
The Insert Pickup Groups window displays.

Step 2 In the File Name drop-down list box, choose the CSV file that contains the updated call pickup groups.

To view the contents of the file that you want to insert, click View File.Tip

Step 3 If you updated an existing list of call pickup groups, check the Override the existing configuration check
box.
See BAT Settings to Update Pickup Groups in the Database, on page 475 for descriptions of configuration
settings.

Step 4 In the Job Information area, enter the Job description.
Step 5 Choose an insert method. Do one of the following:

a) Click Run Immediately to insert pickup groups immediately.
b) Click Run Later to insert pickup groups at a later time.

Step 6 Click Submit to create a job for inserting pickup groups.
Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Topics Related to Call Pickup Groups, on page 476
Upload File to Server, on page 21

BAT Settings to Update Pickup Groups in the Database
The following table provides descriptions of BAT update configuration settings for pickup groups.
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Table 47: Settings in BAT for Inserting CSV Files

DescriptionSetting in BAT

From the drop-down list box, choose the call pickup file that you want
to insert.

File Name

This check box applies if you are updating pickup groups for existing
settings.

Checking this check box overwrites the other pickup group name-
members with the information that is contained in the file that you want
to insert. If you do not check the check box, an error, which writes to the
log file, indicates that the other pickup group name already exists;
therefore, no updates occur.

For each pickup group, ensure the combination of Pickup
Group Number and Partition is unique.

Note

While updating pickup groups, Pickup Group Number and
Partition values will be ignored and existing Other Pickup
Groups will be disassociated.

Note

Override the existing
configuration

Topics Related to Call Pickup Groups
• Call Pickup Group Setup Using BAT, on page 471

• Create Call Pickup Group CSV Data File Using BAT.xlt, on page 472

• CSV Data File Creation for Call Pickup Groups Using Text Editor, on page 473

• Edit Existing Call Pickup Group CSV Data File, on page 473

• Delete Call Pickup Groups, on page 477

• Call Pickup Group CSV File Settings, on page 474

• Update Call Pickup Groups in CUCM Database Using BAT, on page 475

• BAT Settings to Update Pickup Groups in the Database, on page 475

• Create Text-Based CSV File for Call Pickup Groups, on page 658
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C H A P T E R 57
Call Pickup Group Deletions

This chapter provides information to delete call pickup groups by creating a query to locate the pickup group
records you want to delete.

• Delete Call Pickup Groups, on page 477

Delete Call Pickup Groups
You can use BAT to delete call pickup groups.

Procedure

Step 1 Choose Bulk Administration > Call Pickup Group > Delete Call Pickup Groups
The Find and List Call Pickup Groups window displays.

Step 2 In first Find Call Pickup Groups where drop-down list box, choose from the following options:

• Pickup Group Number

• Pickup Group Name

• Partition

Step 3 From the second Find Call Pickup Groups where drop-down list box, choose one of the following criteria:

• begins with

• contains

• is exactly

• ends with

• is empty

• is not empty

Step 4 Specify the appropriate search text, if applicable, and click Find.
To add multiple filters, check the Search Within Results check box and select, AND or OR. To further define
your query, repeat Step 2, on page 477 through Step 4, on page 477.
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Step 5 In the Job Information area, enter the Job description.
Step 6 Choose a delete method. Do one of the following:

a) Click Run Immediately to delete pickup groups immediately.
b) Click Run Later to delete pickup groups at a later time.

Step 7 Click Submit to create a job for deleting pickup groups.

If you do not enter any information in the query text box, the system creates a job for deleting
all pickup group records.

Note

Confirm that you want to delete all the pickup groups displayed in the result set by browsing the
entire set of results, before submitting a job for deleting call pickup groups.

Caution

Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
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P A R T XI
Mobility

• Access List, on page 481
• Remote Destination, on page 485
• Remote Destination Profiles, on page 489
• Mobility Profile, on page 503





C H A P T E R 58
Access List

This chapter provides information to use the Bulk Administration menu to insert, delete, and export access
lists. An access list comprises a sequential list that consists of at least one permit statement and possibly one
or more deny statements that apply to IP addresses and possibly upper-layer IP protocols. The access list has
a name by which it is referenced. Many software commands accept an access list as part of their syntax.

• Insert Access Lists, on page 481
• Delete Access Lists, on page 482
• Export Access Lists, on page 482

Insert Access Lists
You can insert access lists using BAT.

Before you begin

• You must have a data file in comma separated value (CSV) format that contains the unique details for
the access lists.

• Upload the data files by choosing the relevant target and function for the transaction.

Procedure

Step 1 Choose Bulk Administration > Mobility > Access List > Access List Insert.
The Insert Access List Configuration window displays.

Step 2 From the File Name drop-down list box, choose the file that you uploaded.
Step 3 To override the existing configuration, check the Override the existing configuration check box.
Step 4 In the Job Information section, enter a description for the job.

The default description specifies Insert Access List.
Step 5 You can choose to run the job immediately or later by selecting the corresponding radio button.
Step 6 To create a job for inserting the access list, click Submit.

A message in the Status section lets you know that the job was submitted successfully.
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Step 7 To schedule and/or activate this job, use the Job Scheduler option in the Bulk Administration main menu.

Related Topics
Upload File to Server, on page 21

Delete Access Lists
You can delete access lists using BAT.

Before you begin

• You must have a data file that contains the access list names.

• Upload the data files by choosing the relevant target and function for the transaction.

Do not use the insert or export transaction files that are created with bat.xlt for
the delete transaction. Instead, you must create a custom file with details of the
access list records that need to be deleted. Use only this file for the delete
transaction. In this custom delete file, you do not need a header, and you can enter
values for access list names.

Note

Procedure

Step 1 Choose Bulk Administration > Mobility > Access List > Access List Delete.
The Delete Access List Configuration window displays.

Step 2 From theDelete Access List where name in custom file drop-down list box, choose the file that you uploaded
for deleting access list, and click Find.

Step 3 The Job Information section displays along with the selected access list.
Step 4 You can choose to run the job immediately or later by selecting the corresponding radio button.
Step 5 To create a job for deleting the access list, click Submit.

A message in the Status section lets you know that the job was submitted successfully.

Step 6 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
Upload File to Server, on page 21

Export Access Lists
You can export access lists using BAT.
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If you are accessing help from the Export Access List Configuration window, skip to Step 8, on page 483.Note

Procedure

Step 1 Choose Bulk Administration > Mobility > Access List > Access List Export. The Export Access List
Configuration window displays.

Step 2 From the first Find Access List where drop-down list box, choose one of the following options.

• Name
• Description
• Owner

Step 3 From the second Find Access List where drop-down list box, choose one of the following options.

• begins with
• contains
• ends with
• is exactly
• is empty
• is not empty

Step 4 Specify the appropriate search text, if applicable.

To find all files that are registered in the database, click Find without entering any search text.Tip

Step 5 To further define your query, you can:
a) Choose AND or OR from the drop-down box and repeat Step 2, on page 483 through Step 4, on page 483.
b) Add multiple filters by clicking the + button, and remove them by clicking the — button.
c) Remove all the filters at once by clicking the Clear Filter button.

Step 6 Click Find.

A list of discovered files displays by

• Name
• Description
• Allowed
• Owner

Step 7 Click Next.
The next Export Access List Configuration window displays.

Step 8 In the Export Access Lists section, enter a file name in the File Name field.
Step 9 From the Bulk Access List Export Format drop-down list box, choose Access List Format.
Step 10 You can choose to run the job immediately or later by selecting the corresponding radio button in the Job

Information section.
Step 11 To create a job for exporting the access list, click Submit.

A message in the Status section lets you know that the job was submitted successfully.
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Step 12 To schedule and/or activate this job, use the Job Scheduler option in the Bulk Administration main menu.
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C H A P T E R 59
Remote Destination

This chapter provides information to use BAT to insert, delete, and export remote destination details.

• Insert Remote Destination, on page 485
• Delete Remote Destination, on page 486
• Export Remote Destination, on page 487

Insert Remote Destination
You can insert remote destination details using BAT.

Before you begin

• You must have a data file in comma separated value (CSV) format that contains the unique details for
the remote destination.

You must enter the time zone details without parenthesis or asterisk. For example,
if you are entering GreenwichMean Time as the time zone, enter it as “Etc/GMT”
and not “(GMT) Etc/GMT*”.

Note

• Upload the data files by choosing the relevant target and function for the transaction.

Procedure

Step 1 Choose Bulk Administration > Mobility > Remote Destination > Remote Destination Insert.
Step 2 From the File Name drop-down list box, choose the file that you uploaded.
Step 3 To override the existing configuration, check the Override the existing configuration check box.
Step 4 In the Job Information section, enter a description for the job. Insert Remote Destination specifies the

default description.
Step 5 You can choose to run the job immediately or later by selecting the corresponding radio button.
Step 6 To create a job for inserting the remote destination, click Submit.

A message in the Status section lets you know that the job was submitted successfully.
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Step 7 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Upload File to Server, on page 21

Delete Remote Destination
You can delete remote destinations using BAT.

Before you begin

• You must have a data file in comma separated value (CSV) format that contains the unique details for
the remote destination.

Do not use the insert or export transaction files that are created with bat.xlt for
the delete transaction. Instead, you must create a custom file with details of the
remote destination records that need to be deleted. Use only this file for the delete
transaction. In this custom delete file, you do not need a header, and you can enter
values for name, or description.

Note

• Upload the data files by choosing the relevant target and function for the transaction.

Procedure

Step 1 Choose Bulk Administration > Mobility > Remote Destination > Remote Destination Delete.
Step 2 From the Delete Remote Destination where drop-down list box, choose one of the following options:

• Name

• Destination

• Remote Destination Profile

• Dual Mode Phone

Step 3 From the custom file drop-down list box, choose the file that you uploaded for deleting remote destination,
and click Find.

Step 4 The Job Information section displays along with the selected remote destination.
Step 5 You can choose to run the job immediately or later by selecting the corresponding radio button.
Step 6 To create a job for deleting the remote destination, click Submit.

A message in the Status section lets you know that the job was submitted successfully.

Step 7 To schedule and/or activate this job, use the Job Scheduler option in the Bulk Administration main menu.
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When you delete a remote destination, the time-of-day access, time period, and time schedule
records associated with the remote destination also get deleted.

Attention

Related Topics
Upload File to Server, on page 21

Export Remote Destination
You can export a remote destination using BAT.

If you are accessing help from the secondExport Remote Destination Configurationwindow after selecting
the remote destination for export, skip to Step 8, on page 488.

Note

Procedure

Step 1 Choose Bulk Administration > Mobility > Remote Destination > Remote Destination Export.
The Export Remote Destination Configuration window displays.

Step 2 From the first Find Remote Destination where drop-down list box, choose one of the following options:

• Name
• Destination
• Remote Destination Profile
• Dual Mode Phone

Step 3 From the second Find Remote Destination where drop-down list box, choose one of the following options:

• begins with
• contains
• ends with
• is exactly
• is empty
• is not empty

Step 4 Specify the appropriate search text, if applicable.

To find all files that are registered in the database, click Find without entering any search text.Tip

Step 5 To further define your query, you can
a) Choose AND or OR from the drop-down box, and repeat Step 2, on page 487 through Step 4, on page 487.
b) Add multiple filters by clicking the + button, and remove them by clicking the — button.
c) Remove all the filters at once by clicking the Clear Filter button.

Step 6 Click Find.

A list of discovered files displays by

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
487

Mobility
Export Remote Destination



• Name
• Destination
• Remote Destination Profile
• Dual Mode Phone

Step 7 Click Next.
The next Export Remote Destination Configuration window displays.

Step 8 In the Export Remote Destination section, enter a file name in the File Name field.
Step 9 From the File Format drop-down list box, choose Remote Destination Format.
Step 10 You can choose to run the job immediately or later by selecting the corresponding radio button in the Job

Information section.
Step 11 To create a job for exporting the remote destination, click Submit.

A message in the Status section lets you know that the job was submitted successfully.

Step 12 To schedule and/or activate this job, use the Job Scheduler option in the Bulk Administration main menu.
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C H A P T E R 60
Remote Destination Profiles

This chapter provides information to use the Bulk Administration menu to format, insert, delete, and export
Remote Destination Profiles (RDPs) in batches, rather than performing individual updates through CiscoUnified
Communications Manager Administration.

• Remote Destination Profile Templates, on page 489
• Remote Destination Profile File Format, on page 494
• Remote Destination Profile Insertions, on page 498
• Remote Destination Profile Deletions, on page 499
• Remote Destination Profile Exports Using Export Utility, on page 500

Remote Destination Profile Templates
You can use BAT remote destination profile templates to define common attributes for remote destinations
such as device pool, location, calling search space, presence group, and privacy information.

Related Topics
Add or Update Lines in Remote Destination Profile Template, on page 491
Create Remote Destination Profile Template, on page 490
Delete Remote Destination Profile Template, on page 491
Find Remote Destination Profile Template, on page 489

Find Remote Destination Profile Template
Because you might have several remote destination profile (RDP) templates, Cisco Unified Communications
Manager lets you locate specific templates on the basis of specific criteria.

Procedure

Step 1 Choose Bulk Administration > Mobility > Remote Destination Profiles > Remote Destination Profile
Template.
The Find and List Remote Destination Templates window displays. Use the two drop-down list boxes to
search for a template.

Step 2 From the first Find UDP Templates where drop-down list box, choose one of the following criteria:
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• Name
• Description
• Device Pool
• Calling Search Space

From the second Find Remote Destination Template where drop-down list box, choose one of the following
criteria:

• begins with
• contains
• ends with
• is exactly
• is empty
• is not empty

Step 3 Specify the appropriate search text, if applicable, and click Find.

To find all remote destination templates that are registered in the database, click Find without
entering any search text.

Tip

A list of discovered templates displays by:

• Template Name
• Description
• Device Pool
• Calling Search Space

Step 4 From the list of records, click the template name that matches your search criteria.

The Remote Destination Profile Template Configuration window displays.

Create Remote Destination Profile Template
You can create a template to add remote destination profiles in bulk.

Procedure

Step 1 Choose Bulk Administration > Mobility > Remote Destination Profiles > Remote Destination Profile
Template.

Step 2 Click Add New.
The Remote Destination Template Configuration window displays.

Step 3 Enter configuration details in the fields that display.
See Remote Destination Profile Template Field Descriptions, on page 492 for field descriptions.

Step 4 Click Save.
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What to do next

When the status indicates that the transaction has completed, you can add line attributes.

Add or Update Lines in Remote Destination Profile Template
You can add one or more lines to the BAT template or to update existing lines.

Procedure

Step 1 Find the RDP Template to which you want to add line.
Step 2 In the Remote Destination Profile Template Configuration window, click Line [1] Add a new DN in the

Association Information area.
Step 3 Enter or choose the appropriate values for the line settings that are described in Table 3: Field Descriptions

for Adding a Line to a BAT Template, on page 65, and click Save.

BAT adds the line to the phone template configuration. All RDPs in this batch will use the settings that you
choose for this line.

After you enter or choose the appropriate values, you must return to this page to complete the
procedure.

Note

Step 4 Repeat Step 2, on page 491 through Step 3, on page 491 to add settings for any additional lines.

If you choose Back to Find/List from the Related Links drop-down list box in the upper, right
corner of the Line Template Configuration window, the Find and List Directory Numbers
window displays. To find existing line template, enter the appropriate search criteria and click
Find. To add a new line template, click Add New on Find and List Line Template window.

Note

Cisco recommends that you use alphanumeric characters for Line Template. This is because, if numbers are
given, a chance exists of conflict with an actual directory number. Using this method, you also avoid conflicts
with features such as Call Pickup group number, Call Park number, and so on.

Related Topics
Find Remote Destination Profile Template, on page 489

Delete Remote Destination Profile Template
You can delete RDP templates when you no longer require them.

Procedure

Step 1 Find the RDP Template that you want to delete.
Step 2 In the Find and List Remote Destination Profile Templates window, check the check box next to the

template that you want to delete and click Delete Selected.

A message displays that asks you to confirm the delete operation.
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Step 3 To delete the template, click OK. The template name disappears from the list of templates on the Find and
List Remote Destination Profile Templates window.

If you submit a job that uses a particulate RDP template and if you delete the template, the job
also gets deleted.

Caution

Related Topics
Find Remote Destination Profile Template, on page 489

Remote Destination Profile Template Field Descriptions
The following table provides field descriptions for Remote Destination Profile Template.

In the BAT user interface, field names that have an asterisk require an entry. Treat fields that do not have an
asterisk as optional.

Note

Table 48: Field Descriptions for Remote Destination Profile Template

DescriptionField

Enter template name.Template Name

Enter a description for the RDP template that you want to create.
The description can include up to 50 characters in any language,
but it cannot include double-quotes ("), percentage sign (%),
ampersand (&), back-slash (\), or angle brackets (<>).

Description

Provide a Cisco Unified Communications Manager user ID.User ID

Choose a device pool for this group of RDPs.Device Pool

Choose the calling search space for this group of RDPs.

A calling search space specifies the collection of Route Partitions
that are searched to determine how a dialed number should be
routed.

Calling Search Space

Choose the media resource group list (MRGL) for this group of
RDPs.

An MRGL specifies a list of prioritized media resource groups.
An application can choose required media resources from the
available ones according to the order that is defined in theMRGL.

Media Resource List

Choose the user hold audio source for this group of RDPs.

The user hold audio source identifies the audio source fromwhich
music is played when a user places a call on hold.

User Hold Audio Source
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DescriptionField

Choose the music on hold audio source to be played when the
system places a call on hold while the user transfers a call or
initiates a conference or call park.

Network Hold MOH Audio Source

Choose the appropriate location for this group of RDPs.

The location specifies the total bandwidth that is available for
calls to and from this location. A location setting of None means
that the locations feature does not keep track of the bandwidth
that this device consumes.

Location

From the drop-down list box, choose the locale that is associated
with the phone user interface. The user locale identifies a set of
detailed information to support users, including language and
font.

Cisco Unified Communications Manager makes this field
available only for phone models that support localization.

If no user locale is specified, Cisco Unified
Communications Manager uses the user locale that
is associated with the device pool.

Note

If the users require that information be displayed
(on the phone) in any language other than English,
verify that the locale installer is installed before
configuring user locale. Refer to the Cisco Unified
Communications Manager Locale Installer
documentation.

Note

User Locale

Choose On, Off, or Default in the Privacy drop-down list box.Privacy

If you want the RDP to receive the status of the presence entity,
choose a Presence Group that is allowed to view the status of the
Presence Group that is applied to the directory number, as
indicated in the Presence Group Configuration window.

Presence Group

From the drop-down list box, choose a calling search space to
use for rerouting.

The rerouting calling search space of the referer gets used to find
the route to the refer-to target. When the Refer operation fails
due to rerouting of the calling search space, the Refer Primitive
rejects the request with the “405Method Not Allowed” message.

The redirection (3xx) primitive and transfer feature also uses the
rerouting calling search space to find the redirect-to or transfer-to
target.

Rerouting Calling Search Space

Check this check box to enable Cisco Unified Communications
Manager to ignore any presentation restriction that is received
for internal calls.

Ignore Presentation Indicators (internal
calls only)
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Remote Destination Profile File Format
You can configuring file formats for CSV data files that are created using a text editor.

Related Topics
Associate Remote Destination File Format with CSV Data File, on page 497
Remote Destination Profile File Format Configuration, on page 495
Create Text-Based CSV File for Remote Destination Profile, on page 660
CSV Data File Creation for Remote Destination Using Text Editor, on page 494
Find Remote Destination File Format, on page 494

CSV Data File Creation for Remote Destination Using Text Editor
You can create the CSV data file by using lines of ASCII text with values separated by commas. The comma
separated values (CSV) file provides textual information in tabular form.

You cannot modify or delete the Default Remote Destination file format.

When you use the Cisco Unified Communications Manager Bulk Administration (BAT) spreadsheet to create
the CSV data file, you can create the file format within the spreadsheet. When you use a text editor to create
the CSV data file, you need to create a file format or use the default file format. You enter the values in the
text-based file in the same order as specified in the file format.

Note

Related Topics
Create Text-Based CSV File for Remote Destination Profile, on page 660

Find Remote Destination File Format
You can find a remote destination file format using BAT.

Procedure

Step 1 ChooseBulk Administration >Mobility >Remote Destination Profile >Remote Destination Profile File
Format > Create File Format.
The Create Remote Destination Profile File Format Configuration window displays.

Step 2 From theRelated Links drop-down list box on the top, right corner of the window, chooseBack to Find/List
and click Go.

Step 3 From the Find Remote Destination File Format where Format Name drop-down list box, choose one of
the following criteria:

• begins with
• contains
• ends with
• is exactly
• is empty
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• is not empty

Step 4 Specify the appropriate search text, if applicable, and click Find.

To find all Remote Destination Profile formats, click Find without entering any search text.Tip

Step 5 To further define your query and to add multiple filters, check the Search Within Results check box and
choose AND or OR from the drop-down box, and repeat Step 3, on page 494 and Step 4, on page 495.

Step 6 From the list of records, click the file format name that matches your search criteria.
The Remote Destination File Format Configuration window displays.

Remote Destination Profile File Format Configuration
You can create, find, copy, modify, or delete a Remote Destination Profile file format using BAT.

Related Topics
Create Remote Destination Profile File Format, on page 495
Copy Remote Destination Profile File Format, on page 496
Modify Remote Destination Profile File Format, on page 496
Delete Remote Destination Profile File Format, on page 497

Create Remote Destination Profile File Format
You can create your file format for the text-based CSV data file.

Procedure

Step 1 ChooseBulk Administration >Mobility >Remote Destination Profile >Remote Destination Profile File
Format > Create File Format.
The Remote Destination Profile File Format Configuration window displays.

Step 2 In the Format Name field, enter a name for this custom format.
Step 3 Under Device Fields, choose the device field names that you want to define for each Remote Destination

Profile. In theDevice Field box, click a device field name and click the arrow to move the field to the Selected
Device Fields box.

A CSV data file must include Remote Destination Profile Name and Description; therefore, these fields always
remain selected.

You can select several random field names in the list by holding down the Ctrl key and then
clicking the arrow to select them together. You can select a range of items by using the Shift key.

Tip

Step 4 Click line field names in theLine Field box and click the arrow to move the fields to the Selected Line Fields
box.

You can change the order of the items in the Selected Line Fields and Selected Device Fields
Order boxes. Select an item and then use the up arrow to move the item closer to the beginning
of the list or the down arrow to move it to the end of the list.

Tip
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Step 5 In the IP Phone Services Maximums area, enter the maximum value in the Maximum Number of Lines
field.

Step 6 To save your custom file format, click Save. The name of the file format displays in the File Format Names
list in the Find and List Remote Destination Profile File Formats window.

Copy Remote Destination Profile File Format
You can copy an existing format for the CSV data file using BAT.

Procedure

Step 1 Find the Remote Destination Profile file format that you want to copy.
Step 2 In the Search Results area, choose a file format that you want to copy.

The Remote Destination Profile File Format Configuration window displays.
Step 3 To make a copy of the chosen file format, click Copy.

To copy the file format, you can also click the corresponding Copy icon in the Find and List
Remote Destination Profile File Formats window.

Note

Step 4 In the Format Name field, enter a new name for the copied format.
Step 5 Modify the copied format using any of these methods:

• Add new fields by choosing them from theDevice Fields or Line Fields box and then clicking the arrow
to move the chosen fields into the Selected Device Field or Selected Line Fields Order box.

• Remove selected fields by choosing them from the Selected Device Fields or Selected Line Fields
Order box and then clicking the arrow to move the chosen fields into the Device Fields or Line Fields
box.

• Change the order of the fields by choosing a field name in the Selected Device Fields or Selected Line
Fields Order box and using the up or down arrow to change its location.

Step 6 After making your changes, click Save to save the copied file format with changes in the list.

Related Topics
Find Remote Destination File Format, on page 494

Modify Remote Destination Profile File Format
You can modify an existing file format for the CSV data file using BAT. You can modify custom formats
only.

Procedure

Step 1 Find the Remote Destination Profile file format that you want to modify.
Step 2 In the Search Results area, choose a file format that you want to modify.

The Remote Destination Profile File Format Configuration window displays.
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Step 3 Modify the copied format using any of these methods:

• Add new fields by choosing them from theDevice Fields or Line Fields box and then clicking the arrow
to move the chosen fields into the Selected Device Field or Selected Line Fields Order box.

• Remove selected fields by choosing them from the Selected Device Fields or Selected Line Fields
Order box and then clicking the arrow to move the chosen fields into the Device Fields or Line Fields
box.

You cannot remove the required fields: Remote Destination Profile Name, and Description.Note

• Change the order of the fields by choosing a field name in the Selected Device Fields Order or Selected
Line Fields Order box and using the up or down arrow to change its location.

Step 4 After making your changes, click Save to save the changes to the file format.

Related Topics
Find Remote Destination File Format, on page 494

Delete Remote Destination Profile File Format
You can delete an existing file format for the CSV data file. You can delete only custom formats.

Procedure

Step 1 Find the Remote Destination Profile file format that you want to delete.
Step 2 In the Search Results area, verify that this is the file(s) that you want to delete and check the check box to

select the format(s).
Step 3 To remove the file format(s) from the list, click Delete Selected. A message asks you to confirm that you

want to delete the file format(s). Click OK to continue.

Make sure to browse the entire list of displayed results before clicking Delete Selected.Attention

The system removes the file format(s) name from the list.

Related Topics
Find Remote Destination File Format, on page 494

Associate Remote Destination File Format with CSV Data File
You can add the file format with the text-based CSV data file. When you used a text editor to create the CSV
data file, you created a file format for entering values in the text-based file. You entered values in the text file
in the order that the file format specified

After the CSV data file is completed, you need to associate the file format with the text-based CSV data file.
After associating the file format with the CSV file, the names for each field display as the first record in the
CSV data file. You can use this information to verify that you entered the values for each field in the correct
order.
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Procedure

Step 1 ChooseBulk Administration >Mobility >Remote Destination Profile >Remote Destination Profile File
Format > Add File Format.
Add File Format window displays.

Step 2 In the File Name field, choose the text-based CSV file that you created for this transaction.
Step 3 In the File Format Name field, choose the file format that you created for this type of bulk transaction.
Step 4 To create a job for associating the matching file format with the CSV data file, click Submit.
Step 5 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599

Remote Destination Profile Insertions
You can use the Bulk Administration menu to insert Remote Destination Profiles (RDPs) in batches, rather
than performing individual updates through Cisco Unified Communications Manager Administration.

Insert Remote Destination Profiles in Cisco Unified Communications Manager
You can insert Remote Destination Profiles into Cisco Unified Communications Manager.

Before you begin

• Youmust have a CiscoUnified CommunicationsManager BulkAdministration (BAT) RemoteDestination
Profile template for the devices that you are adding.

• You must have a data file in comma separated value (CSV) format that contains the unique details for
the Remote Destination Profiles.

• Upload the data files by choosing the relevant target and function for the transaction.

Procedure

Step 1 Choose Bulk Administration > Mobility > Remote Destination Profile > Remote Destination Profile
Insert.
The Insert Remote Destination Profile Configuration window displays.

Step 2 In theFile Name drop-down list box, choose the CSV data file that you created for this specific bulk transaction.
Step 3 In theRemote Destination Profile Template Name drop-down list box, choose the BAT Remote Destination

Profile template that you created for this type of bulk transaction.

Remote Destination Profile template is optional while inserting Remote Destination Profiles.
Ensure that the CSV data file has a 'Desk Phone Name' when a Remote Destination Profile
template is not selected.

Note
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Step 4 Check the Override the existing configuration check box to overwrite the existing Remote Destination
Profile settings with the information that is contained in the file that you want to insert.

Step 5 In the Job Information area, enter the Job description.
Step 6 Choose an insert method. Do one of the following:

a) Click Run Immediately to insert the Remote Destination Profile records immediately.
b) Click Run Later to insert the Remote Destination Profile records at a later time.

Step 7 To create a job for inserting the Remote Destination Profile records, click Submit.
Step 8 To create a job for inserting the gateways, click Submit.

Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599

Remote Destination Profile Deletions
You can use the Bulk Administration menu to delete and export Remote Destination Profiles (RDPs) in
batches, rather than performing individual updates through Cisco Unified Communications Manager
Administration.

Delete Remote Destination Profiles Using Custom File
Use a text editor to create a custom file of Remote Destination Profiles that you want to delete. You can have
MAC addresses and device names in the same custom file, but you cannot have directory numbers in the same
file. You need to create separate files—one file that contains the device names andMAC addresses and another
file that contains the directory numbers.

Before you begin

1. Create a text file that lists one of these details for the RDPs that you want to delete:

• Name

• Description

• Device Pool

• Calling Search Space

2. Put each item on a separate line in the text file.

3. Upload the custom file to CiscoUnifiedCallManager server. For more details on uploading files, see the
Upload File to Server, on page 21.
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Procedure

Step 1 Choose Bulk Administration > Mobility > Remote Destination Profile > Remote Destination Profile
Delete.
The Delete Remote Destination Profile Configuration window displays.

Step 2 In the Delete Remote Destination Profile where drop-down list box, choose the type of custom file that you
have created from one of the following criteria:

• Name

• Description

• Device Pool

• Calling Search Space

Step 3 In the list of custom files, choose the filename of the custom file for this delete.
Step 4 Click Find. A list of RDPs matching your search criteria displays.
Step 5 In the Job Information area, enter the Job description.
Step 6 Choose a delete method. Do one of the following:

a) Click Run Immediately to delete RDP records immediately.
b) Click Run Later to delete RDP records at a later time.

Step 7 Click Submit to create a job for deleting the RDP records.
Step 8 To create a job for inserting the gateways, click Submit.

Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599

Remote Destination Profile Exports Using Export Utility
You can use the export utility to merge records from multiple CiscoUnifiedCallManager servers onto one
CiscoUnifiedCallManager server. Use this procedure to move records from one CiscoUnified CallManager
server to another.

Export Remote Destination Profile Using Export Utility
You can export remote destination profile details.

If you are accessing help from the second Export Remote Destination Profile Configuration window after
selecting the remote destination profile for export, skip to Step 7, on page 501.

Note

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
500

Mobility
Remote Destination Profile Exports Using Export Utility



Procedure

Step 1 Choose Bulk Administration > Mobility > Remote Destination Profile > Remote Destination Profile
Export.
The Export Remote Destination Profile Configuration window displays.

Step 2 From the first Find Remote Destination Profile where drop-down list, choose one of the following criteria:

• Name

• Description

• Device Pool

• Calling Search Space

From the second Find Remote Destination Profile where drop-down list, choose one of the following criteria:

• begins with

• contains

• ends with

• is exactly

• is empty

• is not empty

Step 3 Specify the appropriate search text, if applicable.

To find all Remote Destination Profiles that are registered in the database, click Find without
entering any search text.

Tip

Step 4 To further define your query and to add multiple filters, check the Search Within Results check box, choose
AND or OR from the drop-down list, repeat Step 2, on page 501 and Step 3, on page 501.

Step 5 Click Find.

A list of discovered Remote Destination Profiles displays by:

• Name

• Description

• Device Pool

• Calling Search Space

Make sure to browse the entire list of displayed results before submitting the job.Note

Step 6 Click Next.

The next Export Remote Destination Profile Configuration window displays.

Step 7 Enter an export file name in the File Name field.
Step 8 Choose a file format from the File Format drop-down list.
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Step 9 In the Job Information area, enter the Job description. Delete Remote Destination Profiles is the default
description.

Step 10 Choose an export method. Do one of the following:
a) Click Run Immediately to export Remote Destination Profile records immediately.
b) Click Run Later to export Remote Destination Profile records at a later time.

Step 11 Click Submit to create a job for deleting the Remote Destination Profile records.
Step 12 To schedule and/or activate this job, use the Job Scheduler option in the Bulk Administration main menu.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599

Default Remote Destination Profile File Format
When you export Remote Destination Profile records by using Default Remote Destination Profile file format
option, you export Remote Destination Profile records along different line attributes that are associated with
the Remote Destination Profile. You cannot use the query to limit the number of records.

The following table lists the fields that are exported when you choose the Default Remote Destination Profile
Format file format.

Table 49: Exported Fields in the Default Remote Destination Profile File Format

Exported FieldsField Types

Remote Destination Profile Name, Description, User ID, Device Pool, CSS, AAR
CSS, Media Resource List, User Hold Audio Source, Location, Privacy, Device
Presence Group, Rerouting CSS

Device Fields

Directory Number, Partition, Voice Mail Profile, Line CSS, AARGroup(Line), Line
User Hold Audio Source, Line NetworkHold Audio Source, Forward All Destination,
Forward All CSS, Forward Busy Internal Destination, Forward Busy Internal CSS,
Forward Busy External Destination, Forward Busy External CSS, ForwardNoAnswer
Internal Destination, Forward NoAnswer Internal CSS, Forward NoAnswer External
Destination, Forward No Answer External CSS, Forward No Coverage Internal
Destination, Forward No Coverage Internal CSS, Forward No Coverage External
Destination, ForwardNoCoverage External CSS, ForwardNoAnswer RingDuration,
Call Pickup Group, MLPP Target, MLPP CSS, MLPP No Answer Ring Duration,
External Phone Number Mask, Maximum Number Of Calls, Busy Trigger, Alerting
Name, Alerting Name ASCII, Display, Line Description, Line Presence Group,
Secondary CSS For Forward All, ASCII Display, Forward On CTI Failure
Destination, Forward On CTI Failure CSS, AAR Destination Mask, Forward
Unregistered Internal Destination, Forward Unregistered Internal CSS, Forward
Unregistered External Destination, Forward Unregistered External CSS, Hold
Reversion Ring Duration, Hold Reversion Notification Interval

Line Fields
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C H A P T E R 61
Mobility Profile

This chapter provides information to use Cisco Unified Communications Manager Bulk Administration Tool
manage Mobility Profiles in the Cisco Unified Communications Manager database with a unique identity.
You can insert, delete, and export Mobility Profiles using BAT.

• Insert Mobility Profile, on page 503
• Delete Mobility Profile, on page 504
• Export Mobility Profile, on page 504

Insert Mobility Profile
You can use BAT to insert mobility profiles in bulk.

Procedure

Step 1 Choose Bulk Administration > Mobility > Mobility Profile > Insert Mobility Profile .
The Insert Mobility Profile Configuration window displays

Step 2 From the File Name drop-down list box, choose the CSV data file that you created for this specific bulk
transaction.

Step 3 Checking theOverride the existing configuration check box, overwrites the existingMobility Profile settings
with the information that is contained in the file that you want to insert.

Step 4 In the Job Information field, enter the Job description.
Step 5 Choose an insert method. Do one of the following:

a) Click Run Immediately to insert the profile immediately.
b) Click Run Later to insert the profile at a later time.

Step 6 Click Submit to create a job for inserting the Mobility Profile.
Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Mobility Profile File Format, on page 668
Manage Scheduled Jobs, on page 599
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Delete Mobility Profile
You can delete a Mobility Profile from the Cisco Unified Communications Manager database.

Before you begin

Before you can delete a Mobility Profile from Cisco Unified Communications Manager Administration, you
must do the following:

• Create a text file that lists each Mobility Profile that you want to delete on a separate line.

• Upload the custom file with the first node of the Cisco Unified Communications Manager server.

To delete mobility profiles by using a custom file, use the following procedure.

Do not use the insert or export transaction files that are created with bat.xlt for the delete transaction. Instead,
you must create a custom file with details of the Mobility Profile records that need to be deleted. Use only
this file for the delete transaction. The custom delete file does not require a header and you can enter values
for the name or description or mobile client calling option.

Note

Procedure

Step 1 Choose Bulk Administration > Mobility > Mobility Profile > Delete Mobility Profile.
The Delete Mobility Profile Configuration window displays.

Step 2 From the Delete Mobility Profile where Name/Description/Mobile Client Calling Option in custom file
drop-down list box, choose the file that you uploaded for deleting Mobility Profile.

Step 3 Click Find.
Step 4 The Job Information section displays along with the selected Mobility Profile.
Step 5 You can choose to run the job immediately or later by selecting the corresponding radio buttons.
Step 6 Click Submit to create a job for deleting the Mobility Profile.

A message in the Status section lets you know that the job was submitted successfully.

Step 7 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Upload and Download Files, on page 19

Export Mobility Profile
Use BAT to export Mobility Profiles.
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If you are accessing help from the Export Mobility Profile Configuration window, skip to Step 7, on page
505.

Note

Procedure

Step 1 Choose Bulk Administration > Mobility > Mobility Profile > Export Mobility Profile.
The Find and List Mobility Profiles To Export window displays.

Step 2 In the first Find Mobility Profile where drop-down list box, choose a field to query from the following
options:

• Name

• Description

• Mobile Client Calling Option

Step 3 In the second drop-down list box, choose from the following options:

• begins with

• contains

• is exactly

• ends with

• is empty

• is not empty

Step 4 In the search field box, enter the value that you want to locate, such as a specific profile name or profile
description, and click Find.
You can choose AND or OR to add multiple filters and repeat Step 2, on page 505 through Step 4, on page
505 to further define your query.
All matching records display. You can change the number of items that display on each page by choosing a
different value from the Rows per Page drop-down list box.

Step 5 From the list of records that display, click the link for the record that you want to view.

To find all the mobility profiles that are registered in the database, click Find without entering any search
text. The window displays the record that you choose.

Step 6 Click Next.

The Export Mobility Profile Configuration window displays.

Step 7 In the File Name text box, enter the Mobility Profile file name you intend to export.
Step 8 From the File Format drop-down list box, choose the Mobility Profile file format.
Step 9 In the Job Information area, enter the Job description.
Step 10 Choose an export method. Do one of the following:

a) Click Run Immediately to export mobility profiles immediately.
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b) Click Run Later to export mobility profiles at a later time.

Step 11 Click Submit to create a job for exporting Mobility Profile.
Step 12 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
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P A R T XII
Region Matrix

• Region Matrix Updates, on page 509





C H A P T E R 62
Region Matrix Updates

This chapter provides information to use the RegionMatrix menu in BAT to populate or depopulate the region
matrix. The region tables define physical locations, whereas the regionmatrix tables define available bandwidth
within (intra) and between (inter) regions.

• Populate and Depopulate Region Matrix, on page 509

Populate and Depopulate Region Matrix
Use BAT to populate or depopulate the region matrix.

Procedure

Step 1 ChooseBulk Administration >Region Matrix >Populate/Depopulate Region Matrix. The RegionMatrix
Configuration window displays.

Step 2 In the Region Matrix Options section, choose Populate Region Matrix or Depopulate Region Matrix based
on what you want to do.

Step 3 In the Job Information section, enter a name for the job. This helps you to identify your job.
Step 4 Select Run now or Run later , depending upon when you want to run the job.
Step 5 Click the Submit button.
Step 6 View the Job Scheduler window to check the status of the job that you submitted.

You can use this window to reschedule the job if required.

Unlike other BAT processes, the progress of a job to populate or depopulate the region matrix
cannot be measured in terms of records passed, failed, or processed. The results can be viewed
only after the entire process is complete.

Note

The number of records criterion is not applicable to this transaction.Note

An administrator can change the region bandwidth defaults, however, this cannot be done through the BAT
menu.
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Choose System > Service Parameters in Cisco Unified Communications Manager to access the
region bandwidth defaults. The parameter type specifies Cisco Unified CommunicationsManager
and the four parameters of interest comprise part of the Clusterwide Parameters (System - Location
and Region) section.

Note
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P A R T XIII
Import/Export

• Import/Export Menu, on page 513
• Import Configuration Data, on page 525
• Import File Validation, on page 531





C H A P T E R 63
Import/Export Menu

This chapter provides information to use the Import/Export menu in Cisco Unified CommunicationsManager
Bulk Administration Tool (BAT) to export or import parts of the Cisco Unified Communications Manager
database to another server, or to the same server with modifications. This reduces the configuration time that
is required by importing a preconfigured database to the installed Cisco Unified Communications Manager
server.

• Export Configuration Data, on page 513
• Edit .tar File, on page 522
• Topics Related to the Import/Export Menu, on page 523

Export Configuration Data
Use BAT to export configuration data from Cisco Unified Communications Manager.

You cannot export VPN details through Import/Export if you are using the U.S. export unrestricted version
of Cisco Unified Communications Manager.

Note

Procedure

Step 1 Choose Bulk Administration > Import/Export > Export.
The Export Data window displays.

Step 2 In the Job Information section, enter the.tar file name, without the extension, in the Tar File Name field.

BPS uses this filename to export the configuration details.

All files that are exported at the same time get bundled together (.tar) and can be downloaded
from the server.

Note

Step 3 In the Select items to Export section, choose the options you want to export.
a) Check the appropriate check boxes under System Data.

See "System Data Options" at Export Configuration Data Options, on page 514.

b) Check the appropriate check boxes under Call Routing Data.
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See "Call Routing Data Options" at Export Configuration Data Options, on page 514.

c) Check the appropriate check boxes under Media Resources.
See "Media Resources Options" at Export Configuration Data Options, on page 514.

d) Check the appropriate check boxes under User Data.
See "User Data Options" at Export Configuration Data Options, on page 514.

e) Check the appropriate check boxes under Device Data.
See "Device Data Options" at Export Configuration Data Options, on page 514.

f) Check the appropriate check boxes under Advanced Features.

See "Advanced Features Options" at Export Configuration Data Options, on page 514.

The check boxes for VPNProfile, VPNGateway, VPNGroup, andVPNFeature Configuration
do not appear if you are using the U.S. export unrestricted version of Cisco Unified
Communications Manager. You cannot export VPN details through Import/Export if you are
using the U.S. export unrestricted version of Cisco Unified Communications Manager.

Note

Step 4 You can use the Select All button to check all the check boxes at once and the Clear All button to clear all
the check boxes.

Step 5 In the Job Description field, enter the description that you want to provide for the job. Export Configuration
is the default description.

Step 6 You can choose to run the job immediately or later by selecting the corresponding radio button.
Step 7 To check for interdependency of tables to make sure that the related records are also exported, click Check

Dependency.

You can de-select any of the check boxes after checking dependency. You also have the option
to skip checking dependency.

Note

Check dependency selects dependent items up to one level of dependency. For example, if an
item depends on CSS, then only CSS will be selected and the items that CSS depends on will not
be selected.

Note

Step 8 To create a job for exporting the selected data, click Submit.

A message in the Status section lets you know that the job was submitted successfully.

Step 9 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599

Export Configuration Data Options
You can choose the options to export when you use BAT to export configuration data from Cisco Unified
Communications Manager.

• System data options

• Call routing data options
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• Media resources options

• User data options

• Device data options

• Advanced features options

System Data Options

• Cisco Unified Communications Manager

• Cisco Unified Communications Manager Group

• Date/Time Group

• Device Pool

• Enterprise Parameter

• Location

• Phone NTP Reference

• Region

• Server

• Service Parameter

• SRST

• Security Profile (Phone & SIP Trunk)

• Physical Location

• Device Mobility Group

• Presence Group

• LDAP System

• Device Mobility Info

• DHCP Server

• DHCP Subnet

• Application Server

• LDAP Directory

• LDAP Authentication

• MLPP Domain

• Resource Priority Namespace Network Domain

• Resource Priority Namespace List

• CUMA Server Security Profile
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• Geo Location Configuration

• Geo Location Filter

• Enterprise Phone Configuration

• Certificate

• LDAP Custom Filter for Users

• LDAP Custom Filter for Groups

• Location Bandwidth Manager Group

• Audio Codec Preference Lists

• LDAP Search

Call Routing Data Options

• Application Dial Rules

• CSS (Class of Control)

• Partitions (Class of Control)

• Route Filter

• Time Period (Class of Control)

• Time Schedule (Class of Control)

• Translation Pattern

• AAR Group

• Forced Authorization Codes

• Directory Lookup Dial Rules

• Client Matter Codes

• Call Park

• Call Pickup Group

• Directory Number

• MeetMe Number

• Cisco Attendant Console Pilot Point

• Directed Call Park

• SIP Dial Rules

• Line Group

• Route Group

• Hunt List
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• Route List

• Hunt Pilot

• Intercom Route Partition

• Intercom CSS

• Access List

• Route Pattern

• Called Party Transformation Pattern

• SIP Route Pattern

• Intercom Directory Number

• Intercom Translation Pattern

• Calling Party Transformation Pattern

• Time Of Day Access

• Logical Partition Policy

• CCD Requesting Service

• Hosted DN Group

• Block Learned Patterns

• Hosted DN Patterns

• CCD Advertising Service

• External Call Control Profile

• Transformation Profile

• CCD Feature Configuration

• CCD Partition

• Mobility Profile Configuration

• Handoff Configuration

• Enterprise Feature Access Configuration

• Elin Group

Media Resources Options

• Annunciator

• Conference Bridge

• Media Resource Group

• Media Resource Group List
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• Media Termination Point

• Transcoder

• Music On Hold Server

• Mobile Voice Access

• Music On Hold Server

• IVR

User Data Options

• SIP Realm

• Application User

• Access Control Group

• Role

• Application User CAPF Profile

• Credential Policy Default

• Credential Policy

• End User

• End User CAPF Profile

• UC Service

• Service Profile

• Self-Provisioning

• User Profile

• Feature Group Template

• Universal Device Template

• Universal Line Template

Device Data Options

• Softkey Template

• Gate Keeper

• Trunk

• SIP Profile

• Phone Services

• Phone Button Template

• Common Phone Profile
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• Gateway

• Device Defaults

• Device Profile

• Common Device Configuration

• CTI Route Point

• Phone

• Recording Profile

• Remote Destination

• Remote Destination Profile

• Feature Control Policy

• Default Device Profile

• SIP Normalization Script

• SDP Transparency Profile

• Wireless LAN Profile Group

• Wireless LAN Profile

• Network Access Profile

• Wi-Fi Hotspot Profile

• Expressway-C
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Advanced Features Options

Note
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The check boxes for VPN Profile, VPN Gateway, VPN Group, and VPN Feature Configuration do not appear
if you are using the U.S. export unrestricted version of Cisco Unified Communications Manager. You cannot
export VPN details through Import/Export if you are using the U.S. export unrestricted version of Cisco
Unified Communications Manager.

• Message Waiting Numbers

• Voice Mail Pilot

• Voice Mail Profile

• Voice Mail Port

• SAF Forwarder

• SAF Security Profile

• EMCC Remote Cluster

• EMCC Intercluster Service Profile

• Intercompany Media Engine Server Connections—Ensure that the Cisco IME server is installed and
available before you configure this field.

• Intercompany Media Service—Ensure that the Cisco IME server is installed and available before you
configure this field.

• Intercompany Media Service—Ensure that the Cisco IME server is installed and available before you
configure this field.

• IntercompanyMedia Services Trust Element—Ensure that the Cisco IME server is installed and available
before you configure this field.

• Intercompany Media Services Enrolled Pattern—Ensure that the Cisco IME server is installed and
available before you configure this field.

• IntercompanyMedia Services Enrolled Group—Ensure that the Cisco IME server is installed and available
before you configure this field.

• Intercompany Media Services Exclusion Group—Ensure that the Cisco IME server is installed and
available before you configure this field.

• Fall Back Profile—Ensure that the Cisco IME server is installed and available before you configure this
field.

• IntercompanyMedia Services Learned Route—Ensure that the Cisco IME server is installed and available
before you configure this field.

• VPN Profile

• VPN Gateway

• VPN Group

• EMCC Feature Config

• Intercompany Media Services Firewall—Ensure that the Cisco IME server is installed and available
before you configure this field.
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• Intercompany Media Services Exclusion Number—Ensure that the Cisco IME server is installed and
available before you configure this field.

• Intercompany Media Services E.164 Transformation—Ensure that the Cisco IME server is installed and
available before you configure this field.

• Intercompany Media Services Feature Configuration—Ensure that the Cisco IME server is installed and
available before you configure this field.

• Fallback Feature Configuration—Ensure that the Cisco IME server is installed and available before you
configure this field.

• VPN Feature Configuration

• Called Party Tracing

• Directory Number Alias Lookup And Sync

• Call Control Agent Profile

• Infrastructure Device

Log Files
Multiple log files are created for a single export transaction. One for the overall transaction, and one each for
the items selected for export. These log files display separate results for each item. The log file name is
prepended with the item name, to make it easier to identify the logs.

These files can be accessed from the Job Scheduler page.

Related topics

See Topics Related to the Import/Export Menu, on page 523.

Edit .tar File
The tar file comprises a list of CSV files and a header file. Header file can be used to refer to the details of
the server from where the export was carried out and the time when it was carried out. The header file also
has details regarding the files in the package.

You can make changes directly in the exported .tar file after you have exported the required data using BAT.
The exported .tar file is located on the first node of the Cisco Unified Communications Manager server.

Procedure

Step 1 Choose Bulk Administration > Upload/Download Files.
The Find and List Files page displays.

Step 2 Download the.tar file that you want to update.
Step 3 Un-tar the.tar file to some location on your machine using thetar -xvf command.

The.csv file gets extracted to the location that you specified.
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The “tar -xvf” command may not work on a Windows server. TAR and UNTAR operations
are possible in Windows using 7-Zip, which is a freeware available on the World Wide Web.

Note

The name of the.csv file is always the same as the item name.Note

Step 4 Use Microsoft Excel to edit the.csv file and save your changes.

You can also use a text editor to edit the.csv file, but Cisco recommends using Microsoft Excel
to edit the.csv file.

Note

Always maintain the same filename and file format for the.csv file. If you add a new file to the tar package,
ensure that the file has the same name and file format as it would have if it is exported from Cisco Unified
Communications Manager. Also make sure that the new filename is added to the Header file.

If you are expecting to add a new item, always try to export that item from Cisco Unified
Communications Manager, even if there are no records for that item. This will create a.csv file
with the correct name and file format.

Tip

Step 5 Re-tar the files using the tar -cvf command while making sure that the new.tar file is saved in the default
common location.

The “tar -cvf” command may not work on a Windows server, TAR and UNTAR operations are
possible in Windows using 7-Zip, which is a freeware available on the World Wide Web.

Note

The.tar files must maintain the original directory structure when you re-tar the files, because BPS
looks for.tar files at the default location only.

Caution

Step 6 Upload the.tar file for import.

Make sure that you select the Target as Import/Export and the Transaction Type as Import.Note

If you decide to use a text editor to update the file, make sure that you add a comma for every
new entry in the file format.

Note

Import/Export tool does not support updating the password and pin attributes. They are exported
in encrypted form in the exported file and hence it cannot be changed to plain text. Entities which
have credentials are—CommonPhone Profile, SIPRealm,ApplicationUser, LDAPAuthentication,
LDAP Directory, Cisco Attendant Console, and Enduser. Be aware that you must not modify the
User ID, User Pkid, Password, and Pin fields in the enduser.csv in the exported file.

Note

Related Topics
Download File Off Server, on page 20
Upload File to Server, on page 21

Topics Related to the Import/Export Menu
• Export Configuration Data, on page 513

• Edit .tar File, on page 522
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• Find Downloadable File on Server, on page 19

• Download File Off Server, on page 20

• Upload File to Server, on page 21

• Delete File From Server, on page 21

• Import Configuration to Server, on page 525
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C H A P T E R 64
Import Configuration Data

This chapter provides information to import configuration data to Cisco Unified Communications Manager
using the Bulk Administration Menu.

You can only update the existing enterprise or service parameters using import/export. If your import .csv
file has templates specific to IPMA, make sure that you run the IPMA wizard on the target server before you
proceed with the import transaction.

• Import Configuration to Server, on page 525
• Cyclic Dependency, on page 527
• Override Only, on page 528
• Upgrade From Cisco Unified CallManager 4.x Releases, on page 529
• Topics Related to Import/Export Menu, on page 529

Import Configuration to Server
You can import configuration data to Unified CommunicationsManager using the Bulk AdministrationMenu.

The LDAP password configured under theUser Management > User Settings > Service Profile > Directory
Profile Unified CM Administration interface will be exported in the encrypted format when you export the
Service Profiles data using BAT. To import Service Profiles data from a Unified Communications Manager
server to another, you must manually re-enter the password in plain text form in the exported .csv file. This
is because you cannot import the same password as the decryption key is different for different servers.

If you are using the LDAP credentials for authentication, you should disable the Cisco Jabber Diagnostic
Tool using the DiagnosticsToolEnabled parameter configured in the Jabber Client Configuration
(jabber-config.xml) file.

Note

To successfully import enterprise or service parameters, you must update the parameter from the Enterprise
Parameter or Service Parameter window in Cisco Unified Communications Manager Administration from
where it is being imported. In this case, when you are in the Enterprise Parameter or Service Parameter
window in Cisco Unified Communications Manager Administration, click Save without making any changes
before you run import.
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You can only update the existing enterprise or service parameters using Import/Export. If some of the
parameters are missing in the database, importing the parameter fails.

Attention

You can use the “Override the existing configuration” option to make BPS update an item if it exists on the
server or insert the item if it does not. When you import phones or User Device Profiles using the override
option, the IP Phone services do not get updated but only get appended to the existing set of entities.

Because there can be multiple IP Phone services with the same name and there is no unique key to distinguish
these services, Import or Export cannot determine which service to update and appends the service instead.

Note

Before you begin

If your import.csv file has templates specific to IPMA, make sure that you run the IPMA wizard on the target
server before you carry out the import transaction.

Procedure

Step 1 Choose Bulk Administration > Import/Export > Import.
Step 2 Select the .tar file name in the File Name field and click Next.

The File Name drop-down list displays all uploaded .tar files.Note

Step 3 The Import Configuration section lists all the components of the .tar file. Check the corresponding check
boxes for the options that you want to import.

Step 4 Tomake BPS update the item if it exists and insert if it does not, check theOverride the existing configuration
check box.

Overriding the existing configuration is optional.

In case the files are modified, then the filename and the file format must not be changed during
the update.

Note

Step 5 You can click Select All to select all the options at once, and click Clear All to clear all selections.
Step 6 Choose to run the job immediately or later by selecting the corresponding radio button.
Step 7 To create a job for importing the selected data, click Submit.

A message in the Status section lets you know that the job was submitted successfully.

Step 8 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

What to do next

You can use Override when you are running the same tar file with corrections, after a failed job-run.
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When a Unified Communications Manager server is created, there are database triggers on the background
which create entities such as Conference Bridge (CFB), Media Termination point (MTP), and so on,
automatically. These entities have names like CFB_1, and MTP_1.

When a user exports this information into a TAR file and imports it to a different Unified Communications
Manager server, then the system creates items such as CFB and MTP. The names on the new Unified
Communications Manager server may be consistent with the names before import, or can be different.

Note

Related Topics
Log Files, on page 522
Upload File to Server, on page 21

Cyclic Dependency
Some entities in Cisco Unified Communications Manager depend upon each other in such a way that one
cannot be imported without importing the other. Import/Export carries out the import process for such entities
in two stages:

1. The entity with the higher priority is imported first, with a blank value for the supporting entity.

This occurs because the value of the supporting entity is not available at the time.Note

2. After importing all the entities in the.tar, Import/Export updates the higher priority entity with the value
of the supporting entity to complete the import process.

The value of the supporting entity becomes available in the next cycle.Note

Example

Consider the following example to understand how cyclic dependency works:

Device Pool and Media Resource Group List (MRGL)—Device Pool (entity with the higher priority) gets
imported first, with a blank value for MRGL (supporting entity), because the value of MRGL is not available
at the time. After importing all the entities in the.tar file, Import/Export updates Device Pool, replacing the
blank value with the true value of MRGL to complete the import process.

Consider the following entities as bound by cyclic dependency:

• Device Pool and MRGL

• Device Pool and Route Group

• Partition and Time Schedule

• Application User and User group

• Licensing
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Sample Record

devicepool.csv
DEVICE POOL NAME,CISCO UNIFIED CALLMANAGER GROUP,DATE/TIME GROUP,REGION,SRST REFERENCE,CALLING
SEARCH SPACE FOR AUTO-REGISTRATION,AAR CALLING SEARCH SPACE,DEVICE MOBILITY CALLING SEARCH
SPACE,MEDIA RESOURCE GROUP LIST,LOCATION,NETWORK LOCALE,CONNECTION MONITOR DURATION,DEVICE
MOBILITY GROUP,AAR GROUP,REVERTED CALL FOCUS PRIORITY,LOCAL ROUTE GROUP,CALLING PARTY
TRANSFORMATION CSS,CALLED PARTY TRANSFORMATION CSS,INCOMING CALLING PARTY NATIONAL NUMBER
PREFIX,INCOMING CALLING PARTY INTERNATIONAL NUMBER PREFIX,INCOMING CALLING PARTY UNKNOWN
NUMBER PREFIX,INCOMING CALLING PARTY SUBSCRIBER NUMBER PREFIX,PHYSICAL LOCATION

Branch_0000,CMG 1 Phones,Central,region_0001,Disable,NULL,NULL,NULL,Intrn_MRGL-1_Volkswagen
Intn.,,NULL,-1,NULL,NULL,Default,NULL,NULL,NULL,Default,Default,Default,Default,NULL

mediaresourcegrouplist.csv
NAME,MEDIA RESOURCE GROUP 1,SORT ORDER 1

Intrn_MRGL-1_Volkswagen Intn.,,

Import/Export generates two logs files for every import of dependent entities. The first log file indicates the
status of insert of the first entity; the other indicates whether the first entity was successfully updated with the
value of the supporting entity.

Note

Items Not Supported on Import or Export
The following items are not supported on import or export:

• Dial Plan Installer

• Route Plan Report

• MOH Audio Source

• Fixed MOH Audio Source

• MOH Audio File Management

• Cisco Voice Mail Port wizard

• Firmware load information

• Licensing

• Announcement

Override Only
Import/Export does not support insert functionality for the following entities in the Cisco Unified
Communications Manager database. You can only update/override these entities.

• Cisco Unified CM

• LDAP System
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• Enterprise Parameters

• Service Parameter

• Mobility Configuration

• Annunciator/MOHServer—When a CiscoUnified CommunicationsManager server is created, database
triggers create entities such as MOH server, annunciator, and so on. When you export this information
into a TAR file and import it to a different Cisco Unified Communications Manager server, the system
trigger creates items such as MOH server, annunciator, and so on. Import/Export supports only update
of existing MOH server—server association/annunciator—server association. You can edit the TAR file
to make sure that the csv file has the valid association before importing. Cisco recommends that you
import the server first; then, based on the association created, you can edit the csv file and do an Import
with Override.

• Device Defaults

• Credential Policy Default

• Certificate—Import/Export supports only update of existing certificates as new certificates cannot be
created/uploaded from Cisco Unified Communications Manager Administration. Only the Duration in
Cache parameter from the certificate can be updated.

• Self-Provisioning

Upgrade From Cisco Unified CallManager 4.x Releases
Keep the following points in mind when you import entities after an upgrade fromCisco Unified CallManager
4.x releases:

• BAT supports Import/Export between the same versions of Cisco Unified Communications Manager
only. After the upgrade from a 4.x release of Cisco Unified CallManager, make sure that you have the
same Cisco Unified Communications Manager version on both the source and target servers.

• Some user groups associated to application users that are relevant to the erstwhile Cisco Unified
CallManager 4.x version that was running on the source server before the upgrade, may not be relevant
to the Cisco Unified Communications Manager version running on the target server. Import transaction
for such user groups will fail.

Topics Related to Import/Export Menu
• Export Configuration Data, on page 513

• Edit .tar File, on page 522

• Log Files, on page 522

• Override Only, on page 528

• Upgrade From Cisco Unified CallManager 4.x Releases, on page 529

• Find Downloadable File on Server, on page 19
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• Download File Off Server, on page 20

• Upload File to Server, on page 21

• Delete File From Server, on page 21
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C H A P T E R 65
Import File Validation

This chapter provides information to use the Validate Import File page in BAT to validate the import .tar file.

• Import File Validation Items, on page 531
• Validate Import File, on page 531
• Topics Related to Import File Validation, on page 532

Import File Validation Items
The Validate Import File page in BAT validates the following items in the import .tar file:

• The .tar file includes a header file.
• All files listed in the header file are actually present in the .tar file.
• All files in the .tar file are listed in header file.
• File names are correct (as per the Import/Export convention).
• File format for the CSV files in the .tar file is correct.

This feature does not include field level validation for valid characters, string length, etc.Note

Validate Import File
Use the Validate Import File page in BAT to validate the import.tar file.

The validation procedure is carried out only for the items specified for the import.tar file.Note

Procedure

Step 1 Choose Bulk Administration > Import/Export > Validate Import File.
The Validate Import File window displays.

Step 2 Select the.tar file name in the Tar File Name field and click Submit.
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The File Name drop-down list box lists all uploaded.tar files.
A message in the Status section lets you know that the job was submitted successfully.

Step 3 To check the status of the job, use the Job Scheduler option in the Bulk Administration main menu.

What to do next

If there are any problems encountered during validation, these are listed in the log files.

Related Topics
Import File Validation Items, on page 531
Log Files, on page 522
Topics Related to Import File Validation, on page 532
Upload File to Server, on page 21

Topics Related to Import File Validation
• Export Configuration Data, on page 513

• Edit .tar File, on page 522

• Find Downloadable File on Server, on page 19

• Download File Off Server, on page 20

• Upload File to Server, on page 21

• Delete File From Server, on page 21
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P A R T XIV
Phone Migration

• Manage Phone Migration, on page 535





C H A P T E R 66
Manage Phone Migration

This chapter provides information to use the Phone Migration feature in Cisco Unified Communications
Manager Bulk Administration Tool to migrate phones from one type to another in bulk. You can access the
Phone Migration submenu from the Bulk Administration menu of Cisco Unified Communications Manager.

• Phone Migration Considerations, on page 535
• Migrate Phones, on page 536

Phone Migration Considerations
A text-based CSV data file is used to migrate phones. You can create the CSV data file using either the BAT
spreadsheet or a text editor.

Some limitations to keep in mind while migrating phones are:

• Migrating to a phone with fewer speed dials or lines will not remove lines or speed dials. However, some
of the lines/speed dials will no longer show up on the phone. You can still find all of the original
lines/speed dials on the phone configuration page.

• Even migrating to a newer phone can cause loss of features like in the case of moving from SIP to SCCP
or vice versa.

• Only existing phones can be migrated. If you enter a non-existing device in the CSV file, the system
displays an error message.

• If the phone gets migrated successfully, the old phone will be updated with the new phone settings.

• If you select the reset or restart option, the new phone would be reset.

Create CSV Data Files for Phone Migration Using BAT Spreadsheet
You can use the BAT spreadsheet to create the CSV data file that contains the details for phone migration.

After you have finished editing the fields in the BAT spreadsheet, you can export the content to a CSV
formatted data file. A default filename is assigned to the exported CSV formatted data file:

PhoneMigration#timestamp.txt

where “timestamp” represents the precise date and time that the file was created.
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If you enter a comma in one of the fields, BAT.xlt encloses that field entry in double quotes when you export
to BAT format.

If you enter a blank row in the spreadsheet, the system treats the empty row as the end of the file. The system
does not convert data that is entered after a blank line to the BAT format.

Note

Procedure

Step 1 To open the BAT spreadsheet, locate and double-click BAT.xlt file
Step 2 When prompted, click Enable Macros to use the spreadsheet capabilities.
Step 3 Click the Phone Migration tab.
Step 4 In each row, provide the information for the following fields:

• Old Device Name—Enter the name of the phone that you are migrating, from 1 to 50 characters that
identifies the old device. This field is mandatory.

• NewDeviceMACAddress—Enter theMAC address of the newDevice, 12 characters. This is amandatory
field.

• Description—Enter a description, up to 50 characters. This is an optional field. The description can
include up to 50 characters in any language, but it cannot include double-quotes ("), percentage sign (%),
ampersand (&), back-slash (\), or angle brackets (<>).

Step 5 To transfer the data from the BAT Excel spreadsheet into a CSV file, click Export to BAT Format.

The system saves the file using the default filename PhoneMigration#timestamp.txt toC:\XLSDataFiles
or you can use Browse to save your file in another existing folder on your local workstation

For information on how to read the exported CSV data file, click the link to View Sample File
in the Phone Migration Configuration window in BAT.

Note

What to do next

Upload the CSV data file to the first node of the Cisco Unified Communications Manager server so BAT can
access the data input file.

Related Topics
BAT Spreadsheet Data Collection for CSV Data File Creation, on page 12
Creating Text-Based CSV File for Phone Migration, on page 661
Upload and Download Files, on page 19

Migrate Phones
Use the Phone Migration feature in BAT to migrate phones in bulk.
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Before you begin

• You must have a data file in comma separated value (CSV) format that contains device name of the
phone that you wish to migrate, the MAC address for the new phone, and the description for the new
phone.

• You must have a phone template of a specific type, and the protocol you wish to use for migration
configured and ready.

• Upload the data files by choosing the relevant target and function for the transaction.

Procedure

Step 1 Choose Bulk Administration > Phone Migration.
The Phone Migration Configuration window displays.

Step 2 You can choose to reset or restart phones by selecting the appropriate radio button from the Reset/Restart
Information section.
Don’t Reset/Restart phones is the default setting.

Step 3 In the Phone Migration Information section, from the File Name drop-down list box, choose the file that
you uploaded.

Step 4 From the Phone Template Name drop-down list box, choose the phone template that you wish to use for
migration.

Step 5 In the Job Information section, enter a description for the job.
The default description specifies Phone Migration.

Step 6 You can choose to run the job immediately or later by selecting the corresponding radio button.
Step 7 To create a job for migrating phones, click Submit.

Step 8 A warning message informing you of a possible loss of features/data displays. Do one of the following:
a) Click Cancel to return to the Phone Migration Configuration window without submitting the job.
b) Click OK, to continue with submitting the job.
A message in the Status section lets you know that the job was submitted successfully.

Step 9 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
Upload File to Server, on page 21
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P A R T XV
Extension Mobility Cross Cluster (EMCC)

• Extension Mobility Cross Cluster Template, on page 541
• Insert, Update, and Delete EMCC Devices, on page 545





C H A P T E R 67
Extension Mobility Cross Cluster Template

This chapter provides information to use Cisco Unified CommunicationsManager Bulk Administration (BAT)
to insert, update, or delete Extension Mobility Cross Cluster (EMCC) in batches, rather than performing
individual updates through Cisco Unified Communications Manager Administration.

• EMCC Templates, on page 541
• Topics Related to EMCC Templates, on page 544

EMCC Templates
Use BAT EMCC templates to define the common EMCC attributes to add a group of new EMCC. Prior to
creating the template, make sure EMCC settings have already been configured in CiscoUnified Communications
Manager Administration. You cannot create new settings in BAT.

Find EMCC Template
Because you might have several EMCC templates, lets you locate specific templates on the basis of specific
criteria. Use the following procedure to locate templates.

During your work in a browser session, your find/list search preferences are stored in the cookies on the client
machine. If you navigate to other menu items and return to this menu item, or if you close the browser and
then reopen a new browser window, your search preferences are retained until you modify your search.

Note

Procedure

Step 1 Choose Bulk Administration > EMCC > EMCC Template.
The EMCC Template Find and List window displays. Use the two drop-down lists to search for a template.

Step 2 From the first Find EMCC Template where drop-down list box, choose one of the following criteria:

• Template Name

• Description

From the second Find EMCC Template where drop-down list box, choose one of the following criteria:
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• begins with

• contains

• is exactly

• ends with

• is empty

• is not empty

Step 3 Specify the appropriate search text, if applicable, and click Find.

To find all EMCC Templates that are registered in the database, click Find without entering any
search text.

Tip

A list of discovered templates displays.

Step 4 From the list of records, click the device name that matches your search criteria.
The window displays the EMCC template that you choose.

Related Topics
Topics Related to EMCC Templates, on page 544

Create New EMCC Template
Use BAT to create an EMCC template.

Procedure

Step 1 Choose Bulk Administration > EMCC > EMCC Template.
The EMCC Template Find and List window displays.

Step 2 Click Add New.
The EMCC Template Configuration window displays.

Step 3 Enter the EMCC settings that this batch has in common.
See Table 50: Field Descriptions for an EMCC Template, on page 543 for field descriptions.

Step 4 After you have entered all the settings for this EMCC template, click Save.
This creates the template.

What to do next

After creating the template, set a default template from the Insert page. You can access the Insert page through
Bulk Administration > EMCC > Insert/Update EMCC.

Related Topics
Topics Related to EMCC Templates, on page 544
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Delete EMCC Template
You can delete EMCC BAT templates when you no longer require them.

The template that is set as the default EMCC template cannot be deleted from the system. You can find the
default EMCC template from the Insert/Update EMCC page, or from the Delete EMCC page. You can also
find it from the EMCC Template Find List page. On the Find List page, no check box displays against the
default template.

Note

Procedure

Step 1 Find the EMCC Template that you want to delete.
Step 2 In the EMCC Template Configuration window, verify that this is the template that you want to delete and

click Delete.

You can also delete the EMCC template from the EMCC Template Find and List window.
Check the check box next to the template that you want to delete and click Delete Selected.

Note

A message displays that asks you to confirm the delete operation.
Step 3 To delete the template, click OK. The template name disappears from the list of EMCC templates list on the

Find and List EMCC Templates window.

If you submit a job that uses a particulate EMCC template and if you delete the template, the job
also gets deleted.

Caution

Related Topics
Find EMCC Template, on page 541
Topics Related to EMCC Templates, on page 544

BAT EMCC Template Field Descriptions
The following table provides descriptions of all possible fields that display when you are adding an EMCC
template.

Some fields display the values that were configured in CiscoUnified CommunicationsManager Administration.

In the BAT user interface, field names that have an asterisk require an entry. Treat fields that do not have an
asterisk as optional.

Table 50: Field Descriptions for an EMCC Template

DescriptionField

Device Information

Enter the name for the template.Template Name
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DescriptionField

Enter a description for the EMCC template that you want to create. The
description can include up to 50 characters in any language, but it cannot
include double-quotes ("), percentage sign (%), ampersand (&),
back-slash (\), or angle brackets (<>).

Description

Choose the device pool for this EMCC.

For devices, a devicepool defines sets of common characteristics, such
as region, date/time group, Cisco Unified Communications Manager
group, and calling search space for auto-registration.

DevicePool

Choose the default SIP profile or a specific profile that was previously
created. SIP profiles provide specific SIP information for the phone such
as default telephony event payload type, registration and keepalive
timers, media ports, Iris, and dynamic DNS server addresses.

SIP Profile

Choose the common device configuration to which you want this EMCC
assigned. The common device configuration includes the attributes
(services or features) that are associated with a particular user. You
configure the Common device configurations in the Common Device
Configuration window.

To see the common device configuration settings, click the ViewDetails
link.

Common Device Configuration

From the drop-down list box, choose a common phone profile from the
list of available common phone profiles.

Common Phone Profile

Topics Related to EMCC Templates
• EMCC Templates, on page 541

• Create New EMCC Template, on page 542

• Delete EMCC Template, on page 543

• BAT EMCC Template Field Descriptions, on page 543
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C H A P T E R 68
Insert, Update, and Delete EMCC Devices

This chapter provides information to use Cisco Unified CommunicationsManager Bulk Administration (BAT)
to insert, update, and delete EMCC devices in the Cisco Unified Communications Manager database.

• Insert EMCC Devices, on page 545
• Update EMCC Devices, on page 546
• Delete EMCC Devices, on page 547

Insert EMCC Devices
Use BAT to add EMCC devices to the Cisco Unified Communications Manager database.

Each EMCC device bears a unique name in the format: EMCC1, EMCC2, and so on. BAT assigns EMCC
device numbers by obtaining the last one used. If any other entity like, Phone, UDP, RDP, or EMCCTemplates
are named in the same format (EMCC1, EMCC2), then BAT Insert EMCC generates an error for duplicate
naming. Therefore, ensure that the above entities with the same name format, are renamed before inserting
EMCC Devices.

Example

The Admin user wants to insert 27 numbers of EMCC devices. First, BAT searches for the last EMCC device
serial number used in the UCM say, EMCC123. Then it starts inserting devices from the next number onwards:
EMCC124 to EMCC150. If UDP devices have already used the following names: EMCC135, EMCC137,
and EMCC150, then BAT Insert EMCC will generate a naming error. EMCC devices with the above names
do not get created unless the UDP devices are renamed.

Before you begin

Before you insert EMCC devices, youmust have a valid EMCC template set as default. Set the default template
following the update EMCC devices procedure.

To determine howmany EMCC devices to add, look at the number of registered phones and add 5% to account
for devices that may not be registered at the moment. If you have 100 phones, multiply 100 by 0.5, which
equals 5. You add the result (5) to the total (100). The number of EMCC devices is 105.

To display information about the number of registered phones, gateways, and media resource devices on Cisco
Unified Communications Manager, open RTMT and choose Voice/Video > Device > Device Summary.
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Procedure

Step 1 Choose Bulk Administration > EMCC > Insert/Update EMCC.
The Insert/Update EMCC Configuration window displays.

Step 2 Make sure that the Insert EMCC Devices radio button is selected.
Step 3 Enter the number of devices in the Number of EMCC Devices to be added field.
Step 4 In the Job Information area, enter the Job description.

Insert EMCC Devices is the default description.

Step 5 To insert the EMCC devices immediately, click theRun Immediately radio button. ClickRun Later to insert
the devices at a later time.

Step 6 To create a job for inserting the EMCC devices, click Submit.
Step 7 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Update EMCC Devices, on page 546

Update EMCC Devices
Use BAT to update EMCC devices in the database.

Procedure

Step 1 Choose Bulk Administration > EMCC > Insert/Update EMCC.
Step 2 Select the Update EMCC Devices radio button.
Step 3 To set the default template, choose an EMCC template from the Default EMCC Template drop-down list

box.
Step 4 Select the Reset radio button to reset all devices, select Don't Reset if you do not wish to reset all devices.
Step 5 In the Job Information area, enter the Job description.

Update EMCC Devices is the default description.

Step 6 To update the EMCC records immediately, click the Run Immediately radio button. Click Run Later to
update the records at a later time.

Step 7 To create a job for updating the EMCC devices, click Submit.
Step 8 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
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Delete EMCC Devices
You can use BAT to delete EMCC devices in bulk. Use the procedures to delete EMCC devices.

Procedure

Step 1 Choose Bulk Administration > EMCC > Delete EMCC.

The Delete EMCC Configuration window displays.

Step 2 Enter the number of devices to that you wish to delete in the Number of EMCC Devices to be deleted field.
Step 3 In the Job Information area, enter the Job description.

Delete EMCC is the default description.

Step 4 To delete the EMCC devices immediately, click the Run Immediately radio button. Click Run Later to
delete the devices at a later time.

Step 5 To create a job for deleting the EMCC devices, click Submit.
Step 6 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
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P A R T XVI
Intercompany Media Engine (IME)

• Trust Element, on page 551
• Trust Group, on page 555
• Enrolled Group, on page 559
• Exclusion Group, on page 563
• Fallback Profile, on page 567





C H A P T E R 69
Trust Element

This chapter provides information to use Cisco Unified CommunicationsManager Bulk Administration (BAT)
to insert or delete Trust Element records in Cisco Unified Communications Manager database.

• Insert Trust Element Configuration, on page 551
• Delete IME Trust Element Configuration, on page 552
• Topics Related to IME, on page 552

Insert Trust Element Configuration
Use BAT to add Trust Element Configuration to the Cisco Unified Communications Manager database.

Before you begin

• You must have a CSV data file that contains the Element name, Description, Element Type, and the
Trust Group

• You can create the CSV data file by using the BAT spreadsheet that is converted to CSV format.

Procedure

Step 1 Choose Bulk Administration > Intercompany Media Services > Trust Element > Insert Trust Element.
The Insert Trust Element Configuration window displays.

Step 2 In the File Name field, choose the CSV data file that you created for this bulk transaction.
Step 3 (Optional) Check the Override the existing configuration check box if you want to update settings for

existing trust elements in your system.
Step 4 In the Job Information area, enter the Job description.

The default description is Insert Trust Element.

Step 5 To insert the Insert Cisco Trust Element records immediately, click the Run Immediately radio button. Click
Run Later to insert the records at a later time.

Step 6 To create a job for inserting the Unified Trust Element records, click Submit.
Step 7 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.
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Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Topics Related to IME, on page 552

Delete IME Trust Element Configuration
You can delete Trust Element from the Cisco Unified Communications Manager database using a custom
CSV data file.

Do not use the insert transaction files that are created with bat.xlt for the delete transaction. Instead, you must
create a custom file with details of the Trust Element records that need to be deleted. Use only this file for
the delete transaction. In this custom delete file, you do not need a header, and you can enter values for name,
description, and so on.

Note

Before you begin

• Create a text file that lists the Element Name for the Trust Element that you want to delete.

• Upload the custom files to the Cisco Unified Communications Manager server first node.

Procedure

Step 1 Choose Bulk Administration > Intercompany Media Services > Trust Element > Delete Trust Element.
The Delete Trust Element Configuration window displays.

Step 2 From the Delete Trust Element where Name in custom file drop-down list box, choose the filename of the
custom file for this delete, and click Find.
The Trust Element matching your search criteria displays.

Step 3 Click Submit to create a job to delete the Trust Element.
Step 4 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Topics Related to IME, on page 552
Upload File to Server, on page 21

Topics Related to IME
• BAT Log Files, on page 609

• BAT Spreadsheet Data Collection for CSV Data File Creation, on page 12
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• Create Text-Based CSV File for IME Trusted Element Configuration, on page 662

• CSV Data File Overrides Template Values, on page 9

• Delete IME Trust Element Configuration, on page 552

• Insert Trust Element Configuration, on page 551

• Manage Scheduled Jobs, on page 599

• Upload File to Server, on page 21
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C H A P T E R 70
Trust Group

This chapter provides information to use Cisco Unified CommunicationsManager Bulk Administration (BAT)
to insert or delete Trust Group records in Cisco Unified Communications Manager database.

• Insert IME Trust Group Configuration, on page 555
• Deleting IME Trust Group Configuration, on page 556
• Topics Related to IME Trust Group Configuration, on page 556

Insert IME Trust Group Configuration
You can add Trust Group Configuration to the Cisco Unified Communications Manager database using a
custom CSV data file.

Before you begin

You must have a CSV data file that contains the name, Description, and Trust details.

You can create the CSV data file by using the BAT spreadsheet that is converted to CSV format.

Procedure

Step 1 Choose Bulk Administration > Intercompany Media Services > Trust Group > Insert Trust Group.
The Insert Trust Group Configuration window displays.

Step 2 In the File Name field, choose the CSV data file that you created for this bulk transaction.
Step 3 In the Job Information area, enter the Job description.

The default description is Insert Trust Group.

Step 4 To insert the Insert Unified Trust Group records immediately, click the Run Immediately radio button. Click
Run Later to insert the records at a later time.

Step 5 To create a job for inserting the Insert Unified Trust Group records, click Submit.
Step 6 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
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Topics Related to IME Trust Group Configuration, on page 556

Deleting IME Trust Group Configuration
You can delete Trust Group from the database using a custom CSV data file.

Do not use the insert transaction files that are created with bat.xlt for the delete transaction. Instead, you must
create a custom file with details of the Trust Group records that need to be deleted. Use only this file for the
delete transaction. In this custom delete file, you do not need a header, and you can enter values for name,
description, Group type, or Cisco Link Route Filter Group Profile.

Note

Before you begin

1. Create a text file that lists the Name for the Trust Group that you want to delete.

2. Upload the custom files to the server first node.

Procedure

Step 1 Choose Bulk Administration > Intercompany > Media Services > Trust Group > Delete Trust Group.
The Delete Trust Group Configuration window displays.

Step 2 From the Delete Trust Group where Name in custom file drop-down list box, choose the filename of the
custom file for this delete, and click Find.
The Trust Group matching your search criteria displays.

Step 3 Click Submit to create a job to delete the Trust Group.
Step 4 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Topics Related to IME Trust Group Configuration, on page 556
Upload File to Server, on page 21

Topics Related to IME Trust Group Configuration
• BAT Log Files, on page 609

• BAT Spreadsheet Data Collection for CSV Data File Creation, on page 12

• Create Text-Based CSV File for IME Trusted Group Configuration, on page 663

• CSV Data File Overrides Template Values, on page 9

• Deleting IME Trust Group Configuration, on page 556
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• Insert IME Trust Group Configuration, on page 555

• Manage Scheduled Jobs, on page 599

• Upload File to Server, on page 21
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C H A P T E R 71
Enrolled Group

This chapter provides information to use Cisco Unified CommunicationsManager Bulk Administration (BAT)
to insert or delete Enrolled Group records in Cisco Unified Communications Manager database.

• Insert IME Enrolled Group Configuration, on page 559
• Delete IME Enrolled Group Configuration, on page 560
• Topics Related to IME Enrolled Group Configuration, on page 560

Insert IME Enrolled Group Configuration
You can add Enrolled Group Configuration to the Cisco Unified Communications Manager database using a
custom CSV data file.

Before you begin

You must have a CSV data file that contains the group name, description, fallback profile, and all patterns in
group are aliases data.

You can create the CSV data file by using the BAT spreadsheet that is converted to CSV format.

Procedure

Step 1 Choose Bulk Administration > Intercompany Media Services > Enrolled Group > Insert Enrolled
Group.
The Insert Enrolled Group Configuration window displays.

Step 2 In the File Name field, choose the CSV data file that you created for this bulk transaction.
Step 3 In the Job Information area, enter the Job description.

The default description is Insert Enrolled Group.

Step 4 To insert the Insert Unified Enrolled Group records immediately, click the Run Immediately radio button.
Click Run Later to insert the records at a later time.

Step 5 To create a job for inserting the Insert Unified Enrolled Group records, click Submit.
Step 6 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.
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Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Topics Related to IME Enrolled Group Configuration, on page 560

Delete IME Enrolled Group Configuration
You can delete Enrolled Group from the database using a custom CSV data file.

Do not use the insert transaction files that are created with bat.xlt for the delete transaction. Instead, you must
create a custom file with details of the Enrolled Group records that need to be deleted. Use only this file for
the delete transaction. In this custom delete file, you do not need a header, and you can enter values for name.

Note

Before you begin

1. Create a text file that lists the Group name for the Enrolled Group that you want to delete.

2. Upload the custom to the server first node.

Procedure

Step 1 Choose Bulk Administration > Intercompany Media Services > Enrolled Group > Delete Enrolled
Group.

Step 2 From the Delete Enrolled Group where Name in custom file drop-down list box, choose the filename of
the custom file for this delete, and click Find.
The Enrolled Group matching your search criteria displays.

Step 3 Click Submit to create a job to delete the Enrolled Group.
Step 4 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Topics Related to IME Enrolled Group Configuration, on page 560
Upload File to Server, on page 21

Topics Related to IME Enrolled Group Configuration
• BAT Log Files, on page 609

• BAT Spreadsheet Data Collection for CSV Data File Creation, on page 12

• Create Text-Based CSV File for IME Enrolled Group Configuration, on page 664

• CSV Data File Overrides Template Values, on page 9
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• Delete IME Enrolled Group Configuration, on page 560

• Insert IME Enrolled Group Configuration, on page 559

• Manage Scheduled Jobs, on page 599

• Upload File to Server, on page 21
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C H A P T E R 72
Exclusion Group

This chapter provides information to use Cisco Unified CommunicationsManager Bulk Administration (BAT)
to insert or delete Exclusion Group records in Cisco Unified Communications Manager database.

• Insert IME Exclusion Group Configuration, on page 563
• Delete IME Exclusion Group Configuration, on page 564
• Topics Related to IME Exclusion Group Configuration, on page 564

Insert IME Exclusion Group Configuration
You can add Exclusion Group Configuration to the database using a custom CSV data file.

Before you begin

• You must have a CSV data file that contains the name and description.

• You can create the CSV data file by using the BAT spreadsheet that is converted to CSV format.

Procedure

Step 1 Choose Bulk Administration > Intercompany Media Services > Exclusion Group > Insert Exclusion
Group.

Step 2 In the File Name field, choose the CSV data file that you created for this bulk transaction.
Step 3 In the Job Information area, enter the Job description.

The default description is Insert Exclusion Group.

Step 4 To insert the Insert Unified Exclusion Group records immediately, click the Run Immediately radio button.
Click Run Later to insert the records at a later time.

Step 5 To create a job for inserting the Insert Unified Exclusion Group records, click Submit.
Step 6 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
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Topics Related to IME Exclusion Group Configuration, on page 564

Delete IME Exclusion Group Configuration
You can delete Exclusion Group from the database using a custom CSV data file.

Do not use the insert transaction files that are created with bat.xlt for the delete transaction. Instead, you must
create a custom file with details of the Exclusion Group records that need to be deleted. Use only this file for
the delete transaction. In this custom delete file, you do not need a header, and you can enter values for name.

Note

Before you begin

1. Create a text file that lists the name of the Exclusion Group that you want to delete.

2. Upload the custom files to the server first node.

Procedure

Step 1
Step 2 Choose Bulk Administration > Intercompany Media Services > Exclusion Group > Delete Exclusion

Group.
Step 3 From the Delete Exclusion Group where Name in custom file drop-down list, choose the filename of the

custom file for this delete, and click Find.
Step 4 Click Submit to create a job to delete the Exclusion Group.
Step 5 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Topics Related to IME Exclusion Group Configuration, on page 564
Upload File to Server, on page 21

Topics Related to IME Exclusion Group Configuration
• BAT Log Files, on page 609

• BAT Spreadsheet Data Collection for CSV Data File Creation, on page 12

• Create Text-Based CSV File for IME Exclusion Group Configuration, on page 665

• CSV Data File Overrides Template Values, on page 9

• Delete IME Exclusion Group Configuration, on page 564

• Insert IME Exclusion Group Configuration, on page 563
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• Manage Scheduled Jobs, on page 599

• Upload File to Server, on page 21
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C H A P T E R 73
Fallback Profile

This chapter provides information to use Cisco Unified CommunicationsManager Bulk Administration (BAT)
to insert or delete Fallback Profile records in Cisco Unified Communications Manager database.

• Insert Fallback Profile Configuration, on page 567
• Delete Fallback Profile Configuration, on page 568
• Topics Related to Fallback Profile Configuration, on page 568

Insert Fallback Profile Configuration
You can add Fallback Profile Configuration to the database using a custom CSV data file.

Before you begin

• Youmust have a CSV data file that contains the Name, Description, Advertised Fallback Directory E.164
Number, Fallback QOS Sensitivity Level, Fallback Call Answer Timer, Fallback Directory Number
Partition, Fallback Directory Number, Number of Digits for Caller ID Partial Match and Fallback Call
CSS.

• You can create the CSV data file by using the BAT spreadsheet that is converted to CSV format.

Procedure

Step 1 Choose BulkAdministration > Intercompany Media Services > Fallback Profie > Insert Fallback Profile.
Step 2 In the File Name field, choose the CSV data file that you created for this bulk transaction.
Step 3 In the Job Information area, enter the Job description.

The default description is Insert Fallback Profile.

Step 4 To insert the Insert Unified Fallback Profile records immediately, click the Run Immediately radio button.
Click Run Later to insert the records at a later time.

Step 5 To create a job for inserting the Insert Unified Fallback Profile records, click Submit.
Step 6 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.
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Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Topics Related to Fallback Profile Configuration, on page 568

Delete Fallback Profile Configuration
You can delete Fallback Profile from the database using a custom CSV data file.

Do not use the insert transaction files that are created with bat.xlt for the delete transaction. Instead, you must
create a custom file with details of the Fallback Profile records that need to be deleted. Use only this file for
the delete transaction. In this custom delete file, you do not need a header, and you can enter values for name.

Note

Before you begin

1. Create a text file that lists the name of the Fallback Profile that you want to delete.

2. Upload the custom files to the server first node.

Procedure

Step 1 Choose Bulk Administration > Intercompany Media Services > Fallback Profile > Delete Fallback
Profile.

Step 2 From the Delete Fallback Profile where Name in custom file drop-down list, choose the filename of the
custom file for this delete, and click Find.
The Fallback Profile matching your search criteria displays.

Step 3 Click Submit to create a job to delete the Fallback Profile.
Step 4 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Topics Related to Fallback Profile Configuration, on page 568
Upload File to Server, on page 21

Topics Related to Fallback Profile Configuration
• BAT Log Files, on page 609

• BAT Spreadsheet Data Collection for CSV Data File Creation, on page 12

• Create Text-Based CSV File for Fallback Profile Configuration, on page 666

• CSV Data File Overrides Template Values, on page 9
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• Delete Fallback Profile Configuration, on page 568

• Insert Fallback Profile Configuration, on page 567

• Manage Scheduled Jobs, on page 599

• Upload File to Server, on page 21
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• Confidential Access Level Setup, on page 573





C H A P T E R 74
Confidential Access Level Setup

This chapter provides information about using Cisco Unified Communications Manager Administration to
configure Confidential Access Levels (CAL).

• About Confidential Access Level Setup , on page 573
• CAL Enforcement Level, on page 574
• CAL Limitations, on page 575
• Set Up Confidential Access Level , on page 576

About Confidential Access Level Setup
In Cisco Unified Communications Manager Administration, use the Bulk Administration > Confidential
Access Level > Import Confidential Access Level Matrix menu path to configure CAL. CAL feature is
used for restricting calls and other supplementary features such as transfer, forward, conferences including
Meet-Me, and so on.

CAL is a numerical value assigned to an entity:

• Device (for example, an IP Phone)

• Line (for example, a Directory Number)

• Trunk (for example, a SIP trunk)

CAL has two main functions:

• Controls call completion based on configuration.

• Displays information on the phone that conveys additional information about the call.

Format of CAL Matrix

The Confidential Access Level (CAL) matrix is an X/Y matrix that is used to compare one CAL to another
for implementing a call policy. The CAL from the originating number is selected along the X-axis of the
matrix and compared against the destination number along the Y-axis of the matrix. The intersection of these
two values is known as the resolved CAL. The resolved CAL determines whether the call should proceed and
also the message that is displayed to the users.

A sample CAL matrix is as follows:
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Column 5Column 4Column 3Column 2Column 1

321CALDescription

1111Unrestricted

2212Restricted

3213Confidential

ConfidentialRestrictedUnrestrictedDescriptionEND

The matrix must be symmetrical. For example, in the sample CAL matrix above, the value at the intersection
of CAL 2 and CAL 3 is same as the value at the intersection of CAL 3 and CAL 2. Thus, the resolved CAL
in both the cases is 2 (Restricted). Cisco Unified Communications Manager does not validate if the imported
matrix is symmetrical. So it is the responsibility of the administrator to configure a matrix that aligns with the
desired calling policy.

Important

You can configure different CALs as per the requirement. The following CALs have been configured in this
sample matrix:

• 1 - Unrestricted

• 2 - Restricted

• 3 - Confidential

The first row of the CAL matrix must contain all the valid CALs that you want to import into Cisco Unified
Communications Manager. Description and CAL values are optional. The CALs in the remaining columns
can be any numeric values that you want to import. The subsequent rows define the textual description, as
seen in column 1, and its relationship with other CALs in column 3 and the subsequent columns. For every
CAL entered in the first row, there should be a resulting row that contains a textual description for that value.
In other words, column 1 must contain textual descriptions for all the CALs that are entered in the first row.
The last line (END, Description) indicates the end of the CAL matrix. The CALs beyond this row are not
imported.

If a call is originated from a number whose CAL is 1 (Unrestricted) to a destination number whose CAL is 2
(Restricted), the resolved CAL is 1 (the intersection of CAL 1 and CAL 2). Hence, the text corresponding to
CAL 1—Unrestricted is displayed on both the phones. Similarly, if the call is between a Restricted party (with
CAL 2) and a Confidential party (with CAL 3), then Restricted (corresponding to the resolved CAL 2) will
be displayed on both the phones. Thus, the CALmatrix resolves to the highest common value possible between
all parties of the call.

CAL Enforcement Level
In Cisco Unified Communications Manager 10.0(1), the CAL feature is not configurable on internal Cisco
Unified Communications Manager devices that are used in features such as Directed Call Park, Built in
Bridges, and so on, and also on a few endpoints such asMGCPBRI devices,Mobility, and CTI based endpoints.
If you apply CAL resolution restriction strictly for all the calls, it may result in undesired call failures. Also,
applying the CAL restriction without assigning CAL values to all the devices may result in call failures.
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To avoid undesired call failures and to facilitate smooth deployment of the CAL feature, the following modes
of CAL enforcement are implemented in Cisco Unified Communications Manager Release 10.0(1):

• Strict Mode-in this mode, the CAL Enforcement Level enterprise parameter is set to Strict. If the CAL
value is not configured for a device or if a feature that does not support CAL is invoked, the call is
allowed.

• Lenient Mode-in this mode, the CAL Enforcement Level enterprise parameter is set to Lenient. Even if
the CAL value is not configured for a device or if a feature that does not support CAL is invoked, the
call is allowed. However, if CAL values are configured for all the devices and the CAL resolution fails,
the call is not allowed.

Cisco recommends that you deploy the CAL feature in Lenient mode in Cisco Unified Communications
Manager Release 10.0(1).

Note

To set the CAL enforcement level, choose System >Enterprise Parameters and select the CAL enforcement
level from the CAL Enforcement Level drop-down list.

Note

To ensure that the Lenient mode functions properly, it is highly recommended that you configure appropriate
warning text on the 'CAL Resolution Warning Message Text' enterprise parameter. For example, Warn: CAL
unknown. The warning text is displayed on the phones whenever the CAL values are not configured but the
call is allowed.

Important

CAL Limitations
The following limitations apply to the CAL feature:

• The built-in bridges (BIB) on the phones are not assigned CAL values. In Barge andMonitoring features,
where BIBs are used, a warning message is displayed on the phones that use these features. The warning
text is displayed based on the warningmessage that is configured in the CALResolutionWarningMessage
Text enterprise parameter.

• Unlike SIP trunks, as theMGCP and H323 devices do not pass the resolved CAL values from one cluster
to another, you may see different resolved CAL values on the calling and called entities on the call.

• The CAL feature is not supported on all phone models. To check if CAL is supported on your phone,
see the Cisco Unified IP Phone User Guide that is specific to your phone model.

• In Cisco Unified Communications Manager Release 10.0(1), Directed Call Park and Mobility features
can work only in Lenient mode.

• Extension Mobility applies only the CAL values that are associated with the lines.
• The calling SIP phones do not display PENDING message until the call is answered even if the CAL
header is included in the SIP 180 Ringing message. To overcome this limitation, you can apply a LUA
script at the SIP Profile level associated with the phone. The LUA script removes the CAL Header in
the SIP 180 ringing message and updates the Remote Party ID to PENDING. An example of a LUA
script is provided below. You can apply this script to display PENDING message on the calling phone
until the call is answered.
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M = {}
trace.enable()
function M.outbound_180_INVITE(msg)
local cal =msg:getHeader("Confidential-Access-Level")
if cal then
msg:removeHeader("Confidential-Access-Level")
1
CAL limitations
REVIEW DRAFT - CISCO CONFIDENTIAL
local rpi =msg:getHeaderValues("Remote-Party-ID")
local uri = "\"PENDING\" "
rpi[1] = uri .. string.match(rpi[1], "(<.+)")
msg:modifyHeader("Remote-Party-ID", rpi[1])
msg:addHeader("Remote-Party-ID",rpi[2])
end
end
return M

• When you disable Auto Pickup, the 418 Incompatible SIP message is not sent to the phones when CAL
resolution fails during the pickup.

• When a phone with the CAL associated with its line receives an INVITE message, where the Directory
number in the From header is different from the value configured in the Cisco Unified Communications
Manager database for that phone, the Cisco Unified Communications Manager sends a SIP 418 Invalid
CALmessage to the phone if the CAL feature is enabled. If the CAL feature is disabled, the Cisco Unified
Communications Manager retains the original behavior and sends a SIP403 Forbidden message.

Set Up Confidential Access Level
Follow these steps to set up confidential access level:

Procedure

Step 1 Choose Bulk Administration > Confidential Access Level > Import Confidential Access Level Matrix.

The Confidentiality Access Level Matrix Upload window opens.

Step 2 Click Browse and select the csv file that you want to upload.

The csv file contains the CAL table which is an X/Y matrix used to find the resolved CAL value.Note

Step 3 Click Upload.

The Upload button is enabled only for CCMSuper Users and Standard Confidential Access Level
Users access groups.

Note
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• License Updates and Exports Using CUP Menu, on page 579





C H A P T E R 75
License Updates and Exports Using CUP Menu

This chapter provides information to use the CUPS menu in BAT to update and export licenses of all Unified
Presence and Cisco Unified Personal Communicator users.

Cisco Unified Presence, a critical component for delivering the full value of a Cisco Unified Communications
environment, collects information about user availability. Using this information, applications such as Cisco
Unified Personal Communicator and Cisco Unified Communications Manager can improve productivity by
determining the most effective way for collaborative communication.

• Update and Export CUP and CUPC User Licenses, on page 579

Update and Export CUP and CUPC User Licenses
You can use the CUPS menu in BAT to update and export CUPS and CUPC user licenses.

Procedure

Choose from the following options:
a) To update CUPS/CUPC Users, choose Bulk Administration > CUPS > Update CUPS/CUPC Users
b) To export CUPS/CUPC Users, choose Bulk Administration > CUPS > Export CUPS/CUPC Users

Add or Update CUPS and CUPC User Licenses
You can use BAT to add or change the license.

Procedure

Step 1 Use the Upload/Download Files window to upload the csv file.

You must ensure that you select the correct BAT target and transaction type while you are
uploading the csv file.

Note

Step 2 Navigate to the Update CUPS window, select the csv file that is uploaded, and submit the job.
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You can choose to run the job immediately or later by clicking the respective radio button. If you
choose Run Later, you need to use the Job Scheduler window to schedule and activate this job.

Note

Step 3 Use the Job Scheduler window to monitor the progress of the BAT job that is submitted.

Export All CUPS/CUPC User License Information
You can use the Export Users Query window can be used to obtain the current license information about all
users for Unified Presence and Cisco Unified Personal Communicator.

No option currently exists to select a subset of Unified Presence users; all Unified Presence users in the system
get exported to file.

Note

Procedure

Step 1 Navigate to the Export Users Query window.
Step 2 To view the basic user information and their license status, click Find.
Step 3 To view the Export window for CUPS/CUPC, click Next.
Step 4 Specify the file name to be exported and click Submit to start the BAT job.
Step 5 Go to the Job Scheduler window to view the status of the BAT job that is submitted.

After the job completes, you can go to the Upload/Download Files window to download the
exported.csv file.

Note
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Tool for Auto-Registered Phones Support

• Manage Tool for Auto-Registered Phones Support (TAPS), on page 583
• Tool for Auto-Registered Phone Support (TAPs) User Locales, on page 593
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Manage Tool for Auto-Registered Phones Support
(TAPS)

This chapter provides information about installing, configuring, and using the Tool for Auto-Registered Phones
Support (TAPS).

• TAPS Overview, on page 583
• Install TAPS, on page 586
• TAPS Application Configuration in UCCX Applications Server, on page 587
• Activate TAPS Service, on page 588
• Start Stop and Restart TAPS, on page 588
• TAPS Option Settings, on page 589
• Configure TAPS Auto-Registration, on page 589
• TAPS Secure Directory Number Option, on page 590
• View TAPS Log Files, on page 592
• Related Topics, on page 592

TAPS Overview
The Tool for Auto-Registered Phones Support (TAPS) enables phone users to call the TAPS directory number
and download the preconfigured phone settings for the user's directory number. TAPS works in conjunction
with Cisco Unified Communications ManagerAdministration to provide these capabilities:

• Configure TAPS—Allows you to enable TAPS usage for all phones that use auto-registration or to limit
TAPS to only phones that are added through BAT with dummy MAC addresses.

• Secure TAPS—Allows you to keep some directory numbers from being updated through TAPS.

• User Locales for TAPS—Allows you to choose the languages for TAPS prompts.

TAPS components get installed on the Cisco Unified CommunicationsManager first node as part of the Cisco
Unified Communications Manager installation. You must enable auto-registration in Cisco Unified
Communications Manager for TAPS to function. In addition, you must enable the CallManager service on
the first node, even if the first node is not being used to register phones.
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When you use TAPS, it leads to the depletion of auto-registration range on the Cisco Unified Communications
Manager. After update through TAPS, the auto-registered directory number (DN) of the phone becomes an
unassigned DN. You should delete unassigned DNs using BAT periodically to free up the auto-registration
range.

Note

You must install TAPS application on the Cisco Unified Contact Center Express (CiscoUCCX) server. TAPS
requires the CiscoIP Interactive Voice Response (IPIVR) application that runs on the CiscoUCCX server for
the user interface and prompts.

Administrators need to provide instructions to tell end users how to use TAPS to configure their new phones.

Cisco recommends that you stop the TAPS service when you are not using TAPS to add phones to Cisco
Unified Communications Manager database.

Note

Related Topics
Select Language of TAPs Prompts on New Phone, on page 595
Configure TAPS Auto-Registration, on page 589
TAPS Secure Directory Number Option, on page 590
User Locales for Tool for Auto-Registered Phone Support, on page 593
Related Topics, on page 592

TAPS Auto-registration Options
You can set the following options for using TAPS to update auto-registering phones.

• Update MAC addresses and download a predefined configuration for new phones.

• Reload the configuration for replacement phones.

TAPS with New Phone Examples
After BAT has added the new phone configurations with dummy MAC addresses in Cisco Unified
Communications ManagerAdministration, you can plug the phones into the network. You or the phone user
can dial a TAPS directory number that causes the phone to download its configuration. At the same time, the
phone gets updated in Cisco Unified CommunicationsManager Administration with the correctMAC address.
You must make sure that Auto-registration is enabled in Cisco Unified Communications Manager
Administration for TAPS to function.

When you use TAPS, it leads to the depletion of auto-registration range on the Cisco Unified Communications
Manager. After update through TAPS, the auto-registered directory number (DN) of the phone becomes an
unassigned DN. You should delete unassigned DNs using BAT periodically to free up the auto-registration
range.

Note
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Example

You have 100 new-hire employees starting on Monday. You must add these users and their new phones to
Cisco Unified Communications Manager Administration. You can use BAT to create a phone template for
these 100 phones and a CSV data file for phones and users. By using the dummy MAC address option in the
CSV data file, you do not need to add the individualMAC addresses for the new phones.With auto-registration
enabled in Cisco Unified Communications Manager, you can plug the phones directly into the network. You
or the new employee can load the configuration by dialing the TAPS directory number and following the
voice-prompt instructions.

Reloading Configurations Using TAPS
When you must replace an existing phone that is not functioning, you can use TAPS to download the existing
phone configuration to the new phone. After the user receives the new phone and plugs the phone into the
network, the user dials the TAPS directory number to download configuration for the previous phone. The
user makes no configuration changes during this process.

In Cisco Unified Communications Manager Administration, you must enable auto-registration. You must
ensure that you configure TAPS usage for all phones to enable a user to download an existing phone
configuration.

When you use TAPS, it leads to the depletion of auto-registration range on the Cisco Unified Communications
Manager. After update through TAPS, the auto-registered directory number (DN) of the phone becomes an
unassigned DN. You should delete unassigned DNs using BAT periodically to free up the auto-registration
range.

Note

For more information, see the Cisco Unified Communications Manager Online Help.

Example

John's CiscoUnifiedIPPhone model 7940 gets short-circuited during a lightning storm. He receives a new
CiscoUnifiedIPPhone model 7940 and plugs it into the network. John can dial the TAPS directory number,
and the new phone will download the configuration that was previously used for the damaged phone. TAPS
automatically updates device information in Cisco Unified Communications Manager Administration.

Related Topics
Configure TAPS Auto-Registration, on page 589
Related Topics, on page 592

Secured Directory Numbers
Because TAPS can replace a directory number, you can protect certain directory numbers from being
overwritten. To protect important directory numbers, you can use the Secure TAPS option.

Example

The directory number 5000 provides voice-messaging access for your system. You do not want a new user
to mistakenly configure 5000 on the new phone. The Secure TAPS option allows you to specify that TAPS
cannot access directory number “5000.”
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Related Topics
TAPS Secure Directory Number Option, on page 590
Related Topics, on page 592

Language Prompts for TAPS Users
You can configure user prompts for TAPS to play in several languages. Administrators can choose the
languages to make available to users.

If you need to use language prompts other than English prompts, before you install, upgrade, or configure
TAPS, run the Cisco Unified Communications Manager Locale Installer on each cluster node and restart each
node.

Using the locale installer ensures that you have the latest translated text, translated voice prompts,
country-specific phone tones, and country-specific gateways tones available for the phones. For more
information on the Cisco Unified Communications Manager Locale Installer, refer to the specific locale
installer documentation.

You can use the file get tftp <AAR file name> CLI command the get the AAR file the Cisco Unified
Communications Manager TFTP directory.

Note

Related Topics
User Locales for Tool for Auto-Registered Phone Support, on page 593
Related Topics, on page 592

Install TAPS
This section provides information about installing, reinstalling, and uninstalling TAPS. TAPS interfaces with
both Cisco Unified Communications Manager server and CiscoCustomer Response Solution server. This
installation procedure involves installing TAPS on the UCCX server.

Refer to the Cisco Unified Contact Center Express (Cisco Unified CCX) Software and Hardware Compatibility
Guide to find out the CiscoUCCX version compatible to the TAPS version you are installing.

Note

Before you begin

The following prerequisites apply to TAPS installation for BAT:

• Make sure that the Cisco Unified Communications Manager first node is configured and running.

• Have the IP address for the Cisco Unified Communications Manager first node server.

• Ensure the CiscoUCCX server is configured. The CiscoUCCX application can reside on its own dedicated
server.

• Be sure to use the locale installer to create the country-specific TAPS prompts.

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
586

Tool for Auto-Registered Phones Support
Language Prompts for TAPS Users



Install TAPS on the UCCX application server.

Procedure

Step 1 Log on with administrator privileges to the system that is running the Cisco Unified CommunicationsManager
first node database.

Step 2 Choose Applications > Plugins.
The Find and List Plugins window displays.

Step 3 Find the TAPS link and click Download to save the TAPS_AAR.aar plugin to your local machine.
Step 4 Log in to the UCCX App admin page through Applications > AAR Management as TAPS user and Upload

the TAPS_AAR.aar from AAR Management page.
Step 5 Go to Applications > Application Management.

The Application Management page displays.
Step 6 Click on the TAPS application.
Step 7 Select the Cisco_Unified_CM_IP_Address check box and specify the Cisco Unified Communications

Manager IP address, enclosed in double quotes.

By default the IP address will be “”, you must enter the IP address between the quotes.Note

Step 8 Restart Tomcat and Cisco Unified CCX Cluster View Daemon using the following commands

• utils service “Cisco Tomcat” stop/start

• utils service “Cisco Unified CCX Cluster View Daemon” stop/start

Refer to the Cisco Unified Contact Center Express Administration Guide for more information
on managing the TAPS_AAR.aar.

Note

Related Topics
Related Topics, on page 592

TAPS Application Configuration in UCCX Applications Server
You can review the Cisco UCCX application server documentation by browsing to CiscoVoice Applications
and Tools at www.cisco.com. See the Cisco Unified Contact Center Express Administration Guide for
instructions on how to configure an application.

The TAPS application does not work with a Cisco UCCX Standard license. You must use either an Enhanced
or Premium license.

Note

Related Topics
Related Topics, on page 592
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Activate TAPS Service
You can activate and deactivate TAPS service using Cisco Unified Communications Manager Serviceability
after you access it using the appropriate URL.

Procedure

Step 1 Access Cisco Unified Communications Manager Serviceability.
Step 2 Choose Tools > Service Activation.

The Service Activation window displays.
Step 3 Choose the appropriate server from the drop-down list box. Click Next.
Step 4 Choose TAPS Service from Database and Admin Services of the UnifiedCMServices list and click Save.

If the service is already activated, the Activation Status will display as Activated.Note

The service gets activated, and the Activation Status column displays the status as Activated.

Start Stop and Restart TAPS
The TAPS service starts automatically after it is activated by using Cisco Unified Communications Manager
Serviceability. This section describes the procedures to stop or restart the TAPS service.

Procedure

Step 1 In Cisco Unified CommunicationsManager Serviceability, chooseTools >Control Center - Feature Services.

The Control Center–Feature Services window displays.

Step 2 Choose the Cisco Unified Communications Manager server from the Servers drop-down list box.

TAPS Service displays in list under Database and Admin Services column, in the UnifiedCMServices.

If TAPS is already activated, the Status displays as Activated.Note

Step 3 Check the check box that corresponds to TAPS Service.
Step 4 If you want to restart the TAPS service, click Restart.

The service restarts, and the message, Service Successfully Restarted, displays.

Step 5 If you want to stop the TAPS service, click Stop.

The service stops, and the message, Service Successfully Stopped, displays.

Step 6 If you want to start a stopped TAPS service, click Start.
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The service starts, and the message, Service Successfully Started, displays.

Related Topics
Activate TAPS Service, on page 588

TAPS Option Settings
Administrators can choose how to use TAPS in their Cisco Unified Communications Manager system. These
TAPS feature options provide more flexibility when allowing users to update phones or download phone
profiles. TAPS options include auto-registration, TAPS secure directory number, and user locales for
auto-registered phone support.

Configure TAPS Auto-Registration
The Configure TAPS option provides two ways to use TAPS to update phones that auto-register with the
Cisco Unified Communications Manager database.

• For phones that are added by using BAT and have a dummy MAC address.

• For existing phones in Cisco Unified Communications Manager Administration

The default setting limits use of TAPS to phones that have a dummy MAC address with a device name that
starts with the prefix “BAT.”

You can set the Configure TAPS option to allow any phone to auto-register in the Cisco Unified
Communications Manager system, including phones that have a standard MAC address.

When you use TAPS, it leads to the depletion of auto-registration range on the Cisco Unified Communications
Manager. After update through TAPS, the auto-registered directory number (DN) of the phone becomes an
unassigned DN. You should delete unassigned DNs using BAT periodically to free up the auto-registration
range.

Note

Procedure

Step 1 In the CiscoUnified CommunicationsManager Administrationwindow, choose System > Service Parameters.
The Service Parameter Configuration window displays.

Step 2 From the Server drop-down list, choose the appropriate server.
Step 3 From the Service drop-down list, choose TAPS Service.
Step 4 Choose one of these two options from the Parameter Value drop-down list box, and click Save.

a) Allow Auto-Registered phones to reset with a profile with a dummy MAC address.
TAPS updates auto-registered phones with a profile that have the dummy MAC address only.

b) Allow Auto-Registered phones to reset with any profile.

TAPS updates auto-registered phones with any profile.
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A status message indicates that the update is successful.

What to do next

To return to the TAPS Options window, click Back.

Related Topics
Related Topics, on page 592

TAPS Secure Directory Number Option
The Secure TAPS options let you specify directory numbers that TAPS cannot access. Use this capability
when you want to protect directory numbers from being accidentally assigned to another phone.

When you use TAPS, it leads to the depletion of auto-registration range on the Cisco Unified Communications
Manager. After update through TAPS, the auto-registered directory number (DN) of the phone becomes an
unassigned DN. You should delete unassigned DNs using BAT periodically to free up the auto-registration
range.

Note

Use the following sections to find restricted directory numbers or to add restrict more directory numbers:

Related Topics
Find Secure Directory Numbers, on page 590
Remove Directory Number Restriction, on page 591
Restrict Directory Numbers, on page 591
Related Topics, on page 592

Find Secure Directory Numbers
You can find and list the directory numbers that have been restricted.

Procedure

Step 1 Choose Bulk Administration > TAPS > Secure TAPS.
The Find and List Directory Numbers to Secure window displays.

Step 2 Enter the appropriate search criteria and click Search.
If there are secured numbers available, then the list displays those numbers.

What to do next

You can proceed to restrict directory numbers or lift the restriction for a directory number.
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Related Topics
Related Topics, on page 592
Remove Directory Number Restriction, on page 591
Restrict Directory Numbers, on page 591
TAPS Secure Directory Number Option, on page 590

Restrict Directory Numbers
You can block TAPS from using directory numbers that you specify. TAPS cannot use any directory number
that you include in the list of secured directory numbers.

Procedure

Step 1 Choose Bulk Administration > TAPS > Secure TAPS.
The Find and List Directory Numbers To Secure window displays.

Step 2 Click Add New.
The Secure Directory Numbers Configuration window displays.

Step 3 In the Directory Number field, enter the number(s) that you want to protect from TAPS, and click Save.

To enter multiple Directory Numbers, use one line for each Directory Number entry.Tip

Step 4 To return to Find and List Directory Numbers window, choose Back to Find/List from the Related links
drop-down list box on the right, top corner of the window and click Go.

TAPS cannot use the directory numbers that are shown in this list. If a user tries to update a device profile by
entering one of the directory numbers in this list, TAPS will refuse the request.

Related Topics
Related Topics, on page 592

Remove Directory Number Restriction
You can remove a directory number from the list of directory numbers that TAPS cannot access.

Procedure

Step 1 Choose Bulk Administration > TAPS > Secure TAPS.
The Find and List Secure Directory Numbers window displays.

Step 2 Find the directory numbers you want to delete.
Step 3 Choose the directory numbers that you want to remove from the secure directory number list and clickDelete.

Related Topics
Find Secure Directory Numbers, on page 590
Related Topics, on page 592
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View TAPS Log Files
Use BAT to view TAPS log files. Each row of the log file represents each TAPS transaction.

Procedure

Choose Bulk Administration > TAPS > View Taps Log File.
The View TAPS Log File window displays.

Related Topics
Related Topics, on page 592

Related Topics
• TAPS Overview, on page 583

• Install TAPS, on page 586

• Activate TAPS Service, on page 588

• Activate TAPS Service, on page 588

• Start Stop and Restart TAPS, on page 588

• TAPS Option Settings, on page 589

• TAPS Auto-registration Options, on page 584

• View TAPS Log Files, on page 592

• User Locales for Tool for Auto-Registered Phone Support, on page 593

• Select Language of TAPs Prompts on New Phone, on page 595
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Tool for Auto-Registered Phone Support (TAPs)
User Locales

The chapter provides information to add or remove languages for TAPS prompts.

You have to select at least one user locale for TAPS to work. Use the Locale Installer to install user locale
support. For more information on the Cisco Unified Communications Manager Locale Installer, refer to the
specific locale installer documentation.

• User Locales for Tool for Auto-Registered Phone Support, on page 593
• Add Languages to Tool for Auto-Registered Phone Support Prompts, on page 594
• Remove Languages From Tool for Auto-Registered Phone Support Prompts, on page 594
• Select Language of TAPs Prompts on New Phone, on page 595
• Topics Related to Tool for Auto-Registered Phone Support User Locales, on page 596

User Locales for Tool for Auto-Registered Phone Support
Administrators can specify the languages for TAPs voice prompts by using the User Locales for TAPS option.
You can configure user prompts for TAPS in several languages.

You must run the Locale Installer to install user locale support.

The TAPS user locales installed in Cisco Unified Communications Manager will automatically be copied to
the Cisco Unified Contact Center Express when a TAPS call is made. The TAPS user locales are not available
on the Prompt Management page of Cisco Unified Contact Center Express.

Note

Using the locale installer ensures that you have the latest translated text, translated voice prompts,
country-specific phone tones, and country-specific gateways tones that are available for the phones. For more
information on the Cisco Unified Communications Manager Locale Installer, refer to the specific locale
installer documentation.

You have to select at least one user locale for TAPS to work.Note
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Add Languages to Tool for Auto-Registered Phone Support
Prompts

You can add languages for TAPS prompts.

Procedure

Step 1 In the Cisco Unified Communications Manager Administration window, choose Bulk Administration >
TAPS > User Locales for TAPS.
The User Locales Configuration window displays.

Step 2 In the User Locales list box, choose the languages that you want to use for user prompts. Click the arrow to
move the chosen language to the Selected User Locales list box.

TheUser Locales list box is the list of languages that are installed on Cisco Unified CommunicationsManager.

You can choose, a maximum of twenty, languages as you need for user prompts andmove them to the Selected
User Locales list box.

If the language that you want does not appear, you must download the Locale Installer from
cisco.com and install it on your cluster nodes.

Note

All the languages that you add to the Locales pane are offered as options to the user. The order
of the locales in the Locales pane does not matter because users set the support prompt language
preference on their phone.

Note

Step 3 After you have chosen the languages for user prompts, click Save to create a job.
Step 4 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

Related Topics
BAT Log Files, on page 609
Manage Scheduled Jobs, on page 599
Topics Related to Tool for Auto-Registered Phone Support User Locales, on page 596

Remove Languages From Tool for Auto-Registered Phone
Support Prompts

You can remove languages for TAPS prompts.

Procedure

Step 1 Choose Bulk Administration > TAPS > User Locales for TAPS.
The Select User Locales window displays.
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Step 2 In the Selected User Locales list box, choose the language that you want to remove. Click the arrow to move
the chosen language to the User Locales list box.

The Selected User Locales list box is the list of languages that is chosen for user prompts. You can choose
one or many languages from user prompts and move them to the User Locales list box.

Step 3 Click Save.
A status message indicates that the update is complete.

What to do next

To return to the TAPS Options window, click Back.

Related Topics
Topics Related to Tool for Auto-Registered Phone Support User Locales, on page 596

Select Language of TAPs Prompts on New Phone
End users can select the language of TAPs prompts for their phones.

Procedure

Step 1 Plug the phone into a port.

The phone automatically registers and displays a number.

It takes around 20-25 seconds for downloading phone profile and making necessary updates in
first node and directory.

Note

Step 2 Dial the CTI Route Point number provided by your system administrator and follow the prompts.
Step 3 Dial the TAPS extension that your system administrator provided.
Step 4 A voice prompts you to choose the language that you want to use. Choose appropriately.
Step 5 Dial your personal extension number, that your system administrator provided, followed by #.

You may be instructed to enter the complete telephone number (including area code).Note

Step 6 To confirm, enter your personal extension number again, followed by #.
Step 7 You will receive confirmation prompt.
Step 8 Hang up the phone.

The phone resets and displays your extension number.

What to do next

If you experience any problems, contact your system administrator.
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Related Topics
Topics Related to Tool for Auto-Registered Phone Support User Locales, on page 596

Topics Related to Tool for Auto-Registered Phone Support User
Locales

• User Locales for Tool for Auto-Registered Phone Support, on page 593

• Select Language of TAPs Prompts on New Phone, on page 595

• Install TAPS, on page 586

• Activate TAPS Service, on page 588

• Activate TAPS Service, on page 588

• Start Stop and Restart TAPS, on page 588

• TAPS Option Settings, on page 589

• TAPS Secure Directory Number Option, on page 590
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Scheduling Jobs

• Manage Scheduled Jobs, on page 599





C H A P T E R 78
Manage Scheduled Jobs

This chapter provides information about activating BPS and scheduling jobs.

You can schedule bulk transactions and specify a time when they need to start these transactions. All jobs
that are submitted through the Bulk Administration menu in the Cisco Unified Communications Manager
Administration, queue up on the Bulk Provisioning Service (BPS). Depending on the start time specified for
a job, the transaction starts running. If no start time is mentioned, the transactions execute in the order that
they are received.

• Activate Bulk Provisioning Service, on page 599
• Start, Stop and Restart BPS, on page 600
• Deactivate BPS and Log Out, on page 600
• Find Jobs Submitted to BPS, on page 601
• Schedule Submitted Jobs, on page 602

Activate Bulk Provisioning Service
Before submitting a job for execution, the Bulk Provisioning Service (BPS) should be activated.

BPS starts automatically after it is activated. Every time that the service is started, BPS synchronizes with
Cisco Unified Communications Manager database.

Procedure

Step 1 FromCiscoUnified Communications Manager Serviceabilitywindow, chooseTools > Service Activation.
The Service Activation window displays.

Step 2 From the Server drop-down list box, choose the server that is running CiscoUnified CommunicationsManager.
Step 3 In the Database and Admin Services area, check the check box corresponding to CiscoBulk Provisioning

Service.

If the service is already activated, the Activation Status will display as Activated.Note

Step 4 Click Update.
The window refreshes and the Activation Status corresponding to Bulk Provisioning Service displays Activated.
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Related Topics
Start, Stop and Restart BPS, on page 600
Topics Related to Tool for Auto-Registered Phone Support User Locales, on page 596

Start, Stop and Restart BPS
You can manually stop or restart the Bulk Provisioning Service (BPS).

The BPS starts automatically after it is activated using CiscoUnified CommunicationsManager Serviceability.Note

Procedure

Step 1 In CiscoUnified CommunicationsManager Serviceability, chooseTools >Control Center - Feature Services.

The Control Center–Feature Services window displays.

Step 2 Choose the Cisco Unified Communications Manager server from the Servers drop-down list box.

CiscoBulk Provisioning Service displays in list under Service Name column, in the Database and Admin
Services area.

If BPS is already activated, the Activation Status will display as Activated.Note

Step 3 Check the check box corresponding to BPS and do one of the following:
a) To restart BPS, click Restart.

The service restarts, and the message, Service Successfully Restarted, displays.

b) To stop BPS, click Stop.
The service stops, and the message, Service Successfully Stopped, displays.

c) To start the stopped BPS, click Start.
The service starts, and the message, Service Successfully Started, displays.

Deactivate BPS and Log Out
After you deactivate BPS you can log out of the tool when you no longer need to use itl.

Procedure

Step 1 In CiscoUnified Communications Manager Serviceability, choose ToolsService Activation.
The Service Activation window displays.

Step 2 Choose the Cisco Unified Communications Manager server from the Servers drop-down list box.
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CiscoBulk Provisioning Service displays in the list under Service Name column in theDatabase and Admin
Services area.

Step 3 Uncheck the check box corresponding to the CiscoBulk Provisioning Service and click Update.
The service deactivates and the Status column displays the status as Deactivated.

Find Jobs Submitted to BPS
You can find jobs that are already submitted to BPS through the Bulk Administration menu on Cisco Unified
Communications Manager Administration.

Procedure

Step 1 Choose Bulk Administration > Job Scheduler. The Find and List Job window displays.
Step 2 From the first Find Job where drop-down list box, choose one of the following options.

• User
• Status
• Job ID
• Description
• Scheduled Date Time

When searching for jobs, use epoch time and not human readable date. For example, search with
1438171 rather than July 2015.

Note

Step 3 From the second Find Job where drop-down list box, choose one of the following options.

• begins with
• contains
• is exactly
• ends with
• is empty
• is not empty

Step 4 From the third drop-down list box, choose Show to display completed jobs.
Step 5 Specify the appropriate search text, if applicable, and click Find.

To further define your query, you can choose AND or OR to add multiple filters and repeat Step 2, on page
601 through Step 5, on page 601.

To find all jobs that are registered in the database, click Find without entering any search text.Tip

A list of discovered jobs displays by:

• Job Id
• Scheduled Date Time
• Submit Date Time
• Sequence
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• Description
• Status
• Last User

The Status displays Hold if Run Later radio button was selected while scheduling the job.
The Status displays Pending if Run Immediately radio button was selected. The Status
displays Completed for completed jobs and it displays Incomplete for jobs that had an error
and could not be completed.

Note

Step 6 Click the Job ID for the job in process or on hold, that you want to schedule and/or activate.
The Job Configuration window displays.

Schedule Submitted Jobs
You can schedule submitted jobs.

Procedure

Step 1 Find the job you want to schedule.
Step 2 In the Job Configuration window, enter the settings for scheduling and activating the job.

See the following table.

Table 51: Job Configuration Settings

DescriptionField

Displays the job ID that is created when the job is submitted.Job Id

Displays the status of the job from one of the following options:

• Hold

• Pending

• Completed

• Incomplete

Job Status

Choose the month, date, and year from the drop-down list. Enter the time
when you want the job to be scheduled.

Scheduled Date Time

Displays the date and time when the job was submitted.Submit Date Time
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DescriptionField

Choose from the drop-down list, the sequence in which the job should be
run. You can choose a number between 1 and 20.

If the scheduled date and time is same for two or more jobs,
then the jobs are queued in BPS according the sequence
number. If the scheduled date and time, and Sequence is same,
then the jobs are queued depending on the submitted date and
time.

Note

Sequence

Displays the description you entered when the job was created. This
description can be edited to include up to 50 characters in any language, but
it cannot include double-quotes ("), percentage sign (%), ampersand (&),
back-slash (\), or angle brackets (<>).

Job Description

Choose from the following options, the frequency of the transaction:

• Once

• Monthly

• Weekly

• Daily

• Hourly

For example, if you choose Daily, the transaction will be repeated daily at
the time entered in the Schedule Time and Date field.

Frequency

Displays the end time for recurring (frequency) job.Job End Time

Displays the user ID of the administrator who last modified this job.Last Modified By

Step 3 Click Activate job to activate the job at the scheduled time or click Save to save the configuration settings
to activate the job at a later time.

The Find and List Jobs window displays.

If a Job is saved, but not activated then status of the job will be displayed as Hold. These jobs
will not be processed by BPS unless they are activated.

Note

Step 4 Click the job ID for the job you have activated. In the Job Configuration window, the following information
displays in the Job Results area, for all jobs that are complete, incomplete, stop requested, or processing.

• Job Launched Date Time

• Job Result Status

• Number of records Processed

• Number of Records Failed

• Total Number of Records

• Log File Name
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Click on the link in the Log File Name column to view the log file for this transaction.Note

What to do next

To go back to the list of jobs, choose Back to Find/List from the Related Links drop-down list and click
Go.

Related Topics
Find Jobs Submitted to BPS, on page 601
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Troubleshooting BAT and TAPS

• Manage Troubleshooting BAT and TAPS, on page 607
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Manage Troubleshooting BAT and TAPS

This chapter provides information about various problems and messages that you might encounter when you
are using Cisco Unified Communications Manager Bulk Administration (BAT) or Tool for Auto-Registered
Phones Support.

• Enable Trace to View Configuration Files, on page 607
• Disable Trace of Configuration Files, on page 608
• BAT Log Files, on page 609
• Troubleshooting BAT, on page 609
• Troubleshooting BAT Performance, on page 613
• Troubleshooting BAT and TAPS, on page 614
• Topics Related to Troubleshooting BAT and TAPS, on page 615

Enable Trace to View Configuration Files
You can enable the writing of trace files feature from the Service Control window in Cisco Unified
Communications Manager Serviceability.

Trace files provide a means of tracking problems in the functioning of a tool. The system writes trace files
for BAT and TAPS to the server on which BAT and TAPS are installed.

The BAT and TAPs trace files display as follows:

bps<index number>.log

taps<index number>.log

where <index number> ranges from 1- 250.

Procedure

Step 1 In Cisco Unified Communications Manager Serviceability, choose Trace > Trace Configuration.
The Trace Configuration window displays.

Step 2 Choose the Cisco Unified Communications Manager server, from the Server drop-down list box.
Step 3 Choose one of the following services from the Configured Services drop-down list box.

• For BAT trace file settings, choose CiscoBulk Provisioning Service
• For TAPS trace file settings, choose TAPS Service
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Step 4 To activate the trace feature, click the Trace On check box.
Step 5 In theTrace Filter Settings, choose the trace level that you want to set from theDebug Trace Level drop-down

list box.

Click the desired debug trace level as described in the following table.

Table 52: Debug Trace Levels

DescriptionLevel

Traces very severe error events that may cause the application to abort.Fatal

Traces alarm conditions and events. Used for all traces that are generated
in abnormal path. Uses minimum number of CPU cycles.

Error

Traces potentially harmful situations.Warn

Traces the majority of servlet problems and has a minimal effect on system
performance.

Info

Traces all State Transition conditions plus media layer events that occur
during normal operation.

Trace level that turns on all logging.

Debug

Step 6 Check the check boxes for CiscoBulk Provisioning Service Trace Fields and Device Name Based Trace
Monitoring, as needed.

Step 7 In the Trace Output Settings, enter values for the maximum number of files, maximum number of lines per
file, and maximum number of minutes per file, and click Update.

The system enables the feature, and the trace files get written to the following locations on the server:

• BAT trace files: /var/log/active/cm/trace/bps/log4j
• TAPS trace files: /var/log/active/cm/trace/taps/log4j

Step 8 Click Update.

What to do next

After you have configured the information that you want to include in the trace files, you can collect and view
trace files using the trace and log central option in the Real-Time Monitoring Tool (RTMT). For more
information, refer to CiscoUnified Communications Manager Serviceability System Guide.

Disable Trace of Configuration Files
You can disable the writing of trace files from the Service Control window in Cisco Unified Communications
Manager Serviceability.
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Procedure

Step 1 In Cisco Unified Communications Manager Serviceability, choose Trace > Trace Configuration.
The Trace Configuration window displays.

Step 2 Choose the Cisco Unified Communications Manager server from the Server drop-down list box.
Step 3 Choose CiscoBulk Provisioning Service from the Configured Services drop-down list box.
Step 4 To deactivate the trace feature, uncheck the Trace On check box.
Step 5 Click Update.

This action disables the feature.

BAT Log Files
BAT generates log files for each bulk transaction. The log file shows the key value of a record, so the
administrator may reexamine the record. The MAC address of the phone serves as the key value when you
are adding, updating, or modifying phones. When users are added, the User ID serves as the key value. To
view the log files for each job that is created in BAT, find the appropriate job and click on the link in the Log
File Name column. A pop-up window displays the log file details of that job.

The log file names designate the operation that was performed and the time that the operation ended.

• Log File Names—File name shows the Job ID, which is a unique identifier that the system creates when
a job is submitted.

• TimeStamp—The timestamp format that is included in the log file name specifies mmddyyyyhhmmss.

• The log file name is of the format jobid#timestamp.txt

Related Topics
Find Jobs Submitted to BPS, on page 601
Topics Related to Troubleshooting BAT and TAPS, on page 615

Troubleshooting BAT
Problem The following list describes some scenarios that could occur and provides possible resolutions.

Bulk Administration Menu Does Not Display in Administration
ProblemBulkAdministrationmenu does not display in CiscoUnified CommunicationsManager Administration.

Possible Cause Bulk Administration menu is accessible only from first node of Cisco Unified
Communications Manager.

Solution Make sure that you are logged into first node of Cisco Unified Communications Manager.
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Cannot Access Complete Bulk Administration Functionality
Problem Cannot access complete Bulk Administration functionality.

Possible Cause After logging into Cisco Unified Communications Manager Administration, all the Bulk
Administration windows are not accessible.

Solution This problem may arise due to restricted access to the application given to the User ID. Contact the
System Administrator to be granted required permissions.

Export to BAT Format Button Does Not Work in BAT.xlt File
Problem Export to BAT Format button does not work in BAT.xlt file.

Possible Cause Clicking the Export to BAT Format button in the BAT.xlt file does not seem to do anything.

Solution Click a blank cell. The button can seem to be disabled if the cursor is on the text in a cell or in the
text box.

BAT Excel Spreadsheet Gives a Compilation Error While Exporting Data to the
CSV Format

Problem BAT Excel spreadsheet gives a compilation error while exporting data to the CSV format.

Possible CauseCheck the version ofMicrosoft Excel that you are using. Customers have reported problems
with BAT.xlt when they were using Excel97.

Solution Use Microsoft Excel 2000 version or higher.

BAT Excel Spreadsheet Does Not Respond to Actions
Problem BAT Excel spreadsheet does not respond to actions.

Possible Cause .BAT Excel spreadsheet does not respond to actions like Add More Lines and so on.

Solution .Ensure that EnableMacros option is selected while opening BAT Excel spreadsheet.To enable macros
in BAT.xlt use the following steps:

1. Open BAT.xlt.
2. Go to Menu > Tools > Macro > Security.
3. Set the Security Level to Medium.
4. Close BAT.xlt and open it again. When prompted, choose Enable Macros.

Data Files (CSV) Format Do Not Match Phone Template/Sample File
Problem Data files (CSV) format do not match Phone Template/Sample File.

Possible Cause The number of lines in the data file should be less than or equal to the number of lines
that are configured in the BAT phone template, but is not. For example, the phone template has three
lines, and, of these, Lines 1, 2, and 3 are configured. You should use a phone data file with up to three
configured lines. 1111, 2222, 4444 results in Line1-1111, Line2-2222, Line3-none, Line4-4444.
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Solution Check the BAT phone template that you intend to use. The number of lines that are specified on the
CSV data file should not exceed the number of lines that are configured in the BAT phone template. Also,
the number of speed dials that the CSV data file specifies should not exceed the maximum possible number
of speed dials for the BAT phone template that you plan to use.

Uploaded CSV File Does Not Display in the File Name Drop-down List Box
Problem Uploaded CSV file does not display in the File Name drop-down list box.

Possible Cause The CSV file that you uploaded to Cisco Unified Communications Manager Server using
File Upload Configuration widow, does not display in the File Name drop-down list box field for various
operations. For example, if you uploaded a CSV file for inserting phones using Uploading/Downloading
menu option in Bulk Administration menu, but the file does not appear as one of the options in the Insert
Phone Configuration window File Name drop-down list box.

Solution Check and make sure that the file is uploaded for the right function. In the preceding example, the
you might have uploaded the file for Phones - Insert All details, where as the CSV file actually belongs to
Phones -Insert Specific details.

Delete the file through Upload/Download Files menu option and upload it for the right function.

Jobs Remain in Pending State Even After the Scheduled Time Expires
Problem Jobs remain in Pending state even after the scheduled time expires.

Possible Cause You schedule jobs with a specific scheduled time for execution. But, the jobs remain in
Pending state, even after the scheduled time.

Solution Check for the following details:

1. Check that Cisco Bulk Provisioning Service (BPS) is started.
2. Check that there is no other job in Processing state. BPS can process only one job at a time.
3. Check if Stop Processing is requested for BPS transactions. If so, go to Job Scheduler window and click

Activate Job.

Jobs Remain in Hold State
Problem Jobs remain in Hold state.

Possible Cause After you submit jobs with all the required data, the jobs show in Hold state on the job
scheduler window. These jobs do not get executed.

Solution You need to activate jobs that are in Hold state, before they can be executed by BPS. Go to Job
Scheduler window and follow the process to activate the job.

Job Does Not Display in the Find and List Jobs Window
Problem Job does not display in the Find and List Jobs window.

Possible Cause After you submit a job with all the required data, choose Bulk Administration > Job
Scheduler. Enter the appropriate search criteria for the job you scheduled and click Find. The job does
not display in the search results. Check if Hide is chosen in the third drop-down list box in the Search
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Options area of the Find and List Jobs window. This option hides all the completed jobs. If the job you
submitted is already complete then it will not be displayed in the Search Results area.

Solution In the Find and List jobs window, choose Show from the third drop-down window and click Find
again. The search results now display completed jobs also.

Port Number Not Configured in the Template
Problem Port number not configured in the template.

Possible Cause The CSV file specified the port number, but no corresponding ports are configured in the
BAT template.

Solution In the BAT template, configure the ports that you have specified in the CSV file.

MAC Address Values Are Not Allowed in the File If Dummy MAC Address
Values Are Desired

Problem MAC address values are not allowed in the file if dummy MAC address values are desired.

Possible Cause The CSV file containsMAC addresses. You cannot provide dummyMAC addresses when
MAC addresses are present in any row in the CSV file.

Solution If you want to use dummy MAC addresses, create a new CSV file that contains only those records
for which you have not specified MAC addresses. Alternatively, you can specify MAC addresses in the CSV
file and not check the Create Dummy MAC Address check box.

The BAT.xlt Spreadsheet Does Not Work with Microsoft Excel XP (Office XP)
Problem The BAT.xlt spreadsheet does not work with Microsoft Excel XP (Office XP)

Possible Cause In Microsoft Excel packaged with Office XP, macro security is set to high by default. Due
to this setting, macros in BAT.xlt cannot run which renders BAT.xlt unusable.

Solution To enable macros in BAT.xlt use the following steps:

1. Open BAT.xlt.
2. Go to Menu >Tools >Macro > Security.
3. Set the Security Level to Medium.
4. Close BAT.xlt and open it again. When prompted, choose Enable Macros.

After the Request to Migrate an SCCP Phone to SIP Through the Migrate Phones
- SCCP TO SIP Window Is Submitted, Model 7940 and 7960 Continue to Show
Up as SCCP Phones

Problem After the request to migrate an SCCP phone to SIP through the Migrate Phones - SCCP TO SIP
window is submitted, Cisco Unified IP Phones model 7940 and 7960 continue to show up as SCCP phones.

Solution To solve this problem, power cycle (power off and on) individual phones after migration.
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For Cisco Unified IP phones (models 7911, 7941, 7961, 7970, and 7971), the migration activity works correctly,
and the phones register as SIP after migration.

Note

Record Does Not Match the File Format Selected
Problem Record does not match the file format selected.

Possible Cause When you create a CSV file using MS Excel with the last column blank, MS Excel fails
to add a comma for the last column after row 15. This error occurs when such a CSV file is used for any
of the BAT operations.

Solution If you want the last column of CSV file to be blank, use the following steps:

1. Enter some dummy value for the last column while creating the CSV file.
2. Save the CSV file and close it.
3. Open the saved CSV file using Text Editor/Notepad.
4. Replace the dummy values with a blank value and save it.

BAT.xlt Is Working in Compatibility Mode with Microsoft Excel 2007
Problem BAT.xlt is working in compatibility mode with Microsoft Excel 2007.

Possible Cause The excel template bat.xlt is a Microsoft Excel 2003 file. When the file is opened in
Microsoft Excel 2007, the file opens in compatibility mode. In compatibility mode, the excel template
acts like a Microsoft Excel 2003 file, and the features of Microsoft Excel 2007 are not available.

Solution Make sure that BAT.xlt is in normal mode. Open Bat.xltl; then choose File > Save As and click Excel
Macro Enabled Workbook. Provide a name, and click Save. Close the bat.xlt and open the file that you saved
(the Saved As file).

Troubleshooting BAT Performance
Keep in mind that it is best to send bulk transactions during low-traffic periods. When you insert BAT files
to the first node database during the time when Unified CommunicationsManager is processing a high volume
of calls, the BAT transactions can be slow. In fact, you can adversely affect how Unified Communications
Manager processes calls.

You can improve BAT performance by restricting the file size of the file to less than 12000 records per file.

You can also improve BAT performance by stopping the TFTP service on the Unified Communications
Manager first node server before you insert the BAT files to the first node database. You must restart the
TFTP service when the insert transaction complete.

Procedure

Step 1 In Cisco Unified Serviceability window, choose Tools > Control Center - Feature Services.
Step 2 Choose Cisco TFTP from the Unified CM Service list by clicking the corresponding radio button.
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Step 3 Click Stop and click OK.

Youmust restart the TFTP service when the insert transaction is complete. Use the same procedure
and click Start to restart the service.

Note

Related Topics
Topics Related to Troubleshooting BAT and TAPS, on page 615

Troubleshooting BAT and TAPS
As a general rule, we recommend that you stop TAPS service when TAPS is not in use. You can prevent
undesired TAPS usage by stopping the service, and you can save some CPU time.

Related Topics
Topics Related to Troubleshooting BAT and TAPS, on page 615

Viewing Tool for Auto-Registered Phones Support Log Files
TAPS generates a row of information for each TAPS log file.

To view TAPS log file, choose Bulk Administration > TAPS > View TAPS Log File.

Tool for Auto-Registered Phones Support Error Messages
You may receive the following messages while running TAPS on the CiscoUCCX server.

Related Topics
Topics Related to Troubleshooting BAT and TAPS, on page 615

When Dialing the TAPS Route Point Number, the Caller Receives a Busy Tone
Problem When dialing the TAPS route point number, the caller receives a busy tone.

Possible Cause The busy tone indicates that the maximum number of simultaneous sessions for TAPS
has been reached. The maximum number of sessions for TAPS equals the number of ports that are
assigned to the TAPS application in UCCX configuration.

Solution You must increase the number of ports that are assigned to TAPS in CiscoUCCX to prevent this
situation.

When the CiscoUCCX Server Starts, the JTAPI Subsystem Shows Partial Service or Out of Service
Problem When the CiscoUCCX server starts, the JTAPI subsystem shows partial service or out of service.

Possible Cause Message occurs because of configuration problems in the Cisco Unified Communications
Manager or the CiscoUCCX server.

Solution Perform one or all of the following steps until the problem has been corrected:

• Verify that Cisco Unified Communications Manager is started.

• Make sure that JTAPI is available on the CiscoUCCX server.
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• Make sure that the JTAPI version on the UCCX server is the same as the JTAPI version that is installed
on Cisco Unified Communications Manager.

• Make sure that the Route Points and CTI ports are properly configured on the Cisco Unified
Communications Manager.

• Verify that the Allow control of device from CTI check box is checked for the JTAPI user; you can verify
that this in the user window in Cisco Unified Communications Manager Administration.

• Verify that the CTI Manager service is started.

• Verify that the ports and the route point are associated to the user in the Cisco Unified Communications
Manager user configuration.

For further troubleshooting, collect and review MIVR log files for CiscoUCCX server.

Topics Related to Troubleshooting BAT and TAPS
• BAT Log Files, on page 609

• Enable Trace to View Configuration Files, on page 607

• Troubleshooting BAT, on page 609

• Troubleshooting BAT Performance, on page 613

• Troubleshooting BAT and TAPS, on page 614
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P A R T XXII
Infrastructure Devices

• Manage Infrastructure Devices, on page 619





C H A P T E R 80
Manage Infrastructure Devices

• Infrastructure Device Setup Using BAT, on page 619
• Create Infrastructure Device CSV Data File using BAT.xlt, on page 619
• CSV Data File Creation for Infrastructure Devices Using Text Editor, on page 620
• Insert Infrastructure Devices, on page 621
• Infrastructure Device Insert Examples, on page 622

Infrastructure Device Setup Using BAT
You can create the CSV file for Infrastructure Device using the BAT spreadsheet BAT.xlt.

The BAT.xlt file exists on the first node of the Cisco Unified Communications Manager server; however, you
normally do not have Microsoft Excel installed on the server. In that case, copy the file from the first node
and move it to a local machine that has Microsoft Excel installed.

Note

Procedure

Step 1 Choose Bulk Administration > Upload/Download Files.
The Find and List Files window opens.

Step 2 Click Find and download the BAT.xlt file.

Create Infrastructure Device CSV Data File using BAT.xlt
Procedure

Step 1 Open a BAT.xlt spreadsheet that allows you to export or create a text-based CSV file.
Step 2 Use a separate line to enter the values for each infrastructure device that you want to add. The CSV file must

have the following comma delineated columns:
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• Device Name
• IPv4 Address
• IPv6 Address
• BSSID
• Description

Step 3 Click Export to BAT Format.
This displays Cisco CallManager Bulk Administration Tool pop-up window.

Step 4 Click OK to create a .txt file, which will be stored in your local workstation.

Example:

C:\XlsDataFiles\Infrastructuredevice-04222015144259.

What to do next

Upload the created file using Bulk administration > Upload/Download Files.

CSV Data File Creation for Infrastructure Devices Using Text
Editor

You can create a CSV text file for Infrastructure Devices using a text editor, such as Microsoft Notepad.

Procedure

Step 1 Open a text editor or any application that allows you to export or create a text-based CSV file.
Step 2 The first line of the CSV file must be "ACCESSPOINT OR SWITCH NAME,IPV4 ADDRESS,IPV6

ADDRESS,BSSID,DESCRIPTION".
Step 3 Use a separate line to enter the values for each infrastructure device that you want to add. The CSV file must

have the following comma delineated columns:

• Device Name
• IPv4 Address
• IPv6 Address
• BSSID
• Description

Step 4 To View sample csv data file, Click Bulk administration > Infrastructure Device > Insert Infrastructure
Device.
The Insert Infrastructure Device Configuration window opens.

Step 5 Click View Sample File.
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Insert Infrastructure Devices
Use this procedure to complete a bulk import of your wireless Access Point infrastructure from a CSV file
into the database. You can use this procedure to import a CSV file that was exported from Cisco Prime
Infrastructure or if you want to import access points from a third-party wireless Access Point controller.

Before you begin

You must have a data file in comma separated value (CSV) format with the following delineated columns:

• AccessPoint or Switch Name

• IPv4 Address

• IPv6 Address

• BSSID—Required for Wireless Access Protocol (WAP) infrastructure devices

• Description—A location identifier, a combination of switch type and location, or another meaningful
identifier

You can define both an IPv4 and IPv6 address, or you can define an IPv4 or an IPv6 address.

For Meraki Access Points, the updates the Basic Service Set Identifiers (BSSID) in the Database after
normalizing it to its base BSSID. For more information about BSSID masking calculation for Meraki Access
Points, see Calculating Cisco Meraki BSSID MAC Addresses.

For Non- Meraki Access Points, the Unified CM updates the BSSID in the database by masking the last byte
with 0.

This masking logic helps Unified CM to uniquely identify the Access Point as opposed to the BSSIDs for the
individual channels on the Access Point.

Note

Procedure

Step 1 Choose Bulk Administration > Infrastructure Device > Insert Infrastructure Device.
The Insert Infrastructure Device Configuration window displays.

Step 2 In the File Name field, choose the CSV data file that you created for this transaction.
Step 3 In the Job Information area, enter the Job description.

The default description is Insert Infrastructure Device.

Step 4 Select when you want to run the job:

• Select the Run Immediately radio button, if you want to run the job immediately.
• Select the Run Later radio button, if you want to schedule the job for later.

Step 5 Click Submit.
If you chose to run the job immediately, the job runs.

Step 6 If you chose to run the job later, schedule when the job runs:
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a) Choose Bulk Administration > Job Scheduler.
b) Click Find and select the job that you just created.
c) In the Job Scheduler window, schedule when you want to run the job.
d) Click Save.

At the scheduled time, the job runs.

Infrastructure Device Insert Examples
Infrastructure Device Insert Examples

The following are examples of a properly formatted Infrastructure device entry:

• SFO12-32-AP2,10.77.29.28,FE80::0202:B3FF:FE1E:8330,EC:E1:A9:DA:85:30,SF->Bldg12->3rdFloor

• SFO12-42-AP1,10.77.29.52,,3C:CE:73:56:2A:10,SF->Bldg12->4rdFloor

• NYC01-3560SW1,10.177.34.50,,,NYC->Blgd1->-IDF1

• CHI-3650,10.190.23.33,,,Chicago->1060AddisonSt

• RCDN-AP2,,,AA:17:D8:07:CF:4D,Bldg0-F1

For Non-Meraki Access Points, the updates the Basic Service Set Identifiers (BSSID) in the Database by
masking the last byte with 0. The BSSID should not be that of an individual wireless network.

The example “RCDN-AP2,,,AA:17:D8:07:CF:4D,Bldg0-F1” is for non-Meraki Access Points. For more
information about BSSIDmasking calculation forMeraki Access Points, see Calculating CiscoMeraki BSSID
MAC Addresses.

Note

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
622

Infrastructure Devices
Infrastructure Device Insert Examples

https://documentation.meraki.com/MR/WiFi_Basics_and_Best_Practices/Calculating_Cisco_Meraki_BSSID_MAC_Addresses
https://documentation.meraki.com/MR/WiFi_Basics_and_Best_Practices/Calculating_Cisco_Meraki_BSSID_MAC_Addresses


P A R T XXIII
Manage Directory URIs and Patterns

• Manage Directory URIs and Patterns, on page 625
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This chapter describes how to import and export directory URIs, +E.164 patterns and PSTN failover rules to
and from Cisco Unified Communications Manager.

• Export Local Directory URIs and +E.164 Patterns, on page 625
• Import Directory URIs and Patterns From a Non-ILS System, on page 626
• Directory URI Format, on page 627

Export Local Directory URIs and +E.164 Patterns
This procedure describes how to export all locally configured directory URIs, +E.164 number patterns, and
their associated PSTN failover rules, to a CSV file that you can import into the other call control system.

Cisco Unified CommunicationsManager writes to the CSV file only those directory URIs and +E.164 number
patterns that were configured in the local cluster. Cisco Unified Communications Manager includes directory
URIs and +E.164 patterns that were imported from an LDAP directory into the local cluster, but does not
include directory URIs or patterns that were learned via ILS or that were imported from a third party URI
catalog.

Note

Procedure

Step 1 In Cisco Unified CMAdministration, chooseBulk Administration >Directory URIs and Patterns >Export
Local Directory URIs and Patterns.

Step 2 Click one of the following radio buttons to define the domain name that you want to attach to the export file:

• Organizational Top Level Domain—Click this radio button to use the value of the Organizational Top
Level Domain enterprise parameter for the export file domain name.

• Route String Domain—Click this radio button to use the value of the Route String field, as configured
in ILS Configuration, for the export file domain name.

• User Defined Domain—Click this radio button to create a customized domain name to attach to the
export file.

Step 3 If you chose a User Defined Domain, enter the domain name in the Domain Name text box.
Step 4 Click the Export Local Directory URIs and Patterns button.
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Step 5 Save the CSV file to a local drive.

Import Directory URIs and Patterns From a Non-ILS System
Follow this procedure if you are running the Intercluster Lookup Service (ILS) on your local cluster and you
want to import a global dial plan catalog, including directory URIs, +E.164 number patterns, or PSTN failover
rules from a CSV file for a call control system that is not running ILS, such as a Cisco TelePresence Video
Communication Server (VCS) or a third-party call control system.

To perform this procedure, the Cisco Bulk Provisioning Service must be running on the local cluster, which
must be configured as a hub cluster in an ILS network. After you import the catalog into Cisco Unified
Communications Manager, ILS replicates the imported catalog to the other clusters in the ILS network.

Make sure that the CSV file that you use for the import is compatible with your version of Cisco Unified
Communications Manager. For example, a CSV file that is compatible to import into Version 9.0(1) is not
compatible with Version 10.0(1). To view a sample CSV file for your release, in Cisco Unified CM
Administration, choose Bulk Administration > Directory URIs and Patterns > Insert Directory URIs
and Patterns and click View Sample File.

Note

Within Cisco Unified CM Administration, you can enter directory URIs with embedded double quotation
marks or commas. However, when you use Bulk Administration to import a CSV file that contains directory
URIs with embedded double quotation marks and commas, you must enclose the entire directory URI in
double quotation marks and escape the embedded double quotation marks with a double quotation mark. For
example, a directory URI of Jared, “Jerry”,Smith@test.com must be input as “Jared”, ““Jerry””,
“Smith@test.com” in the CSV file.

Note

Procedure

Step 1 In Cisco Unified CM Administration, choose Call Routing > Global Dial Plan Replication > Imported
Global Dial Plan Catalogs.

Step 2 In the Name field, enter a name for the catalog.
Step 3 In the Description field, enter a description of the catalog.
Step 4 In the Route String field, create a route string for the system from which you are importing the catalog.
Step 5 Click Save.
Step 6 In Cisco Unified CM Administration, choose Bulk Administration > Upload/Download Files.
Step 7 Click Add New.
Step 8 Click Browse and select the CSV file for the catalog that you want to import.
Step 9 In the Select the Target drop-down list box, choose Imported Directory URIs and Patterns.
Step 10 In the Select Transaction Type drop-down list box, choose Insert Imported Directory URIs and Patterns.
Step 11 Click Save.
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Step 12 In Cisco Unified CMAdministration, chooseBulk Administration >Directory URIs and Patterns > Insert
Imported Directory URIs and Patterns.

Step 13 In the File Name drop-down list box, choose the CSV file that contains the catalog that you want to import.
Step 14 In the Imported Directory URI Catalog drop-down list box, choose the catalog that you named in the

Imported Global Dial Plan Catalog window.
Step 15 In the Job Description text box, enter a name for the job that you are about to run.
Step 16 Select when you want to run the job.

• If you want to run the job now, click the Run Immediately radio button, and click Submit.

• If you want to schedule the job to run at a specified time, check the Run Later radio button and click
Submit. If you choose this option, you must use the Bulk Administration Job Scheduler to schedule
when the job runs.

Cisco Unified CommunicationsManager saves all imported +E.164 patterns to the Global Learned
+E.164 Patterns partition.

Note

Directory URI Format
Directory URIs are alphanumeric strings consisting of a user and a host address separated by the @ symbol.
Cisco Unified Communications Manager supports the following formats for directory URIs:

• user@domain (for example, joe@cisco.com)

• user@ip_address (for example, joe@10.10.10.1)

Cisco Unified Communications Manager supports the following formats in the user portion of a directory
URI (the portion before the @ symbol):

• Accepted characters are a-z, A-Z, 0-9, !, $, %, &, *, _, +, ~, -, =, \, ?, \, ‘, ,, ., /.

• The user portion has a maximum length of 47 characters.

• The user portion accepts percent encoding from %2[0-9A-F] through %7[0-9A-F]. For some accepted
characters, Unified CM automatically applies percent encoding. See below for more information on
percent encoding.

• The user portion is case-sensitive or case-insensitive depending on the value of the URI Lookup Policy
enterprise parameter. The default value is case-sensitive.

Cisco Unified Communications Manager supports the following formats in the host portion of a directory
URI (the portion after the @ symbol):

• Supports IPv4 addresses or fully qualified domain names.

• Accepted characters are a-z, A-Z ,0-9, hyphens, and dots.

• The host portion cannot start or end with a hyphen.

• The host portion cannot have two dots in a row.

• Minimum of two characters.
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• The host portion is not case sensitive.

Due to database restrictions, the Directory URI field has a maximum length of 254 characters.

You can also enter a directory number in the user portion of a directory URI. However, Cisco Unified
Communications Manager may treat the directory URI as a directory number depending on which Dial String
Interpretation option you choose for the SIP Profile.

Note

For compatibility with third party call control systems, Cisco recommends setting the value of the URI Lookup
Policy enterprise parameter to case insensitive.

Note

Percent Encoding of Directory URIs

In the user portion of a directory URI, Unified CM automatically applies percent encoding to the following
characters when the directory URI is saved in the database:

# % ^ ` { } | \ : ” < > [ ] \ ‘ and spaces

When percent encoding is applied, the digit length of the directory URI increases. For example, if you input
joe smith#@cisco.com (20 characters) as a directory URI, Cisco Unified Communications Manager stores
the directory URI in the database as joe%20smith%23@cisco.com (24 characters). Due to database restrictions,
Cisco Unified Communications Manager rejects any attempt to save a directory URI of greater than 254
characters.

Directory URI Format Exception for Bulk Administration

Within Cisco Unified CM Administration, you can enter directory URIs with embedded double quotes or
commas. However, when you use Bulk Administration to import a CSV file that contains directory URIs with
embedded double quotes and commas, you must use enclose the entire directory URI in double quotes and
escape the embedded double quotes with a double quote. For example, the Jared, "Jerry",Smith@test.com
directory URI must be input as "Jared,""Jerry"",Smith@test.com" in the CSV file.
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A P P E N D I X A
Text-Based CSV Files

Unified CommunicationsManager Bulk Administration (BAT) uses data that is entered in a comma-separated
values (CSV) file format to provide information for insert transactions to the Unified CommunicationsManager
database on the first node server. By using the CSV data format, you can build a textual file that contains data
records in a tabular format.

You can create a CSV data file by using a text editor, such as Notepad++. You must use a separate line to
enter data for each record. Separate each data field with a comma and include comma separators for blank
fields. Enter data on every line in the data file because an error occurs during the insert transaction if you enter
a blank line in a CSV file.

When you insert the data records to the Unified Communications Manager database, BAT accesses a set of
designated folders that reside on the server that is running the first node database. For BAT to access the
appropriate CSV data file for the transaction, you must upload the CSV data file to the first node database
server of Unified Communications Manager.

We recommend uploading Text-Based CSV files saved in the UTF-8 format only, as characters other than
ASCII characters can be stored in this format. Using a text editor, such as Notepad++, you can select encoding
as UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down. Text-Based CSV files saved in
formats other than UTF-8 may render garbled when downloaded from Unified Communications Manager.

Note

• Create Text-Based CSV File for Phones, on page 630
• Create Text-Based CSV User File, on page 635
• User File Format, on page 636
• Create Text-Based CSV File for User Device Profile, on page 638
• Create Text-Based CSV File for Cisco Unified CM Assistant Manager-Assistant Associations, on page
641

• Create Text-Based CSV File for Cisco VG200 Gateways, on page 642
• Create Text-Based CSV File for Cisco VG224 Gateways, on page 645
• Create Text-Based CSV File for Cisco VG310 Gateways, on page 646
• Create Text-Based CSV File for VG320 Gateways, on page 647
• Create Text-Based CSV File for VG350 Gateways, on page 649
• Create Text-Based CSV File for VG420 Gateways, on page 650
• Create Text-Based CSV File for VG450 Gateways, on page 650
• Create Text-Based CSV File for ISR 4461 Gateways, on page 652
• Create Text-Based CSV File for Cisco Catalyst 6000 FXS Ports, on page 652
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• Cisco Catalyst 6000 (FXS) Torts File Format, on page 653
• Create Text-Based CSV File for Cisco VG202 and VG204 Gateways, on page 654
• Create Custom Text-Based CSV Files for Client Matter Codes and Forced Authorized Codes, on page
655

• Create Text-Based CSV File for Call Pickup Groups, on page 658
• Create Text-Based CSV File for Remote Destination Profile, on page 660
• Creating Text-Based CSV File for Phone Migration, on page 661
• Create Text-Based CSV File for IME Trusted Element Configuration, on page 662
• Create Text-Based CSV File for IME Trusted Group Configuration, on page 663
• Create Text-Based CSV File for IME Enrolled Group Configuration, on page 664
• Create Text-Based CSV File for IME Exclusion Group Configuration, on page 665
• Create Text-Based CSV File for Fallback Profile Configuration, on page 666
• Create Text-Based CSV File for End User CAPF Profile, on page 667
• Create Text-Based CSV File for Mobility Profile, on page 668
• Create Text based CSV file for Infrastructure Devices, on page 669
• Related Topics, on page 669

Create Text-Based CSV File for Phones
You can create a CSV text file for phones, IP telephony devices, and user combinations using a text editor,
such as Notepad++.

Instead of using the BAT spreadsheet for data input when you are adding phones, you can create the
comma-separated values (CSV) file using lines of ASCII text with values separated by commas. There are
different CSV data file formats for different phone types. You must use the appropriate phone file format for
the CSV text file.

We recommend uploading Text-Based CSV files saved in the UTF-8 format only, as characters other than
ASCII characters can be stored in this format. Using a text editor, such as Notepad++, you can select encoding
as UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down. Text-Based CSV files saved in
formats other than UTF-8 may render garbled when downloaded from .

Note

Procedure

Step 1 Open a text editor or any application that allows you to export or create a text-based CSV file.
Step 2 Use a separate line to enter the values for each phone, IP telephony device, or user combination that you want

to add to . You must create separate CSV files for each type of device. Keep in mind the following rules when
you create the CSV data file.

• Always include comma separators, even if a field is blank.

• Specify the user ID if the phone is to be associated to a user.

• Directory Number fields are optional only when you are creating the CSV file for use with a BAT template
that has no lines. If lines are configured on the BAT phone template, you must supply directory numbers
in the CSV file for each device.
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• An error occurs when you insert a CSV file with blank lines.

• While saving your CSV file, choose to save it as UTF-8 encoded. In Notepad++, you can select encoding
as UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down.

What to do next

Upload the CSV file to the first node of .

Related Topics
Phone CSV Data File Formats, on page 631
Export the Fields for All Phone Details Option, on page 633
Phone CSV File Examples, on page 634

Phone CSV Data File Formats
Different types of phones require specific data formats. Keep in mind that fields that are labeled as optional
in the phone file format become mandatory fields when certain conditions are met.

Related Topics
Phones with Users Combinations File Format, on page 631
CTI Ports/H.323 Clients File Format, on page 632
CTI Ports-Users and H.323 Client-Users Combinations File Format, on page 632

Phones with Users Combinations File Format
The following sample shows the field length and whether the field is optional or mandatory for a text-based
CSV file for phones and the fixed user format.
First Name (Optional, up to 64 characters), Last Name (Mandatory, 1 to 64 characters), User
ID (Mandatory, 1 to 128 characters), Password (Optional, up to 128 characters), Manager
User ID (Optional, up to 128 characters, must use the ID that exists in global directory),
Department (Optional, up to 64 characters), PIN (Optional, up to 20 numerals), Default
Profile (Optional, up to 50 characters), User Locale (Optional, up to 50 characters),
Telephone Number (Optional, up to 20 numerals), Primary Extension (Optional, up to 50
numerals), Associated PC (Optional, up to 50 characters), ICD Extension (Optional, up to
50 numerals), Mail ID (Optional, up to 255 characters), Presence Group (Optional, up to 50
characters), Subscribe Calling Search Space (Optional, up to 50 characters), MAC Address
(Mandatory, up to 12 characters), Description (Optional, up to 50 characters), Location
(Optional, up to 50 characters), Directory Number (Optional, up to 24 numerals and special
characters), Display (Optional, up to 30 characters), Line Text Label (Optional, up to 30
characters), Forward Busy External (Optional, up to 50 numerals and special characters),
Forward No Answer External (Optional, up to 50 numerals and special characters), Forward
No Coverage External (Optional, up to 50 numerals and special characters), Forward Busy
Internal (Optional, up to 50 numerals and special characters), Forward No Answer Internal
(Optional, up to 50 numerals and special characters), Forward No Coverage Internal (Optional,
up to 50 numerals and special characters), Call Pickup Group (Optional, up to 50 characters),
Speed Dial (Optional, up to 50 numerals and special characters), Speed Dial Label (Optional,
up to 30 characters)

Sample

John,Smith,johns,abcde,Daviss,12,12345,johnProfile,English United
States,1,1231123245AB,Dallas,
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9725557154,9725557154,Mike,9725557172,9725557196,9725557112,
9725557127,9725557158,9725557189,9725557121/TollByPass,1230000000,Helpdesk

CTI Ports/H.323 Clients File Format
The following sample shows the field length and whether the field is optional or mandatory for a text-based
CSV file for CTI ports and H.323 clients format.
Device Name (Mandatory, up to 15 characters for CTI ports and up to 50 characters for H.323
Clients), Description (Optional, up to 50 characters) Location (Optional, up to 50
characters),UserID(Optional, 1 to 30 characters),Directory Number(Optional, up to 24 numerals
and special characters),Display (Optional, up to 30 characters), Line Text Label (Optional,
up to 30 characters), Forward Busy External(Optional, up to 50 numerals and special
characters),Forward No Answer External (Optional, up to 50 numerals and special characters),
Forward No Coverage External (Optional, up to 50 numerals and special characters), Forward
Busy Internal (Optional, up to 50 numerals and special characters), Forward No Answer
Internal (Optional, up to 50 numerals and special characters), Forward No Coverage Internal
(Optional, up to 50 numerals and special characters), Call Pickup Group (Optional, up to
50/50 characters)

Sample

TAPS Port 1,CTI TAPS Port 1,Dallas,johns,9728437154,9728437154,
Mike,9728437172,9728437196,9728437127,9728437154,9728437178,
9728437189,9728437121/TollByPass,1230000000,Helpdesk

CTI Ports-Users and H.323 Client-Users Combinations File Format
The following sample shows the field length and whether the field is optional or mandatory for a text-based
CSV file for CTI ports with users and H.323 clients with users format.
First Name (Optional, up to 64 characters), Last Name (Mandatory, 1 to 64 characters), User
ID (Mandatory, 1-128 characters), Password (Optional, up to 128 characters), Manager User
ID (Optional, up to 128 characters, must use existing ID in global directory), Department
(Optional, up to 64 characters), PIN (Optional, up to 128 numerals), Default Profile
(Optional, up to 50 characters), User Locale (Optional, up to 50 characters), Telephone
Number (Optional, up to 64 numerals), Primary Extension (Optional, up to 50 numerals),
Associated PC (Optional, up to 50 characters), ICD Extension (Optional, up to 50 numerals),
Mail ID (Optional, up to 255 characters), Presence Group (Optional, up to 50 characters),
Subscribe Calling Search Space (Optional, up to 50 characters),Device Name (Mandatory, up
to 15 characters for CTI ports-users combination and up to 50 characters for
H.323client-users combinations),Description (Optional, up to 50 characters), Location
(Optional, up to 50 characters), Directory Number (Optional, up to 24 numerals and special
characters), Display (Optional, up to 30 characters), Line Text Label (Optional, up to 30
characters), Forward Busy External (Optional, up to 50 numerals and special characters),
Forward No Answer External (Optional, up to 50 numerals and special characters), Forward
No Coverage External (Optional, up to 50 numerals and special characters), Forward Busy
Internal (Optional, up to 50 numerals and special characters), Forward No Answer Internal
(Optional, up to 50 numerals and special characters), Forward No Coverage Internal (Optional,
up to 50 numerals and special characters), Call Pickup Group (Optional, up to 50 characters)

Sample

John,Smith,johns,abcde,Daviss,12,12345,johnProfile,English United States,1,TAPS Port 1,CTI
TAPS Port 1,9725557154,9725557154,Mike,9725557172,9725557196,9725557112,9725557127,9725557158,
9725557189,9725557121/TollByPass,1230000000,Helpdesk
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If you use a comma or double quotes as part of the value in one of the fields, you must enclose the entire text
value with double quotation marks to designate it as a single value.

For example, if you entered John, Bill as a text value, then you must enter the value as “John,Bill”.

If you entered a double quote in a value, then you must replace the double quote with two consecutive double
quotes and enclose the value with double quotes. For example you must enter John “Chief as “John”“Chief”.

Note

Related Topics
Create Text-Based CSV File for IME Trusted Group Configuration, on page 663

Export the Fields for All Phone Details Option
When you are using the export utility to generate a file that containing all the details for the phone records,
the export file has the following format.

Cisco does not recommend editing the file that is generated with the export utility. The system dynamically
generates fields, such as Logout time and Login time, that must not be edited at all. You must ensure that the
login user ID and Product Specific XML fields are accurate for them to work properly, and you must not edit
them. Use BAT to update the product specific configurations.

Caution

Device Name,Description,Device Pool,Phone Template,CSS,AAR CSS,Location,Extension
Mobility,Network Locale,Media Resource Group List,User Hold Audio Source,Network Hold Audio
Source,Device User Locale,Signal Packet Capture Mode,Packet Capture Duration,Built in
Bridge,Privacy,Retry Video Call as Audio,Ignore Presentation Indicators,Softkey
Template,Module 1,Module 2,Phone Load Name,Module 1 Load Name,Module 2 Load
Name,Information,Directory,Messages,Services,Authentication Server,Proxy Server,Idle,Idle
Timer,MLPP Indication,MLPP Preemption,MLPP Domain,Device Type,User ID,Common Profile,Owner
User ID,Allow CTI Control Flag,Device Presence Group,Security Profile,Device Subscribe
CSS,Unattended Port,Require DTMF Reception,RFC2833 Disabled,Certificate
Operation,Authentication String,Certification Operation Completion Time,Device Protocol,Secure
Shell User,Secure Shell Password,XML,Dial Rules,CSS Reroute,CSS Refer,DTMF Signalling,Default
DTMF Capability,SIP Profile,SIPCodec_MTPPreferredOrigCodec,Logout Profile,MTP Required,Digest
User,Always Use Prime Line,Always Use Prime Line for Voice Messages,Geo Location

Directory Number,Partition,Voice Mail Profile,Line CSS,AAR Group,Line User Hold Audio
Source,Line Network Hold Audio Source,Auto Answer,Forward All Voice Mail,Forward All
Destination,Forward All CSS,Forward Busy Internal Voice Mail,Forward Busy Internal
Destination,Forward Busy Internal CSS,Forward Busy External Voice Mail,Forward Busy External
Destination,Forward Busy External CSS,Forward No Answer Internal Voice Mail,Forward No
Answer Internal Destination,Forward No Answer Internal CSS,Forward No Answer External Voice
Mail,Forward No Answer External Destination,Forward No Answer External CSS,Forward No
Coverage Internal Voice Mail,Forward No Coverage Internal Destination,Forward No Coverage
Internal CSS,Forward No Coverage External Voice Mail,Forward No Coverage External
Destination,Forward No Coverage External CSS,Forward No Answer Ring Duration,Call Pickup
Group,MLPP Target,MLPP CSS,MLPP No Answer Ring Duration,Line Text Label,External Phone
Number Mask,Maximum Number of Calls,Busy Trigger,Message Waiting Lamp Policy,Ring setting
(Phone Idle),Ring Setting (Phone Active),Caller Name,Caller Number,Redirected Number,Dialed
Number,Line Description,Alerting Name,Alerting Name ASCII,Line Presence Group,Secondary
CSS for Forward All,Forward on CTI Failure Voice Mail,Forward on CTI Failure
Destination,Forward on CTI Failure CSS,Display,ASCII DisplayParty Entrance Tone,Log Missed
Calls,Park Monitor Forward No Retrieve Ext Voice Mail,Park Monitor Forward No Retrieve Int
Voice Mail,Park Monitor Forward No Retrieve Ext CSS,Park Monitor Forward No Retrieve Int
CSS,Park Monitor Forward No Retrieve Ext Destination,Park Monitor Forward No Retrieve Int
Destination,Park Monitor Reversion Timer
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Speed Dial Number,Speed Dial Label,Speed Dial Label ASCII,Service Name,Subscribed Service
Name,Subscribed Service Name ASCII,Parameter Name,Parameter Value,Busy Lamp Field
Destination,Busy Lamp Field Directory Number,Busy Lamp Field Label,Busy Lamp Field Label
ASCII

Related Topics
Create Text-Based CSV File for IME Trusted Group Configuration, on page 663

Phone CSV File Examples
The following list provides examples of commonly used phone CSV data files:

Using a Template Attribute-Forward Busy Destination

If Forward Busy Destination is 3001 on a phone template, all records in a CSV file that have no value for
Forward Busy Destination use 3001.
1231123245AB,SEP1231123245AB,Dallas,johns,9728437154,9728437154,Mike,,9728437196,9728437127,
9728437154,9728437178,9728437189,9728437121/TollByPass,1230000000,Helpdesk

No Phone Description Entry

If the description for a phone is blank, use this format:
1231123245AB,,Dallas,johns,9728437154,9728437154,Mike,9728437172,9728437196,
9728437127,9728437154,9728437178,9728437189,9728437121/TollByPass,1230000000,Helpdesk

No Active Line or Location Entry

If no active line is required and the location is also blank, use this format:
1231123245AB,SEP1231123245AB,,,1230000000,HelpDesk

Two Active Lines

If two active lines are required, use this format:
1231123245AB,SEP1231123245AB,Dallas,johns,9725557154,9725557154,Mike,9725557172,9725557196,
9728437127,9728437154,9728437178,9728437189,9725557121/TollByPass,9725557155,9725557155,
Kelvin,9725557133,9725557196,9728437112,9728437145,9728437187,9728437198,9725557112/
TollByPass,1230000000,Helpdesk

For the MAC Address, enter MAC address values or check the option for creating dummy MAC addresses.Note

Mandatory Phone Entries

If one line is required and you want to include only the required values and none of the optional values, use
this format:
1231123245AB,,,,9725557154,,,,,

Using Dummy MAC Address Option

If the option is checked for a dummy MAC address and you want one line, use this format:
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,Dallas,9725557154,9725557154,Mike,9725557172,9725557196,9728437127,9728437154,9728437178,
9728437189,9725557121/TollByPass,johns,1230000000,Helpdesk

Related Topics
Create Text-Based CSV File for IME Trusted Group Configuration, on page 663

Create Text-Based CSV User File
You can create a CSV text file for users using a text editor, such as such as Notepad++.

Instead of using the BAT spreadsheet for data input when you are adding users, you can create the
comma-separated values (CSV) file by using lines of ASCII text with values separated by commas. You must
use the user file format for the user CSV text file.

Cisco recommends uploading Text-Based CSV files saved in the UTF-8 format only, as characters other than
ASCII characters can be stored in this format. Using a text editor, such as Notepad++, you can select encoding
as UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down. Text-Based CSV files saved in
formats other thanUTF-8may render garbledwhen downloaded fromCiscoUnified CommunicationsManager.

Note

Procedure

Step 1 Open a text editor or any application that allows you to export or create a text-based CSV file.
Step 2 Using a separate line for each user, enter the values for each user that you want to add to Cisco Unified

Communications Manager.

You can associate any number of existing devices to a new user by entering the device name of all the devices
separated by a comma at the end of the record.

You can associate a directory number to a user, even if that user does not control any device.

An error occurs if any blank lines exist in the CSV file.Note

Step 3 While saving your CSV file, choose to save it as UTF-8 encoded. In Notepad++, you can select encoding as
UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down.

What to do next

Upload the file to first node of the Cisco Unified Communications Manager.

Related Topics
Create Text-Based CSV File for IME Trusted Group Configuration, on page 663
Upload File to Server, on page 21
User File Format, on page 636

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
635

Text-Based CSV Files
Create Text-Based CSV User File



User File Format

You must specify PIN and Password values, either on the CSV file or when using BAT for file insertion. If
you want to apply individual PINs or passwords for each user or group of users, specify the PIN and password
information in the CSV file. If you want to use a default PIN and password that all users can use, do not
specify PIN or password values in the CSV file and instead provide this information when you use BAT to
insert the CSV file in Cisco Unified Communications Manager.

Tip

The following sample format and examples show the fields, field length, and whether the field is optional or
mandatory for a text-based CSV file for users.
First Name (Optional, up to 64 characters), Last Name (Mandatory, 1 to 64 characters), User
ID(Mandatory, up to 128 characters), Manager User ID (Optional, up to 128 characters, must
use existing ID in global directory), Department (Optional, up to 64 characters), PIN
(Optional, up to 128 numerals), Default Profile (Optional, up to 50 characters), User Locale
(Optional, up to 50 characters), Telephone Number (Optional, up to 64 numerals), Primary
Extension (Optional, up to 50 numerals), Associated PC (Optional, up to 50 characters), ICD
Extension (Optional, up to 50 numerals), Mail ID (Optional, up to 255 characters), Presence
Group (Optional, up to 50 characters), Subscribe Calling Search Space (Optional, up to 50
characters).

Sample

John,Smith,johns,abc123de,karend,0012055,9989,johns profile,English
United States,SEP1231123245AB,9725557154,SEP0010EB001234

You must specify delimiters even if a field is blank. Refer to the following examples and sample CSV records
when you are creating CSV files.

Example 1

If the manager for a user is blank, use this format:
John,Smith,johns,abc123de,,0012055,9989,johns profile,English United
States,SEP1231123245AB,9725557154,SEP0010EB001234

Example 2

When you want to complete only the mandatory fields, use this format:
Smith,johns,,,,,,,,

Example 3

When you want to complete only the mandatory fields and associate the user to a phone, use this format:
Smith,johns,,,,,,,SEP1231123245AB,

Example 4

A user can control more than one device. You can add device names for additional devices at the end of the
record.

• If the user controls only one device, use this format:
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John,Smith,johns,abc123de,karend,0012055,9989,johns profile,English
United States,SEP1231123245AB,9725557154

• If the user controls three devices, use this format:
John,Smith,johns,abc123de,karend,0012055,9989,johns profile,English
UnitedStates,SEP1231123245AB,9725557154,SEP0010EB001234,SEP0010EB432101

Update Users File Format
Use a text editor to create the CSV text file for updating users. Upload the file to first node server.

When you are updating a record, you need to supply all mandatory fields for a file. If you have stored values
in the optional fields, and you update a record with blank optional fields, you will reset the values to blank.
It is possible for you to retain previously stored values during update.

The following sample format shows the field length and string types followed by examples of CSV files for
updating users.
User ID (Mandatory, 1 to 128 characters), Password (Optional, up to 128 characters), Manager
(Optional, up to 128 characters, must use existing ID in global directory), Department
(Optional, up to 64 characters), PIN (Optional, up to 128 numerals), Default Profile
(Optional, up to 50 characters), User Locale (Optional, up to 50 characters), Telephone
Number (Optional, up to 64 numerals), Primary Extension (Optional, up to 50 numerals),
Associated PC (Optional, up to 50 characters), ICD Extension (Optional, up to 50 numerals),
Mail ID (Optional, up to 255 characters).

Sample

johns,Daviss,123,johnProfile,English United States,SEP8612113425AC,9725557154

You must specify delimiters even if a field is blank. Refer to the following examples and sample CSV records
when you are creating CSV files.

Note

Example 1

If the manager for a user is blank. use this format:
johns,,123,johnProfile,English United States,SEP8612113425AC,9725557154

Example 3

Mandatory fields include the following fields:
John,Daviss,123,johnProfile,,,

Related Topics
Create Text-Based CSV File for IME Trusted Group Configuration, on page 663
Retain Existing User Information During Update, on page 210
Upload File to Server, on page 21
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Create Text-Based CSV File for User Device Profile
You can create a CSV text file for user device profiles using a text editor, such as Notepad++.

Instead of using the BAT spreadsheet for data input when you are adding user device profiles, you can create
the comma-separated values (CSV) file by using lines of ASCII text with values separated by commas. You
must use the user device profile file format for the CSV text file.

If you use comma or double quotes as part of string in one of the fields, you must enclose the entire text string
with double quotes.

Note

Cisco recommends uploading Text-Based CSV files saved in the UTF-8 format only, as characters other than
ASCII characters can be stored in this format. Using a text editor, such as Notepad++, you can select encoding
as UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down. Text-Based CSV files saved in
formats other thanUTF-8may render garbledwhen downloaded fromCiscoUnified CommunicationsManager.

Note

Procedure

Step 1 Open a text editor or any application that allows you to export or create a text-based CSV file.
Step 2 Using a separate line for each user device profile, enter the values for each user device profile that you want

to add to Cisco Unified Communications Manager.

An error occurs if any blank lines exist in the CSV file.Note

Step 3 While saving your CSV file, choose to save it as UTF-8 encoded. In Notepad++, you can select encoding as
UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down.

What to do next

Upload the CSV file to the first node server for Cisco Unified Communications Manager.

Related Topics
Create Text-Based CSV File for IME Trusted Group Configuration, on page 663
Upload File to Server, on page 21
User Device Profile File Format, on page 638

User Device Profile File Format
The following sample format shows the field length and string types followed by examples of a CSV files for
user device profiles.
Device Profile Name(Mandatory, 1 to 50 characters),Description(Optional, 1 to 50
characters),Login UserID (Optional, 4 to 30 characters),Directory Number(Optional, up to
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24 numerals and special characters),Display(Optional, for internal Caller ID, up to 30
characters),Line Text Label(Optional, up to 30 characters),Forward Busy External
Destination(Optional, up to 50 numerals),Forward No Answer External Destination(Optional,
up to 50 numerals),Forward No Coverage External(Optional, up to 50 numerals),Forward Busy
Internal Destination(Optional, up to 50 numerals),Forward No Answer Internal
Destination(Optional, up to 50 numerals),Forward No Coverage Internal(Optional, up to 50
numerals),Call Pickup Group(Optional, up to 50/50 characters),Speed Dial Number(Optional,
up to 50 numerals),Speed Dial Label(optional, up to 30 characters)

Sample

John Profile,John's Profile,Johns,9725557154,9725557154,Mike,9725557172,9725557196,
9725557126,9725557154,9725557178,9725557189,9725557121/TollByPass,1230000000,Helpdesk

Example 1

You must specify delimiters even if a field is blank. The following example shows the correct format for not
specifying a Display setting:
John Profile,John's
Profile,Johns,9725557154,,Mike,9725557172,9725557196,9725557126,9725557154,9725557178,
9725557189,9725557121/TollByPass,1230000000,Helpdesk

Example 2

If it is a 0-line profile and only mandatory fields are added, use the following example:
John Profile,,,,

Example 3

If only the mandatory fields are completed and you want to associate the user device profile to only one
directory number, use this format:
John Profile,,,9725557154,,,,,

User Device Profile with Two Lines and Two Speed Dials
The following example format shows the field length and string types of a CSV file for user device profiles
with two lines.
User Device Profile Name(Mandatory, 1 to 50 characters),Description(Optional, 1 to 50
characters),Login UserID (Optional, 4 to 30 characters),Directory Number1(Optional, up to
24 numerals and special characters),Display1(Optional, for internal Caller ID, up to 30
characters),Line Text Label1(Optional, up to 30 characters),Forward Busy External
Destination1(Optional, up to 50 numerals),Forward No Answer External Destination1(Optional,
up to 50 numerals),Forward No Coverage External Destination1(Optional, up to 50
numerals),Forward Busy Intermal Destination1(Optional, up to 50 numerals),Forward No Answer
Internal Destination1(Optional, up to 50 numerals),Forward No Coverage Internal
Destination1(Optional, up to 50 numerals),Call Pickup Group1(Optional, up to 50/50
characters),Directory Number2(Optional, up to 24 numerals and special
characters),Display2(Optional, for internal Caller ID, up to 30 characters),Line Text
Label2(Optional, up to 30 characters),Forward Busy External Destination2(Optional, up to
50 numerals),Forward No Answer External Destination2(Optional, up to 50 numerals),Forward
No Coverage External Destination2(Optional, up to 50 numerals),Forward Busy Intermal
Destination2(Optional, up to 50 numerals),Forward No Answer Internal Destination2(Optional,
up to 50 numerals),Forward No Coverage Internal Destination2(Optional, up to 50
numerals),Call Pickup Group2(Optional, up to 50/50 characters),Speed Dial Number1(Optional,
up to 50 numerals),Speed Dial Label1(optional, up to 30 characters),Speed Dial
Number2(Optional, up to 50 numerals),Speed Dial Label2(optional, up to 30 characters)
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Example

John Profile,John's
Profile,John’s,9725557154,9725557154,Mike,9725557172,9725557196,9725557126,9725557154,
9725557178,9725557189,9725557121/TollByPass,9725557155,9725557155,Kelvin,9725557133,9725557196,
9725557113,9725557145,9725557187,9725557198,9725557112/TollByPass,1230000000,Helpdesk,
2149523460,Keith

Export File Fields for User Device Profile with All Details Option
When you are using the export utility to generate a file that contains all the details for the user device profiles,
the export file will have the following format. The example shows the length and type of fields in the export
all details file.

The export utility does not generate model-specific fields for user device profiles.

Cisco does not recommend editing the file that is generated with the export utility. The system dynamically
generates some fields, such as Logout time and Login time, that must not be edited at all. You must ensure
that the login user ID and Product Specific XML fields are accurate for them to work properly, and you must
not edit them. Use BAT to update the product-specific configurations.

Caution

Device Profile Name,Description,Device Pool,Phone Template,CSS,AAR CSS,Location,Extension
Mobility,Network Locale,Media Resource Group List,User Hold Audio Source,Network Hold Audio
Source,Device User Locale,Signal Packet Capture Mode,Packet Capture Duration,Built in
Bridge,Privacy,Retry Video Call as Audio,Ignore Presentation Indicators,Softkey
Template,Module 1,Module 2,Phone Load Name,Module 1 Load Name,Module 2 Load
Name,Information,Directory,Messages,Services,Authentication Server,Proxy Server,Idle,Idle
Timer,MLPP Indication,MLPP Preemption,MLPP Domain,Device Type,User ID,Common Profile,Owner
User ID,Allow CTI Control Flag,Device Presence Group,Security Profile,Device Subscribe
CSS,Unattended Port,Require DTMF Reception,RFC2833 Disabled,Certificate
Operation,Authentication String,Certification Operation Completion Time,Device Protocol,Secure
Shell User,Secure Shell Password,XML,Dial Rules,CSS Reroute,CSS Refer,DTMF Signalling,Default
DTMF Capability,SIP Profile,SIPCodec_MTPPreferredOrigCodec,Logout Profile,MTP Required,Digest
User,Always Use Prime Line,Always Use Prime Line for Voice Message

Directory Number,Partition,Voice Mail Profile,Line CSS,AAR Group,Line User Hold Audio
Source,Line Network Hold Audio Source,Auto Answer,Forward All Voice Mail,Forward All
Destination,Forward All CSS,Forward Busy Internal Voice Mail,Forward Busy Internal
Destination,Forward Busy Internal CSS,Forward Busy External Voice Mail,Forward Busy External
Destination,Forward Busy External CSS,Forward No Answer Internal Voice Mail,Forward No
Answer Internal Destination,Forward No Answer Internal CSS,Forward No Answer External Voice
Mail,Forward No Answer External Destination,Forward No Answer External CSS,Forward No
Coverage Internal Voice Mail,Forward No Coverage Internal Destination,Forward No Coverage
Internal CSS,Forward No Coverage External Voice Mail,Forward No Coverage External
Destination,Forward No Coverage External CSS,Forward No Answer Ring Duration,Call Pickup
Group,MLPP Target,MLPP CSS,MLPP No Answer Ring Duration,Line Text Label,External Phone
Number Mask,Maximum Number of Calls,Busy Trigger,Message Waiting Lamp Policy,Ring setting
(Phone Idle),Ring Setting (Phone Active),Caller Name,Caller Number,Redirected Number,Dialed
Number,Line Description,Alerting Name,Alerting Name ASCII,Line Presence Group,Secondary
CSS for Forward All,Forward on CTI Failure Voice Mail,Forward on CTI Failure
Destination,Forward on CTI Failure CSS,Display,ASCII Display,Party Entrance Tone,Log Missed
Calls,Park Monitor Forward No Retrieve Ext Voice Mail,Park Monitor Forward No Retrieve Int
Voice Mail,Park Monitor Forward No Retrieve Ext CSS,Park Monitor Forward No Retrieve Int
CSS,Park Monitor Forward No Retrieve Ext Destination,Park Monitor Forward No Retrieve Int
Destination,Park Monitor Reversion Timer

Speed Dial Number,Speed Dial Label,Speed Dial Label ASCII,Service Name,Subscribed Service
Name,Subscribed Service Name ASCII,Parameter Name,Parameter Value,Busy Lamp Field
Destination,Busy Lamp Field Directory Number,Busy Lamp Field Label,Busy Lamp Field Label
ASCII
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Use True and False for settings with Boolean values.Note

Related Topics
Create Text-Based CSV File for IME Trusted Group Configuration, on page 663

Create Text-Based CSV File for Cisco Unified CM Assistant
Manager-Assistant Associations

You can create a CSV text file for UnifiedCM Assistant manager and assistants using a text editor, such as
Notepad++.

Instead of using the BAT spreadsheet for data input when you are adding UnifiedCMAssistant managers and
assistants, you can create the comma-separated values (CSV) file by using lines of ASCII text with values
separated by commas. You must use the manager and assistants file format for the CSV text file.

Cisco recommends uploading Text-Based CSV files saved in the UTF-8 format only, as characters other than
ASCII characters can be stored in this format. Using a text editor, such as Notepad++, you can select encoding
as UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down. Text-Based CSV files saved in
formats other thanUTF-8may render garbledwhen downloaded fromCiscoUnified CommunicationsManager.

Note

Procedure

Step 1 Open a text editor or any application that allows you to export or create a text-based CSV file.
Step 2 Using a separate line for each manager-assistants association, enter the values for each manager-assistant that

you want to add to Cisco Unified Communications Manager.

An error occurs if any blank lines exist in the CSV file.Note

You can assignmultiple assistants to a manager by entering the user IDs of the manager and assistants separated
by a comma at the end of the record.

Step 3 While saving your CSV file, choose to save it as UTF-8 encoded. In Notepad++, you can select encoding as
UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down.

What to do next

Upload the CSV file to the first node server for Cisco Unified Communications Manager.

Related Topics
Create Text-Based CSV File for IME Trusted Group Configuration, on page 663
Managers and Assistants File Formats, on page 642
Upload File to Server, on page 21
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Managers and Assistants File Formats
The following sample formats and examples show the field length and string types for UnifiedCommunications
Manager Assistant manager and assistant associations. Use the user ID of the manager for the Manager ID
and the user ID of the assistant for the Assistant ID. You can also associate many managers to one assistant
by putting the Assistant ID first, followed by a list of Manager IDs. When you insert the CSV file, you select
the type of association.

Default Manager-Assistant Association
Use the following default format for manager-assistant association.
ManagerID (Mandatory, 1 to 30 characters),AssistantID 1 (Mandatory, 1 to 30
characters),AssistantID 2 (Optional, 1 to 30 characters)...AssistantID # (Optional, 1 to
30 characters)

Sample

Johns,Mikeh,Larryh

Default Assistant-Manager Association
Use the following default format for assistant-manager association.
AssistantID (Mandatory, 1 to 30 characters),ManagerID 1(Mandatory, 1 to 30
characters),ManagerID 2 (Optional, 1 to 30 characters)...ManagerID # (Optional, 1 to 30
characters)

Sample

Larryh,Johns,Mikeb,Karend

Custom Manager-Assistant Association
For proxy line configurations, you can build a CSV data file that specifies the proxy lines on assistant phones
by using this format.
ManagerID (Mandatory, 1 to 30 characters),Device Name (Optional, 15 characters),Intercom
DN (Optional, 1 to 24 characters),Assistant User ID (Mandatory, 1 to 30 characters),Device
Name (Optional, 15 characters),Intercom DN (Optional, 1 to 24 characters),Proxy Line DN
(Mandatory, 1to 24 characters),Manager Line DN (Mandatory, 1 to 24 characters)

Example

Johns,SEP1231123245AB,90001,Mikeh,SEP2342342342AB,20001,20002,90002

Related Topics
Create Text-Based CSV File for IME Trusted Group Configuration, on page 663

Create Text-Based CSV File for Cisco VG200 Gateways
You can create a CSV text file for VG200 gateways using a text editor, such as Notepad++.
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Instead of using the BAT spreadsheet for data input when you are adding CiscoVG200 gateways, you can
create the comma-separated values (CSV) file by using lines of ASCII text with values separated by commas.
You must use the appropriate file format for the type of trunk and port for the gateway.

Cisco recommends uploading Text-Based CSV files saved in the UTF-8 format only, as characters other than
ASCII characters can be stored in this format. Using a text editor, such as Notepad++, you can select encoding
as UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down. Text-Based CSV files saved in
formats other thanUTF-8may render garbledwhen downloaded fromCiscoUnified CommunicationsManager.

Note

Procedure

Step 1 Open a text editor or any application that allows you to export or create a text-based CSV file.
Step 2 Using a separate line for each gateway, enter the values for each gateway and port that you want to add to

Cisco Unified Communications Manager.

An error occurs if any blank lines exist in the CSV file.Note

Step 3 While saving your CSV file, choose to save it as UTF-8 encoded. In Notepad++, you can select encoding as
UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down.

What to do next

Upload the CSV file to the first node server for Cisco Unified Communications Manager.

Related Topics
Create Text-Based CSV File for IME Trusted Group Configuration, on page 663
FXO or FXS Trunks CSV File Format, on page 643
T1 CAS T1 PRI or E1 PRI Trunks File Format, on page 644
Upload File to Server, on page 21

FXO or FXS Trunks CSV File Format
The following sample format shows the required field length and string types followed by sample of CSV
files for a Cisco VG200 gateway.
MGCP Domain Name(Mandatory, 1 to 64 characters),Description(Optional, up to 100 characters),
Slot (Mandatory, up to 3 numerals), Subunit (Mandatory, up to 3 numerals), Port
Number(Mandatory, up to 3 numerals), Port Description Optional, up to 50 characters),Port
Directory Number(Optional, up to 24 numerals and special characters)

Sample

MGCPTest,VG200 Lab Gateway,0,1,0,Port 0,97255576601MGCPTest,VG200 Lab Gateway,0,1,1,Port
1,97255572001
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You must include comma separators even if a field is blank. Specify the directory number and route partition
only if the port type in the Cisco VG200 gateway template is POTS.

Note

Example 1

If the Description for a Cisco VG200 gateway is blank, use this format:
MGCPTest, ,0,1,0,Port 0,97255576601

Related Topics
Related Topics, on page 669

T1 CAS T1 PRI or E1 PRI Trunks File Format
The following sample format shows the required field length and string types followed by examples of CSV
files for the Cisco VG200 gateway.

T1 CAS Trunks

MGCP Domain Name(Mandatory, 1 to 64 characters),Description(Optional, up to 100
characters),Slot(Mandatory, up to 3 numerals),Subunit(Mandatory, up to 3 numerals),Port
Number(Mandatory, up to 3 numerals),Port Description (Optional, up to 50 characters),CAS
Port Number(Optional, up to 3 numerals)

Sample 1

MGCPTest,VG200 Lab Gateway,001,001,001,,,

T1 PRI or E1 PRI

MGCP Domain Name(Mandatory, 1 to 64 characters),Description(Optional, up to 100
characters),Slot(Mandatory, up to 3 numerals), Subunit(Mandatory, up to 3 numerals), Port
Number(Mandatory, up to 3 numerals), Port Description (Optional, up to 50 characters)

Sample 2

MGCPTest,VG200 Lab Gateway,001,001,001,,

You must include comma separators even if a field is blank.Note

Example for Both Trunk Options

If you provide only the mandatory value, use this format:
MGCPTest,,001,001,001,,

T1 CAS Examples

If the Description for a Cisco VG200 gateway is blank, use this option:
MGCPTest,,001001,001,001,MGCP Port,
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For port identifiers, ensure the first digit is either 0 or 1 (signifying either Sub-Unit 0 or Sub-Unit 1), followed
by the port number, 01 to 24. Acceptable values include 001 through 024 or 101 through 124. If the Cisco
VG200 gateway template has three port identifiers, use this option:
MGCPTest,VG200 Lab Gateway,001,002,003

Related Topics
Related Topics, on page 669

Create Text-Based CSV File for Cisco VG224 Gateways
You can create a CSV text file for VG224 gateways using a text editor, such as Notepad++.

Instead of using the BAT spreadsheet for data input when you are adding CiscoVG224 gateways, you can
create the comma-separated values (CSV) file by using lines of ASCII text with values separated by commas.
You must use the appropriate file format for the type of trunk and port for the gateway.

Cisco recommends uploading Text-Based CSV files saved in the UTF-8 format only, as characters other than
ASCII characters can be stored in this format. Using a text editor, such as Notepad++, you can select encoding
as UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down. Text-Based CSV files saved in
formats other than UTF-8 may render garbled when downloaded from .

Note

Procedure

Step 1 Open a text editor or any application that allows you to export or create a text-based CSV file.
Step 2 Using a separate line for each gateway, enter the values for each gateway and port that you want to add to .

An error occurs if any blank lines exist in the CSV file.Note

Step 3 While saving your CSV file, choose to save it as UTF-8 encoded. In Notepad++, you can select encoding as
UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down.

What to do next

Upload the CSV file to the first node server for .

Related Topics
Create Text-Based CSV File for IME Trusted Group Configuration, on page 663
FXS Trunks CSV File Format for VG224, on page 645
Upload File to Server, on page 21

FXS Trunks CSV File Format for VG224
The following sample format shows the required field length and string types followed by sample of CSV
files for a Cisco VG224 gateway.
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MGCP Domain Name(Mandatory, 1 to 64 characters),Description(Optional, up to 100
characters),Slot(Mandatory, up to 3 numerals), Subunit (Mandatory, up to 3 numerals), Port
Number(Mandatory, up to 3 numerals), Port Description Optional, up to 50 characters),Port
Directory Number(Optional, up to 24 numerals and special characters)

Sample

MGCPTest,VG224 Lab Gateway,2,0,0,Port 0,97255576601MGCPTest,VG224 Lab Gateway,2,0,1,Port
1,97255572001

You must include comma separators even if a field is blank. Specify the directory number and route partition
only if the port type in the Cisco VG224 gateway template is POTS.

Note

Example 1

If the Description for a Cisco VG224 gateway is blank, use this format:
MGCPTest, ,2,0,0,Port 0,97255576601

Related Topics
Related Topics, on page 669

Create Text-Based CSV File for Cisco VG310 Gateways
You can create a CSV text file for VG310 gateways using a text editor, such as Notepad++.

Instead of using the BAT spreadsheet for data input when you are adding Cisco VG310 gateways, you can
create the comma-separated values (CSV) file by using lines of ASCII text with values separated by commas.
You must use the appropriate file format for the type of trunk and port for the gateway.

Cisco recommends uploading Text-Based CSV files saved in the UTF-8 format only, as characters other than
ASCII characters can be stored in this format. Using a text editor, such as Notepad++, you can select encoding
as UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down. Text-Based CSV files saved in
formats other than UTF-8 may render garbled when downloaded from .

Note

Procedure

Step 1 Open a text editor or any application that allows you to export or create a text-based CSV file.
Step 2 Using a separate line for each gateway, enter the values for each gateway and port that you want to add to .

An error occurs if any blank lines exist in the CSV file.Note

Step 3 While saving your CSV file, choose to save it as UTF-8 encoded. In Notepad++, you can select encoding as
UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down.

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
646

Text-Based CSV Files
Create Text-Based CSV File for Cisco VG310 Gateways



What to do next

Upload the CSV file to the first node server for .

Related Topics
Create Text-Based CSV File for IME Trusted Group Configuration, on page 663
FXS Trunks CSV File Format for VG310, on page 647
Upload File to Server, on page 21

FXS Trunks CSV File Format for VG310
The following sample format shows the required field length and string types followed by sample of CSV
files for a Cisco VG310 gateway.
MGCP Domain Name(Mandatory, 1 to 64 characters),Description(Optional, up to 100
characters),Slot(Mandatory, up to 3 numerals), Subunit (Mandatory, up to 3 numerals), Port
Number(Mandatory, up to 3 numerals), Port Description Optional, up to 50 characters),Port
Directory Number(Optional, up to 24 numerals and special characters)

Sample

MGCPTest,VG310 Lab Gateway,2,0,0,Port 0,97255576601MGCPTest,VG310 Lab Gateway,2,0,1,Port
1,97255572001

You must include comma separators even if a field is blank. Specify the directory number and route partition
only if the port type in the Cisco VG310 gateway template is POTS.

Note

Example 1

If the Description for a Cisco VG310 gateway is blank, use this format:
MGCPTest, ,2,0,0,Port 0,97255576601

Related Topics
Related Topics, on page 669

Create Text-Based CSV File for VG320 Gateways
You can create a CSV text file for VG320 gateways using a text editor, such as Notepad++.

Instead of using the BAT spreadsheet for data input when you are adding CiscoVG320 gateways, you can
create the comma-separated values (CSV) file by using lines of ASCII text with values separated by commas.
You must use the appropriate file format for the type of trunk and port for the gateway.

Cisco recommends uploading Text-Based CSV files saved in the UTF-8 format only, as characters other than
ASCII characters can be stored in this format. Using a text editor, such as Notepad++, you can select encoding
as UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down. Text-Based CSV files saved in
formats other than UTF-8 may render garbled when downloaded from .

Note
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Procedure

Step 1 Open a text editor or any application that allows you to export or create a text-based CSV file.
Step 2 Using a separate line for each gateway, enter the values for each gateway and port that you want to add to .

An error occurs if any blank lines exist in the CSV file.Note

Step 3 While saving your CSV file, choose to save it as UTF-8 encoded. In Notepad++, you can select encoding as
UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down.

What to do next

Upload the CSV file to the first node server for .

Related Topics
Create Text-Based CSV File for IME Trusted Group Configuration, on page 663
FXS Trunks CSV File Format for VG320, on page 648
Upload File to Server, on page 21

FXS Trunks CSV File Format for VG320
The following sample format shows the required field length and string types followed by sample of CSV
files for a Cisco VG320 gateway.
MGCP Domain Name(Mandatory, 1 to 64 characters),Description(Optional, up to 100
characters),Slot(Mandatory, up to 3 numerals), Subunit (Mandatory, up to 3 numerals), Port
Number(Mandatory, up to 3 numerals), Port Description Optional, up to 50 characters),Port
Directory Number(Optional, up to 24 numerals and special characters)

Sample

MGCPTest,VG320 Lab Gateway,2,0,0,Port 0,97255576601MGCPTest,VG320 Lab Gateway,2,0,1,Port
1,97255572001

You must include comma separators even if a field is blank. Specify the directory number and route partition
only if the port type in the Cisco VG320 gateway template is POTS.

Note

Example 1

If the Description for a Cisco VG320 gateway is blank, use this format:
MGCPTest, ,2,0,0,Port 0,97255576601

Related Topics
Related Topics, on page 669
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Create Text-Based CSV File for VG350 Gateways
You can create a CSV text file for VG350 gateways using a text editor, such as Notepad++.

Instead of using the BAT spreadsheet for data input when you are adding Cisco VG350 gateways, you can
create the comma-separated values (CSV) file by using lines of ASCII text with values separated by commas.
You must use the appropriate file format for the type of trunk and port for the gateway.

Cisco recommends uploading Text-Based CSV files saved in the UTF-8 format only, as characters other than
ASCII characters can be stored in this format. Using a text editor, such as Notepad++, you can select encoding
as UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down. Text-Based CSV files saved in
formats other than UTF-8 may render garbled when downloaded from .

Note

Procedure

Step 1 Open a text editor or any application that allows you to export or create a text-based CSV file.
Step 2 Using a separate line for each gateway, enter the values for each gateway and port that you want to add to .

An error occurs if any blank lines exist in the CSV file.Note

Step 3 While saving your CSV file, choose to save it as UTF-8 encoded. In Notepad++, you can select encoding as
UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down.

What to do next

Upload the CSV file to the first node server for .

Related Topics
Create Text-Based CSV File for IME Trusted Group Configuration, on page 663
FXS Trunks CSV File Format for VG350, on page 649
Upload File to Server, on page 21

FXS Trunks CSV File Format for VG350
The following sample format shows the required field length and string types followed by sample of CSV
files for a Cisco VG350 gateway.
MGCP Domain Name(Mandatory, 1 to 64 characters),Description(Optional, up to 100
characters),Slot(Mandatory, up to 3 numerals), Subunit (Mandatory, up to 3 numerals), Port
Number(Mandatory, up to 3 numerals), Port Description Optional, up to 50 characters),Port
Directory Number(Optional, up to 24 numerals and special characters)

Sample

MGCPTest,VG350 Lab Gateway,2,0,0,Port 0,97255576601MGCPTest,VG350 Lab Gateway,2,0,1,Port
1,97255572001
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You must include comma separators even if a field is blank. Specify the directory number and route partition
only if the port type in the Cisco VG350 gateway template is POTS.

Note

Example 1

If the Description for a Cisco VG350 gateway is blank, use this format:
MGCPTest, ,2,0,0,Port 0,97255576601

Related Topics
Related Topics, on page 669

Create Text-Based CSV File for VG420 Gateways
You can create a CSV text file for VG420 gateways using a text editor, such as Notepad++.

Instead of using the BAT spreadsheet for data input when you are adding CiscoVG420 gateways, you can
create the comma-separated values (CSV) file by using lines of ASCII text with values separated by commas.
You must use the appropriate file format for the type of trunk and port for the gateway.

We recommend uploading Text-Based CSV files saved in the UTF-8 format only, as characters other than
ASCII characters can be stored in this format. Using a text editor, such as Notepad++, you can select encoding
as UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down. Text-Based CSV files saved in
formats other than UTF-8 may render garbled when downloaded from Unified Communications Manager.

Note

Procedure

Step 1 Open a text editor or any application that allows you to export or create a text-based CSV file.
Step 2 Using a separate line for each gateway, enter the values for each gateway and port that you want to add to

Unified Communications Manager.

An error occurs if any blank lines exist in the CSV file.Note

Step 3 While saving your CSV file, choose to save it as UTF-8 encoded. In Notepad++, you can select encoding as
UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down.

What to do next

Upload the CSV file to the first node server for Unified Communications Manager.

Create Text-Based CSV File for VG450 Gateways
You can create a CSV text file for VG450 gateways using a text editor, such as Notepad++.
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Instead of using the BAT spreadsheet for data input when you are adding Cisco VG450 gateways, you can
create the comma-separated values (CSV) file by using lines of ASCII text with values separated by commas.
You must use the appropriate file format for the type of trunk and port for the gateway.

Cisco recommends uploading Text-Based CSV files saved in the UTF-8 format only, as characters other than
ASCII characters can be stored in this format. Using a text editor, such as Notepad++, you can select encoding
as UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down. Text-Based CSV files saved in
formats other than UTF-8 may render garbled when downloaded from .

Note

Procedure

Step 1 Open a text editor or any application that allows you to export or create a text-based CSV file.
Step 2 Using a separate line for each gateway, enter the values for each gateway and port that you want to add to .

An error occurs if any blank lines exist in the CSV file.Note

Step 3 While saving your CSV file, choose to save it as UTF-8 encoded. In Notepad++, you can select encoding as
UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down.

What to do next

Upload the CSV file to the first node server for .

Related Topics
Create Text-Based CSV File for IME Trusted Group Configuration, on page 663
FXS Trunks CSV File Format for VG450, on page 651
Upload File to Server, on page 21

FXS Trunks CSV File Format for VG450
The following sample format shows the required field length and string types followed by sample of CSV
files for a Cisco VG450 gateway.
MGCP Domain Name(Mandatory, 1 to 64 characters),Description(Optional, up to 100
characters),Slot(Mandatory, up to 3 numerals), Subunit (Mandatory, up to 3 numerals), Port
Number(Mandatory, up to 3 numerals), Port Description Optional, up to 50 characters),Port
Directory Number(Optional, up to 24 numerals and special characters)

Sample

MGCPTest,VG450 Lab Gateway,2,0,0,Port 0,97255576601MGCPTest,VG450 Lab Gateway,2,0,1,Port
1,97255572001

You must include comma separators even if a field is blank. Specify the directory number and route partition
only if the port type in the Cisco VG450 gateway template is POTS.

Note
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Example 1

If the Description for a Cisco VG450 gateway is blank, use this format:
MGCPTest, ,2,0,0,Port 0,97255576601

Related Topics
Related Topics, on page 669

Create Text-Based CSV File for ISR 4461 Gateways
You can create a CSV text file for ISR 4461 gateways using a text editor, such as Notepad++.

Instead of using the BAT spreadsheet for data input when you are adding Cisco ISR 4461 gateways, you can
create the comma-separated values (CSV) file by using lines of ASCII text with values separated by commas.
You must use the appropriate file format for the type of trunk and port for the gateway.

We recommend uploading Text-Based CSV files saved in the UTF-8 format only, as characters other than
ASCII characters can be stored in this format. Using a text editor, such as Notepad++, you can select encoding
as UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down. Text-Based CSV files saved in
formats other than UTF-8 may render garbled when downloaded from Unified Communications Manager.

Note

Procedure

Step 1 Open a text editor or any application that allows you to export or create a text-based CSV file.
Step 2 Using a separate line for each gateway, enter the values for each gateway and port that you want to add to

Unified Communications Manager.

An error occurs if any blank lines exist in the CSV file.Note

Step 3 While saving your CSV file, choose to save it as UTF-8 encoded. In Notepad++, you can select encoding as
UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down.

What to do next

Upload the CSV file to the first node server for Unified Communications Manager.

Create Text-Based CSV File for Cisco Catalyst 6000 FXS Ports
You can create a CSV text file for Cisco Catalyst 6000 FXS ports using a text editor, such as Notepad++.

Instead of using the BAT spreadsheet for data input when you are adding Cisco Catalyst 6000 FXS ports, you
can create the comma-separated values (CSV) file by using lines of ASCII text with values separated by
commas. You must use the appropriate file format for the type of gateway.
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Procedure

Step 1 Open a text editor or any application that allows you to export or create a text-based CSV file.
Step 2 Using a separate line for each port, enter the values for each port that you want to add to .

An error occurs if any blank lines exist in the CSV file.Note

Step 3 While saving your CSV file, choose to save it as UTF-8 encoded. In Notepad++, you can select encoding as
UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down.

What to do next

Upload the CSV file to the first node server for .

Related Topics
Cisco Catalyst 6000 (FXS) Torts File Format, on page 653
Related Topics, on page 669

Cisco Catalyst 6000 (FXS) Torts File Format
The CSV file contains information about each port as a record. Each record specifies the gateway MAC
address and port number on that gateway to which you want to add or update the port details.

BAT does not add CiscoCatalyst 6000 (FXS) gateways. It only adds or updates ports to an existing gateway.Note

For the MAC address, enter no MACaddress values for an existing CiscoCatalyst 6000 (FXS) gateway. This
MACaddress uses the last 12 characters in the Gateway Name.

If you provide no values for Partition for any record on the CSV file, the system uses values from the BAT
template for these fields.

The following sample format shows the required field length and string types followed by examples of CSV
files for Catalyst 6000 (FXS) ports.
MAC Address (Mandatory, 12 characters),Port Number (Mandatory, 2 numerals),Directory
Number(Optional, up to 24 numerals and special characters)

Sample

1231123245AB,23,9725557250

You must include comma separators even if a field is blank.Note

Do not specify a partition unless you have also specified a directory number.Note
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Examples

If the directory number for a port is blank, use this format:
1231123245AB,23,

If you want to add only the mandatory values, use this format:
1231123245AB,23,

Related Topics
Related Topics, on page 669

Create Text-Based CSV File for Cisco VG202 and VG204
Gateways

You can create a CSV text file for VG202 or VG204 gateways using a text editor, such as Notepad++.

Instead of using the BAT spreadsheet for data input when you are adding Cisco VG202 and VG204 gateways,
you can create the comma-separated values (CSV) file by using lines of ASCII text with values separated by
commas. You must use the appropriate file format for the gateway.

Cisco recommends uploading Text-Based CSV files saved in the UTF-8 format only, as characters other than
ASCII characters can be stored in this format. Using a text editor, such as Notepad++, you can select encoding
as UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down. Text-Based CSV files saved in
formats other than UTF-8 may render garbled when downloaded from .

Note

Procedure

Step 1 Open a text editor or any application that allows you to export or create a text-based CSV file.
Step 2 Using a separate line for each gateway, enter the values for each gateway and port that you want to add to .

An error occurs if any blank lines exist in the CSV file.Note

Step 3 While saving your CSV file, choose to save it as UTF-8 encoded. In Notepad++, you can select encoding as
UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down.

What to do next

Upload the CSV file to the first node server for .

Related Topics
Create Text-Based CSV File for IME Trusted Group Configuration, on page 663
CSV File Format for VG202 and VG204 Gateways, on page 655
Upload File to Server, on page 21
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CSV File Format for VG202 and VG204 Gateways
The following sample formats and examples show the fields, field length, and whether the field is optional
or mandatory for a text-based CSV file for VG202 and VG204 Gateways.

There are two CSV file formats for VG202 and VG204 Gateways depending upon the Protocol:

• MGCP

• SCCP

For MGCP Gateway

Domain Name(Mandatory, 1 to 64 characters),Description(Optional, up to 100
characters),Slot(Mandatory, up to 3 numerals),Subunit(Mandatory, up to 3 numerals),Port
Number(Mandatory, up to 3 numerals),Port Description(Optional, up to 50 characters),Port
Directory Number(Optional, up to 24 numerals and special characters).

Sample

test,test,0,0,0,sample,1000

For SCCP Gateway

Mac Address(Mandatory, 1 to 64 characters),Description(Optional, up to 100
characters),Slot(Mandatory, up to 3 numerals),Subunit(Mandatory, up to 3 numerals),Port
Number(Mandatory, up to 3 numerals),Port Description(Optional, up to 50 characters),Port
Directory Number(Optional, up to 24 numerals and special characters).

Sample
SKIGW1111111111,test,0,0,0,sample,1000

Create Custom Text-Based CSV Files for Client Matter Codes
and Forced Authorized Codes

You can create a custom text-based CSV file using a text editor, such as Notepad++.

Procedure

Step 1 Open a text editor or any application that allows you to export or create a text-based CSV file.
Step 2 Using a separate line for each code, create a custom Client Matter Codes (CMC) CSV file or a Forced

Authorized Codes (FAC) CSV file, as described in the following steps:

• For CMC—Step 3 and Step 4

• For FAC— Step 3 and Step 4

Remember that you must create two separate CSV files, one for CMC and one for FAC.Tip

Step 3 To create a CMC CSV file, enter the corresponding information, where x, y represent the following fields:

• x—The client matter code (mandatory entry for all additions, updates, and deletions)
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• y—The description (optional if you update the entry)

For example, youmay enter 5555,Acme Toys, where 5555 equals the mandatory client matter code, and Acme
Toys equals the description.

Step 4 To create a FAC CSV file, enter the corresponding information, where x,y,z represent the following fields:

• x—The forced authorization code (mandatory entry for all additions, updates, and deletions)

• y—The authorization code name (optional if you update the entry)

• z—The authorization level (optional if you update the entry)

For example, you may enter 1234,John Smith,20, where 1234 equals the forced authorization code, John
Smith equals the authorization code name, and 20 equals the authorization level.

If you add new codes at the same time that you update them, make sure that you enter all required
information. You can change any part of an existing record, but you must include the code; for
example, the forced authorization code or client matter code. Deleting information and leaving
it blank does not remove the information from the database; a blank value does not overwrite an
existing value in the database, but, updating the value, for example, to Acme Toys, Inc., or John
L. Smith from the preceding examples, overwrites the existing value in the database.

Caution

Step 5 Upload the CSV file to the first node of .

While saving your CSV file, choose to save it as UTF-8 encoded. In Notepad++, you can select encoding as
UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down.

Cisco recommends uploading Text-Based CSV files saved in the UTF-8 format only, as characters
other than ASCII characters can be stored in this format. Using a text editor, such as Notepad++,
you can select encoding as UTF-8without Byte OrderMark (BOM) from the Encoding drop-down.
Text-Based CSV files saved in formats other than UTF-8 may render garbled when downloaded
from .

Note

Step 6 Perform one of the following tasks:

• If you made additions or updates, insert the file in the CUCM database using BAT.

• You can delete code settings.

You cannot perform insert and update operations simultaneously with the same CSV file. You
have to create separate CSV files for insert and update.

Note

Related Topics
Code Setting Deletion Examples, on page 465
Related Topics, on page 669
Update CMC or FAC in CUCM Database Using BAT, on page 462
Upload File to Server, on page 21
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CMC File Format
The following sample format and examples show the fields, field length, and whether the field is optional or
mandatory for a text-based CSV file for client matter codes.
Client Matter Code(Mandatory, 1 to 16 numerals),Description(Optional, 1 to 50 Characters)

Sample

1234567890123456,Marketing

Example

If the value of the field includes a comma, that field must be enclosed in double quotes. Use this format for
fields with commas:
1234567890123456, "Marketing, team"

Related Topics
Related Topics, on page 669

Update CMC File Format
Use a text editor to create the CSV text file for updating client matter codes.

The following sample format shows the field length and string types followed by examples of CSV files for
updating client matter codes.
Client Matter Code(Mandatory, 1 to 16 numerals),Description(Optional, 1 to 50 Characters)

Sample

1234567890123456,Marketing

Example

If the description is empty, use this format:
1234567890123456,

Related Topics
Related Topics, on page 669

FAC File Format
The following sample format and examples show the fields, field length, and whether the field is optional or
mandatory for a text-based CSV file for forced authorization codes.
Forced Authorization Code(Mandatory, 1 to 16 numerals),Authorization Code Name (Mandatory,
1 to 50 Characters),Authorization Level(Mandatory,values range from 0 to 255)

Sample

1234567890123456,John FAC,251

Related Topics
Related Topics, on page 669
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Update FAC File Format
Use a text editor to create the CSV text file for updating forced authorization codes.

The following sample format shows the field length and string types followed by examples of CSV files for
updating forced authorization codes.

Forced Authorization Code(Mandatory, 1 to 16 numerals),Authorization Code Name (Mandatory,

1 to 50 Characters),Authorization Level(Mandatory,values range from 0 to 255)

Sample

1234567890123456,John FAC,251

Example

Values you do not want to update must still include the delimiter. If only the Authorization Code Name has
to be updated use the following format:
1234567890123456,John FAC,

If only the Authorization level has to be updated, use the following format:
1234567890123456,John FAC,220

Related Topics
Related Topics, on page 669

Create Text-Based CSV File for Call Pickup Groups
You can create a custom text-based CSV file for call pickup groups using a text editor, such as Notepad++.

Procedure

Step 1 Open a text editor or any application that allows you to export or create a text-based CSV file.

Use a separate line for each call pickup group name.

Step 2 Enter the Pickup Group Name, Pickup Group Number, Partition, Other Pickup Group Name-Member1...
Other Pickup Group Name-Member10.

For example, you may enter Marketing,7815,Part1,Marketing,Managers,Training, where Marketing is the
mandatory pickup group name, 7815 is the mandatory pickup group number. Part1 is the partition, Marketing,
Managers, and Training are the other pickup group names that are associated to the pickup group Marketing.

Deleting information and leaving it blank does not remove the information from the database; a
blank value does not overwrite an existing value in the database, but updating the value, for
example, to Sales from Marketing, from the preceding examples, overwrites the existing value
in the database.

Caution

Step 3 Upload the CSV file to the first node of .

While saving your CSV file, choose to save it as UTF-8 encoded. In Notepad++, you can select encoding as
UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down.
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Cisco recommends uploading Text-Based CSV files saved in the UTF-8 format only, as characters
other than ASCII characters can be stored in this format. Using a text editor, such as Notepad++,
you can select encoding as UTF-8without Byte OrderMark (BOM) from the Encoding drop-down.
Text-Based CSV files saved in formats other than UTF-8 may render garbled when downloaded
from .

Note

Step 4 Perform one of the following tasks:

• If you made additions or updates, insert the file in the CUCM database using BAT.

• You can delete call pickup groups settings.

Related Topics
Related Topics, on page 669
Code Setting Deletion Examples, on page 465
Update CMC or FAC in CUCM Database Using BAT, on page 462
Upload File to Server, on page 21

CPG File Format
The following sample format and examples show the fields, field length, and whether the field is optional or
mandatory for a text-based CSV file for call pickup groups.
Pickup Group Name(Mandatory, 1 to 50 characters),Pickup Group Number(Mandatory, 1 to 24
numerals),Partition(Optional, 1 to 50 Characters),Other Pickup Group Name-Member1... Other
Pickup Group Name-Member10(Optional, 1 to 50 Characters)

Sample

Marketing,7815,Part1,Marketing,Managers,Training

Example

Optional values that you do not want to specify at this time must still include the delimiter (a comma) except
for Other Pickup Group members.

If the Partition for a Pickup Group is blank, use the following format:
Marketing,7815,

Related Topics
Related Topics, on page 669

Update CPG File Format
Use a text editor to create the CSV text file for updating the call pickup group.

The following sample format shows the field length and string types followed by examples of CSV files for
updating call pickup groups.
Pickup Group Name(Mandatory, 1 to 50 characters),Pickup Group Number(Mandatory, 1 to 24
numerals),Partition(Optional, 1 to 50 Characters),Other Pickup Group Name-Member1... Other
Pickup Group Name-Member10(Optional, 1 to 50 Characters)
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Sample

Marketing,,,Marketing,Managers,Training

Example

Marketing,,,Managers,Marketing,Training

If you do not want to update Other Pickup Group member, do not include the delimiter (a comma). Use the
following format:

Related Topics
Related Topics, on page 669

Create Text-Based CSV File for Remote Destination Profile
Instead of using the BAT spreadsheet for data input when you are adding Remote Destination Profiles (RDPs),
you can create the comma-separated values (CSV) file by using lines of ASCII text with values separated by
commas. You can use a text editor such as Notepad++.

Cisco recommends uploading Text-Based CSV files saved in the UTF-8 format only, as characters other than
ASCII characters can be stored in this format. Using a text editor, such as Notepad++, you can select encoding
as UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down. Text-Based CSV files saved in
formats other than UTF-8 may render garbled when downloaded from .

Note

Procedure

Step 1 Open a text editor or any application that allows you to export or create a text-based CSV file.
Step 2 Use a separate line to enter the values for each RDP that you want to add to . Keep in mind the following

rules when you create the CSV data file.

• Always include comma separators, even if a field is blank.

• Specify the user ID if the RDP is to be associated to a user.

• Consider Directory Number fields as optional only when you are creating the CSV file for use with a
BAT template that has no lines. If lines are configured on the BAT RDP template, you must supply
directory numbers in the CSV file for each RDP.

• An error occurs when you insert a CSV file with blank lines.

Step 3 While saving your CSV file, choose to save it as UTF-8 encoded. In Notepad++, you can select encoding as
UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down.

What to do next

Upload the CSV file to the first node of .
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Related Topics
Upload File to Server, on page 21

Creating Text-Based CSV File for Phone Migration
Instead of using the BAT spreadsheet for data input when you are migrating phones, you can create the
comma-separated values (CSV) file by using lines of ASCII text with values separated by commas. You can
use a text editor such as Notepad++.

Cisco recommends uploading Text-Based CSV files saved in the UTF-8 format only, as characters other than
ASCII characters can be stored in this format. Using a text editor, such as Notepad++, you can select encoding
as UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down. Text-Based CSV files saved in
formats other than UTF-8 may render garbled when downloaded from .

Note

Procedure

Step 1 Open a text editor or any application that allows you to export or create a text-based CSV file.
Step 2 Use a separate line to enter the values for each phone that you want to migrate. Keep in mind the following

rules when you create the CSV data file.

• Always include comma separators, even if a field is blank.

• An error occurs when you insert a CSV file with blank lines.

Step 3 While saving your CSV file, choose to save it as UTF-8 encoded. In Notepad++, you can select encoding as
UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down.

What to do next

Upload the CSV file to the first node of .

Related Topics
Upload File to Server, on page 21

Phone Migration File Format
The following sample format and example shows the fields, field length, and whether the field is optional or
mandatory for a text-based CSV file for phone migration.
Old Device Name(Mandatory, 1 to 50 characters),New Device MAC Address(Mandatory, 12
characters)Description(Optional, 1 to 50 characters).

Sample

Old Device Name,New Device MAC Address,Description
SEP123456789012,123333789012,Marketing
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Create Text-Based CSV File for IME Trusted Element
Configuration

Instead of using the BAT spreadsheet for data input when you are inserting IMETrusted Element Configuration,
you can create the comma-separated values (CSV) file by using lines of ASCII text with values separated by
commas. You can use a text editor such as Notepad++.

Cisco recommends uploading Text-Based CSV files saved in the UTF-8 format only, as characters other than
ASCII characters can be stored in this format. Using a text editor, such as Notepad++, you can select encoding
as UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down. Text-Based CSV files saved in
formats other than UTF-8 may render garbled when downloaded from .

Note

Procedure

Step 1 Open a text editor or any application that allows you to export or create a text-based CSV file.
Step 2 Use a separate line to enter the values for each IME Trusted Element Configuration that you want to add.

Keep in mind the following rules when you create the CSV data file.

• Always include comma separators, even if a field is blank.

• An error occurs when you insert a CSV file with blank lines.

Step 3 While saving your CSV file, choose to save it as UTF-8 encoded. In Notepad++, you can select encoding as
UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down.

What to do next

Upload the CSV file to the first node server for .

Related Topics
Upload File to Server, on page 21

IME Trusted Element Configuration File Format
The following sample format and example shows the fields, field length, and whether the field is optional or
mandatory for a text-based CSV file for IME Trusted Element Configuration.

Name (Mandatory 1 to 50 characters), Description (Optional, 1 to128 characters), Element Type (Mandatory,
1 to 50 characters), Cisco IME Link Route Filter Group (Mandatory, 1 to 50 characters).

Sample

Name, Description, Element Type, Cisco IME Link Route Filter Group
Elem1,sample_file,Prefix,grp1
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Create Text-Based CSV File for IME Trusted Group Configuration
Instead of using the BAT spreadsheet for data input when you are inserting IME Trusted Group Configuration,
you can create the comma-separated values (CSV) file by using lines of ASCII text with values separated by
commas. You can use a text editor such as Notepad++.

Cisco recommends uploading Text-Based CSV files saved in the UTF-8 format only, as characters other than
ASCII characters can be stored in this format. Using a text editor, such as Notepad++, you can select encoding
as UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down. Text-Based CSV files saved in
formats other than UTF-8 may render garbled when downloaded from .

Note

Procedure

Step 1 Open a text editor or any application that allows you to export or create a text-based CSV file.
Step 2 Use a separate line to enter the values for each IME Trusted Group Configuration that you want to add. Keep

in mind the following rules when you create the CSV data file.

• Always include comma separators, even if a field is blank.

• An error occurs when you insert a CSV file with blank lines.

Step 3 While saving your CSV file, choose to save it as UTF-8 encoded. In Notepad++, you can select encoding as
UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down.

What to do next

Upload the CSV file to the first node of .

Related Topics
Upload File to Server, on page 21

IME Trusted Element Configuration File Format
The following sample format and example shows the fields, field length, and whether the field is optional or
mandatory for a text-based CSV file for IME Trusted Group Configuration.

Name (Mandatory 1 to 50 characters), Description (Optional, 1 to128 characters), Element Type (Mandatory,
1 to 50 characters), Cisco IME Link Route Filter Group (Mandatory, T/F).

Sample

Name, Description, Trusted
grp1,sample_file,t
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Create Text-Based CSV File for IME Enrolled Group
Configuration

Instead of using the BAT spreadsheet for data input when you are inserting IME Enrolled Group Configuration,
you can create the comma-separated values (CSV) file by using lines of ASCII text with values separated by
commas. You can use a text editor such as Notepad++.

Cisco recommends uploading Text-Based CSV files saved in the UTF-8 format only, as characters other than
ASCII characters can be stored in this format. Using a text editor, such as Notepad++, you can select encoding
as UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down. Text-Based CSV files saved in
formats other than UTF-8 may render garbled when downloaded from .

Note

Procedure

Step 1 Open a text editor or any application that allows you to export or create a text-based CSV file.
Step 2 Use a separate line to enter the values for each IME Enrolled Group Configuration that you want to add. Keep

in mind the following rules when you create the CSV data file.

• Always include comma separators, even if a field is blank.

• An error occurs when you insert a CSV file with blank lines.

Step 3 While saving your CSV file, choose to save it as UTF-8 encoded. In Notepad++, you can select encoding as
UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down.

What to do next

Upload the CSV file to the first node of .

Related Topics
Upload File to Server, on page 21

IME Enrolled Group Configuration File Format
The following sample format and example shows the fields, field length, and whether the field is optional or
mandatory for a text-based CSV file for IME Enrolled Group Configuration.

Group Name (Mandatory 1 to 50 characters), Description (Optional, 1 to128 characters), Fallback Profile
(Optional, 1 to 50 characters), All Patterns In Group Are Aliases (Optional, T/F).

Sample

Group Name, Description,Fallback Profile, All Patterns In Group Are Aliases
Enrol_grp1,sample_file,profile1,t

Bulk Administration Guide for Cisco Unified Communications Manager, Release 14 and SUs
664

Text-Based CSV Files
Create Text-Based CSV File for IME Enrolled Group Configuration



Create Text-Based CSV File for IME Exclusion Group
Configuration

Instead of using the BAT spreadsheet for data input when you are inserting IMEExclusionGroup Configuration,
you can create the comma-separated values (CSV) file by using lines of ASCII text with values separated by
commas. You can use a text editor such as Notepad++.

Cisco recommends uploading Text-Based CSV files saved in the UTF-8 format only, as characters other than
ASCII characters can be stored in this format. Using a text editor, such as Notepad++, you can select encoding
as UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down. Text-Based CSV files saved in
formats other than UTF-8 may render garbled when downloaded from .

Note

Procedure

Step 1 Open a text editor or any application that allows you to export or create a text-based CSV file.
Step 2 Use a separate line to enter the values for each IME Exclusion Group Configuration that you want to add.

Keep in mind the following rules when you create the CSV data file.

• Always include comma separators, even if a field is blank.

• An error occurs when you insert a CSV file with blank lines.

Step 3 While saving your CSV file, choose to save it as UTF-8 encoded. In Notepad++, you can select encoding as
UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down.

What to do next

Upload the CSV file to the first node of . See the Upload File to Server, on page 21.

Related Topics
Upload File to Server, on page 21

IME Exclusion Group Configuration File Format
The following sample format and example shows the fields, field length, and whether the field is optional or
mandatory for a text-based CSV file for IME Exclusion Group Configuration.

Group Name (Mandatory 1 to 50 characters), Description (Optional, 1 to128 characters).

Sample

Name,Description
Exclu_grp1,sample_file
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Create Text-Based CSV File for Fallback Profile Configuration
Instead of using the BAT spreadsheet for data input when you are inserting Fallback Profile Configuration,
you can create the comma-separated values (CSV) file by using lines of ASCII text with values that are
separated by commas. You can use a text editor such as Notepad++.

Cisco recommends uploading Text-Based CSV files saved in the UTF-8 format only, as characters other than
ASCII characters can be stored in this format. Using a text editor, such as Notepad++, you can select encoding
as UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down. Text-Based CSV files saved in
formats other than UTF-8 may render garbled when downloaded from .

Note

Procedure

Step 1 Open a text editor or any application that allows you to export or create a text-based CSV file.
Step 2 Use a separate line to enter the values for each Fallback Profile Configuration that you want to add. Keep in

mind the following rules when you create the CSV data file.

• Always include comma separators, even if a field is blank.

• An error occurs when you insert a CSV file with blank lines.

Step 3 While saving your CSV file, choose to save it as UTF-8 encoded. In Notepad++, you can select encoding as
UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down.

What to do next

Upload the CSV file to the first node of .

Related Topics
Upload File to Server, on page 21

Fallback Profile Configuration File Format
The following sample format and example shows the fields, field length, and whether the field is optional or
mandatory for a text-based CSV file for Fallback Profile Configuration.

Name (Mandatory, 1 to 50 characters), Description (Optional, 1 to128 characters), Advertised Fallback
Directory E.164 Number (Optional, 1 to16 characters), Fallback Qos Sensitivity Level (Mandatory, 1 to 2
characters), Fallback Call CSS (Mandatory, 1 to2 characters), Fallback Call Answer Timer (Mandatory, 1 to2
characters), Fallback Directory Number Partition (Mandatory, 1 to 50 characters), Fallback Directory Number
(Mandatory, 1 to 50 characters), Number of Digits for Caller Id Partial Match (Mandatory, 1 to 2 characters).
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Sample

Name,Description,Advertised Fallback Directory E.164 Number, Fallback Qos Sensitivity Level, Fallback
Call CSS, Fallback Call Answer Timer, Fallback Directory Number Partition, Fallback Directory Number,
Number of Digits for Caller Id Partial Match.
profile1,sample_file,+91233232,1,Trunk Reroute Calling Search Space,2,partition1,1212,1

Create Text-Based CSV File for End User CAPF Profile
Instead of using the BAT spreadsheet for data input when you are inserting end user CAPF profiles, you can
create the comma-separated values (CSV) file by using lines of ASCII text with values separated by commas.
You can use a text editor such as Notepad++.

Cisco recommends uploading Text-Based CSV files saved in the UTF-8 format only, as characters other than
ASCII characters can be stored in this format. Using a text editor, such as Notepad++, you can select encoding
as UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down. Text-Based CSV files saved in
formats other thanUTF-8may render garbledwhen downloaded fromCiscoUnified CommunicationsManager.

Note

Procedure

Step 1 Open a text editor or any application that allows you to export or create a text-based CSV file.
Step 2 Use a separate line to enter the values for each end user CAPF profile that you want to add. Keep in mind the

following rules when you create the CSV data file:

• Always include comma separators, even if a field is blank.

• An error occurs when you insert a CSV file with blank lines.

Step 3 While saving your CSV file, choose to save it as UTF-8 encoded. In Notepad++, you can select encoding as
UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down.

What to do next

Upload the CSV file to the first node of Cisco Unified Communications Manager.

Related Topics
Upload File to Server, on page 21

End User CAPF Profile File Format
The following sample format and example shows the fields, field length, and whether the field is optional or
mandatory for a text-based CSV file for end user CAPF profile.

Instance ID (Mandatory, 1 to 132 characters), End User ID (Mandatory, 1 to 128 characters), Certificate
Operation (Mandatory, 1 to 100 characters), Authentication Mode (Mandatory, 1 to 100 characters),
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Authentication String (Optional, 1 to 50 characters), Key Size (Mandatory, 1 to 4 characters), Operation
Completes By (Mandatory, 1 to 15 characters)

Sample

Instance ID,EndUser ID,Certificate Operation,AuthenticationMode,Authentication String,Key Size,Operation
Completes By
11,user,No Pending Operation,By Existing Certificate (precedence to
LSC),1234567,512,2010:1:21:12

Create Text-Based CSV File for Mobility Profile
Instead of using the BAT spreadsheet for data input when you are inserting mobility profiles, you can create
the comma-separated values (CSV) file by using lines of ASCII text with values that are separated by commas.
You can use a text editor such as Notepad++.

Cisco recommends uploading Text-Based CSV files saved in the UTF-8 format only, as characters other than
ASCII characters can be stored in this format. Using a text editor, such as Notepad++, you can select encoding
as UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down. Text-Based CSV files saved in
formats other thanUTF-8may render garbledwhen downloaded fromCiscoUnified CommunicationsManager.

Note

Procedure

Step 1 Open a text editor or any application that allows you to export or create a text-based CSV file.
Step 2 Use a separate line to enter the values for eachmobility profile that you want to add. Keep in mind the following

rules when you create the CSV data file:

• Always include comma separators, even if a field is blank.

• An error occurs when you insert a CSV file with blank lines.

Step 3 While saving your CSV file, choose to save it as UTF-8 encoded. In Notepad++, you can select encoding as
UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down.

What to do next

Upload the CSV file to the first node of Cisco Unified Communications Manager.

Related Topics
Upload File to Server, on page 21

Mobility Profile File Format
The following sample format and example shows the fields, field length, and whether the field is optional or
mandatory for a text-based CSV file for Mobility Profile.
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Mobility Profile Name (Mandatory, 1 to 50 characters), Description (Optional, 1 to128 characters), Service
Access Number (Optional, 1 to 50 characters), Enterprise Feature Access Number/Partition (Optional, 1 to
50 characters), Callback Caller ID (Optional, 1 to 50 characters), Mobile Client Calling Option (Mandatory,
1 to 50 characters).

Sample

Mobility Profile Name,Description,Service Access Number,Enterprise Feature Access
Number/Partition,Callback Caller Id,Mobile Client Calling Option
MoProfile1,testexport,2323,123456 in part1,33,Dial via Office Reverse

Create Text based CSV file for Infrastructure Devices
You can create a CSV text file for Infrastructure Devices using a text editor, such as Notepad++.

Cisco recommends uploading Text-Based CSV files saved in the UTF-8 format only, as characters other than
ASCII characters can be stored in this format. Using a text editor, such as Notepad++, you can select encoding
as UTF-8 without Byte Order Mark (BOM) from the Encoding drop-down. Text-Based CSV files saved in
formats other thanUTF-8may render garbledwhen downloaded fromCiscoUnified CommunicationsManager.

Note

Procedure

Step 1 Open a text editor or any application that allows you to export or create a text-based CSV file.
Step 2 The first line of the CSV file must be "ACCESSPOINT OR SWITCH NAME,IPV4 ADDRESS,IPV6

ADDRESS,BSSID,DESCRIPTION".
Step 3 Use a separate line to enter the values for each infrastructure device that you want to add. The CSV file must

have the following comma delineated columns:

• Device Name
• IPv4 Address
• IPv6 Address
• BSSID
• Description

Step 4 To View sample csv data file, Click Bulk administration > Infrastructure Device > Insert Infrastructure
Device.
The Insert Infrastructure Device Configuration window opens.

Step 5 Click View Sample File.

Related Topics
• Create Text-Based CSV File for Phones, on page 630
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• Create Text-Based CSV User File, on page 635

• Create Text-Based CSV File for User Device Profile, on page 638

• Create Text-Based CSV File for Cisco Unified CM Assistant Manager-Assistant Associations, on page
641

• Create Text-Based CSV File for Cisco VG200 Gateways, on page 642

• Create Text-Based CSV File for Cisco Catalyst 6000 FXS Ports, on page 652

• Create Custom Text-Based CSV Files for Client Matter Codes and Forced Authorized Codes, on page
655

• Create Text-Based CSV File for Call Pickup Groups, on page 658

• Create Text-Based CSV File for Remote Destination Profile, on page 660

• Creating Text-Based CSV File for Phone Migration, on page 661

• Create Text-Based CSV File for IME Trusted Element Configuration, on page 662

• Create Text-Based CSV File for IME Enrolled Group Configuration, on page 664

• Create Text-Based CSV File for IME Exclusion Group Configuration, on page 665

• Create Text-Based CSV File for Fallback Profile Configuration, on page 666

• Create Text-Based CSV File for End User CAPF Profile, on page 667

• Create Text-Based CSV File for Mobility Profile, on page 668
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BAT Performance

• BAT Performance, on page 671

BAT Performance
The following table lists the performance values for various BAT transactions.

The listed performance data occurs at laboratory conditions, and this data can change depending on Cisco
Unified Communications Manager activity. Off-peak hour numbers only provide an approximate guidance
to judge the overall time for transaction.

Note

Table 53: BAT Performance Measures for Various Transactions

Records Processed/MinuteTransaction

Forced Authorization Codes

200Insert FAC

500Delete FAC

Client Matter Codes

250Insert CMC

500Delete CMC

Call Pickup Groups

200Insert CPG

500Delete CPG

Phones/Users

100Validate Phones/Users

30Insert Phones/Users
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Records Processed/MinuteTransaction

Users

150Insert Users

65Update Users

500Reset Password/PIN Query

350Reset Password/PIN Custom

500Generate User reports

250Export Users - Specific

200Export Users - All

300Delete Users - Query

300Delete Users - Custom

Manager Assistants

75Manager/Assistant Insert

300Manager/Assistant CSV-Based Delete

300Manager/Assistant Query-Based Delete

300Manager/Assistant Custom File-Based Delete

UDP Transactions

300Validate UDP

65Insert UDP Specific Details

50Export All Details

75Add lines UDP

125Report UDP

70Delete UDP

Phone Transactions

250Validate Phones

45Insert Specific Phones

75Export All Details

150Update Phones

75Add lines for Phones
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Records Processed/MinuteTransaction

500Reset/Restart Phones

300Generate Phone Reports

75Delete Phones (Query)

Infrastructure Devices

500Insert Infrastructure Device
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